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Lesson 1: Getting Started

What You Will Learn

After completing this lesson, you will be able to:

· Define programming in general terms.

· Logically solve a complex problem and write it out in pseudo-code.

· Demonstrate basic flow charting.

Related Topics Covered in this Lesson

· General Program Structure

· Code Execution

Overview - Getting Started

Programming computers can be intimidating if you have not been exposed to it before. The exercises in this module are designed to give you the chance to explore programming logic without dealing with the syntax of a programming language. We will not touch a computer. Instead, you will be working in teams to solve problems creatively, and in so doing, you will lay the foundation for learning any programming language.

Anyone can be a Programmer

You may not be aware of it, but you are already a programmer. Ever since the first time you figured out that you could reach the cookie jar by pushing a chair over to the counter, you have been using programming, because programming is nothing but structured, logical problem solving.

A Word about Computers

Computers only understand certain commands. They do not learn; they do not remember; they do not make intelligent decisions. They can only do exactly what you tell them to do, in exactly the sequence you specify. 

To illustrate this, think of the phrase, “Put on your shoes and socks.” Fortunately, as people we have the ability to translate that into “Put on your socks and then put on your shoes.” If you were a computer, and someone told you to do that, you would end up with very dirty socks. 

Even the most experienced programmer may find flaws in the logic flow of a program that stem from forgetting that the computer does only what it is told because what you think you told it to do, and what you really told it to do are two different things! It can be something as simple as the difference between:

“Go to the corner and turn left.”

 and 

“Turn left and go to the corner.”

You would end up it two totally different places.

Exercise 1

For this first exercise, you will be working alone. In the space provided on the next page, write directions from your house to the nearest gas station. They can be as detailed or as simple as you like. Do not discuss your plans with anyone until you have completed your instructions. Then compare your directions with a neighbor’s. 

Write your directions on this page:

Discussion

To write your directions, you needed to make some assumptions and decisions. For instance, where were you when you started? In the house? At the door? In a car? If you were in a car, which direction were you facing? Perhaps you built some decision making into the directions. Was there a traffic light along the way? Did you build in the directions to stop if the light was red, or did you assume that was written into the description of a licensed driver? How does your user know when he is at the service station?

If someone who was totally unfamiliar with your area were to use your directions, would he or she be able to find the service station? Your directions are a simple program. If you wrote it well, a stranger would be able to get to the gas station. If not, he or she might become hopelessly lost.

Your directions probably follow the general structure of a programming procedure.

· Some kind of a start here or origination statement

· The body of the directions, or programming instructions

· Some kind of a “stop here” or destination statement

All programming languages follow that same form, although they have different keywords and syntax to perform these functions.

Exercise 2

For this exercise, you will work with three to five other participants. Imagine that you are standing in a doorway, facing into one room in a two-room building. There is a door between the two rooms, and a door in the other room that leads to the outside. Your task is to make your way into the other room, and out the other outside door. There are two problems:

· You can only see directly ahead of you

· You do not know where the doors are

To illustrate the problem, the building is arranged like this:




Figure 1 - Two Room Building

You may be standing along any of the outside walls facing into either of the rooms. There is a door between the rooms. The outside door in the other room may be on any of the three outside walls in that room. Write your instructions on the next page. Have fun!

Write your directions here:

Discussion:

How did it go? Do you think that your instructions would work under any circumstances? If you were standing at the other outside door facing in, would your program still work? What did you do to ensure that you did not go back out the same door you entered?

Flow Charting

Whenever you are faced with a problem like the one you just solved, the solution follows a certain pattern. Programmers have long created flow charts to map the decision-making processes involved in solving problems. Charting the logic behind a program allows you to catch errors in rationale before starting to code, thus avoiding many bugs from the beginning. Flow charts consist of several symbols connected by arrows to show the flow of the program.




Figure 2 - Oval for Start and End

The oval is generally used for the starting and ending points of a program. No action takes place here.




Figure 3 - Rectangle for Input/Output

The rectangle is used for input, output and action steps. This includes getting information from users, performing calculations, sending information to a spreadsheet, etc.

[image: image1.wmf]
Figure 4 - Diamond for Decision

The diamond is used for a decision making step. The criteria for the question is at the diamond, and there are always two lines leading away from it, one for a positive result, and one for a negative result.

To illustrate, consider the process of logging onto a computer. First, you must get input on the user’s password. Then you must compare the input to the stored password. If it is correct, you log onto the system; if not, you get an error message, which asks for user input again. Diagrammed in a flow chart, it looks like this:
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Figure 5 - Flow Chart 

Your next assignment is to get together with your group, and flow chart the building exercise you did before in the space below.

Draw flow chart here:

Points to Remember

· Programming need not be intimidating. It is just logical problem solving.

· Programs need a start statement, a body, and an end statement. 

· Careful planning before you start writing code can make programming much easier. 

Lesson 2: Control Structures

What You Will Learn 

After completing this lesson, you will be able to:

· Use branching structures (If, Then, Else, and Case statements).

· Use looping structures (Do While, Do Until).

· Use proper programming form for procedures.

Related Topics Covered in this Lesson

· Defining Procedures

· Using Variables and Counters

· Commenting your Programs

Overview - Control Structures

Thus far, we have been using plain English, and have not concerned ourselves with structure. In this lesson we will add some structure, and introduce you to proper programming form. First we will look at a program that requires no decisions, then refine it to work in all kinds of situations.

Make a Robot

In the next exercise, you will work with your group. One person in the group should be designated as a robot and you are to write a program to control him or her. Your program specifications are that the robot must be sitting in a chair when the procedure starts. The robot must stand, walk to the wall and touch it, turn around, walk back to his chair and sit in it. He may not make any decisions on his own; all functionality must be hard coded into the instructions.

[image: image3.wmf]
Hint: You will need to know how many steps your robot is away from the wall before you begin.

When you are writing code, it is customary to indent your lines in the following manner:

Starting statement


Body code


With the instructions for the procedure

Ending statement

At this point we want to start following programming conventions, so indent your instructions in the manner above. In the last lesson you were writing pseudocode, which is the term programmers use for program instructions written in human language. Now we will limit your vocabulary in much the same way that programming languages are limited to certain syntax and keywords. During this exercise you may use only the following words:

Start <procedure name>

Step(number of steps)

Turn (Direction, number of degrees)

Raise Arms

Lower Arms

Stand

Sit

End

[image: image4.wmf]
Note the syntax of the directions above. After the starting statement, the procedure name is in <> symbols. This means that you should fill in your own name for the procedure. The instructions connected to the Turn and Step commands are in parentheses, indicating that they are arguments, or variables that the command needs in order to function. Where the syntax is:

Turn(direction, number of degrees)

The actual command might be:

Turn(right,45)

At times you may also see brackets [] surrounding words. That means you need to use one or the other of the words enclosed in the brackets.

Remember—this is supposed to be fun, so have a good time!

Write your code here:

Discussion:

Did you remember to have the robot turn around again before sitting down? Did you leave him enough room to turn at the wall. Remember, robots (just like computers) do exactly what they are told, in exactly the sequence you specify. Easy to get yourself in trouble, isn’t it?

Making Decisions

You have seen that it is sometimes necessary to make a decision based on particular criteria. In the building exercise in Lesson 1, you had to decide if there was a door in front of you before you could tell what to do next. In programming we call this kind of operation a branching structure. There are two kinds of main branching structures in most programming languages, If statements and Case statements. 

If Statements

If statements allow you to take different courses of action depending on the results of a test or tests. They generally follow the form below:

If <test> then <result> else <other result>

If there is more than one test to make, or if there are several things to do as the first or second result, it is better to use a block form of the If statement:

If <test1> then


result step 1


result step 2

Elseif <test2>


Result 

Else


Another result

End If




Figure 6 - If Then Flow Chart

While the syntax may change a little depending on the language, nearly all languages have a block form of the If statement, and they are all very similar. As the code executes, each statement is evaluated. If a test is False, the execution skips to the next Else statement. If the test is True, it executes the Result statements, and then goes to End If.

Case Statements

Case statements are used when there is only one testing criteria, but there may be many answers to the test. For instance, if you were testing for the color of a person’s car, there may be several answers: red, blue, white, or any other color. 

In a case statement, this would read something like this:

Select Case CarColor


‘check for the car color


Case “red” 




‘if it is red



do one thing


‘follow this action


Case “blue”




‘if it is blue



do another thing

‘do this


Case “white”



‘if it is white



do something else

‘do this


Case Else




‘if it is any other color



do yet another


‘do this

End Select




Figure 7 - Case Flow Chart

This handy structure is available in many languages, but not all of them. Because it is not as widely available, many programmers overlook it, even when it would really fit the bill.

GoTo and GoSub

Most languages also have some sort of statement that sends the course of execution to a line number or a line label. GoSub sends the execution to a different procedure, and when that procedure is finished, execution resumes at the line after GoSub. In some languages, you simply enter the name of the other procedure without explicitly saying GoSub, or even Run. 

Generally, using a GoTo statement sends the program on a one-way trip to a different line in the same procedure or to a different procedure, and it never comes back. (The one exception to that is in error handling, but that is beyond the scope of these exercises.) Of course, if you send the execution of a program to a line above the GoTo statement, it simply follows the sequence of the program, and then comes back to that line naturally.

Some programming languages allow you to use a line number to send the program to, in others, you create a line label. These are simply names you give a line, like this:

StartHere:

If the program encounters a line that says:

If <test> GoTo StartHere

The test is evaluated, and if it is True, the execution skips to the line StartHere: and executes sequentially from that line.




Figure 8 - GoTo Flow Charts

Build in Decision Making Power

Let’s go back to your robot. If someone were to move the chair, and your program did not allow for decision making, you would either have the robot falling short of the wall, or trying to walk right through it. With all this new information in mind, you are ready to build some decision making power into your robot. You may now add the keywords:

Not
If
Then
Else

ElseIf
End If
GoTo
<LineLabel:>

AtWall
AtChair



Use the bottom of this page to revise your robot code.

If your group is like most, you probably ended up with something like this on the last exercise:

Start


Stand


Arms Up


If AtWall then



Arms Down



Sit



GoTo LineLabel1


End If

LineLabel2:


Step(1)


If not AtWall then 



GoTo LineLabel2


Else 



Turn(Right, 180)


End if

LineLabel3:


Step(1)


If not AtChair then 



GoTo LineLabel3


Else 



Turn(Right, 180)


End if


Arms Down


Sit

LineLabel1:


Exit Routine

End

While this works fine, it is a little clumsy. One thing you can do to make it smoother is to use a counter variable to keep track of the number of steps to the wall, then simply have your robot go back the same number of steps when he turns around. 

Variables

Variables are simply placeholders for information that your program uses temporarily. You give them a name, and assign a value to them. They may hold numbers, or strings (text), dates, currency, or Boolean values (True or False). The type of information held in a variable is known as the data type. Variables can be declared explicitly, like this:

Dim MyVariable as string

MyVariable = “April”

Or they may be declared “on the fly,” or implicitly:

MyVariable = “April”

Implicitly declared variables can hold any data type, and the data type can change during code execution, but they take more memory and are not as efficient to use.

In the robot sample below, we are using the word Counter, but you could call it anything (Fred, even).

Start


Stand


Arms Up


If AtWall then



Arms Down



Sit



GoTo LineLabel1


End If


Counter = 0

LineLabel2:


Step(1)


Counter = Counter + 1


If not AtWall then 



GoTo LineLabel2


Else 



Turn(Right, 180)


End if


Step(Counter)


Turn(Right, 180)


Arms Down


Sit

LineLabel1:

End 

While this is better, it is still a little clumsy. The code above uses a GoTo statement to create a looping effect. If the robot can not touch the wall, he takes another step and tries again. Repeating a task is so common that all languages have some sort of looping structure to accomplish it, and they are far more efficient and elegant than using If and GoTo.

Looping

Loops come in two main varieties. Do loops and For loops. Think of a loop as Do this and keep looping. A tongue-in-cheek dictionary definition is:

Loop (n.) See Loop 

Do Loops

The common syntax for a Do loop is:

Do [While] [Until] <test>
‘Use either While or Until


instructions



‘may be several lines

Loop

First you instruct the program to test for something, and either keep performing the same instructions while the test evaluates to True or until it is True. The Loop statement after the instructions sends execution back to the test again. In this kind of looping structure, if the test is not True, no instructions are carried out at all. Sometimes you may want your instructions carried out once, whether or not the test is true. In these cases you would want the instructions to precede the test like this:

Do 


instructions

Loop [While] [Until] <test>

In either case, once the test proves False, execution falls out of the loop, and continues with the first statement after the loop.




Figure 9 - Do Loop Flow Charts

For Loops

For loops allow you to execute a series of instructions a certain number of times. The general syntax is:

For <variable> = <start number> to <end number> step <number>


instructions

Next <variable>




Figure 10 - For Next Flow Chart

For loops work by counting the number of times to go through the loop. Each time through the loop, the variable takes on the value of the count. There must be a start number and an end number; there may be a step number. If there is no step number, 1 is assumed. For example:

For x = 2 to 10 step 2


print x

Next x

This would go through the loop five times. The first time the value of x would be 2, then 4, then 6, then 8, and finally 10. It starts with 2, ends with 10 and, because we specified step 2, it skips every other number. Your start number can be greater than your end number, as long as the step is a negative. Then the program counts down.

In some languages, there are also For Each loops, in which you specify a collection of items, and execute instructions one time for each of the items in the collection. We will not go into the particulars about those here, but you should be aware that they exist

Getting Efficient

Let’s look at the robot program again, and build in a loop instead of that clumsy If structure:

Start


Stand


Arms Up


If at wall then



Arms Down



Sit



GoTo LineLabel


End If


Counter = 0

Do Until at wall


Step(1)


Counter = Counter + 1

Loop

Turn(Right, 180)

Step(Counter)

Turn(Right, 180)

Arms Down

Sit

LineLabel:

End

This is definitely looking better! There is still one thing you can do to clean it up, though. Looking at the If statement at the top, you can see that the purpose of it is to simply break out of the program if you are already at the wall. This is another common scenario. Sometimes you need to break out of the whole routine, other times you may need to break out of a loop.

Exit

The Exit statement was designed for times when you need to break out of something without letting it complete a sequence of actions. The syntax is like this:

Exit <whatever>

If you are in a subroutine, it is Exit Sub. If you are in a Do loop, it is Exit Do. In a For loop, it is Exit For. So now your routine becomes:

Start


Stand


Arms Up


If AtWall then



Arms Down



Sit



Exit routine


End If


Counter = 0

Do Until AtWall


Step(1)


Counter = Counter + 1

Loop

Turn(Right, 180)

Step(Counter)

Turn(Right, 180)

Arms Down

Sit

End

Now you have an efficient piece of code, and creating it was relatively painless!

Points to Remember

· There is more than one way to program anything. Some may be more efficient than others, but if it works, it is right.

· Most languages have the same control structures we have discussed here. Once you know the logic behind programming, learning any new language is just a matter of learning a different syntax.

Lesson 3: Programming Theory

What You Will Learn

After completing this lesson, you will be able to:

· Differentiate between when it is appropriate to program versus when it is appropriate to use alternative methods.

· List four programming methods and name a Microsoft product associated with each method.

Related Topics Covered in this Lesson

· Pseudocode

· Structured Programming

· Event-Driven Programming

· Object-Oriented Programming

Overview - Programming Theory

In previous lessons we introduced Programming Logic. During this lesson we will build upon those concepts by introducing the theory of programming. Afterwards, you will be able to answer questions such as: What is programming and when should I program? Additionally, this lesson will discuss various types of programming methods.

Why Programming?

Let us begin by making a pretty bold statement: programming is not the cure all for every computing problem. Programming can extend an application tremendously, or it can consume hours of effort with negligible results.

When to Program

There are certain times when it is beneficial, or perhaps even necessary, to use programming code. The following list suggests when coding would be appropriate:

· Expanding the limits of the application's functionality. Often you need to perform a specialized task (or series of specialized tasks.) An example might be the collection of data, automating the collecting, converting from one form to another, and then generating reports.

· Increasing speed. Often code can execute much faster than an equivalent macro or batch function.

· Creating special functionality. Many of the features in sophisticated applications are only available through code, that is, there is no user interface equivalent.

· Creating your own function. Perhaps you are in a banking/engineering industry and use a special financial/mathematical function that does not ship with the application you have purchased, so you must create it yourself.

· Providing advanced user-defined error trapping. Most applications that provide a macro or batch language have very little, if any, error-trapping capabilities. Most of your error trapping must be done through code.

· Passing information from one object to another. You have heard this before, just in a different buzz word – OLE Automation. OLE Automation is all done through code.

· Performing system-level actions. Low-level calls to the operating system typically must be done through code, rarely, if ever, are these types of methods exposed through a user interface or macro language.

When Not to Program

There are also times when there is no need to program. The following list describes when coding would be inappropriate:

· The application already has the feature. This may seem obvious but there are those who seek to reinvent the wheel. Keep in mind that the code supporting existing functionality (such as built-in code behind a toolbar button) has been optimized for the best possible performance by the application’s developers.

· There is a macro or scripting language that has the same functionality. If an application has a macro/scripting language, often a lot of the work can be done there. As long as you are performing routine functions and have no need for error checking macros/scripts work just fine. Note there may be some performance gain from moving to code.

Pseudocode Defined

Pseudocode is an English-like language used for teaching the concepts of programming. Pseudocode is not usually directly executable by a programming language. Syntactically, you may have to make some minor adjustments for any given specific programming language. For this module pseudocode will be sufficient for all exercises.

Compiled vs. Interpreted Programming Languages

Traditional compiled languages, such as C, compile human-readable source code into machine-readable, and much faster, object code. These object programs then need to be linked into an executable file to be used. Syntax errors are not generally located until the code is completely compiled, although parsing compilers are an exception to this rule. Syntax errors are discussed in further detail in Lesson Three of this module.

Traditional interpreted languages, such as QBasic, use interpreters that read each line of code and translate it into computer instructions as you write it. An advantage of this method is that an interpreter can test your code as you write it. In some cases this line-by-line interpretation can be slow.

Microsoft® Visual Basic® incorporates elements of both compiled and interpreted languages. Visual Basic does interpret each line of code for you as you write it, but Microsoft Office products perform this interpretation in the background, and do not exhibit any performance degradation because of this interpretation.

In addition to this interpretation, Microsoft Office products also compile your code into a combination of compiled and interpreted code known as p-code. This p-code runs much faster than interpreted code. The compilation takes place either when you first run the code, or when you compile from within your programming environment.

Programming Styles and Philosophy

As most programmers have observed, the larger a project is, the more complicated it becomes to write. Over the course of computing history, several different methods and concepts have arisen to make code more flexible and easier to develop. By studying some of these methods, it will be easier for you to understand customer needs, identify appropriate methods of programming, as well as create code that is easier to understand and maintain.

In this topic, we will address some of the more prevalent programming styles or methods and discuss how they apply to programming. As you will see, the various styles are not mutually exclusive. Frequently you will see a synergistic combination of styles.

Top-Down Programming

In top-down programming, programmers start with generic ideas and procedures, adding all the details, or bells and whistles, but only after the overall concept has been worked out. This approach helps programmers budget their time and prevents them from getting wrapped up in the minor details of their program before the basic or core code is written.

Various methods and work habits have been introduced to assist with the top-down style, the foremost being flow charting. Flow charts are a graphical design tool that allows the programmer to visualize the basic flow of their program. Flow charts contain the gist or overview of the application but rarely deal with details such as “the detail line of report x will be indented five spaces and printed in a 12-point Courier font with this specific layout.”

Structured Programming

As developers began using top-down programming, they had a tendency to patch, hack, and piece their programs together in a way that made applications difficult to read and even more difficult to maintain. These programs, which were often referred to as spaghetti code, earned their name because the program flow was often erratic and hard to trace. This presented problems for teams working on group projects and programmers hired to modify other programmers’ work. Structured programming was introduced to mitigate these dilemmas.

Structured programming is an approach that uses linear program flow and sub-procedures to promote readability and maintainability of code. Certain branching structures, especially Goto statements are discouraged.

Structured programs also endorse the use of One Entry, One Exit. This means that programmers are encouraged not to enter or leave subroutines in the middle of their code.

Although all Microsoft languages apply different aspects of structured programming, QuickBasic or Microsoft COBOL come the closest to being strictly structure oriented since they adhere to the concept of One Entry, One Exit.

Event-Driven Programming

As applications evolved programmers discovered that a good portion of time was spent developing code to trap user actions, such as a keystroke or mouse movement. As form-based applications, such as Microsoft Access or Microsoft Visual Basic, became prevalent other form-related events became necessary such as Form Open, Form Close, Form Resize, and so on.

The essence of event-driven programming is that you can assign specific procedures to one or more actions. So, if a user opens a form, a section of code related specifically to initializing the form or application runs at that time.

To some people, event-driven code seems random or unpredictable due to the fact that the user’s actions can occur in any order. Care should be taken to foresee all possible combinations of user actions and provide logical actions in response to them.

Some of the Microsoft languages and products that exemplify event-driven programming are Microsoft Visual Basic, Microsoft Visual Basic for Applications, and Microsoft Access.
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Knowledge Base article Q88164, “Introduction to Windows Programming for MS-DOS Programmers”

Object-Oriented Programming

Object-oriented programming (OOP) is geared towards reducing development time by making a larger base of reusable code available to programmers. With OOP, the focus lies upon objects or classes. One of the main ideas of object-oriented programming is that all of the data and procedures related to a particular object are kept together with the object itself. The creator of the original object provides attributes or properties and actions or methods that allow the programmer to manipulate the objects to their liking.

One example is having a calendar object that could be incorporated seamlessly into your program. While the programmer would be required to know what methods and properties are available for the calendar, they would be spared the overhead of creating the code that exposed those methods and properties. By setting the calendar properties, attributes like calendar color or font size could be controlled by code. By using the calendar methods, the programmer could cause their code to print the calendar or schedule appointments.

The biggest key to OOP is knowing what objects exist and what methods, properties, and events they possess.

Applications that apply various forms of OOP are Microsoft Visual C++® and Microsoft Visual FoxPro®.

Other Programming Methods

There are additional standards and methods that are geared towards maintaining programs, all of them designed specifically to make it easier to share code between programmers. These methods go beyond the scope of this course but were mentioned above to provide a frame of reference. It also makes the code easier to maintain or modify over a period of time.

[image: image6.png]



See the article “Visual Basic Programming Conventions from Microsoft Consulting Services,” available on the January 1996 edition of Microsoft Developers Network for other ideas on programming conventions. Although the article directly addresses Visual Basic, the concepts discussed can be applied universally.

Exercises

1. Name two reasons when you would need to use a programming language. Name one reason when you would not need to use a programming language.

2. List each of the three types of programming languages and a Microsoft product associated with each type.

Challenge Yourself!

1. Define pseudocode.
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Lesson 4:  Elements of a Procedure

What You Will Learn

After completing this lesson, you will be able to:

· Describe the purpose of a procedure and give three reasons why they are used.

· Describe how data types can impact a program’s use of data and list some of the common data types.

· Explain how a constant differs from a variable and describe situations appropriate for the use of each.

· Define the concept of expressions and list the three categories of operators with examples for each category.

· Build simple expressions using operators, variables, and functions.

· Explain the difference between a Sub and a Function procedure.

· Explain how and why arguments are used with procedures.

Related Topics Covered in this Lesson

· Evolution of Procedures

· Data Type Conversion

· Sub Procedures

· Function Procedures

· Property Procedures

· Returning Values from Functions

Introduction

This course assumes the completion of the Programming Fundamentals module.  Each of the Exercises used in this course is written in a generic form.  Instructions such as Create a new module or Execute this function using the Debug window involve different steps, depending upon which implementation and interface for Microsoft® Visual Basic® is being discussed.  Appendix A provides the necessary instructions and background material for the Visual Basic for Applications interfaces in the following products:  Microsoft Access, Microsoft Excel, Microsoft Project, and Microsoft Visual Basic (also referred to as VB).  Please refer to Appendix A and understand the interface you intend to use prior to beginning this course.

Overview - Elements of a Procedure

This lesson will introduce the syntax for the elements of a procedure that are specific to Visual Basic for Applications (also referred to as VBA). 

Procedure Structure

Procedures in Visual Basic for Applications start with either the keyword sub or function and end with end sub or end function respectively.

Sub TestSub()

End Sub
Function Test()

End Function
Function procedures are distinct from Sub procedures in that they can return a value to the procedure that called it.

Function Area()


Area = 3.14 * 3 ^ 2

End Function
Result:

28.26

[image: image7.wmf]
Because function procedures can return values, some Microsoft products can use functions outside the VBA environment. Microsoft Excel can call function procedures from worksheet formulas.  Microsoft Access can call function procedures from Forms and Queries.

A more in depth discussion of Procedures is covered at the end of this lesson.

Understanding Data Types

One of the fundamental concepts in any programming course is the idea of data types.  Data types are defined boundaries for values.  In the simplest form if a value is going to be defined as a number then the program must not let users enter text for that value.  If this happens an error occurs.

There are various types of data and each programming language shares some basic types and has the ability to define its own specialized types. Most high-level programming languages also allow the user to create their own data types.  The following section describes some general data types found in most programming languages.

Fundamental Data Types

Fundamental data types can be broken down into four basic categories.  Each category may contain several fundamental data types. The basic categories and their fundamental data types include the following:

TEXT

· String - Store text strings of virtually any size

NUMBERS

· Integer and Long Integer  - Store whole numbers, without fractional parts

· Single and Double - Store floating point numbers (numbers with fractional or decimal parts)

· Currency - Hold monetary values with maximum reliability and no rounding errors

TIME

· Date - Hold dates and times

BINARY

· Boolean - Store values with one of two responses:  True or False, Yes or No

The Tupperware Container Analogy

One way of looking at the various data types is to think of Tupperware containers in a kitchen.  Some containers hold liquids, and are airtight.  Others hold solids and are perforated.  Think of the difference between a pie container versus the cake container.  Some foodstuffs need to breathe, like a head of lettuce, in this case you might use a Tupperware container that resembles a colander.

Data type characteristics are similar to Tupperware.  If you have a refrigerator and you have some leftover barbecue chicken you would not put each piece of chicken in a separate cake container.  This would fill up your refrigerator too fast and waste a lot of space.  Computers have memory restrictions much like your refrigerator has spatial restrictions.  So, you should choose the appropriate sized container for optimum use of space.

If you know that you will be using whole numbers ranging from -3 to 120, then an integer data type would be appropriate.  Sure, you could choose a double-precision data type but that would be like putting the single piece of chicken in the big cake Tupperware container.

String Data Type

The String data type is used to store text strings of virtually any size. 

If you have a variable that will always contain a string and never a numeric value, you can declare it to be of the String data type.  By default, a string variable is a variable-length string; the string grows or shrinks in length as you assign new data to it.

Fixed-Length String Syntax

If you prefer, you can also declare Strings that have a fixed length.  With fixed-length Strings you can set a maximum amount of characters for a value.  If you know that a value is only going to have, at a maximum of50 characters, you can define a String data type as only having 50 characters.

Examples of the String Data Type

The following values would all be Strings:

· “abc”

· “12a”

· “111-OEM-2222”

· “This is a string value.”

Integer

The Integer data type is used to store small whole number values.  The approximate range of an integer variable is ± 32K.  If you know you are only going to use small whole numbers in a value it is best to declare that value as an Integer.

Examples of the Integer Data Type

The following values would all be Integers:

· 123

· 30,999

· 0

· -245

Long Integer

The Long Integer data type is used to store large whole number values.  The approximate range of a long integer variable is ±2.15 billion.  If you need whole numbers larger than 32K you would declare that value as a Long Integer.

Examples of the Long Integer Data Type

The following values would all be Long Integers:

· 504,678,934

· 33,789

· 4

· -2048

· -2,009,555,875
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Long Integers also encompass the range of regular integers, that is, they can also have values between ±32K.

Single

The Single data type is used to store floating point numbers with limited precision.  The approximate range of a single variable is ±3.4E38, with only seven-digit decimal accuracy.

Examples of the Single Data Type

The following values would all be Singles:

· 100,00,000,000,000.987654

· 1.234567

· -0.0000001

· -123,456,789,123,456,789,123,456,789.0000009

Double

The Double data type is used to hold floating point numbers with greater precision than a single.  Double data types values range is approximately ±1.8E308, with 15-digit decimal accuracy.

Examples of the Double Data Type

The following values would all be Doubles:

· 123,456,789,012,345,678,901,234,567,890,123,456,789,012.123456789012345

· 4.888888888888

· -345.987654321

· -111,111,111,111,111,111,111,111,111,111,111,111,111,111,111,111,111.22

[image: image9.wmf]
Much like Long Integers encompass the range of Integers, Doubles encompass (include) the range of Singles.

Currency

The Currency data type stores monetary floating-point numbers with no rounding error. Currency values are accurate to 15 digits to the left of the decimal point and four digits to the right.

Examples of the Currency Data Type

The following values would all be Currencies:

· 123,456,789,012,345.1234

· 1.2345

· -0.0001

· -999,999,999,999,999.9999

Date

The Date data type holds Date/Time values.  Normally, these values are stored as serial numbers with the digits to the left of the decimal representing the date, and the digits to the right of the decimal representing the time.

Examples of the Date Data Type

The following values would all be Dates:

· 08/22/68

· Saturday November 25, 1995

· 1:10 PM

· 35028.54968
[image: image10.wmf]
Note the formatting of the Date/Time value has no effect on the actual value (number) that is stored.

Boolean

The Boolean data type holds binary values (True/False, Yes/No, On/Off, -1/0).

Examples of the Boolean Data Type

Boolean values can be the following:

· -1

· 0

Numeric Data Types

If you know that a variable always stores whole numbers (for example, 12) rather than fractional numbers (3.57), declare the variable as either an Integer or Long Integer data type.  Operations with integers are faster and consume less memory than precision data types (i.e., Single and Double).  Integers or Long Integers are especially useful as loop counter variables.

If the variable contains a fraction, declare it as a Single, Double, or Currency variable.  The Currency data type supports up to four digits to the right of the decimal point, and 15 to the left; it is fast, accurate, and suitable for monetary calculations (there is no rounding error with a Currency data type).   Floating-point (single and double) numbers have much larger ranges than currency variables, but are subject to minute rounding errors.

Variant Data Type

Some programming languages have a catch-all data type, that adjusts itself to whatever the need of the value is.  These are known in the popular programming languages as variant data types.  The problem is that these are not the fastest data types and have a large overhead when it comes to storage and memory use.

By default, if you do not supply a data type, the variable is given the Variant data type.  The Variant data type can store many kinds of data.  Like a text box control on a form, or a cell in a spreadsheet, a variant is equally capable of storing numbers, strings of text, dates and times, or the Null value.

When you declare a variable to be variant, you gain the ability to automatically convert between different data types.  Variables are discussed in the next section of this lesson.

Variant Trade-Offs

Although you can perform operations on Variant variables without much concern for what kind of data they actually contain, there are some trade-offs when using variants.

· PRO  Variants are flexible.  You do not need to know what data type is stored in a variant variable.  VBA provides automatic conversions where necessary and where possible.  Variants are the only data type that can hold Null values.  Variants can hold binary data (OLE automation objects, BLOBs).

· CON  Variants tend to be slower than variables declared to be one of the fundamental data types.  Variants consume more memory to store the same data.

You can usually create more concise, faster code by using other data types where appropriate.

User-Defined Data Types

Sometimes the programming language does not have the data types that the programmer desires.  Most of the time this can be solved through user-defined data types.  As the name alludes to, user-defined data types allow the programmer to create their own data types. User-defined data types can contain one or more elements of any data type, array, or a previously defined user-defined type.

[image: image11.png]



For more information on creating user-defined data types please see the VBA Fundamentals Unit of the Microsoft Office Programming Fundamentals Curriculum.
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 Try This:  Guess the Data Types (for each of the values below choose the smallest data type the value can be.)
1. 0 or -1

2. -0.1

3. -4

4. 123.456789012

5. 1/1/90

6. 123456.789a

7. 35,000

· What are the benefits/drawbacks of choosing the smallest data types for your programs?

Data Type Summary

Below is a summary of the data types that Microsoft Visual Basic for Application supports with their shortcut notation for variable declaration if the data type supports it.  Shortcut notation is consistent with previous versions of Visual Basic for Windows.  However, new data types do not have Shortcut codes.

Data type 
Storage size
Range
Shortcut

Byte
1 byte
0 to 255
n/a

Long

(long integer)
4 bytes
-2,147,483,648 to 2,147,483,647.
&

Boolean
2 bytes
True or False
n/a

Integer
2 bytes
-32,768 to 32,767
%

Single

(single-precision floating-point)
4 bytes
-3.402823E38 to -1.401298E-45 for negative values; 1.401298E-45 to 3.402823E38 for positive values
!

Double

(double-precision floating-point)


8 bytes
-1.79769313486232E308 to -4.94065645841247E-324 for negative values; 4.94065645841247E-324 to 1.79769313486232E308 for positive values
#

Currency

(scaled integer)
8 bytes
-922,337,203,685,477.5808 to 922,337,203,685,477.5807.
@

Date


8 bytes
January 1, 100 to December 31, 9999. (Including time)
n/a

Object

4 bytes
Any Object reference
n/a

String

(variable-length)
10 bytes + string length

0 to approximately 2 billion (approximately 65,400 for Microsoft Windows® version 3.1 and earlier)
$

String

(fixed-length)
Length of string
1 to approximately 65,400
$

Variant

(with numbers)
16 bytes

Any numeric value up to the range of a Double
n/a

Variant

(with characters)
22 bytes + string length
Same range as for variable-length String
n/a

User-defined 

(using Type)

Number required by elements
The range of each element is the same as the range of its data type
n/a

Table 1 - Data Type Summary
Working with Variables and Constants

Often when working with a programming language, you want to store values temporarily while performing calculations.  For example, you may want to calculate several values, compare them, and perform different operations on them, depending upon the results of the comparison.  You want to retain the values so that you can compare them, but because you need to store them only while your code is running, you do not want to store them in a file on disk, or in a table in a database.

Variables

All modern programming languages use variables to store values.  Variables are like fields in a database, or cells on a spreadsheet, except that they exist within code, rather than in a table or a spreadsheet.  Like a field, a variable has a name (the word you use to refer to the value the variable contains) and a data type (which determines the kind of data the variable can store).

In the Microsoft Basic programming languages, variables are created (or declared) using a Dim statement, this is known as dimensioning a variable.  Variables declared with the Dim statement are said to be explicitly-declared variables.  You can also implicitly declare variables, without using a Dim statement; however, this practice is not recommended, because of speed degradation and poor programming practices.

In many programming languages there are settings within the language to force an explicit declaration.  That is you must declare (or Dim) the variable before using it.  

Explicitly declared variables are dimensioned at design time using one of the following statements: 

· Dim

· Public

· Private

· Static

· Const 

Each statement designates a lifetime and scope that will be discussed later in this lesson. 

Simple Examples of Declaring Variables

The following examples use the keyword Dim to declare a variable.

Dim strMyText as String

Dim dblBigPrecision as Double

Dim varMyVar
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Dimensioning a variable without a data type automatically makes it a Variant data type.

Example - Explicit Declaration

To dimension a variable, use a keyword, the variable name, the word as, followed by a data type.  For example, to dim the variable X as an integer:

Sub Test()


Dim X As Integer

X = 1 + 1

End Sub
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The String data type has two forms.  By default, dimensioning a variable as String creates a string of variable-length.  The string grows or shrinks as you assign new data to it. By using the syntax String * size,  you can limit Strings to fixed sizes.  For example, to create String that is 76 characters long:

Dim CustomerName As String * 76

Note, however, that variables assigned fewer than 50 characters are padded with enough trailing spaces to total 50 characters.

A variable is implicitly declared if it is used but not formally declared using one of the five statements listed above.  Implicitly declared variables are created and manipulated as the Variant data type.  

· Implicitly declared variables always use the Variant data type regardless of the size of the data it stores.  At least 16 bytes of memory are always allocated, more for strings.

· Implicit variables are always local in scope and cannot be made available to other procedures.

· Built-in error checking is lost as well since the variant converts the value as needed.

Because of these limitations, it is recommended that you always explicitly declare variables.

Example - Implicit Declaration

Function Test()


X = 1 + 1

End Function

Option Explicit

You can force VBA to generate an error message if you do not explicitly declare all variables by placing the following in the Declaration section of the module. The Declaration section of a module is that area at the top of a module before any procedure is named. 

Option Explicit

Sub MyProcedure()

End Sub

Any code outside a procedure is also referred to as module-level code.
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Option Explicit can help programmers catch spelling errors when entering code. Since each misspelling is  considered a new variable, VBA will generate an error message.  Some programming environments have an options setting to force Explicit declaration.
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 Try This: Implicit vs. Explicit

1. Open the module saved in the previous Try This.

2. Create a Declaration section at the top of your module by clicking at the beginning of the first line of code and pressing the enter key twice.

3. Place your cursor at on the first blank line in the Declaration section and enter the following:

Option Explicit

4. Enter the following into the module below the Declaration section:

Function testimp()

X = X + 1

End Function

5. Enter the following in the Immediate pane:

?testimp()

You should receive an error message.

What does the error message say?

6. Now add the following line to the function as the second line:

Dim X as integer

7. Execute the function from the Immediate pane again.

Does the error message come up?

8. Remove the Dim line from the function and the Option Explicit from the Declaration section of the module.

9. Try executing the function from the Immediate pane.

Does an error message appear?  Why not?

10. Save this module for the next Try This exercise.

· Option Explicit forces you to declare all variables.

A More Complex Example

In the following procedure, dtmAny, dtmYear, and dtmMonth are variables with the Date data type.

Function DueDate(dtmAny As Date) as Date

    ‘Returns first day of month for dtmAny
    Dim dtmYear as Date, dtmMonth as Date

    ‘Gets the year of dtmAny

    dtmYear = Year(dtmAny)

    ‘Gets the month of dtmAny

    dtmMonth = Month(dtmAny) + 1

    ‘DateSerial converts numbers to Dates

    DueDate = DateSerial(dtmYear, dtmMonth, 1)
End Function

Constants

Your code might contain unchanging values which appear over and over.  Or your code might depend upon certain numbers that are difficult to remember – numbers that, in and of themselves, have no obvious meaning.

In these cases, you can greatly improve the readability of your code – and make it easier to maintain – by using constants.  A constant is a meaningful name that takes the place of a number or string that does not change.  In other words, it is a value that remains constant.  You cannot modify a constant, nor can you assign a new value to it as you can to a variable.  Most programming languages support the use of constants.

Constants can be one of two types:

· Intrinsic or system-defined constants are provided by applications.  VBA provides a large number of intrinsic constants, as do Microsoft Access, Microsoft Excel, and other applications that work with VBA.

· Symbolic or user-defined constants are declared by the programmer, using the Const statement.

In the Microsoft Basic languages, constants are declared using the reserved word Const, followed by the variable name, an equal sign, and then the value. The syntax is shown below:

Const <constant name> = <value>

Examples

Const statements can represent mathematical or date/time quantities.



Const conPI = 3.14159265358979



Const conRELEASEDATE = #9/30/95#
Const statements can represent String values.

    Const conVERSION = “Version 7.0 for Windows 95”

    Const conCODENAME = “Pioneer”

Scope and Lifetime

Variables have two other important aspects:

· Scope

· Lifetime

These are used to determine when and how long a procedure can work with a variable or constant.

Scope

The scope of a variable defines when procedures can access or reference that variable. There are three different levels of scope in VBA:

· Local or Procedure   The variable is available only within the procedure. Variables declared with the Dim or Static statements inside of the procedure have this scope.

· Private   The variable is available to all procedures within the module in which the variable is declared. These variables are declared in the module's Declaration section using the Dim or Private statements.

· Public   Available to all procedures in all modules. These variables are declared in the Declaration section of a module using the statement Public. 
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Help Topic: Understanding Scope
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 Try This: Local scope
1. Enter the following two procedures into the module saved during the previous Try This:

Sub FirstScope()

Dim X as integer

X= X + 2

Debug.Print X

End Sub

Sub SecondScope()

Dim X as integer

X  = X + 5

Debug.Print X

End Sub

2. Execute these procedures through the Immediate pane.

Do the procedures affect each other’s variable named X?

3. Save this module.

· Variables declared locally lose their value once the sub or function has ended.
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 Try This:  Module Scope
1. Add the following line to the Declaration section of the module saved in the previous Try This:

Private X As Integer

2. In the Firstscope function, add an apostrophe (') to the beginning of the Dim line:

'Dim X As integer

The apostrophe is the comment character, and causes VBA to ignore anything to the right of the character.

3. Execute FirstScope and SecondScope functions from the Immediate pane.

Is SecondScope affected the value of x in Firstscope?  Why?

· Local scope takes precedence over Private or Public scope.
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 Try This:  Public or Global Scope
1. Create a new module, and name it TestScope.   Enter the following procedure:

Sub TestPublic()

X = X + 100

Debug.Print X

End Sub

2. Execute this procedure from the Immediate pane.

Does this function work?  

Does this procedure reference the X variable from the first module?

3. Change the declaration in the first module from Private to Public. Execute TestPublic again.

Is the resulting value of X different now?  Why?

· Use caution when declaring variables as Public.

Lifetime

Lifetime of a variable determines how long the values are preserved. 

· The values in Private and Public variables are preserved as long as the application is open or until you reinitialize the variable. 

· Local variables only hold their values while the procedure in which they are declared is executing.  

· The values in local variables can be preserved by declaring them with the Static statement. This changes the variable’s lifetime to be as long as the application is open or until the code is reinitialized.

Sub MyProcedure()

Static x As Integer

End Sub
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 Try This:  Lifetime
1. Enter the following Sub procedure into the module saved in the previous Try This exercise:

Sub LifeTest()

Dim x As Integer

X = X +1

debug.print X

End Sub

2. In the Debug window enter the following:

LifeTest

What is the value of X?

3. Execute the procedure a second time.

Does the value of X change?

4. Replace the keyword Dim  with the keyword  Static.

5. Execute the procedure from the Debug window.

What is the value of X?

6. Execute the procedure a second time.

Why does X now have a larger value?

7. Save the module.

· Unless preceded by the keyword Static, local variables hold their value only during the execution of the procedure.  Variables created in the Declarations section maintain their value as long as the module is open, or until they are reinitialized by code.

After you have defined constants, you can place them in your code to make it more readable.  You use the constant wherever you would have used the value you assigned to the constant.

Example

Code without constants

Function CalcArea()

Dim Area As Double

Dim Radius As Double

Radius = 5

Area = 3.14159 * Radius ^ 2

End Function

Below is a procedure that performs the same exact calculation but uses a constant for the value of PI.

Function CalcArea2()

Const PI = 3.14159

Dim Area As Double

Dim Radius As Double

Radius = 5

Area = PI * Radius ^ 2

End Function
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While most programming languages do not require this methodology, it is a tradition among programmers (i.e. good programming practices) to capitalize all constant variables.  This makes for more readable code.

Arrays

Arrays are another type of variable, but instead of storing a single value, arrays can store many values. By declaring a variable as an array, it is possible to refer to a series of variables by the same name and use an index to distinguish each one.

Arrays of Fixed Number of Elements

An array is defined by following the variable or constant name with a set parenthesis with the number of elements desired in the parenthesis. The following declaration creates a 100-element array of integers:

Dim MyArray(100) As Integer

MyArray(0) = 1

MyArray(99) = 100

Arrays in VBA use a zero base, by default. This means the above array can contain 101 values, starting with element 0.  Declaring the array of the proper data type is even more important than with regular variables because the number of bytes used per variable is multiplied by the number of elements. The first example reserves 200 bytes of memory. If this was defined as variant it would require 1600 bytes of memory.
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It is possible to change the lower bound of arrays.  By entering Option Base 1 in the declarations section of a module, the element will be counted starting at 1 rather than 0.  If used, the Option Base statement must appear in a module before any statements that declare variables or define constants.

There are three ways to declare a fixed element array:

· Public array- Use the Public statement in a module’s Declaration section.

· Private array- Use either the Dim or Private statement in a module’s Declaration section.

· Local- The Static Statement must be used in a procedure for a fixed element array.

Multidimensional Arrays

Arrays can be of multiple dimensions, meaning that you could store 10 people’s first names and last names in the same array.  The declaration is similar to the single dimensional array except you use a comma between each dimension of the array.

Function Test()


Static MyArray(2,10) As String


MyArray(0,1) = “Connie”


MyArray(1,1)=”Waite”


Debug.Print MyArray(0,1), MyArray(1,1)

End Function

The above example prints:

Connie
Waite
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 Try This:  Multidimensional array
1. Enter the following procedure into the module saved in the previous Try This.

Sub Test()

 Static MyArray(2, 10) As String

 Dim Person As Integer

 For Person = 0 To 9

   
MyArray(0, Person) = InputBox("Enter First Name")

   
MyArray(1, Person) = InputBox("Enter Last Name")

 Next Person

 For Person = 0 To 9

   Debug.Print Person, MyArray(0, Person), MyArray(1, Person)

 Next Person

End Sub

· Remember that unless Option Base 1 is used, array elements are numbered starting at 0.

Dynamic Arrays

Occasionally you may not know the specific size of an array, or you may need to change the size of the array at run-time. VBA allows you to create a dynamic array and change the number of elements at run-time. You use the ReDim Statement to change the number of elements in an array. For example:

Dim MyArray() As Integer

ReDim MyArray(10)

The first line creates the array but does not set a size. The next line allocates elements for the array. If you resize the array to a size smaller than it was sized earlier you lose any data in the dropped elements. ReDim should not be used without first explicitly declaring the variable.
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See “Using Arrays in Visual Basic” for more examples of Arrays. 

Using Expressions

An expression is any combination of operators, constants, literal values, functions and names of fields, controls and properties that evaluate to a single value.  Expressions can be used in place of values required by functions, subroutines or variable assignments.  Functions and subroutines will be discussed in depth later in this lesson.

Sample Expressions

· 5

· “Hello”

· 1+2+3*4

· MyControl & (MyCustomFunction()^2)

The placement of operators in expressions is vital and can affect the value returned by the expression, as demonstrated in the next section.

Working with Operators

One of the most important components of an expression is its operators.  There are several types of operators in each programming language.  Some are very common and you will recognize them right away, others are quite obscure.

Operators fall into four basic groups.  In this next section we will discuss the operators that are common to the applications in the Microsoft Office suite:

· Arithmetic

· Comparison

· Logical

· Concatenation

Arithmetic Operators

Arithmetic operators, as their name implies, perform mathematical calculations.  Common programming arithmetic operators are listed in the table below:

Operator
Description
Example
Result

^
Used to raise a number to the power of an exponent.
2^3

3^3^3
8

19683

*
Used to multiply two numbers.
2*2

459.35*3334.90
4

153836.315

/
Used to divide two numbers and return a floating-point result.
10/4

10/3
2.5

3.33333

\
Used to divide two numbers and return an integer result. 
11\4

9\3
2

3

Mod
Used to divide two numbers and return only the remainder. 
10 Mod 5

10 Mod 3
0

1

+
Used to sum two numbers.
2+2

4257.04+98112
4

102369.04

-
Used to find the difference between two numbers or to indicate the negative value of a numeric expression.
4 - 2

459.35 - 334.90
2

124.45

Table 2- Arithmetic Operators
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 Try This:  Show Integer, Mod and Standard division.
1. Enter the following expressions into the Immediate window:

?14/3

?14\3

?14 Mod 3

What is different about the first two?

· What result does the third expression return?

Comparison Operators

Comparison operators are used to perform comparisons.  There are two types of comparison operators – equality and greater than/less than.  The table below shows the six combinations of comparison operators.

Operator
Description
True if
False if

<
Less than
expression1 < expression2
expression1 >= expression2

<=
Less than or equal to
expression1 <= expression2
expression1 > expression2

>
Greater than
expression1 > expression2
expression1 <= expression2

>=
Greater than or equal to
expression1 >= expression2
expression1 < expression2

=
Equal to
expression1 = expression2
expression1 <> expression2

<>
Not equal to
expression1 <> expression2
expression1 = expression2

Table 3- Comparison Operators
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Comparison operators are sometimes referred to as Relational operators.

In addition, the following Logical Operators are specific to Visual Basic for Applications:

Operator
Purpose
More Information

Like
Compares two strings
If wildcards are used, does pattern matching

Is
Compares two Object variables
If variables reference the same object, returns True

Table 4 - Relational Operators
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 Try This: Use Like and wildcards to demonstrate pattern matching
1. Enter the following expressions into the Immediate window.

?”Frederick” Like “Fred”

?”Fred” Like “Frederick”

?”Frederick” Like “Fred*”

?”Fred*” Like “Frederick”

Why does the third expression return True?

· Why does the last expression return False?

Logical Operators

Logical operators perform logic operations on expressions.  The most common logical operators for the Microsoft Office suite are shown in the table below.  

For all of the examples below use the following for the variables: A = 10: B = 8: C = 6: D = Null

Operator
Description
Example
Result

And
Used to perform a logical conjunction on two expressions.
A > B And B > C

B > A And B > C

A > B And B > D
True

False

Null

Eqv
Used to perform a logical equivalence on two expressions. 
A > B Eqv B > C

B > A Eqv B > C

A > B Eqv B > D
True

False

Null

Imp 
Used to perform a logical implication on two expressions. 
A > B Imp B > C

A > B Imp C > B

B > A Imp C > B

B > A Imp C > D

C > D Imp B > A
True

False

True

True

Null

Not
Used to perform logical negation on an expression.
Not(A > B)

Not(B > A)

Not(C > D)
False

True

Null

Or
Used to perform a logical disjunction on two expressions.
A > B Or B > C

B > A Or B > C

A > B Or B > D

B > D Or B > A
True

True

True

Null

Xor 
Used to perform a logical exclusion on two expressions. 
A > B Xor B > C

B > A Xor B > C

B > A Xor C > B

B > D Xor A > B
False

True

False

Null

Table 5 - Logical Operators
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 Try This:  Boolean logic
1. Enter the following expressions into the Immediate window.

?True And False

?True Or False

?Not True

?False Eqv False

· Why does the last statement return True?

Concatenation Operators

Concatenation operators are used to combine strings.  There are two basic concatenation operators: & and +.  Both perform the concatenation of strings and numerics.  The table below shows examples of each:

Operator
Description
Example
Result

&
Concatenates
“Hello” & “World”

“Check” & 123 & “ Check”

“Check”  & NULL & “Check”
“Hello World”

“Check 123 Check”

“Check  Check”

+
Concatenates
“Hello” + “ World”

“Check” + “123” + “Check”

“Check” + NULL + “Check”
“Hello World”

“Check 123 Check”

Null

Table 6- Concatenation Operators
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Notice the spaces between the strings and the concatenation operators.  The spaces are necessary for VBA to concatenate correctly.  If the spaces are left out,, you may receive error messages.

Order of Operations

When several operations occur in an expression, each part is evaluated and resolved in a predetermined order.  That order is known as operator precedence.  Parentheses can be used to override the order of precedence and force some parts of an expression to be evaluated before others.  Operations within parentheses are always performed before those outside.  Within parentheses, however, normal operator precedence is maintained.

When expressions contain operators from more than one category, arithmetic operators are evaluated first, comparison operators are evaluated next, and logical operators are evaluated last.  Comparison operators all have equal precedence; that is, they are evaluated in the left-to-right order in which they appear.  Arithmetic and logical operators are evaluated in the following order of precedence:

Arithmetic
Comparison
Logical

Exponentiation (^)
Equality (=)
Not

Negation (-)'
Inequality (<>)
And

Multiplication and division (*,/)
Less than (<)
Or

Integer division (\)
Greater than (>)
Xor

Modulo arithmetic (Mod)
Less than or Equal to (<=)
Eqv

Addition and subtraction (+,-)
Greater than or Equal to (>=)
Imp

String concatenation (&)
Like


Table 7- Order of Operation

When multiplication and division occur together in an expression, each operation is evaluated as it occurs from left to right.  Likewise, when addition and subtraction occur together in an expression, each operation is evaluated in order of appearance from left to right.
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The String Concatenation operator (&) is not an Arithmetic operator, but in precedence it does fall after all Arithmetic operators and before all Comparison operators.

Constructing Basic Procedures

Code is written in units called procedures. A procedure contains a series of statements that perform operations or calculate values.

Typically, there are two kinds of procedures:

· Function procedures

· Sub procedures

<Procedure Type> <Procedure Name>(<optional parameters>)
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End <Procedure Type>

A Simple Code Example

The following code generates a Windows-style message box with the words Hello World as text in the middle of the message box and an OK button to close the message box.

Sub Hello()
    MsgBox “Hello World”

End Sub
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Figure 11 - Resulting Message Box of the Above Procedure

Function Procedures

If you discover that you are repeatedly using the same expression in various places in your application, you might want to write a custom function that calculates that expression, and then use the function in place of the expression.  For example, suppose that you often need to calculate the date of the first day of the next month (perhaps this is the date that payment is due, or that shipments go out).  You can calculate this date with the following expression:

= DateSerial(Year(Now), Month(Now) + 1, 1)

However, this complicated expression is easy to mistype.  Instead of typing this expression, you could substitute a custom Function procedure that performs this calculation.  Writing a Function procedure to perform a calculation has several significant advantages over using the equivalent expression. 

Using a Function procedure, you can:

· Be sure that the calculation is performed the same way every time, without the risk of a typing mistake.

· Modify the calculation by changing it in only one place (the module in which the function is defined) rather than in every place the calculation is used.

· Perform complex operations, such as If ... Then logic or looping, which are difficult or impossible to handle in a simple expression.

· Handle errors in ways that you define.

· Include comments to document complicated expressions.

This expression could be rewritten as a function:

Function FirstOfNextMonth()


FirstOfNextMonth = DateSerial(Year(Now), Month(Now) + 1, 1)

End Function

NOTE: In Microsoft Project, function procedures are only available to be called from subroutines or other functions.  Functions can not be called from a menu.

Functions Return Values

Functions have two distinguishing characteristics.  

· Return value   A function always returns a value.   For example, the expression above calculates the first day of the next month.  If this expression is placed inside of a function, the function is said to place that calculation in the function’s return value.

· Parentheses   Functions always have parentheses in the function definition and function call.  The parentheses indicate to VBA that this procedure is a function, and they provide a way to pass information to your function when you call the function.

To specify the return value that should be returned by a function, you reference a special variable.  This variable is created automatically by VBA (you do not need to Dim this variable).  The variable is automatically named with the name of your function.  For example, the FirstOfNextMonth() function assigns the results of the calculation to the special variable named FirstOfNextMonth.  Because this variable has the same name as the function, this function will use the results of the calculation as its return value.

The value returned by a function has a data type.  When you define the function, you can declare the data type of the value the function returns.  If you do not explicitly declare the data type of the function, the function returns a variant.

Example

The FirstOfNextMonth() function is declared to return a Date value.

Function FirstOfNextMonth() As Date

    FirstOfNextMonth = DateSerial(Year(Now), Month(Now) + 1, 1)

End Function

Sub Procedures

Sub procedures, much like Function procedures, execute lines of code to complete a task.  The only difference between Sub procedures and Function procedures is that Sub procedures do not return a value.

Sub procedures are declared in exactly the same fashion as Function procedures, with the exception that they use the key word Sub.
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Sub procedures do not return value, only Function procedures can return values.

A Simple Sub Procedure Example

This Sub procedure creates a Windows-style message box that displays the phrase Goodbye Cruel World! with an OK button.

Sub goodbye()
    MsgBox “Goodbye Cruel World!”

End Sub
Using Sub Procedures for Events

Sub procedures are most often used for event programming.  An example might be the Click method of a command button on a Microsoft Access form.  When the user presses or clicks the command button, the developer of the form wants some actions to take place.  More often than not, those actions do not need to return a value, thus this would be an ideal place for a Sub procedure.

Calling Sub Procedures from Other Procedures

Suppose you have the following two Sub procedures:

Sub CallingProc()

   Debug.Print “Hello”

   CalledProc

End Sub

Sub CalledProc()

   Debug.Print “World”

End Sub

If you ran the CallingProc procedure, two lines of text would be printed in the Debug environment (more on the Debug environment in later modules).  The first line would display Hello and the second line would display World.  If you ran the CalledProc procedure, only the word World would appear.

Notice how the first procedure calls the second procedure.  It simply lists the name of the Sub procedure without the reserve word Sub or the closing set of parenthesis.
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When calling a Sub procedure from another procedure, either a Function or a Sub, you do not use the set of parenthesis after the procedure name.

Using Arguments in Procedures

Arguments are constants, variables, or expressions that supply information to a procedure.  Sometimes procedures are not self sufficient, that is they need information from outside the procedure.  One of the ways to provide procedures with outside information is to pass in arguments.

Arguments are defined within the parenthesis of the first line of the procedure.  Arguments should be declared with data types.  If the programming language has a Variant data type then type casting is not mandatory but is still recommend for readability’s sake.

Syntax for Arguments

<Procedure Type> <Procedure Name> (<Argument1 [as data type]>, …<ArgumentN [as data type]>)

Argument Example

The following procedure accepts two Single data type values named height and base as arguments to calculate the area of a triangle.  The function performs the calculation and returns the double precision calculation to the expression that used the CalcTri custom function.

Function CalcTri(height As Single, base As Single)

    Dim area As Double

    area = height * base * 0.5

    CalcTri = area

End Function

 You can test this function by opening the Debug window and typing:

Print CalcTri(10,20)

and pressing the enter key.  If you have entered the function properly, you should receive the value 100 in the Debug window, immediately below your print statement.

Calling Procedures with Arguments

Function and Sub procedures require different syntax when they are called.  When functions return values they must have a variable set up and parameters are passed through the parenthetical part of the function name (see first example below.)  For Sub procedures, values are not returned, so just calling the Sub with comma-separated values for its arguments is sufficient (see second example below.)  Let us look at each of these cases individually with examples.

Calling a Function with Arguments

Suppose we have the following two functions:

Function FuncA(a As Integer, b As Integer)

    Dim x As Integer, y as integer, z as integer
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    y = a + 1

    z = b - 1

    x = FuncB(y, z)
    Debug.Print x

End Function

Function FuncB(i As Integer, j As Integer)

    FuncB = i + j

End Function

Notice in FuncA that a variable x must be defined to store the return value from called function FuncB and that the arguments are passed within parenthesis.  Also notice in FuncB you must state that the function name equals whatever you want to return.

Calling a Sub with Arguments

Now let us look at similar code but using Sub procedures:

Sub SubA(a As Integer, b As Integer)
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    Dim y As Integer, z as integer

    y = a + 1

    z = b - 1

    SubB y, z

End Sub

Sub SubB(i As Integer, j As Integer)

    Dim m As Integer

    m = i + j

    Debug.Print m

End Sub

The first thing you should notice is the way the arguments are passed to SubB from within SubA.  Since Sub procedures do not return values we do not have to declare a variable for SubB.  Second you should notice that in order for us to see the final result we must print the variable m from within SubB, we cannot return the calculation back to SubA for printing.

In either case both sets of procedures calculate the same results, they just do it in a slightly different matter.
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 Try This:  Calculating Values through Passed Arguments
1. Given the following code calculate the results given the parameters below.

Sub MySub(x As Integer, y As Integer, s As String)

    Dim z As Integer

    Dim i As Integer

    Dim j As Integer

    i = x * 2

    j = i + y

    z = MyFunc(j)

    Debug.Print z

    Debug.Print s

End Sub

Function MyFunc(a As Integer)

    MyFunc = a * 3

End Function

· What are the results of MySub 1, 1, “abc”?

· What are the results of calling MySub 2, 0, “XYZ”?

· What are the results of calling MySub 0, 2, “1”?

Named Arguments

When you call a Sub or Function procedure, you can supply arguments, in the order they appear in the procedure's definition, or you can supply named arguments without regard to position.

For example, the following Sub procedure takes three arguments.

Sub Args(FirstName As String, Age As Integer, Birth As Date)


Debug.Print FirstName, Age, Birth

End Sub

You can call this procedure by supplying its arguments in correct position, as in the next example.



Args "Mary", 26, #2-21-69#

Result:



Mary
26
2/21/69

Supplying named arguments produces the same results.



Args Age:=26, Birth:=#2/21/69#, FirstName:="Mary"

Result:



Mary
26
2/21/69

Note that when you supply a named argument, the argument names are followed by a colon (:) and the equal sign (=).
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 Try This:  Named arguments
1. Enter the following function into the Module window:

Function AddArgs(Arg1 as Integer, Arg2 as Integer)


AddArgs = Arg1 + Arg2

End Function

2. Enter in the Immediate window:

?AddArgs(3,5)

What value is returned?

3. Enter the following in the Immediate window:

?AddArgs(Arg2:=16, Arg1:=3)

What value is returned?

· Named arguments are not dependent on position and are useful when attempting to pass only one of several arguments.

ParamArray

Parameter arrays provide you with a way to pass a dynamic number of arguments to a function.

ParamArray Keyword

With ParamArray you can pass a dynamic amount of variables, such as those stored in an array, into a procedure. 

Only use ParamArray as the last argument in a procedure’s argument list. It indicates that the final argument is an optional array of Variant elements. You cannot use ParamArray with ByVal, ByRef, or Optional keywords.  These keywords will be discussed in a later lesson.

The following function takes two arguments. It takes LastName and number of hours per day for each employee. It uses the Ubound function to find how many elements are in the array. It then sums those elements and displays the result. Each employee may have a varying number of hours during a pay period.

Function UseParamArray(LastName As String, ParamArray Hours())

Dim I As Integer

Dim RunningSum As Double

For I = 0 To UBound(Hours)

    RunningSum = RunningSum + Hours(I)

Next I

Debug.Print "Total Hours for " & LastName & " = "  _



& RunningSum

End Function
[image: image37.wmf]
In the code above, the line-continuation character or the underscore “_” is used to extend a single line of code to more than one physical line.  There are two rules when using the line continuation character.  It must immediately follow a space and it cannot appear within a text string.
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For more information on ParamArray, see online Help.

Optional Arguments

When developing generic functions it may be necessary to have arguments passed to a function that are specific to a situation. Not all calls to this function requires all of the arguments. VBA adds this capability with the Optional keyword.

Optional arguments are preceded by the Optional keyword in the procedure definition. When you call a procedure with an optional argument, you can choose whether or not to specify the optional argument. 

· An optional argument must always be passed as a Variant. 

OK:

Function ReturnName(Fname as String, Optional Lname)

OK:

Function ReturnName(Fname as String, Optional Lname as Variant)

Not OK:

Function ReturnName(Fname as String, Optional Lname as String)

· Once the Optional keyword is used, all following arguments must also be defined as Optional.

OK:

Function ReturnName(Optional Fname, Optional Lname)

OK:

Function ReturnName(Fname, Optional Lname)

Not OK:

Function ReturnName(Optional Fname, Lname)

· The Optional keyword cannot be used for any argument if the ParamArray keyword is being used for any of the parameters.

OK:

Function ReturnName(Fname, Optional Lname)

Not OK:

Function ReturnName(Fname, Optional ParamArray Lname as String)

Not OK:
Function ReturnName(ParamArray Fname, Optional Lname as Variant)

Named arguments are especially useful when you are calling a procedure that has optional arguments. If you use named arguments, you do not need to include commas (,) to denote missing positional arguments. Using named arguments makes it easier to keep track of which arguments you have passed and which you have omitted.

IsMissing

The IsMissing function is used to determine if an argument was passed to the function. Used in an If..Then structure you can conditionally control what your code does. The following example adds the last name Doe if none is supplied to the function.

Function testoptl(FName As String, Optional LName As Variant) 

    If IsMissing(LName) Then

        testoptl = FName & " Doe"

    Else

        testoptl = FName & " " & LName

    End If

End Function
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 Try This:  Optional arguments
1. Modify the AddArgs function created in the previous Try This to look as follows:

Function AddArgs(Arg1 As Integer, Arg2 As Integer, Optional Arg3)


If IsMissing(Arg3) then



Arg3 = 1


End If

AddArgs = Arg1 + Arg2 + Arg3

End Function

2. Enter the following in the Immediate window.



?AddArgs(2,3)

What value is returned?

3. Now enter the following:

?AddARgs(2,3,6)

What value is returned now?

· Remember that Optional arguments require the Variant data type, and therefore require more memory than expressly declared argument variables.

Passing Arguments by Value

By default, all arguments are passed by reference to procedures.  When the variable is passed by reference, the procedure that is called actually takes control of the variable and changes the value the variable holds.  You can choose to pass only the value the variable holds, rather than the variable itself.  This way, a specific value can be passed to the procedure, but the argument variable still holds its original value. To do this, use the ByVal statement when declaring the argument.

Function Test(ByVal MyString As String)


Debug.Pring MyString

End Function
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 Try This:  Passing arguments by value
1. Enter the following two procedures in the Module window.

Sub TestByVal1()


Dim X As Integer


X = 3


TestByVal2 X


Debug.Print “X is “ & X

End Sub

Sub TestByVal2(Y As Integer)


Y = Y * 2


Debug.Print “Y is “ & Y

End Sub

2. Enter the following in the Immediate window.

TestByVal1

What gets printed in the Debug window?

3. Change the first line of TestByVal2 as follows:

Sub TestByVal2(ByVal Y As Integer)

4. Now execute TestByVal1 again.

What is different?

· Passing arguments by value preserves the variables original setting.

Exercises

1. How much space does it take to store a Currency value?  How many digits of precision does a Currency data type have?

2. Name the most likely data types for each of the following values:

· 123

· 123.456

· 123.4567890123

· 0 or -1 (only)

· 123456789012345.1234

· 1/1/96

· 123f567

· 123456

3. Name the four main types of operators.  Give an example of each.

4. Will the following functions execute properly or return an error?


Function Test (Arg1, Arg2, Optional Arg3 as Variant)


Function Test (Optional Arg1, Optional Arg2, Arg3)


Function Test (ParamArray Arg1, Optional Arg2)


Function Test (Arg1, ParamArray Arg2)


Function Test (Arg1, Arg2, Optional Arg3 as Integer)

Challenge Yourself!

1. Create a function that accepts two values and calculates the area of a rectangle.  (Hint: area=height*width)

Create a function with a student’s name as the first argument and multiple test scores as the second argument.  The function should return the student's average score.

Lesson 2: Control Structures

What You Will Learn 

After completing this lesson, you will be able to: 

· Demonstrate the use of Conditional statements, including the use of Logical operators, in conjunction with decision structures and block decision structures.

· List the three categories of looping structures and demonstrate their use through pseudo- code.

· Define the concept nested code and identify where nesting might be appropriate in expressions, decision structures, and looping structures.

Related Topics Covered in this Lesson 

· If..Then..Else

· Select Case

· For..Next

· Do..Loop

· Structure of Nested Code

Overview - Programming Flow and Control

In this lesson you will be introduced to the concepts of programming structures, both decision and looping.  Next, there is a more advanced discussion of nesting data structures within one another.

By the end of this lesson, you will be able to create simple If, Select, For, and Do loops.  

User Interaction

In addition to processing data stored in variables or found in the application environment, procedures need to be able to accept data or decisions interactively from the user of the program.  The object models for Microsoft applications allow for many creative ways to interact with a procedure.  These will be discussed in detail in later modules.  However, there are two built-in VBA functions that are used across application platforms.  They are MsgBox and InputBox.

MsgBox

MsgBox displays a message in a dialog box, waits for the user to click a button, and returns a value indicating which button the user clicked.

MsgBox(prompt[,buttons][,title][,helpfile,context])

The MsgBox function syntax has these named arguments:

Argument
Description

Prompt
String expression displayed as the message in the dialog box.  The maximum length of prompt is approximately 1024 characters, depending on the width of the characters used.  If prompt consists of more than one line, be sure to include a carriage return (character code 13) or carriage return line feed (character code 10) between each line.

Buttons
Numeric expression that is the sum of values specifying the number and type of buttons to display, the icon style to use, the identity of the default button, and the modality.  If omitted, the default value for buttons is 0.  For more information, please see Help in your application.

Title

String expression displayed in the Title bar of the dialog box.  If you omit title, the program title is placed in the title bar.

Helpfile
String expression that identifies the Help file to use to provide context-sensitive Help for the dialog box. If  Helpfile is provided, context must also be provided.

Context
Numeric expression that is the Help context number the Help author assigned to the appropriate Help topic.  If context is provided, the helpfile must also be provided.

Table 8 - MsgBox Arguments
Example:

Sub AMessageBox()


MsgBox "Do what!!???", 2, "My Message"

End Sub

Result:
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Figure 12 - Message Box

InputBox

InputBox is very much like MsgBox, but it also allows the user to input text, which it can then return to the procedure. 

InputBox(prompt[,title][,default][,xpos][,ypos][,helpfile,context])

The MsgBox function syntax has these named-arguments:

Argument
Description

Prompt
String expression displayed as the message in the dialog box.  The maximum length of prompt is approximately 1024 characters, depending on the width of the characters used.  If prompt consists of more than one line, be sure to include a carriage return (character code 13), or carriage return linefeed (character code 10) between each line.

Title
String expression displayed in the Ttitle bar of the dialog box.  If you omit title, the word Input is placed in the Title bar.

Default
String expression displayed in the text box as the default response if no other input is provided.  If you omit default, the text box is displayed empty.

Xpos
Numeric expression that specifies, in twips, the horizontal distance of the left edge of the dialog box from the left edge of the screen.  If xpos is omitted, the dialog box is horizontally centered.

Ypos
Numeric expression that specifies, in twips, the vertical distance of the upper edge of the dialog box from the top of the screen.  If ypos is omitted, the dialog box is vertically positioned approximately one-third of the way down the screen.

Helpfile
String expression that identifies the Help file to use to provide context-sensitive Help for the dialog box. If helpfile is provided, context must also be provided.

Context
Numeric expression that is the Help context number the Help author assigned to the appropriate Help topic.  If context is provided, helpfile must also be provided.

Table 9 - Input Box Arguments

Example:

Sub InputIt()


myname = InputBox("What is your name?")


MsgBox "My name is " & myname

End Sub

Result:
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Figure 13 - Input Box
Decision-Control Structures

There are two common types of decision control structures in most programming languages. They are also sometimes referred to as Conditional or Branching structures.  The two decision control structures are:

· If statements

· Select Case statements

Statements are discussed in the following section.

If Statements

The If statement has two forms.  The first is used when only a few statements are to execute based on whether the result is True or False.  This type of If statement is commonly used when setting variables based on a condition.  

Syntax 1:

If condition Then statements [Else elsestatements]

Multiple commands can be separated by colons (:) for statements and elsestatements.  The second form of the If statement is best used with larger statement blocks.

Syntax 2:

If condition Then



[statements]
[ElseIf condition-n Then



[elseifstatements]]...

[Else


[elsestatements]]

End If
If…Then…Else Example

The following example prompts the user for a number and if the number is less than zero, tells the user to enter a number greater than zero.  If the number is greater then 100 it prompts for a smaller number.  Finally if the number is between 1 and 99 it gives the square of the number.

Sub IfThenElse()


Dim Num As Integer


Num = InputBox(“Enter a number please.”)



If Num <= 0 Then



MsgBox “Please enter a number greater than zero”



ElseIf Num > 100 Then



MsgBox “Your number is too large.”



Else



MsgBox Num & “ squared is “ & Num ^ 2



End If

End Sub
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 Try This:  Working with If statements
1. Given the following code, list the results for the scenarios below.

Sub TestIf(x As Integer)


If x < 0 Then



MsgBox “You're in the Hole.”


ElseIf x = 0 Then



MsgBox “You're even-steven!”


Else



MsgBox “You're in the Black.”


End If

End Sub

· What happens when TestIf(-100) is run?  TestIf(0)?  TestIf(1234)?

Select Case

The Select Case statement executes a block of statements based on the value of an expression.  Programming languages examine the testexpression, and evaluate each of the expressionlists in turn, searching for a match.  If it finds a match, it runs the code after the Case statement and stops when it reaches the next Case statement.  If it finds no match, it runs the code after the Case Else statement. If two cases match the test, only the first is executed. The Case statement ends when it reaches the last statement in the Case block or End Select statement.

Syntax of Select Case

Select Case testexpression


[Case expressionlist-n




[statements-n]]...



[Case Else



[elsestatements]]

End Select
Example of Select Case

Sub DisplayGrade()


Score = InputBox("Enter your score, 1-100")


Select Case Score



Case 0 To 64




MsgBox "Your grade is F"



Case 65 To 69




MsgBox "Your grade is D"



Case 70 To 79




MsgBox "Your grade is C"



Case 80 To 89




MsgBox "Your grade is B"



Case 90 To 99




MsgBox "Your grade is A"



Case 100




MsgBox "Your grade is A+"



Case Else




MsgBox "You entered an invalid score"


End Select
End Sub
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 Try This:  Working with Select Case Statements
1. Given the following code, determine the results of the procedure calls below.

Function TryCase(strMyText As String)


Select Case strMyText



Case “red”, “green”, “blue”




MsgBox “You have listed a primary color.”



Case “Ryan”, “Tadd”, “Steve”




MsgBox “You have entered a trainer's name.”



Case Else




MsgBox “I don't understand what you have entered.”


End Select

End Function

· What happens if you run TryCase(“Tadd”)?  TryCase(“blue”)?  TryCase(“Excel”)?

Looping Structures

Looping structures execute a group of statements more than once depending on the particular conditions specified. The two main types of loops include For...Next loops and Do loops.  This next section explores these loops and some of their variations as well as the infamous Goto statement.

For...Next Loops

A For...Next statement executes the code it contains a specific number of times. In the syntax shown below, note that the counter value can either increase or decrease depending on whether step is positive or negative.

For...Next Syntax

For counter = start To end [Step step]


[statements]



[Exit For]


[statements]

Next [counter]

For...Next Example

In this example the procedure starts looping from 1 to 20 and prompts the user with a message box with every other number in it.

Sub TestForNext()


Dim I as Integer


For I = 1 To 20 Step 2



MsgBox “Now on number: “& I


Next I

End Sub

A negative step example:

Sub TestForNext()


Dim I as Integer


For I = 10 To 1 Step -1



Debug.Print I


Next I

End Sub
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 Try This:  Counting the For...Next loop executions
1. Given the following code:

Function TryForNext()


Dim I as Integer


For I = 0 To 21 Step 3



MsgBox “Now on number: “& I


Next I

End Function

· How many times will the loop execute?  What if it was from 1 to 21?
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 Try This:  Do both a positive and negative step
1. Create a procedure that prints 0 through 100, by 10’s to the Debug window.

2.  Modify the previous function to print 100 to 0, by 10’s to the Debug window.

Do Loops

A Do loop repeats a section of code until a condition is satisfied or while a condition is true. For instance, a Do loop would be useful for refining a calculated value until a preset tolerance requirement is met or for performing a task while a variable equals a specified value.

There are two types of Do loops: one that checks the condition before executing any enclosed code, and one that checks the condition after executing the code. The version that does the checking before executing the code is shown in the following Syntax 1 section.

Do Loops Syntax 1

Do [{While | Until} condition]



[statements]



[Exit Do]



[statements]

Loop
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Note that if the condition proves False the first time it is checked, the enclosed code never executes.

Example of Do Loop Syntax 1

Do Until Abs(Estimate - Actual) < TOLERANCE


Estimate = CalcEstimate(Data)


If Estimate > MAXSAFEVALUE Then



SafeValue = False



MsgBox “Maximum safe range exceeded.”



Exit Do


End If

Loop

Do Loop Syntax 2

This second type of Do loop checks the condition after executing the code. Keep in mind that the statements inside the loop are always executed at least once, even if the condition is False.

Do



[statements]


[Exit Do]


[statements]
Loop [{While | Until} condition]
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Note this type Do loop always executes at least once.

Example of Do Loop Syntax 2

Do

RunDemo

'Run demo procedure


Answer = MsgBox(“Run the demo again?”, vbYesNo)

Loop Until Answer = vbNo
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 Try This:  Working with Do loops
1. Given the following code:

Function TryDoLoop1()


Dim i As Integer


i = 10


Do While i < 10



Debug.Print i



i = i + 1


Loop

End Function

· How many times will this loop execute?  What is the value of i when it finishes?
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 Try This:  Working with Do Loops, Part II
1. Given the following code:

Function TryDoLoop2()


Dim i As Integer


i = 10


Do



Debug.Print i



i = i + 1


Loop While i < 10

End Function

· How many times will this loop execute?  What is the value of i when it finishes?

While...Wend

The While Wend looping structure is equivalent to the Do While loop.  Typically the While...Wend loop provides for backwards compatibility with earlier versions of Basic and should not be used.  The Do...Loop statement provides a more structured and flexible way to perform looping.  The While...Wend looping structure executes a series of statements as long as a given condition is True.

While...Wend Syntax

While condition



[statements]

Wend
Exit

The Exit Statement is used to break out of a looping structure. When an Exit Do, Exit For, Exit While, or Exit For Each is encountered within a loop, execution of the procedure proceeds to the line following the Next, Wend, or Loop statement for the current loop.

Unconditional Branching

Branching structures that unconditionally branch to other parts of the procedure are less desirable than other structures because they make the procedure difficult to read and debug.  However, there are occasional needs for them (i.e., error checking) and they are listed below.

Goto

The Goto statement branches unconditionally to the specified line or label in the current procedure.

GoTo line
GoSub

The GoSub statement branches unconditionally to the specified line in the current procedure.  When the program encounters a Return statement, it returns to the line following the GoSub statement.

GoSub line

line:

Return
On Goto, On GoSub

On Goto and On GoSub branch to a number of different labels or line numbers based on the value of the expression (a number between 1 and 255).  The difference between the two is that On GoSub returns to the line following the statement when it encounters a Return statement, while On Goto does not.

On expression Goto destination
On expression GoSub destination
Nesting Data Structures

Data structures can be embedded within other data structures.  The embedded data structures can be the same as the outer data structure or can be a different type of data structure.  Furthermore there is no limit on the amount of nesting you can do, except machine memory.  Below are two examples of nested data structures.  The first uses three of the same data structures, the If data structure; the second uses two different data structures, Do…While and If…Then.

Nesting Example 1

Sub ThreeNestedIfs()


Dim a As Integer, b As Integer


a = 1


b = 3



If a > b Then




Debug.Print "A is bigger."



Else




If a = b Then





Debug.Print "A equals B."




Else





If a < b Then






Debug.Print "A is smaller."





End If




End If



End If

End Sub

The example above returns: A is smaller.

Nesting Example 2

Sub TwoDifferentNestedDataStruct()


Dim a As Integer, b As Integer


a = 1


b = 3


Do


Debug.Print a



a = a + 1



If a > b Then




Debug.Print b



End If

Loop While a < 5

End Sub
This example returns the following values: 1, 2,  3,  3, 4, 3

Exercises

1. Name the two decision control structures.

2. Name three of the looping structures.

3. Which of the following loops executes at least once?  Do While….Loop or Do….Loop While

Challenge Yourself.

1. Write a procedure that prompts a user for a number and users the If statement to determine if a number is greater or less than 25.  Display the result in a message box to the user.

2. Write a procedure that uses the Select Case statement to determine if a person enters a color of the rainbow or a different color.  Display to the user the color of the rainbow that they entered, or a message of an unknown color.

Write a procedure that uses a For…Next loop to display the odd numbers from 1 to 25.

Lesson 3: String Manipulation

What You Will Learn 

After completing this lesson, you will be able to: 

· Demonstrate understanding of the string manipulation functions by parsing and concatenating strings.

Related Topics Covered in this Lesson 

· Left, Right, Mid, InStr, Len, String, Space, StrComp, StrConv, Lset, Rset, Trim, Ltrim, RTrim, ASC, Chr, Format 

· Concatenation

· Option Compare

Overview - String Manipulation

In this lesson, we will introduce each of the VBA string functions and learn how these functions can be used to manipulate strings to accomplish common programming tasks.

VBA String Functions

VBA has many flexible tools for manipulating strings.  The following table summarizes the common programming actions involving strings and identifies the functions and/or keywords that are used to carry out these actions in VBA.

Action
Keywords

Compare two strings
StrComp

Convert to lowercase or uppercase
Format, LCase, UCase

Create string of repeating character
Space, String

Find length of a string
Len

Format a string
Format

Justify a string
LSet, RSet

Manipulate strings
InStr, Left, LTrim, Mid, Right, RTrim, Trim

Set string comparison rules
Option Compare

Work with ASCII and ANSI values
Asc, Chr

Convert strings
StrConv

Table 10—VBA String Manipulation Keyword Summary

Retrieving a Portion of a String

A common programming task involving strings is to extract a portion from a larger string.  Three functions help accomplish this task: Left, Right, and Mid.  Each of the functions is introduced below with its syntax and a code example.

Left

The Left function returns the specified number of characters from the left side of a string.

Left(string, length)

The Left function syntax has these named arguments:

Argument
Description

string
String expression from which the leftmost characters are returned.  If the string contains Null, Null is returned.

Length
Numeric expression indicating how many characters to return.  If 0, a zero-length string is returned.  If greater than or equal to the number of characters in string, the entire string is returned.

Table 11—Left Function Arguments

Example

Sub ExampleLeft()


Dim AnyString As String


AnyString = "Hello World"


Debug.Print Left(AnyString, 5)

End Sub

Result

Hello

Right

The Right function returns the specified number of characters starting from the right side of a string and moving left.

Right(string, length)

The Right function syntax has these named arguments:

Argument
Description

string
String expression from which the rightmost characters are returned.  If string contains Null, Null is returned.

length
Numeric expression indicating how many characters to return.  If 0, a zero-length string is returned.  If greater than or equal to the number of characters in string, the entire string is returned.

Table 12—Right Function Arguments

Example

Sub ExampleRight()


Dim AnyString As String


AnyString = "Hello World"


Debug.Print Right(AnyString, 5)

End Sub

Result

World

Mid

The Mid function returns the specified number of characters starting from the specified start position.

Mid(string, start[, length])

The Mid function syntax has these named arguments:

Argument
Description

string
String expression from which characters are returned.  If the string contains Null, Null is returned.

start
Character position in the string where the part to be taken begins.  If start is greater than the number of characters in string, Mid returns a zero-length string.

Length
Number of characters to return.  If omitted or if there are fewer than length characters in the text (including the character at start), all characters from the start position to the end of the string are returned.

Table 13—Mid Function Arguments

Example

Sub ExampleMid()


Dim AnyString As String


AnyString = "Hello World"


Debug.Print Mid(AnyString, 4, 5)

End Sub

Result

lo Wo
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 Try This:  Retrieving portions of a string
1. Enter the following procedure in the Module window.

Sub PartStrings()

    Dim MyString As String

    MyString = "11/20/95"

    Debug.Print "Month " & Left(MyString, 2)

    Debug.Print "Day " & Mid(MyString, 4, 2)

    Debug.Print "Year " & Right(MyString, 2)

End Sub

2. Enter the following into the Immediate pane of the Debug window and press enter:



?PartStrings()

· What is returned in the Debug window?  What would need to change if MyString were “112095” instead?

Comparing and Searching in Strings

Below are the common functions that can be used to compare two strings or specific characters, or find the position of a string or character in another string.

InStr

Often you may need to find the position of a character in a string, to either help parse the string or to find where the end of the string should be.  The InStr function is used to accomplish these tasks.

InStr([start, ]string1, string2[, compare])

The InStr function syntax has these named arguments:

Argument
Description

Start
Numeric expression that sets the starting position for each search.  If omitted, search begins at the first character position.  If start contains Null, an error occurs.  The start argument is required if compare is specified.

String1
String expression being searched.

String2
String expression sought.

Compare
Number specifying the type of string comparison.  Specify 1 to perform a textual case-insensitive comparison.  Specify 0 (default) to perform a binary comparison.  If compare is Null, an error occurs.  Start is required if compare is specified.  If compare is omitted, the setting of Option Compare is used to determine the type of comparison. (Option Compare is discussed further later in this lesson)

Table 14—InStr Function Arguments

Return Values

If
InStr returns

string2 is not found
0

string2 is found within string1
Position at which match is found

string1 is zero-length
0

string1 is Null
Null

string2 is zero-length
start

string2 is Null
Null

start > string2
0

Table 15—InStr Function Return Values
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Null means value indicating that a variable contains no valid data.  Null is not the same as the value zero (0).

Example

Sub ExampleInStr()


Dim AnyString As String


AnyString = "Waite, Connie"


Debug.Print InStr(1, AnyString, ",")

End Sub

Result

6

Len

The Len function returns the total length of a string. 

Len(string | varname)

The Len function syntax has these arguments:

Argument
Description

string
Any valid string expression.  If string contains no valid data, Null is returned.

Varname
Any valid variable name.  If varname contains no valid data, Null is returned.

Table 16—Len Function Arguments

Example

Function testlen()


Dim AnyString As String


AnyString = "Waite, Connie"


Debug.Print Len(AnyString)

End Function

Result

13

Asc

This function returns the numeric ASCII value for the first character in a string. This can be used to help differentiate between uppercase and lowercase characters.

Asc(string)

Argument
Description

String
The string named argument is any valid string expression.  If the string contains no characters, a run-time error occurs

Table 17—Asc Function Argument

Example

Function testasc()


Debug.Print Asc("A")


Debug.Print Asc("a")

End Function

Result

65 

97

Chr

This procedure returns the character for a particular numeric ASCII value. Chr can be used when you need to add characters that cannot be typed or if you need to use a reserved character like the double quote.

Chr(charcode)

Argument
Description

Charcode
The charcode argument is a number that identifies a character.

Table 18—Chr Function Argument

Example

Sub TestChr()


Debug.Print "Well, " & Chr(34) & "This is a Test" & Chr(34) & " right?"

End Sub 

Result

Well, "This is a Test" right?

Option Compare

The Option Compare statement specifies the string comparison method (Binary, Text, or Database) for a module.  If a module does not include an Option Compare statement, the default text comparison method is Binary. Binary is a case-sensitive comparison based on the ANSI code page being used.  The Text string comparison method is case insensitive.  The Option Compare statement is placed in the Declaration section of the module.

Option Compare {Binary | Text | Database}

Examples

Option Compare Binary

Option Compare Text

Option Compare Database
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Option Compare Database can only be used within Microsoft Access.  This results in string comparisons based on the sort order that is determined by the local ID of the database where the string comparisons occur.  See online Help in Microsoft Access.

StrComp

StrComp compares two strings and returns that the first string is smaller (-1), equal to (0), or larger (1) than the second string. If a binary string comparison is used the results are case sensitive. 

StrComp(string1, string2[, compare])

The StrComp function syntax has these named arguments:

Argument
Description

String1
Any valid string expression.

String2
Any valid string expression.

Compare
Number specifying the type of string comparison.  Specify a 1 to perform a textual comparison.  Specify a 0 (default) to perform a binary comparison.  If compare is Null, an error occurs.  If compare is omitted, the setting of Option Compare is used to determine the type of comparison.

Table 19—StrComp Function Arguments

Return Values

If
StrComp returns

string1 is less than string2
-1

string1 is equal to string2
0

string1 is greater than string2
1

string1 or string2 is Null
Null

Table 20—StrComp Function Return Values

Example

Sub testcomp()


Const BinaryComp As Integer = 0


Const TextComp As Integer = 1


Dim string1 As String


Dim string2 As String


string1 = "My"


string2 = "my"


Debug.Print StrComp(string1, string2, BinaryComp)


Debug.Print StrComp(string1, string2, TextComp)

End Sub

Result

-1 (My < my)

 0 (My = my)
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 Try This:  Comparing strings
1. Enter the following procedure into the Module window.

Sub TestComp()

    Dim MyString As String

    Debug.Print Asc("A")

    Debug.Print Chr(46)

    Debug.Print StrComp("a", "A", 0)

    Debug.Print StrComp("a", "A", 1)

End Sub

2. Enter the following into the Immediate pane of the Debug window and press enter:



?TestComp()

· What is the ASCII value of  A?  What character has the ASCII value 46?  Why do the two StrComp functions return different values?
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 Try This:  Parse list of items
1. Enter the following procedure into the Module window.

Sub TestString()


Dim MyString As String


Dim CurrentStart As Long


Dim StringLen As Long


Dim CommaPos As Long


Dim WordLen As Long


MyString = "One, Two, Three, Four, Five"


CurrentStart = 1


StringLen = Len(MyString)


CommaPos = InStr(CurrentStart, MyString, ",")


Do Until CurrentStart = StringLen



If CommaPos <> 0 Then




WordLen = CommaPos - CurrentStart




Debug.Print Mid(MyString, CurrentStart, WordLen)




CurrentStart = CommaPos + 1




CommaPos = InStr(CurrentStart, MyString, ",")



Else




WordLen = (StringLen - CurrentStart) + 1




Debug.Print Mid(MyString, CurrentStart, WordLen)




CurrentStart = StringLen



End If


Loop

End Sub

2. Enter the following into the Immediate pane of the Debug window and press ENTER:



?TestString()

· What are the results?

3. Now remove the commas from MyString and modify the procedure to work with the new string.

· What changes are required for the function to work properly without the commas in the string?

Modifying Strings

On many occasions, a programming task requires that a string actually be modified or changed.  This section discusses the common string functions that are used to modify strings. 

Trim, Ltrim, RTrim

The Trim function removes spaces from both the right and left sides of the string. The LTrim function removes any spaces on the left, and RTrim, any spaces on the right.

LTrim(string)

RTrim(string)

Trim(string)

Argument
Description

String
The string named argument is any valid string expression.  If  the string contains no valid data, Null is returned.

Table 21—Trim, Ltrim, RTrim Function Arguments

Example

Function TestTrim()


Dim string1 As String


string1 = "    <-- Trim -->   "


Debug.Print "Start" & string1 & "end"


Debug.Print "Start" & Trim(string1) & "end"


Debug.Print "Start" & LTrim(string1) & "end"


Debug.Print "Start" & RTrim(string1) & "end"

End Function

Result

Start    <-- Trim -->   end

Start<-- Trim -->end

Start<-- Trim -->   end

Start    <-- Trim -->end

LSet, Rset

These statements are used to left- or right- justify a string inside of a fixed-length string variable.

LSet stringvar = string

RSet stringvar = string

The LSet, RSet statement syntax has these parts:

Argument
Description

Stringvar
Name of string variable

String
String expression to be left- or right-aligned within stringvar

Table 22—LSet, RSet Statement Arguments

Example

Sub testSet()


Dim MyString As String * 10


Dim string1 As String


string1 = "test"


LSet MyString = string1


Debug.Print MyString & "end"


RSet MyString = string1


Debug.Print MyString & "end"

End Sub 

Result:

test      end

      testend 

String, Space

The String function returns a string of the length and character specified. The Space function returns a string of spaces the length specified.

String(number, character)

The String function syntax has these named arguments:

Argument
Description

Number
Length of the returned string.  If number contains Null, Null is returned.

Character
Character code specifying the character or string expression whose first character is used to build the return string.  If character contains Null, Null is returned.

Table 23—String Function Arguments

Space(number)

Argument
Description

Number
The Number argument is the number of spaces you want in the string.

Table 24—Space Function Argument

Example

Sub testString()


Debug.Print String(10, "*")


Debug.Print "start" & Space(10) & "end"

End Sub 

Result

**********

start          end

StrConv 

The StrConv function can change a string to proper case, uppercase or lowercase.

StrConv(string, conversion)

The StrConv function syntax has these named arguments:

Argument
Description

String
The string expression to be converted

Conversion
The sum of values specifying the type of conversion to perform

Table 25—StrConv Function Arguments

Conversion Settings

Constant
Value
Description

vbUpperCase
1
Converts the string to uppercase characters

vbLowerCase
2
Converts the string to lowercase characters

vbProperCase
3
Converts the first letter of every word in string to uppercase

Table 26—StrConv Function Conversion Settings

Example

Sub TestConv()


Dim MyString As String


MyString = "john wood"


Debug.Print StrConv(MyString, vbProperCase)


Debug.Print StrConv(MyString, vbUpperCase)


Debug.Print StrConv(MyString, vbLowerCase)

End Sub

Result

John Wood

JOHN WOOD

john wood
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The StrConv function is also used to convert strings to and from double-byte characters, to and from Unicode, and to Katakana and Hiragana characters.  See Online Help for more information regarding these conversions.
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Under Microsoft Excel for Microsoft Windows® 95, the StrConv function only functions properly under the Far East versions of the product.  It can be entered into non-Far East versions, but it always returns the string the same way it was received without converting it.

LCase, UCase

Two additional functions are provided which can be used to convert string to upper- or lower- case.

LCase(string)

UCase(string)

Argument
Description

String
The string argument is any valid string expression.  If  the string contains Null, Null is returned.

Table 27—LCase, UCase Functions Argument

Example

Sub ExampleCases()


Dim myString As String


myString = "Hello World"


Debug.Print LCase(myString)


Debug.Print UCase(myString)

End Sub

Returns

hello world

HELLO WORLD

Mid Statement

Unlike the Mid function, the Mid statement replaces a portion of a string rather than returning a portion of a string.

Mid(stringvar, start[, length]) = string

The Mid statement syntax has these parts:

Argument
Description

Stringvar
Name of string variable to modify

Start
Character position in stringvar where the replacement of text begins

Length
Number of characters to replace.  If omitted, all of string is used.

String
String expression that replaces part of stringvar

Table 28—Mid Statement Arguments

Example

Sub testMid()


Dim MyString As String


MyString = "One, Two, Three"


Mid(MyString, 6, 3) = "six"


Debug.Print MyString

End Sub

Result

One, six, Three
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 Try This:  Modifying strings
1. Enter the following procedure in the Module window.

Function ModString()


Dim MyString As String


MyString = "one, two, three"


Debug.Print StrConv(MyString, vbUpperCase)


Mid(MyString, 6, 3) = "six"


Debug.Print MyString

End Function

2. Enter the following into the Immediate pane of the Debug window and press enter:


?ModString()

What are the results?

3. Now modify the function to convert the string to proper case and replace, three with seven.

· Did the function modify the string correctly?

Format

The Format function is used to modify expressions according to instructions contained in a format expression.  Numeric, Date/Time, Date/Time Serial Number, and String expressions can all be formatted using the Format function.

Format(expression[,format])

The Format function syntax has these arguments:

Argument
Description

Expression
Any valid expression

Format
A valid named or user-defined format expression

Table 29—Format Function Arguments

Example

Sub UpperCase()

    Dim x As String

    x = "hello world"

    Debug.Print Format(x, ">")

End Sub

Returns

HELLO WORLD

Predefined Named Formats

VBA contains many predefined named formats specific to Numbers and Dates/Times.  To use one of the predefined formats place the format name surrounded by quotes in the second argument of the Format function.

Format Name
Description

General Number
Displays number as is, with no thousand separators.

Currency
Displays number with thousand separator, if appropriate; display negative numbers enclosed in parentheses; display two digits to the right of the decimal separator.  Note that output is based on system settings.

Fixed
Displays at least one digit to the left and two digits to the right of the decimal separator.

Standard
Displays number with thousands separator, at least one digit to the left and two digits to the right of the decimal separator.

Percent
Displays number multiplied by 100 with a percent sign (%) appended to the right; always displays two digits to the right of the decimal separator.

Scientific
Use standard scientific notation.

Yes/No
Displays No if number is 0; otherwise, display Yes.

True/False
Displays False if number is 0; otherwise, display True.

On/Off
Displays Off if number is 0; otherwise, display On.

Table 30—Named Numeric Formats

Format Name
Description

General Date
Display a date and/or time.  For real numbers, display a date and time (for example, 4/3/93 05:34 PM); if there is no fractional part, displays only a date (for example, 4/3/93); if there is no integer part, displays time only (for example, 05:34 PM).  Date displays is determined by your system settings.

Long Date
Displays a date according to your system's long date format.

Medium Date
Displays a date using the medium date format appropriate for the language version of the host application.

Short Date
Displays a date using your system's short date format.

Long Time
Displays a time using your system's long time format: includes hours, minutes, seconds.

Medium Time
Displays time in 12-hour format using hours and minutes and the AM/PM designator.

Short Time
Displays a time using the 24-hour format (for example, 17:45).

Table 31—Named Date/Time Formats

Example

Sub getdate()


Debug.Print Format(Time, "Long Time")


Debug.Print Format(Date, "Long Date")

End Sub

Returns

'Depends on current system date and time and current 

'system-defined long date and time formats.

2:51:20 PM

Tuesday, February 20, 1996

User-Defined Formats

In addition to the predefined name formats, you can create your own customized formats.

Example 1

Dim myTime As Date

Dim myDate As Date

myTime = #5:04:23 PM#

myDate = #1/27/93#

MyStr = Format(MyTime, "h:m:s")

 ' Returns "17:4:23".

MyStr = Format(MyTime, "hh:mm:ss AMPM") ' Returns "05:04:23 PM".

MyStr = Format(MyDate, "dddd, mmm d yyyy")

' Returns "Wednesday, Jan 27 1993".

Example 2

' If format is not supplied, a string is returned.

MyStr = Format(23)
' Returns "23".

Example 3

MyStr = Format(5459.4, "##,##0.00")
' Returns "5,459.40".

MyStr = Format(334.9, "###0.00")

' Returns "334.90".

MyStr = Format(5, "0.00%")


' Returns "500.00%".

MyStr = Format("HELLO", "<")

' Returns "hello".

MyStr = Format("This is it", ">")
' Returns "THIS IS IT".
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Microsoft Access for Windows 95 and Microsoft Visual Basic 4.0 both support two additional, optional arguments for the Format function: firstdayofweek and firstweekofyear.  As the names suggest, these arguments are used for supplying the first day of the week and the first week of the year when working with dates.  See online Help in the appropriate application for more information regarding these arguments.
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 Try This:  Using the Format function
1. Open a module and insert the following procedure.

Sub formats()

    Dim myDate As Date

    Dim myTotal As Currency

    Dim myAnswer As String

    myDate = Date

    myTotal = -200

    myAnswer = "The answer is SIXTEEN."

    Debug.Print Format(myDate, "Long Date")

    Debug.Print Format(myTotal, "Currency")

    Debug.Print Format(myAnswer, ">")

End Sub

2. Enter the following into the Immediate pane of the Debug window and press enter:



formats

· What is displayed in the Debug window?

3. Now modify the code so that the date is displayed as 02/96 (Month/Year), the money is displayed in red when it is negative and black when positive, and the answer is set to lowercase.

· What changes were required?

Concatenation

Another common programming task is to combine two or more strings together into one string for various purposes.  The process of combining two or more strings is called concatenation.  Concatenation is commonly used to create strings for message boxes, input boxes, function return values, and SQL database queries.

In Visual Basic, the concatenation operator is an ampersand (&). Be sure to include a space before and after the ampersand. The following example concatenates a string and a variable to display in a simple message box.

Sub Message()


Dim myVariable


myVariable = 200


MsgBox "The answer is " & myVariable & "."

End Sub

Returns

The answer is 200. 
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 Try This:  Concatenating Carriage Returns into a Message Box
1. Open the Module window and insert the following procedure.

Sub CatMsg()

    Dim myMsg As String

    myMsg = "You have chosen the remove operation."

    myMsg = myMsg & Chr(10) & Chr(13)

    myMsg = myMsg & Chr(10) & Chr(13)

    myMsg = myMsg & "Do you wish to continue?"

    MsgBox myMsg, vbYesNo

End Sub

2. Enter the following into the Immediate pane of the Debug window and press enter:



CatMsg

· What is displayed?  What are the Chr(10) and Chr(13) functions used for?

Participant's Learning Responsibility

Following is a list of topics/issues that were not covered in class, but they are still important to know.  You are expected to understand the topics below, complete any exercises or reading assignments, and be prepared to ask any questions you have at the start of the next class.

To Know

File Manipulation

Exercises

1. What do the following statements return?

?Left("This is a test", 7)

?Right("This is a test", 9)

?Mid(Format(Date, "mm/dd/yy"), 4, 2)

?InStr("Doe, John",",")

?Len("Mary Had a Little Lamb…")

2. Create a function which accepts as an argument any string and returns the number of times the word "the" appears in the string argument.

3. Create a function which accepts as an argument any URL (Uniform Resource Locator) and returns the domain name of the server the URL refers to.  For example, if the function were passed "http://www.microsoft.com/backoffice/NT/index.htm" it would return "www.microsoft.com"

Challenge Yourself!

1. Create a function that accepts as an argument any person's name and then parses out the first, middle, and last names of the argument into three different variables. The function should handle names with only a middle initial, no middle name, or two middle names.

Lesson 4: Error Handling

What You Will Learn 

After completing this lesson, you will be able to: 

· Use Error Handling statements to build an error routine in code.

· Use the Err and Error functions to display additional error information.

· Use the Err object to display additional error information in Microsoft Access and 
Microsoft Visual Basic.

Related Topics Covered in this Lesson

· On Error Goto

· Resume Next

· Resume

· Exit Sub/Function

· Raise, Clear Methods

Recommended Reading 

· Building Applications with Microsoft Access for Windows 95, Chapter 8, "Handling Run-Time Errors."

Overview - Error Handling

Error handling allows the code to trap unexpected behavior. For example, a procedure tries to open a file that does not exist, because the user enters the wrong type of data in a dialog box. Procedures can be written to anticipate these types of errors and correct the condition, alert the user to the problem, or gracefully exit from the procedure.




Figure 14—Error Handling Flow Chart

On Error

The key to error handling is the On Error statement. This statement enables error trapping. The On Error statement tells VBA where to go when an error occurs. There are three syntaxes that are used.

On Error GoTo Err_MyFunc

This instructs VBA to jump to the label Err_MyFunc when an error occurs.

On Error Resume or On Error Resume Next

These direct VBA to either try the statement that caused the error again or to move to the next line of code and continue from there. This type of syntax is used when the program could encounter harmless errors that can be ignored.

On Error GoTo 0

This tells VBA to stop trapping errors. After this statement has been executed any errors cause standard error messages to appear.




Figure 15—Error Trapping Methodology

Resume

In the error-handling code sometimes the cause of the problem can be taken care of, then the code needs to go back and try the original operation again. The Resume statement resumes execution at the line of code that caused the problem.

Resume Next

In the error-handling code, if a specific error occurred the procedure can safely move to the next line of code without a problem. The Resume Next statement starts execution on the line after the error line.

Exit Function/Sub

Sometimes it is necessary to exit a procedure after an error has occurred. In the error-handling code, the opened objects and variables can be reset, informing the user of the error and then exiting the procedure gracefully. 

Err and Error Functions

Two functions allow you to extract details about the most recent error:  Err and Error().  The Err function returns the specific number of the error that occurred.  The Error function takes as an argument an appropriate error number and returns a string description of the error.  

The following procedure shows an example of how procedures can handle errors and how the Err and Error functions are used to return information about the error.

Sub MyErrorHandle()

On Error GoTo Err_MyErrorHandle

    Dim X As Integer

    MsgBox "Testing Error Handling"

    X = 1 \ 0 'Integer divide by zero

    Exit Function

Err_MyErrorHandle:

    MsgBox "Error " & Err & ": " & Error(Err)

    Exit Function

End Sub

[image: image62.png]


 Try This:  Implement an Error Handler
1. Enter the following procedure into the Module window.

Sub TestErrors()

    Dim Num As Integer

    Dim Den As Integer

    Dim Result As Integer

    On Error GoTo Err_TestErrors

    Num = 10

    Den = 0

    Result = Num \ Den

    Exit Function

Err_TestErrors:

    MsgBox "Error " & Err & ": " & Error(Err)

    Exit Sub

End Sub

2. Enter the following into the Immediate pane of the Debug window and press enter:



?TestErrors()

· What information is displayed in the dialog box?

Err Object

Microsoft Access for Windows 95 and Visual Basic 4.0 both employ Err as an object that contains information about the error that just occurred. It has properties and methods that you can use to check which error occurred, clear an error value, or cause an error.  The Err object provides more information and has greater functionality than the Err statement discussed earlier.  For example, using the Raise method of the Err object, you can actually force errors of specific types in VBA.

[image: image63.wmf]
Currently, the Err object is not supported under Microsoft Excel for Windows 95 and Microsoft Project for Windows 95.

Properties

The Number property is an integer that indicates the last error that occurred. Check the value of Err.Number to determine which error occurred. In some cases, you might be able to correct an error and continue processing without interrupting the user. Otherwise, you need to notify the user of an error, and take action based on the user’s response.

The Description property is a string that contains a description of the error.

The Source property contains the name of the object application that generated the error. This is helpful when using OLE. For example, if you access Microsoft Excel and it generates an error, Microsoft Excel sets Err.Number to the correct error code and sets Err.Source to Excel.Application. 

Methods

The Clear method clears an error. It sets the value of Err.Number back to 0. 

The Raise method causes an error. Use the Raise method to pass an error back to a calling procedure or to test your own error-handling code. VBA does not use all available numbers for its own errors. If you want to generate and trap your own errors, begin your numbering scheme with 32767 and work your way down. For example:

Err.Raise 32000

Participant's Learning Responsibility

Following is a list of topics/issues that were not covered in class, but they are still important to know.  You are expected to understand the topics below, complete any exercises or reading assignments, and be prepared to ask any questions you have at the start of the next class.

To Know

· Changes in error handling from Microsoft Access 2.0 to 7.0 (i.e., the Err Object vs. Err statement).

Exercises

1. Fill in the description of each property of the Err Object in the table below:

Property
Description

Err.Number


Err.Description


Err.Source


2. Create a function that accepts two numbers as arguments, divides the first number by the second number and returns the answer.  Make the function display a custom message rather than the standard run-time error if the second arguments is zero.

Lesson 5: Debugging Techniques

What You Will Learn

After completing this lesson, you will be able to: 

· Define the use of a watch.

· Use the Debug.Print method to display a value in the Debug window.

· Use the MsgBox statement to display a value in code.

· Use the Stop statement to halt code at a specific point of execution.

· Use breakpoints to halt code at a specific line.

Related Topics Covered in this Lesson 

· Instant Watch

· Immediate Window

Recommended Reading 

· Building Applications with Microsoft Access for Windows 95, Chapter 7, "Debugging Visual Basic Code.”

Overview - Debugging Techniques

When you are debugging, your task is to determine where something went wrong.  Perhaps you chose the wrong operator, used the wrong function, or forgot to initialize a variable properly. While there are no magic tricks to debugging, VBA provides debugging tools to help you analyze run-time errors in particular, and VBA code in general. These tools are particularly helpful in analyzing program logic errors.

Debugging Techniques 

Types of Errors

There are three types of errors in programming:

· Language errors - These errors result from incorrectly constructed code.  VBA detects these errors automatically when the programmer enters a line code or moves the cursor off of a line of code, or immediately before the code executes.

· Run-time errors - These errors occur when a statement attempts an operation that is impossible to carry out.  The code may be syntactically correct but, because of the current conditions, is not an appropriate operation.

· Logic errors - The code has neither language or run-time errors, but does not perform in the manner in which it was intended.

VBA can provide assistance with language and run-time errors by alerting the programmer with a message describing the type of error.  Logic errors are more difficult to debug because no errors are detected by VBA during execution.

Debugging Interface

VBA includes several tools to assist the programmer in debugging and testing code.  The first is the Debug window. Using the Debug window, the programmer can monitor the values of expressions and variables while stepping through each statement in the code. 

The Debug window has the following parts:

Part
Description

Immediate pane
The Immediate pane is where you enter code to execute it immediately.  The Immediate pane is displayed by default the first time you open the Debug window.

Watch pane
The Watch pane displays information about all defined Watch expressions.

Procedure box
During break mode, the Procedure box displays the name of the project, module, and procedure name where execution is stopped.  The button to the right of the Procedure box displays the Calls dialog box.

Split bar
The split bar separates the Debug window into two panes.  The upper pane displays the Immediate or Watch pane.  The Code pane below the split bar displays the code where execution is stopped.  To size a pane, select the split bar and drag it up or down.

Code pane
The Code pane displays the procedure code where execution is stopped.  (Available only in Microsoft Excel and Microsoft Project.)

Table 32—Debug Windows Parts

Debug Windows

There are currently two different Debug window designs in use in the Microsoft applications.  Microsoft Excel and Microsoft Project use one design, while Microsoft Access and Visual Basic 4.0 use another.  Each of the two designs is discussed below:
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Figure 16—Default Debug Window of Microsoft Excel and Microsoft Project
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Figure 17—Watch Pane of Debug Window in Microsoft Excel and Microsoft Project
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Figure 18—Default Debug Window of Microsoft Access and Visual Basic 4.0
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Figure 19—Watch Pane in Debug Window of Microsoft Access and Visual Basic 4.0

Additional Tools

In addition to the Debug window, the Visual Basic toolbar includes buttons for stepping through code and adding breakpoints and watches to code. 

[image: image120.png]Connok |
|

X [A abl

@ ¢ Addions Controls.

= Delete Label

Custamize Label




[image: image121.png][Ad

nal Controls

Avaible Conliok:

[0 ActivertFlugin Object < [

/0D COMMON DIALOGS CONTROL, Cancel

0 FutureSplash Object e
03 HHC Object

0 koric Button Canircl
0 eric Menu Contal

0 MarquesCi Dbiect

9 Microsaft Fams 2.0 CheckBox

3 Microsaft Frms 2.0 ComboBox

2 Microsaft Farms 2.0 CommandBuion

Show————————
@ it s 20 e L,;] A—

- Calendar Canlrol 80
Location  C:AWINDOWSASYSTEMMSCAL OCX




[image: image122.png]Corios |

X A ol B8 B
Fle Ao
=]

= 5]

13




[image: image123.png]ot

o

Normal
=& Project (CommandBars816)
Microsoft Word Obects.
43 Modles

2 Module1
-5 References =

[CommandButton] Commandbutton =

e p—

JForecolor M craooonorzs x|




[image: image68.png]



Figure 20 - Visual Basic Toolbar

Break Mode

Break mode is a pause in the execution of the code.  The following tasks are available while in break mode:

· Determine which active procedures have been called

· Watch the values of variables, properties, and statements

· Change the values of variables and properties

· Run Visual Basic statements immediately

· Manually control the line-by-line execution of the code

When in break mode, the programmer has access to a variety of tools.  When any of the following  events occur, VB switches to break mode:

· Clicking one of the Step buttons in the Tools Macro dialog box to execute a procedure

· Execution reaches a line that contains a breakpoint. A breakpoint is set by selecting the line where the break should occur and clicking the Toggle Breakpoint button, or by clicking the Run Toggle Breakpoint command.

· Execution reaches a Stop statement

· A break expression defined in the Add Watch dialog box changes or becomes True

· An untrapped run-time error occurs

· The Debug button is clicked in the dialog box that appears after ctrl-break or esc is pressed

Stepping Through Code

While in break mode, the programmer may step through each line of code using the Step Into (f8) and Step Over (shift+f8) commands (or the buttons on the Visual Basic toolbar.). The difference between the two commands is that the Step Into command steps through every command, including those in any procedures called by the current procedure.  The Step Over command behaves exactly like the Step Into command until a call to a procedure is encountered.  Step Over executes calls to procedures as one command (instead of stepping through each line in the called procedure) and then continues stepping.

The Stop Statement

When the procedure encounters a Stop statement, VBA goes into break mode.  The difference between the Stop statement and a breakpoint is that the statement is part of the executable code and is saved with the program.  All breakpoints are cleared when the file containing the procedure is closed.

Watch Expressions

A Watch expression follows the value of a particular variable or expression and displays the value in the Watch pane of the Debug window.  
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Figure 21—Add Watch Window

There are two ways to use a Watch expression.  The first is to select the variable name, expression, or property in the code and click the Tools Add Watch command.  This adds the variable to the list of expressions in the Watch pane.  As the code executes, the value of the expression changes.  It is also possible to set the Watch Type in this dialog box.  This is useful for instructing VBA to break automatically when the value of the expression becomes True or when it changes.

A second way to use a Watch expression is to use the Instant Watch command.  By selecting a variable or expression in the code and either clicking the Instant Watch button or clicking the command on the Tools menu, a dialog box appears which shows the current value of the expression.  Clicking the Add button adds it to the Watch pane.
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 Try This:  Add a Watch
1. Create a new module and insert the following procedure:

Sub myLoop()

    Dim i As Integer

    For i = 1 To 10

        Debug.Print i

    Next

End Sub

2. Click Add Watch on the Tools menu.

3. Enter the following into the expression box:



i = 5

4. Set Watch Type to Break when Expression is True.

5. Click OK.

6. Enter the following into the Immediate pane of the Debug window and press enter:



?myLoop()

· What happened to the code?  How would you step through the code at this point?

The Immediate Pane

The Immediate pane displays information that results from debugging statements in the code or statements that are entered directly in the Immediate pane.

Information is displayed in the Immediate pane from within a procedure using the Print method.  For example, the following code displays The value of x is ? in the Immediate pane:


Debug.Print "The value of x is " & x

Or, the Print method may be used directly in the Immediate pane by entering:


Print x

The question mark (?) is the equivalent of the Print command in the Immediate pane, so the following line produces the same result:

? x

Pressing the enter key causes the statement to evaluate.  The Immediate pane also accepts other Visual Basic commands, even those that change the values of variables and properties or the behavior of the code.

Multiple lines of code can be entered on one line using the colon (:) as a separator, which is useful for loops:

For x=1 to 5 : ? x : Next

Procedure Call Stack
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The Calls dialog box is useful when tracking the operation of code as it executes through a series of procedures.  This is especially useful when tracking nested procedures.  To view a list of all the nested calls, click the Show button to the right of the Procedure box.
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Figure 22—Calls Window

If, for example, procedure callOne called procedure callTwo, which called procedure callThree, the Calls dialog box would list procedure callThree, then callTwo, then callOne, with the most recently called procedure at the top.

The procedures are added to the list as they are called and removed from the list as they are completed.

Exercises

1. What tools does VBA have for debugging purposes?

2. What is the difference between an Instant Watch and a Watch?
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Lesson 1: Application and Project Objects

What You Will Learn

After completing this lesson, you will be able to:

· Navigate through the Object Hierarchy.

· Execute Application and Project Methods.

· Understand how to locate different Methods and Properties.

· Understand what a collection is.

· Understand how and where macros are stored.
Related Topics Covered in this Lesson

·  Object Hierarchy

· Navigation

· Moving the active cell.

· Commonalties between Methods and Properties

· CurrentView, Table and Filter Properties.

Overview of Object Hierarchy

Microsoft Visual Basic for Applications (VBA) allows each application to extend the Microsoft® Visual Basic® language with application specific objects.  Microsoft Excel exposes Workbook, Chart, and Cell objects whereas Microsoft Project exposes Project, Task, Resource, and Calendar objects.  Of course, there are places of overlap.  Both Microsoft Project and Excel expose Application and Microsoft Windows® objects and wherever possible the shared objects have the same properties and methods.  

Nesting of Objects

Objects are nested within each other to form a hierarchy.  The Application contains the Projects, which contain the Tasks, which contain the Assignments.  It is probably easiest to understand the hierarchy of the Microsoft Project object model the diagram on the next page.

Navigation

As you can see, the Application object sits at the top of the hierarchy.  From the Application object you can navigate down to any other object.  For example, the Duration field is contained in a Task, which is contained in a Project, which is contained in the Application.  So to modify the Duration, you specify:

Application.Projects(1).Tasks(3).Duration = "3d"

Fortunately, some shortcuts are available when referencing objects.  First, the Application object is optional when accessing objects within Microsoft Project.  So you can use:

Projects(1).Tasks(3).Duration = "3d"

Additionally, there is some pre-defined reference objects for commonly used objects.  For example, there is an ActiveProject property that returns a Project object that represents the active project.  So, if Projects(1) were the active project, the same duration field can be accessed like:



ActiveProject.Tasks(3).Duration = "3d"

You can also use the Activecell property that returns the active cell.  In the example below, if you had a cell selected on the third task in your project you would accomplish the same thing as the above example. 

ActiveCell.Task.Duration = "3d"

Common Objects

There are some objects, which are common to Microsoft Project and Excel.  For example, both products support automatic or manual recalculation.  Hence, the Application objects in both products have a Calculation property.  For example, the following code has the same effect in Excel as it does in Project.

Application.Calculation = True

Differences between Microsoft Project and Excel

One difference to note between the implementation of Visual Basic for Applications in Microsoft Project and Excel is the extent of their respective object models.  Microsoft Excel has taken the approach of creating objects for all of the data and user interface.  In Microsoft Project, the emphasis was on exposing objects for the unique scheduling data (tasks, resources, etc.) and a hierarchy for navigating to that data.  Most of the user interface elements are left to statements (such as FileOpen).

This difference can be seen in things like the way you close a file.  In Microsoft Project, you use the FileClose statement:

Projects(2).Activate

FileClose

In Microsoft Excel, you can do this in one step:

Workbooks(2).Close
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Application Object

The Application is at the top of the Object Model hierarchy.  It is through the Application object that all other objects can be accessed.  The Application object contains several interesting properties and methods, which are useful in macros.

User Interface Commands and Methods

The Application object contains methods, which correspond to the user interface actions.  For instance:

Application.FileOpen Name:="project1.mpp"

Application.EditCopyPicture

Since the Application object is always optional when writing macros within Microsoft Project, you can specify these items simply by their name:

FileOpen Name:="project1.mpp"

EditcopyPicture

Application Object Methods

Application Methods are commands that execute a Project feature.  For example, the CalculateProject method is the same as hitting F9 on your keyboard.  FileOpen is the same as choosing Open from the File Menu.

Most of the Application methods are used for basic Project commands.  For example, the File and Edit menu methods have the same effect as choosing items from under your File and Edit menus.

FileNew, FileOpen, FileClose, FileSave, FileSaveAs, FileExit, EditCut, EditCopy, EditPaste, EditDelete, etc.

Some of the more interesting and useful application methods are ones that enable movement control of the active cell.

SelectCellDown, SelectCellRight, SelectCellLeft, SelectCellUp, SelectColumn.  These allow easy movement of the active cell, similar to using your arrow keys.  The following macro calculates a formula in the Number1 field and then moves down 3 tasks and repeats the formula.

For I = 1 to 10


ActiveCell.Task.Number1 = ActiveCell.Task.Duration * 5


SelectCellDown 3

Next I

Almost all actions that can be performed manually in Project can be achieved by running application methods from within a macro.  When you record a macro, you are using the user interface to issue commands.  Hence, when a macro is recorded, these Application methods are used.

Exercise1:

Using the record macro feature of Project, record a macro that records as many commands that you can think of.  After you are finished recording, edit your macro and look at the different application methods it recorded.

Exercise2:  (MoveRect)

Write a macro using application methods that saves a file you created, and then moves the active cell around in a rectangle of any size 5 times.  Then close the file.  (Do not use the macro recorder or help file, this is an exercise to help train your mind to think in “method” mode.)  
Application Object Properties

Most of the Application Object properties are used to set up and change the environment.  For example, the Top property returns the position on the screen of the application window.  You can set this property to a different value to reposition the window.  However, not all properties are editable.  For example, the Version property simply reports what version of Project your are currently working with.  You cannot set the value.  Version = 5.0 would fail.

Options & Leveling Properties

Another useful aspect of the Application object is the ability to set the option properties, which correspond, to the settings found in the Options and Leveling dialogs.  Many times users need to make sure that before running their macro certain settings are always set to specific values.  By setting a series of Application properties ahead of time the user can insure consistency.

LevelOrder = pjLevelPriority

‘Sets the leveling order to Priority, Standard

StartYearIn = pjMarch

‘Sets the fiscal year to start in March

MoveAfterReturn = True
‘Self explanatory

Most of the settings found in the Tools/Options dialog are accessible through the Application object.  The exceptions here are the settings, which are project specific, like the default Standard Rate for new resources.  Since these options are project specific, they are contained in the Project object.

Exercise:

Using the list of properties for the Application Object from the help file, write a macro that displays several current values of properties from the Options and Leveling dialogs.

Corresponding Application Methods

All of the options that can be accessed via either the Application or Project objects property can also be set using an Application method.  There is one Application method for each tab in the Options dialog.  For example:

Application.Calculation = pjManual

is the same as

OptionsCalculation Automatic:= False

And,

ActiveProject.AutoAddResources = True

is the same as

OptionsGeneral AutoAddResources:= True

The advantage of using the properties is that you can determine the current setting of the option, as demonstrated in the following example, which saved the state of calculation before setting it to manual.

bCalcSetting = Application.Calculation

Application.Calculation = pjManual

Application.Calculation = bCalcSetting

The advantage in using the method is that many options can be set at once.  The following example shows how you can set some of the display options for the application using both properties and a method.

Application.DisplayStatusBar = True

Application.DisplayScrollBars = True

OptionsView DisplayStatusBar:=True, DisplayEntryBar:=True, _

DisplayScrollBars:=True

For the options, which are project specific, the corresponding Application method provides the functionality to set the default for new projects.  In the Tools/Options dialog, near some of the project specific options there is a ‘Set as Default” button which records the settings of the current project as the default settings for new projects.  With those Application methods, there is an accompanying SetDefaults argument, which allows those settings to be recorded.  For example, to set the hours per week to 40 for new projects, you can use the OptionsCalendar method:

OptionsCalendar HoursPerWeek:=40, SetDefaults:=True

Project Object

Project objects are located within the Application object and contain all of the project-level information, such as the start of the project and the manager, as well as the details of the project, namely the tasks and resources.

Referencing Project Objects

There are several ways of referencing a project object.  The easiest way is by referencing the active project.  There is a property of the application object called ActiveProject, which returns the object corresponding to the active project.

MsgBox ActiveProject.ProjectStart

This example displays the start date of the active project in a dialog box.

You can also use the Projects collection to refer to a particular project.  Projects can be referenced either by their index or by their name.

MsgBox Projects(1).ProjectStart

MsgBox Projects("project1.mpp").ProjectStart

CurrentView, CurrentTable and CurrentFilter

Some useful properties of a Project object are those relating to the Views, Tables, and Filters.  Each project contains CurrentView, CurrentTable, and CurrentFilter properties.  These return the name of the current view, table, and filter respectively.  Using these properties allows you to make sure that the user is in the correct view before executing a macro or lets you save the user’s state so that it can be restored after the execution of a macro.

The following example records the current state of the project, prints a PERT Chart, and then returns the user to the correct state.

Sub PrintPERTChart()


strView = ActiveProject.CurrentView


strFilter = ActiveProject.CurrentFilter


ViewApply "PERT Chart"


FilePrint


ViewApply strView


If strFilter <> "" Then



FilterApply strFilter


End If

End Sub

List Collections

Another useful object found in the project object is related to the CurrentView, CurrentTable, and CurrentFilter properties.  It is the List collection.  The List collection is a collection of strings or numbers.  Because it is a collection, you can iterate over all of the items in the list using the For Each...Next construct discussed earlier.  You can also index the items in the list directly.

In the Project object, there are several List collections, which correspond to the Views, Tables and Filters available for use by the project.  For example, the TaskViewList contains the names of all of the task views available for the project.  Similarly, the ResourceFilterList contains all of the resource filters.

This example is a function, which checks the current view to see if it is a task view.  It uses both the CurrentView and the TaskViewList properties.  (This example would only have problems if a resource view had the same name as a task view.)

Function InTaskView() As Boolean

Dim bFound as Boolean

Dim varTemp as Variant


bFound = False


For Each varTemp in ActiveProject.TaskViewList



If ActiveProject.CurrentView = varTemp then




bFound = True




Exit For



End If


Next varTemp


InTaskView = bFound

End Function

Remember, even if a view is not in the TaskViewList, this does not necessarily mean that it is a resource view.  The Module Editor view for editing Visual Basic code is neither a task nor a resource view.

Exercise:  (ApplyAView)

Write a macro that prompts the user to enter the name of a task view and them applies it only if it is available.  If it is not them return an error message.

Lesson 2: Task, Resource and Assignment Objects

What You Will Learn 

After completing this lesson, you will be able to: 

· Reference tasks, resources and assignments.

· Perform functions on tasks and resources.

· Change values of fields for tasks, resources and assignments.
Related Topics Covered in this Lesson 

· Referencing fields

· Linking tasks

· Outlining tasks

· Getfield and Setfield functions.

· Accessing Assignment information

Task Object

Of course, the main objective of the Project object is to hold the scheduling information for the project, namely tasks and resources.

Referencing a Task

As with Project objects, tasks can be referenced in several different ways.  ID, Unique ID, or Name can reference a task object via the Tasks collection.

Tasks(1)

Tasks.UniqueID(4)

Tasks("Feed the cat")

There are advantages and disadvantages to each of these methods.  Referencing by ID (or row number) is the most straightforward, since these numbers are displayed to the user during the normal operation of Microsoft Project.  Since inserting and deleting tasks can cause the ID of a task to change, referencing with the ID will not be reliable if the macro must always refer to the same task.

Referencing by UniqueID allows you to always refer to the same task, but is conceptually more difficult because this information is not normally viewed.

Lastly, referencing by name makes for very readable code since you are able to refer to the task by name.  The drawback is that Microsoft Project supports multiple tasks with the same name, so referencing by name would only allow you to refer to the first task with a particular name.

Task Information

There are basically three different kinds of information contained in a task - Fields, Schedule Logic, and Structure.  While there is some overlap between these types, it serves as a model for organizing the information contained in a task.

Fields (Properties)

Almost all of the information in a task can be found in one of the fields Microsoft Project supports and so access to fields is an important part of Visual Basic for Applications in Microsoft Project.  Microsoft Project supports many different task fields.  These fields are simply accessed as a property of the task object that corresponds to the field name.

For example, to change the duration of a task, you would do something like:

ActiveProject.Tasks(3).Duration = "3d"

The Duration field (or the Duration property of a Task) is a good example of the use of a field in Visual Basic for Applications.  As shown in the example, the Duration property accepts a string.  It will also accept a number that is interpreted as the number of minutes in the duration:

ActiveProject.Tasks(3).Duration = 1440  '3d * 8h/d * 60m/h

In the normal use of the product, there are some cases where the duration of a task is calculated and therefore cannot be modified.  The most common occurrence is when the task is a summary task.  Summary tasks summarize the information of the subtasks indented below them in the outline.  Since Microsoft Project also supports a Summary field, it is easy to determine whether or not the a task is capable of having its duration changed:

If Not ActiveProject.Tasks(3).Summary Then


ActiveProject.Tasks(3).Duration = "3d"

End If

Additionally, there are many fields, which one normally associates with a task, such as Duration and BaselineStart, which are also applicable to the project itself.  For this reason, Microsoft Project supports all the task fields in the Project object as well.  As with a summary task, most of these fields are calculated and cannot be changed.

MsgBox ActiveProject.Duration

This example would show the length of the project in a dialog box.

Another interesting example of task information is the resource assignments.  Microsoft Project supports several task fields which can display the resources assigned to a task –Resource Names displays the names of the resources working on a task, Resource Initials displays the initials of the resources, and Resource Group displays the groups containing the resources.

As with any other field, these are all exposed as properties of a task.

MsgBox ActiveProject.Tasks(3).ResourceNames

This example would display the names of the resources working on task 3 in the same way as the Resource Names column in the Gantt Chart does.

Additionally, we have added objects, which give users access to the same information:

MsgBox ActiveProject.Tasks(3).Resources(1).Name

would display the name of the first resource assigned to task 3.

Lastly, both the Task and the Resource objects contain an Assignment object, which details the information about the assignment of a resource to a task.  The details of the Assignment object are discussed later.

Schedule Logic

Another important body of information in a task is the schedule logic.  In Microsoft Project, the logic is determined by creating predecessor and successor relationships.  One method of examining the logic of a task is to refer to the fields, which display this information as a string:

MsgBox ActiveProject.Tasks(3).Predecessors

This example would display something like “2FS+3d” to indicate that task 2 is a predecessor with a lag of 3 days.

As with resource assignments, Microsoft Project provides some of this information in an object form as well.  PredecessorTasks and SuccessorTasks are collections of tasks that are the predecessors and successors of the task in question.  So:

MsgBox ActiveProject.Tasks(3).PredecessorTasks(1).Duration

would display the duration of the first predecessor task of task 3.

Microsoft Project also supplies methods for manipulating task relationships.  The LinkPredecessors and LinkSuccessors methods allow the macro writer to create either predecessor or successor relationships.  Similarly, UnlinkPredecessors and UnlinkSuccessors allow the removal of relationships.

The following macro would unlink task 3 from all its successors:

Set x = ActiveProject.Tasks(3)

x.UnlinkSuccessors(x.SuccessorTasks)

Structure

The last kind of information contained in a task is the structure or organization of the tasks.  In Microsoft Project, tasks are organized into an outline where summary tasks summarize the information of the subtasks indented below them.  This is also known as a Work Breakdown Structure or WBS.

Again, this information can be derived from fields that are accessible in the product.  OutlineLevel gives the outline level of a task with 1 being the top of the outline and 10 being the lowest outline level.  OulineNumber gives the automatically generated WBS Code based on the outline.  The second task under the third summary task would have an Outline Number of “3.2”.

As with some of the other fields, Microsoft Project also provides this information in an object form.  OutlineChildren is a collection of the subtasks of a given task.  OutlineParent is the reverse - the summary task of a given task.  With these two collections, it is possible to navigate the outline structure directly.

Sub Siblings()


Set objParent = ActiveCell.Task.OutlineParent


For Each objTemp In objParent.OutlineChildren



strTemp = objTemp.Name & ListSeparator & strTemp


Next objTemp


'Remove the last List Separator


strTemp = Left$(strTemp, Len(strTemp) - Len(ListSeparator))


MsgBox strTemp

End Sub

This example displays the names of all the tasks, which have the same parent as the currently selected task.

To modify the outline, methods are exposed which move the task between outline levels.  OutlineIndent moves a task down one level in the outline structure.  OutlineOutdent does the reverse and moves the task up in the outline structure.  Additional methods are available which change the appearance of the outline on screen.  OutlineHideSubtasks will hide the subtasks of a summary task.  OutlineShowSubtasks will show any hidden subtasks of a summary task.  OutlineShowAllTasks will show all hidden subtasks of any summary task.

To link and unlink tasks together you can use the LinkPredecessors or LinkSuccessors methods. The following example prompts the user for the name of a task and then makes the task a predecessor of the selected tasks.

Sub LinkTasksFromPredecessor()


Dim Entry
' Task name entered by user


Dim T

' Task object used in For Each loop


Dim Exists
' Whether or not the resource exists

' Prompt the user for the name of a task to turn into a predecessor.


Entry = InputBox("Enter the name of a task:")


Exists = False

' Assume task doesn't exist.


' Search active project for the specified task.


For Each T in ActiveProject.Tasks



If T.Name = Entry Then




Exists = True



' Make the task a predecessor of the selected tasks.




ActiveSelection.Tasks(1).LinkPredecessors Tasks := T



End If


Next T


' If task doesn't exist, display error and quit Sub procedure.


If Not Exists Then



MsgBox("Task not found.")



Exit Sub


End If

End Sub

Exercise1:  (TaskTraverse)

Write a macro that traverses a listing of tasks.  If the duration is greater than 5 days then remove 10% of the duration from that task.  Also check to see if a summary task has more than 5 children, if so then collapses that outline.

Exercise2:  (TaskLink)

1. Write a macro that will automatically link only the first two tasks under a summary task.

Resource Object

The Resource object follows the same guidelines as the Task object.  Access to all of the fields is available directly as properties of the object.

Referencing a Resource

As with the Task object, there are several ways of referencing a Resource object.  ID, Unique ID, or name can reference a Resource object via the Resources collection.

Resources(3)

Resources.UniqueID(10)

Resources("Ken")

The same advantages and disadvantages of these methods that are seen in the Task object apply to the Resource object as well.  The only difference is that you do not normally have multiple resources with the same name, so indexing by name is more reliable with Resource objects than it is with Task objects.

Resource Information Fields (Properties)

Just like with the Task object, the fields associated with a resource are accessible as properties of the Resource object:

ActiveProject.Resources("Susan").StandardRate = "$25.00/h"

ActiveProject.Resources(3).BaseCalendar = "Night Shift"

This is the easiest and most understandable way of accessing the information for a resource.

GetField and SetField Methods

Another set of methods is also available for both Task and Resource objects, which allow you to access field information.  These are the GetField and SetField methods.

GetField takes a field number and returns the contents of the field as a string.  This is useful if you want to ensure that the value returned is a string.  It is also useful if you want to programmatically access fields at run-time.

This example prompts for the name of a field and then displays the information contained in that field on a resource view:

Sub DisplayField()


strTemp = InputBox("Enter the name of the field you want to see")


strTemp = LCase(strTemp)


Select Case strTemp



Case "name"




intFieldID = pjResourceName



Case "initials"




intFieldID = pjResourceInitials



Case "standard rate"




intFieldID = pjResourceStandardRate



Case ""




End



Case Else




MsgBox "You entered a field I don’t understand"




End


End Select


MsgBox(ActiveCell.Resource.GetField(FieldID:=intFieldID))

End Sub

The SetField method is the reciprocal of GetField.  It takes a field number and the string value to which you want to set the field.

ActiveCell.Resource.SetField FieldID:=pjResourceName, _



Value:="Jimbo"


ResourceCalendarEditDays Method

Another method that is available for the Resource object which allows you to set working and non-working time in the resource’s calendar.  This is the ResourceCalendarEdit method.

The following macros show how to set working and non-working time for a resource:


Sub BobNoWork()



‘The following line sets 1/6/98 through 1/8/98 to be non-working



ResourceCalendarEditDays ProjectName:="Project1.mpp", ResourceName:=”bob”, Startdate:=”1/6/98 12:00 AM”, _




EndDate:=”1/8/98 12:00 AM”, Working:=False


End Sub


Sub BobWork()



‘This line of code changes the working time for the dates 1/12/98 through 1/16/98.



‘The new working time is from 7:00 AM to 12:00 PM and 1:00 PM to 7:00 PM.



ResourceCalendarEditDays ProjectName:="Project1.mpp", ResourceName:=”bob”, StartDate:=”1/12/98 12:00 AM”, _




EndDate:=”1/16/98 12:00 AM”, Working:=True, Default:=False, _




From1:=”7:00 AM”, To1:=”12:00 PM”, From2:=”1:00 PM”, To2:=”7:00 PM”


End Sub


CostRateTables and PayRates Method

Another method that is available for the Resource object which allows you to set pay rates for each of the Cost Rate Tables are the CostRateTables and Payrates Methods.

The following macro shows how to set a pay rate for a particular cost rate table:


Sub SetCost()



‘This line adds a pay rate on Cost Rate Table C for 1/15/98 at $3.00/hr


Z=ActiveProject.Resources(“bob”).CostRateTables(“C”).PayRates.add (“1/15/1998”, ”3.00/h”)



‘This line displays a message box containing the table position where the rate was added


MsgBox Z


End Sub

Exercise1:

Write a macro that will prompt the user to enter the name of a resource and then display the value for the Max units and ask them if they would like to change the value.  If yes then get the new value and make the change.

Assignment Object

The Assignment object holds information about how work on a task is being accomplished by a resource.  The information includes the amount of work, the cost, and the start and finish dates of the work on the task.  In Microsoft Project you can see this information through either the Task Form or Resource Form views.

Referencing an Assignment

Assignment objects are referenced by a Unique ID value associated with each assignment.  Because these values are not necessarily sequential, it is probably easier to iterate over the Assignments collection with For Each...Next to find the particular assignment you want to work with.

Fields (Properties)

As with Task and Resource objects, Assignment objects provide access to the information contained in the assignment fields.  This includes fields such as Actual Cost, Overtime Work, and Units.

This example provides a list of all the tasks a resource is working on in the resource’s Text1 field in much the same way that the Resource Names field of a task displays all the resources working on the task:

Sub TaskNamesField()


Dim Sep, strTemp As String


Dim r, a As Object


Sep = ListSeparator


For Each r In ActiveProject.Resources



strTemp = ""



For Each a In r.Assignments




strTemp = a.TaskName & Sep & strTemp



Next a



'Remove the last List Separator



strTemp = Left$(strTemp, Len(strTemp) - Len(Sep))



r.Text1 = strTemp


Next r

End Sub

Assignment Information over Time

Because the work on a task occurs over a period of time, it is often useful to view the allocation of resources over time.  While the Assignment object does not contain this information in a time-phased manner, the TimescaledData method of the Application object does allow you to access it programmatically.

The TimescaledData method takes several arguments to specify the task and resource combination you wish to examine, the date range, the type of periods (such as Week vs. Day), and the type of information (Work vs.  Cost).  It returns a string containing the values for each period separated by the List Separator.  You can then parse the string to determine the values in each period.

This example displays a dialog box of the return timescaled data.  It is the assignment of resource 1’s work broken down in hours across the entire project.

MsgBox TimescaledData(ActiveCell.Task.ID, 1, ActiveProject.ProjectStart, _

          ActiveProject.ProjectFinish, pjWork, pjTimescaleHours)

Exercise1:  (AssignWork1)

Write a macro that finds all assignments of an inputted resource and removes 1 hour of work from each assignment.

Exercise2:  (AssignWork2)

Write a macro that finds all assignments of all tasks with the name equal to the text1 field of the task and adds 20% more work than it already has.

TimeScaledData Method

The TimeScaledData method in Microsoft Project allows us to specify by day what work a resource will be doing.  This type of manipulation allows us to access regular work, actual work, and actual overtime work to name a few.  For a complete list of the timephased fields that can be accessed, please refer to the TimeScaleData Method in the Microsoft Project Visual Basic Help File.

The following macro shows how to modify the timephased work and actual work for a specific day:

Sub Macro8()

'The following line sets the Work field for task 1 to 4h on 1/15/98.

'If you don't include a label such as h for hours for Value ("4h" rather

'than "4") Project assumes minutes.

ActiveProject.Tasks(1).TimeScaleData(StartDate:="1/15/98 12:00 AM", _

EndDate:="1/16/98 12:00 AM", Type:=pjTaskTimescaledWork, _

TimeScaleUnit:=4, Count:=1).Item(1).Value = "4h"

'The following line sets the Actual Work field for task 1 to 4h on 1/15/98

ActiveProject.Tasks(1).TimeScaleData(StartDate:="1/15/98 12:00 AM", _

EndDate:="1/16/98 12:00 AM", Type:=pjTaskTimescaledActualWork, _

TimeScaleUnit:=4, Count:=1).Item(1).Value = "4h"

'The following line sets the Work field for the resource assigned to

'task 1 to 2h on 1/16/98

ActiveProject.Tasks(1).Assignments(1).TimeScaleData _

(StartDate:="1/16/98 12:00 AM", EndDate:="1/17/98 12:00 AM", _

Type:=pjAssignmentTimescaledWork, TimeScaleUnit:=4, Count:=1). _

Item(1).Value = "2"

'The following line sets the Actual Work field for the resource assigned to

'task 1 to 2h on 1/16/98

ActiveProject.Tasks(1).Assignments(1).TimeScaleData _

(StartDate:="1/16/98 12:00 AM", EndDate:="1/17/98 12:00 AM", _

Type:=pjAssignmentTimescaledActualWork, TimeScaleUnit:=4, Count:=1). _

Item(1).Value = "2"

End Sub

Lesson 3: Calendar, Selection and Window Objects

What You Will Learn 

After completing this lesson, you will be able to: 

· Manipulate the working calendar.

· Use Date arithmetic.

· Reference the active cell and task.

· Manipulate Windows inside Project.

Related Topics Covered in this Lesson 

· Period Method

· Weekday object

· Shifts

· Date Arithmetic.

· ActiveCell/ActiveSelection

· Window activating

Calendar Object

The Calendar object contains information about when work can take place during the project including the days and the times during the day that are available for work.  Additionally, each resource has its own calendar, which can contain information about differences, such as vacations, from the normal calendar.
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Period Method and Object

The easiest way to access information in a calendar is to use the Period method.  The Period method takes a range of dates and returns a Period object.  A Period object is like a collection of days except that you cannot iterate over the days in a Period.  For example, to specify Independence Day in the United States as a nonworking day, one could do:

ActiveProject.BaseCalendars("Standard").Period("7/4/94") _ 



.Working = False

Note that if the finish date of a range is not given, as in this example, the period returned is the one day.

The following example sets July 4th and July 5th as nonworking:

With ActiveProject.BaseCalendars("Standard")


.Period("7/4/94", "7/5/94").Working = False

End With

This method is very useful when the Year, Month, and Day objects cannot easily describe the range you want to work with.

Year, Month, Day Objects

A more object-oriented way of manipulating information in a calendar is to access the Year, Month and Day objects contained in the calendar.  With these objects and the collections, which contain them, one can perform more powerful operations on the calendar.

For Each y in ActiveProject.BaseCalendars("Standard").Years


y.Months(7).Days(4).Working = False

Next y

By using the objects, one can make the 4th of July a nonworking day every year.  To make the code a little more readable, one could instead specify the name of the month like:

For Each y in ActiveProject.Calendar.Years


y.Months("July").Days(4).Working = False

Next y

Weekday Objects

The final way of manipulating the calendar is to access the Weekday object.  Microsoft Project allows the user to specify a day of the week as a working day or as a day off.  This makes it easy to make a 4-day workweek instead of the standard Monday through Friday.

One could make all Fridays nonworking like:

ActiveProject.BaseCalendars("Standard").Weekdays(6).Working = False

To make the code more readable, as was done with the Month object, there are two choices.  One could use a defined constant:

ActiveProject.BaseCalendars("Standard").Weekdays(pjFriday) _ 



.Working = False

Or use the three character name of the day:

ActiveProject.BaseCalendars("Standard").Weekdays("Fri") _ 



.Working = False

Properties and Methods

The Period, Year, Month, Day, and Weekday objects share most of the same properties and methods.

The Working property that was used in the above examples sets whether or not work can occur on the range of the calendar specified by the object.

The Shift1, Shift2, and Shift3 properties return a Shift object that allows you to specify the Start and Finish time for a shift

The Default method applies to resource calendars.  It returns the object to the state of its associated Base Calendar.

An example, which uses more of these properties, would be one to make Fridays a half-day of work:

With ActiveProject.BaseCalendars("Standard").Weekdays("Fri")


.Working = True


.Shift1.Start = "8:00"


.Shift1.Finish = "12:00"


.Shift2.Clear


.Shift3.Clear

End With

Scheduling Methods

One of the most interesting set of methods exposed by Microsoft Project are those which give the macro writer access to scheduling capabilities.  Microsoft Project provides methods to add and subtract dates as well as display dates and  in different formats.

Date Arithmetic

By exposing date arithmetic methods in Microsoft Project, a realm of different macros are possible.  It also makes it possible to include Microsoft Project as a part of an integrated scheduling solution.  With these methods, a Solution Provider could use Microsoft Project as a scheduling engine by either entering the information into Microsoft Project, or by just using the date arithmetic methods directly.

DateAdd

The DateAdd method accepts a start date and duration and returns the finish date.  Optionally, you can specify a calendar to be used in the calculation.  If a calendar is not specified, then the project calendar is used.



x = Application.DateAdd(StartDate:="7/11/94 8:00 AM", _ Duration:="3d")

In this example, x would be 7/13/94 at 5:00pm, since a 3d activity beginning on July 11th at 8:00am would end at the end of July 13th.

DateSubtract

The DateSubtract method is the reciprocal of the DateAdd method.  It accepts a finish date and duration and returns the start date.  As with the DateAdd method, you can optionally specify a calendar.



x = Application.DateSubtract("7/13/94 5:00pm", "3d")

Being the complement of DateAdd, this example would return 7/11/94 at 8:00am.

DateDifference

The DateDifference method is related to both DateAdd and DateSubtract method.  It takes two dates and returns the duration between them.  Again, a calendar can be optionally specified.



x = Application.DateDifference("7/11/94 8:00am", "7/13/94 5:00pm")

Here, DateDifference would return 1440 minutes, which is 3 days.

Date Arithmetic Example

Using these methods, you can create a fairly simple macro which will adjust all of the dates in a project when your project start date slips:

Sub AdjustDates()


nCurDateFormat = Application.DefaultDateFormat


Application.DefaultDateFormat = pjDate_mm_dd_yy_hh_mmAM


sStartDate = ActiveProject.ProjectStart


sNewStartDate = InputBox(Prompt:="Enter New Start Date", Default:=sStartDate)


If sNewStartDate = "" Then End 'Canceled the InputBox


nDelta = application.DateDifference(sStartDate, sNewStartDate)


If nDelta = 0 Then



MsgBox "New start date must be greater than current start date."



End


End If


For Each t In ActiveProject.Tasks



If t.ConstraintDate <> "NA" Then



   Select Case t.ConstraintType



      Case pjMFO, pjFNLT, pjFNET



      ‘Finish Constraints are fine




   t.ConstraintDate = DateAdd(t.ConstraintDate, nDelta)




Case Else




'Start Constraints are problematic.




'8:00am + 1d gives 5:00pm.  Since we want 8:00am the




'next day, we add 1d+1m and then subtract the 1m




  t.ConstraintDate = DateAdd(t.ConstraintDate,nDelta + 1)




  t.ConstraintDate = DateSubtract(t.ConstraintDate, 1)



   End Select



End If


Next t


ActiveProject.ProjectStart = sNewStartDate


Application.DefaultDateFormat = intCurDateFormat

End Sub

Date & Duration Formatting

Related to the Date Arithmetic methods are some methods that allow you to display dates and durations in different formats.

DateFormat

DateFormat takes a date and a constant specifying the format in which you want the date to appear.  The available formats are the same as the default formats for displaying information in Microsoft Project.

MsgBox DateFormat("12/31/94", pjDate_mmmm_dd_yyyy)

This example would display ‘December 31, 1994’ in a dialog box.

DurationFormat

Similar to the DateFormat method, DurationFormat takes duration and a constant specifying the units in which you want the duration to appear.  The available units are minutes, hours, days, and weeks.

MsgBox DurationFormat("3d", pjWeeks)

This example would display ‘.6w’ in a dialog box.

DurationValue

Although the DurationValue method does not affect the formatting of duration, it is closely related to the DurationFormat method.  DurationValue take a string and returns the value of that string as duration.  Microsoft Project expresses durations in minutes, so 1 day = 8 hours = 480 minutes.



x = DurationValue("2d")

Here, x would be set to 960, which is the number of minutes in 2 days.

Because durations are expressed in minutes, you can add durations using normal arithmetic.  For example, the following code would add the entered duration to the selected task.

x = DurationValue(InputBox("Enter amount by which to increase _ duration"))

ActiveCell.Task.Duration = ActiveCell.Task.Duration + x

strTemp = "The new duration in weeks is "

strTemp = strTemp & DurationFormat(ActiveCell.Task.Duration, pjWeeks)

MsgBox strTemp

Exercise1:  (CalRangeSet)

Write a macro that schedules a Christmas break.  First prompt the user for a date range, and set those days in that range to nonworking on the base calendar.

Sub CalRangeSet()

  DRangeStart = InputBox("Enter the Start date of the break")

  DRangeFinish = InputBox("Enter the Finish date of the break")

  ActiveProject.BaseCalendars("Standard").Period(DRangeStart, DRangeFinish).Working = False

End Sub

Exercise2:  (CalTaskMove)

Write a macro that prompts the user for an amount of time (“3d”) and then creates a new task that starts that many days after the previous task. 

1. Sub CalTaskMove()

2.   Dim newTime As String

3.   newTime = InputBox("Enter the a duration")

4.   x = ActiveProject.Tasks(ActiveCell.Task.ID - 1).Start

5.   ActiveCell.Task.Start = DateAdd(x, newTime)

6. End Sub

Selection Objects

Even though Microsoft Project does not supply objects for all of the user interface elements in the product, selection of information is provided so that macro writers can manipulate information based on the users selection.

Theory

Microsoft Project supports two variations of the active selection: a Cell object accessible from the ActiveCell property of the Application, and a Selection object available through the ActiveSelection property of the Application.

Since Microsoft Project can be thought of more as a database with records and fields than a spreadsheet with rows and columns, both the Cell and Selection object provide information about the selected records (tasks or resources) and the selected fields.

Cell Object

The Cell object allows access to the active record and field in the selection.  This is sometimes a subset of the selection, if the selection contains more than one cell.
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To determine the record, the Cell object contains a Task and a Resource object.  This allows the macro writer to access all of the fields of the selected record.  For example:

MsgBox "You have task " & ActiveCell.Task.Name & " selected."

will display the name of the task regardless of the field selected.

There are occasions where a task will not be selected, for instance in a resource view.  In this case, ActiveCell.Task will return nothing.  So a more robust version of this example would be:

If Not (ActiveCell.Task Is Nothing) Then


MsgBox "You have task " & ActiveCell.Task.Name & " selected."

End If

To determine the field selected, the Cell object provides two properties.  The FieldName property contains the name of the field as a string.  So we could do:

If Not (ActiveCell.Task is Nothing) Then


strTemp = "You have the "


strTemp = strTemp &
ActiveCell.FieldName


strTemp = strTemp &
" field of "


strTemp = strTemp &
ActiveCell.Task.Name


strTemp = strTemp &
" selected."


MsgBox strTemp

End If

The FieldID property returns the ID number of the field that can be used with either the GetField or the SetField methods discussed earlier.

If Not (ActiveCell.Task is Nothing) Then


strTemp = InputBox("Enter value to be placed in the Active Cell")


ActiveCell.Task.SetField FieldID:=ActiveCell.FieldID, Value:=strTemp

End If

Selection Object

The Selection object is an extension of the Cell object.  Instead of the Task and Resource objects contained in the Cell object, the Selection object contains Tasks and Resources collections.  Similarly, in place of the FieldName and FieldID properties are FieldNameList and FieldIDList List collections.

With the Selection object one could implement a version of the Fill Down command found in Microsoft Project and Excel.

If Not (ActiveCell.Task is Nothing) Then


strTemp = InputBox("Enter value to be placed in all the cells in the same column as the active cell")


For Each t in ActiveSelection.Tasks



t.SetField FieldID:=ActiveCell.FieldID, Value:=strTemp


Next t

End If

Exercise

Write a macro that will increment a counter in a cell.  For example, if you type a 1 in a cell and select it plus cells below and then run the macro, you would end up with these cells being filled with 1, 2, 3, 4, 5.  See if you can also get it to work with text.  Ex. Phase1, Phase2, Phase3, etc. 

Window & Pane Objects

The Window and Pane objects offer a limited set of properties, but are useful when you want to manipulate some of the visual properties of your project windows.

A Window object provides a Close method, allowing you to close a window.  This is useful when you have multiple windows open for the same project.  This example closes the active window:

ActiveWindow.Close

To change the height of a window:

ActiveWindow.Height = 400

To change the state of the current window, use the WindowState property.  There are three states to choose from, pjMaximized, pjMinimized, and pjNormal.  To maximize the window use:

ActiveWindow.WindowState = pjMaximized

Project also allows control over each individual pane within the active window through the pane object.  To determine which pane is active in a window:

MsgBox ActiveWindow.ActivePane

This returns 1 for the top pane, and 2 for the bottom pane.

You can manipulate the panes in a window as objects directly:

ActiveWindow.TopPane.Activate

This activates the top pane.  You could also use the Application object property PaneNext that Activates the lower pane if the upper pane is active or activates the upper pane if the lower pane is active.

ActiveWindow.BottomPane.Close

This closes the bottom pane.

Another way to close the bottom pane is to use the Application objects PaneClose method.  This is the same as choosing remove split from the window menu.  If you want to split the screen, then use PaneCreate.
Lesson 4: View, Table and Filter Methods

What You Will Learn 

After completing this lesson, you will be able to: 

· Apply Views, Tables and Filters.

· Create and edit Views, Tables and Filters.

· Access lists of Tables, Views and Filters.
Related Topics Covered in this Lesson 

· ViewApply and ViewEdit

· TableApply and TableEdit

· FilterApply and FilterEdit

· ViewList, TableList, FilterList

Views Methods

The Views method is an Application Object method.  It is used for setting the view in the active window.  If you executed the Views method, it would simply bring up the More Views dialog box.  

In order to give the user more control, Project supplies the ViewApply method.  When used, the user must supply a valid name of a view.  In return, no dialog box will be displayed.

ViewApply “Gantt Chart”

If you would like to create a new or edit an existing view, you should use the ViewEditSingle method or the ViewEditCombination method.  These methods allow full customization of the views.  The following syntax is available for macro commands 

ViewEditSingle([Name], [Create], [NewName], [Screen], [ShowInMenu], [HighlightFilter], [Table], [Filter])

Name
Optional String. The name of a single-pane view to edit, create, or copy. The default is the name of the active view.

Create
Optional Boolean. True if Microsoft Project should create a new single-pane view. If NewName is Empty, the new view is given the name specified with Name. Otherwise, the new view is a copy of the view specified with Name and is given the name specified with NewName. The default value is False.

NewName
Optional String. A new name for the view specified with Name (Create is False) or a name for the new view just created (Create is True). If NewName is Empty and Create is False, the view specified with Name retains its current name. The default value is False.

Screen
Optional Long. A constant specifying the view to display. The default value is pjGantt. Can be one of the following PjScreen constants:

pjCalendar


pjResourceUsage

pjGantt


pjTaskDetailsForm

pjPERT


pjTaskForm

pjResourceForm

pjTaskNameForm

pjResourceGraph

pjTaskPERT

pjResourceNameForm
pjTaskSheet

pjResourceSheet


ShowInMenu
Optional Boolean. True if the view name appears on the View menu. The default value is False.

HighlightFilter
Optional Boolean. True if Microsoft Project should highlight filtered items. The default value is False.

Table
Optional String. The name of a table to display in the view. Required for a new view.

Filter
Optional String. The name of a filter to apply to the view. Required for a new view.

ViewEditCombination([Name], [Create], [NewName], [TopView], [BottomView], [ShowInMenu])

Name
Optional String. The name of a two-pane view to edit, create, or copy. The default is the name of the active view.

Create
Optional Boolean. True if Microsoft Project should create a new two-pane view. If NewName is Empty, the new view is given the name specified with Name. Otherwise, the new view is a copy of the view specified with Name and is given the name specified with NewName. The default value is False.

NewName
Optional String. A new name for the view specified with Name (Create is False) or a name for the new view just created (Create is True). If NewName is Empty and Create is False, the view specified with Name retains its current name. The default value is False.

TopView
Optional String. The name of the view to display in the upper pane. The view specified by Name will display in the lower pane.

BottomView
Optional String. The name of the view to display in the lower pane. The view specified by Name will display in the upper pane.

ShowInMenu
Optional Boolean. True if the view name appears on the View menu. The default value is False.

The ViewList method is used to return a view name or a list of all views currently defined in the project.

For Each t In ActiveProject.ViewList

MsgBox t

Next t

Exercise1

Write a macro that creates and applies a split screen view with a Task Sheet on top and a Task Form on the bottom formatted to show Resource Cost. (**Do not use the macro recorder)

Tables Methods

The Tables method is another Application Object method.  It is used for setting the active pane in the active window.  If you executed the Tables method, it would simply bring up the More Table dialog box.  

In order to give the user more control, Project supplies the TableApply method.  When used, the user must supply a valid name of a table.  In return, no dialog box will be displayed.

TableApply “Tracking”

If you would like to create a new or edit an existing table, you should use the TableEdit method.  This method allows full customization of 15 options in a table.  The following macro command will create a new table called Flags containing task information and does not appear in the menu.

TableEdit name := "Flags", taskTable := True, create := True, _ 


fieldName := "Priority", showInMenu := False

The TaskTableList and ResourceTableList methods are used to return a task or resource table name or a list of all task or resource tables currently defined in the project.

For Each t In ActiveProject.TaskTableList

MsgBox t

Next t

Exercise1

Using the list of customizable options for a table, listed in online help, write a macro that creates a new table containing fields: ID, Name, Actual Start, and Actual Finish.  Do not use the macro recorder.  (Hint:  A new TableEdit line is necessary for each field you add)

Filter Methods

The Filters method is another Application Object method.  It is used for setting the filter of the active pane in the active window.  If you made a call to the Filters method it would simply bring up the More Filters dialog box.  

In order to give the user more control, Project supplies the FilterApply method.  When used, the user must supply a valid name of a filter.  In return, no dialog box will be displayed.

FilterApply “Milestones”

If you would like to create a new or edit an existing Filter, you should use the FilterEdit method.  This method allows full customization of 12 options in a filter.  The following example creates a filter for tasks with the highest priority (if one doesn't exist), and then applies the filter.

Sub CreateAndApplyHighestPriorityFilter()


Dim TaskName
' Index for For Each loop


Dim Found

' Whether or not the filter exists.


Found = False
' Assume the filter doesn't exist.


For Each TaskName In ActiveProject.TaskFilterList



If TaskName = "Highest Priority" Then




Found = True




Exit For



End If


Next TaskName


' If filter doesn't exist, create it.


If Not Found Then FilterEdit Name:="Highest Priority", _ 



create:=True, taskFilter:=True, _



FieldName:="Priority", _ 



test:="equals", value:="Highest"


' Apply the filter.


FilterApply "Highest Priority"

End Sub

The TaskFilterList and ResourceFilterList methods are used to return a task or resource filter name or a list of all task or resource filters currently defined in the project.

For Each t In ActiveProject.TaskFilterList


MsgBox t

Next t

Exercise1

Using the list of customizable options for a filter, listed in online help, write a macro that creates a new interactive filter that will prompt the user to enter a beginning ID and an Ending ID, then displays only milestones in that range.  Do not use the macro recorder.  (Hint:  A new FilterEdit line is necessary for each row you add)

Lesson 5: Sorting and Multiple Projects

What You Will Learn 

After completing this lesson, you will be able to: 

· Sort

· Consolidate Projects

· Share Resources

Related Topics Covered in this Lesson 

· Sorting

· Consolidation

· Resource Sharing

Sort Method

The Sort Method allows the user to sort the tasks or resources in the active pane.  The user supplies the keys and direction, either ascending or descending

Sort Key1:=“Priority”, ascending1:=True, Key2:=“Start”, _ 



ascending2:=False, renumber:=false, outline:=False

Multiple Projects

Consolidation

The ConsolidateProjects Method allows the user to consolidate many projects together into one.  The syntax is:

ConsolidateProjects Filenames, NewWindow, AttachToSources,


PoolResources, HideSubtasks

Filenames is a listing of the different files you want to consolidate.  

FewWindow specifies whether to create a new window for the projects you specify with the filenames argument.

AttachToSources specifies whether changes in the consolidated project affect source projects.

PoolResources Due to changes in the object model of Microsoft Project, this argument is ignored. It is retained so that existing macros that make use of this argument do not cause errors.

HideSubtasks specifies whether to hide the subtasks of the projects you specify with the filenames argument.

The following example creates a consolidated project, prints a report, and closes the consolidated project without saving it.

Sub ConsolidatedReport()


ConsolidateProjects Filenames := "project1.mpp,project2.mpp"


ReportPrint Name:="Critical Tasks"


FileClose save := pjDoNotSave

End Sub

Resource Sharing

The ResourceSharing Method allows Control over resource sharing.  It takes three arguments.

object.ResourceSharing share, name, pool

Share specifies whether to share resources.

Name specifies the filename of the resource pool.

Pool specifies whether resources in the pool take precedence over resources in the local project.

The following line of code sets the active project to use resources from a file called “Pool.mpp”

ResourceSharing share:=True, name:=“Pool.mpp”

The ResourceSharingPoolAction Method performs specific actions on a resource pool.

ResourceSharingPoolAction action, fileName, readOnly

By setting the action parameter it will do 1 of 5 actions: Causes the resource pool to take precedence over the sharers.  Causes the sharers to take precedence over the resource pool.  Opens the sharer (the file specified with the fileName argument).  Opens all sharers into a consolidated project or Unlinks the sharer from the resource pool. (The sharer is specified with the fileName argument.)

A property that can be useful is the resourcePoolName property.  It simply returns the filename of the resource pool used by a project.  If it is not using a resource pool it returns the name of the project.

MsgBox ActiveProject.ResourcePoolName
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Lesson 5: UserForm Basics

What You Will Learn

After completing this lesson, you will be able to:

· Design and Run Custom Dialog Boxes using the Office 97 UserForm.

· Define and create UserForm Events and demonstrate their use.

· Customize the UserForm ToolBox.

Related Topics Covered in this Lesson

· The Forms Object Model Overview

· The UserForm ToolBar

· Where to find UserForm Help files and the Object Browser.

Recommended Reading

· The Forms Design Reference in the Help file.

· The Forms Developer’s Tips in the Help file.

· Application Note WE1163, Visual Basic for Applications Examples for Controlling UserForms

Overview

UserForms are custom dialog boxes that allow the user to communicate with a custom Office 97 application. These dialog boxes can be created in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98,  or Microsoft Word.

Access users can insert the same Active-X controls into Access Forms, however, as they do not use the Office UserForm we will not be covering Access in this Triage.

In this lesson we will present the organization of UserForms using the Forms Object Model, define the Seven Steps for Creating UserForms, and describe the UserForms Tools available in the Visual Basic Environment.

The Microsoft Forms Object Model

There are 4 Objects, 3 Collections, 29 Events, 28 Methods, 134 Properties, and 14 Controls (15 in Microsoft Excel)  associated with UserForms.

Not all of the Events, Methods and Properties will be discussed in this Triage. For a complete list and details pertaining to these items, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Contents Tab – Microsoft Forms Object Model Reference.
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The Microsoft Forms Object Model

The Microsoft Forms Object Model includes the following types of Objects:

· Controls

· Collections

· Objects (within collections)

Each element of the Forms Object Model has some combination of Properties, Events, and Methods.

Microsoft Forms has three collections: 

· Controls Collection - contains all the controls on a Form, Frame, or Page. 

· Pages Collection - contains all the Page objects in a MultiPage. Each MultiPage has its own distinct Pages Collection.

· Tabs Collection - contains all the Tab objects in a TabStrip. Each TabStrip has its own distinct Tabs Collection.

Objects & Collections

For a complete list and details pertaining to UserForm Objects and Collections, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Contents Tab – Microsoft Forms Object Model Reference – Objects/Collections.
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Controls Collection

Includes all the Controls contained in an Object. Each Control in the Controls Collection of an Object has a unique Index whose value can be either an integer or a string.

The Index Value for the first Control in a Collection is 0; the value for the second Control is 1, and so on. This value indicates the order in which controls were added to the Collection. 

If the Index is a string, it represents the Name of the Control. The Name Property of a Control also specifies a control's Name.

You can use the Controls Collection to enumerate or count individual Controls, and to set their properties. For example, you can enumerate the Controls collection of a particular form and set the Height property of each control to a specified value. Note  The For Each...Next statement is useful for enumerating a Collection.

The 15 Controls available in Office 97 UserForms will be discussed in detail in Lesson 2.
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Font Object

Defines the characteristics of the text used by a control or form. Each control or form has its own Font object to let you set its text characteristics independently of the characteristics defined for other controls and forms.

Use Font Properties to specify the Font Name, to set Bold or Underlined text, or to adjust the size of the text.

The Font Properties of your form or container determine the default Font Attributes of controls you put on the form. The default property for the Font Object is the Name Property. If the Name Property contains a null string, the Font Object uses the default System Font.
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Page Object

A Page is one page of a MultiPage and a single member of a Pages Collection. Each Page object contains its own set of controls and does not necessarily rely on other pages in the collection for information.

A Page inherits some properties from its container; the container sets the value of each inherited property.

A Page has a unique Name and Index Value within a Pages Collection. You can reference a Page by either its Name or its Index Value. The Index of the first Page in a Collection is 0; the Index of the second Page is 1; and so on.

When two Page objects have the same Name, you must reference each Page by its Index Value. References to the Name in code will access only the first Page that uses the Name.

The default Name for the first Page is Page1; the default Name for the second Page is Page2.

Pages Collection

A Pages Collection includes all the Pages of a MultiPage. Each Pages Collection provides the features to manage the number of Pages in the Collection and to identify the Page that is currently in use.

A Page Object has a unique Name and Index Value within a Pages Collection. You can reference a Page either by its Name or its Index Value. The Index of the first Page in a Collection is 0; the Index of the second Page is 1; and so on. The default Name for the first Page is Page1; the default Name for the second Page is Page2. The default Value of a Pages Collection identifies the current Page of a Collection.
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Tab Object

A Tab is an individual member of a Tabs collection. Visually, a Tab Object appears as a rectangle protruding from a larger rectangular area or as a button adjacent to a rectangular area. 

In contrast to a Page, a Tab does not contain any controls. Controls that appear within the region bounded by a TabStrip are contained on the form, as is the TabStrip. 

Each Tab has its own set of Properties, but has no Methods or Events. You must use Events from the appropriate TabStrip to initiate processing of an individual Tab. 

Each Tab has a unique Name and Index Value within the Collection. You can reference a Tab by either its Name or its Index Value. The Index of the first Tab is 0; the Index of the second Tab is 1; and so on.

When two Tab Objects have the same Name, you must reference each Tab by its Index Value. References to the Name in code will access only the first Tab that uses the Name.

Tabs Collection

A Tabs Collection includes all Tabs of a TabStrip. Each Tabs Collection provides the features to manage the number of Tabs in the Collection and to identify the Tab that is currently in use. The default value of the Tabs collection identifies the current Tab of a Collection.

A Tab object has a unique Name and Index Value within a Tabs Collection. You can reference a Tab either by its Name or its Index Value. The Index Value reflects the ordinal position of the Tab within the Collection. The Index of the first Tab in a Collection is 0; the Index of the second Tab is 1; and so on.
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DataObject Object

A holding area for formatted text data used in transfer operations. Also holds a list of formats corresponding to the pieces of text stored in the DataObject.

A DataObject can contain one piece of text for the Clipboard text format, and one piece of text for each additional text format, such as custom and user-defined formats. 

A DataObject is distinct from the Clipboard. A DataObject supports commands that involve the Clipboard and drag-and-drop actions for text. When you start an operation involving the Clipboard (such as GetText) or a drag-and-drop operation, the data involved in that operation is moved to a DataObject. 

The DataObject works like the Clipboard. If you copy a text string to a DataObject, the DataObject stores the text string.

If you copy a second string of the same format to the DataObject, the DataObject discards the first text string and stores a copy of the second string. It stores one piece of text of a specified format and keeps the text from the most recent operation.

Properties

Properties are the attributes of an item. For example, you might want to use the Text Property to retrieve or insert text in a TextBox, ListBox or ComboBox.

A specific Property can be one attribute for one Control and a significantly different attribute for another Control. For example, The Value Property for a TextBox is the text in the edit region, for a ListBox it’s the Bound Column of the currently selected row, for the ScrollBar its an integer between the values of the Min and Max Properties, and for the CommandButton its always set to false.

Properties can apply to Objects, Collections and Controls. For a list of the 134 Properties available to Office 97 UserForms, see Properties Summary in the Appendix.

For complete details pertaining to Office 97 UserForm Properties, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Contents Tab – Microsoft Forms Object Model Reference – Properties or the Object Browser.

Methods

Methods are the actions you can take within a macro to accomplish a task such as Copy data from the Clipboard to a Text Box. Methods can apply to Objects, Collections and Controls. For a list of the 28 Methods available to Office 97 UserForms, see Methods Summary in the Appendix.

For complete details pertaining to Office 97 UserForm Methods, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Contents Tab – Microsoft Forms Object Model Reference – Methods or the Object Browser.

Events

Events are conditions under which Office has the capability to run a specifically named user written macro. For example, a Click Event occurs when a user clicks his mouse on an Object that can detect the mouse click.

Events can be detected by UserForm Objects and by specific Controls. For a list of the 29 Events available to Office 97 UserForms, see Events Summary in the Appendix.

For complete details pertaining to Office 97 UserForm Events, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Contents Tab – Microsoft Forms Object Model Reference – Events or the Object Browser.

Creating a Custom Dialog Box

There are seven steps to consider when creating a custom dialog box using UserForms. The steps are summarized here and will be defined in more detail later. Use the following procedure to create a custom dialog box:

1. Create a UserForm: On the Insert menu in the Visual Basic Editor, click UserForm.

2. Add Controls to the UserForm: Find the control you want to add in the Toolbox and drag the control onto the form.

3. Set Control Properties: Right-click a control in design mode and click Properties to display the Properties window.

4. Initialize the Controls: You can initialize controls in a procedure before you show a form, or you can add code to the Initialize event of the form.

5. Write Event Procedures: All controls have a predefined set of events. For example, a command button has a Click event that occurs when the user clicks the command button. You can write event procedures that run when the events occur.

6. Show the Dialog Box: Use the Show method to display a UserForm.

7. Use Control Values While Code is Running: Some properties can be set at run time. Changes made to the dialog box by the user are lost when the dialog box is closed.
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Q164815 VBA – How to Create and Display a Custom Dialog Box

This article contains step by step instructions for creating and displaying a Visual Basic for Applications custom dialog box (or "User Form").

1. Create a UserForm

To create a custom dialog box, you must create a UserForm. To create a UserForm, click UserForm on the Insert Menu in the Visual Basic Editor.
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Project Window

The new UserForm is added to the Project Window. The Project Explorer displays a hierarchical list of the projects and all of the items contained and referenced by each project. If the Project Window is not visible, use Project Explorer item on the View Menu to display it

With the Project Window open, you can select an item from the collapsible tree in the List window. You can then:

· Click the View Code Button to open the Code window to begin entering code.

· Click the View Object Button to open a window containing the specified object.

· Click the Toggle Folders Button to toggle between folder view and folder contents view.
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UserForm Window

The UserForm Window allows you to create the windows or dialog boxes in your project. You draw and view controls on a form. While you are designing a form:

· Each form window has a Maximize, Minimize, and Close button.

· You can view the form grid and determine the size of the gridlines from the General tab of the Options dialog box.

· Use the buttons in the Toolbox to draw controls on the form.  You can set your controls to align with the grid of your form from the General Tab of the Options dialog box.
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Properties Window

The Properties Window lists the design-time properties for selected objects and their current settings. You can change these properties at design time. When you select multiple controls, the Properties window contains a list of the properties common to all the selected controls.

Use the Properties window to change the name, behavior, and appearance of the form. For example, to change the caption on a form, set the Caption Property. If the Properties Window is not visible, use Properties Window item on the View Menu to display it 

Properties Window Elements

Object Box

Lists the currently selected object. Only objects from the active form are visible. If you select multiple objects, the properties common to the objects and their settings, based on the first object selected, appear on the Properties List tabs.

Properties List Tabs

Alphabetic Tab — Alphabetically lists all properties for the selected object that can be changed at design time, as well as their current settings.

You can change the property setting by selecting the property name and typing or selecting the new setting.

Categorized Tab — Lists all properties for the selected object by category. For example, BackColor, Caption, and ForeColor are in the Appearance category.

You can collapse the list so that you see the categories or you can expand a category to see the properties. When you expand or collapse the list, you see a plus (+) icon or minus (-) icon to the left of the category name.

2. Add Controls to the UserForm

The Toolbox is used to add controls to the UserForm. Find the control you want to add in the Toolbox, drag the control onto the form, and then drag an adjustment handle on the control until the control's outline is the size and shape you want.

If the Toolbox dialog box is not visible, use Toolbox item on the View Menu to display it 
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Toolbox

The lower left-hand control, RefEdit, is included with Microsoft Excel 97 by default, but not with Microsoft Project, Microsoft PowerPoint, Microsoft Project 98 or Microsoft Word.

In Lesson 2 we’ll review how to use each of the controls shown here. In the section on UserForm Tools and Techniques, we’ll review how to add additional Active-X controls to the Toolbox.

Note   Dragging a control (or a number of "grouped" controls) from the form back to the Toolbox creates a template of that control, which can be reused. This is a useful feature for implementing a standard "look and feel" for your applications and will be reviewed in the section on UserForm Tools and Techniques.

When you've added controls to the form, use the commands on the Format menu in the Visual Basic Editor (or the UserForm Toolbar) to adjust the control alignment and spacing.

3. Set Control Properties

You can set some control properties at design time (before any macro is running). In design mode, right-click a control and click Properties to display the Properties Window (see above). Property names are shown in the left column in the window, property values in the right column.

You set a property value by entering the new value to the right of the property name. For a complete list of UserForm Properties, see the Appendix at the end of this Triage.

4. Initialize the Controls

You can initialize controls at run time by using Visual Basic code in a macro. For example, you could fill a list box, set text values, or set option buttons.
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Initialize List Box from Module Example

The SetupUserForm macro, written in a Module, uses the AddItem Method to add data to the existing list box control (ListBox1) on UserForm1. It then displays the form using the Show Method.

Private Sub SetupUserForm1()

   With UserForm1

      .ListBox1.AddItem "North"

      .ListBox1.AddItem "South"

      .ListBox1.AddItem "East"

      .ListBox1.AddItem "West"

      .Show

   End With

End Sub

You can also use code in the Initialize Event of a UserForm to set initial values for controls on the form. An advantage to setting initial control values in the Initialize Event is that the initialization code stays with the form.

You can copy the form to another project, and when you run the Show method to display the dialog box, the controls will be initialized.
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Initialize List Box from UserForm with Initialize Event Example

Displaying a UserForm will cause an Initialize Event. The UserForm Initialize event macro, written in UserForm1, uses the AddItem Method to add data to the existing list box control (ListBox1) on UserForm1.

The List Box on the UserForm is initialized as a result of the UserForm being displayed by using the Show Method in another macro, or perhaps, by pressing F5 while the UserForm is selected in the Visual Basic Editor.

Private Sub UserForm_Initialize()

   UserForm1.ListBox1.AddItem "Test One"

   UserForm1.ListBox1.AddItem "Test Two"

End Sub

5. Write Event Procedures

An event is an action recognized by an object, such as clicking the mouse or pressing a key, and for which you can write code to respond. Events can occur as a result of a user action or program code, or they can be triggered by the system.

After you have added controls to your dialog box or document, you add event procedures to determine how the controls respond to user actions. UserForms and controls have a predefined set of events.

For example, a command button has a Click event that occurs when the user clicks the command button, and UserForms have an Initialize event that runs when the form is loaded.

To write a control or form event procedure, open a module by double-clicking the form or control, and select the event from the Procedure drop-down list box.
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Selecting the CommandButton1 Click Macro

In this example, we double-clicked on Command Button 1 and selected the “Click” event. The Visual Basic Editor automatically inserted “Private Sub CommandButton1_Click()” and “End Sub” in the code window.

Event procedures include the name of the control. For example, the name of the Click event procedure for a command button named BudgetReport1 is BudgetReport1_Click.

If you add code to an event procedure and then change the name of the control, your code remains in procedures with the previous name.

For example, assume you add code to the Click event for CommmandButton1 and then rename the control to CommandButton2. When you double-click CommandButton2, you will not see any code in the Click event procedure. You will need to move code from CommandButton1_Click to CommandButton2_Click.

To simplify development, it is a good practice to name your controls correctly before writing code.

6. Show the Dialog Box

To test your dialog box in the Visual Basic Editor, click Run Sub/UserForm on the Run Menu in the Visual Basic Editor. To display a dialog box from a macro in a Visual Basic Module, use the Show Method.

Show the UserForm Example

The DisplayUserForm macro uses the Show Method to display the dialog box named UserForm1.

Private Sub DisplayUserForm()

   UserForm1.Show

End Sub

It is possible to load a UserForm into memory without actually displaying it. It may take a complex UserForm several seconds to appear.

The ability to pre-load a UserForm into memory allows you to decide when to incur this overhead. To load UserForm1 into memory without displaying it, use the following code:

Load UserForm1

To display the UserForm, you must use the Show Method as shown previously.
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Q161521 Microsoft Excel – How to Move Between Custom UserForms with CommandButtons
When you create a project with multiple UserForms, you can use CommandButtons to move between the UserForms. This article explains how to create two UserForms and includes a sample macro that moves between the UserForms.

Temporarily Hiding a UserForm

If you want to temporarily hide a UserForm, use the Hide Method. You may want to hide a UserForm if your application involves moving between UserForms. To hide a UserForm, use the following code:

UserForm1.Hide

Dismissing a UserForm

To remove a UserForm from memory, use the Unload Statement. To unload a UserForm named UserForm1, use the following code:

Unload UserForm1

If you are unloading a UserForm in an event procedure associated with the UserForm or a control on a UserForm (for example, clicking a CommandButton control), you can use the Me Keyword instead of the name of the UserForm.

To use the Me Keyword to unload a UserForm, use the following code:

Unload Me

7. Use Control Values While Code is Running

Some control properties can be set and returned while Visual Basic code is running. The following example sets the Text Property of a text box to "Hello."

TextBox1.Text = "Hello"

If you return the values of controls on a UserForm after the form has been unloaded, you get the initial values for the controls rather than the values the user entered.

If you want to save the data entered on a UserForm, you can save the information to module-level variables while the form is still running. 

Using UserForm Events

UserForm Events are changes in conditions which can be detected (trapped) by Office 97 UserForm Objects.

If you attach a Visual Basic for Applications procedure (macro) to an Event that the UserForm Object supports, it will run the macro upon detection of the Event.

For example, a Click Event occurs when a user clicks his mouse on an Object in the UserForm. If there is a macro attached to the Click Event for this Object, the Event is “trapped” and the macro is run whenever the Click Event occurs.

A single action performed by a user can initiate multiple events.

For example, when a user clicks his mouse on an Object, the MouseDown, MouseUp and Click Events all occur. A particular Object might not detect all three Events and macros are not necessarily created for all three events even if they are detected by the Object.

Among the most commonly used events for a UserForm are the Initialize, Click, and Terminate Events.

A Visual Basic module that contains an Event Procedure (macro) may be called a module "behind" the UserForm. A module that contains Event Procedures is not visible in the Modules Collection of the Project Explorer window of the Visual Basic Editor.

You must double-click the body of a UserForm to view the UserForm Code module.

Trapping UserForm Events

The following steps show you how to use several UserForm Events:

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98 or Microsoft Word.

2. On the Tools menu, point to Macro, and then click Visual Basic Editor.

3. Click UserForm on the Insert Menu to insert a UserForm into your file.

4. Double-click the UserForm to display the Code Window for the UserForm.

5. In the module, type the following 5 procedures.

6. Run the UserForm.

Initialize Event Example

Displaying a UserForm will cause an Initialize Event. The UserForm Initialize event macro changes the Caption Property of the UserForm to "Events Events Events!" and the BackColor Property to dark blue.

Private Sub UserForm_Initialize()

Me.Caption = "Events Events Events!"

Me.BackColor = RGB(10, 25, 100)

End Sub

Click Event Example

Clicking on a UserForm will cause a Click Event. The UserForm Click event macro resizes the UserForm. Because you created a procedure for the Resize Event (below), you receive two message boxes as a result of clicking the UserForm.

The Resize Event occurs twice because the code behind the Click Event changes both the Width and the Height Properties of the UserForm. 

Private Sub UserForm_Click()

Me.Height = Int(Rnd * 500)

Me.Width = Int(Rnd * 750)

End Sub

Resize Event Example

See notes for the Click Event above. Changing the size of a UserForm will cause a Resize Event. The UserForm Resize event macro uses the Width and Height Properties to obtain the width and height settings for the UserForm and displays them in a Message Box.

Private Sub UserForm_Resize()

msg = "Width: " & Me.Width & Chr(10) & "Height: " _

    & Me.Height

MsgBox prompt:=msg, Title:="Resize Event"

End Sub

QueryClose Event Example

Closing a UserForm will cause a QueryClose Event. The UserForm QueryClose event macro displays a message box with the caption (Caption Property) you gave the UserForm in the code for the Initialize Event.

The QueryClose Events are useful when you want to perform a certain set of actions when the UserForm is closed by the user. 

Private Sub UserForm_QueryClose(Cancel As Integer, _

    CloseMode As Integer)

msg = "Now Unloading " & Me.Caption

MsgBox prompt:=msg, Title:="QueryClose Event"

End Sub

Terminate Event Example

Closing a UserForm will cause a Terminate Event to follow the QueryClose Event and the removal of the UserForm from memory.

The UserForm Terminate event macro generates a message box which states that the caption (Caption Property) of the UserForm is UserForm1.

The Caption Property is no longer “Events, Events, Events” because the UserForm has been removed from memory and the caption of the UserForm has returned back to its original value. As you may recall, UserForm attributes that have been changed during usage are not preserved.

Private Sub UserForm_Terminate()

msg = "Now Unloading " & Me.Caption

MsgBox prompt:=msg, Title:="Terminate Event"

End Sub

Preventing a UserForm from Being Dismissed with the Close Button

When you run a UserForm, a Close Button is added to the upper-right corner of the UserForm Window. If you want to prevent the UserForm from being closed with the Close Button, you must trap the QueryClose Event.

The QueryClose Event occurs just before the UserForm is unloaded from memory. Use the CloseMode Argument of the QueryClose Event to determine how the UserForm is being closed.

A value of vbFormControlMenu for the CloseMode Argument indicates that the Close Button was clicked. To keep the UserForm active, set the Cancel Argument of the QueryClose Event to True.

The following steps show you how to use the QueryClose Event to prevent a UserForm from being dismissed with the Close Button:

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert Menu.

4. Draw a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).

5. Double-click the UserForm to display the Code window for the UserForm.

6. In the module, type the following code:

7. Run the UserForm.

Prevent UserForm Dismissal with Close Button Example

Clicking on a Command Button will cause a Click Event. The CommandButton1 Click event macro unloads the UserForm from memory using the Unload Statement with the Me Keyword.

Private Sub CommandButton1_Click()

Unload Me

End Sub

The QueryClose Event occurs if the user clicks on the UserForm’s Close Button or as a result of the “Unload Me” in the Click Event macro.

The UserForm QueryClose event macro tests to see if the CloseMode Argument = vbFormControlMenu and if so, sets the Cancel Property to True, stopping the closing process. The Caption Property is then changed.

As a result, the UserForm is not dismissed when you click the Close Button. You must click the CommandButton Control to dismiss (unload) the UserForm.

Private Sub UserForm_QueryClose(Cancel As Integer, CloseMode As Integer)

IF CloseMode = vbFormControlMenu Then

    Cancel = True

    Me.Caption = "Click the CommandButton to close Me!"

End If

End Sub

UserForm Tools

UserForm Toolbar

Available on the View Menu - View - UserForm, this toolbar contains buttons that are shortcuts to some commonly used menu items that are useful for working with forms. Most items on the toolbar are grayed-out unless you have selected multiple controls on your UserForm.
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UserForm and UserForm Toolbar

You can click a toolbar button once to carry out the action represented by that button. You can select the Show ToolTips option in the General tab of the Options dialog box if you want to display ToolTips for the toolbar buttons. 

Toolbar Buttons

The first four buttons are:

· Bring to Front - Moves the selected objects to the front of all other objects on a form.

· Send To Back - Moves the selected objects behind all other objects on a form.

· Group - Creates a group of the selected objects.

· Ungroup - Ungroups a previously grouped set of objects.
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The next button is a MRU Popup used to Align the controls and contains the following items:

· Lefts - Aligns the horizontal position of the selected objects, putting the left-most edges in line.

· Centers - Aligns the horizontal position of the selected objects, putting the centers in line.

· Rights - Aligns the horizontal position of the selected objects, putting the right-most edges in line.

· Tops - Aligns the vertical position of the selected objects, putting the tops in line.

· Middles - Aligns the vertical position of selected objects, putting the middles in line.

· Bottoms - Aligns the vertical position of the selected objects, putting the bottoms in line.

· to Grid - Aligns the top left of the selected object to the closest grid. The object is not resized.
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The next button is a MRU Popup used to Center the controls and contains the following items:

· Horizontally - Centers the selected objects horizontally.

· Vertically - Centers the selected objects vertically.
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The next button is a MRU Popup used to “Make Same Size” the controls and contains the following items

· Width - Adjusts width.

· Height - Adjusts height.

· Both - Adjusts both the width and the height.

The last control on the UserForm Toolbar is Zoom, which reduces or enlarges the display of all controls on the UserForm. You can set any magnification between 10 and 400 percent.
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UserForm Toolbox

The Toolbox is used to add controls to the UserForm. Find the control you want to add in the Toolbox, drag the control onto the form, and then drag an adjustment handle on the control until the control's outline is the size and shape you want.

If the Toolbox dialog box is not visible, use Toolbox item on the View Menu to display it 

To add a control to a form

Use any of the following methods to add a control from the Toolbox to your form. You can also use these methods to insert a control in a Frame, TabStrip, or MultiPage on the form.

· Click a control in the Toolbox and then click in the form. The control appears in its default size. You can then drag the control to change its size.

· Drag a control from the Toolbox to the form. The control appears in its default size.

· Double-click the control in the Toolbox, and then click in the form once for each control you want to create. For example, to create four command buttons, double-click the CommandButton in the Toolbox and then click four times in the form.
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To add a control to the Toolbox

Alternate-click any control icon in the Toolbox, or an empty area on any page of the Toolbox.
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From the shortcut menu, select Additional Controls.
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From the Available Controls list, select the new controls and click OK.

You now have the new Active-X control, Calendar in this case, in your Toolbox. The RefEdit Control, which comes with Microsoft Excel 97, is the only control outside of the 15 Microsoft Forms 2.0 Controls that come with Office 97 that we will discuss.

To add a customized control to the Toolbox
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Place a control on your form and customize it. For example, to create an OK button, place a CommandButton on the form, set its Caption property to OK and set its Default property to True.
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Select the customized control and drag the control to the Toolbox.

When you drag a control onto the Toolbox, you only transfer property values. Any code you have written for that control does not transfer with the control. You must write new code for the icon or copy code from the control on the form to the control on the Toolbox.

To customize a Toolbox icon
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Alternate-click the icon in the Toolbox and choose Customize from the shortcut menu.
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To change the ToolTip, enter the new text for the ToolTip.
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To edit the icon, choose Edit Picture. Then choose the color you want to use and choose the pixel in the image where you want to apply that color.

To assign a new bitmap, choose Load Picture. Then identify the file that contains the bitmap you want to use as the icon. If you attempt to load a picture that is larger than an icon, an error occurs. 

To Create a Control Template

If you frequently use a group of controls together, you can customize the Toolbox by creating a Control Template that quickly adds your group of controls to a UserForm.

For example, if you often create a form that has two command buttons and several text boxes in a particular layout, you can create a control template that includes these controls. When you create a new form, you can use the control template to add the same set of controls in the same layout.

To add a control template to the UserForm Toolbox:
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Select a group of controls on a form.
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Drag the controls to the Toolbox.
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Right-click the Control Template, and then click Customize New Group to assign ToolTip text for the control template.

To create a new Toolbox page
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Alternate-click the tab of any Toolbox page. The new page will be inserted after this page. Choose New Page.

See the Help file for the other things you can do with a Toolbox Page, such as:

· Change the Page Order, Name and ToolTip

· Import and Export Pages

· Move and Copy Controls Between Pages

· Delete Pages

Where to find Help on UserForm Topics

Help for UserForm topics can be located in the Visual Basic Editor by selecting the Help Menu, Contents and Index menu item.

Topic
Help File Location

Designing UserForms
Microsoft Forms Design Reference

Microsoft Forms Developer’s Tips

UserForm Window
Visual Basic User Interface Help – Windows

UserForm Window Keys
Visual Basic User Interface Help – Keys

UserForm Toolbar
Visual Basic User Interface Help – Toolbars

UserForm Objects, Methods, Properties, Controls, Events, Collections
Microsoft Forms Object Model Reference

Visual Basic Objects, Methods, Properties, etc.
Visual Basic Language Reference

Object Browser
Visual Basic User Interface Help – Miscellaneous

How to use the Object Browser
Visual Basic How-To Topics

Where to Find Information on Properties, Methods and Events

A list of the Properties, Methods, and Events for a Control are available in the Object Browser. To find this information, switch to the Visual Basic Editor (press alt+f11), click Object Browser on the View menu (or press f2), select the MSForms Library, type the name of the control in the search text box, and then press enter or click Search. The selected item should be highlighted under “Classes.” For a definition of the Icons displayed in the “Members” pane, go to the Help Menu and enter Icon in the Index.

You can get a list of the Properties and Methods available to specific controls in a UserForm by entering the control’s name followed by a dot (.) in a code pane. For example, if you insert a CheckBox in a UserForm and double-click the UserForm, the code pane will open and display a UserForm_Click macro. Typing “CheckBox1.” in the macro will cause VBE to display a list of the Properties and Methods that can be used in the macro. If the list does not appear, got to the Tools Menu, select Options, and on the Editor tab, check the “Auto List Members” check box.

You can get a list of the Events available to a specific control by inserting the control on a UserForm and double-click the UserForm to bring up the code pane. At the top of the code pane, select the name of the control in the left dropdown and the list of Events for that control will be listed in the right dropdown.

To get a list of all of the Objects, Controls, Methods, Properties, Events, and Collections, See the Help File section entitled “Microsoft Forms Object Model Reference” in the Help Menu, Contents and Index, Contents tab.

Lesson 2: UserForm Controls

What You Will Learn

After completing this lesson, you will be able to:

· Identify, insert into a UserForm, and programmatically manipulate the 15 UserForm Controls provided with Office 97.

· Understand how to apply many of the common UserForm Control Properties, Methods and Events to other Active-X Controls.

Related Topics Covered in this Lesson

· UserForm Control Grouping Techniques

· UserForm Paging vs. Tabing Concepts

Recommended Reading

· The Forms Design Reference in the Help file.

· The Forms Developer’s Tips in the Help file.

Overview

Controls are objects that simplify the application development process by providing functionality without having the write large amounts of code.

In this lesson we will explore each of the 15 Office 97 UserForm Controls and the typical and common Properties, Methods, and Events.

CommandButton - Starts, ends, or interrupts an action or series of actions.

Label - Displays descriptive text such as titles, captions, pictures, or brief instructions.

TextBox - Displays information entered by a user or displays a set of data, such as a table, query, worksheet, or a calculation result.

ListBox - Lets the user select one or more values from a displayed list of values.

ComboBox - Combines the features of a ListBox and a TextBox. The user can enter a new value, as with a TextBox, or select an existing value as with a ListBox.

Frame – Creates a functional and visual control group such as a group of OptionButton Controls.

OptionButton – Shows the selection status of one item in a group of choices.

CheckBox – Uses a checked/unchecked image to display the selection state (true or false) of an item.

ToggleButton – Identical to a CommandButton except that it uses a depressed/released image to display the selection state (true or false) of an item.

TabStrip – Uses multiple tabs to display different sets of information for the same set of controls.

MultiPage – Uses multiple tabs (pages) to display different sets of controls.

ScrollBar – Returns or sets the value of another control based on the position of the scroll box.

SpinButton – Used to increment or decrement a value in another control.

RefEdit – Used to return a selection of Range Addresses from a Microsoft Excel 97 Workbook.

For complete details pertaining to Office 97 UserForm Controls, please refer to the Help File in the Visual Basic for Applications Editor – Help Menu – Controls Tab – Microsoft Forms Object Model Reference – Properties or the Object Browser.

CommandButton Control

The CommandButton Control starts, ends, or interrupts an action or series of actions.

The macro or event procedure assigned to the CommandButton's Click Event determines what the CommandButton does. For example, you can create a CommandButton that opens another form. You can also display text, a picture, or both on a CommandButton.

Properties

The default property of a CommandButton Control is the Value Property. The Value Property for a CommandButton, is always False.

Setting the Value Property to True in a macro or procedure initiates the CommandButton’s Click Event.

Properties that apply to the CommandButton Control are:

Accelerator
AutoSize
BackColor
BackStyle
BoundValue

Cancel
Caption
ControlTipText
Default
Enabled

Font (Object)
ForeColor
Height
HelpContextId
LayoutEffect

Left
Locked
MouseIcon
MousePointer
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
Picture
PicturePosition
TabIndex
TabStop

Tag
TakeFocusOnClick
Top
Value
Visible

Width
WordWrap




Methods

The Methods that apply to the CommandButton Controls are Move, SetFocus, and ZOrder.

The Move Method is used to reposition and/or resize the Commandbutton.

The SetFocus Method moves the focus to this CommandButton.

The ZOrder Method is used to position a CommandButton above or below other Objects that are stacked one on top of another.

Events

The default event for a CommandButton Control is the Click Event. The Click Event occurs when the user clicks the CommandButton Control with the mouse which runs the default “Private Sub <CommandButton Name>_Click( )” macro.

When the Click Event results from clicking the CommandButton Control, the sequence of Events leading to the Click Event is the MouseDown and MouseUp Events.

Events that apply to the CommandButton Control are:

BeforeDragOver
BeforeDropOrPaste
Click
DblClick
Enter

Error
Exit
KeyDown
KeyPress
KeyUp

MouseDown
MouseMove
MouseUp



How to use Multiple Events to Change a Control’s Properties

You can use multiple events to accomplish the same goal. For example, we can modify a Control’s properties by using both mouse and keyboard input.

Change Background Color Example

This example demonstrates the manipulation typical UserForm Control attributes, the Click Event, KeyPress Event, and BackColor Property.

You can use a CommandButton Control to start a Visual Basic for Applications procedure. The procedure is usually attached to the Click Event of the CommandButton.

1. Create a new file in Microsoft Excel Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert Menu.

4. Draw a CommandButton control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a CommandButton Control in a UserForm

5. Double-click the CommandButton Control to display the UserForm Code Window and type the code below for the CommandButton1 Click Event and the CommandButton1 KeyPress Event.
6. Run the UserForm by pressing F5 or selecting “Run Sub/UserForm” on the Run Menu in the Visual Basic Editor.

The background color of the CommandButton changes to a random color each time you click it.

The color also changes to Red, Green, or Blue if you press the “R”, “G”, or “B” keys on the keyboard.
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Any other keyboard key changes the background color to white

The CommandButton1 Click event macro creates a random value (Rnd Function) for each of the Red, Green, and Blue components of a color. It then assign the color to the CommandButton using the RGB Attribute of the BackColor Property.

Private Sub CommandButton1_Click()

red = Int(Rnd * 255)

green = Int(Rnd * 255)

blue = Int(Rnd * 255)

CommandButton1.BackColor = RGB(red, green, blue)

End Sub

The CommandButtion1 KeyPress event macro uses a Select Case Statement, Chr Function, and the KeyAscii Argument to determine which keyboard key was pressed.

If the key pressed was an “r” or “R” it sets the Backcolor Property to Red.

If the key pressed was an “g” or “G” it sets the Backcolor Property to Green.

If the key pressed was an “b” or “B” it sets the Backcolor Property to Blue.

For any other key, it sets the BackColor Property to White.

Private Sub CommandButton1_KeyPress(ByVal KeyAscii As _

    MSForms.ReturnInteger)

Select Case Chr(KeyAscii)

    Case "r", "R"

        CommandButton1.BackColor = RGB(255, 0, 0)

    Case "g", "G"

        CommandButton1.BackColor = RGB(0, 255, 0)

    Case "b", "B"

        CommandButton1.BackColor = RGB(0, 0, 255)

    Case Else

        CommandButton1.BackColor = RGB(255, 255, 255)

End Select

End Sub

Label Control

A Label Control on a form displays descriptive text such as titles, captions, pictures, or brief instructions. For example, Labels for an address book might include a Label for a name, street, or city.

A Label doesn't display values from data sources or expressions; it is always unbound and doesn't change as you move from record to record.

A Label Control cannot be edited by the user while the UserForm is running.

Properties

The default property for a Label Control is the Caption Property. The Caption Property is the descriptive text that appears on an object to identify or describe it.

The default Caption for a Label Control is Label1 for the first Label in a form. If the Label’s Caption is too long, the Caption is truncated.

The ForeColor Property of the Label determines the color of the text in the Caption.

If the Label’s AutoSize Property is set to True, the size of the Label Control automatically adjusts to frame the entire Caption, if possible.

Properties that apply to the Label Control are:

Accelerator
AutoSize
BackColor
BackStyle
BorderColor

BorderStyle
Caption
ControlTipText
Enabled
Font (Object)

ForeColor
Height
LayoutEffect
Left
MouseIcon

MousePointer
Name
Object
OldHeight
OldLeft

OldTop
OldWidth
Parent
Picture
PicturePosition

SpecialEffect
Tag
TextAlign
Top
Visible

Width
WordWrap




Methods

The Methods that apply to Label Controls are Move and ZOrder.

The Move Method is used to reposition and/or resize the Label.

The ZOrder Method is used to position a Label above or below other Objects that are stacked one on top of another.

Events

The default event for a Label Control is the Click Event. The Click Event occurs when the user clicks the Label Control with the mouse which runs the default “Private Sub <Label Name>_Click( )” macro.

When the Click Event results from clicking the Label Control, the sequence of Events leading to the Click Event are the MouseDown and MouseUp Events.

Events that apply to the Label Control are:

BeforeDragOver
BeforeDropOrPaste
Click
DblClick
Error

MoueDown
MouseUp
MouseMove



How to Make Multiple Formatting Changes

UserForms have a large number of properties that can be modified. In this example we will manipulate a number of formatting properties including the properties of the Font Object.

Format Label Example

In this example we will change the display Properties of a Label Control.
Using a CommandButton Control’s Click Event, we will execute code that will change the Caption, AutoSize, WordWrap, Font.Name, Font.Size, Font.Bold, and ForeColor Properties of the Label Control.

To change the Name, Size and Bold Properties of the text in the Label Control we need to the Font Object. The Font Object is the only Object that is listed with the Properties in the Help file.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert menu.

4. Draw a Label control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a Label Control in a UserForm

5. Draw a CommandButton control on the UserForm.

6. Double-click the CommandButton Control to display the UserForm Code Window and type the code below for the CommandButton1 Click Event.
7. Run the UserForm by pressing F5 or selecting “Run Sub/UserForm” on the Run Menu in the Visual Basic Editor.

8. Click the CommandButton.

[image: image158.png]ol | NowPoge |

A A abl

P &
=

[t
Cr




The Label changes to Bold, Times New Roman Font with a Font Size of 14 and a Font Color of blue. The Label size will change to accommodate all of the text and with word-wrap set to false, may even be truncated if the UserForm is smaller than the new Label size requires.

The CommandButton1 Click event macro uses the With Statement to simplify changing the Label’s Caption, AutoSize, WordWrap, Font.Name, Font.Size, Font.Bold, and ForeColor Properties of the Label Control.

To change the Font Properties we need to use the Font Object. The Font Object is the only Object that is listed with the Properties in the Help file.

Private Sub CommandButton1_Click()

With Label1

'Set the text of the label.

   .Caption = "This is Label Example 1"

'Automatically size the label control.

   .AutoSize = True

   .WordWrap = False

'Set the Font used by the Label Control.

   .Font.Name = "Times New Roman"

   .Font.Size = 14

   .Font.Bold = True

'Set the Font Color to blue.

   .ForeColor = RGB(0, 0, 255)

End With

End Sub

TextBox Control

A TextBox is the control most commonly used to display information entered by a user. Also, it can display a set of data, such as a table, query, worksheet, or a calculation result.

If a TextBox is bound to a data source, then changing the contents of the TextBox also changes the value of the bound data source.

Formatting applied to any piece of text in a TextBox will affect all text in the control. For example, if you change the font or point size of any character in the control, the change will affect all characters in the control.

Properties

The default property for a TextBox Control is the Value Property. The Value Property specifies the content of the TextBox Control. For example, if we have a line of code that says:

TextBox1.Value = “This is a test.”

Then the contents of TextBox1 will be changed to contain “This is a test.” when line of code is executed.

Properties that apply to the TextBox Control are:

AutoSize
AutoTab
AutoWordSelect
BackColor
BackStyle

BorderColor
BorderStyle
BoundValue
CanPaste
ControlSource

ControlTipText
CurLine
CurTargetX
CurX
DragBehavior

DropButtonStyle
Enabled
EnterFieldBehavior
EnterKeyBehavior
Font (Object)

ForeColor
Height
HelpContextId
HideSelection
IMEMode

IntegralHeight
LayoutEffect
Left
LineCount
Locked

MaxLength
MouseIcon
MousePointer
MultiLine
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
PasswordChar
Scrollbars
SelectionMargin
SelLength

SelStart
SelText
ShowDropButtonWhen
SpecialEffect
TabIndex

TabKeyBehavior
TabStop
Tag
Text
TextAlign

TextLength
Value
Visible
WordWrap


Methods

The Methods that apply to the TextBox Control are Copy, Cut, Move, Paste, SetFocus, and ZOrder.

The Copy Method copies the contents of the TextBox to the Clipboard.

The Cut Method removes selected information from the TextBox and transfers it to the Clipboard.

The Move Method is used to reposition and/or resize the TextBox.

The Paste Method transfers the contents of the Clipboard to the TextBox.

The SetFocus Method moves the focus to this TextBox.

The ZOrder Method is used to position a TextBox above or below other Objects that are stacked one on top of another.

Events

The default Event for a TextBox Control is the Change Event. The Change Event occurs when the Value Property of the TextBox changes causing the macro “Private Sub <TextBox1 Name>_Change( )” to be executed.

The Change Event occurs when the setting of the Value Property changes, regardless of whether the change results from execution of code or a user action in the interface, such as entering a new text value in the TextBox.

The Change Event procedure can synchronize or coordinate data displayed among Controls. For example, you can use the Change Event procedure of a ScrollBar Control to update the contents of the TextBox that displays the value of the ScrollBar. Or, you can use a Change Event procedure to display data and formulas in a work area and results in another area.

In some cases, the Click Event may also occur when the Value Property changes. However, using the Change Event is the preferred technique for detecting a new value for a property.

Events that apply to the TextBox Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

DblClick
Enter
Error
Exit
KeyDown

KeyPress
KeyUp
MouseDown
MouseMove
MouseUp

How to Validate a Password

The TextBox’s PasswordChar Property can be used to enter a password without displaying what is being typed.

Validate Password in TextBox Example

In this example we will insert a TextBox Control and a CommandButton Control in a UserForm then hide the password as it is being typed by using the PasswordChar Property to display an astrisk in place of each character we type.

If you set the PasswordChar Property of a TextBox, it becomes a "masked-edit" control. Every character that is typed into the TextBox is replaced visually by the character that you specify.

If the password entered is not correct, we will use the Text Property to clear the data in the TextBox and the SetFocus Property to return the cursor back to the TextBox so that the user can try again.

If the user doesn’t know the password (it is “userform”), the user must exit the UserForm by pressing the Cancel button in the top right corner of the UserForm.

Lastly, we will use the Unload Statement to remove the UserForm from memory. By using the Me Keyword, we do not have to specify the Name of the UserForm (UserForm1 in our case) in the Unload Statement.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word..

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert Menu.

4. Draw a TextBox Control on the UserForm UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a TextBox Control in a UserForm

5. If the Properties window is not visible, click Properties on the View Menu.
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Change the PasswordChar Property of the TextBox Control to *.

Note: You could also change the PasswordChar Property to an asterisk in code by using the following line in a UserForm Initialize macro.

TextBox1.PasswordChar = "*"

7. Draw a CommandButton Control on the UserForm.

8. Double-click the CommandButton Control to display the UserForm Code Window and type the code below for the CommandButton1 Click Event and the CommandButton1 KeyPress Event.
9. Run the UserForm by pressing F5 or selecting “Run Sub/UserForm” on the Run Menu in the Visual Basic Editor.

10. Type the password “userform” into the TextBox.

11. Click the CommandButton.
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If you typed the correct password you receive a welcome dialog box.
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If you typed an incorrect password you will receive an error message and be given an opportunity to re-enter the password.

The CommandButton1 Click event macro compares the entered data with the text “userform.”

If there is a match, a Message Box Statement will display a “Welcome!” message and will use the Unload Statement to remove the UserForm from memory. By using the Me Keyword, we do not have to specify the Name of the UserForm (UserForm1 in our case) in the Unload Statement.

If there is not a match, the Message Box Statement is used to display “Password is Incorrect. Please reenter." The Text Property is then used to clear the TextBox and the SetFocus Property is used to place the cursor in the TextBox.

Private Sub CommandButton1_Click()

If TextBox1.Text <> "userform" Then

    MsgBox "Password is Incorrect. Please reenter."

    TextBox1.Text = ""

    TextBox1.SetFocus

Else

    MsgBox "Welcome!"

    Unload Me

End If

End Sub

ListBox Control

The ListBox Control lets you select one or more values from a displayed list of values.

If the ListBox is bound to a data source such as an Microsoft Excel worksheet, then the ListBox stores the selected value in that data source. To populate a ListBox Control with a range of cells on an Microsoft Microsoft Excel worksheet, use the RowSource Property.

The ListBox can either appear as a list or as a group of OptionButton Controls or CheckBox Controls.

When you use the MultiSelect Property, you can set up a ListBox Control to accept multiple selections.

You can not drop text into a drop-down ListBox.

Properties

The default property of a ListBox Control is the Value Property.

For a single-column list, the Value Property contains the item currently selected from the list.

As the Value Property returns a single item, it cannot be used with a multi-select ListBox. Use the Selected Property to determine if a particular item in the multi-select ListBox is selected or not.

For a multi-column list, the Value Property contains the BoundColumn of the currently selected row.

The BoundColumn Property identifies the source of data in a multi-column ListBox. When the user chooses a row in a multi-column ListBox the BoundColumn Property identifies which item from that row to store as the value of the control.

For example, if each row contains 8 items and BoundColumn is 3, the Value Property contains a 3 and the BoundColumn Property contains the information from the third column of row 8, the currently-selected row.

Properties that apply to the ListBox Control are:

BackColor
BorderColor
BorderStyle
BoundColumn
BoundValue

Column
ColumnCount
ColumnHeads
ColumnWidths
ControlSource

ControlTipText
Enabled
Font (Object)
ForeColor
Height

HelpContextId
IMEMode
IntegralHeight
LayoutEffect
Left

List
ListCount
ListIndex
ListStyle
Locked

MatchEntry
MouseIcon
MousePointer
MultiSelect
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
RowSource
Selected
SpecialEffect
TabIndex

TabStop
Tag
Text
TextColumn
Top

TopIndex
Value
Visible
Width


Methods

The Methods that apply to the ListBox Control are AddItem, Clear, Move, RemoveItem, SetFocus, and ZOrder.

The AddItem Method adds an item to a single-column ListBox or adds a row to the list in a multi-column ListBox. For a multi-column ListBox, AddItem inserts an entire row. If the control is bound to data, the AddItem method fails. You can add more than one row at a time to a ListBox using the List Property.

The Clear Method removes all entries from the list in a ListBox

The Move Method is used to reposition and/or resize the Commandbutton.

The RemoveItem Method removes a row from the list in a ListBox unless the ListBox is data bound (that is, when the RowSource Property specifies a data source for the ListBox).

The SetFocus Method moves the focus to this CommandButton. By default, setting the focus does not activate the ListBox window or place it on top of other controls

The ZOrder Method is used to position a CommandButton above or below other Objects that are stacked one on top of another.

Events

The default event for a ListBox Control is the Click Event. The Click Event occurs when the user clicks on a value in the ListBox’s drop-down list with the mouse. This action runs the default “Private Sub <ListBox Name>_Click( )” macro.

The Click event is not initiated when Value is set to Null. 

Question: Do we get a Click Event in a multi-select ListBox?

When the Click Event results from clicking the ListBox Control, the sequence of Events leading to the Click Event is the MouseDown and MouseUp Events.

Events that apply to the ListBox Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

Click
DblClick
Enter
Error
Exit

KeyDown
KeyPress
KeyUp
MouseDown
MouseMove

MouseUp





How to Load a ListBox From an Array of Values

There are three ways to Load values into a ListBox Control. You can set the List Property to an array of values, set the RowSource Property to a Range on an Microsoft Excel Worksheet, or add items to the list using the AddItem Method. This example uses the List Property which will work in all Office 97 applications.

ListBox, List Property Example

In this example we will load the ListBox from an array of values and display a single selected item from a ListBox Control.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert Menu.

4. Draw a ListBox Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a ListBox Control in a UserForm

5. If the Properties Window is not visible, click Properties on the View Menu.

6. Double-click the ListBox Control to display the UserForm Code Window and type the code below for the UserForm Initialize Event and the ListBox Click Event:

7. Run the UserForm.

When you click an item in the list, a message box appears with the currently selected item. To cancel the ListBox, click the Cancel Button in the top right corner of the UserForm.
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Displaying a Selected ListBox Item

The UserForm Initialize event macro uses the List Property to load the ListBox Control with a single-column array of values.

Private Sub UserForm_Initialize()

ListBox1.List() = Array("Apples", "Bananas", "Cherries")

End Sub

The ListBox1 Click event macro uses the Message Box Function to display the selected Value Property for the ListBox Control.

Private Sub ListBox1_Click()

MsgBox ListBox1.Value

End Sub

How to Load a ListBox From an Microsoft Excel Worksheet

You can load a Listbox directly from a Range of values in a vertical column on an Microsoft Excel Worksheet by using the RowSource Property. If the range of values in the worksheet is in a horizontal row, we can loop through the range and add the values using the AddItem Method. Both approaches are presented in the following example.

Worksheet Based ListBox Example

The RowSource Property used in this example only applies to Microsoft Excel and uses a column of contiguous values in a worksheet range as the source of the ListBox data.

1. Create a new workbook in Microsoft Excel.

2. In cells A1:A5 on Sheet1, type the contiguous values in a column that you want to use to populate the ListBox.
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Microsoft Excel Worksheet Example

3. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

4. Insert a UserForm into your workbook. To do this, click UserForm on the Insert menu.

5. Draw a ListBox Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a ListBox Control in a UserForm

6. If the Properties Window is not visible, click Properties on the View Menu.

7. Change the RowSource Property of the ListBox Control to “Sheet1!A1:A5.”
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Entering the RowSource Property Updates the ListBox

As soon as the RowSource Property is entered in the Properties Dialog Box, the Bound Data appears in the UserForm.

You could have also changed the RowSource Property by using the following line in a UserForm Initialize event macro.

ListBox1.RowSource = "=Sheet1!A1:A5"

8. Double-click the ListBox Control to display the UserForm Code Window and type the code below for the ListBox Click Event.

9. Run the UserForm.

When you click an item in the list, a message box appears with the currently selected item.
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Displaying a Selected ListBox item

The ListBox1 Click event macro uses the Message Box Function to display the selected Value Property for the ListBox Control. We did not have to use the Initialize Event to load the RowSource Property because we set that at design time in the Properties Window of the ListBox Control, but we could have.

Private Sub ListBox1_Click()

MsgBox ListBox1.Value

End Sub

If the worksheet data is in a horizontal row (e.g. A1:E1), rather then a vertical column as described above, do not use the RowSource Property, place the following code in a Module, and run this macro in place of running the UserForm.

The ListBox Click event macro above can be used with either approach.

Sub PopulateListWithHorizontalRange()

For Each x in Sheet1.Range(“A1:E1”)

   UserForm1.ListBox1.AddItem x.Value

Next x

UserForm1.Show

End Sub

How to Select Multiple Values From a ListBox

You can select multiple values from a ListBox by using the MultiSelect Property. To retrieve the selected items we use the Selected Property.

Multi-Select ListBox Example

This example loads the ListBox, sets the MultiSelect Property, and loops through all the items in the ListBox using the Selected Property to determine which items have been selected.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your file. To do this, click UserForm on the Insert Menu.

4. Draw a ListBox Control on the the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a ListBox Control in a UserForm

5. If the Properties Window is not visible, click Properties on the View Menu.

6. Change the MultiSelect Property of the ListBox Control to “1 – frmMultiSelectMulti.”
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Setting the MultiSelect Property to Multi

You could have also changed the MultiSelect Property by using the following line in a UserForm Initialize event macro instead of in the Properties Window.

ListBox1.MultiSelect = fmMultiSelectMulti

7. Draw a CommandButton Control on the UserForm.

8. Double-click the CommandButton Control to display the UserForm Code Window and type the code below for the UserForm Initialize Event and the CommandButton1 Click Event.

9. Run the UserForm.

10. Select one or more items in the list.

11. Click the CommandButton.

Each item you selected in the ListBox is displayed in a separate message box. After all the selected items are displayed by a message box, the UserForm is automatically dismissed.
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Displaying Multiple ListBox Selections

The UserForm Initialize event macro uses the Dimension Statement to establish MyArray, a 6 subscript Array of String Values, then loads each of the 6 subscripts.

The macro then uses the List Property of the ListBox Control to load the values from MyArray into the ListBox.

You will note that the previous ListBox, List Property Example is a more efficient technique for loading small arrays. You could also load the list using the AddItem Property in a loop where “x” is the array item to be loaded using the following code:

UserForm1.ListBox1.AddItem MyArray(x)

To use Bound data from an Microsoft Excel Worksheet use the RowSource Property, as in the Worksheet Based ListBox Example above, in place of the data provided by UserForm Initialize Macro.

Private Sub UserForm_Initialize()

Dim MyArray(5) As String

'Load String values in MyArray

   MyArray(0) = "Audi"

   MyArray(1) = "Buick"

   MyArray(2) = "Chrysler"

   MyArray(3) = "Dodge"

   MyArray(4) = "Peanut Butter"

   MyArray(5) = "Ford"

'Load ListBox1

   ListBox1.List() = MyArray

End sub

The CommandButton1 Click event macro uses the ListCount Property to determine how many items are in the ListBox then loops through each item.

With each loop it uses the Selected Property of the ListBox to determine if the item had been selected.

If the Selected Property of the item was set to True a Message Box Function is used to display the text of the ListBox item.

After each item in the loop has been examined, the Unload Statement with the Me Keyword is used to remove the UserForm from memory.

Sub CommandButton1_Click()

'Loop through the items in the ListBox.

For x = 0 To ListBox1.ListCount - 1

'If the item is selected...

    If ListBox1.Selected(x) = True Then

'display the Selected item.

        MsgBox ListBox1.List(x)

    End If

Next x

Unload Me

End Sub

How to Create a Multiple Column ListBox in Microsoft Excel

The ColumnCount Property can be used to set up columns in a ListBox. You may also want to use the ColumnWidths Property to size the individual columns.

Worksheet Based, Multi-Column ListBox Example

The RowSource Property used in this example only applies to Microsoft Excel and uses a worksheet range as the source of the ListBox data.

Using the ColumnCount Property, you can format a ListBox Control to display more than one column of data with more than one item on each line of the list.

This example shows how to load a multi-column list into a ListBox Control and retrieve data from the selected rows and columns.

1. Create a new workbook in Microsoft Excel.

2. In cells A1:C5 on Sheet1, type the values that you want to use to populate the ListBox.
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Microsoft Excel Worksheet Example

3. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

4. Insert a UserForm into your workbook. To do this, click UserForm on the Insert Menu.

5. Draw a Label Control and a ListBox Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Sample UserForm with Label and ListBox Controls

6. If the Properties Window is not visible, click Properties on the View Menu.

7. Change the following properties of the ListBox control to the values that are listed in the following table.

Property
Value

BoundColumn
1

ColumnCount
3

ColumnHeads
True

ColumnWidths
35: 35; 35

RowSource
Sheet1!A2:A5
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Setting the ColumnHeads Property to True

The BoundCoumn Property will be used to determine which column’s data will be available in the Value Property once a row has been selected.

The ColumnCount Property identifies how many columns the ListBox will have.

The ColumnHeads Property specifies whether column headings are to be displayed. When the system uses the first row of data items as column headings, they can't be selected.

The ColumnWidths Property sets the width, in points, for each of the columns in the ListBox.

The RowSource Property accepts worksheet ranges from Microsoft Excel as the source of data for the ListBox.

You could also changed the ColumnCount, ColumnHeads, ColumnWidths, and RowSource Properties by using the following lines in a UserForm Initialize event macro instead of in the Properties Window.

With ListBox1

   .BoundColumn = 1

   .ColumnCount = 3

   .ColumnHeads = True

   .ColumnWidths = “35; 35; 35”

   .RowSource = “=Sheet1!A2:C5”

End With

8. Double-click the ListBox Control to display the UserForm Code Window and type the code below for the ListBox Change Event.

9. Run the UserForm.

When you click an entry in the ListBox, the label changes to reflect all three of the items in that entry.
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Displaying a Selected Row in the Label of a Multi-Column ListBox

The ListBox Change event macro sets the Worksheet Range used by the ListBox Control’s RowSource Property as an Object called SouceRange.

The macro then loads the Variable, Val1, with the contents of the Value Property of the ListBox Control. This value is selected from the Column specified in the BoundColumn Property (which we set to “1”), and the selected Row.

The macro then loads the Variable,Val2, with the Value found in the Worksheet Range by using the Offset Property to select the Row based on the ListBox’s ListIndex Property and a Column offset of 1, the second column of the Range. Before the data is loaded into the Variable, the Resize Property is used to return the specific cell located by the Offset Property.

The macro then loads the Variable, Val3, exactly as it did Val2 except the column offset is 2, the third column of the Range.

The macro then changes the Label by setting the Caption Property of Label1 to be the three Variables with a single blank space between each variable.

Private Sub ListBox1_Change()

Set SourceRange = Range(ListBox1.RowSource)

Val1 = ListBox1.Value

Val2 = SourceRange.Offset(ListBox1.ListIndex, 1). _

   Resize(1, 1).Value

Val3 = SourceRange.Offset(ListBox1.ListIndex, 2). _

   Resize(1, 1).Value

Label1.Caption = Val1 & " " & Val2 & " " & Val3

End Sub
How to Create a Multiple Column ListBox in Microsoft Word

In Microsoft Word, the RowSource Property does not work as it requires an Microsoft Excel Worksheet. Likewise, ther is no way to use the ColumnHeads Property to create a header in the ListBox. We can, however, use an array as in previous examples, and we can load the ListBox from a Table in Microsoft Word as this example shows.

List Property, Multi-Column ListBox Example

In addition to loading a ListBox with an array of values entered directly in the macro, we can also load the ListBox with values from other sources. To load a ListBox with values in a Microsoft Word Table we loop through the values in the Table to load an array, then load the Listbox with the values captured in the array.

Using the ColumnCount Property, you can format a ListBox Control to display more than one column of data with more than one item on each line of the list.

This example shows how to load a multi-column list into a ListBox Control and retrieve data from the selected rows and columns.

1. Create a new Document in Microsoft Word.

2. From the Table Menu, select Insert Table, create a 5 Column by 3 Row Table in the Microsoft Word document and type the values that you want to use to populate the ListBox.

Microsoft Word Document Table Example

Bill
Brown
127 Main Street
Topika
Kansas

Jane
Stapleton
2793b Spruce Ln
Denver 
Colorado

Geoff
Wainwright
836 Newbury Ct.
Largo
Florida

3. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

4. Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

5. Draw a Label Control and a ListBox Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Sample UserForm with ListBox Control

6. Double-click the ListBox Control to display the UserForm Code Window and type the code below for the UserForm Initialize and ListBox Click Events.

7. Run the UserForm.

When you click an entry in the ListBox, a Message Box appears with the first two items from the selected Row. Because the ListBox isn’t wide enough to display all the data in the five columns, it automatically added a Horizontal Scroll Bar to the Control.

When we first click on an item in the ListBox, the value of the Selected Property Changes and as a result, a Click Event occurs which displays the Message Box.

If we click on the same item in the ListBox a second time there is no change to any values in the ListBox and a Click Event does not occur therefore we do not get a Message Box for multiple clicks of the same item in the ListBox.
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Displaying a Selected Row of a Multi-Column ListBox in a Message Box

The UserForm Initialize event macro creates an Array of Strings called MyArray, uses the Count Property of the Rows and Columns of the Table to determine the Tables size, and Re-Dimensions the Array to this size.

The macro then loops through the Rows and within this loop, loops through the Column Cells of the table.

In each Table Cell it loads a Variable called CellData with the value from the Cell and uses the Left Function to strip off the Paragraph Marks and End-of-Cell Markers as it as it loads the appropriate location in MyArray.

Finally, it sets the ColumnCount Property to the number of Columns previously captured in the Variable ColCount and loads the contents of MyArray into the List Property of the ListBox.

The ListBox1 Click event macro loops through each item in the Multi-Column List and If the item’s Selected Property had been set to True, displays that lines first and second column in a Message Box.

Private Sub UserForm_Initialize()

Dim MyArray() As String

RowCount = ActiveDocument.Tables(1).Rows.Count

ColCount = ActiveDocument.Tables(1).Columns.Count

ReDim MyArray(RowCount - 1, ColCount - 1)

For i = 1 To RowCount

   For j = 1 To ColCount

'Select each cell in the table

      Celldata = ActiveDocument.Tables(1).Cell(i, j)

'Remove the paragraph and end-of-cell markers

' as we load the array

      MyArray(i - 1, j - 1) = Left(Celldata, _

         Len(Celldata) - 2)

   Next

Next

ListBox1.ColumnCount = ColCount

ListBox1.List() = MyArray

End Sub

Private Sub ListBox1_Click()

For x = 0 To ListBox1.ListCount

   If ListBox1.Selected(x) = True Then

      MsgBox ListBox1.List(x) & " " & ListBox1.List(x, 1)

   End If

Next x

End Sub

How to Clear the Contents of a ListBox

You can clear the contents of a ListBox by using the RemoveItem Property.

Remove All ListBox Control Items Example

If the ListBox is Bound to an Microsoft Excel Worksheet Range,

Clear the value in the RowSource Property in the Properties Window.
-OR-

Use the following line of code in a macro which sets the RowSource Property to nothing;

ListBox.RowSource = “”

If the ListBox is NOT Bound to an Microsoft Excel Worksheet Range, use the following lines of code in a macro:

This code determines how many items are in the ListBox by using the ListCount Property.

The code then deletes the item using the RemoveItem Method.

For i = 1 to ListBox.ListCount

   ListBox1.RemoveItem 0

Next i

ListBox Knowledge Base Articles
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Q161598 Microsoft Excel – How to Add Data to a ComboBox or a ListBox

In Microsoft Excel, there are two ways of populating a ComboBox or ListBox. You can link the control to worksheet cells or you can populate the control with a Microsoft Visual Basic for Applications macro.
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Q161518 Microsoft Excel – How to Populate One ListBox Based On Another ListBox

This article contains an example of using the selected item in one ListBox control on a UserForm to determine the list that will populate a second ListBox control.
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Q161346 Microsoft Excel – How to Determine Which Items Are Selected in a ListBox

This article explains how to retrieve selected items from a ListBox control that allows you to select multiple values.

ComboBox Control

Combines the features of a ListBox Control and a TextBox Control. The user can enter a new value, as with a TextBox, or select an existing value as with a ListBox.

If a ComboBox is bound to a data source such as an Microsoft Excel worksheet, then the ComboBox inserts the value the user enters or selects into that data source.

If a multi-column ComboBox is bound, then the BoundColumn Property determines which value is stored in the bound data source.

If you want to use a ComboBox Control and limit values to those in the list, you can set the Style Property of the ComboBox to fmStyleDropDownList so the control looks and acts like a drop-down list box.

The list in a ComboBox consists of rows of data. Each row can have one or more columns, which can appear with or without headings. Some applications do not support column headings, others provide only limited support.

Note: All of the examples in the previous section for the ListBox Control also can be applied to the ComboBox Control, except for those that use the MultiSelect Property.

Properties

The default property of a ComboBox Control is the Value Property.

For a single-column list, the Value Property contains the item currently selected from the list.

As the Value Property returns a single item, it cannot be used with a multi-select ComboBox. Use the Selected Property to determine if a particular item in the multi-select ComboBox is selected or not.

For a multi-column list, the Value Property contains the BoundColumn of the currently selected row.

Changing the contents of the Value Property does not change the value of the BoundColumn.

The BoundColumn Property identifies the source of data in a multi-column ComboBox. When the user chooses a row in a multi-column ColumnBox the BoundColumn Property identifies which item from that row to store as the value of the control.

For example, if each row contains 8 items and BoundColumn is 3, the Value Property contains a 3 and the BoundColumn Property contains the information from the third column of row 8, the currently-selected row.

To add or delete entries in a ComboBox, you can use the AddItem or RemoveItem Method.

Properties that apply to the ControlBox Control are:

AutoSize
AutoTab
AutoWordSelect
BackColor
BackStyle

BorderColor
BorderStyle
BoundColumn
BoundValue
CanPaste

Column
ColumnCount
ColumnHeads
ColumnWidths
ControlSource

ControlTipText
CurTargetX
CurX
DragBehavior
DropButtonStyle

Enabled
EnterFieldBehavior
Font (Object)
ForeColor
Height

HelpContextId
HideSelection
IMEMode
LayoutEffect
Left

LineCount
List
ListCount
ListIndex
ListRows

ListStyle
ListWidth
Locked
MatchEntry
MatchFound

MatchRequired
MatchLength
MouseIcon
MousePointer
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
RowSource
SelectionMargin
SelLength
SelStart

SelText
ShowDropButtonWhen
SpecialEffect
Style
TabIndex

TabStop
Tag
Text
TextAlign
TextColumn

TextLength
Top
TopIndex
Value
Visible

Width





Methods

The Methods that apply to the ComboBox Control are AddItem, Clear, Copy, Cut, DropDown, Move, Paste, RemoveItem, SetFocus, and ZOrder.

The AddItem Method adds an item to a single-column ComboBox or adds a row to the list in a multi-column ComboBox. For a multi-column ComboBox, AddItem inserts an entire row. If the control is bound to data, the AddItem method fails. You can add more than one row at a time to a ComboBox by using the List Property.

The Clear Method removes all entries from the list.

The Copy Method copies the currently selected text to the Clipboard.
The Cut Method removes currently selected text to the Clipboard. This method does not require that the control have the focus.

The DropDown Method displays the list portion of a ComboBox.

The Move Method is used to reposition and/or resize the ComboBox.

The Paste Method transfers the contents of the Clipboard to the ComboBox as text.

The RemoveItem Method removes a row from the list in a ComboBox unless the ComboBox is data bound (that is, when the RowSource Property specifies a data source for the ComboBox).

The SetFocus Method moves the focus to this ComboBox. By default, setting the focus does not activate the ComboBox window or place it on top of other controls.

The ZOrder Method is used to position a ComboBox above or below other Objects that are stacked one on top of another.

Events

The default event for a ComboBox Control is the Change Event. The Change Event occurs when the Value Property changes due to entering or selecting a new text value in the ComboBox.

With the ComboBox, the Click Event will also occur when the Value Property changes. However, using the Change Event is the preferred technique for detecting a new value for a property.

Events that apply to the ComboBox Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

Click
DblClick
Enter
Error
Exit

KeyDown
KeyPress
KeyUp
MouseDown
MouseMove

MouseUp





How to Add an Item to a ComboBox List

When a user types a new value into the ComboBox Control, you may want to add the new value to the list.

Add Item to ComboBox Example

The following steps show you how to add the new value entered into the ComboBox using AddItem Property.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4. Draw a ComboBox Control and a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a ComboBox Control in a UserForm

5. Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event and the CommandButton1 Click Event.

6. Run the UserForm

7. Type the value “Mangoes” into the ComboBox Control (or any value not already in the list).

8. Click the CommandButton.

If you click the drop-down arrow to see the items in the ComboBox, the new value that you typed appears at the end of the list.
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Displaying the ComboBox with the New Item Added

The UserForm Initialize event macro uses the List Property to load the ComboBox Control with a single-column array of values

Private Sub UserForm_Initialize()

UserForm1.ComboBox1.List = Array("Apples", "Bananas", _

   "Oranges", "Peaches")

End Sub

The CommandButton Click event macro uses the MatchFound Property to determine if the entry is different from any of the values in the list and if it is, uses the AddItem Method to add the value of the new entry at the end of the list.

Private Sub CommandButton1_Click()

If ComboBox1.MatchFound = False Then ComboBox1.AddItem _

   ComboBox1.Value

End Sub

How to Add an Item to a Bound Worksheet

When a user types a value that is not already in the bound ComboBox list, you may want to add the new value to both the ComboBox list and the bound worksheet.

Add Item to RowSource Example

The following steps show you how to add the new value entered into the ComboBox to the list and the Bound worksheet RowSource. This example applies only to Microsoft Excel.

1. Create a new workbook in Microsoft Excel.

2. In cells A1:A5 on Sheet1, type the values that you want to use to populate the ListBox.
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Microsoft Excel Worksheet Example

3. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

4. Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

5. Draw a ComboBox Control and a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a ComboBox Control in a UserForm

6. Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event and the CommandButton1 Click Event.

7. Run the UserForm.

8. Type a value in the ComboBox that is not already in the list.
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Entering a New Value in the ComboBox

9. Click the CommandButton control.

The new item that you typed into the ComboBox control is added to the list, and the list and to the bound worksheet.

[image: image183.png]UserForm1 [x] [N [x]

{361 rab2 | Tabt (T2

Frame1
 optionButtont

 optionButton?.

 optionButton




Updated ComboBox List and bound Worksheet

The UserForm Initialize event macro sets the RowSource Property to the Address of the range starting at Cell A1 and going down (End Property) to the end of the data in the column. It then sets the ComboBox’s ListIndex Property to “0” so that the first Item in the List is displayed in the Edit Box of the ComboBox.

To display the ComboBox List immediately upon showing the UserForm, insert the following line before the End Sub line in this macro.

ComboBox1.DropDown
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Displaying the DropDown

Although the DropDown is displayed separately from the ComboBox, both are displayed and either can be used to select an existing value. To add a new value, only the Edit Box in the ComboBox can be used.

The CommandButton Click event macro uses the MatchFound Property to determine if the value in the Edit Box in the ComboBox is one of the values in the List. If the value is new, saves the Address of the next worksheet Cell in the column in a Variable called NewCell, and saves the Value from the ComboBox in this location. Finally, it resets the RowSource Property’s  Address to include all the Cells from A1 to this new Cell.

Private Sub UserForm_Initialize()

' Determine the RowSource Address

ComboBox1.RowSource = Sheet1.Range("A1", _

   [A1].End(xlDown).Address).Address

' Display the first item in the list

ComboBox1.ListIndex = 0

End Sub

Private Sub CommandButton1_click()

' If the data does not match an existing list item...

If ComboBox1.MatchFound = False Then

' Get the cell location for the new value

   NewCell = [A1].End(xlDown).Offset(1).Address

' Put the new value in the new cell location

   Sheet1.Range(NewCell).Value = ComboBox1.Value

' Reset the RowSource to include the new cell

   ComboBox1.RowSource = Sheet1.Range("A1", NewCell). _

      Address

End If

End Sub

How to use One ComboBox to Display the List in Another

Sometimes it is useful to make the list displayed in one ComboBox dependent on the choice made in another ComboBox.

For example, in a checkbook application, if we select a category in one ComboBox of “Groceries,” the other ComboBox might list all the local supermarkets. But if we had selected “Dining Out” instead, the dependent ComboBox might display a list of restaurants. This example applies to Microsoft Excel.

Controling one ComboBox List From Another Example

1. Create a new workbook in Microsoft Excel.

2. In cells A1:D4 on Sheet1, type the values that you want to use to populate the ListBox.
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Microsoft Excel Worksheet Example

3. Select cells A2 through A4 with the mouse.

4. On the Insert Menu, point to Name, and then click Define. Type Main_List in the Names in Workbook Box, and then click OK.

5. This creates a defined name which you can use to bind the RowSource Property of ComboBoxs we will create in the UserForm.

6. Repeat the process defined in steps 3 and 4 using the following ranges and names:

7. Select cells B2 through B4 and use the name “Color.”

8. Select cells C2 through C4 and use the name “Size.”

9. Select cells D2 through D4 and use the name “Texture.”

10. Make sure that the names in the Main_List column exactly match the Range Names.

11. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

12. Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

13. Draw two ComboBox Controls and a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting the ComboBox Controls in a UserForm

14. Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event, ComboBox1 Change and CommandButton1 Click Events.

15. Run the UserForm.

16. Select a value from ComboBox1. The value displayed in ComboBox2 will be the top item from the associated list.

17. Select a value in ComboBox2 and click CommandButton1.

A Message Box will be displayed with the values of both ComboBoxes.
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Displaying the Selected ComboBox Items

The UserForm Initialize event macro sets the RowSource Property for ComboBox1 to the Address of the named range “Main_List”, sets the Style Property to a Drop-Down list only (disables the Edit Box so that the user must select an item from the list), and sets the ListIndex Property to “0” to display the top item in the list. This macro then does essentially the same thing for ComboBox2 except it binds the list from the named range “Color.”

The ComboBox Change event macro is attached to ComboBox1. It sets the RowSource Property of ComboBox2 to the named range address specified by the Value Property from ComboBox1. It then displays the top item in the ComboBox2 list by setting the ListIndex Property to “0”.

The CommandButton1 Click event macro displays a Message Box with the Values selected from both ComboBox1 and ComboBox2.

Private Sub UserForm_Initialize()

With ComboBox1

    .RowSource = Range("Main_List").Address

    .Style = fmStyleDropDownList

    .ListIndex = 0

End With

With ComboBox2

    .RowSource = Range("Color").Address

    .Style = fmStyleDropDownList

    .ListIndex = 0

End With

End Sub

Private Sub ComboBox1_Change()

ComboBox2.RowSource = Range(ComboBox1.Value).Address

ComboBox2.ListIndex = 0

End Sub

Private Sub CommandButton1_Click()

MsgBox "You have selected the " & ComboBox2.Value & " " & ComboBox1.Value

End Sub

Frame Control

Creates a functional and visual Control Group. All option buttons in a Frame are mutually exclusive, so you can use the Frame to create an Option Group. For examples of using a Frame Control with an Option Group, please see the OptionButton Control section of this Triage.

You can use a Frame to group controls with closely related contents. For example, in an application that processes customer orders, you might use a Frame to group the name, address, and account number of customers.

You can also use a Frame to create a group of Toggle Buttons, but the toggle buttons are not mutually exclusive.

Properties

Properties that apply to the Frame Control are:

ActiveControl
BackColor
BorderColor
CanPaste
CanRedo

CanUndo
Caption
ControlTipText
Cycle
DrawBuffer

Enabled
Font (Object)
ForeColor
Height
HelpContextId

InsideHeight
InsideWidth
KeepScrollBarsVisible
LayoutEffect
Left

MouseIcon
MousePointer
Name
Object
OldHeight

OldLeft
OldTop
OldWidth
Parent
Picture

PictureAlignment
PictureSizeMode
PictureTiling
ScrollBars
ScrollHeight

ScrollLeft
ScrollTop
ScrollWidth
SpecialEffect
TabIndex

TabStop
Tag
Top
VerticalScrollbarSide
Visible

Width
Zoom




Methods

The Methods that apply to the Frame Control are Copy, Cut, Move, Paste, RedoAction, Repaint, Scroll, SetDefaultTabOrder, SetFocus, UndoAction, and ZOrder.

The Copy Method copies the currently selected text to the Clipboard.

The Cut Method removes currently selected text to the Clipboard. This method does not require that the control have the focus.

The Move Method is used to reposition and/or resize the Frame.

The Paste Method transfers the contents of the Clipboard to the Frame as an Object.

The RedoAction Method Reverses the effect of the most recent Undo action provided the CanRedo Property is True. The RedoAction Method is not valid in code and returns True if it was successful.

The RePaint Method updates the display by redrawing the frame. Is useful if the contents or appearance of the Frame changes significantly, and you don't want to wait until the system automatically repaints the area.

The Scroll Method moves the Scroll Bar on the Frame that appears when the Frame that is larger than its display area.

The SetDefaultTabOrder Method sets the TabIndex Property of each control in the Frame, using a default top-to-bottom, left-to-right tab order.

The SetFocus Method moves the focus to the Frame and is valid for an empty Frame as well as a Frame that contains other controls. An empty Frame will take the focus itself, and any subsequent keyboard events apply to the Frame. In a Frame that contains other controls, the focus moves to the first control in the Frame, and subsequent keyboard events apply to the control that has the focus.

The UndoAction Method reverses the most recent action that supports the Undo command if the CanUndo Property is True. UndoAction Method is not valid in code.

The ZOrder Method is used to position a Frame Control above or below other Objects that are stacked one on top of another.

Events

The default event for a Frame is the Click Event. Occurs when the user clicks on a blank area in the Frame with the mouse. The sequence of events leading to the Click event is MouseDown, MouseUp, and Click.

Events that apply to the Frame Control are:

AddControl
BeforeDragOver
BeforeDropOrPaste
Click
DblClick

Enter
Error
Exit
KeyDown
KeyPress

KeyUp
Layout
MouseDown
MouseMove
MouseUp

RemoveControl
Scroll
Zoom



How to Use Various Frame Properties

The Frame Control has a number of Properties that are not directly related to the Controls inserted in the Frame. This example demonstrates how the ControlTipText, BackColor, ForeColor, BorderStyle, MouseIcon, MousePointer, ScrollBars, and SpecialEffect Properties change the display of the Frame in a UserForm.

Various Frame Properties Example

The following steps show you how to create Frame Controls using the aforementioned Properties.

1. Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2. On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3. Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4. Draw a series of 13 Frame Controls on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting Frame Controls in a UserForm

5. Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event.

6. Run the UserForm

The UserForm is displayed with one example of the BorderStyle and ControlTipText Properties, five examples of the SpecialEffect Properties, three examples of Color Properties, three examples of Built-In MousePointer Properties and one example which includes using the Custom MousePointer Property to display a MouseIcon Property and the ScrollBars Property.

The ControlTipText Property will not display for a Control which also uses the MousePointer Property.

The BorderStyle and SpecialEffect Properties are mutually exclusive.

Although the Help File for the SpecialEffect Property indicates that the Sunken Constant is the default for the Frame Control, the default for the Frame Control is actually the Etched Constant.

In this example, the Mouse Pointer was positioned over Frame13 causing the Custom MousePointer to be displayed.
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Displaying the Various Forms Control Properties

The UserForm Initialize event macro modifies the Caption and other Properties previously defined for of each of the 13 Frame Controls.

Private Sub UserForm_Initialize()

Frame1.Caption = “BorderStyle”

Frame1.ControlTipText = “This is an example of” _

    & “the Single BorderStyle Property.”

Frame1.BorderStyle = fmBorderStyleSingle

    Frame2.Caption = “Flat SE”

    Frame2.SpecialEffect = fmSpecialEffectFlat

        Frame3.Caption = “Etched SE”

        Frame3.SpecialEffect = fmSpecialEffectEtched

Frame4.Caption = “Bump SE”

Frame4.SpecialEffect = fmSpecialEffectBump

    Frame5.Caption = “Raised SE”

    Frame5.SpecialEffect = fmSpecialEffectRaised

        Frame6.Caption = “Sunken SE”

        Frame6.SpecialEffect = fmSpecialEffectSunken

Frame7.Caption = “BorderColor”

Frame7.BorderStyle = fmBorderStyleSingle

Frame7.BorderColor = RGB(255, 0, 0)

    Frame8.Caption = “BackColor”

    Frame8.BackColor = RGB(255, 255, 0)

        Frame9.Caption = “ForeColor”

        Frame9.ForeColor = RGB(0, 0, 255)

Frame10.Caption = “Help MP”

Frame10.MousePointer = fmMousePointerHelp

    Frame11.Caption = “HourGlass MP”

    Frame11.MousePointer = fmMousePointerHourGlass

        Frame12.Caption = “NoDrop MP”

        Frame12.MousePointer = fmMousePointerNoDrop

Frame13.Caption = “Custom MousePointer, MouseIcon” _

    & “and ScrollBars”

Frame13.ScrollBars = fmScrollBarsBoth

Frame13.MousePointer = fmMousePointerCustom

Frame13.MouseIcon = LoadPicture _

    (“c:\windows\forms\configs\cnfnot.ico”)

End Sub

OptionButton Control

Shows the selection status of one item in a group of choices. Use an OptionButton to show whether a single item in a group is selected. Each OptionButton in a Frame Control is mutually exclusive.

OptionButtons can be grouped by either using the Frame Control or the GroupName Property.

If an OptionButton is bound to a data source, the OptionButton can show the value of that data source as either True or False. Changing the setting changes the value of the data source.

If the user selects the OptionButton, the current setting is True, if the user does not select the OptionButton, the setting is False.

If the TripleState Property is set to True, an OptionButton can have a null value set through code but not through the user interface. The null value is displayed as a shaded button.

A disabled OptionButton is dimmed and does not show a value

Properties

The default property for an OptionButton Control is the Value Property. The Value Property is an integer value indicating whether the item is selected:

Properties that apply to the OptionButton Control are:

Accelerator
Alignment
AutoSize
BackColor
BackStyle

BoundValue
Caption
ControlSource
ControlTipText
Enabled

Font (Object)
ForeColor
GroupName
Height
HelpContextId

LayoutEffect
Left
Locked
MouseIcon
MousePointer

Name
Object
OldHeight
OldLeft
OldTop

OldWidth
Parent
Picture
PicturePosition
SpecialEffect

TabIndex
TabStop
Tag
Top
TripleState

Value
Visible
Width
WordWrap


Methods

The Methods that apply to the OptionButton Control are Move, SetFocus and Zorder.

The Move Method is used to reposition the OptionButton a specific distance from its current position on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified OptionButton. If the OptionButton is in a Frame that contains other controls, the focus moves to the first control in the Frame, and subsequent keyboard events apply to the control that has the focus.

The Zorder Method is used to position an OptionButton Control above or below other Objects that are stacked one on top of another.

Events

The default event for an OptionButton is the Click Event. Occurs when the user clicks on the OptionButton with the mouse. The sequence of events leading to the Click event is MouseDown, MouseUp, and Click.

Events that apply to the OptionButton Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

Click
DblClick
Enter
Error
Exit

KeyDown
KeyPress
KeyUp
MouseDown
MouseMove

MouseUp





How to Return the Selected OptionButton in a Frame Control

When multiple OptionButtons Controls are grouped in a Frame Control, selecting any one OptionButton deselects the other OptionButtons in the Frame. In order to determine which OptionButton was selected, we must loop through all the OptionButtons to see which Control has a Value Property set to True.

Return Selected OptionButton in Frame Example

The following steps show you how to loop through the OptionButtons in a Frame Control to determine which OptionButton had been selected.

1 Create a new file in Microsoft Excel, Microsoft PowerPoint, icrosoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw a Frame Control with three OptionButton Controls inserted into the Frame Control then add a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting OptionButton Controls in a UserForm

5 Double-click the UserForm to display the UserForm Code Window and type the code below for the CommandButton1 Click Event.
6 Run the UserForm

Selecting one of the OptionButtons (OptionButton 2 in the example displayed below) and clicking on the CommandButton places the caption to the left of the OptionButton Control.
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Selecting an OptionButton Control

The CommandButton1 Click event macro loops through each OptionButton and checks its Value Property. If the Value Property is set to True, it sets the Alignment Property to fmAlignementLeft which positions the OptionButton Caption to the Left of the Option Button. If the Value Property is set to False, it sets the Alignment Property to fmAlignementRight which positions the OptionButton Caption to the Right of the Option Button.

Private Sub CommandButton1_Click()

For Each x In Frame1.Controls

   If x.Value = True Then

      x.Alignment = fmAlignmentLeft

   Else

      x.Alignment = fmAlignmentRight

   End If

Next x

End Sub

How to Return the Selected OptionButton in a Group

To create a Group of mutually exclusive OptionButton Controls, you can put the buttons in a Frame on your form, or you can use the GroupName Property. GroupName is more efficient for the following reasons:

· You do not have to include a Frame for each group. By not using a Frame, you reduce the number of controls on the form, and in turn, improve performance and reduce the size of the form.

· You have more design flexibility. If you use a Frame to create the group, all the buttons must be inside the Frame. If you want more than one group, you must have one Frame for each group. However, if you use GroupName to create the group, the group can include option buttons anywhere on the form. If you want more than one group, specify a unique name for each group; you can still place the individual controls anywhere on the form.

· You can create buttons with transparent backgrounds, which can improve the visual appearance of your form. The Frame is not a transparent control.

To determine which OptionButton has been selected when you have multiple groups, use the GroupName Property to loop through all of the controls that are part of each Group. Within the Group, loop through each control and check the Value Property to see which OptionButton Control in the Group has been selected.

Return Selected OptionButton in Group Example

The following steps show you how to loop through the all of the Groups in an UserForm and loop through each OptionButton within each Group to determine which OptionButtons had been selected.

1 Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw nine OptionButton Controls and a CommandButton Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting OptionButton Controls in a UserForm

5 Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event and the CommandButton1 Click Event.
6 Run the UserForm

Each Group is displayed with a different color background. Select one OptionButton from each Group and click on the CommandButton. A Message Box will be displayed for each Group selected..
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Selecting an OptionButton Control

The UserForm Initialize event macro sets the GropeName and BackColor Properties for each of the nine OptionButtons in each of the three Groups.

The CommandButton1 Click event macro loops through each Control in the UserForm using the Me Keyword. Within this loop, the macro uses an If Statement and the Name Property to locates only those Controls that have “Option” (OptionButton) in their Name. It then checks these Controls to see if the Control’s Value Property is set to True. Lastly it uses a Select Case Statement and the GroupName Property to determine which of the three Groups this OptionButton Control is set for and displays the result in a Message Box.

Private Sub UserForm_Initialize()

'Setup the first Group

OptionButton1.GroupName = "Red"

OptionButton1.BackColor = RGB(256, 128, 128)

OptionButton3.GroupName = "Red"

OptionButton3.BackColor = RGB(256, 128, 128)

OptionButton7.GroupName = "Red"

OptionButton7.BackColor = RGB(256, 128, 128)

OptionButton9.GroupName = "Red"

OptionButton9.BackColor = RGB(256, 128, 128)

'Setup the second Group

OptionButton2.GroupName = "Green"

OptionButton2.BackColor = RGB(128, 256, 128)

OptionButton5.GroupName = "Green"

OptionButton5.BackColor = RGB(128, 256, 128)

OptionButton6.GroupName = "Green"

OptionButton6.BackColor = RGB(128, 256, 128)

'Setup the third Group

OptionButton4.GroupName = "Blue"

OptionButton4.BackColor = RGB(128, 128, 256)

OptionButton8.GroupName = "Blue"

OptionButton8.BackColor = RGB(128, 128, 256)

End Sub

Private Sub CommandButton1_Click()

For Each x In Me.Controls

   If InStr(x.Name, "Option") Then

      If x.Value = True Then

         Select Case x.GroupName

            Case "Red"

               MsgBox x.Caption & " was selected " & _

                   "from the Red Group"

            Case "Green"

               MsgBox x.Caption & " was selected " & _

                   "from the Green Group"

            Case "Blue"

               MsgBox x.Caption & " was selected " & _

                  "from the Blue Group"

         End Select

      End If

   End If

Next x

End Sub

CheckBox Control

Displays the selection state of the CheckBox. Use a CheckBox Control to give the user a choice between True and False. When the user selects a CheckBox, it displays a check mark in the box and its current setting is True, if the user does not select the CheckBox, it is empty and its setting is False.

Depending on the value of the TripleState Property, a CheckBox can also have a null value. If a CheckBox is bound to a data source, changing the setting changes the value of that source. A disabled CheckBox shows the current value, but is dimmed and does not allow changes to the value from the user interface.

You can create a group of CheckBox Controls inside a Frame Control or as part of a Named Group but they will not be mutually exclusive.

The ListBox Control also lets you put a check mark by selected options. Depending on your application, you can use the ListBox Control instead of using a group of CheckBox Controls.

Properties

The default property for a CheckBox Control is the Value Property, an integer value indicating whether the item is selected:

· Null

Indicates the item is in a null state, neither selected nor cleared.

· –1

True. Indicates the item is selected.

·   0

False. Indicates the item is cleared.

Properties that apply to the CheckBox Control are:

Accelerator
Alignment
AutoSize
BackColor
BackStyle

BoundValue
Caption
ControlSource
ControlTipText
Enabled

Font (Object)
ForeColor
Height
HelpContextId
LayoutEffect

Left
Locked
MouseIcon
MousePointer
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
Picture
PicturePosition
SpecialEffect
TabIndex

TabStop
Tag
Top
TripleState
Value

Visible
Width
WordWrap



Methods

The Methods that apply to the CheckBox Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the CheckBox a specific distance from its current position on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified CheckBox. If the CheckBox is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a CheckBox Control above or below other Objects that are stacked one on top of another.

Events

The default event for a CheckBox is the Click Event. Occurs when the user clicks on the CheckBox with the mouse. The sequence of events leading to the Click event is MouseDown, MouseUp, and Click.

Events that apply to the CheckBox Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

Click
DblClick
Enter
Error
Exit

KeyDown
KeyPress
KeyUp
MouseDown
MouseMove

MouseUp





How to Determine the CheckBox Control Value

The Value Property can return a True if the CheckBox is Checked, a False if the CheckBox is not checked and, if the TripleState Property is set to True, can return a Null.

Determining the CheckBox Control Value Example

The following steps show you how to determine the Value of the CheckBox Property.

1 Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw a CheckBox Control on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting a CheckBox Control in a UserForm

5 If the Properties Window is not visible, click Properties on the View Menu.

6 Change the TripleState Property of the CheckBox Control to True.
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Setting the TripleState Property to True

You could also set the TripleState Property to True by using the following UserForm Initialization macro:

Private Sub UserForm_Initialize()

CheckBox1.TripleState = True

End Sub

7 Double-click the UserForm to display the UserForm Code Window and type the code below for the CheckBox Change Event.

[image: image80.wmf]
Although the Click Event is default event for a CheckBox, it will not detect a CheckBox Click Event if the CheckBox contains a Null Value. Use the CheckBox Change Event if the TripleState Property is set to True.

8 Run the UserForm

Repeated clicking on the CheckBox will change its value from False to Null to True and back to False. As each change is made, the CheckBox Caption will change to reflect the Value being set.
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Clicking on the CheckBox Control

The CheckBox1 Change event macro uses a Select Case Statement to determine if the Value Property of the CheckBox is set to True, False or Null. In each case, The CheckBox Caption Property is changed to reflect the CheckBox Value.

Private Sub CheckBox1_Change()

Select Case CheckBox1.Value

    Case True

        CheckBox1.Caption = "True"

    Case False

        CheckBox1.Caption = "False"

    Case Else

        CheckBox1.Caption = "Null"

End Select

End Sub

How to Create a Group of Mutually Exclusive CheckBox Controls

CheckBox and ToggleButton Controls are not mutually exclusive even when in a Frame Control or Control Group. We can, however, make them behave this way with a macro by setting the Value Property for the selected Control to True and setting the Value Property for the remaining Controls to False.

Creating Mutually Exclusive Controls Example

The following steps show you how to create mutually exclusive controls.

1 Create a new file in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw three CheckBox Controls on the UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting CheckBox Controls in a UserForm

5 Double-click the UserForm to display the UserForm Code Window and type the code below for the three CheckBox MouseUp Events.

6 Insert a Module into your document. To do this, click Module on the Insert Menu.

7 In the Module, type the code below for the ExclusiveControls macro. Be sure that the Public Statement is the first line in the Module.

8 Run the UserForm

Clicking on any one CheckBox will cause the other CheckBox Controls to loose their selection check marks.
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Clicking on a CheckBox Control

The CheckBox(1, 2, 3) MouseUp event macros all use the Variable named Clicked to capture the Name of the CheckBox and call the “ExclusiveControls” macro using an OnTime Method.

On the Module, the Public Variable named Clicked is created for use by all macros in this document to capture the name of the CheckBox that was selected by the user.

The ExclusiveControls macro loops through all the Controls in the UserForm. The If Statement then compares the name of each Control in the For Each Loop with the Control name that was stored in the Clicked Variable. If the Names match, the Value Property is set to True. If the names do not match, the Value Property is set to False, insuring that the other controls are all deselected.

To limit the Controls tested, you could put the CheckBox Controls in a Frame Control and change the For Each Statement in the ExclusiveControls macro to:

For Each toggle in UserForm1.Frame1.Controls
In the UserForm…

Private Sub CheckBox1_MouseUp(ByVal Button As Integer, _

   ByVal Shift As Integer, ByVal X As Single, _

   ByVal Y As Single)

Clicked = CheckBox1.Name

Application.OnTime Now, "ExclusiveControls"

End Sub

Private Sub CheckBox2_MouseUp(ByVal Button As Integer, _

   ByVal Shift As Integer, ByVal X As Single, _

   ByVal Y As Single)

Clicked = CheckBox2.Name

Application.OnTime Now, "ExclusiveControls"

End Sub

Private Sub CheckBox3_MouseUp(ByVal Button As Integer, _

   ByVal Shift As Integer, ByVal X As Single, _

   ByVal Y As Single)

Clicked = CheckBox3.Name

Application.OnTime Now, "ExclusiveControls"

End Sub

In the Module…

Public Clicked As String

Sub ExclusiveControls()

Dim toggle As Control

For Each toggle In UserForm1.Controls

    If toggle.Name = Clicked Then

        toggle.Value = True

    Else

        toggle.Value = False

    End If

Next

End Sub

ToggleButton Control

A ToggleButton Control is identical to a CommandButton Control in appearance until you click it. When you click to select a ToggleButton, it appears to be depressed (pushed down). The Value property of a ToggleButton control is True when the button is selected or False when it is not selected.

Depending on the value of the TripleState property, a ToggleButton can also have a value of Null. A ToggleButton set to a value of Null appears dimmed.

If a ToggleButton is bound to a data source, the ToggleButton shows the current value of that data source as either True or False.

A disabled ToggleButton shows a value, but is dimmed and does not allow changes from the user interface. 

You can also use a ToggleButton inside a Frame to select one or more of a group of related items.

Properties

The default property for a ToggleButton Control is the Value Property, an integer value indicating whether the item is selected:

· Null

Indicates the item is in a null state, neither selected nor cleared.

· –1

True. Indicates the item is selected.

·   0

False. Indicates the item is cleared.

Properties that apply to the ToggleButton Control are:

Accelerator
Alignment
AutoSize
BackColor
BackStyle

BoundValue
Caption
ControlSource
ControlTipText
Enabled

Font (Object)
ForeColor
Height
HelpContextId
LayoutEffect

Left
Locked
MouseIcon
MousePointer
Name

Object
OldHeight
OldLeft
OldTop
OldWidth

Parent
Picture
PicturePosition
SpecialEffect
TabIndex

TabStop
Tag
Top
TripleState
Value

Visible
Width
WordWrap



Methods

The Methods that apply to the ToggleButton Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the ToggleButton a specific distance from their current positions on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified ToggleButton. If the ToggleButton is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a ToggleButton Control above or below other Objects that are stacked one on top of another.

Events

The default event for a ToggleButton is the Click Event. Occurs when the user clicks on the ToggleButton with the mouse. The sequence of events leading to the Click event is MouseDown, MouseUp, and Click.

Events that apply to the ToggleButton Control are:

AfterUpdate
BeforeDragOver
BeforeDropOrPaste
BeforeUpdate
Change

Click
DblClick
Enter
Error
Exit

KeyDown
KeyPress
KeyUp
MouseDown
MouseMove

MouseUp





How to Determine the ToggleButton Control Value

The ToggleButton and CheckBox Controls use the same Properties, Methods, and Events. Use the example for “How to Determine the CheckBox Control Value,” substituting the text “ToggleButton” in place of “CheckBox” in the example.

How to Bind ToggleButton Controls to an Microsoft Excel Worksheet

The Value Property can return to an Microsoft Excel Worksheet Cell, a True if the ToggleButton is selected, a False if the ToggleButton is not selected and, if the TripleState Property is set to True, a Null. Use the ControlSource Property to associate the ToggleButton Value with a worksheet cell.

Binding a ToggleButton Control to a Worksheet Example

The following steps show you how to determine the Value of the OptionButton Property.

1 Create a new Workbook in Microsoft Excel.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw a Frame Control and three ToggleButton Controls in the Frame (Drag n’ Drop or Click n’ Draw).

The Frame Control is not necessary to make the ToggleButtons work but it does demonstrate that the Frame Control does not make the ToggleButtons (or CheckBoxes) mutually exclusive.
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Inserting a Frame and ToggleButton Controls in a UserForm

5 If the Properties Window is not visible, click Properties on the View Menu.

6 Change the TripleState Property of each of the three the ToggleButton Controls to True.
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Setting the TripleState Property to True

You could also set the TripleState Property to True by using the following UserForm Initialization macro:

Private Sub UserForm_Initialize()

ToggleButton1.TripleState = True

ToggleButton2.TripleState = True

ToggleButton3.TripleState = True

End Sub

7 Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event.

8 Run the UserForm

Repeated clicking on the ToggleButtons will change the values in Sheet 1, cells A1, A2, and A3 from False to Null to True and back to False and change the ToggleButtons displayed in the UserForm from not selected (popped out), to greyed-out, to selected (pushed in). The ToggleButtons are not mutually exclusive in the Frame Control as OptionButton Controls would be.
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Clicking on the ToggleButton Controls

The UserForm Intialize event macro uses the ControlSource Property to link cells A1, A2, and A3 of the currently selected worksheet to the ToggleButtons.

Private Sub UserForm_Initialize()

ToggleButton1.ControlSource = "A1"

ToggleButton2.ControlSource = "A2"

ToggleButton3.ControlSource = "A3"

End Sub

How to Create a Group of Mutually Exclusive ToggleButton Controls

The ToggleButton and CheckBox Controls use the same Properties, Methods, and Events. Use the example for “How to Create a Group of Mutually Exclusive CheckBox Controls,” substituting the text “ToggleButton” in place of “CheckBox” in the example.

TabStrip Control
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A TabStrip Control presents a set of related controls as a visual group.

The TabStrip is implemented as a container of a Tabs collection, which in turn contains a group of Tab objects.

You can use a TabStrip to view different sets of information for related controls. When you switch between Tabs, the Controls remain the same but can show different information for each Tab selected. 

For example, the controls might represent information about a daily schedule for a group of individuals, with each set of information corresponding to a different individual in the group. Set the title of each tab to show one individual's name. Then, you can write code that, when you click a tab, updates the controls to show information about the person identified on the tab.

The TabStrip Control is created with two Tabs. To add additional tabs, alternate-click on one of the Tabs in the TabStrip Control and choose “New Page.”

Properties

The default property for a TabStrip Control is the SelectedItem Property which returns the currently selected Tab.

The Value Property is not listed in the Help file. It returns an integer of the currently active Tab in the Tabs collection of the TabStrip. Zero (0) indicates the first Tab. The maximum value is one less than the number of Tabs.

Properties that apply to the TabStrip Control are:

BackColor
BoundValue
ClientHeight
ClientLeft
ClientTop

ClientWidth
ControlTipText
Enabled
Font (Object)
ForeColor

Height
HelpContextId
LayoutEffect
Left
MouseIcon

MousePointer
MultiRow
Name
Object
OldHeight

OldLeft
OldTop
OldWidth
Parent
SelectedItem

Style
TabFixedHeight
TabFixedWidth
TabIndex
TabOrientation

TabStop
Tag
Top
Value
Visible

Width





Methods

The Methods that apply to the TabStrip Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the TabStrip a specific distance from its current position on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified TabStrip. If the TabStrip is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a TabStrip Control above or below other Objects that are stacked one on top of another.

Events

The default event for a TabStrip is the Change Event which occurs when the Value Property of the TabStrip Control changes, regardless of whether the change results from execution of code or when the user clicks on a TabStrip Tab with the mouse.

Events that apply to the TabStrip Control are:

BeforeDragOver
BeforeDropOrPaste
Change
Click
DblClick

Enter
Error
Exit
KeyDown
KeyPress

KeyUp
MouseDown
MouseMove
MouseUp


How to Manipulate Controls in a TabStrip

The advantage of using a TabStrip is that you can display multiple values for the same controls by selecting a Tab.

This example demonstrates how to modify the appearance of an Image Control and a TextBox Control when the user chooses a Tab on a TabStrip Control. The Change Event will only occur if you change the currently selected Tab.

Manipulating Controls in a TabStrip Example

The following steps show you how to change the Value Property of Controls in a TabStrip Control.

1 Create a new File in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw a TabStrip Control and place an Image Control and a TextBox Control in the TabStrip Control (Drag n’ Drop or Click n’ Draw).
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Inserting TabStrip, Image, and TextBox Controls in a UserForm

5 Double-click the TabStrip to display the UserForm Code Window and type the code below for the TabStrip Change Event.

6 Run the UserForm

The Image Controls background color starts out as White and changes to Green or Red depending on which Tab is selected. The Text Control starts out as blank and changes to the text “Green” or “Red” depending on which Tab is selected.

[image: image204.png]


Clicking on Tab2 in the TabStrip Control

The TabStripChange event macro uses the Select Case Statement to test the Index Property of the currently selected Tab. Based on the Index Property value stored in the “i” Variable, it selects a Case that changes the BackColor Property of the Image Control and Text Property of the TextBox Control.

Private Sub TabStrip1_Change()

Dim i As Integer

i = TabStrip1.SelectedItem.Index

Select Case i

    Case 0 'Change color and text to Red.

        Image1.BackColor = RGB(255, 0, 0)

        TextBox1.Text = "Red"

    Case 1 'Change color and text to Green.

        Image1.BackColor = RGB(0, 255, 0)

        TextBox1.Text = "Green"

End Select

End Sub
How to Substitute Displayed Controls in a TabStrip

A TabStrip normally displays the same Controls on all Tabs. There may, however, be a situation where most of the controls are identical, but you need to use a different Control on some Tabs in a TabStrip. This example demonstrate the use of the ZOrder Method as one technique for stacking Controls and placing the Control you wish to use on a particular Tab on the top of the stack.

If you are changing most or all of the controls on a Tab (as we are doing in this example), it is more appropriate to use the MultiPage Control.

ZOrder Method to Stack Controls in a TabStrip Example

The following steps show you how to stack Controls in a TabStrip Control and switch the order of the stack based upon the selected Tab.

1 Create a new File in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Separately draw a TabStrip Control, ListBox Control, and Frame Control in the UserForm. Within the Frame Control, insert three OptionButton Controls (Drag n’ Drop or Click n’ Draw).
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Inserting Separate Controls in a UserForm

5 Drag the Frame Control onto the TabStrip Control, then drag the ListBox Control over the Frame Control. This will stack the all three controls with the ListBox on top. You may wish to appropriately resize UserForm once the Controls have been stacked.

6 Double-click the TabStrip to display the UserForm Code Window and type the code below for the TabStrip Change Event.

7 Run the UserForm

The UserForm is displayed with the ListBox Control on top of the Frame Control on Tab1. When you select Tab2, the Frame Control is placed on top of the ListBox Control. For examples of how to use ListBox, Frame, and OptionButton Controls, please see the previously documented Controls above.
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Clicking on Tab1 or Tab2 in the TabStrip Control

The TabStripChange event macro uses the Select Case Statement to test the Index Property of the currently selected Tab. Based on the Index Property value stored in the “i” Variable, it selects a Case for that Tab which uses the ZOrder Method to place the appropriate Control on the top (fmtop) of the stacked Controls.

Private Sub TabStrip1_Change()

Dim i As Integer

i = TabStrip1.SelectedItem.Index

Select Case i

    Case 0 'Place the ListBox Control on top.

        ListBox1.ZOrder fmtop

    Case 1 'Place the Frame Control on top.

        Frame1.ZOrder fmtop

End Select

End Sub

TabStrip Knowledge Base Articles

[image: image81.png]



Q155009 Microsoft Excel – How to Use the TabStrip Control in a UserForm
This article explains how to use the TabStrip control in a UserForm, and provides an example of how to create a group of mutually exclusive ToggleButton controls on a UserForm. Use a TabStrip control to view different sets of information for related controls. A TabStrip is recommended if you use a singe layout for your data. For example, use different Tabs in a TabStrip control to display different "views" for one group of controls. The TabStrip is implemented as a container of a Tabs collection, which in turn contains a group of Tab objects. By default, the control contains two Tabs; you can add or remove Tabs as needed. The client region of a TabStrip control is not a separate form. Instead, the region is a portion of the form that contains the TabStrip control. The border of a TabStrip control defines a region of the form that you can associate with Tabs. When you place a control in the client region of a TabStrip, you are adding a control to the form that contains the TabStrip.

MultiPage Control
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A MultiPage Control presents multiple screens of information as a single set.

The MultiPage is a container of a Pages collection, each of which contains one or more Page objects.

A MultiPage is useful when you work with a large amount of information that can be sorted into several categories.

For example, use a MultiPage to display information from an employment application. One page might contain personal information such as name and address; another page might list previous employers; a third page might list references.

The MultiPage lets you visually combine related information, while keeping the entire record readily accessible. New pages are added to the right of the currently selected page rather than adjacent to it.

The MultiPage Control is created with two Pages. To add additional Pages, alternate-click on one of the Page tabs in the Multipage Control and choose “New Page.”

Properties

The default property for a MultiPage is the Value property, which returns an integer of the currently active Page in the Pages collection of the MultiPage. Zero (0) indicates the first page. The maximum value is one less than the number of pages.

Properties that apply to the MultiPage Control are:

BackColor
BoundValue
ControlTipText
Enabled
Font (Object)

ForeColor
Height
HelpContextId
LayoutEffect
Left

MultiRow
Name
Object
OldHeight
OldLeft

OldTop
OldWidth
Parent
SelectedItem
Style

TabFixedHeight
TabFixedWidth
TabIndex
TabOrientation
TabStop

Tag
Top
Value
Visible
Width

Methods

The Methods that apply to the MultiPage Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the MultiPage a specific distance from its current position on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified MultiPage Control. If the MultiPage Control is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a MultiPage Control above or below other Objects that are stacked one on top of another.

Events

The default event for a MultiPage is the Change Event which occurs when the Value Property of the MultiPage Control changes, regardless of whether the change results from execution of code or when the user clicks on a Page with the mouse.

Events that apply to the MultiPage Control are:

AddControl
BeforeDragOver
BeforeDropOrPaste
Change
Click

DblClick
Enter
Error
Exit
KeyDown

KeyPress
KeyUp
Layout
MouseDown
MouseMove

MouseUp
RemoteControl
Scroll
Zoom


How to Manipulate Controls in a MultiPage

You can use a MultiPage Controls to collect information using different Controls on each Page.

Manipulating Controls in a MultiPage Example

Although a MultiPage Control can display any type of Control and different Controls on each Page, this example uses Label and TextBox Controls to collect Name, Address, and Phone Number information. This macro is used as the basis for the following Wizard User Interface example.

1 Create a new File in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw a MultiPage Control with four Pages (Drag n’ Drop or Click n’ Draw).

To add an additional Pages, alternate-click on one of the Page tabs in the Multipage Control and choose “New Page.”

· On Page 1, add a Label Control and a TextBox Control.

· On Page 2, add two Label Controls and a Text Control.

· On Page 3, add three Label Controls and a TextBox Control.

· On Page 4. add four Label Controls and a CommandButton Control
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Inserting MultiPage and Page 1, Label, and TextBox Controls in a UserForm
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Inserting Page 2 and 3 Label and TextBox Controls in the MultiPage Control
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Inserting Page 4, Label and CommandButton Controls in the MultiPage Control

5 Select Page1 so it will be displayed when the UserForm is run.

6 Double-click the TabStrip to display the UserForm Code Window and type the code below for the UserForm Initialize, MultiPage Change, and CommandButton Click Events.

7 Run the UserForm

Page 1 is displayed.

Information entered in the Name TextBox on Page 1 is displayed in the Name Label of Pages 2, 3, and 4.

Information entered in the Address TextBox on Page 2 is displayed in the Address Label of Pages 3 and 4.

Information entered in the Phone Number TextBox on Page 3 is displayed in the Phone Number Label of Page 4.

Clicking on the OK button closes the UserForm. It this point the code could be enhanced to store the Name, Address, and Phone Number in the location of choice.
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Clicking on Page4 after entering data on Pages 1, 2, and 2 of the MultiPage Control

The UserForm Initialize event macro uses the Caption Property to set the text in the top Label in each Page of the MultiPage Control and changes the Caption of the CommandButton Control to “OK.”

The MultiPage1 Change event macro uses the Select Case Statement to test the Value Property of the currently selected Page. Based on the Value Property (which ranges from 0 to 3), data captured from the TextBox Control’s Text Property is used to update the appropriate Label Control’s Caption Property. As no changes are made to any Controls on Page 1, we do not need to select Case 0.

The CommandButton Click event macro uses the Unload Me Statement to close the UserForm.

Private Sub UserForm_Initialize()

Label1.Caption = "Please enter User's name."

Label2.Caption = "Please enter User's address."

Label4.Caption = "Please enter User's Phone Number."

Label7.Caption = "If correct, click OK"

CommandButton1.Caption = "OK!"

End Sub

Private Sub MultiPage1_Change()

Select Case MultiPage1.Value

    Case 1

        Label3.Caption = TextBox1.Text

    Case 2

        Label5.Caption = TextBox1.Text

        Label6.Caption = TextBox2.Text

    Case 3

        Label8.Caption = TextBox1.Text

        Label9.Caption = TextBox2.Text

        Label10.Caption = TextBox3.Text

End Select

End Sub

Private Sub CommandButton1_Click()

Unload Me

End Sub

How to Create a UserForm Wizard

When a task requires several incremental steps, a Wizard interface can be very effective. Instead of using multiple UserForms to create a Wizard from a sequence of Dialog Boxes, you can use a MultiPage Control.

Wizard User Interface Example

You can use the Pages and Value Properties of a MultiPage Control to create a Wizard interface. This example builds upon the previous Manipulating Controls in a MultiPage Example. For the basic layout of the UserForm, please refer to the aforementioned example.

· Create a UserForm as per the Manipulating Controls in a MultiPage Example, Steps 1-5.

6 Expand the UserForm downward to make room for two CommandButton Controls between the MultiPage and the bottom of the UserForm.

7 Insert CommandButton2 on the right and CommandButton 3 on the left below the MultiPage Control. Do not put the CommandButtons in the MultiPage Control.
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Inserting Two Additional CommandButtons in the UserForm

8 Double-click the TabStrip to display the UserForm Code Window and type the code below for the UserForm Initialize and CommandButton1, 2, and 3 Click Events.

9 Run the UserForm

Page 1 is displayed. To get to Page 2, 3, or 4, click the “Next>” Button. Use the “<Back” Button to return to a previously displayed Page.

Information entered in the Name TextBox on Page 1 is displayed in the Name Label of Pages 2, 3, and 4.

Information entered in the Address TextBox on Page 2 is displayed in the Address Label of Pages 3 and 4.

Information entered in the Phone Number TextBox on Page 3 is displayed in the Phone Number Label of Page 4.

Clicking on the OK button closes the UserForm. It this point the code could be enhanced to store the Name, Address, and Phone Number in the location of choice.
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Clicking on Next> after entering data on Pages 1, 2, and 2 of the MultiPage Control

The UserForm Initialize event macro uses the Caption Property to set the text in the top Label in each Page of the MultiPage Control and changes the Caption Property of the CommandButton Control to “OK.” The macro then disables the tabs for Pages 2, 3, and 4 by setting the Enabled Property to False, and activates Page 1 of the MultiPage Control by setting the Value Property of the MultiPage Control to “0.” Finally, it sets the Caption Property of the Next> and <Back Buttons and disables the <Back Button (CommandButton2).

The CommandButton1 Click event macro uses the Unload Me Statement to close the UserForm.

The CommandButton2 Click event macro controls the incrementing of the Pages. The Macro uses a Select Case Statement to test the Value Property of the currently selected Page. The Value Property ranges from 0 to 3, data captured from the TextBox Control’s Text Property is used to update the appropriate Label Control’s Caption Property. As we cannot move forward from Page 4, we do not need to select Case 3. Next, it disables the Page we are leaving and enables the page we are going to by changing the value of the Enabled Property for the appropriate Page, then it sets the Value Property to display the page we are going to. If we are leaving Page 1, it enables the <Back Button, and if we are going to Page 4, it disables the Next> Button by changing the value of the Enabled Property for the appropriate CommandButton.

The CommandButton3 Click event macro controls the decrementing of the Pages. The Macro uses a Select Case Statement to test the Value Property of the currently selected Page. Value Property ranges from 0 to 3. As we cannot move backward from Page 1, we do not need to select Case 0. Next, it disables the Page we are leaving and enables the page we are going to by changing the value of the Enabled Property for the appropriate Page, then it sets the Value Property to display the page we are going to. If we are leaving Page 4, it enables the Next> Button, and if we are going to Page 1, it disables the <Back Button by changing the value of the Enabled Property for the appropriate CommandButton.

Private Sub UserForm_Initialize()

Label1.Caption = "Please enter User's name."

Label2.Caption = "Please enter User's address."

Label4.Caption = "Please enter User's Phone Number."

Label7.Caption = "If correct, click OK"

CommandButton1.Caption = "OK!"

With MultiPage1

   .Pages(1).Enabled = False

   .Pages(2).Enabled = False

   .Pages(3).Enabled = False

   .Value = 0

End With

CommandButton2.Caption = "Next>"

CommandButton3.Caption = "<Back"

CommandButton3.Enabled = False

End Sub

Private Sub CommandButton1_Click()

Unload Me

End Sub

Private Sub CommandButton2_Click()

Select Case MultiPage1.Value 'Used for the "Next>" Button

   Case 0 'On Page 1, going to Page 2

      Label3.Caption = TextBox1.Text 'Store Name in Label3.

      With MultiPage1

         .Pages(0).Enabled = False 'Disable Page 1

         .Pages(1).Enabled = True 'Enable Page 2

         .Value = 1 'Activate Page 2

      End With

      CommandButton3.Enabled = True 'Enable "<Back" Button

   Case 1 'On Page 2, going to Page 3

      Label5.Caption = TextBox1.Text 'Store Name in Label5.

      Label6.Caption = TextBox2.Text 'Store Address in Label6.

      With MultiPage1

         .Pages(1).Enabled = False 'Disable Page 2

         .Pages(2).Enabled = True 'Enable Page 3

         .Value = 2 'Activate Page 3

      End With

   Case 2 'On Page 3, going to Page 4

      Label8.Caption = TextBox1.Text 'Store Name in Label8.

      Label9.Caption = TextBox2.Text 'Store Address in Label9.

      Label10.Caption = TextBox3.Text 'Store Ph. # in Label10.

      With MultiPage1

         .Pages(2).Enabled = False 'Disable Page 3

         .Pages(3).Enabled = True 'Enable Page 4

         .Value = 3 'Activate Page 4

      End With

      CommandButton2.Enabled = False 'Disable "Next>" Button

End Select

End Sub

Private Sub CommandButton3_Click()

Select Case MultiPage1.Value 'Used for the "<Back" Button

   Case 1 'On Page 2, going to Page 1

      With MultiPage1

         .Pages(1).Enabled = False 'Disable Page 2

         .Pages(0).Enabled = True 'Enable Page 1

         .Value = 0 'Activate Page 1

      End With

      CommandButton3.Enabled = False 'Disable "<Back" Button

   Case 2 'On Page 3, going to Page 2

      With MultiPage1

         .Pages(2).Enabled = False 'Disable Page 3

         .Pages(1).Enabled = True 'Enable Page 2

         .Value = 1 'Activate Page 2

      End With

   Case 3 'On Page 4, going to Page 3

      With MultiPage1

         .Pages(3).Enabled = False 'Disable Page 4

         .Pages(2).Enabled = True 'Enable Page 3

         .Value = 2 'Activate Page 3

      End With

      CommandButton2.Enabled = True 'Enable "Next>" Button

End Select

End Sub

Multipage Knowledge Base Articles
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Q155374 Microsoft Excel – How to Use the MultiPage Control in a UserForm

This article explains how to use the MultiPage control in a UserForm and provides an example.

ScrollBar Control

Returns or sets the value of another control based on the position of the Scroll Box within the ScrollBar.

A ScrollBar is a stand-alone control you can place on a form. It is visually like the scroll bar you see in certain objects such as a ListBox or the drop-down portion of a ComboBox. However, unlike the scroll bars in these examples, the stand-alone ScrollBar is not an integral part of any other control.

To create a horizontal or vertical ScrollBar, drag the sizing handles of the ScrollBar horizontally or vertically on the form.

To use the ScrollBar to set or read the value of another control, you must write code for the ScrollBar’s Events and Methods.

For example, to use the ScrollBar to update the value of a TextBox, you can write code that reads the Value Property of the ScrollBar and then sets the Value Property of the TextBox.

Properties

The default property for a ScrollBar Control is the Value Property, an Integer between the values specified for the Max and Min Properties.

Properties that apply to the ScrollBar Control are:

BackColor
BoundValue
ControlSource
ControlTipText
Delay

Enabled
ForeColor
Height
HelpContextId
LargeChange

LayoutEffect
Left
Max
Min
MouseIcon

MousePointer
Name
Object
OldHeight
OldLeft

OldTop
OldWidth
Orientation
Parent
ProportionalThumb

SmallChange
TabIndex
TabStop
Tag
Top

Value
Visible
Width



Methods

The Methods that apply to the ScrollBar Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the ScrollBar a specific distance from their current positions on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified ScrollBar. If the ScrollBar is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a ScrollBar Control above or below other Objects that are stacked one on top of another.

Events

The default event for a ScrollBar is the Change Event. It occurs when the scroll box is moved within the ScrollBar. The Change event procedure can synchronize or coordinate data displayed among controls. For example, you can use the Change Event procedure of the ScrollBar to update the contents of a TextBox that displays the Value of the ScrollBar.

Events that apply to the ScrollBar Control are:

AfterUpdate
BeforeDragOver
BeforeUpdate
Change
Enter

Error
Exit
KeyDown
KeyPress
KeyUp

Scroll





How to Modify a Date With a ScrollBar Control

You can use the Value Property of a ScrollBar Control to modify the contents of another Control.

Modify a Date With a ScrollBar Control Example

In this example, the ScrollBar position changes the Date displayed in a Label Control.

1 Create a new File in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw two Label Controls and a ScrollBar Contol in a UserForm (Drag n’ Drop or Click n’ Draw).

To create a horizontal ScrollBar control, Click and Draw the control from left to right.
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Inserting Label and ScrollBar Controls in a UserForm

5 Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event and the ScrollBar Change Event.

6 Run the UserForm

Sliding the scroll box left or right updates both labels. The top label displays a day and date. The bottom label displays how many days this date is from today’s date.
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Sliding the Scroll Box in the ScrollBar Control to the Left

The UserForm Intialize event macro uses the Min and Max Properties of the ScrollBox Control to set the negative and positive limits for the date to be displayed in days. The Caption Property for Label 1 is set to display today’s date and the Caption Property for Label 2 is set to a text string indicating that the date displayed in Label 1 is today’s date.

The ScrollBar Change event macro updates the Caption Property of Label 1 with a text string containing today’s date, incremented or decremented by ScrollBar Control’s Value Property. Next, the macro uses a Select Case Statement to test the Value Property of the ScrollBox Control. Based on the Value Property (which ranges from –2,000 to +2,000), the Case Statement uses the ScrollBar Caption Property to change the text in Label 2 with one of the following methods. If the Value of the ScrollBar is less then –1 or greater then +1, the Value of the ScrollBar is concatinated into the text for the Label 2 Caption. If the Value is –1, 0, or +1, a text string is used for the Label 2 Caption.

Private Sub UserForm_Initialize()

ScrollBar1.Min = -2000

ScrollBar1.Max = 2000

Label1.Caption = Format(Date, "Long Date")

Label2.Caption = "Is today's date."

End Sub

Private Sub ScrollBar1_Change()

Label1.Caption = Format(Date + ScrollBar1.Value, "Long Date")

Select Case ScrollBar1.Value

   Case Is < -1

      Label2.Caption = "Is " & ScrollBar1.Value * -1 & _

         " days in the past."

   Case -1

      Label2.Caption = "Is 1 day in the past."

   Case 0

      Label2.Caption = "Is today's date."

   Case 1

      Label2.Caption = "Is 1 day in the future."

   Case Is > 1

      Label2.Caption = "Is " & ScrollBar1.Value & _

         " days in the future."

End Select

End Sub
SpinButton Control

The SpinButton Control increments and decrements numbers. Clicking a SpinButton changes only the value of the SpinButton. You can write code that uses the SpinButton to update the displayed value of another control. For example, you can use a SpinButton to change the month, the day, or the year shown on a date. You can also use a SpinButton to scroll through a range of values or a list of items, or to change the value displayed in a text box.

To display a value updated by a SpinButton, you must assign the value of the SpinButton to the displayed portion of a control, such as the Caption property of a Label or the Text property of a TextBox. To create a horizontal or vertical SpinButton, drag the sizing handles of the SpinButton horizontally or vertically on the form.

Properties

The default property for a SpinButton Control is the Value Property, an Integer between the values specified for the Max and Min Properties.

Properties that apply to the SpinButton Control are:

BackColor
BoundValue
ControlSource
ControlTipText
Delay

Enabled
ForeColor
Height
HelpContextId
LayoutEffect

Left
Max
Min
MouseIcon
MousePointer

Name
Object
OldHeight
OldLeft
OldTop

OldWidth
Orientation
Parent
SmallChange
TabIndex

TabStop
Tag
Top
Value
Visible

Width





Methods

The Methods that apply to the SpinButton Control are Move, SetFocus and ZOrder.

The Move Method is used to reposition the SpinButton a specific distance from their current positions on a form, Frame, or Page.

The SetFocus Method moves the focus to the specified SpinButton. If the SpinButton is in a Frame that contains other Controls, the focus moves to the first Control in the Frame, and subsequent keyboard events apply to the Control that has the focus.

The ZOrder Method is used to position a SpinButton Control above or below other Objects that are stacked one on top of another.

Events

The default event for a SpinButton is the Change Event. It occurs when clicking the up arrow or down arrow on the SpinButton. The Change event procedure can synchronize or coordinate data displayed among controls. For example, you can use the Change Event procedure of the SpinButton to update the contents of a TextBox that displays the Value of the SpinButton.

Events that apply to the SpinButton Control are:

AfterUpdate
BeforeDragOver
BeforeUpdate
Change
Enter

Error
Exit
KeyDown
KeyPress
KeyUp

SpinDown
SpinUp




How to Create a Hex Color Picker With a SpinButton Control

This is a great tool for determining the Hexadecimal value for colors to be used in Web Page creation.

You can use the Value Property of a SpinButton Control to modify the contents of another Control. In this example, the color displayed in the Hex Color Picker TextBox is comprised of three primary colors, Red, Green, and Blue, which can each have values of 0 to 255 (0-FF in Hexadecimal). Based in these values, the Color Picker can display any Hue, Saturation, Luminance, Intensity, and Color from Black, where all three values are 0, to White, where all three values are set to 256.

The three SpinButton Controls are used to set the values for each of the primary colors from 0 to 255 and the TextBox Contols display the values used in both Decimal and Hexadecimal for each primary color.

Modify a BackColor With a SpinButton Control Example

The SpinButton values change the color and color intensity values displayed in the primary color TextBox (both the Decimal and Hexadecimal values are displayed) and the color of the Color Picker TextBox. The ToggleButton Control changes the speed with which the SpinControl updates the values by modifying its SmallChange Property. By using the TripleState Property of the ToggleButton Control, we can set the SmallChange Property to one of three values instead of just two.

1 Create a new File in Microsoft Excel, Microsoft PowerPoint, Microsoft Project 98, or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw four Label Controls, four TextBox Controls and three SpinButton Contols in a UserForm (Drag n’ Drop or Click n’ Draw).

To create a horizontal SpinButton Control, Click and Draw the control from left to right.
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Inserting Label, TextBox, and SpinButton Controls in a UserForm

5 Double-click the UserForm to display the UserForm Code Window and type the code below for the UserForm Initialization Event, ToggleButton Change Event, and the SpinButton Change Event.

6 Run the UserForm

Clicking on the left or right arrows of any of the SpinButton Controls will change the values displayed and color in the Primary Color TextBoxes as well as the color in Textbox4, the Color Picker TextBox. Clicking on the ToggleButton provides a way of speeding-up the rate of change to 3 or 10 times the slow speed of color change when the SpinButton is held down.
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Holding Down the SpinButtons Change the Values and Colors Displayed

Global Variables are created for the Red (R), Green (G), and Blue (B) values so that they will be available for use by all the macros.

The UserForm Intialize event macro first sets the values of the R, G and B variables to 128, the middle of the 0 – 255 range. The With TextBox Statements group the macro code for each of the three primary colors. Within each color group the logic is identical. We set the Caption Property for the Label Control, set then Min and Max Property for the SpinButton Control to a valid range for the ForeColor and BackColor Property values (0-255). We then set the Properties for the TextBox Font to Bold, Text to the Decimal and Hexadecimal value, ForeColor to White and BackColor to the primary color. Finally, we set the Caption Property for Label4 to “HEX Color Picker”, the Color Picker TextBox the starting “grey” color, The Caption Property of the ToggleButton to “Slow Change,” and the ToggleButton’s TripleState Property to True.

The ToggleButton1 Change event macro checks the ToggleButton’s Value Property for False (0), True (-1), or Null (Else). For each case the logic is identical. We update the ToggleButton’s Caption Property and set the SmallChange Property of the SpinButton Control to either 1 (Slow Change), 3 (Medium Change), or 10 (Fast Change) which determines how much to increment or decrement the color value by when the SpinButton is held down.

The three SpinButton Change event macros have identical logic. We load the current SpinButton Value into the appropriate primary color Variable, load the Decimal and Hexadecimal (HEX Function) values into the Text Property of the appropriate TextBox, set the appropriate TextBox BackColor Property and update the Color Picker TextBox (TextBox4) Back Color Property to the combined values of all three primary colors.

Dim R As Integer

Dim G As Integer

Dim B As Integer

Private Sub UserForm_Initialize()

R = 128: G = 128: B = 128

With TextBox1

   Label1.Caption = "RED"

   SpinButton1.Min = 0

   SpinButton1.Max = 255

   SpinButton1.Value = R

   .Font.Bold = True

   .Text = R & "-" & Hex(R)

   .ForeColor = RGB(255, 255, 255)

   .BackColor = RGB(R, 0, 0)

End With

With TextBox2

   Label2.Caption = "GREEN"

   SpinButton2.Min = 0

   SpinButton2.Max = 255

   SpinButton2.Value = G

   .Font.Bold = True

   .Text = G & "-" & Hex(G)

   .ForeColor = RGB(255, 255, 255)

   .BackColor = RGB(0, G, 0)

End With

With TextBox3

   Label3.Caption = "BLUE"

   SpinButton3.Min = 0

   SpinButton3.Max = 255

   SpinButton3.Value = G

   .Font.Bold = True

   .Text = B & "-" & Hex(B)

   .ForeColor = RGB(255, 255, 255)

   .BackColor = RGB(0, 0, B)

End With

Label4.Caption = "HEX Color Picker"

TextBox4.BackColor = RGB(R, G, B)

ToggleButton1.Caption = "Slow Change"

ToggleButton1.TripleState = True

End Sub

Private Sub ToggleButton1_Change()

Select Case ToggleButton1.Value

   Case 0

      ToggleButton1.Caption = "Slow Change"

      SpinButton1.SmallChange = 1

      SpinButton2.SmallChange = 1

      SpinButton3.SmallChange = 1

   Case -1

      ToggleButton1.Caption = "Fast Change"

      SpinButton1.SmallChange = 10

      SpinButton2.SmallChange = 10

      SpinButton3.SmallChange = 10

   Case Else

      ToggleButton1.Caption = "Medium Change"

      SpinButton1.SmallChange = 3

      SpinButton2.SmallChange = 3

      SpinButton3.SmallChange = 3

End Select

End Sub

Private Sub SpinButton1_Change()

R = SpinButton1.Value

TextBox1.Text = R & "-" & Hex(R)

TextBox1.BackColor = RGB(R, 0, 0)

TextBox4.BackColor = RGB(R, G, B)

End Sub

Private Sub SpinButton2_Change()

G = SpinButton2.Value

TextBox2.Text = G & "-" & Hex(G)

TextBox2.BackColor = RGB(0, G, 0)

TextBox4.BackColor = RGB(R, G, B)

End Sub

Private Sub SpinButton3_Change()

B = SpinButton3.Value

TextBox3.Text = B & "-" & Hex(B)

TextBox3.BackColor = RGB(0, 0, B)

TextBox4.BackColor = RGB(R, G, B)

End Sub

SpinButton Knowledge Base Articles
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Q161816 Microsoft Excel – Min Can Exceed Max on ScrollBar or SpinButton Control

You can set the Min property to a value that is greater than the value for the Max property for the ScrollBar and SpinButton ActiveX controls.

Image Control

Displays a picture on a form. The Image lets you display a picture as part of the data in a form.

For example, you might use an Image to display employee photographs in a personnel form.

The Image lets you crop, size, or zoom a picture, but does not allow you to edit the contents of the picture.

For example, you cannot use the Image to change the colors in the picture, to make the picture transparent, or to refine the image of the picture. You must use image editing software for these purposes.

You can display a picture on a Label. However, a Label does not let you crop, size, or zoom the picture.

To assign a picture to an Image Control at Run Time, use the LoadPicture Function.

The Image Control supports the following file formats:

· *.bmp

· *.cur

· *.gif

· *.ico

· *.jpg

· *.wmf

Properties

There is no default property for an Image Control.

Properties that apply to the Image Control are:

AutoSize
BackColor
BackStyle
BorderColor
BorderStyle

ControlTipText
Enabled
Height
LayoutEffect
Left

MouseIcon
MousePointer
Name
Object
OldHeight

OldLeft
OldTop
OldWidth
Parent
Picture

PictureAlignment
PictureSizeMode
PictureTiling
SpecialEffect
Tag

Top
Visible
Width



Methods

The Methods that apply to the Image Control are Move and ZOrder.

The Move Method is used to reposition the =Image a specific distance from their current positions on a form, Frame, or Page.

The ZOrder Method is used to position an Image Control above or below other Objects that are stacked one on top of another.

Events

The default event for an Image is the Click Event. It occurs when the user clicks the mouse on the image.

Events that apply to the Image Control are:

BeforeDragOver
BeforeDropOrPaste
Click
DblClick
Error

MouseDown
MouseMove
MouseUp



How to Load a Picture Into an Image Control

You can use the Picture Property of an Image Control to load a picture into the control.

Load Picture Example

In this example, a BitMap Image is solicited from the user with the GetOpenFilename Function and placed in the Image Control.

1 Create a new File in Microsoft Excel or Microsoft Word.

2 On the Tools Menu, point to Macro, and then click Visual Basic Editor or press Alt + F11.

3 Insert a UserForm into your document. To do this, click UserForm on the Insert Menu.

4 Draw an Image Control on a UserForm (Drag n’ Drop or Click n’ Draw).
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Inserting an Image Control in a UserForm

5 Because the code differs depending upon the Application you are in, when you double-click the UserForm to display the UserForm Code Window and type the code below for the Image Click Event, be certain that you use the example that matches your Application (Microsoft Excel or Microsoft Word).

6 Run the UserForm

Click in the Image Control box in the UserForm. A Dialog Box will appear allowing you to browse the drives and locate a BitMap file (*.bmp)of your choice. Typically, there are BitMap files in the local Windows folder. Once you have highlighted the Bitmap file, click the Open button to return the image into the Image Control.

Clicking on the Image Control
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Clicking on the Open Button Returns the Image to the UserForm
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The Microsoft Excel Image Click event macro uses an Application.GetOpenFilename Method to display the Open File Dialog Box. The FileFilter Parameter limits the files displayed to Bitmap files. The Title Parameter changes the Title of the Dialog Box to “Select Image to Open.” The “On Error Resume Next” Statement is used in case the selected file is corrupt, not a Bitmap file, or if the user cancels the Dialog Box. The LoadPicture Function of the Picture Property of the Image Control loads the BitMap image based on the file path and name provided by the GetOpenFilename Dialog. The Refresh Method of the UserForm (Me) redisplays the Image Control with the changed image.

The Microsoft Word Image Check event macro is similar to the Microsoft Excel version except it uses the Set Method to bring up Microsoft Word’s File Open Dialog Box

Microsoft Excel Example

Private Sub Image1_Click()

FileName = Application.GetOpenFilename _

   (filefilter:="Bitmap Files(*.bmp),*.bmp", _

   Title:="Select Image to Open")

On Error Resume Next

Image1.Picture = LoadPicture(FileName)

Me.Repaint

End Sub

Microsoft Word Example

Private Sub Image1_Click()

Set mydlg = Dialogs(wdDialogFileOpen)

mydlg.Name = "*.bmp"

mydlg.Display

On Error Resume Next

Image1.Picture = LoadPicture(mydlg.Name)

Me.Repaint

End Sub

Module 5: Interoperability
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Lesson 1: Starting, Activating, and Closing Applications

What You Will Learn

After completing this lesson, you will be able to:

· Describe and demonstrate how to activate an application via a macro.

· Describe and demonstrate how to maximize or minimize an application via a macro.

· Describe and demonstrate how to start an application via a macro.

· Describe and demonstrate how to close an application via a macro.

· Describe and demonstrate how to tell if an application is running via a macro.

Related Topics Covered in this Lesson

· Activating Applications

· Maximizing and Minimizing Applications

· Starting Applications

· Closing Applications

· How to tell if An Application Is Running

Activating Applications

Switching to another application means the same thing as "giving it focus" or "activating" it. There are a variety of ways a macro in a source application can make a target application active. Most of them require that the target application is running and is in the Microsoft® Windows® Task List. An "invisible" application is one that is running in memory, but is not physically visible and does not show up in the Windows Task List. Throughout Module 3, unless specified otherwise, the phrase "visible application" or "running visibly" means the application is in the Windows Task List, not that it's physically visible. This concept is covered in detail in Lesson 3.

If invisible applications aren't strange enough, an application can have no windows at all, so there is nothing to activate. Such an application can still show up in the Windows Task List, for example a VB5 program that has a Main procedure but no Forms. The rest of Module 3 assumes all running applications have a window and are in the Windows Task List unless specified otherwise.

Here's some items related to activating an application:

· AppActivate

· AppMaximize, AppMinimize, AppRestore (Microsoft Project window only)

· Visible Property

· Shell

· AppExecute

AppActivate
The most common way to activate an application: The application to be activated has to be in the Windows Task List.  AppActivate is discussed in detail later.

AppMaximize, AppMinimize, AppRestore (Microsoft Project window only)

Another application can use DDE or OLE Automation to tell Microsoft Project to execute one of these. Microsoft Project must be in the Windows Task List. The Microsoft Project window is activated as well as changed in the specified manner. See Microsoft Project Online Help for more information about these methods.

Visible Property

Many applications that support OLE Automation have a Visible property. If an application is running but not in the Windows Task List, then setting its Visible property to True will add it to the Windows Task List and activate it. If it's already in the Windows Task List, then setting Visible to True does nothing. OLE Automation and the Visible property are covered in detail in Lesson 3.

Shell

The Shell command is normally used to start an instance of an application, but can also be used to switch to a currently running application that supports only one instance. For example, using the Shell command in an Excel macro to start Microsoft Project will simply switch to Microsoft Project if it's already running. The Shell command is discussed in detail later in this lesson.

AppExecute

Microsoft Project also has the AppExecute method, which can be used to start or switch to a target application. The AppExecute method is discussed in detail later in this lesson.

The table below provides some comments and sample code illustrating some of the ways to activate an application.

AppActivate
Target Application must be in the Windows Task List. You specify the window title that you want to activate. In VB for Applications, you don't have to specify the name of maximized documents.
Microsoft Project macro that switches to an instance of Excel that is in the Windows Task List.

Sub Sub1()

    AppActivate "Microsoft Excel"

End Sub

AppMaximize

AppMinimize

AppRestore
Microsoft Project methods. Another application can use DDE or OLE Automation to tell Microsoft Project to execute one of these. Microsoft Project must be in the Windows Task List.
Excel macro that switches to Microsoft Project and maximizes it - Microsoft Project must be in the Windows Task List.

Sub Sub2()

    Dim x As Object

    Set x = GetObject(,"MSProject.Application")

    x.AppMaximize

    Set x = Nothing

End Sub

Visible
A property common to many applications that support OLE Automation. If an application is running but not in the Windows Task List, setting its Visible property to True will add it to the Windows Task List and activate it. If it's already in the Windows Task List, setting Visible to True does nothing. It's usually used in combination with AppActivate.
Excel macro that activates Microsoft Project. Microsoft Project must be running but doesn't have to be in the Windows Task List. Setting Visible to True covers that possibility.

Sub Sub3()

    Dim x As Object

    Set x = GetObject(,"MSProject.Application")

    x.Visible = True

    AppActivate "Microsoft Project"

    Set x = Nothing

End Sub

Shell 
If the target application is already running (in the Windows Task List or not), and supports only one instance, then Shell activates it rather than starting it.
Excel macro that switches to Microsoft Project if it is already running, otherwise it starts Microsoft Project.

Sub Sub4()

    Shell "C:\Winproj\Winproj.exe",  3

End Sub

AppExecute
Specific to Microsoft Project. Microsoft Project can use this to activate an application in the Windows Task List or to start another application. Requires an exact window title in order to switch to another application.
Microsoft Project macro to switch to Excel if  "Microsoft Excel - Book1" is in the Windows Task List.

Sub Sub5()

    AppExecute Window:="Microsoft Excel - Book1"

End Sub

AppActivate title [ , wait ]

Used to switch to any application listed in the Windows Task List.
title

In Microsoft Visual Basic® 5.0 (VB5), this must be set to the title bar text of the window to be activated  - including the hyphen and document name if there is an open maximized document. In applications that support Visual Basic for Applications (VBA), like Microsoft Excel and Microsoft Project, the title only needs to include the application name part of the title bar, but if you do include the hyphen part, it must match exactly. The title argument is not case sensitive.

If there is more than one window that matches the specified title, then the most recently used instance (the highest one in the Windows Task List) is activated. Windows that are not on the Windows Task List can't be activated.

AppActivate cannot activate an application that is running invisibly - i.e. one that is running but doesn't show in the Windows Task List.

wait

This argument is only available in applications that support Visual Basic for Applications. VB5 doesn't use this argument. Set this argument to True if the source macro trying to execute the AppActivate command must wait until the source application has focus before it is allowed to activate the specified target. The default is False.

Example
Suppose there are three instances of NotePad listed in the Windows Task List in the order shown:


NotePad - Test2.txt


NotePad - Test1.txt


NotePad - (Untitled)

The table below shows what would result from various uses of AppActivate:
Command
Result                                                                  

AppActivate "NotePad"
Activates the first one in the Windows Task List.

AppActivate "NotePad - wow"
Error

AppActivate "NotePad - Test1.txt"
Activates the specified instance only.

Example
Suppose the title bar in Microsoft Project says:
Microsoft Project - P1.MPP

Then an Excel macro could switch focus to Microsoft Project with any of the following commands:

AppActivate "Microsoft Project"

AppActivate "Microsoft Project"

AppActivate "Microsoft Project - P1.MPP"

A VB5 procedure could only use the last statement above. 

If a source application establishes an OLE conversation with Microsoft Project, then it can use AppActivate with the Caption property of the target application. The Caption property represents the exact title bar text. The following example could be a VB5 procedure or an Excel macro that activates Microsoft Project regardless of what's on the title bar:

Sub Sub1()


Dim x As Object


Set x = GetObject(,"MSProject.Application")


AppActivate x.Caption


Set x = Nothing

End Sub

Maximizing and Minimizing Another Application

Depending on the applications, a source application might be able to maximize, minimize, resize, or move a target application. You can manipulate the Microsoft Project window using the Microsoft Project methods AppMaximize, AppMinimize, AppRestore, AppMove, and AppSize (there are similar methods to manipulate the document windows). The above methods are specific to Microsoft Project. Many applications have a WindowState property that can be used to maximize, minimize, or restore their application window. Some commands, like Shell, that are used to start applications include options to control how the target application window comes up - Shell is covered later in this lesson.
Example
The following Excel macro assumes that Microsoft Project is already running. It makes Microsoft Project visible (in case it was running invisibly), switches to Microsoft Project and maximizes it.

Sub Sub5()


Dim x As Object


Set x = GetObject(, "MSProject.Application")


x.Visible = True


x.AppMaximize


Set x = Nothing

End Sub

Example
The following Microsoft Project macro assumes that an instance of Excel is already running. It makes that instance visible and maximizes it.

Note that the predefined Microsoft Project constant pjMaximized has the same value as the predefined Excel constant xlMaximized. The Microsoft Project macro used pjMaximized instead of xlMaximized because the Excel constants are not recognized in Microsoft Project macros automatically without establishing a reference to the Excel 8.0 Object Library. This is covered in detail in lesson 3. Of course, you can use the actual value instead of the constant.

Sub b2()


Dim x As Object


Set x = GetObject(, "Excel.Application")


x.Visible = True


x.WindowState = pjMaximized


Set x = Nothing

End Sub

Starting Other Applications

There are a variety of ways a macro in a source application can start a target application. Many applications support a command like Shell. If both the source and target applications support OLE Automation, then the source can use CreateObject or GetObject to start the target application. Microsoft Project also has the AppExecute method, which can switch to, or start up, a target application.

See Online Help for a complete discussion of related commands.

Shell  pathname [ , windowstyle ]

Starts the specified application with the optional specified window style. To insure that the target application is completely started before the source macro continues, follow the Shell command with the DoEvents command if it has one.

pathname
Name of executable file including optional path. It can include optional command line arguments. It can not be the name of a document (although Online Help says it can).

windowstyle

Pass one of the following optional values to control the state of the target window when it starts (default is 2).


1, 5, 9
Normal with focus.


2

Minimized with focus.


3

Maximized with focus.


4,8

Normal without focus.


6,7

Minimized without focus.

As soon as the target application responds that it has finished the initial part of its startup process, the calling macro will proceed to the next line of code after the Shell command. It will not wait for the other application to close before continuing. Shell can be used as a function. It returns an id number (called a module handle) that identifies the instance of the executable that it started. You can pass this id to some API procedures to get information about that instance, including whether it's still running. If you don't want your macro to continue until the target executable has quit, the GetModuleUsage API function is useful. API calls are covered in Lesson 5. The GetModuleUsage function is used in an example later in this lesson. If you don't want to use the value returned by Shell, then don't use ( ) around the arguments.

If the target application supports multiple instances (like Excel) then Shell always starts a new instance. For applications like Microsoft Project that support only a single instance, Shell activates the existing instance.

When Shell looks for the specified executable, if a directory is supplied with the filename, it only looks there. If no directory is specified, it looks at the following, in the order given, until it finds the executable or gives an error: current directory, windows directory, system directory, and path statement. It doesn't look in Win.ini or Reg.dat  (OLE registry information). 

If you include command line arguments (like a document filename) with the executable name, Shell will wait only until the target application releases control back to the operating system; it doesn't necessarily wait for the document to open.

Shell is not aware of "working directories". If it's important, try using the Chdrive and Chdir commands to switch to the working directory before using the Shell command - that way the target application might find startup files it needs (for example Microsoft Project's Global.mpt).

Example
Assume Microsoft Project is not running, that winproj.exe is in c:\winproj and Global.mpt is in c:\winproj\workdir and that the current directory is c:\stuff. Then this Excel macro will start Microsoft Project maximized with focus, but will create a new default Global.mpt without warning messages.

Sub StartMSProject()


Shell "c:\winproj\winproj.exe", 3

End Sub

With the same assumptions as above, the following Excel macro will start Microsoft Project with the Global.mpt from the working directory:

Sub StartMSProject()


ChDrive "c"


ChDir
"c:\winproj\workdir"


Shell "c:\winproj\winproj.exe", 3

End Sub

Example
Assume Excel is not running. This Microsoft Project macro starts Excel maximized with focus and tells it to load the specified workbook. As soon as Excel finishes its startup screen, it lets the Microsoft Project macro continue as it loads test.xls in the background.

Sub Sub1()


Shell "c:\Excel\Excel.exe c:\Excel\data\test.xls", 3


AppActivate "Microsoft Project"

End Sub


Note that if you replace the above Shell statement with

Shell "c:\Excel\data\test.xls", 3


it gives an error, although Online Help says it should work.

AppExecute window, command, minimize, activate
Microsoft Project method only. It can be used to activate or start a target application or both. You must provide the window or command argument or both.
window

Set to the title bar text of the window to be activated, including the hyphen and document name if there is a maximized document. It's not case sensitive.

command

The command used to start the target application. Similar to the pathname argument in the Shell command.

minimize

Set this to True to minimize the target window. Default is False.

activate

Set this to True if you want to give focus to the target application. Default is True.
AppExecute looks at the window argument first if provided. If it finds the window, then it ignores the command argument. If the window argument is not given or has a bad value, then it looks to the command argument. In the case where it has to depend on the command argument, it may look for an exiting instance first or it may not, depending on the target application. For example, it always starts a new copy of NotePad. In Windows 3.1 it uses an existing instance of Excel, but in Windows 95 it always starts a new instance.

In cases where AppExecute is switching to an existing instance, the minimize and activate arguments are ignored, and AppExecute switches to the most recently used instance of the target application  (the highest one in the Windows Task List). It cannot be used to activate an application that is not in the Windows Task List.

If AppExecute does have to start a new instance, it looks at the following to locate the executable: If a pathname is supplied in the command argument, it looks no further, otherwise it checks Reg.dat, and then in the current directory, windows directory, system directory, and the path statement. This is different from Shell, which always starts a new instance, and never checks Reg.dat.

You can specify a document file along with the executable file in the command argument, but then Reg.dat is not checked. You cannot specify just a document file for the command argument.

Example
Suppose there are two copies of Excel running and two copies of NotePad running, and they are in the following order in the Windows Task List:


NotePad - Test2.txt


Microsoft Excel - Book1


NotePad - Test1.txt


Microsoft Excel - Book2

The table below shows the result of various commands, each starting with the above assumptions.

Command
Result

AppExecute window:="Notepad"
Error

AppExecute window:="Notepad - Test1.txt"
Activates that one

AppExecute command:="Notepad"
Starts a new copy of NotePad

AppExecute command:="Notepad - Test1.txt"
Error

AppExecute command:="Excel"
Activates the first Excel in the Windows Task List

AppExecute window:="Excel - Book2"
Activates that one

Example
Assuming Excel is not running (and that Excel.exe is in c:\Excel for the first example only) and that Excel is properly registered, then any of the following alone should start Excel and give it focus.

AppExecute command:="c:\Excel\Excel.exe"

AppExecute command:="Excel.exe"

AppExecute command:="Excel" 

AppExecute window:="ha ha", command:="Excel" 

Example
Assume the same as the above, but also that c:\Excel is not in the Path statement, and that Test.xls is in c:\Excel. Then

AppExecute command:="c:\Excel\Excel.exe  test.xls"
works, but

AppExecute command:="Excel.exe  test.xls"

fails because it can't find Excel.exe and won't check the registry.

AppExecute command:="c:\Excel\test.xls"

fails too, because it doesn't do associations.

Example
Assume Excel is already running, and that the title bar is "Excel - Book1.xls". Then the following both work:

AppExecute Window:="Excel - Book1.xls"

AppExecute Window:="Excel - Book1.xls", Command:="ha ha"

Closing Applications

There are a couple of ways that a macro can close an application: Using OLE Automation to apply the Quit method of the target application (if it has one) or DDE to send the Quit command of the target application (if it has one), or, in the worse case, activating the target application and using a SendKeys command to choose File Exit or to send the Alt-F4 key combination. Microsoft Project also has the FileExit method that comes with a convenient argument to specify whether it should automatically save changes to projects, not save changes, or prompt to save changes. For example, in a Project macro, the following line closes Project and automatically saves changes:

FileExit save:=pjSave
The possible values for the save arguments are 0, 1, and 2 represented by named constants pjDoNotSave, pjSave, and pjPromptSave. 

SendKeys, OLE Automation, and DDE are covered in later lessons. Applications that are started as a result of an OLE reference may close automatically when the OLE reference is destroyed. Reference-dependence is covered in detail in Lesson 3.

When a macro tells a target application to quit, it should take into account the possibility that the target application might display "alerts", warning messages, or error messages. An alert is usually a message that offers you a choice of actions. For example, when told to quit, Microsoft Project might give the message "Save changes to 'Project1'?", or "Some other application is using Microsoft Project. Do you want to exit Microsoft Project?". The conservative approach to handling potential messages is to activate the target application before telling it to close. Some applications have commands that turn off "alerts". The default response for an alert is automatically chosen without showing the message. Both Microsoft Project and Excel have the DisplayAlerts property. Microsoft Project also has the Alerts method. The following lines have the same effect in Microsoft Project:

Alerts False

DisplayAlerts = False

With alerts turned off, Microsoft Project automatically saves changes to projects that have been saved at least once in the past, and automatically brings up the Save As dialog for new projects that have changed. Microsoft Project also has the FileExit method described earlier. Setting DisplayAlerts to False in Excel currently does not prevent the save changes dialog, as it should.

Microsoft Project has its DisplayAlerts property equal to True by default. If a macro wants to be sure Microsoft Project will display alerts, it should put DisplayAlerts equal to True, just in case some other macro had previously put DisplayAlerts equal to False.
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 Try This
The following Excel macro saves any projects in Microsoft Project that need to be saved, without giving alert messages. Then the macro closes Microsoft Project.

1. 
Create two new projects in Microsoft Project. Save one but not the other, then enter a task in each one.

2. 
Enter and run the following Excel macro. When it brings up the Save As dialog, see what happens if you choose cancel.

Sub Sub1()


Dim x As Object


Set x = GetObject(,"MSProject.Application")


x.DisplayAlerts = False


AppActivate "Microsoft Project"


x.Quit

   Set x = Nothing

End Sub


3. 
Change the macro so it assigns True to DisplayAlerts instead of False. Create two more projects as in step (1) and run the macro again.

Note: The DisplayAlerts line could have been replaced by  x.Alerts False

You would not need the Alerts line if instead of x.Quit, you used x.FileExit 1
Microsoft Project was activated before closing it so any unanticipated error messages could be seen.


Example
Suppose several copies of NotePad are running and one has the title bar "NotePad - Test1.txt". The following Microsoft Project macro closes that specific instance of NotePad:

Sub Sub1()

    AppActivate "Test1.txt - NotePad"

    SendKeys "%{F4}", True

End Sub

If you leave off the " - Test1.txt" in the AppActivate statement, it would close one of the instances of NotePad, but maybe not the one you wanted.

How To Tell If An Application Is Running

Here's a couple of ways to tell if another application is currently running.

· Try to activate another application and trap the error if it fails. If it fails, you know the application is not in the Windows Task List, although it might be running "invisibly".

· Try to establish an OLE or DDE conversation with an application and trap the error if it fails (although it might fail because the other application is running but not responding). This method can tell if an application is running even if it's not in the Windows Task List. Using GetObject when the target application is displaying a message might cause the calling macro to lock up. OLE Automation and DDE are covered in detail in Lessons 3 and 4.

· API calls: These are covered in detail in Lesson 5. The FindWindow function is perhaps the cleanest way to tell if an application is running (in the Windows Task List or not). To use it, you must know the classname of the application. For example, the classname of Microsoft Project 98 is "JWinproj-WhimperMainClass", and the classname of Excel 8.0 is "XLMAIN". The GetModuleUsage function is often used with the Shell command to test if the application instance started with Shell is still running.
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 Try This
The following Microsoft Project macro tells you whether NotePad is in the Windows Task List or not.

1. 
Make sure NotePad is not running.

2. 
Enter and run the following Microsoft Project macro.

Sub IsNotePadRunning()

    Dim MyErr As Integer

    On Error Resume Next

    AppActivate "Untitled - NotePad"

    MyErr = Err

    On Error GoTo 0

    If MyErr > 0 Then

        MsgBox "NotePad is not running."

    Else

      AppActivate "Microsoft Project"

      MsgBox "NotePad is running"

    End If

End Sub

3. 
Start NotePad and run the above macro again.
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 Try This
The following Excel macro tells you whether Microsoft Project is responding or not to GetObject.

1. 
Make sure Microsoft Project is not running.

2. 
Enter and run the following Excel macro.

Sub IsMSProjectRunning()


Dim x As Object, MyErr As Integer


On Error Resume Next


Set x = GetObject(, "MSProject.Application")


MyErr = Err


On Error GoTo 0


If MyErr > 0 Then



MsgBox "MSProject is not responding."

   Else

      MsgBox "MSProject is responding"

   End If

   Set x = Nothing

End Sub

3. 
Start Microsoft Project. Don't have any dialogs or messages open in Microsoft Project. Run the above Excel macro again.

4. 
Make sure you don't have anything-important open in any application. Open the Tools Macros dialog in Microsoft Project, switch back to Excel, and run the above macro again.
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 Try This
The following Excel macro tells you whether Microsoft Project is running or not. It uses the FindWindow API call with the classname of Microsoft Project. The GetClassname API function in Lesson 5 can be used to find classnames.

1. 
Make sure Microsoft Project is not running.

2. 
Enter and run the following Excel macro.

'PLACE THE DECLARE LINE IN THE DECLARATION AREA OF AN EXCEL MODULE

Declare Function FindWindowA Lib "USER32" _

(ByVal lpClassName As Any, ByVal lpWindowName As Any) As Long

Sub IsMSProjectRunning()

    If FindWindowA("JWinproj-WhimperMainClass", 0&) = 0 Then

        MsgBox "MSProject is not running"

    Else

        MsgBox "MSProject is running"

    End If

End Sub

3. 
Start Microsoft Project and run the above Excel macro again.
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 Try This
The following Excel macro starts Microsoft Project and establishes an OLE conversation. Then it waits in a DoEvents loop until it is no longer able to use the reference to Microsoft Project to read the Microsoft Project caption.

1. 
Make sure Microsoft Project is not running.

2. 
Enter and run the following Excel macro. It should start and activate Microsoft Project. Adjust the path to Microsoft Project if necessary.

Sub Sub5()

    Dim x As Object, s As String

    Shell "c:\Program Files\Microsoft Office\Office\winproj.exe", 3

    On Error Resume Next

    Set x = GetObject(, "MSProject.Application")

    Do

        DoEvents

        s = x.Caption

    Loop Until Err > 0

    MsgBox "MSProject is busy or not running."

   Set x = Nothing

End Sub

3. 
Exit Microsoft Project. The MsgBox line in the above macro should execute.



Lesson 1 Exercises


Assume in these exercises that there are no "invisible" applications, i.e. that any applications running are listed in the Windows Task List. Also assume that there are no "busy" applications. Try to complete these without the use of API calls or OLE Automation. They all can be done using AppActivate, SendKeys, and On Error Resume Next.

1.   
Write an Excel macro that tries to activate (not start) Microsoft Project. If it fails, then the macro gives the following message:

Make sure Microsoft Project is running before using this macro.

      The message box should just have an OK button. Then the macro ends.

2.
Write an Microsoft Project macro that tries to activate (not start) Excel. If it fails, then the macro gives the following message:

Excel is not running. Do you want to start it?

      
The message box should have a Yes and No button. If the user selects Yes, then the macro starts a new instance of Excel, and ends. If the user selects No, then the macro just ends.

3.   
Write an Microsoft Project macro that tests if Excel is running. If Excel is not running, then the macro starts Excel and ends. If Excel is running, then the macro activates Microsoft Project and displays the following message:

Excel is already running. You can switch to it,

or start a new instance.

The message box should have 3 buttons labeled: Current, New, and Cancel. If the user chooses the Current button then the macro activates Excel and then ends. If the user chooses the New button, then the macro starts a new instance of Excel, makes it active, and ends. If the user chooses Cancel then the macro just ends.

Use the "Message" method so you can change the Yes button caption to Current, and the No button caption to New. For help, look up "Message" in the Microsoft Project Online Help, in the VB section.

4.   
Write an Microsoft Project macro that closes one instance of Excel. Test the macro by entering some data in a new Excel workbook, and then switching to Microsoft Project and running the macro.

Lesson 2: SendKeys

What You Will Learn

After completing this lesson, you will be able to:

· Describe and demonstrate how to use SendKeys to send key strokes to another application.

Related Topics Covered in this Lesson

· Sending key strokes to another application with SendKeys

SendKeys

The macro languages in many applications support a SendKeys statement that can be used to send key strokes to the active object in the active application.  For a complete listing of all the SendKeys commands that are available, refer to appropriate Visual Basic help file.

Here's the form of SendKeys in Microsoft Project, Microsoft Excel, Microsoft Word, and VB5:

SendKeys string,[wait]
string

String that contains the keys you want to send. This includes text as well as special keys like {HOME}, {ESC}, and {ENTER}. See Online Help for the rest of the special keys. The shift, control and alt keys are represented by the single characters +, ^, and %. The following eight characters must be enclosed in braces to send them as literals without interpretation:


 + ^ % { } [ ] ~

The ~ is shorthand for {ENTER}, although it's not listed in Online Help. It's easier to read a macro that doesn't use this shortcut.

To repeat a key several times, put the key followed by a space and the number of repetitions inside braces. 

SendKeys can't send the PRINT SCREEN (PRTSC) key.
wait
Optional argument that can be set to True to force the calling macro to wait until the target application has finished processing the key strokes. The default is False, which allows the calling macro to continue immediately.

If the target application has its own SendKeys command and supports DDE, then the source application could use DDEExecute to tell the target application to use the SendKeys command in the target application, for example:

DDEExecute "SendKeys ""hello"""

However it's better to use the source application's SendKeys command directly:

SendKeys "hello"

In both cases, using AppActivate must make the target application active first, for example.

To improve code readability you can use several SendKeys statements instead of one long one.
Example
The Microsoft Project macro below starts a new copy of NotePad maximized, enters the name, start, and finish of the active project along with some text, saves the file, and closes the instance of NotePad. The "Y" is sent to choose Yes to the overwrite warning in case the file already exists,
Sub SK3()


Shell "NotePad", 3


SendKeys "Project Summary Information:{Enter 2}", True


SendKeys "Name: " & ActiveProject.Name & "{Enter}", True


SendKeys "Start: " & ActiveProject.Start & "{Enter}", True


SendKeys "Finish: " & ActiveProject.Finish & "{Enter}", True

 
SendKeys "%FS"


SendKeys "C:\TEST2.TXT{ENTER}"


SendKeys "Y" 'in case get overwrite message


SendKeys "%{F4}"

End Sub

Example
The following Microsoft Project macro sends keys to itself. It should be attached to a button on a toolbar and used only when in the Visual Basic Editor. When run, it creates a Sub/End Sub template with top and bottom comment borders, and positions the cursor one space to the right of the first word Sub.

Sub NewSub()


SendKeys "'{= 20}{Enter}"


SendKeys "Sub{Enter 5}"


SendKeys "End Sub{ENTER}"


SendKeys "'{= 20}"


SendKeys "{Up 6}{END}"

   SendKeys " "

End Sub

Here's what the key strokes do:


'



Apostrophe for a comment line for the top border


{= 20}


Top border: ====================

{Enter}


Next line


Sub



String for the start of the sub


{Enter 5}

5 blank lines


End Sub


String for the end of the sub


{Enter}


Next line 


'



Apostrophe for a comment line for the bottom border


{= 20}


Bottom border: ====================



{UP 6}{END}
Position cursor after the first word Sub

Note: There is a space at the end of the string s so that the cursor moves one space to the right of the first word Sub.

Example
The following Microsoft Project macro sends keys to itself.  It assumes there are at least three objects in the Gantt drawing layer of the active project. It applies the Gantt Chart full screen and enters some text in the THIRD drawing layer object, which is assumed to be a text box.

Sub SendKeysToTextBox()


ViewApply Name:="&Gantt Chart", SinglePane:=True


SendKeys "{F6}{TAB 2}{F2}"


SendKeys "{HOME}+{END}Hello{ENTER}Goodbye {! 10}{F6}"

End Sub

Here's what the key strokes do:


{F6}



Put focus on the first drawing layer object


{TAB 2} 


Put focus on the third object - a text box


{F2}



Put the text box in edit mode (flashing cursor)


{HOME}+{END}
Select all the text currently in the text box.


Hello



Enter some text


{Enter}



New line


Goodbye



Enter some text


{! 10}



Enter 10 exclamation points.


{F6}



Switch focus back to Gantt Chart table

In general, the {F6} key cycles focus from the top pane, to the drawing layer (if the top pane is a Gantt Chart) to the bottom pane (the bottom pane has no drawing layer). Once the drawing layer has focus, the {TAB} key cycles focus though the objects in the order they were created.

Lesson 2 Exercises

1. 
Write an Microsoft Project macro that lets the user enter some text in an input box and assigns it to a string variable. Then the macro starts a new instance of NotePad maximized with focus, and uses SendKeys to put the string variable contents into the new NotePad file. Note that if S is a string variable, then you can send it with SendKeys without quotes.

2. 
Write an Microsoft Project macro that selects and copies the task name column from the active project, starts a new maximized instance of NotePad with focus, and uses SendKeys to paste the task names into NotePad. If you have to, use the macro recorder to find out how to apply the Gantt view, select the name column, and do Edit Copy. Test it when the active project has tasks and when it doesn't.

3. 
Write an Microsoft Project macro that does the same thing as the above exercise without using copy/paste. After the macro starts NotePad, it uses a For Each loop - for each task T in the active project, it uses SendKeys to send the task name as key strokes and then sends the {Enter} key to get to the next row. Note that T.Name is a string and can be sent using SendKeys without quotes around it.

4. 
Write a Microsoft Project macro, to be run from a toolbar button that enters the following text when you are in the Module Editor:


If Then


End If

It should put 2 spaces between "If" and "Then" and 1 blank row before the "End If" line, and the cursor should end up on space to the right of the first "If". The indentation of the two lines should be determined by the position of the cursor when the macro was run. 

Lesson 3: OLE Automation

What You Will Learn

After completing this lesson, you will be able to:

· Describe the degree of OLE Automation support provided in Excel, Project, Word, and VB5.

· Describe the general forms of GetObject and CreateObject possible with Excel, Project, and Word objects.

· Describe and demonstrate how to use GetObject(,class) where class is "Excel.Application" or "MSProject.Application".

· Describe and demonstrate how to use CreateObject(class) where class is "Excel.Application", "MSProject.Application", or "Word.Basic".

· Describe how Application Object Libraries can be used and what applications currently have them.

· Define Invisible and Reference-Dependence Applications and Documents.

· Describe the Visible property and ways that an application can run invisibly.

Related Topics Covered in this Lesson

· CreateObject

· GetObject

· Application Object Libraries

· Invisible Applications and Documents

· Reference-Dependent Applications and Documents

OLE Automation

OLE Automation is the process by which a source application uses object variables or references to control a target application, or documents or other objects supported by the target application. You start by setting an object variable to the target application or some object that the target application supports, using CreateObject, GetObject, or you establish a reference to the target application's Application Object Library (if it has one). Then the object variable in the source macro can use the methods and properties of the corresponding object in the target application.

An application can also use CreateObject and GetObject to refer to itself or one of its subordinate objects. For example the following is both a legal Excel macro and a legal Microsoft Project macro:

Sub Macro1( )


Set xlobject = CreateObject("excel.sheet")


Set xlsheet = xlobject.Application.ActiveWorkbook.Sheets("sheet1")



xlsheet.Range("a1").Value = "ABC"



xlsheet.Parent.SaveAs "c:\xltest.xls"



xlobject.Application.Quit


Set xlsheet = Nothing


Set xlobject = Nothing
End Sub

Note that an application cannot initiate a DDE conversation with itself - see the section on DDE. For example, the following statement is illegal in a Microsoft Project macro:

DDEInitiate "Winproj", "System"

OLE Automation Support

Here's the degree to which Excel, Microsoft Project, Word, and VB5 support OLE Automation:

Microsoft Excel and Microsoft Project

Microsoft Excel 97 and Microsoft Project 98 macros can use all three techniques: CreateObject, GetObject, or establishing a reference to another application's Application Object Library.

Microsoft Word

Microsoft Word macros cannot use OLE Automation to control other applications, but other applications can use OLE Automation to control it. When other applications use an object variable to control Word, they cannot use the Word named arguments. Word commands can be used by listing the values of arguments without argument names, but you can't skip arguments with consecutive commas (or whatever the list separator is).  For example, here's the syntax for the Word Basic command FileOpen, with the first three arguments:

FileOpen .Name = text [,.ConfirmConversions = number] [,.ReadOnly = number] 

Both of the following Word lines open the specified file as read only:

FileOpen .Name = "c:\word6\t1.doc", .ReadOnly = 1

FileOpen "c:\word6\test1.doc", 0, 1

The second line above has a dummy 0 for the value of the ConfirmConversions  argument - you can't skip it when you don't use the argument names.

The Microsoft Project macro below tells Word Basic to do the same thing as the above. Word does not have to open when the macro runs. If Word is not open before the Microsoft Project macro runs, then Word will automatically close when the Microsoft Project macro ends, because w is a local variable.

Sub Sub1()


Dim w As Object


Set w = CreateObject("Word.Basic")


w.FileOpen "c:\word6\t1.doc", 0, 1


Set w = Nothing

End Sub

DDE actually shines here - you can use the argument names if you use DDEExecute. Word must be open before the Microsoft Project macro below runs.

Sub Sub1()

   DDEInitiate "WinWord", "system"

   DDEExecute "[FileOpen .Name = ""c:\word6\t1.doc"", .ReadOnly = 1]"

   DDETerminate

End Sub

Problem behavior: One last warning about using Word Basic commands without argument names - there are a few problems with some commands. For example, the EditFind command requires a bogus dummy string argument between its first and second argument if you don't use argument names:

EditFind .Find = "wow", .Direction = 0
'OK

EditFind "wow",  0

'Doesn't work, but should

EditFind "wow", " ", 0
'Does work, but shouldn't

Visual Basic

Visual Basic 5.0 procedures can use OLE Automation to control other applications, but another application cannot use OLE Automation to control VB5 objects. For example a Microsoft Project macro can't set an object variable to manipulate a text box in a VB5 form. VB5 has some other limitations: 

· VB5 cannot make references to Application Object Libraries.

· VB5 procedures can't use some of the block structures available in Visual Basic for Applications, such as the "For Each" loop and the "With" block.

· VB5 procedures cannot used named argument, but must instead list the argument values in order. Microsoft Project behaves inconsistently regarding skipping arguments by using consecutive commas (assuming the list separator is a comma). Skipping arguments by using consecutive commas causes an "Argument value not valid" error for some methods/functions in Microsoft Project macros. Even in cases where it's OK in an Microsoft Project macro, the same statement may cause the error when run from a VB5 procedure. 

The following table of syntax examples assumes the object variable x refers to Microsoft Project:

Statement
Microsoft Project
VB5

x.FileOpen Name:="P1.mpp"
Yes


x.FileOpen "P1.mpp"
Yes
Yes

x.SelectCell 3, , False
Yes


x.SelectCell 3, 4, False
Yes
Yes

Some Terminology

Here's some terminology that will be used in the OLE Automation examples. These terms will become clearer in the examples, and are discussed in greater detail in the "Invisible Objects and Object Lifetime" topic.

Invisible Application: An application that is running but doesn't show in the Windows Task List. An application can be made visible by setting its Visible property to True if it has one. In this context, "visible" means "in the Windows Task List", not necessarily physically visible.

Invisible Document: A document in an invisible application or a document in a visible application, but the document can't be seen and doesn't appear in the list of open windows. An invisible document can be "more hidden" than a "hidden" document. As you'll see later, an Microsoft Project invisible project might not show up in the Window Unhide list, but will show in the Window New Window list.

Reference-Dependent Object: An open object that exists only as long as it or one of its subordinate objects is being referenced.

As you'll see later, some objects can be toggled between invisible and visible. Also, some actions can cause a reference-dependent object to become reference-independent.

Here's some things that can cause an object variable to stop pointing to an object:

· The object variable was set to some other object

· The object variable was set to Nothing, for example Set x = Nothing

· The object variable was a local variable and the macro has ended

· The END macro command was executed (not by choosing the menu command Run End)

· The menu command Run, Reset was used

Note: The last two items apply to clearing the value of any variable.

As you experiment with CreateObject and GetObject, you may end up running invisible copies of applications. The following macros can be used to make Microsoft Project and Excel visible. The way GetObject is used in these macros requires that Microsoft Project and Excel already be running (visible or not). The On Error Resume Next statements prevent error messages if they are not running. The GetObject function is discussed in detail later in this lesson. There are also API calls that can be used to make applications visible - see Lesson 5.

[image: image91.png]


 Try This
(A) The Excel macro below makes Microsoft Project visible and active if it is running (and not busy).

1. 
Get into Excel and create an new module called OLE (From the Insert menu, choose Macro, and then Module).

2. 
Enter the following macro:

Sub ShowMSProject()


Dim oMSP As Object


On Error Resume Next


Set oMSP = GetObject(, "MSProject.Application")


If Err > 0 Then



MsgBox "MSProject is busy or not running."


Else



oMSP.Visible = True



AppActivate "Microsoft Project"


End If

   Set oMSP = Nothing

End Sub

3. 
Save the workbook.

4. 
Start Microsoft Project, switch to Excel and run the ShowMSProject macro. Microsoft Project should become active. As you'll see later, this macro can make Microsoft Project active even if it were originally invisible.

(B) 
The Microsoft Project macro below makes the earliest instance of Excel visible and active if it is already running (and not busy).

1. 
Get into Microsoft Project and create a new module called OLE.

2. 
Enter the following macro:

Sub ShowExcel()


Dim oXL As Object


On Error Resume Next


Set oXL = GetObject(, "Excel.Application")


If Err > 0 Then



MsgBox "Excel is busy or not running."


Else



oXL.Visible = True



AppActivate "Microsoft Excel"


End If

   Set oXL = Nothing

End Sub

3. 
Start a new instance of Excel, switch to Microsoft Project and run the ShowExcel macro. The instance of Excel should become active. As you'll see later, this macro can make the youngest instance of Excel active even if it were originally invisible.



CreateObject (class)
Returns a reference to an object determined by the class argument. Depending on class, the reference may be to an existing object or to a newly created object. The object reference returned by CreateObject is usually assigned to an object variable.

Class
A string of the form "appName.objectType". Here are some of the values available for Microsoft Project, Excel, and Word:

appName
objectType

MSProject
Application (Online Help left this out.)

MSProject
Project

Excel

Application

Excel

Sheet

Excel

Chart

Word

Basic

Word

Application

Note that Microsoft Word has both a  Word.Application object and a Word.Basic object.   If Word is started as a result of CreateObject or GetObject then when the object variable ceases to exist, Word automatically closes all documents and the Word application without warnings.

Many of the following examples use x as the object variable, but any legal object variable name could be used.

Using CreateObject With Microsoft Project Objects

Set x = CreateObject("MSProject.Application")

Refers to an existing instance if Microsoft Project is running, otherwise it starts an invisible reference-dependent instance with no open projects. Does not activate Microsoft Project. The x refers to MSProject.Application.

Note that a reference-dependent instance of Microsoft Project becomes reference-independent if you open any projects with methods like FileNew or FileOpen.

Global.mpt Concerns: Project looks in the current directory and in the winproj.exe directory for Global.mpt, not in the working directory. If can't find, it creates one in the executable directory without warning.
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 Try This
(A) 
The Excel macro below starts Microsoft Project, and makes it visible:

1. 
Make sure Microsoft Project is not running.

2. 
Enter the following macro in Excel and run it.

Dim x As Object
'In the declaration area.

Sub Sub1a()


Set x = CreateObject("MSProject.Application")


x.Visible = True

   x.FileNew

   Set x = Nothing

End Sub3. 
Switch to Microsoft Project. You should see an open project.

4. 
Switch back to the Excel macro and from the Run menu, choose Reset.

(B) The Excel macro below starts Microsoft Project invisibly, creates a new project, and adds a new task to it.

1. 
Make sure Microsoft Project is not running.

2. 
Enter the following macro in Excel and run it.

Sub Sub1b()


Dim x As Object

   Set x = CreateObject("MSProject.Application")


x.FileNew

   x.ActiveProject.Tasks.Add Name:="wow"

   Set x = Nothing

End Sub

3. 
Check the Windows Task List. Microsoft Project should not be in the list.

4. 
Start Microsoft Project manually in Program Manager. The new project and task created by the macro should be there. Is this instance of Microsoft Project reference-dependent?

5. 
Close Microsoft Project and don't save changes to the new project.

6. 
Change the macro so those x is declared as a module-level variable, i.e. move the Dim statement to the declaration area of the Excel module. Also, add the line x.Visible=True before the line x.FileNew.

7. 
Run the macro again.

8. 
Try to close Microsoft Project - you should get a warning that Microsoft Project is being used by another application. Cancel the message. Why didn't this message come up the first time you ran the macro?

9. 
Switch back to the Excel macro and from the Run menu, choose Reset.

10. 
Switch to Microsoft Project and close it. Why no message this time?



Set x = CreateObject("MSProject.Project")

Starts an invisible reference-dependent instance of Microsoft Project, if it's not running. It then creates a new invisible project. The x refers to the new project, and x.Parent refers to MSProject.Application. The new project is reference-dependent, unless the command executed as an Microsoft Project command.

If Microsoft Project is running visibly, then the name of the invisible project isn't listed in the Window menu's open project list or in the Window Unhide list, but is listed in the Window New Window list. You can use Window New Window to make the invisible project become visible.
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 Try This
The Microsoft Project macro below creates two new invisible projects and displays the names of all the "open" projects.

1. 
Enter the following macro in Microsoft Project and run it.


Sub Sub2a()



Dim p As Object, p1 As Object, p2 As Object



Set p1 = CreateObject("MSProject.Project")



Set p2 = CreateObject("MSProject.Project")



For Each p In Projects




MsgBox p.Name



Next

      Set p1 = Nothing

      Set p2 = Nothing


End Sub

2. 
After the macro ends, check the Microsoft Project Window menu, and you can see that the two new projects are not listed as open or hidden. Use Window New Window to make the projects visible, and then close them. Were these two new projects reference-dependent?

3. 
Paste the above macro into an Excel module. Replace the word "Projects" in the "For Each ..." line to "p1.Parent.Projects" (without the quotes). Note that p1.Parent refers to Microsoft Project.

4. 
Run the macro. Switch to Microsoft Project. Verify that the two new projects are not in the Window New Window list. Do you think the two projects are invisible or just not open at all? Were the two created projects reference-dependent?



Using CreateObject With Excel Objects

Set x = CreateObject("Excel.Application")

Always starts a new invisible reference-independent instance of Excel. The x refers to the Excel.Application object of the new instance.

Set x = CreateObject("Excel.Sheet")

Starts an invisible reference-dependent instance of Excel if it's not running, otherwise it uses the *youngest instance. It creates a new worksheet "Sheet1" in a new reference-dependent workbook called "Object" (or "Object 2" etc.). The x refers to Sheet1, x.Parent to the workbook, and x.Parent.Parent to Excel.Application. If Excel is visible, then the new workbook is visible, and Excel is reference-independent.

*If there are existing instances, youngest means the one that was started last.
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 Try This
The Microsoft Project macro below creates two new workbooks, and puts the time in cell A1 of Sheet1 of each workbook.

1. 
Make sure Excel is not running.

2. 
Enter the following macro in Microsoft Project and run it.

Dim s1 As Object, s2 As Object
'In the declarations area.


Sub Macro1()



Set s1 = CreateObject("Excel.Sheet")



Set s2 = CreateObject("Excel.Sheet")



Set xls1 = s1.Sheets("sheet1")



Set xls2 = s2.Sheets("sheet1")




xls1.Cells(1, 1).Value = Format(Now, "mm:ss")




xls2.Cells(1, 1).Value = Format(Now, "mm:ss")




s1.Parent.Parent.Visible = True



Set xls1 = Nothing



Set xls2 = Nothing



Set s1 = Nothing



Set s2 = Nothing

End Sub

3. 
Check the names of the workbooks and the times in cell Sheet1!A1 of each workbook. Close the workbooks "Object" and "Object 2". What does s1.Parent.Parent.Visible refer to?

4. 
Manually use File New to create another workbook in Excel and type "hey" in Sheet1!A1. 

5. 
Leave Excel running. Switch back to Microsoft Project and run the macro again. Note that it did not activate the Excel window this time - setting the Visible property to True only activates Excel if it is not in the Windows Task List.

6. 
Switch to Excel. Check the workbook names again. Did the macro create a new instance of Excel the second time it was run?

7. 
Leave Excel running. Switch back to Microsoft Project and from the Run menu choose Reset. Switch to Excel. Are the workbooks created by the macro still there? Did the macro create reference-dependent workbooks?

If s1 and s2 had been declared locally, would you have seen the workbooks created by the macro after the macro ended?



Set x = CreateObject("Excel.Chart")

Starts an invisible reference-dependent instance of Excel if it's not running, otherwise it uses the youngest instance. It creates a new worksheet "Sheet1" and chart sheet "Chart1" in a new reference-dependent workbook called "Object (or "Object 2" etc.). Chart1 is based on Sheet1, which Excel populates with sample data. The x refers to Chart1, x.Parent to the workbook, and x.Parent.Parent to Excel.Application. If Excel is visible, then the new workbook is visible, and Excel is reference-independent.

Question: How can you use x to refer to Sheet1?
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 Try This
The Microsoft Project macro below creates a new workbook with one worksheet and one chart sheet.

1. 
Enter the following macro in Microsoft Project and run it.

Dim oChart As Object
'In the declarations area.

Sub Macro1()


Set oChart = CreateObject("Excel.Chart")

   oChart.Parent.Parent.Visible = True

   Set oChart = Nothing

End Sub

2. 
Switch to Excel. Where is the chart getting its data from?  How can you find out whether the workbook created is reference-dependent?



Using CreateObject With Word Objects

Set x = CreateObject("Word.Basic")


Or

Set x = CreateObject(“Word.Application”)

If Word is not running, then a visible reference-dependent instance of Word is started with focus and with no open documents, otherwise x references the youngest existing instance of Word without activating it. The x refers to Word.Basic.
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 Try This
The Microsoft Project macro below creates a new Word document, enters some text, and saves the document.

1. 
Make sure Word is not running.

2. 
Enter the following macro in Microsoft Project and run it.

Sub w1()


Dim w as object


Set w = CreateObject("Word.Basic")


w.FileNew


w.Insert "hello"


w.FileSaveAs "c:\temp.doc"

   Set w = Nothing

End Sub


Or

Sub w1()


Dim w as object


Set w = CreateObject("Word.Application")



w.Documents.Add

   
w.Selection.TypeText Text:="Hello"

   
w.Selection.TypeParagraph

   
w.ActiveDocument.SaveAs FileName:="test.doc"

   Set w = Nothing

End Sub

3. 
Is Word still running after the macro ends? Was the instance of Word created reference-dependent? If w had been declared as a module-level variable, would Word remain open after the macro ends? Open c:\temp.doc to see if it was created and saved correctly. Close temp.doc. Create a new doc and enter some text.

4. 
Leave Word running. Switch to Microsoft Project and change "hello" to "wow" in the macro and run it again. Is Word still running? Did it overwrite c:\temp.doc? Any overwrite warning? Did it use the existing instance of Word or start a new instance?



GetObject ([pathname][,class])

Returns a reference to an object determined by the arguments. Depending on the arguments, the reference may be to an existing object or to a newly created object. The object reference returned by CreateObject is usually assigned to an object variable.

pathname
The path and file name of a document file.

class
Has the same meaning as in CreateObject.
You must provide one or the other or both of the arguments.

You don't need to use the class argument if you give a document name. If you provide a document pathname but not a class, then it finds the correct application if the system associations are correctly setup, and then uses the default class for the application.

If you use an empty string for pathname then GetObject("", class) behaves like CreateObject(class).

If you leave out pathname, then GetObject(, class) usually requires class to be an application object and the application to be running.

If you provide both a document pathname and a class, then the specified document must support that class. For example, the first statement below is legal and the second is not:


Set x = GetObject("c:\winproj\p1.mpp", "MSProject.Project")

'OK


Set x = GetObject("c:\winproj\p1.mpp", "MSProject.Application")
'Not OK

Using GetObject with Microsoft Project Objects

Set x = GetObject(, "MSProject.Application")

Microsoft Project must be running, otherwise an OLE Automation error occurs. The x refers to Microsoft Project Application.

Set x = GetObject("", "MSProject.Application")

Behaves like:  Set x = CreateObject("MSProject.Application").

Set x = GetObject("", "MSProject.Project")

Behaves like:  Set x = CreateObject("MSProject.Project")

Set x = GetObject("c:\wprj4dat\p1.mpp")

Set x = GetObject("c:\wprj4dat\p1.mpp", "MSProject.Project")

Each of these starts an invisible reference-dependent instance of Microsoft Project, if it's not running. If the specified MPP file is not open, then it is opened invisibly, and is reference-dependent unless the command was executed as an Microsoft Project command. The x refers to the project, and x.Parent refers to MSProject.Application.

These are ILLEGAL :

Set x = GetObject(, "MSProject.Project")

Set x = GetObject("c:\wprj4dat\p1.mpp", "MSProject.Application")
Using GetObject with Excel Objects

Set x = GetObject(,"Excel.Application")

Excel must be running, otherwise an OLE Automation error occurs. The x  refers to

Excel.Application for the youngest instance of Excel.

Set x = GetObject("","Excel.Application")

Behaves like:  Set x = CreateObject("Excel.Application").

Set x = GetObject("","Excel.Sheet")

Behaves like:  Set x = CreateObject("Excel.Sheet")

Set x = GetObject("c:\Excel\test.xls")

Set x = GetObject("c:\Excel\test.xls", "Excel.Sheet")

Each of these starts an invisible reference-independent instance of Excel, if it's not running, otherwise it uses the youngest existing instance. If the specified XLS file is not open, then it is opened as a hidden workbook, and is reference-dependent unless the command was executed as an Excel command. The x refers to the leftmost worksheet in the specified file. If there are no worksheets then you get an error.

Set s = GetObject("","Excel.Chart")

Behaves like:  Set s = CreateObject("Excel.Chart")

Set s = GetObject("c:\Excel\test.xls", "Excel.Chart")

Behaves like: GetObject("c:\Excel\test.xls") except that the workbook must contain at least one chart sheet or you get an error. The s refers to the leftmost chartsheet.

These are ILLEGAL :

Set s = GetObject(,"Excel.Sheet")

Set s = GetObject("c:\Excel\test.xls", "Excel.Application")

Using GetObject with Word Objects

Set w = GetObject("", "Word.Basic")

Behaves like w = CreateObject("Word.Basic")

Set d = GetObject("d:\word6\test.doc")

Doesn't give an error message, but you can't use it for anything.

These are ILLEGAL:

Set w = GetObject(, "Word.Basic")

Set w = GetObject("d:\word6\test.doc", "Word.Basic")

Set w = GetObject(, "Word.Application")

Set w = GetObject("d:\word6\test.doc", "Word.Application")

CreateObject and GetObject - Review

There are many exotic ways to use CreateObject and GetObject, but only a few variations are commonly used. First of all, the application you want to control is usually already running visibly, and there usually is just one instance. Also, you usually set the object variable to refer to the application, not to a subordinate object in the application, like a sheet or chart. To work with other subordinate objects in the application, you work your way down the object ladder.

Remember whenever you use CreateObject or GetObject you need to set your variable to equal Nothing when you are through using it.  If you do not, the memory used by that CreateObject or GetObject might not be released.

.

Set x = 
Result

CreateObject("MSProject.Application")

GetObject("","MSProject.Application")


Refers to an existing instance if Microsoft Project is running, otherwise it starts an invisible reference-dependent instance with no projects open. The x refers to MSProject.Application.

CreateObject("MSProject.Project")

GetObject("","MSProject.Project")


Starts an invisible reference-dependent instance of Microsoft Project, if it's not running. It then creates a new invisible project. The x refers to the new project, and x.Parent refers to MSProject.Application. The new project is reference-dependent, unless the command executed as an Microsoft Project command.

CreateObject("Excel.Application")

GetObject("","Excel.Application")
Always starts a new invisible reference-independent instance of Excel. The x refers to the Excel.Application object of the new instance.

CreateObject("Excel.Sheet")

GetObject("","Excel.Sheet")


Starts an invisible reference-dependent instance of Excel if it's not running, otherwise it uses the youngest instance. It creates a new worksheet "Sheet1" in a new reference-dependent workbook called "Object" (or "Object 2" etc.). The x refers to Sheet1, x.Parent to the workbook, and x.Parent.Parent to Excel.Application. If Excel is visible, then the new workbook is visible and Excel is reference-independent.

CreateObject("Excel.Chart")

GetObject("","Excel.Chart")


Starts an invisible reference-dependent instance of Excel if it's not running, otherwise it uses the youngest instance. It creates a new worksheet "Sheet1" and chart sheet "Chart1" in a new reference-dependent workbook called "Object (or "Object 2" etc.). Chart1 is based on Sheet1 that Excel populates with sample data. The x refers to Chart1, x.Parent to the workbook, and x.Parent.Parent to Excel.Application. If Excel is visible, then the new workbook is visible and Excel is reference-independent.

CreateObject("Word.Basic")

GetObject("", "Word.Basic")

CreateObject("Word.Application")

GetObject("", "Word.Application")


If Word is not running, then a visible reference-dependent instance of Word is started with focus and with no open documents, otherwise it activates the youngest existing instance. The x refers to Word.Basic.

GetObject(,"MSProject.Application")


Microsoft Project must be running, otherwise an OLE Automation error occurs. The x refers to Microsoft Project Application.

GetObject("c:\data\p1.mpp")

GetObject("c:\data\p1.mpp", _ 
MSProject.Project")


Starts an invisible reference-dependent instance of Microsoft Project, if it's not running. If the specified MPP file is not open, then it is opened invisibly, and is reference-dependent unless the command was executed as an Microsoft Project command. The x refers to the project, and x.Parent refers to MSProject.Application.

GetObject(,"Excel.Application")


Excel must be running, otherwise an OLE Automation error occurs. The x refers to Excel.Application for the youngest instance of Excel.

GetObject("c:\data\test.xls")

GetObject("c:\data\test.xls", _


"Excel.Sheet")


Each of these starts an invisible reference-independent instance of Excel, if it's not running, otherwise it uses the youngest existing instance. If the specified XLS file is not open, then it is opened as a hidden workbook, and is reference-dependent unless the command was executed as an Excel command. The x refers to the leftmost worksheet in the specified file; an error occurs if there are no worksheets.

GetObject("c:\data\test.xls", _


"Excel.Chart")
Like GetObject("c:\data\test.xls") except that x refers to the leftmost chartsheet in the specified file; an error occurs if there are no chartsheets.

Using Application Object Libraries

Excel and Microsoft Project have their own Application Object Libraries. Other applications may have their own libraries in the future.

Advantages of using object libraries:

· You don't need to set an object variable with either CreateObject or GetObject. Your macro can use the predefined object names that refer to the target application, for example, Excel and Microsoft Project (although in some cases you must use Excel.Application and MSProject.Application).

· Macros in the source application can use the named constants from the target Application Object Library. For example, if Excel has a reference to the Microsoft Project 4.0 Object Library, then Excel macros would automatically understand constants like pjDuration.

Disadvantages of using object libraries:

· Once a macro in a source application references a target application library, the target application might continue to run invisibly after the source macro ends, and even after the source application closes.
· If you close the target application after if has been referenced by a source macro, then the source application may have trouble referencing the library again until you do one of the following in the source application.

· Choose the menu command Run Reset.

· Execute the End command in the Debug window or in a macro.

· Uncheck the reference to the Object Library, close the dialog, get back into it, and recheck the reference.

· Exit and restart the source application.

Microsoft Project 98 Object Library

To use the Microsoft Project 8.0 Object Library from Excel, get into an Excel module and choose Tools, References, and check: Microsoft Project 8.0 Object Library. Then you don't need CreateObject or GetObject to refer to Microsoft Project. You can just use the name Microsoft Project or MSProject.Application to refer to Microsoft Project. You could also introduce another object variable with a shorter name, for example:

Set x = MSProject.Application

When an Excel macro references Microsoft Project, it refers to an existing instance if Microsoft Project is already running, otherwise it starts a new invisible instance with no open projects. In the latter case, Microsoft Project continues to run until you do one of the following:

· Choose the Excel menu command Run Reset.

· Execute the End command in the Debug window or in an Excel macro.

· Uncheck the reference to the Microsoft Project 4.0 Object Library in Excel, close the dialog, get back into it, and recheck the reference.

· Exit Excel and restart it.

· Manually close Microsoft Project or tell it to Quit via a macro.

Also, if you close Microsoft Project after an Excel macro has referenced it, then Excel macros can't reference Microsoft Project again until one of the above actions is taken.
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 Try This
The Excel macro below starts Microsoft Project if not already running, makes it visible and active, and creates a new visible project.

1. Enter the following Excel macro and run it. 

Note: Verify that the Microsoft Project 8.0 Object Library is referenced whithin Microsoft Excel.

 Sub Sub4()

 
MSProject.Application.Visible = True

   AppActivate "Microsoft Project"

   MSProject.FileNew

 End Sub

2. 
Close Microsoft Project (choose Yes to any warning message).

3.
Run the macro again. Did you get an error message? From the Run menu, choose Reset, and run the macro again.



Excel 97 Object Library from Microsoft Project

To Use the Microsoft Excel 8.0 Object Library from Microsoft Project, get into the module editor and choose Tools, References, and check Microsoft Excel 8.0 Object Library. Then you don't need CreateObject or GetObject to refer to Excel. You can just use the name Excel or Excel.Application. You could also use another object variable with a shorter name, for example:

Set x = Excel.Application.

The first time an Microsoft Project macro references Excel, a new invisible instance is run, and all later references use that same instance. That instance continues running until you manually close it or use a macro to tell it to Quit. Note that there isn't a way to reference an existing instance of Excel using this library technique. If you need to reference an existing instance, then use GetObject.

Also, if you close Excel after an Microsoft Project macro has referenced it, then Microsoft Project macros can't reference Excel again (via the library reference) until one of the following actions is taken in Microsoft Project:

· Uncheck the reference to the Excel 8.0 Object Library, close the dialog, get back into it, and recheck the reference.

· Execute the End command in the Debug window or in a Microsoft Project macro.

· Choose the menu command Run Reset.

· Exit Microsoft Project and restart it.

Note: Unlike Microsoft Project, when you close Excel, it does not give a warning that another application is using Excel.

Invisible Objects and Object Lifetime - Review

This section reviews and formalized the concepts of reference-dependent objects and opening applications and documents invisibly.

Invisible Application:

An application that is running but doesn't show in the Windows Task List. This is not the same as being minimized or hidden under other windows. If a macro creates an invisible instance of an application, the macro may need to close the application or make it visible before the macro ends, to avoid having invisible instances eating up resources.

If x refers to MSProject.Application, then Microsoft Project can be made visible by using x.Visible=True, x.AppMaximize, x.AppMinimize, or x.AppRestore. The last three statements always activate Microsoft Project, but x.Visible=True makes Microsoft Project active only if Microsoft Project isn't already visible. The statement x.Visible=False has no effect on Microsoft Project.

If x refers to Excel.Application, then x.Visible=True makes Excel visible, and x.Visible=False makes it invisible. Using x.Visible=True when Excel is already visible does not activate Excel.

Microsoft Word can't be made invisible using OLE Automation.

Invisible Document:

A document that is in an invisible application, or a document in a visible application, but the document can't be seen and doesn't appear on the list of open files at the bottom of the application's Window menu. If the application is visible, the document might be invisible because of the method used to open it, or because it was made hidden by some command after it was opened.

If you use CreateObject or GetObject to create/open a project in Microsoft Project, then the project is invisible.

If you use CreateObject or GetObject to create/open a sheet or chart in a new invisible instance of Excel, then the associated workbook is invisible. If Excel is then made visible, the workbook is still a hidden workbook.

There are no invisible documents in Word.
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 Try This
These Excel macros illustrate when an invisible project can or cannot be the active project.

1. 
Make a test project with two tasks named T1 and T2 and save it as "c:\p1.mpp".

2. 
Close Microsoft Project.

3. 
Enter the following Excel macro and run it.

Sub Macro1( )


Dim x As Object, p As Object


Set x = CreateObject("MSProject.Application") 'Starts invisible

   x.FileOpen "c:\p1.mpp" 
  

'Open p1.mpp

   Set p = x.ActiveProject 

'Set object variable


    p.Tasks(2).Name = "zawa"
'Change task2 name


    x.Alerts False          
'Save without asking


    x.Quit                     
'Close Microsoft Project

   Set x = Nothing

End Sub

4. 
Check that the name of task 2 has changed to zawa.

5. 
The following Excel macro won't work. Enter and run it. Choose OK to the Microsoft Project error message, switch back to Excel, and choose Goto in the Excel error message. What's wrong with this macro?

Sub Macro2()


Dim x As Object, p As Object

   Set p = GetObject("c:\p1.mpp")

   Set x = p.Parent


x.Visible = True

   p.Tasks(2).Name = "zawa"

   x.FileSave

   x.Quit

   Set x = Nothing

End Sub

6. 
Here' a quick fix for the above macro. Add the following three lines before the x.FileSave line, and run the macro again. Which application's messages is the "On Error" line supposed to prevent? Which application's messages is the "x.Alert" line supposed to prevent?

On Error Resume Next

x.Alerts False

x.FileOpen "c:\p1.mpp"



Reference-dependent Object:

An open object that exists only as long as it or one of its subordinate objects is being referenced. The object could be an application or a subordinate object that the application supports, like a project in Microsoft Project, or a worksheet in Excel, or Word Basic in Word.

If you run an Microsoft Project macro that starts Word as a result of

Set x = CreateObject("Word.Basic")

then that instance of Word.Basic is reference-dependent, because if the value of x changes or x ceases to exist, then Word will automatically close without warning, and without saving changes to documents.

The next two definitions are specific cases:

Reference-dependent document:

An open document that exists only as long as it or one of its subordinate objects is being referenced. When a reference-dependent document closes automatically, it typically does not automatically save changes or ask if you want to save changes.

For example, if you run an EXCEL macro that opens a project using

Set p = GetObject("c:\winproj\p1.mpp")

then p1.mpp is reference-dependent, because if the value of p changes or p ceases to exist, then p1.mpp automatically closes without warning and without saving changes.

NOTE: If you run the above command in an Microsoft Project macro instead of an Excel macro, then p1.mpp is not reference-dependent. I.e. even after p ceases to exist, p1.mpp is still open - it's invisible, but can be seen on the Window New Window list.

Similarly, if you run an Microsoft Project macro that opens a worksheet using

Set s = GetObject("c:\Excel\test.xls")

then test.xls is reference-dependent, because if the value of s changes or s ceases to exist, then test.xls automatically closes. Note that test.xls opens as a hidden workbook and will become reference independent if unhidden manually or by executing 

s.Parent.Parent.Windows("test.xls").Visible = True

Reference-dependent projects are created/opened as a result of CreateObject or GetObject run from another application like Excel, and are invisible at first. They can be made visible through the Window New Window menu command if it's available. Invisible reference-dependent projects can never be the active project.

Reference-independent projects are most recently created/opened with methods other than CreateObject or GetObject, i.e. like FileNew and FileOpen.

Technically there are no reference-dependent Word documents because Word doesn't have a Word.Document object. However, the Word.Basic object can be reference-dependent and if the Word.Basic object closes, it closes the application and all open documents without warning.

Reference-dependent Application Instance:

An instance of an application that exists only as long as it or one of its subordinate objects is being referenced.

Microsoft Project can be reference-dependent only if there are no open reference-independent projects, and if Microsoft Project was started as a result of CreateObject/GetObject or a reference via the Microsoft Project 8.0 Object Library.

For example, if Microsoft Project is not running, then starting it with

Set x = CreateObject("MSProject.Application")

creates a reference-dependent instance of Microsoft Project, because if the value of x changes or x ceases to exist, then Microsoft Project closes automatically.

If Microsoft Project is started as the result of CreateObject or GetObject, then if starts out dependent on the object variable used in the CreateObject or GetObject command. After that, it can become reference-independent by restarting it manually, or by opening reference-independent projects.

There are no visible reference-dependent instances of Excel. Once an instance of Excel shows up in the Windows Task List, it remains running until you manually close it or use some command like the Quit method. Invisible instances may or may not be reference dependent. CreateObject("Excel.Application") starts reference-independent instances. CreateObject("Excel.Sheet") and CreateObject(Excel.Chart") create reference-dependent instances if Excel was not already running.

Technically Word can't be a reference-dependent application because there is no

Word.Application object, but the Word.Basic object can be reference-dependent and behaves like an application object.

Lesson 3 Exercises

1. 
Write a Microsoft Project macro that starts a new invisible instance of Excel and creates a new workbook. For each nonblank task in the active project, the task names and durations are written to the first two columns of Sheet1 in the new workbook. Then the Excel Save As dialog comes up so you can enter a filename to save the new workbook. After that Excel quits. The only part of Excel you see is the Save As dialog and any overwrite warning. You don't get the "Save changes?" message. Write the macro so that the durations show up as text in the workbook just like they look in the task table. No blank rows are written to the worksheet. Test run the macro on a project that has several tasks including some blank rows, then open up the workbook it saved and see if it has the correct data.

2. 
Write an Microsoft Project macro that switches to Excel if it's running, otherwise starts a new visible instance and switches to it. The macro maximizes the Excel window and adds a new workbook. The task names and durations in the active project are written to the first two columns of Sheet1. The durations are written as pure numbers representing working days relative to ActiveProject.HoursPerDay. Then a chart sheet is added and the ChartWizard method is used to specify the source range for the chart to be the data in Sheet1. Assuming that x refers to Excel.Application, and that s refers to x.Sheets("Sheet1"), then the chart can be added with the following lines in the Microsoft Project macro:

x.Charts.Add

x.ActiveChart.ChartWizard _


Source:=s.Cells(1, 1).CurrentRegion, _


PlotBy:=2, _


CategoryLabels:=1

Lesson 4: File Input/Output

What You Will Learn

After completing this lesson, you will be able to:

· List the most commands used to read and write text files.

· Describe formatting problems that can occur using the Write# command.

· Demonstrate in a macro how to use FreeFile, Open, Input#, Write#, EOF, and Close.

Related Topics Covered in this Lesson

· Macro Commands Used To Read and Write Text Files

· Formatting Data For Output To Text Files

File Input/Output

This section is a light introduction to file input/output, and emphasizes sequential processing of CSV files.

Visual Basic for Applications has a rich set of file input/output commands. You can read/write data from any offset within a file or read/write data sequentially. You can easily read/write comma separated files or read/write a byte at a time, a line at a time, or fixed length records. 

Sequential processing means that you read from a file or write to a file sequentially, starting from the beginning of the file. Random processing means that you can read data from a file or write data to a file, starting at any position within the file. 

Here's a couple of possible uses for file input/output in Microsoft Project macros:

· Create custom reports that write to CSV files.

· Create (write) or process (read) custom mpx files.

· Use a temporary file to "dynamically" exchange data between Microsoft Project and another application or a VB5 program.

The following commands can handle most sequential file input/output needs:

Command
Common Usage

FreeFile
Get a free file handle (needed by other commands)

Open
Open the file

Input #
Read in fields and assign them to variables

Write #
Write out data - automatically comma separated

Print #
Write out data - not automatically comma separated

EOF
Used to check if all records have been read

LOF
Length of file - file must have been opened by Open

FileLen
Length of file - must not be open - you specify the filename

Close
Close a file opened by Open

NOTE: If you leave out the Close command at the end of your macros, or if you get a runtime error before the macro executes the Close command, you may get a message telling you the file is already open when you run the macro again. If this happens, use the menu command Run Reset.

If you need random access, then you'll want to look at some of these commands:

Put
Write data starting at a specified position within the file

Get
Read data starting at a specified position within the file

Seek
Specify the position for the next read/write

Loc
Returns the position for the next read/write

See Online Help for the detailed syntax and options available with the above commands.

Formatting Concerns

When reading/writing CSV files, you need to deal with the formatting that the CSV file contains. Different applications format different kinds of data in different ways when creating CSV files. About the only thing that is consistent is that commas separate the fields. The table below shows how the same Microsoft Project fields would be written out using the Write# command compared to using FileSaveAs with the CSV format. It shows how the Id, Name, Duration, Start, and Flag1 task properties are written out for a single task, with no additional formatting. The task has Id=1. It starts on 1/2/95 8:00 AM, but the current Microsoft Project Date Format shows the date in a task table as 1/2/95. It is assumed that Activeproject.HoursPerDay is 8.

Screen 1
MsgBox 2
Write# 3
FileSaveAs 4

1
1


1


1

task1
task1


"task1"


task1

1d
480
480


1d

1/2/95
1/2/95 8:00:00 AM
#1995-01-02 8:00:00#
1/2/95

Yes

True


#TRUE#

No

1 
The Screen column shows how the data appears in the task table on screen.

2 The MsgBox column was discovered by examining the output from:

Set t = ActiveProject.Tasks(1)

MsgBox t.ID

MsgBox t.Name

MsgBox t.Duration

MsgBox t.Start

MsgBox t.Flag1

3 The Write# column was discovered by writing to a text file and then examining the text file in NotePad. The code looked like:

Dim fnum As Integer, t As Object

fnum = FreeFile

Open "c:\test.csv" For Output As fnum

Set t = ActiveProject.Tasks(1)

Write #fnum, t.ID, t.Name, t.Duration, t.Start, t.Flag1

4 The FileSaveAs column was created manually by choosing File, Save As, and using the CSV format.

Formatting woes: The # signs in the Write# column aren't recognized as date and boolean (true/false, yes/no) qualifiers when the CSV file created by Write# is manually read back in by Microsoft Project or Excel using File Open (error messages result in Microsoft Project). Also, if the pure number 480 is read back into Microsoft Project using File Open, it doesn't interpret it as minutes, and instead would tack on the default duration units, so you could end up with a duration of 480d.

The table below shows some ways to get around these formatting problems. It assumes the same data as in the previous table.

Screen
Command
Writes this

1d
Write# fnum, t.Duration
480

1d
1
Write# fnum, t.Duration / 60 / 8 & "d"   
"1d"

1d
2
Write# fnum, t.GetField(pjTaskDuration) 
"1d"

1/2/95
Write# fnum, t.Start
#1995-01-02 8:00:00#

1/2/95
2
Write# fnum, CStr(t.Start)
"1/2/95 8:00:00 AM"

1/2/95
Write# fnum, t.GetField(pjTaskStart)
"1/2/95"

Yes
Write# fnum, t.Flag1
#TRUE#

Yes
Write# fnum, CStr(t.Flag1)
"True"

Yes
Write# fnum, Format(t.Flag1,"yes/no")
"Yes"


Yes
2
Write# fnum, t.GetField(pjTaskFlag1)

"Yes"

1 In general, the expression: T.Duration / 60 / 8

should be replaced by: T.Duration / 60 / Activeproject.HoursPerDay

2
Commonly used methods.
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 Try This
This Microsoft Project macro writes Id, Name, Duration, Start, and Flag1 values for all tasks in the active project to a CSV file.

1. 
Open/Create a test file with some tasks.

2. 
Enter and run the following Microsoft Project macro:

Sub write3()


Dim fnum As Integer


Dim oTask As Object


fnum = FreeFile()







Open "c:\test.csv" For Output As fnum




For Each oTask In ActiveProject.Tasks



Write #fnum, _








oTask.ID, _




oTask.Name, _




oTask.GetField(pjTaskDuration), _




CStr(oTask.Start), _




oTask.GetField(pjTaskFlag1)


Next


Close fnum

End Sub

3. 
After the macro finishes, open up c:\test.csv in NotePad and examine how the data is formatted. Close NotePad.

4. 
Open c:\test.csv in Excel and examine how the data is formatted. Close Excel.

5. 
Use the Microsoft Project menu command File Open to open c:\test.csv. Any problems?

Did a task sheet view have to be active for this macro to work? Did a table have to exist that begins with fields Id, Name, Duration, Start, and Flag1?
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 Try This
This Microsoft Project reads in task Text1, Name, and Duration fields from a text file and searches for a task in the active project whose Text1 and Name fields match those read in - the search is case sensitive for Text1, but not for Name. If it finds a match, it sets the duration of that task to the duration read in. If doesn't find a match then if adds a new task with the Text1, Name, and Durations read in.

1. 
Enter the text below in NotePad. Save it as c:\match.txt and then exit NotePad.

"012","task x","10d"

"005","task y","20d"

"007","task w","30d"

2. 
Create a project with the following task data:

Id
Name
Duration
Text1

1
task a
1d
009

2
task x
1d
011

3
task w
1d
007

4
task x
1d
012

3. Enter the following Microsoft Project sub procedure, but don't run it yet.

Sub MergeFile()


Dim fnum As Integer, otask As Object


Dim Text1Input$, NameInput$, DurationInput$


Dim matchingID As Integer


fnum = FreeFile()


Open "c:\match.txt" For Input As fnum


Do Until EOF(fnum)

  

Input #fnum, Text1Input, NameInput, DurationInput


 
matchingID = GetIdOfMatch(Text1Input, NameInput)

  

If matchingID = 0 Then

     

Set otask = ActiveProject.Tasks.Add

  

Else

     

Set otask = ActiveProject.Tasks(matchingID)

  

End If



otask.Text1 = Text1Input

  

otask.Name = NameInput

  

otask.Duration = DurationInput


Loop


Close fnum

End Sub

4. 
Enter the following Microsoft Project function. It is passed the Text1 and Name read in, and it returns the ID of the first matching task it finds. If there is no match, it returns a 0.

Function GetIdOfMatch(TextInput$, NameInput$) As Integer


Dim otask As Object

  
For Each otask In ActiveProject.Tasks

   
If Not otask Is Nothing Then

     
  
If otask.Text1 = TextInput _




And UCase(otask.Name) = UCase(NameInput) Then


       

GetIdOfMatch = otask.ID

        
 

Exit Function

        
End If



End If

  
Next

  
GetIdOfMatch = 0

End Function

5. 
Run the MergeFile macro and then check a task table to see if it updated the tasks correctly. It should look like this:

Id
Name
Duration
Text1

1
task a
1d
009

2
task x
1d
011

3
task w
30d
007

4
task x
10d
012

5
task y
20d
005



Binary Examples

Example

This Microsoft Project macro plugs the word "hello" into an existing file Test1, starting at the 3rd byte, without changing the rest of the file.

Sub Bin1()


Dim fnum As Integer


Dim s As String


fnum = FreeFile()


Open "c:\Test1" For Binary As fnum


s = "hello"


Put fnum, 3, s


Close fnum

End Sub

Example

This Microsoft Project macro reads 5 characters, one character at a time, from the file Test1, starting with the 3rd byte in the file. The ASCII code for each byte read is displayed in a MsgBox, along with the character, if it's printable or a message if it's not.

Sub Bin2()


Dim fnum As Integer


Dim n as integer


Dim c As String * 1
'String can hold 1 char only


Dim s As String 


fnum = FreeFile()


Open "c:\Test1" For Binary As fnum


For n = 3 To 5



Get fnum, n, c



If Asc(c) >= 32 Then




s = c



Else




s = "Can't display"



End If



MsgBox "n = " & n & Chr(10) & _


 


"Ascii code = " & Asc(c) & Chr(10) & _





"Character: " & s



Next


End Sub

Lesson 4 Exercises

1.
Write an Microsoft Project macro that lets the user enter a path and filename in an InputBox, and then saves the comma separated Task UniqueId and Start fields to that file, where the UniqueId's are saved without quotes, and the Start dates are saved with quotes. For example if a task with UniqueId 7 has a start of 10/1/94 then the record written to the CSV file looks like:


7,"10/1/94 8:00:00 AM"

Don't write out records for blank tasks. Assume there's at least one nonblank task in the active project. Don't bother with a custom error handler to handle bad filenames etc. Test this on a project with a couple of tasks and examine the file it creates (open it in NotePad).

2.
Create and save a text file in NotePad that contains the Unique Id and duration fields shown below:


3,"5d"


1,"2d"


7,"3d"

Save the file as "C:\M3L6E2.TXT".

Write a macro that reads in this file and assigns the durations to the appropriate tasks (matching the Unique Ids). You can hard code the filename "C:\M3L6E2.TXT", but make no assumptions as to the number of records it contains (i.e. use the Do Until EOF(fnum) loop).

Details: Declare a long variable Uid and a string variable Dur. For each record, the Input# command reads the record into the Uid and Dur variables; then the duration of the task with Unique Id = Uid is set equal to the value of Dur. If there is no task with Unique Id =  Uid, then display the message "There is no task with Unique Id =  ", followed by the value of the variable Uid. Then continue on to the next record.

This is much easier than it looks - no searching required. For example, if a task has Unique Id = 5, and you wanted to set its duration to 100d, you could use the Unique Id directly:

ActiveProject.Tasks.UniqueId(5).Duration ="100d"

If there is no task with Unique Id = 5, then the above statement would cause a trappable error (On Error Resume Next etc.). Of course, you're working with variables Uid and Dur instead of literals  5 and "100d". 

Test the macro: Create a project with at least 7 tasks. Display the Unique Id column. Run the macro. Check that the durations of the tasks with unique ids 1, 3, and 7 have changed correctly. Then try deleting the task with unique id = 3 and run the macro again. It should give the error message about unique id = 3.

Lesson 5: API's and DLL's

What You Will Learn

After completing this lesson, you will be able to:

· Define API and DLL.

· Describe how to declare an API function.

· Describe how to use API functions to hide a window, show a window, make a window "always on top", and how to tell if an application is running and whether it is visible or not.

Related Topics Covered in this Lesson

· Where To Find Information About Specific API Functions

· How to Get API Declarations and Global Constants Into a Macro

· API functions To Manipulate and Get Information about Application Windows

· API functions To Pass Data Between Applications Using Global Memory and the ClipBoard.

API's and DLL's

A DLL (Dynamic-link library) is a set of procedures that can be called from windows applications. There are plenty of standard DLLs available. The Windows API includes the User, GDI, and Kernel libraries. Other examples of API's are MAPI (messaging API) and TAPI (telephony API). Documentation about what procedures are in various API libraries is usually found in the appropriate SDK (software development kit). VB5 Professional Edition includes Win31wh.hlp, a help file that ships with the Windows SDK. It's in the WinAPI subdirectory of VB5, and documents Windows API procedures. Win31wh.hlp uses C language syntax, but you need not be a C programmer to get the gist of what a procedure is for. To call a DLL procedure from a macro, you first declare it in the declaration area at the top of a module. Declarations are technical statements telling your macro where to find the DLL procedure, how to pass data to it (if it takes arguments), and what data the procedure will return, if any. Instead of entering declarations manually, you usually copy them from some documentation text or help file. VB5 also includes Win31API.hlp, which has declarations that you can copy and paste into the declaration area of one of your modules. VB5 and applications that support Visual Basic for Applications can call DLL procedures.

API DECLARATIONS

Before you can use a procedure from a DLL, you must declare it. The declarations are entered or pasted into the declaration area in a module. A Declaration must be on one line, unless the macro editor in the application has a continuation character. 

Most declarations include arguments. When you call the procedure in your macro, you replace the arguments just like you would when calling a macro procedure. Some of the API procedures have flag arguments that must be set to one of a few predefined values. The same documentation that contains the declaration statements also contains a list of global constants that you can copy and paste into the declaration area of a module. You can then use the named constants when you call the procedure. In some cases, you are allowed to pass the sum of two constants for a flag to combined two actions, for example:



SWP_NOMOVE + SWP_NOSIZE

Most of the API declarations are function procedures instead of sub procedures. Often they return only a success/failure flag. You can ignore the return value if you have no use for it, by not assigning a variable when you call the function, and not using ( )'s around the argument list. For example, both of the following are legal:

nPreviousState = ShowWindow(handle, SW_SHOWMAXIMIZED)

ShowWindow handle, SW_SHOWMAXIMIZED

In the declaration examples below, return values that are usually ignored are not discussed. See the API documentation for information on these return values.

There are some examples of API declarations below, along with some comments about what the procedures do. There are also some examples of Microsoft Project and Excel procedures that use them. Most of these examples could be run from any application that supports Visual Basic for Applications (like Excel and Microsoft Project) or from VB5, except where indicated otherwise. These examples require that the API procedures used be declared in the declaration area of a module.

Some Window-Related Procedures

The first set of API procedures manipulates or gets information about windows:

· GetActiveWindow

· SetWindowPos

· ShowWindow

· GetClassname

· FindWindow

· IsWindowVisible

GetActiveWindow

Declare Function GetActiveWindow Lib "USER32" () As Long

GetActiveWindow returns the handle to the active window. A window handle is an integer that identifies a window. It's not of much use by itself, but the window handle is usually passed to other procedures when talking actions or requesting data about a specific window. You normally assign it to an integer variable, for example,

handle = GetActiveWindow()

SetWindowPos

Declare Sub SetWindowPos Lib "USER32" _

 
(ByVal hWnd As Long, _


 ByVal hWndInsertAfter As Long, _


 ByVal x As Long, ByVal y As Long, _


 ByVal cx As Long, ByVal cy As Long, _


 ByVal wFlags As Long)

SetWindowPos can be used to move or resize a window, and change the position (zorder) of the specified window within the stack of windows. Below is a description of its arguments:

hWnd
Handle to the window you want to effect.

hWndInsertAfter
A value that specifies the desired zorder. You can either declare or pass one of the constants below, or pass the actual number. If you use the named constants, you must put them in the declaration area of a module:
Global Const HWND_TOP = 0

Global Const HWND_BOTTOM = 1

Global Const HWND_TOPMOST = -1

Global Const HWND_NOTOPMOST = -2

wFlags
A flag that helps describe what you want to do with the window. Here's a few of the possible constants it can be:

Global Const SWP_NOSIZE = &h1

Global Const SWP_NOMOVE = &h2

Global Const SWP_SHOWWINDOW = &h40

Global Const SWP_HIDEWINDOW = &h80

x,y
Coordinates where you want the upper left corner of the window. Ignored if you include SWP_NOSIZE in wFlags.

cx,cy 

Width and height you want for the window.  Ignored if you include SWP_NOMOVE in wFlags.

ShowWindow 

Declare Function ShowWindow Lib "USER32" _

  
(ByVal hWnd As Integer, ByVal nCmdShow As Integer) As Long

The ShowWindow procedure can make the specified window visible or invisible, as well as maximize, minimize, or normalize it. If you use ShowWindow to hide an application window, then that application will no longer be in the Windows Task List. The return value tells what state the window was in before you called the procedure. You normally won't use the returned value. Below is a description of its arguments:

hWnd
Handle to the window you want to effect.

nCmdShow
A flag that helps describe what you want to do with the window. Here's a few of the possible constants it can be:
Global Const SW_HIDE = 0

Global Const SW_SHOWNORMAL = 1

Global Const SW_SHOWMINIMIZED = 2

Global Const SW_SHOWMAXIMIZED = 3

GetClassname

Declare Function GetClassName Lib "user32" Alias "GetClassNameA" _


(ByVal hwnd As Long, ByVal lpClassName As String, _

 ByVal nMaxCount As Long) As Long

Each window has a Classname associated with it that can be used in other procedures to get information about the window. The API GetClassname function returns the Classname of the window that you specify. For example, by using this function, you would discover that the Classname of the Microsoft Project application window is "JWinproj-WhimperMainClass".

hWnd
Handle to the window you want to effect.

lpClassname
Memory address or string variable name where you want the Classname placed. You usually pass it the name of a fixed length string variable. When the procedure is done, it will have assigned the Classname to your variable. When you declare the fixed length string variable, give it a length equal to the maximum number of characters you want it to return (in case the Classname is really long). Here's an example of a variable declaration that reserves room for 10 characters:

Dim s As String * 10

After the procedure is done, you could see the Classname with the command:

MsgBox s

nMaxCount

Maximum number of characters you want it to place in lpClassname.

FindWindow

Declare Function FindWindowA Lib "USER32" _

 (ByVal lpClassname As Any, ByVal lpWindowName As Any) As Long

FindWindow can tell if a specific application is running, even if the application is running invisibly (not in the Windows Task List). You need to provide a Classname or window title bar caption (see GetClassname for a method for discovering application Classnames). The return value is a handle to the window, or 0 if it can't find it. You normally assign the return value to an integer variable, for example,

handle = FindWindowA("JWinproj-WhimperMainClass", 0&)

lpClassname
String with the Classname, or 0& to ignore.

lpWindowName
String with the window title or 0& to ignore

IsWindowVisible

Declare Function IsWindowVisible Lib "User32" _


(ByVal hWnd As Long) As Long

IsWindowVisible can tell if an application window is visible (in the Windows Task List) or not.

hWnd
Handle to the window you are inquiring about.

You need to provide a handle to the window of interest. Normally the handle returned by FindWindow is used. IsWindowVisible returns True if the window is visible or False if it is not, so IsWindowVisible is normally used in an IF statement.

Examples of Window-Related Procedures

The examples below assume the appropriate declarations and global constants, as described above have been placed in the declaration area of a module.

Example

This Excel macro gives a message that tells if Microsoft Project is running, and if it is, it tells whether it is in the Windows Task List (running visibly) or not.

Sub WhatAboutMSProject()


Dim handle As Long


handle = FindWindowA("JWinproj-WhimperMainClass", 0&)


If handle = 0 Then



MsgBox "MSProject is not running"


ElseIf IsWindowVisible(handle) then



MsgBox "MSProject is in the Windows Task List"


Else



MsgBox "MSProject is running, but is not " & _





"in the Windows Task List"


End If

End Sub

Example

This macro makes the active window topmost, i.e. "always on top". The coordinates for moving and sizing are ignored, so it passes zeroes for those arguments.

Sub MakeActiveWindowTopMost()


SetWindowPos GetActiveWindow(), _

   
HWND_TOPMOST, 0, 0, 0, 0, SWP_NOMOVE + SWP_NOSIZE

End Sub

Example

This macro makes the active window not topmost, i.e. "not always on top". The coordinates for moving and sizing are ignored, so it passes zeroes for those arguments.

Sub MakeActiveWindowNotTopMost()


SetWindowPos GetActiveWindow(), _


    HWND_NOTOPMOST, 0, 0, 0, 0, SWP_NOMOVE + SWP_NOSIZE

End Sub

Example

This Microsoft Project macro allows you to discover the Classname of any window. When it runs, it minimizes Microsoft Project to a topmost icon and the caption under the icon will say "Microsoft Project - " followed by the Classname of whatever window is active, for example you would see the following caption under it if Excel were active:


Microsoft Project - XLMAIN

It works by going into a DoEvents loop, which uses the API procedures GetActiveWindow and GetClassname, and displays the returned Classname in the Microsoft Project window caption. The fixed length string sClassname is used to hold the returned Classname (maximum 30 characters), and the string sOldClassname is used to tell when the Classname has changed.

Sub ShowClassnames()


'DECLARE A STRING VARIABLE WITH ROOM FOR 30 CHARACTERS


Dim sClassname As String * 30 


Dim sOldClassname As String


MsgBox "This Microsoft Project macro displays Classnames " & _




 "of the active window under a minimized " & _




 "Microsoft Project icon, after the hyphen. " & _


     
 "To end the macro, maximize Microsoft Project."


MakeActiveWindowTopMost


sOldClassname = ""


AppMinimize


Do

   
DoEvents



GetClassname GetActiveWindow(), sClassname, 30



If sClassname <> sOldClassname Then

     

ActiveWindow.Caption = sClassname

   

sOldClassname = sClassname



End If


Loop While WindowState = pjMinimized


ActiveWindow.Caption = ActiveProject.Name


MakeActiveWindowNotTopMost

End Sub

Example

This Microsoft Project macro checks if Excel is running, and if it is, it makes it invisible (removes it from the Windows Task List). If more than one instance of Excel is running, it only effects one instance.

Sub HideExcel()


Dim handle As Long


handle = FindWindowA("XLMAIN", 0&)


If handle = 0 Then



MsgBox "Excel is not running"


Else



ShowWindow handle, SW_HIDE


End If

End Sub

Example

This Microsoft Project macro checks if Excel is running, and if it is, it makes it visible (puts it in the Windows Task List) and maximizes it. If more than one instance of Excel is running, it only effects one instance.

Sub ShowExcel()


Dim handle As Long


handle = FindWindowA("XLMAIN", 0&)


If handle = 0 Then



MsgBox "Excel is not running"


Else



ShowWindow handle, SW_SHOWMAXIMIZED


End If

End Sub

Some Memory Allocation and Clipboard Procedures

These procedures are used for passing data between applications.

· GlobalAlloc

· GlobalLock

· GlobalUnlock

· GlobalFree

· lstrcpy

· lstrcpyn

· lstrlen

· OpenClipboard

· EmptyClipboard

· SetClipboard

· GetClipboardData

· CloseClipboard

GlobalAlloc

Declare Function GlobalAlloc Lib "KERNEL32" _


(ByVal wFlags As Long, ByVal dwBytes As Long) As Long

Allocates global memory of the specified kind and amount and returns a memory block id.

In Windows, global blocks of memory that can be shared by applications are identified in two ways: By a block id number, and by a memory address. There are also different kinds of memory blocks, for example, moveable blocks that windows is allowed to move around in memory to optimize system performance, fixed blocks that it can't move, and blocks with other characteristics. You tell the GloballAlloc function what kind of memory you want and how much. It returns 0 if there isn't enough available, otherwise it returns the id number for the block. You normally assign it to an integer variable, for example:


MemoryBlockId = GlobalAlloc(GMEM_DDESHARE, 100&)


If MemoryBlockId = 0 Then



MsgBox "Not enough free memory"



End


End If

dwBytes
Long integer that tells how many bytes to allocate.

wFlags
Determines what "kind" of memory. The safest kind to use is DDE share memory, because windows will automatically free this memory when the application that allocated it quits. The corresponding constant for this type of memory is shown below. See the API documentation for other possible kinds of memory.

Global Const GMEM_DDESHARE = &h2000

GlobalLock

Declare Function GlobalLock Lib "KERNEL32" _

  
(ByVal hMem As Long) As Long

Locks the specified memory blocks and returns an address. You must lock it before you can use it. When locked, Windows will insure that no other applications will mess with the contents of that memory block. It's analogous to record locking. In addition, GlobalAlloc is used to convert memory block id numbers into memory block addresses. Some procedures must be passed ids, while others require addresses. You normally assign it to a long integer variable, for example:

MemoryBlockAddress = GlobalLock(MemoryBlockId)

where MemoryBlockId might have been the result of a GlobalAlloc call.

hMem
Id of the memory block you want to lock.

GlobalUnlock

Declare Function GlobalUnlock Lib "KERNEL32" _

  
(ByVal hMem As Long)

hMem
Id of the memory block you want to unlock. You must unlock a global memory block before you can free it.

GlobalFree

Declare Function GlobalFree Lib "KERNEL32" _


(ByVal hMem As Long) As Long

hMem
Id of the memory block you want to free.

lstrcpyA

Declare Function lstrcpyA Lib "KERNEL32" _

  
(ByVal lpDest As String, ByVal lpScr As String) As Long

This function is used to copy data from one string (or memory block) to another. The content of lpString2 is copied to into the string lpString1; lpString1 must have enough room to hold lpString2. The character 0 marks the end of a string or the data to be copied from a memory block, up to a maximum of 64K characters (bytes).

When you pass a string variable or constant to this function, you are actually passing a memory block address. The terms "string" and "memory block address" are interchangeable in this context.

lpDest
Target memory address.

lpScr
Source memory address or string.

lstrcpynA

Declare Function lstrcpynA Lib "KERNEL32" _


(ByVal lpString1 As String, ByVal lpString2 As String, _

 
 ByVal nChars As Long) As Long

Like lstrcpy, but it allows you to specify a maximum number of characters to copy. Much safer.

lpString1

Target memory address or string. You must reserve at least as much room (minus 1) as you specify by the nChars argument.

lpString2
Source memory address or string.

nChars
The maximum number of characters you want to copy. You actually have to specify one more than the number of characters you want, because it counts the 0 character.  For example, if lpString2 is the string "Happy" and you specify nChars=3, then lpString1 becomes "Ha".

lstrlenA

Declare Function lstrlenA Lib "Kernel32" _


(ByVal lpString As String) As Long

This function is used to get the length of a string .The character 0 marks the end the string. The length returned does not count the 0.

lpString
Memory address or string you want to measure.

OpenClipboard

Declare Function OpenClipboard Lib "USER32" _

  
(ByVal hWnd As Long) As Long

Opens the Clipboard so it can be accessed.

hWnd
Handle of the window accessing the Clipboard; you usually pass the result returned from GetActiveWindow().

EmptyClipboard 

Declare Function EmptyClipboard Lib "USER32" () As Long

Used to clear the Clipboard.

SetClipboardData

Declare Function SetClipboardData Lib "USER32" _

  
(ByVal wFormat As Long, ByVal hMem As Long) As Long

Used to put data on the Clipboard. You tell it the format of the data and where it's at (pass a memory block id).

wFormat
Constant that determines the kind of data you are copying to the Clipboard, i.e. the Clipboard format. See the API documentation for the possible choices. For text, use:


Global Const CF_TEXT = 1

hMem
Id of the memory block you want "copied to the Clipboard"

GetClipboardData

Declare Function GetClipboardData Lib "USER32" _

  
(ByVal wFormat As Long) As Long

Used to get data from the Clipboard. You tell it what kind (format) of data you want. It returns a memory block id for the memory where the Clipboard data is located. You normally assign it to an integer variable, for example:

MemoryBlockId = GetClipboardData(CF_TEXT)

You normally use GlobalLock to convert the id to an address and then use lstrcpy to copy the data into a string variable.

wFormat
Same as in SetClipboardData

CloseClipboard

Declare Function CloseClipboard Lib "USER32" () As Long

You must close the Clipboard so other applications can use it. You can place this before any OpenClipboard call to insure that the Clipboard isn't already open.

Examples of Memory Allocation and Clipboard Procedures

The examples below assume the appropriate declarations and global constants as described above have been placed in the declaration area of a module.

Example

This macro allows you to enter text in an InputBox and assign it to a string variable. The contents of the string variable are then placed on the Clipboard, (without placing it in any cell and without using EditCopy). The string variable value is copied to a global memory block, and then the Clipboard is told to point there. Note that you don't use GlobalFree to free up this memory block - the Clipboard is responsible for the memory after you use the SetClipboardData procedure.

Sub PutTextOnClipboard()


Dim MemoryBlockId As Long


Dim MemoryBlockAddress As String


Dim s As String 


s = InputBox("Enter text to put on Clipboard")


OpenClipboard GetActiveWindow()


EmptyClipboard


'ALLOCATE A GLOBAL MEMORY BLOCK


MemoryBlockId = GlobalAlloc(GMEM_DDESHARE, Len(s))


'CONVERT THE MEMORY BLOCK ID INTO AN ADDRESS


MemoryBlockAddress = GlobalLock(MemoryBlockId)


'COPY THE STRING VARIABLE S INTO THE MEMORY BLOCK


lstrcpyA MemoryBlockAddress, s


'TELL THE CLIPBOARD WHERE TO GET ITS DATA FROM


SetClipboardData CF_TEXT, MemoryBlockId


CloseClipboard


MsgBox "Open up the Clipboard. Your string should be there."

End Sub

Example

This macro copies a maximum of 100 characters from the Clipboard directly into a string variable (without placing it in any cell and without using EditPaste). Then the macro shows the contents of the string variable.

Sub GetTextFromClipboard()


Dim MemoryBlockId As Long


Dim MemoryBlockAddress As String


Dim s As String * 100 'Must reserve room in the string


OpenClipboard GetActiveWindow()


MemoryBlockId = GetClipboardData(CF_TEXT)


MemoryBlockAddress = GlobalLock(MemoryBlockId)


lstrcpynA s, MemoryBlockAddress, 101 'Plus 1 for the 0 character


GlobalUnlock MemoryBlockId


CloseClipboard


MsgBox "The text on the Clipboard is: " & s

End Sub

Lesson 5 Exercises

1. 
Write a Microsoft Project macro that starts a new instance of the Calculator application that comes with Windows (Calc.exe) and makes it a top most window.

2. 
Write a Microsoft Project macro that clears the Clipboard and then waits in a DoEvents loop until it sees the word "hello" on the Clipboard. At that point, it activates the Microsoft Project window and displays a message "goodbye". Use the appropriate API calls to do this - see the GetTextFromClipBoard example. Use lstrcpyn where nchars=6 (1 + length of "hello").
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Controlling one Microsoft Office application from another

If you want to run code in one Microsoft Office application that works with the objects in another application, follow these steps.

1 Set a reference to the other application's type library in the References dialog box (Tools menu). After you have done this, the objects, properties, and methods will show up in the Object Browser and the syntax will be checked at compile time. You can also get context-sensitive Help on them.

2 Declare object variables that will refer to the objects in the other application as specific types. Make sure you qualify each type with the name of the application that is supplying the object. For example, the following statement declares a variable that will point to a Word document and another that refers to a Microsoft Excel workbook.

Dim appWD As Word.Application, wbXL As Excel.Workbook

Note   You must follow the steps above if you want your code to be early bound.

3 Use the CreateObject function with the OLE Programmatic Identifier of the object you want to work with in the other application, as shown in the following example. If you want to see the session of the other application, set the Visible property to True.

Dim appWD As Word.Application

Set appWD = CreateObject("Word.Application")

appWd.Visible = True

4 Apply properties and methods to the object contained in the variable. For example, the following instruction creates a new Word document.

Dim appWD As Word.Application

Set appWD = CreateObject("Word.Application.8")

appWD.Documents.Add

5 When you are done working with the other application, use the Quit method to close it, as shown in the following example.

appWd.Quit

Using events with Microsoft Project objects

You can write event procedures in Microsoft Project at the application or project level. For example, the Activate event occurs at the project level and the NewProject event is available at the application level. The Activate event for a project occurs when the project is activated. The NewProject event occurs whenever a new project is created.

Project event procedures are available for any open project. To write event procedures for the Application object, you must create a new object using the WithEvents keyword in a class module.

Note   Event code in your project may or may not run unexpectedly, if event code exists in the global file (Global.mpt).

· If code exists for an event in both the global and project files, only the code in the project event runs.

· If code for an event does not exist in a project, but does in the global file, the code in the global event runs.

· If code for one of three events (BeforeClose, BeforeSave, and Open) exists in the global file, but not in the project, it will affect both the global and project files. If code exists for those events in both the global and project files, the code in the global file affects the global file, and the code in the project affects the project. These are the only events that can affect the global file.

Application object events

Application events occur when a project is created. To write event procedures for the Application object, you must create a new object using the WithEvents keyword in a class module. For more information, see Using events with the Application object.

NewProject
Using events with the Application object

Before you can use events with the Application object, you must create a new class module and declare an object of type Application with events. For example, assume that a new class module is created and called EventClassModule. The new class module contains the following code.

Public WithEvents App As Application

After the new object has been declared with events, it appears in the Object drop-down list box in the class module, and you can write event procedures for the new object. (When you select the new object in the Object box, the valid events for that object are listed in the Procedure drop-down list box.)

Before the procedures will run, however, you must connect the declared object in the class module with the Application object. You can do this with the following code from any module.

Dim X As New EventClassModule

Sub InitializeApp()


Set X.App = Application

End Sub

After you run the InitializeApp procedure, the App object in the class module points to the Microsoft Project Application object, and the event procedures in the class module will run when the events occur.

Project object events

Project events occur when the project changes. To view the event procedures for a project, right-click the title bar of a restored or minimized project window and click View Code on the shortcut menu. Select the event name from the Procedure drop-down list box.

Activate
Calculate

BeforeClose
Change

BeforePrint
Deactivate

BeforeSave
Open

This example maximizes Microsoft Project when the project is opened.

Private Sub Project_Open(ByVal pj As MSProject.Project)

    Application.WindowState = pjMaximized

End Sub

Creating a custom dialog box

Use the following procedure to create a custom dialog box:

1 Create a UserForm
On the Insert menu in the Visual Basic Editor, click UserForm.

2 Add controls to the UserForm
Find the control you want to add in the Toolbox and drag the control onto the form.

3 Set control properties
Right-click a control in design mode and click Properties to display the Properties window.

4 Initialize the controls
You can initialize controls in a procedure before you show a form, or you can add code to the Initialize event of the form.

5 Write event procedures
All controls have a predefined set of events. For example, a command button has a Click event that occurs when the user clicks the command button. You can write event procedures that run when the events occur.

6 Show the dialog box
Use the Show method to display a UserForm.

7 Use control values while code is running
Some properties can be set at run time. Changes made to the dialog box by the user are lost when the dialog box is closed.

Creating a UserForm

To create a custom dialog box, you must create a UserForm. To create a UserForm, click UserForm on the Insert menu in the Visual Basic Editor.

Use the Properties window to change the name, behavior, and appearance of the form. For example, to change the caption on a form, set the Caption property.

Adding controls to a UserForm

To add controls to a UserForm, find the control you want to add in the Toolbox, drag the control onto the form, and then drag an adjustment handle on the control until the control’s outline is the size and shape you want.

Note   Dragging a control (or a number of “grouped” controls) from the form back to the Toolbox creates a template of that control, which can be reused. This is a useful feature for implementing a standard interface for your applications. 

When you've added controls to the form, use the commands on the Format menu in the Visual Basic Editor to adjust the control alignment and spacing.

ActiveX controls

For more information about a specific control, select an object from the following list. For information about events, select a control and click Events at the top of the topic.

CheckBox
ComboBox
CommandButton
Frame
Image
Label
ListBox
MultiPage
OptionButton
ScrollBar
SpinButton
TabStrip
TextBox
ToggleButton

Setting control properties

You can set some control properties at design time (before any macro is running). In design mode, right-click a control and click Properties to display the Properties window. Property names are shown in the left column in the window, property values in the right column. You set a property value by entering the new value to the right of the property name.

Initializing control properties

You can initialize controls at run time by using Visual Basic code in a macro. For example, you could fill a list box, set text values, or set option buttons.

The following example uses the AddItem method to add data to a list box. Then it sets the value of a text box and displays the form.

Private Sub GetUserName()


With UserForm1



.lstRegions.AddItem "North"



.lstRegions.AddItem "South"



.lstRegions.AddItem "East"



.lstRegions.AddItem "West"



.txtSalesPersonID.Text = "00000"



.Show



' ...


End With

End Sub

You can also use code in the Initialize event of a form to set initial values for controls on the form. An advantage to setting initial control values in the Initialize event is that the initialization code stays with the form. You can copy the form to another project, and when you run the Show method to display the dialog box, the controls will be initialized.

Private Sub UserForm_Initialize()


UserForm1.lstNames.AddItem "Test One"


UserForm1.lstNames.AddItem "Test Two"


UserForm1.txtUserName.Text = "Default Name"

End Sub

Control and dialog box events

After you have added controls to your dialog box, you add event procedures to determine how the controls respond to user actions.

UserForms and controls have a predefined set of events. For example, a command button has a Click event that occurs when the user clicks the command button, and UserForms have an Initialize event that runs when the form is loaded.

To write a control or form event procedure, open a module by double-clicking the form or control, and select the event from the Procedure drop-down list box.

Event procedures include the name of the control. For example, the name of the Click event procedure for a command button named Command1 is Command1_Click.

If you add code to an event procedure and then change the name of the control, your code remains in procedures with the previous name.

For example, assume you add code to the Click event for Command1 and then rename the control to Command2. When you double-click Command2, you will not see any code in the Click event procedure. You will need to move code from Command1_Click to Command2_Click.

To simplify development, it is a good practice to name your controls before writing code.

Displaying a custom dialog box

To test your dialog box in the Visual Basic Editor, click Run Sub/UserForm on the Run menu in the Visual Basic Editor.

To display a dialog box from Visual Basic, use the Show method. The following example displays the dialog box named UserForm1.

Private Sub GetUserName()


UserForm1.Show

End Sub

Using control values while code is running

Some control properties can be set and returned while Visual Basic code is running. The following example sets the Text property of a text box to "Hello."

TextBox1.Text = "Hello"

The data entered on a form by a user is lost when the form is closed. If you return the values of controls on a form after the form has been unloaded, you get the initial values for the controls rather than the values the user entered. 

If you want to save the data entered on a form, you can save the information to module-level variables while the form is still running. The following example displays a form and saves the form data.

'Code in module to declare public variables

Public strRegion As String

Public intSalesPersonID As Integer

Public blnCancelled As Boolean

'Code in form

Private Sub cmdCancel_Click()


Module1.blnCancelled = True


Unload Me

End Sub

Private Sub cmdOK_Click()


'Save data 


intSalesPersonID = txtSalesPersonID.Text


strRegion = lstRegions.List(lstRegions.ListIndex)


Module1.blnCancelled = False


Unload Me

End Sub

Private Sub UserForm_Initialize()


Module1.blnCancelled = True

End Sub

'Code in module to display form

Sub LaunchSalesPersonForm()


frmSalesPeople.Show


If blnCancelled = True Then 



MsgBox "Operation Cancelled!", vbExclamation


Else 



MsgBox "The Salesperson's ID is: " &




intSalesPersonID & _




"The Region is: " & strRegion


End If

End Sub

Changes to the Microsoft Project 98 Object Model

Extensive changes have been made to the Microsoft Project 98 Visual Basic object model to support new and improved features in the application. Many objects, properties, and methods have been replaced. To provide backward compatibility, most of the replaced components have been hidden rather than removed. This means that they don’t show up in the object browser by default, but old code that uses the hidden components will still work correctly without modification. When you write new code, however, you should use the new objects, properties, and methods.

The major feature changes made for Visual Basic in Microsoft Project 98 are listed in the following table.

Feature
Description



Events
Provides event-driven programming support for Microsoft Project, replacing the auto-run macros.

UserForms, ActiveX controls
Provides a consistent and expandable control and dialog box interface in all Microsoft Office applications.

CommandBars
Provides a consistent and expandable menu and toolbar interface in all Microsoft Office applications.

New Objects

Objects that have been added to Visual Basic in Microsoft Project 98 are listed in the following table. For more information about the changes to the Microsoft Project 98 object model, see one of the following topics:

Object
Description



CostRateTable, CostRateTables
New multiple pay rate functionality

PayRate, PayRates
New resource rate table functionality

SplitPart, SplitParts
New split task functionality

TimeScaleValue, TimeScaleValues
New timescale data functionality

New Properties and Methods

Properties and methods that have been added to existing objects, or are associated with objects new to Microsoft Project 98, are listed in the following table (sorted alphabetically by property or method name). For more information about the changes to the Microsoft Project 98 object model, see one of the following topics:

New property, event, or method
Objects



AcceptNewExternalData property
Project

ActualOvertimeCost property
Assignment, Resource, Task

ActualOvertimeWork property
Assignment, Resource, Task

Activate event
Project

ACWP property
Assignment, Resource, Task

AddProgressLine method
Application

AppendNotes method
Assignment, Project, Resource, Task

AskForCompletedWork property
Project

Assistant property
Application

AutoCalcCosts property
Project

AutoFilter method
Application

AutoFilter property
Project

AutomaticallyFillPhoneticFields property
Application

AvailableFrom property
Resource

AvailableTo property
Resource

BaseCalendars property
Project

BeforeClose event
Project

BeforePrint event
Project

BeforeSave event
Project

Calculate event
Project

CalendarShowBarSplits method
Application

CanLevel property
Resource

Change event
Project

CodeName property
Project

CommandBars property
Application, Project

Container property
Project

CostRateTable property
Assignment

CostRateTables property
Resource

CustomFieldGetName method
Application

CustomFieldRename method
Application

CustomizeField method
Application

CustomizeIMEMode method
Application

Daten property
Assignment, Resource, Task

DayLabelDisplay property
Project

Deactivate event
Project

DefaultAutoFilter property
Application

DefaultEffortDriven property
Project

DefaultFixedCostAccrual property
Project

DefaultTaskType property
Project

DeleteFromDatabase method
Application

DetailStylesAdd method
Application

DetailStylesFormat method
Application

DetailStylesProperties method
Application

DetailStylesRemove method
Application

DetailStylesRemoveAll method
Application

DetailStylesToggleItem method
Application

DisplayRecentFiles property
Application

DisplayViewBar property
Application

EditClearHyperlink method
Application

EditHyperlink method
Application

EditPasteAsHyperlink method
Application

EffectiveDate property
PayRate

EffortDriven property
Task

EnableCancelKey property
Application

EndDate property
TimeScaleValue

ExternalTask property
Task

FillAcross method
Application

FixedCostAccrual property
Task

FollowedHyperlinkColor property
Project

FollowHyperlink method
Application

GanttShowBarSplits method
Application

HonorConstraints property
Project

HourLabelDisplay property
Project

Hyperlink property
Assignment, Resource, Task

HyperlinkAddress property
Assignment, Resource, Task

HyperlinkColor property
Project

HyperlinkHREF property
Assignment, Resource, Task

HyperlinkSubAddress property
Assignment, Resource, Task

InsertHyperlink method
Application

Item property
Assignment, Calendar, CostRateTable, Day, List, Month, PayRate, Project, Resource, SplitPart, Task, TimeScaleValue, Weekday, Window, Year

LevelClearDates method
Project

LevelEntireProject property
Project

LevelFromDate property
Project

LevelIndividualAssignments property
Application, Task

LevelingCanSplit property
Application, Task

LevelingDelay property
Assignment, Task

LevelPeriodBasis property
Application

LevelToDate property
Project

LinksBetweenProjects method
Application

MacroShowCode method
Application

MacroShowVba method
Application

MacroVirusProtection property
Application

MapEdit method
Application

MinuteLabelDisplay property
Project

MultipleCriticalPaths property
Project

NewProject event
Application

ODBCCreateDataSource method
Application

ODBCManageDataSource method
Application

Open event
Project

OptionsWorkgroup method
Application

OvertimeCost property
Assignment, Resource, Task

PayRates property
CostRateTable, Resource

Peak property
Assignment

Phonetics property
Resource

PhoneticType property
Project

PreleveledFinish property
Task

PreleveledStart property
Task

ProgressLines method
Application

ProjectSummaryTask property
Project

ReceiveNotifications property
Project

RecentFilesMaximum property
Application

Recurring property
Task

RegularWork property
Assignment, Resource, Task

RemainingOvertimeCost property
Assignment, Resource, Task

RemainingOvertimeWork property
Assignment, Resource, Task

Replace method
Application

ResourcePhonetics property
Task

ResourceSharingPoolRefresh method
Application

ResourceSharingPoolUpdate method
Application

ResourceUniqueID property
Assignment

ResponsePending property
Assignment, Resource, Task

SelectTimescaleRange method
Application

SendHyperlinkNote property
Project

ServerPath property
Project

ServerURL property
Project

ShowAssignmentUnitsAs property
Application

ShowCrossProjectLinksInfo property
Project

ShowExternalPredecessors property
Project

ShowExternalSuccessors property
Project

SpaceBeforeTimeLabels property
Project

Split method
Task

SplitParts property
Task

SplitTask method
Application

SpreadCostsToStatusDate property
Project

SpreadPercentCompleteToStatusDate property
Project

StartDate property
TimeScaleValue

StatusDate property
Project

SubProjectReadOnly property
Task

TaskUniqueID property
Assignment

TaskSummaryName property
Assignment

TeamMembersCanDeclineTasks property
Project

TeamStatusPending property
Assignment, Resource, Task

Text property
Cell

TimeScaleData method
Assignment, Resource, Task

TrackOvertimeWork property
Project

ToggleAssignments method
Application

Type property
Task

UnderlineHyperlinks property
Project

UseFYStartYear property
Project

UserControl property
Application, Project

Value property
TimeScaleValue

VBE property
Application

VBProject property
Project

ViewBar method
Application

WebAddToFavorites method
Application

WebCopyHyperlink method
Application

WebGoBack method
Application

WebGoForward method
Application

WebHelp method
Application

WebHideToolbars method
Application

WebInbox method
Application

WebOpenFavorites method
Application

WebOpenHyperlink method
Application

WebOpenSearchPage method
Application

WebOpenStartPage method
Application

WebRefresh method
Application

WebSetSearchPage method
Application

WebSetStartPage method
Application

WebStopLoading method
Application

WebToolbar method
Application

WeekLabelDisplay property
Project

WorkContour property
Assignment

Workgroup property
Resource

WorkgroupMessages property
Project

YearLabelDisplay property
Project

Hidden Properties and Methods

Hidden properties and methods for visible objects are listed in the following table. Most of the hidden properties and methods have been replaced by new functionality in Microsoft Project 98. These properties and methods are supported only for backward compatibility; for new code, you should use the replacement functionality provided in Microsoft Project 98. For more information about the changes to the Microsoft Project 98 object model, see one of the following topics:

Object
Hidden property or method
Replacement



Project
ActualCost
ActualCost property on Task object returned by ProjectSummaryTask property

Project
ActualDuration
ActualDuration property on Task object returned by ProjectSummaryTask property

Project
ActualFinish
ActualFinish property on Task object returned by ProjectSummaryTask property

Project
ActualStart
ActualStart property on Task object returned by ProjectSummaryTask property

Project
ActualWork
ActualWork property on Task object returned by ProjectSummaryTask property

Application
AppLaunch
AppExecute method

Project
Author
BuiltinDocumentProperties property

Application
AutoRemoveDelay
no replacement

Project
BaselineCost
BaselineCost property on Task object returned by ProjectSummaryTask property

Project
BaselineDuration
BaselineDuration property on Task object returned by ProjectSummaryTask property

Project
BaselineFinish
BaselineFinish property on Task object returned by ProjectSummaryTask property

Project
BaselineStart
BaselineStart property on Task object returned by ProjectSummaryTask property

Project
BaselineWork
BaselineWork property on Task object returned by ProjectSummaryTask property

Project
BCWP
BCWP property on Task object returned by ProjectSummaryTask property

Project
BCWS
BCWS property on Task object returned by ProjectSummaryTask property

Application
ClipboardShow (Macintosh only)
no replacement

Project
Comments
BuiltinDocumentProperties property

Project
Company
BuiltinDocumentProperties property

Project
Confirmed
Confirmed property on Task object returned by ProjectSummaryTask property

Project
ConstraintDate
ConstraintDate property on Task object returned by ProjectSummaryTask property

Project
ConstraintType
ConstraintType property on Task object returned by ProjectSummaryTask property

Project
Contact
Contact property on Task object returned by ProjectSummaryTask property

Project
Cost
Cost property on Task object returned by ProjectSummaryTask property

Project
Cost1 - Cost3
Costn property on Task object returned by ProjectSummaryTask property

Project
CostVariance
CostVariance property on Task object returned by ProjectSummaryTask property

Project
Created
CreationDate property

Application
CreatePublisher (Macintosh only)
no replacement

Project
Critical
Critical property on Task object returned by ProjectSummaryTask property

Project
CV
CV property on Task object returned by ProjectSummaryTask property

Project
Delay
Delay property on Task object returned by ProjectSummaryTask property

Application
DisplayNotesIndicator
Indicators field

Project
Duration
Duration property on Task object returned by ProjectSummaryTask property

Project
Duration1 - Duration3
Durationn property on Task object returned by ProjectSummaryTask property

Project
DurationVariance
DurationVariance property on Task object returned by ProjectSummaryTask property

Project
EarlyFinish
EarlyFinish property on Task object returned by ProjectSummaryTask property

Project
EarlyStart
EarlyStart property on Task object returned by ProjectSummaryTask property

Application
EditionStopAll (Macintosh only)
no replacement

Application
FileQuit
FileExit method

Project
Finish
Finish property on Task object returned by ProjectSummaryTask property

Project
Finish1 - Finish5
Finishn property on Task object returned by ProjectSummaryTask property

Project
FinishVariance
FinishVariance property on Task object returned by ProjectSummaryTask property

Project
FixedCost
FixedCost property on Task object returned by ProjectSummaryTask property

Project
FixedDuration
Type property on Task object returned by ProjectSummaryTask property

Task
FixedDuration
Type property

Project
Flag1 - Flag10
Flagn property on Task object returned by ProjectSummaryTask property

Project
FreeSlack
FreeSlack property on Task object returned by ProjectSummaryTask property

Application
HelpCueCards
HelpLaunch or HelpContents method

Application
HelpOnlineIndex
HelpContents method

Application
HelpSearch
HelpContents method

Application
HelpTopics
HelpContents method

Project
HideBar
HideBar property on Task object returned by ProjectSummaryTask property

Project
Keywords
BuiltinDocumentProperties property

Project
LateFinish
LateFinish property on Task object returned by ProjectSummaryTask property

Project
LateStart
LateStart property on Task object returned by ProjectSummaryTask property

Project
LinkedFields
LinkedFields property on Task object returned by ProjectSummaryTask property

Application
MailOpen (Macintosh only)
no replacement

Project
Manager
BuiltinDocumentProperties property

Project
Marked
Marked property on Task object returned by ProjectSummaryTask property

Application
MenuBarApply
CommandBars property

Application
MenuBarEdit
CommandBars property

Application
MenuBars
CommandBars property

Project
Milestone
Milestone property on Task object returned by ProjectSummaryTask property

Project
Notes
ProjectNotes property or Notes property on Task object returned by ProjectSummaryTask property

Project
Number1 - Number5
Numbern property on Task object returned by ProjectSummaryTask property

Project
Objects
Objects property on Task object returned by ProjectSummaryTask property

Application
OptionsPreferences
OptionsCalculation, OptionsCalendar, OptionsEdit, OptionsGeneral, OptionsSchedule, OptionsSpelling, OptionsView, and OptionsWorkgroup methods

Project
OutlineLevel
OutlineLevel property on Task object returned by ProjectSummaryTask property

Project
OutlineNumber
OutlineNumber property on Task object returned by ProjectSummaryTask property

Project
PercentComplete
PercentComplete property on Task object returned by ProjectSummaryTask property

Project
PercentWorkComplete
PercentWorkComplete property on Task object returned by ProjectSummaryTask property

Project
Priority
Priority property on Task object returned by ProjectSummaryTask property

Project
Project
Project property on Task object returned by ProjectSummaryTask property

Application
PublisherOptions (Macintosh only)
no replacement

Project
RemainingCost
RemainingCost property on Task object returned by ProjectSummaryTask property

Project
RemainingDuration
RemainingDuration property on Task object returned by ProjectSummaryTask property

Project
RemainingWork
RemainingWork property on Task object returned by ProjectSummaryTask property

Project
ResourceGroup
ResourceGroup property on Task object returned by ProjectSummaryTask property

Project
ResourceInitials
ResourceInitials property on Task object returned by ProjectSummaryTask property

Project
ResourceNames
ResourceNames property on Task object returned by ProjectSummaryTask property

Project
Resume
Resume property on Task object returned by ProjectSummaryTask property

Project
ResumeNoEarlierThan
Resume property on Task object returned by ProjectSummaryTask property

Task
ResumeNoEarlierThan
Resume property

Project
Rollup
Rollup property on Task object returned by ProjectSummaryTask property

Application
SchedulePlusReminderSet
ReminderSet method

Application
ShowToolTips
no replacement

Project
Start
Start property on Task object returned by ProjectSummaryTask property

Project
Start1 - Start5
Startn property on Task object returned by ProjectSummaryTask property

Project
StartVariance
StartVariance property on Task object returned by ProjectSummaryTask property

Project
Stop
Stop property on Task object returned by ProjectSummaryTask property

Project
Subject
BuiltinDocumentProperties property

Application
SubscriberOptions (Macintosh only)
no replacement

Application
SubscribeTo (Macintosh only)
no replacement

Project
Summary
Summary property on Task object returned by ProjectSummaryTask property

Project
SV
SV property on Task object returned by ProjectSummaryTask property

Project
Text1 - Text10
Textn property on Task object returned by ProjectSummaryTask property

Application
TimescaledData
TimeScaleData method on Assignment, Resource, or Task object

Project
Title
BuiltinDocumentProperties property

Application
ToolbarCopyToolFace
CommandBars property

Application
ToolbarCustomizeTool
CommandBars property

Application
ToolbarDeleteTool
CommandBars property

Application
ToolbarInsertTool
CommandBars property

Application
ToolbarPasteToolFace
CommandBars property

Application
Toolbars
CommandBars property

Application
ToolbarsCustomize
CommandBars property

Project
TotalSlack
TotalSlack property on Task object returned by ProjectSummaryTask property

Project
UpdateNeeded
UpdateNeeded property on Task object returned by ProjectSummaryTask property

Application
ViewShowSelectedTasks
DetailStylesAdd method

Project
WBS
WBS property on Task object returned by ProjectSummaryTask property

Project
Work
Work property on Task object returned by ProjectSummaryTask property

Project
WorkVariance
WorkVariance property on Task object returned by ProjectSummaryTask property

Changed Properties and Methods

Properties and methods that have been changed for Microsoft Project 98 are listed in the following table. Also listed are any constants, properties, or methods that have been removed. Any code that uses these items may produce errors and should be modified accordingly. For more information about the changes to the Microsoft Project 98 object model, see one of the following topics:

Item
Object
Change



ConsolidateProjects method
Application
The meaning of NewWindow has changed and PoolResources is ignored.

CreateMSGraph method
Application
Removed.

FilterEdit method
Application
Inserted Parenthesis into argument list.

HelpMicrosoftNetwork method
Application
Removed.

HelpKeywordHelp method
Application
Removed.

OptionsView method
Application
The DisplayNotesIndicator argument was removed.

EditCopy method
Application
All arguments have been removed.

EditUndo method
Application
Removed.

EditCopyPicture method
Application
The ForPrinter argument has changed from Boolean to Long.

EnableCancelKey property
Application
Changed from Boolean to Long.

FilePageSetupFooter method
Application
All arguments have been removed.

FilePageSetupFooterText method
Application
Removed.

FilePageSetupHeader method
Application
All arguments have been removed.

FilePageSetupHeaderText method
Application
Removed.

FilePageSetupLegend method
Application
The Left, Center, and Right arguments have been removed.

FilePageSetupLegendText method
Application
Removed.

OptionsModuleFormat method
Application
Removed.

OptionsModuleGeneral method
Application
Removed.

OptionsSchedule method
Application
The FixedDuration argument (Boolean) has been replaced with TaskType (Long).

OptionsSpelling method
Application
The ProjectComments argument has been replaced with AssignNotes.

pjCustomizeToolbars constant
PjDialog
Removed.

pjDB3 constant
PjFileFormat
Removed.

pjDB4 constant
PjFileFormat
Removed.

pjFOX constant
PjFileFormat
Removed.

pjModuleEditor constant
PjViewScreen
Removed.

pjMPX1 constant
PjFileFormat
Removed.

pjMPX3 constant
PjFileFormat
Removed.

pjWK1 constant
PjFileFormat
Removed.

pjWK3 constant
PjFileFormat
Removed.

pjWKS constant
PjFileFormat
Removed.

pjUsageProjectFinish constant
PjGridline
Removed.

pjUsageProjectStart constant
PjGridline
Removed.

ProjectID property
Assignment
Removed.

StartWeekOn property
Application
Changed from Boolean to Long.

WindowActivate method
Application
No longer activates the Customize Toolbars dialog box.

Miscellaneous Changes

Extensive changes have been made to the Microsoft Project 98 Visual Basic object model to support new and improved features in the application. Existing macro code may result in errors or other unexpected behavior if not adapted to reflect these changes. For more information about the changes to the Microsoft Project 98 object model, see one of the following topics:

Change
Description



AcceptAllUpdates macro
This Microsoft Project 95 macro is not supported by Microsoft Project 98.

Default property for collections
The default property for collections in Microsoft Project 98 is the Item property and has a required argument. Existing macro code that assumes the default property is the Count property, such as ActiveProject.Tasks, will fail with run-time error 450.

Error codes for invalid property values
In Microsoft Project 95, invalid property values returned the run-time error 5. This has been changed to run-time error 1101.

Error loading DLL when opening a Microsoft Project 4.0 or Microsoft Project 95 project
See Error loading DLL for one possible cause.

Microsoft Project 3.0 macros
Not recognized by Microsoft Project 98. To convert them, they should be opened in the Microsoft Project 4.0 or Microsoft Project 95 Module Editor, the project saved, and then opened in Microsoft Project 98.

Module Editor
The Module Editor has been replaced with the Visual Basic Editor. Any macro code relating to the Module Editor will result in an error.

OutlineParent property
When used at the topmost level of a project, now returns a Task object rather than a Project object. See the ProjectSummaryTask property.

Password-protected code modules
See Password-protected code modules.

Qualification
The Top, Width, and Height properties and the  DateAdd and DateDifference methods must now be qualified with Application.

Using the Count property with ActiveSelection.Resources and ActiveSelection.Tasks
Includes blank rows in its result. Referencing one of these blank rows returns a Null task in a task view or a Null resource in a resource view.

Using Tasks.Index and 
Tasks.Count in consolidated projects
Returns only those tasks that appear in the master project. To return every task in every subproject, use a For Each … In … Tasks construct.

Password-Protected Code Modules

Unlike earlier versions, Microsoft Project 98 supports passwords for projects, but not individual modules.

When opening older projects containing protected modules, Microsoft Project prompts for the password for each protected module. If the correct password is entered, the module is unhidden and saved along with the converted project. (You are given as many chances as required to supply the correct password.) The password is required each time you open the converted project in Microsoft Project 98 until you save it.

If any modules are skipped, Microsoft Project attempts to save them in a new, protected project with an unspecified password. (The project will be named "FileNameMacros", where FileName is the name of the project originally containing the hidden modules.) Macro code in those modules will still run, but you cannot view, edit, or record macros in that project. If, for whatever reason, Microsoft Project is unable to create the protected project, you are given the opportunity to save it with a file name you specify.

If hidden modules are saved in the "FileNameMacros" project, but the converted project is not saved, the correct password is required each time the older project is opened by Microsoft Project 98 until it is converted and saved. Since the "FileNameMacros" project will already exist, Microsoft Project will not be able to save the hidden modules to a project with that name, and you will need to overwrite the existing "FileNameMacros" project or give it a new name.

If you save the "FileNameMacros" project, a reference to it will be added to the converted project. If you were asked for the name of a project to store the hidden macros, but didn't enter a project name, and the converted project was saved anyway, a reference will not be made. In that case, you will need to do the following procedure to manually specify a reference to that location.

1 On the Tools menu of the converted project, point to Macro, and then click Visual Basic Editor.

2 On the Tools menu of the Visual Basic Editor, click References, and then click Browse.

3 Select Microsoft Project Files from the Files of type list.

4 Find the project containing the hidden macros and then click Open.

5 Click OK to close the References dialog box.

If other (non-hidden) macros or toolbar buttons contain references to macros in formerly hidden modules, they should be changed manually. The reference should be "FileNameMacros!MacroName", where FileName is the name of the project originally containing the hidden module (or the user-supplied replacement to "FileNameMacros") and MacroName is the name of the macro in the formerly hidden module.

Error loading DLL

If you open a Microsoft Project 4.0 or Microsoft Project 95 project and receive an "Error loading DLL" message, check for the presence of macros in the project. If it contains macros, and those macros contain Visual Basic keywords in a language other than English or the language of the version you are using, you need additional files from the source of the project before you can use those macros. The additional files are required by the Visual Basic converter that will translate the macro code into English.

The following table describes the required files for each language and the folders where they can be found. The files should be copied to the same folders on your computer.

Language of macros
System folder (Windows 95) or System32 folder (Windows NT)

Folder containing Winproj.exe



Danish
VBADa32.dll, VBAEn32.olb
Pj4Da32.olb, Pj4En32.olb

French
VBAFr32.dll, VBAEn32.olb
Pj4Fr32.olb, Pj4En32.olb

German
VBADe32.dll, VBAEn32.olb
Pj4De32.olb, Pj4En32.olb

Italian
VBAIt32.dll, VBAEn32.olb
Pj4It32.olb, Pj4En32.olb

Japanese
VBAJp32.dll, VBAEnD32.olb
Pj4Jp32.olb, Pj4End32.olb

Norwegian
VBANo32.dll, VBAEn32.olb
Pj4No32.olb, Pj4En32.olb

Spanish
VBAEs32.dll, VBAEn32.olb
Pj4Es32.olb, Pj4En32.olb

Swedish
VBASv32.dll, VBAEn32.olb
Pj4Sv32.olb, Pj4En32.olb

Traditional Chinese
VBAChT32.dll, VBAEnD32.olb
Pj4ChT32.olb, Pj4End32.olb

Appendix B – VBA Reference

14About Method

AcceptNewExternalData Property
14
AccrueAt Property
14
Activate Event
14
Activate Method
15
ActiveCell Property
15
ActivePane Property
16
ActiveProject Property
16
ActiveSelection Property
16
ActiveWindow Property
16
ActualCost Property
16
ActualDuration Property
17
ActualFinish Property
18
ActualOvertimeCost Property
18
ActualOvertimeWork Property
19
ActualStart Property
20
ActualWork Property
20
ACWP Property
20
Add Method
20
AddProgressLine Method
21
Alerts Method
22
AMText Property
22
AppendNotes Method
22
AppExecute Method
22
Application Object
22
Application Property
23
AppMaximize Method
23
AppMinimize Method
23
AppMove Method
23
AppRestore Method
24
AppSize Method
24
AskForCompletedWork Property
24
AskToUpdateLinks Property
24
Assignment Object, Assignments Collection Object
24
Assignments Property
25
Assistant Property
25
AutoAddResources Property
25
AutoCalcCosts Property
26
AutoCorrect Method
26
AutoFilter Method
26
AutoFilter Property
26
AutoLevel Property
26
AutoLinkTasks Property
26
AutomaticallyFillPhoneticFields Property
27
AutoSplitTasks Property
27
AutoTrack Property
27
AvailableFrom Property
27
AvailableTo Property
27
BarBoxStyles Method
27
BarRounding Method
27
BaseCalendar Property
27
BaseCalendarCreate Method
27
BaseCalendarDelete Method
28
BaseCalendarEditDays Method
28
BaseCalendarRename Method
29
BaseCalendarReset Method
29
BaseCalendars Method
30
BaseCalendars Property
30
BaselineCost Property
30
BaselineDuration Property
30
BaselineFinish Property
30
BaselineSave Method
30
BaselineStart Property
31
BaselineWork Property
31
BCWP Property
31
BCWS Property
31
BeforeClose Event
31
BeforePrint Event
31
BeforeSave Event
31
BottomPane Property
32
BuiltinDocumentProperties Property
32
Calculate Event
32
CalculateAll Method
32
CalculateProject Method
32
Calculation Property
32
Calendar Object, Calendars Collection Object
32
Calendar Property
33
Calendar Property Example
33
CalendarBarStyles Method
33
CalendarBarStylesEdit Method
33
CalendarBestFitWeekHeight Method
34
CalendarDateBoxes Method
34
CalendarDateShading Method
36
CalendarDateShadingEdit Method
36
CalendarLayout Method
37
CalendarShowBarSplits Method
37
CalendarTaskList Method
37
CalendarTimescale Method
38
CalendarWeekHeadings Method
38
CanLevel Property
41
Caption Property
41
Cell Object
42
CellDragAndDrop Property
42
Change Event
43
ChangeWorkingTime Method
43
CheckField Method
43
Clear Method
44
Close Method
44
Code Property
44
CodeName Property
44
ColumnAlignment Method
45
ColumnBestFit Method
45
ColumnDelete Method
45
ColumnEdit Method
45
ColumnInsert Method
46
CommandBars Property
46
Confirmed Property
46
ConsolidateProjects Method
46
ConstraintDate Property
47
ConstraintType Property
47
Contact Property
48
Container Property
48
Cost Property
48
Costn Property
48
CostPerUse Property
48
CostRateTable Object, CostRateTables Collection Object
49
CostRateTable Property
49
CostRateTables Property
49
CostVariance Property
50
Count Property
50
Created Property
51
CreationDate Property
51
Critical Property
51
CurrencyDigits Property
51
CurrencySymbol Property
51
CurrencySymbolPosition Property
52
CurrentDate Property
52
CurrentFilter Property
53
CurrentTable Property
53
CurrentView Property
53
CustomDocumentProperties Property
54
CustomFieldGetName Method
54
CustomFieldRename Method
56
CustomForms Method
59
CustomizeField Method
59
CustomizeIMEMode Method
59
CV Property
64
DateAdd Method
64
DateDifference Method
64
DateFormat Method
64
Daten Property
65
DateOrder Property
65
DateSeparator Property
65
DateSubtract Method
66
Day Object, Days Collection Object
66
DayLabelDisplay Property
66
DayLeadingZero Property
67
Days Property
67
DDEExecute Method
67
DDEInitiate Method
67
DDELinksUpdate Method
68
DDEPasteLink Method
68
DDETerminate Method
68
Deactivate Event
68
DecimalSeparator Property
68
Default Method
68
DefaultAutoFilter Property
68
DefaultDateFormat Property
69
DefaultDurationUnits Property
69
DefaultEffortDriven Property
69
DefaultFinishTime Property
69
DefaultFixedCostAccrual Property
69
DefaultResourceOvertimeRate Property
69
DefaultResourceStandardRate Property
69
DefaultStartTime Property
70
DefaultTaskType Property
70
DefaultView Property
70
DefaultWorkUnits Property
70
Delay Property
70
Delete Method
70
DeleteFromDatabase Method
71
DetailStylesAdd Method
72
DetailStylesFormat Method
72
DetailStylesProperties Method
74
DetailStylesRemove Method
74
DetailStylesRemoveAll Method
75
DetailStylesToggleItem Method
75
DisplayAlerts Property
76
DisplayEntryBar Property
76
DisplayOLEIndicator Property
76
DisplayPlanningWizard Property
76
DisplayProjectSummaryTask Property
76
DisplayRecentFiles Property
76
DisplayScheduleMessages Property
77
DisplayScrollBars Property
77
DisplayStatusBar Property
77
DisplayViewBar Property
77
DisplayWizardErrors Property
77
DisplayWizardScheduling Property
77
DisplayWizardUsage Property
77
DocClose Method
78
DocMaximize Method
78
DocMove Method
78
DocRestore Method
78
DocSize Method
78
DrawingCreate Method
79
DrawingCycleColor Method
79
DrawingMove Method
79
DrawingProperties Method
80
DrawingReshape Method
80
DrawingToolbarShow Method
80
Duration Property
80
DurationFormat Method
80
Durationn Property
81
DurationValue Method
81
DurationVariance Property
81
EarlyFinish Property
81
EarlyStart Property
81
EditClear Method
81
EditClearFormats Method
82
EditClearHyperlink Method
82
EditCopy Method
82
EditCopyPicture Method
82
EditCut Method
83
EditDelete Method
83
EditGoto Method
83
EditHyperlink Method
84
EditInsert Method
84
EditPaste Method
84
EditPasteAsHyperlink Method
84
EditPasteSpecial Method
84
EffectiveDate Property
85
EffortDriven Property
85
EMailAddress Property
85
EnableCancelKey Property
85
EndDate Property
85
ExternalTask Property
85
FieldID Property
86
FieldIDList Property
90
FieldName Property
90
FieldNameList Property
90
FileClose Method
90
FileCloseAll Method
90
FileExit Method
90
FileLoadLast Method
91
FileNew Method
91
FileOpen Method
91
FilePageSetup Method
92
FilePageSetupCalendar Method
93
FilePageSetupCalendarText Method
93
FilePageSetupFooter Method
94
FilePageSetupHeader Method
94
FilePageSetupLegend Method
94
FilePageSetupMargins Method
94
FilePageSetupPage Method
95
FilePageSetupView Method
95
FilePrint Method
96
FilePrintPreview Method
96
FilePrintSetup Method
97
FileProperties Method
97
FileSave Method
97
FileSaveAs Method
97
FileSaveWorkspace Method
98
FillAcross Method
99
FillDown Method
99
FilterApply Method
99
FilterEdit Method
99
Filters Method
101
Find Method
101
FindFile Method
102
FindNext Method
102
FindPrevious Method
102
Finish Property
102
Finishn Property
102
FinishVariance Property
102
FixedCost Property
102
FixedCostAccrual Property
103
Flagn Properties
103
FollowedHyperlinkColor Property
103
FollowHyperlink Method
104
Font Method
104
FontBold Method
105
FontItalic Method
105
FontUnderline Method
105
Form Method
105
FormatCopy Method
106
FormatPainter Method
106
FormatPaste Method
106
FormViewShow Method
106
FreeSlack Property
106
FullName Property
106
GanttBarFormat Method
107
GanttBarLinks Method
109
GanttBarSize Method
109
GanttBarStyleDelete Method
109
GanttBarStyleEdit Method
109
GanttBarTextDateFormat Method
111
GanttChartWizard Method
112
GanttShowBarSplits Method
112
GanttShowDrawings Method
112
GetField Method
112
GotoNextOverallocation Method
117
GotoTaskDates Method
117
Gridlines Method
117
GridlinesEdit Method
117
Group Property
118
HasPassword Property
119
Height Property
119
HelpAbout Method
120
HelpAnswerWizard Method
120
HelpContents Method
120
HelpContextHelp Method
120
HelpCreateYourProject Method
120
HelpLaunch Method
121
HelpMSProjectFundamentals Method
121
HelpQuickPreview Method
121
HelpTechnicalSupport Method
121
HideBar Property
122
HonorConstraints Property
122
HourLabelDisplay Property
122
HoursPerDay Property
122
HoursPerWeek Property
122
Hyperlink Property
122
HyperlinkAddress Property
122
HyperlinkColor Property
123
HyperlinkHREF Property
123
HyperlinkSubAddress Property
123
ID Property
123
Index Property
123
InformationDialog Method
124
Initials Property
124
InsertHyperlink Method
125
InsertNotes Method
125
Item Property
125
LastPrintedDate Property
125
LastSaveDate Property
125
LastSavedBy Property
126
LateFinish Property
126
LateStart Property
126
Layout Method
126
LayoutNow Method
126
Left Property
126
Level Method
126
LevelClearDates Method
127
LevelEntireProject Property
127
LevelFromDate Property
127
LevelIndividualAssignments Property
128
LevelingCanSplit Property
128
LevelingClear Method
128
LevelingDelay Property
128
LevelingOptions Method
128
LevelNow Method
129
LevelOrder Property
129
LevelPeriodBasis Property
129
LevelToDate Property
130
LevelWithinSlack Property
130
LinkedFields Property
130
LinkPredecessors Method
130
LinksBetweenProjects Method
131
LinkSuccessors Method
132
LinkTasks Method
132
LinkTasksEdit Method
132
List Object
133
ListSeparator Property
133
LoadLastFile Property
133
Macro Method
134
MacroShowCode Method
134
MacroShowVba Method
134
MacroVirusProtection Property
134
MailLogoff Method
134
MailLogon Method
135
MailPostDocument Method
135
MailProjectMailCustomize Method
135
MailRoutingSlip Method
139
MailSend Method
140
MailSendProjectMail Method
140
MailSendScheduleNote Method
141
MailSession Method
142
MailSystem Method
142
MailUpdateProject Method
142
MapEdit Method
143
Marked Property
144
MaxUnits Property
144
Message Method
145
Milestone Property
145
MinuteLabelDisplay Property
146
Month Object, Months Collection Object
146
MonthLeadingZero Property
147
Months Property
147
MoveAfterReturn Property
147
MultipleCriticalPaths Property
147
Name Property
147
NewProject Event
148
Notes Property
148
Numbern Properties
149
NumberOfResources Property
149
NumberOfTasks Property
149
ObjectChangeIcon Method
149
ObjectConvert Method
149
ObjectInsert Method
149
ObjectLinks Method
149
Objects Property
150
ObjectVerb Method
150
ODBCCreateDataSource Method
150
ODBCManageDataSource Method
150
Open Event
150
OperatingSystem Property
151
OptionsCalculation Method
151
OptionsCalendar Method
151
OptionsEdit Method
152
OptionsGeneral Method
154
OptionsSchedule Method
155
OptionsSpelling Method
155
OptionsView Method
156
OptionsWorkgroup Method
157
Organizer Method
158
OrganizerDeleteItem Method
158
OrganizerMoveItem Method
159
OrganizerRenameItem Method
159
OutlineChildren Property
159
OutlineHideSubtasks Method
160
OutlineIndent Method
160
OutlineLevel Property
160
OutlineNumber Property
160
OutlineOutdent Method
160
OutlineParent Property
160
OutlineShowAllTasks Method
161
OutlineShowSubtasks Method
161
OutlineSymbolsToggle Method
161
Overallocated Property
161
OvertimeCost Property
162
OvertimeRate Property
162
OvertimeWork Property
162
PageBreakRemove Method
163
PageBreakSet Method
163
PageBreaksRemoveAll Method
163
PageBreaksShow Method
163
Pane Object
163
PaneClose Method
163
PaneCreate Method
164
PaneNext Method
164
Parent Property
164
Path Property
164
PathSeparator Property
164
PayRate Object, PayRates Collection Object
164
PayRates Property
165
Peak Property
165
PeakUnits Property
166
PercentComplete Property
166
PercentWorkComplete Property
166
Period Object
167
Period Property
167
PERTBorders Method
168
PERTBoxStyles Method
169
PERTLayout Method
172
PERTSetTask Method
172
PERTShowHideFields Method
173
Phonetics Property
173
PhoneticType Property
173
PMText Property
173
Predecessors Property
173
PredecessorTasks Property
173
PreleveledFinish Property
173
PreleveledStart Property
174
Priority Property
174
ProgressLines Method
175
Project Object, Projects Collection Object
175
Project Property
175
ProjectFinish Property
175
ProjectNotes Property
175
Projects Property
176
ProjectStart Property
176
ProjectStatistics Method
176
ProjectSummaryInfo Method
176
ProjectSummaryTask Property
177
PromptForSummaryInfo Property
177
Quit Method
177
ReadOnly Property
178
ReadOnlyRecommended Property
178
ReceiveNotifications Property
178
RecentFilesMaximum Property
179
Recurring Property
179
RecurringTaskInsert Method
179
RegularWork Property
179
RemainingCost Property
179
RemainingDuration Property
179
RemainingOvertimeCost Property
179
RemainingOvertimeWork Property
180
RemainingWork Property
180
ReminderSet Method
180
Replace Method
180
ReportList Property
181
ReportPrint Method
181
ReportPrintPreview Method
182
Reports Method
182
Reset Method
182
Resource Object, Resources Collection Object
183
Resource Property
183
ResourceAddressBook Method
183
ResourceAssignment Method
183
ResourceCalendarEditDays Method
185
ResourceCalendarReset Method
185
ResourceCalendars Method
185
ResourceDetails Method
185
ResourceFilterList Property
186
ResourceGraphBarStyles Method
186
ResourceGroup Property
187
ResourceID Property
187
ResourceInitials Property
187
ResourceName Property
187
ResourceNames Property
187
ResourcePhonetics Property
188
ResourcePoolName Property
188
Resources Property
188
ResourceSharing Method
188
ResourceSharingPoolAction Method
188
ResourceSharingPoolRefresh Method
189
ResourceSharingPoolUpdate Method
189
ResourceTableList Property
189
ResourceUniqueID Property
190
ResourceViewList Property
190
ResponsePending Property
190
Resume Property
190
RevisionNumber Property
190
Rollup Property
190
RowClear Method
191
RowDelete Method
191
RowInsert Method
191
Saved Property
191
ScheduleFromStart Property
191
SelectAll Method
191
SelectBeginning Method
191
SelectCell Method
192
SelectCellDown Method
192
SelectCellLeft Method
192
SelectCellRight Method
192
SelectCellUp Method
193
SelectColumn Method
193
SelectEnd Method
193
Selection Object
194
SelectionExtend Method
194
SelectRange Method
194
SelectResourceCell Method
194
SelectResourceColumn Method
195
SelectResourceField Method
195
SelectRow Method
195
SelectRowEnd Method
196
SelectRowStart Method
196
SelectSheet Method
196
SelectTaskCell Method
196
SelectTaskColumn Method
197
SelectTaskField Method
197
SelectTimescaleRange Method
197
SendHyperlinkNote Property
198
ServerPath Property
198
ServerURL Property
198
SetActiveCell Method
198
SetField Method
199
SetMatchingField Method
203
SetResourceField Method
204
SetTaskField Method
204
Shift Object
205
Shiftn Property
205
ShowAssignmentUnitsAs Property
205
ShowCriticalSlack Property
205
ShowCrossProjectLinksInfo Property
205
ShowExternalPredecessors Property
206
ShowExternalSuccessors Property
206
ShowTipOfDay Property
206
ShowWelcome Property
206
Sort Method
206
SpaceBeforeTimeLabels Property
206
SpellingCheck Method
206
Split Method
207
SplitPart Object, SplitParts Collection Object
207
SplitParts Property
208
SplitTask Method
208
SpreadCostsToStatusDate Property
209
SpreadPercentCompleteToStatusDate Property
209
StandardRate Property
209
Start Property
209
StartDate Property
209
Startn Property
209
StartOnCurrentDate Property
210
StartVariance Property
210
StartWeekOn Property
210
StartYearIn Property
210
StatusDate Property
211
Stop Property
211
SubProject Property
211
SubProjectReadOnly Property
211
Successors Property
211
SuccessorTasks Property
211
Summary Property
212
SupportsMultipleDocuments Property
212
SupportsMultipleWindows Property
212
SV Property
212
TableApply Method
212
TableEdit Method
212
Tables Method
214
Task Object, Tasks Collection Object
214
Task Property
215
TaskFilterList Property
215
TaskID Property
216
TaskName Property
216
Tasks Property
216
TaskSummaryName Property
216
TaskTableList Property
216
TaskUniqueID Property
217
TaskViewList Property
217
TeamMembersCanDeclineTasks Property
217
TeamStatusPending Property
217
Template Property
217
Text Property
218
Textn Properties
218
TextStyles Method
218
ThousandsSeparator Property
219
TimeLeadingZero Property
219
Timescale Method
219
TimeScaleData Method
220
TimescaleEdit Method
221
TimescaleNonWorking Method
225
TimeScaleValue Object, TimeScaleValues Collection Object
226
TimeSeparator Property
227
TipOfTheDay Method
227
ToggleAssignments Method
227
Top Property
227
TopPane Property
227
TotalSlack Property
227
TrackOvertimeWork Property
227
TwelveHourTimeFormat Property
227
Type Property
228
UnderlineHyperlinks Property
228
UniqueID Property
228
UniqueIDPredecessors Property
228
UniqueIDSuccessors Property
228
Units Property
228
UnlinkPredecessors Method
228
UnlinkSuccessors Method
228
UnlinkTasks Method
229
UpdateNeeded Property
229
UpdateProject Method
230
UpdateTasks Method
230
UsableHeight Property
230
UsableWidth Property
231
UseFYStartYear Property
231
UserControl Property
231
UserName Property
231
Value Property
232
VBE Property
232
VBProject Property
232
Version Property
232
ViewApply Method
232
ViewBar Method
232
ViewEditCombination Method
233
ViewEditSingle Method
233
ViewList Property
234
Views Method
234
ViewShowAvailability Method
235
ViewShowCost Method
235
ViewShowCumulativeCost Method
235
ViewShowCumulativeWork Method
235
ViewShowNotes Method
235
ViewShowObjects Method
235
ViewShowOverallocation Method
235
ViewShowPeakUnits Method
236
ViewShowPercentAllocation Method
236
ViewShowPredecessorsSuccessors Method
236
ViewShowResourcesPredecessors Method
236
ViewShowResourcesSuccessors Method
236
ViewShowSchedule Method
236
ViewShowWork Method
237
Visible Property
237
WBS Property
237
WebAddToFavorites Method
237
WebCopyHyperlink Method
237
WebGoBack Method
237
WebGoForward Method
237
WebHelp Method
238
WebHideToolbars Method
238
WebInbox Method
239
WebOpenFavorites Method
239
WebOpenHyperlink Method
239
WebOpenSearchPage Method
239
WebOpenStartPage Method
239
WebRefresh Method
239
WebSetSearchPage Method
240
WebSetStartPage Method
240
WebStopLoading Method
240
WebToolbar Method
240
Weekday Object, Weekdays Collection Object
240
Weekdays Property
241
WeekLabelDisplay Property
241
Width Property
241
Window Object, Windows Collection Object
242
WindowActivate Method
242
WindowArrangeAll Method
243
WindowHide Method
244
WindowMoreWindows Method
244
WindowNewWindow Method
244
WindowNext Method
245
WindowPrev Method
245
Windows Property
245
WindowSplit Method
245
WindowState Property
246
WindowUnhide Method
246
Work Property
246
WorkContour Property
246
Workgroup Property
247
WorkgroupMessages Property
247
Working Property
247
WorkVariance Property
247
WriteReserved Property
247
Year Object, Years Collection Object
247
YearLabelDisplay Property
248
Years Property
248
Zoom Method
249
ZoomCalendar Method
249
ZoomIn Method
249
ZoomOut Method
249
ZoomPERT Method
249
ZoomTimescale Method
250



About Method

Displays the About Microsoft Project dialog box, which lists version, copyright, and license information about Microsoft Project.

Syntax

expression.About
expression

Optional. An expression that returns an Application object.

AcceptNewExternalData Property

True if new or changed data relating to an external task is automatically accepted when the project is opened. Read/write if the ShowCrossProjectLinksInfo property is False. Read-only Boolean.

AccrueAt Property

Returns or sets when a task accrues the cost of a resource. Read/write Long.

Can be one of the following PjAccrueAt constants:

Constant
Description

PjStart

Task accrues the cost of the resource when the task starts

pjProrated
Task accrues the cost of the resource as the task progresses

pjEnd

Task accrues the cost of the resource when the project ends

AccrueAt Property Example

The following example sets the AccrueAt property to pjProrated for each resource in the active project.

Sub SetProratedAccrueAt()

    Dim R As Resource   ' Resource object used in For Each loop

    ' Cause tasks to accrue the cost of resources during the task.

    For Each R In ActiveProject.Resources

        R.AccrueAt = pjProrated

    Next R

End Sub

Activate Event

Occurs when switching to the project from another project, including when the project is opened or created.

Syntax

Private Sub Project_Activate(ByVal pj As MSProject.Project)
pj

The project that was activated.

Remarks

When you switch between two windows showing the same project, the Activate event for the project doesn't occur.

This event doesn't occur when you create a new window.

Microsoft Project events do not occur when the project is embedded in another document or application.

Activate Event Example

The following example ensures that the project window is maximized whenever it is activated.

Private Sub Project_Activate(ByVal pj As MSProject.Project)

    pj.Windows.ActiveWindow.WindowState = pjMaximized

End Sub

Activate Method

Activates the object, as shown in the following table:

Object
Description

Project
Makes this project the active project.

Pane
Activates the pane. If the pane isn't in the active window, the window that the pane belongs to will also be activated.

Window
Brings the window to the front of the Z-order.

Syntax

expression.Activate

expression

Required. An expression that returns an object in the Applies To list.

Activate Method Example

The following examples activate the next and previous projects, respectively.

Sub ProjectNext()


If ActiveProject.Index < Projects.Count Then



Projects(ActiveProject.Index + 1).Activate

Else



Projects(1).Activate

End If

End Sub

Sub ProjectPrevious()


If ActiveProject.Index > 1 Then



Projects(ActiveProject.Index - 1).Activate

Else



Projects(Projects.Count).Activate

End If

End Sub

ActiveCell Property

Returns a Cell object that represents the active cell. Read-only.

ActiveCell Property Example

The following example displays the name of the resources assigned to the selected task. It assumes a task view is the active view and the active cell is in a task row.

Sub ResourceNames()

   Dim A As Assignment

   For Each A In ActiveCell.Task.Assignments

     MsgBox A.ResourceName

   Next A

   End Sub

ActivePane Property

Returns a Pane object that represents the active pane of a window. Read-only.

ActiveProject Property

Returns a Project object that represents the active project. Read-only.

ActiveProject Property Example

The following example adds the date and time to the Comments field in the Project Properties dialog box and then saves the project.

Sub SaveAndNoteTime()

    ActiveProject.ProjectNotes = ActiveProject.ProjectNotes & vbCrLf & "This project was last saved on " _

        & Date$ & " at " & Time$ & "."

    FileSave

End Sub

ActiveSelection Property

Returns a Selection object that represents the active selection. Read-only.

ActiveSelection Property Example

The following example displays the name of each selected task in a message box.

Sub SelectedTasks()

    Dim T As Task

    If Not (ActiveSelection.Tasks Is Nothing) Then

        For Each T In ActiveSelection.Tasks

            MsgBox T.Name

        Next T

    End If

End Sub

ActiveWindow Property

Returns a Window object that represents the active window. Read-only.

ActualCost Property

Returns the actual cost for an assignment, resource, or task. Read-only Variant.

Remarks

The ActualCost property can be set for Assignment and Task objects (but not summary tasks) if the Actual costs are always calculated by Microsoft Project check box on the Calculation tab of the Options dialog box has been cleared.

ActualCost Property Example

The following example prompts the user for actual costs of tasks with no resources in the active project. It assumes that the Actual costs are always calculated by Microsoft Project check box has been cleared.

Sub GetActualCostsForTasks()

    Dim Entry As String     ' User input

    Dim T As Task           ' Task object used in For Each loop

    ' Count the resources of each task in the active project.

    For Each T In ActiveProject.Tasks

        ' If a task has no resources, then prompt user for actual cost.

        If T.Resources.Count = 0 Then

            Do While 1

                Entry = InputBox$("Enter the cost for " & T.Name & ":")

                ' Exit loop if user enters number or clicks Cancel.

                If IsNumeric(Entry) Or Entry = Empty Then

                    Exit Do

                ' User didn't enter a number; tell user to try again.

                Else

                    MsgBox ("You didn't enter a number; try again.")

                End If

            Loop

            ' If user didn't click Cancel, assign actual cost to task.

            If Not StrComp(Entry, Empty, 1) = 0 Then T.ActualCost = Entry

        End If

    Next T

End Sub

ActualDuration Property

Returns or sets the actual duration (in minutes) of a task. Read-only for summary tasks. Read/write Variant.

ActualDuration Property Example

The following example marks the tasks in the active project with actual durations that exceed a certain number of minutes.

Sub MarkLongDurationTasks()

    Dim T As Task           ' Task object used in For Each loop

    Dim Minutes As Long     ' Duration entered by user

    ' Prompt user for the actual duration, in minutes.

    Minutes = Val(InputBox$("Enter the actual duration, in minutes: "))

    ' Don't do anything if the InputBox$ was cancelled.

    If Minutes = 0 Then Exit Sub

    ' Cycle through the tasks of the active project.

    For Each T In ActiveProject.Tasks

        ' Mark a task if it exceeds the duration.

        If T.ActualDuration > Minutes Then T.Marked = True

    Next T

End Sub

ActualFinish Property

Returns or sets the actual finish date of an assignment or task.  Read-only for summary tasks. Read/write Variant.

ActualFinish Property Example

The following example prompts the user to set the actual finish dates of tasks in the active project.

Sub SetActualFinishForTasks()

    Dim T As Task           ' Task object used in For Each loop

    Dim Entry As String     ' User's entry

    For Each T In ActiveProject.Tasks

        ' Loop until user enters a date or clicks Cancel.

        Do While 1

            Entry = InputBox$("Enter the actual finish date for " & _

                T.Name & ":")

            If IsDate(Entry) Or Entry = Empty Then

                Exit Do

            Else

                MsgBox ("You didn't enter a date; try again.")

            End If

        Loop

        'If user didn't click Cancel, set the task's actual finish date.

        If Entry <> Empty Then

            T.ActualFinish = Entry

        End If

    Next T

End Sub

ActualOvertimeCost Property

Returns the actual overtime cost for an assignment, resource, or task. Read/write for the Assignment object. Read-only Variant.

ActualOvertimeCost Property Example

The following example illustrates the cost of overtime by calculating the total cost of tasks with overtime work, as well as breaking down the individual costs per task.

Sub PriceOfOvertime()

    Dim T As Task

    Dim Price As Variant, Breakdown As String

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            If T.ActualOvertimeWork <> 0 Then

                Price = Price + T.ActualOvertimeCost
                Breakdown = Breakdown & T.Name & ": " & _

                    ActiveProject.CurrencySymbol & _

                        T.ActualOvertimeCost & vbCrLf

            End If

        End If

    Next T

    If Breakdown <> "" Then

        MsgBox Breakdown & vbCrLf & "Total: " & _

            ActiveProject.CurrencySymbol & Price

    End If

End Sub

ActualOvertimeWork Property

Returns the actual overtime work (in minutes) for an assignment, resource, or task. Read/write for the Assignment object. Read-only Variant.

ActualOvertimeWork Property Example

The following example illustrates the cost of overtime by calculating the total cost of tasks with overtime work, as well as breaking down the individual costs per task.

Sub PriceOfOvertime()

    Dim T As Task

    Dim Price As Variant, Breakdown As String

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            If T.ActualOvertimeWork <> 0 Then

                Price = Price + T.ActualOvertimeCost

                Breakdown = Breakdown & T.Name & ": " & _

                    ActiveProject.CurrencySymbol & _

                        T.ActualOvertimeCost & vbCrLf

            End If

        End If

    Next T

    If Breakdown <> "" Then

        MsgBox Breakdown & vbCrLf & "Total: " & _

            ActiveProject.CurrencySymbol & Price

    End If

End Sub

ActualStart Property

Returns or sets the actual start date of an assignment or task.  Read-only for summary tasks. Read/write Variant.

ActualWork Property

Returns or sets the actual work (in minutes) for an assignment, resource, or task. Read-only for the Resource object and summary tasks. Read/write Variant.

ACWP Property

Returns the ACWP for an assignment, resource, or task. Read-only Variant.

Add Method

Adds an object to an Assignments collection (Syntax 1), to a PayRates collection (Syntax 2), to a SplitParts collection (Syntax 3), to a TimescaleValues collection (Syntax 4), to a Projects collection (Syntax 5), or to a Resources or Tasks collection (Syntax 6) and returns a reference to the new object.

Syntax 1

expression.Add(TaskID, ResourceID, Units)
expression

Required. An expression that returns an Assignments collection.

TaskID



Optional Long. The identification number of a task. Required if the parent object is a resource. The task is assigned the resource specified with ResourceID. The default value of TaskID is the identification number of the parent object of the Assignments collection if the parent object is a Task object.

ResourceID

Optional Long. The identification number of a resource. Required if the parent object is a task. The resource is assigned the task specified with the TaskID argument. The default value of ResourceID is the identification number of the parent object of the Assignments collection if the parent object is a Resource object.

Units



Optional Variant. The number of resource units, expressed as a decimal or percentage, to assign to the task. The default value is 1 or 100%, depending upon the Show assignment units as a setting on the Schedule tab of the Options dialog box. If the maximum number of units is less than 1 (or the maximum percentage is less than 100%), the default value of the Units argument is the maximum number of units (or the maximum percentage).

Syntax 2

expression.Add(EffectiveDate, StdRate, OvtRate, CostPerUse)
expression


Required. An expression that returns a PayRates collection.

EffectiveDate

Required Variant. The date the new rate comes into effect.

StdRate



Optional Variant. The new standard rate. If not specified, the rate is the same as for the previous date period.

OvtRate



Optional Variant. The new overtime rate. If not specified, the rate is the same as for the previous date period.

CostPerUse



Optional Variant. The new cost per use. If not specified, the rate is the same as for the previous date period.

Syntax 3

expression.Add(StartSplitPartOn, EndSplitPartOn)
expression



Required. An expression that returns a SplitParts collection.

StartSplitPartOn

Required Variant. The start date of the task portion.

EndSplitPartOn

Required Variant. The end date of the task portion. If EndSplitPartOn is on or before the date specified with StartSplitPartOn, the portion is not created.

Remarks

If creating a new task portion would overlap any other portions in the same task, the non-coincident portions are added to the existing portion.

Syntax 4

expression.Add(Value, Position)
expression



Required. An expression that returns a TimeScaleValues collection.

Value





Required Variant. The value of the timescaled data.

Position




Optional Long. The position of the new value. The default value is n + 1, where n is the number of items in the collection. If the value specified for Position is n + 2 or greater, the intervening items are given a value of 0.

Syntax 5

expression.Add(DisplayProjectInfo)
expression



Required. An expression that returns a Projects collection.

DisplayProjectInfo
Required Boolean. True if the Project Information dialog box appears when a new project is created.

Syntax 6

expression.Add(Name, Before)
expression



Required. An expression that returns a Resources or Tasks collection.

Name





Optional String. The name of the new resource or task. The default value is Empty.

Before





Optional Long. The position of the task or resource in its containing collection. The default value is the position of the last item in the collection.

Add Method Example

The following example adds a new task at the end of the list.

Sub AddTask()

    ActiveProject.Tasks.Add Name:="New Task"

End Sub

The following example adds a resource identified by the number of 212 as a new assignment for the specified task.

Sub AddResource()

    ActiveProject.Tasks(1).Assignments.Add ResourceID:=212

End Sub

AddProgressLine Method

Enters interactive progress line mode, enabling the user to manually draw progress lines.

Syntax

expression.AddProgressLine
expression



Optional. An expression that returns an Application object.

Remarks

The AddProgressLine method has no effect unless the active view is a Gantt view.

The AddProgressLine method requires user interaction before additional code can be executed.

Alerts Method

Determines whether alerts appear when a macro runs.

Syntax

expression.Alerts(Show)
expression



Optional. An expression that returns an Application object.

Show





Optional Boolean. True if Microsoft Project displays error messages when a macro runs. The default value is True.

Remarks

The Alerts method applies only to the macro that contains the method.

AMText Property

Returns the text Microsoft Project displays next to morning hours in the 12-hour time format. Read-only String.

Remarks

Microsoft Project sets the AMText property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

AppendNotes Method

Appends new text to the Notes field.

Syntax

expression.AppendNotes(Value)
expression



Required. An expression that returns an object in the Applies To list.

Value





Required String. The text to append to the existing notes.

Remarks

New text is added with the formatting in use at the end of any existing notes.

AppExecute Method

Starts an application.

Syntax

expression.AppExecute(Window, Command, Minimize, Activate)
expression



Optional. An expression that returns an Application object.

Window




Optional String. The caption of the application to activate.

Command



Optional String. The command to start the application. Required if Window is omitted. If the application is running, Command is ignored.

Minimize




Optional Boolean. True if the main window is minimized. The default value is False.

Activate




Optional Boolean. True if the application is activated. The default value is True.

AppExecute Method Example

The following example starts and activates Microsoft Excel.

Sub StartMicrosoftExcel()


AppExecute Command:="Excel.exe"

End Sub

Application Object

Represents the entire Microsoft Project application. The Application object contains:

· Application-wide settings and options (many of the options in the Options dialog box, Tools menu, for example).

· Properties that return top-level objects, such as ActiveCell, ActiveProject, and so on.

· Methods that act on application-wide elements, such as views, selections, editing actions, and so on.

Using the Application Object

Use the Application property to return an Application object in Microsoft Project. The following example applies the Windows property to the Application object.

Application.Windows("Project1.mpp").Activate

The following example creates a Microsoft Project project object in another application and then opens a project in Microsoft Project.

Dim pj As Object

Set pj = CreateObject("MSProject.Project")

pj.Application.FileOpen "My Project.mpp"

Remarks

Many of the properties and methods that return the most common user-interface objects, such as the active project (ActiveProject property), can be used without the Application object qualifier. For example, instead of writing Application.ActiveProject.Visible = True, you can write ActiveProject.Visible = True.

Application Property

Returns an Application object that represents the application containing an object in the Applies To list. Read-only.

AppMaximize Method

Maximizes the main window.

Syntax

expression.AppMaximize
expression



Optional. An expression that returns an Application object.

AppMinimize Method

Minimizes the main window.

Syntax

expression.AppMinimize
expression



Optional. An expression that returns an Application object.

AppMove Method

Moves the main window.

Syntax

expression.AppMove(XPosition, YPosition, Points)
expression



Optional. An expression that returns an Application object.

XPosition




Optional Long. A number that specifies the distance of the main window from the left edge of the screen.

YPosition




Optional Long. A number that specifies the distance of the main window from the top edge of the screen.

Points





Optional Boolean. True if XPosition and YPosition are measured in points. False if they are measured in pixels. The default value is False.

AppMove Method Example

The following example moves the main window of Microsoft Project 9 points to the left.

Sub MoveMainWindowToLeft()


AppMove XPosition:=Application.Left - 9, Points:=True

End Sub

AppRestore Method

Restores the main window to its last nonminimized and nonmaximized state.

Syntax

expression.AppRestore
expression



Optional. An expression that returns an Application object.

AppSize Method

Sets the width and height of the main window.

Syntax

expression.AppSize(Width, Height, Points)
expression



Optional. An expression that returns an Application object.

Width





Optional Long. A number that specifies the new width of the main window.

Height





Optional Long. A number that specifies the new height of the main window.

Points





Optional Boolean. True if Width and Height are measured in points. False if they are measured in pixels. The default value is False.

AppSize Method Example

The following example moves the main window of Microsoft Project to the left half of the screen.

Sub MoveMainWindowToLeftHalf()

    Dim WindowHeight As Long

    ' Remember the height when maximized.

    Application.WindowState = pjMaximized

    WindowHeight = Application.Height

    AppSize Width:=UsableWidth / 2, Height:=UsableHeight, Points:=True

    Application.Left = 0

    ' Make sure the window uses all the available height.

    If Application.Height < WindowHeight Then Application.Height = WindowHeight

End Sub

AskForCompletedWork Property

Returns or sets how completed work should be reported in TeamStatus messages. Can be one of the following PjTeamStatusCompletedWork constants: pjBrokenDownByDay, pjBrokenDownByWeek, or pjTotalForEntirePeriod. Read/write Long.

AskToUpdateLinks Property

True if the user is prompted to update automatic DDE and OLE links. Read/write Boolean.

Assignment Object, Assignments Collection Object

Represents an assignment for a task or resource. The Assignment object is a member of the Assignments collection.

Using the Assignment Object

Use Assignments(Index), where Index is the assignment index number, to return a single Assignment object. The following example displays the name of the first resource assigned to the specified task.

MsgBox ActiveProject.Tasks(1).Assignments(1).ResourceName

Using the Assignments Collection

Use the Assignments property to return an Assignments collection. The following example displays all the resources assigned to the specified task.

Dim A As Assignment

For Each A In ActiveProject.Tasks(1).Assignments

    MsgBox A.ResourceName

Next A

Use the Add method to add an Assignment object to the Assignments collection. The following example adds a resource identified by the number of 212 as a new assignment for the specified task.

ActiveProject.Tasks(1).Assignments.Add ResourceID:=212

Assignments Property

Returns an Assignments collection representing the assignments for a task or resource. Read-only.

Assistant Property

Returns an Assistant object representing the Office Assistant. Read-only.

Assistant Property Example

The following example displays a previously selected Assistant and animates it with the associated sound. If your computer doesn't have a sound card installed, this example won't generate an error, but the sound won't be heard.

Sub AnimateAssistant()

    With Assistant
        .Visible = True

        .Sounds = True

        .Animation = msoAnimationGetAttentionMajor

    End With

End Sub

AutoAddResources Property

True if new resources are automatically created as they are assigned. False if Microsoft Project prompts before creating new resources. Read/write Boolean.

AutoAddResources Property Example

The following example prompts the user to set the AutoAddResources, AutoCalculate, AutoLinkTasks, AutoSplitTasks, and AutoTrack properties.

Sub PromptForAutoPropertySettings()

    Dim I As Integer            ' Used in For...Next loop

    Dim Prompts(5) As String    ' Prompts to display on the screen

    Dim Response As Long        ' User response to prompt

    Dim Responses(5) As Long    ' Used to store user responses

    ' Set each prompt.

    Prompts(1) = "Automatically create new resources as they are assigned?"

    Prompts(2) = "Automatically recalculate a project when a value, such as a date or cost, changes?"

    Prompts(3) = "Automatically link sequential tasks when you cut, move, or insert tasks?"

    Prompts(4) = "Automatically split tasks into parts for work complete and work remaining?"

    Prompts(5) = "Automatically update the remaining work and cost for a resource when the completion percentage of one of the resource's tasks changes?"

    ' Display each prompt, and store the user's responses.

    For I = 1 To 5

        Response = MsgBox(Prompts(I), vbYesNo)

        Responses(I) = (Response = vbYes)

    Next I

    ' Set the automatic properties according to the user's responses.

    ActiveProject.AutoAddResources = Responses(1)

    Calculation = Responses(2)

    ActiveProject.AutoLinkTasks = Responses(3)

    ActiveProject.AutoSplitTasks = Responses(4)

    ActiveProject.AutoTrack = Responses(5)

End Sub

AutoCalcCosts Property

True if actual costs are always calculated by Microsoft Project. False if users can enter actual costs, and actual costs are never calculated by Microsoft Project. Read/write Boolean.

AutoCorrect Method

Displays the AutoCorrect dialog box.

Syntax 
expression.AutoCorrect
expression




Optional. An expression that returns an Application object.

AutoFilter Method

Activates or deactivates the AutoFilter for the active project.

Syntax

expression.AutoFilter
expression




Optional. An expression that returns an Application object.

Remarks

The AutoFilter method has the same effect as the AutoFilter command on the Filtered for submenu, which is available on the Project menu.

AutoFilter Property

True if the AutoFilter feature is active. Read/write Boolean.

AutoLevel Property

True if resources are automatically leveled. Read/write Boolean.

AutoLinkTasks Property

True if Microsoft Project automatically links sequential tasks when you cut, move, or insert tasks. Read/write Boolean.

AutomaticallyFillPhoneticFields Property

True if phonetic information is automatically provided for resource names and custom fields. The AutomaticallyFillPhoneticFields property only produces tangible results if the Japanese version of Microsoft Project is used. Read/write Boolean.

AutoSplitTasks Property

True if Microsoft Project automatically splits tasks into parts for work complete and work remaining. Read/write Boolean.

AutoTrack Property

True if Microsoft Project automatically updates the work and costs of a task's resources when the task's percent complete changes. Read/write Boolean.

AvailableFrom Property

Returns or sets the earliest date a resource is available for work on the project. Read/write Variant.

AvailableTo Property

Returns or sets the latest date a resource is available for work on the project. Read/write Variant.

BarBoxStyles Method

Displays the Bar Styles, Box Styles, or Detail Styles dialog box, which prompts the user to specify bar styles (Gantt Chart, Resource Graph, and Calendar view), box styles (PERT Chart), or detail styles (Task Usage and Resource Usage view) respectively.

Syntax

expression.BarBoxStyles
expression




Optional. An expression that returns an Application object.

Remarks

The BarBoxStyles method has the same effect as the Bar Styles command (Gantt Chart, Resource Graph, and Calendar view), the Box Styles command (PERT Chart), or the Detail Styles command (Task Usage and Resource Usage view) on the Format menu.

BarRounding Method

Controls whether the start times of tasks are reflected by their corresponding task bars or if the task bars are rounded to a full day.

Syntax

expression.BarRounding(On)
expression



Optional. An expression that returns an Application object.

On






Optional Boolean. True if bars round to the nearest day. The default value is True.

Remarks

The BarRounding method only affects how tasks display on the Gantt Chart or Calendar. The duration of the tasks is not affected.

BaseCalendar Property

Calendar object: Returns a Calendar object representing a base calendar. Read-only.

Resource object: Returns or sets the base calendar for a resource calendar. Read/write String.

BaseCalendarCreate Method

Creates a base calendar.

Syntax

expression.BaseCalendarCreate(Name, FromName)
expression


Optional. An expression that returns an Application object.

Name




Required String. The name of the base calendar to create.

FromName


Optional String. The name of the base calendar to copy.

BaseCalendarCreate Method Example

The following example creates a new base calendar called "Base Holiday Calendar."

Sub CreateHolidayCalendar()


BaseCalendarCreate Name:="Base Holiday Calendar"

End Sub

BaseCalendarDelete Method

Deletes a base calendar.

Syntax

expression.BaseCalendarDelete(Name)
expression


Optional. An expression that returns an Application object.

Name




Required String. The name of the base calendar to delete.

BaseCalendarDelete Method Example

The following example deletes the base calendar entered by the user.

Sub DeleteCalendar()

    Dim CalendarName As String

    CalendarName = InputBox$("Enter name of base calendar to delete:")

    BaseCalendarDelete Name:=CalendarName

End Sub

BaseCalendarEditDays Method

Changes one or more days in a base calendar.

Syntax

expression.BaseCalendarEditDays(Name, StartDate, EndDate, WeekDay, Working, From1, To1, From2, To2, From3, To3, Default)
expression


Optional. An expression that returns an Application object.

Name




Required String. The name of the base calendar to change.

StartDate 



Optional Variant. The first date to change. If StartDate is specified without EndDate, that date is the only day affected. If WeekDay is specified, StartDate is ignored.

EndDate



Optional Variant. The last date to change. If EndDate is specified without StartDate, that date is the only day affected. If WeekDay is specified, EndDate is ignored.

WeekDay



Optional Long. The weekday to change. If StartDate or EndDate is specified, WeekDay is ignored. Can be one of the following PjWeekday constants: pjSunday, pjMonday, pjTuesday, pjWednesday, pjThursday, pjFriday, or pjSaturday.

Working



Optional Boolean. True if the days are working days.

From1




Optional Variant. The start time of the first shift.

To1





Optional Variant. The end time of the first shift.

From2




Optional Variant. The start time of the second shift.

To2





Optional Variant. The end time of the second shift.

From3




Optional Variant. The start time of the third shift.

To3





Optional Variant. The end time of the third shift.

Default




Optional Boolean. Resets the dates specified by StartDate and EndDate, or by WeekDay, to the default values. If Working is specified, Default is ignored.

BaseCalendarEditDays Method Example

The following example makes Wednesday a nonworking day in the Standard calendar.

Sub MakeWednesdaysNonWorking()


BaseCalendarEditDays Name:="Standard", Weekday:=pjWednesday, Working:=False

End Sub

The following example makes the days from 2/10/97 through 2/12/97 nonworking days in the Standard calendar.

Sub MakeSelectedDaysNonWorking()


BaseCalendarEditDays Name:="Standard", StartDate:="2/10/97", EndDate:="2/12/97", Working:=False

End Sub

BaseCalendarRename Method

Renames a base calendar.

Syntax

expression.BaseCalendarRename(FromName, ToName)
expression


Optional. An expression that returns an Application object.

FromName


Required String. The name of the base calendar to rename.

ToName



Required String. The new name of the base calendar.

BaseCalendarRename Method Example

The following example changes the name of the base calendar from Standard to Old Standard.

Sub RenameStandardCalendar()


BaseCalendarRename FromName:="Night Shift", ToName:="Third Shift"

End Sub

BaseCalendarReset Method

Resets a base calendar.

Syntax

expression.BaseCalendarReset(Name)
expression


Optional. An expression that returns an Application object.

Name




Required String. The name of the base calendar to reset.

Remarks

Base calendars have the following default characteristics:

· Monday through Friday are working days with two shifts (8 A.M. to 12 P.M. and 1 P.M. to 5 P.M.).

· Saturday and Sunday are nonworking days.

BaseCalendarReset Method Example

The following example resets the Standard base calendar to the default settings.

Sub RestoreBaseCalendar()


BaseCalendarReset Name:="Standard"

End Sub

BaseCalendars Method

Displays the Change Working Time dialog box, which prompts the user to change a calendar.

Syntax

expression.BaseCalendars
expression


Optional. An expression that returns an Application object.

Remarks

The BaseCalendars method has the same effect as the Change Working Time command on the Tools menu.

BaseCalendars Property

Returns a Calendars collection representing all base calendars in the active project. Read-only.

BaselineCost Property

Returns or sets the baseline cost for an assignment, resource, or task. Read-only for summary tasks. Read/write Variant.

BaselineDuration Property

Returns or sets the baseline duration (in minutes) of a task. Read/write Variant.

BaselineFinish Property

Returns or sets the baseline finish date of a task or task assignment. Read/write Variant.

BaselineSave Method

Creates a baseline plan.

Syntax

expression.BaselineSave(All, Copy, Into)
expression


Optional. An expression that returns an Application object.

All





Optional Boolean. True if the baseline plan is set for all tasks. False if the baseline plan is set only for the selected tasks. The default value is True.

Copy




Optional Long. The fields to copy. Can be one of the following PjSaveBaselineFrom constants:

Constant
Description

 


pjCopyCurrent
All scheduling information from the active project

pjCopyBaseline
Baseline start and baseline finish dates

pjCopyStart_Finish1
Dates in the Start1 and Finish1 custom fields

pjCopyStart_Finish2
Dates in the Start2 and Finish2 custom fields

pjCopyStart_Finish3
Dates in the Start3 and Finish3 custom fields

pjCopyStart_Finish4
Dates in the Start4 and Finish4 custom fields

pjCopyStart_Finish5
Dates in the Start5 and Finish5 custom fields

pjCopyStart_Finish6
Dates in the Start6 and Finish6 custom fields

pjCopyStart_Finish7
Dates in the Start7 and Finish7 custom fields

pjCopyStart_Finish8
Dates in the Start8 and Finish8 custom fields

pjCopyStart_Finish9
Dates in the Start9 and Finish9 custom fields

pjCopyStart_Finish10
Dates in the Start10 and Finish10 custom fields

Into

Optional Long. Where the fields should be copied. Can be one of the following PjSaveBaselineTo constants:

Constant
Description

 


PjIntoBaseline
All baseline information in the active project

pjIntoStart_Finish1
Dates in the Start1 and Finish1 custom fields

pjIntoStart_Finish2
Dates in the Start2 and Finish2 custom fields

pjIntoStart_Finish3
Dates in the Start3 and Finish3 custom fields

pjIntoStart_Finish4
Dates in the Start4 and Finish4 custom fields

pjIntoStart_Finish5
Dates in the Start5 and Finish5 custom fields

pjIntoStart_Finish6
Dates in the Start6 and Finish6 custom fields

pjIntoStart_Finish7
Dates in the Start7 and Finish7 custom fields

pjIntoStart_Finish8
Dates in the Start8 and Finish8 custom fields

pjIntoStart_Finish9
Dates in the Start9 and Finish9 custom fields

pjIntoStart_Finish10
Dates in the Start10 and Finish10 custom fields

BaselineStart Property

Returns or sets the baseline start date of a task or task assignment. Read/write Variant.

BaselineWork Property

Returns or sets the baseline work (in minutes) for an assignment, resource, or task. Read-only for summary tasks. Read/write Variant.

BCWP Property

Returns the BCWP for an assignment, resource, or task. Read-only Variant.

BCWS Property

Returns the BCWS for an assignment, resource, or task. Read-only Variant.

BeforeClose Event

Occurs before the project closes. If the project has changed since it was opened, but has not been saved, this event occurs before the user is prompted to save the project.

Syntax

Private Sub Project_BeforeClose(ByVal pj As MSProject.Project)
pj

The project that is being closed.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

BeforePrint Event

Occurs before the project is printed or previewed.

Syntax

Private Sub Project_BeforePrint(ByVal pj As MSProject.Project)
pj

The project that is being printed or previewed.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

BeforeSave Event

Occurs before the project is saved.

Syntax

Private Sub Project_BeforeSave(ByVal pj As MSProject.Project)
pj

The project that is being saved.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

BottomPane Property

Returns a Pane object representing the bottom pane of a window. Read-only.

BuiltinDocumentProperties Property

Returns a DocumentProperties collection representing the built-in properties of the document. Read-only.

Remarks

To use this property, you should establish a reference to the Microsoft Office 97 Object Library by using the References command on the Tools menu. The Object Library contains definitions for the Visual Basic objects, properties, methods, and constants used to manipulate document properties.

Use the CustomDocumentProperties property to return the collection of custom document properties.

Calculate Event

Occurs after the project is calculated.

Syntax

Private Sub Project_Calculate(ByVal pj As MSProject.Project)
pj

The project that was calculated.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

CalculateAll Method

Calculates all open projects.

Syntax

expression.CalculateAll
expression


Optional. An expression that returns an Application object.

CalculateProject Method

Calculates the active project.

Syntax

expression.CalculateProject
expression


Optional. An expression that returns an Application object.

Calculation Property

Returns or sets the calculation mode. Can be one of the following PjCalculation constants: pjAutomatic or pjManual. Read/write Long.

Calendar Object, Calendars Collection Object

Represents the calendars or a calendar for a resource or project. The Calendar object is a member of the Calendars collection.

Using the Calendar Object

Use BaseCalendars(Index), where Index is the calendar index number or calendar name, to return a single Calendar object.

MsgBox ActiveProject.BaseCalendars(1).Name

Using the Calendars Collection

Use the BaseCalendars property to return a Calendars collection. The following example resets the properties of each base calendar in the active project to their default values.

Dim C As Calendar

For Each C In ActiveProject.BaseCalendars

    C.Reset

Next C

Use the BaseCalendarCreate method to add a Calendar object to the Calendars collection. The following example creates a new base calendar.

BaseCalendarCreate Name:="Base Holiday Calendar"

Calendar Property

Returns a Calendar object representing a calendar for a resource or project, or the calendar containing the day, month, period, weekday, or year object. Read-only.

Calendar Property Example

The following example resets the calendar for the active project.

Sub ResetActiveProjectCalendar()


ActiveProject.Calendar.Reset

End Sub

CalendarBarStyles Method

Turns bar rounding on or off in the Calendar.

Syntax

expression.CalendarBarStyles(BarRounding)
expression


Optional. An expression that returns an Application object.

BarRounding

Optional Boolean. True if bars in the Calendar round to midnight if their start times are less than or equal to the default start time, or if their end times are greater than or equal to the default end time. If BarRounding is omitted, the Bar Styles dialog box appears.

Remarks

The default start and default end times can be set with the OptionsCalendar method.

CalendarBarStylesEdit Method

Changes the style of a bar in the Calendar.

Syntax

expression.CalendarBarStylesEdit(Item, Bar, Pattern, Color, Align, Wrap, Shadow, Field1, Field2, Field3, Field4, Field5, SplitPattern)
expression


Optional. An expression that returns an Application object.

Item





Required Long. The calendar bar to edit. Can be one of the following PjBarItem constants: pjBarNonCritical, pjBarCritical, pjBarSummary, pjBarMilestone, pjBarMarked, pjBarHighlighted, pjBarProjectSummary, or pjBarExternalTask.

Bar





Optional Long. The bar type. Can be one of the following PjCalendarBarType constants: pjNormalBar, pjLineBar, or pjNoBar.

Pattern




Optional Long. The bar pattern. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


Color




Optional Long. The bar color. Can be one of the following PjColor constants:

PjAqua
pjNavy

PjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Align




Optional Long. The justification of text in the bar. Can be one of the following PjAlignment constants: pjLeft, pjCenter, or pjRight.

Wrap




Optional Boolean. True if Microsoft Project wraps text in the bar.

Shadow



Optional Boolean. True if the bar has a shadow.

Field1




Optional String. The first field to display in the bar.

Field2




Optional String. The second field to display in the bar.

Field3




Optional String. The third field to display in the bar.

Field4




Optional String. The fourth field to display in the bar.

Field5




Optional String. The fifth field to display in the bar.

SplitPattern


Optional Long. The line pattern used to display split tasks. Can be one of the following PjLineType constants: pjNoLines, pjDash, pjCloseDot, pjContinuous, or pjDot.

Remarks

Specifying a value for any of Field1 through Field5 requires that any preceding Field arguments also be specified. For example, specifying Field3 also requires Field1 and Field2.

CalendarBestFitWeekHeight Method

Changes the height of the active calendar box to display all task bars.

Syntax

expression.CalendarBestFitWeekHeight
expression


Optional. An expression that returns an Application object.

CalendarDateBoxes Method

Customizes the date boxes in the Calendar.

Syntax

expression.CalendarDateBoxes(TopLeft, TopRight, BottomLeft, BottomRight, TopColor, BottomColor, TopPattern, BottomPattern)
expression


Optional. An expression that returns an Application object.

TopLeft



Optional Long. The format for dates in the upper-left corner of each date box. Can be one of the following PjCalendarDateLabel constants:

Constant
Example date format




pjDay_mm_dd
9/30, 10/1

pjDay_mm_dd_yy
9/30/97, 10/1/97

pjDay_m_dd
S 30, O 1

pjDay_mmm_dd
Sep 30, Oct 1

pjDay_mmm_dd_yyy
Sep 30, '97; Oct 1, '97

pjDay_di
T, W

pjDay_di_mm_dd
T 9/30, W 10/1

pjDay_di_dd
T 30, W 1

pjDay_di_m_dd
T S 30, W O 1

pjDay_didd
T30, W1

pjDay_ddi
Tu, We

pjDay_ddi_mm_dd
Tu 9/30, We 10/1

pjDay_ddi_dd
Tu 30, We 1

pjDay_ddi_m_dd
Tu S 30, We O 1

pjDay_ddd
Tue, Wed

pjDay_ddd_mm_dd
Tue 9/30, Wed 2/1

pjDay_ddd_mm_dd_yy
Tue 9/30/97; Wed 2/1/97

pjDay_ddd_dd
Tue 30, Wed 1

pjDay_ddd_m_dd
Tue S 30, Wed O 1

pjDay_ddd_mmm_dd
Tue Sep 30, Wed Oct 1

pjDay_ddd_mmm_dd_yyy
Tue Sep 30, '97; Wed Oct 1, '97

pjDay_ddd_mmmm_dd
Tue September 30, Wed October 1

pjDay_dddd
Tuesday, Wednesday

pjDayFromEnd_dd
4, 3 (the day from the end date of the project)

pjDayFromEnd_Ddd
D4, D3 (the day from the end date of the project)

pjDayFromEnd_Day_dd
Day 4, Day 3 (the day from the end date of the project)

pjDayFromStart_dd
1, 2 (the day from the start date of the project)

pjDayFromStart_Ddd
D1, D2 (the day from the start date of the project)

pjDayFromStart_Day_dd
Day 1, Day 2 (the day from the start date of the project)

pjDayOfMonth_dd
30, 1 (the day of the month)

pjDayOfYear_dd
273, 274 (the day of the year)

pjDayOfYear_dd_yyyy
273 1997, 274 1997 (the day of the year followed by the year)

pjDayOfYear_dd_yyy
273 '97, 274 '97 (the day of the year followed by the year)

pjNoDateFormat
No date is displayed.

PjOverflowIndicator
The overflow indicator is displayed.

TopRight



Optional Long. The format for dates in the upper-right corner of each date box. Can be one of the PjCalendarDateLabel constants.

BottomLeft


Optional Long. The format for dates in the lower-left corner of each date box. Can be one of the PjCalendarDateLabel constants.

BottomRight

Optional Long. The format for dates in the lower-right corner of each date box. Can be one of the PjCalendarDateLabel constants.

TopColor



Optional Long. The color of the top band in each date box. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

BottomColor

Optional Long. The color of the bottom band in each date box. Can be one of the PjColor constants.

TopPattern


Optional Long. The pattern of the top band in each date box. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


BottomPattern

Optional Long. The pattern of the bottom band in each date box. Can be one of the PjFillPattern constants.

Remarks

Using the CalendarDateBoxes method without specifying any arguments displays the Timescale dialog box with the Date Boxes tab selected.

CalendarDateBoxes Method Example

The following example displays the day of the week (for example, Monday) in the upper-left corner of the calendar date boxes and the month and date (for example, Jan 31) in the upper-right corner of the calendar date boxes.

Sub FormatCalendarDays()


CalendarDateBoxes Topleft:=pjDay_dddd, TopRight:=pjDay_mmm_dd

End Sub

CalendarDateShading Method

Determines which calendar is used when determining when and how dates are shaded on the Calendar.

Syntax

expression.CalendarDateShading(BaseCalendarName, ResourceUniqueID, ProjectIndex)
expression




Optional. An expression that returns an Application object.

BaseCalendarName

Optional String. If referring to a single project, or the master project in a consolidated project, the name of a base calendar to use for shading. If referring to an inserted project in a consolidated project, the name of a base calendar and the name of the inserted project in the manner of "Calendar [Project]", where Calendar is the name of the base calendar and Project is the name of the inserted project.

ResourceUniqueID

Optional Long. The unique identification number of a resource. The corresponding resource calendar is used for shading.

ProjectIndex




Due to changes in the Microsoft Project object model, this argument no longer has an effect. It has been retained for backwards compatibility.

Remarks

Using the CalendarDateShading method without specifying any arguments displays the Timescale dialog box with the Date Shading tab selected.

You must specify either BaseCalendarName or ResourceUniqueID, but you cannot specify both.

CalendarDateShadingEdit Method

Changes box shading in the Calendar.

Syntax

expression.CalendarDateShadingEdit(Item, Pattern, Color)
expression




Optional. An expression that returns an Application object.

Item







Required Long. The type of calendar exception to change. Can be one of the following PjCalendarShading constants:

Constant
Description

 


pjBaseWorking
Working days in a base calendar

pjBaseNonWorking
Nonworking days in a base calendar

pjBaseNonDefaultWorking
In a base calendar, working days for which the working hours are different from the default working hours

pjResourceWorking
Working days in a resource calendar

pjResourceNonWorking
Nonworking days in a resource calendar

pjResourceNonDefaultWorking
In a resource calendar, working days for which the working hours are different from the default working hours

Pattern




Optional Long. The pattern for the type of date box specified by Item. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


Color




Optional Long. The color for the type of date box specified by Item. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

CalendarLayout Method

Changes how task bars are arranged on the Calendar.

Syntax

expression.CalendarLayout(SortOrder, AutoLayout)
expression

Optional. An expression that returns an Application object.

SortOrder


Optional Boolean. True if tasks are displayed in the Calendar using the current sort order. False if the sort order changes to display as many tasks as possible. The default value is True.

AutoLayout

Optional Boolean. True if the Calendar view automatically changes to reflect task changes.

Remarks

Using the CalendarLayout method without specifying any arguments displays the Layout dialog box.

Use the Sort method to set the current sort order.

CalendarShowBarSplits Method

Shows or hides task splits on the Calendar.

Syntax

expression.CalendarShowBarSplits(Display)
expression

Optional. An expression that returns an Application object.

Display



Optional Boolean. True if task splits appear on the Calendar. The default value is True.

CalendarTaskList Method

Displays the list of tasks for a specific date.

Syntax

expression.CalendarTaskList(Date)
expression

Optional. An expression that returns an Application object.

Date




Optional Variant. The date of the desired day. The default value is the date of the currently selected day in the Calendar.

CalendarTimescale Method

Displays the Timescale dialog box, which allows the user to customize the Calendar view.

Syntax

expression.CalendarTimescale
expression

Optional. An expression that returns an Application object.

Remarks

The CalendarTimescale method has the same effect as the Timescale command on the Format menu.

CalendarWeekHeadings Method

Customizes headings in the Calendar.

Syntax

expression.CalendarWeekHeadings(MonthTitle, WeekTitle, DayTitle, ShowPreview, DaysPerWeek)
expression

Optional. An expression that returns an Application object.

MonthTitle

Optional Long. The format of the month title. Can be one of the following PjMonthLabel constants:

Constant
Example date format




pjMonthLabelMonth_mm
9, 10

pjMonthLabelMonth_mm_yy
9/97, 10/97

pjMonthLabelMonth_mm_yyy
9 '97, 10 '97

pjMonthLabelMonth_m
S, O

pjMonthLabelMonth_mmm
Sep, Oct

pjMonthLabelMonth_mmm_yyy
Sep '97, Oct '97

pjMonthLabelMonth_mmmm
September, October

pjMonthLabelMonth_mmmm_yyyy
September 1997, October 1997

pjMonthLabelMonth_FromEnd_mm
5, 4 (months from end date of project)

pjMonthLabelMonthFromEnd_Mmm
M5, M4 (months from end date of project)

pjMonthLabelMonthFromEnd_Month_mm
Month5, Month4 (months from end date of project)

pjMonthLabelMonthFromStart_mm
1, 2 (months from start date of project)

pjMonthLabelMonthFromStart_Mmm
M1, M2 (months from start date of project)

pjMonthLabelMonthFromStart_Month_mm
Month1, Month2 (months from start date of project)

pjMonthLabelNoDateFormat
No date is displayed.

WeekTitle

Optional Long. The format of week titles. Can be one of the following PjDateLabel constants:

Constant
Example date format




pjYear_yyyy
1997, 1998

pjYear_yyy
'97, '98

pjYear_yy
97, 98

pjYearFromEnd_yy
3, 2, 1 (year from the finish date of the project)

pjYearFromEnd_Yyy
Y3, Y2, Y1 (year from the finish date of the project)

pjYearFromEnd_Year_yy
Year 2, Year 1 (year from the finish date of the project)

pjYearFromStart_yy
1, 2, 3 (year from the start date of the project)

pjYearFromStart_Yyy
Y1, Y2, Y3 (year from the start date of the project)

pjYearFromStart_Year_yy
Year 1, Year 2 (year from the start date of the project)

pjHalfYear_h
1, 2

pjHalfYear_Hh
H1, H2

pjHalfYear_Hh_yyy
H1, '97, H2 '97

pjHalfYear_hhh_Half
1st Half, 2nd Half

pjHalfYear_hHyy
1H97, 2H97

pjHalfYear_Hlf_h
Half 1, Half 2

pjHalfYear_Hlf_h_yyyy
Half 1, 1997; Half 2, 1997

pjHalfYearFromEnd_h
2, 1 (half year from the finish date of the project)

pjHalfYearFromEnd_Half_h
Half 2, Half 1 (half year from the finish date of the project)

pjHalfYearFromEnd_Hh
H2, H1 (half year from the finish date of the project)

pjHalfYearFromStart_h
1, 2 (half year from the start date of the project)

pjHalfYearFromStart_Half_h
Half 1, Half2 (half year from the start date of the project)

pjHalfYearFromStart_Hh
H1, H2 (half year from the start date of the project)

pjQuarter_q
1, 2

pjQuarter_qQyy
1Q97, 2Q97

pjQuarter_qqq_Quarter
1st Quarter, 2nd Quarter

pjQuarter_Qq
Q1, Q2

pjQuarter_Qq_yyy
Q1 '97, Q2 '97

pjQuarter_Qtr_q
Qtr 1, Qtr 2

pjQuarter_Qtr_q_yyyy
Qtr 1, 1997; Qtr 2, 1997

pjQuarterFromEnd_q
3, 2, 1 (quarter from the finish date of the project)

pjQuarterFromEnd_Qq
Q3, Q2, Q1 (quarter from the finish date of the project)

pjQuarterFromEnd_Quarter_q
Quarter 2, Quarter 1 (quarter from the finish date of the project)

pjQuarterFromStart_q
1, 2, 3 (quarter from the start date of the project)

pjQuarterFromStart_Qq
Q1, Q2, Q3 (quarter from the start date of the project)

pjQuarterFromStart_Quarter_q
Quarter 1, Quarter 2 (quarter from the start date of the project)

pjMonth_mm
9, 10

pjMonth_mm_yy
9/97, 10/97

pjMonth_mm_yyy
9 '97, 10 '97

pjMonth_m
S, O

pjMonth_mmm
Sep, Oct

pjMonth_mmm_yyy
Sep '97, Oct '97

pjMonth_mmmm
September, October

pjMonth_mmmm_yyyy
September 1997, October 1997

pjMonth_FromEnd_mm
5, 4 (months from the finish date of project)

pjMonthFromEnd_Mmm
M5, M4 (months from the finish date of project)

pjMonthFromEnd_Month_mm
Month5, Month4 (months from the finish date of project)

pjMonthFromStart_mm
1, 2 (months from the start date of project)

pjMonthFromStart_Mmm
M1, M2 (months from the start date of project)

pjMonthFromStart_Month_mm
Month1, Month2 (months from the start date of project)

pjThirdsOfMonths_dd
1, 11, 21

pjThirdsOfMonths_ddd
B, M, E

pjThirdsOfMonths_dddd
Beginning, Middle, End

pjThirdsOfMonths_mm_dd
9/1, 9/11, 9/21

pjThirdsOfMonths_mm_dd_yy
9/1/97, 9/11/97, 9/21/97

pjThirdsOfMonths_mm_ddd_yy
9/B/97, 9/M/97, 9/E/97

pjThirdsOfMonths_mm_ddd
9/B, 9/M, 9/E

pjThirdsOfMonths_mmm_dd
Sep 1, Sep 11, Sep 21

pjThirdsOfMonths_mmm_dd_yy
Sep 1, '97; Sep 11, '97; Sep 21 '97

pjThirdsOfMonths_mmm_ddd
Sep B, Sep M, Sep E

pjThirdsOfMonths_mmm_ddd_yy
Sep B, '97; Sep M, '97; Sep E, '97

pjThirdsOfMonths_mmmm_dd
September 1, September 11, September 21

pjThirdsOfMonths_mmmm_dd_yyyy
September 1, 1997; September 11, 1997; September 21, 1997

pjThirdsOfMonths_mmmm_dddd_yyyy
September Beginning 1997, September Middle 1997, September End 1997

pjThirdsOfMonths_mmmm_dddd
September Beginning, September Middle, September End

pjWeek_mm_dd
9/30, 10/1

pjWeek_mm_dd_yy
9/30/97, 10/1/97

pjWeek_m_dd
S 30, O 1

pjWeek_mmm_dd
Sep 30, Oct 1

pjWeek_mmm_dd_yyy
Sep 30, '97; Oct 1 '97

pjWeek_mmmm_dd
September 30, October 1

pjWeek_mmmm_dd_yyyy
September 30, 1997; October 1, 1997

pjWeek_di_mm_dd
T 9/30, W 10/1

pjWeek_di_m_dd
T S 30, W O 1

pjWeek_di_mmm_dd
T Sep 30, W Oct 1

pjWeek_ddi_mm_dd
Mo 1/31, Mo 2/7

pjWeek_ddi_m_dd
Tu 9/30, We 10/1

pjWeek_ddi_mmm_dd
Tu Sep 30, We Oct 1

pjWeek_ddd_mm_dd
Tu 9/30, We 10/1

pjWeek_ddd_mm_dd_yy
Tue 9/30/97, Wed 10/1/97

pjWeek_ddd_dd
Tue 30, Wed 1

pjWeek_ddd_ww
Sun 41, Sun 41 (first day of week, number of week in year)

pjWeek_ddd_m_dd
Tue S 30, Wed O 1

pjWeek_ddd_mmm_dd
Tue Sep 30, Wed Oct 1

pjWeek_ddd_mmm_dd_yyy
Tue Sep 30, '97; Wed Oct 1, '97

pjWeek_ddd_mmmm_dd
Tue September 30, Wed October 1

pjWeek_ddd_mmmm_dd_yyy
Tue September 30, '97; Wed October 1, '97

pjWeekDayOfMonth_dd
30, 1 (number of day in month)

pjWeekFromEnd_Week_ww
Week 4, Week 3 (the week from the finish date of the project)

pjWeekFromEnd_ww
4, 3 (the week from the finish date of the project)

pjWeekFromEnd_Www
W4, W3 (the week from the finish date of the project)

pjWeekFromStart_Week_ww
Week 1, Week 2 (the week from the start date of the project)

pjWeekFromStart_ww
1, 2 (the week from the start date of the project)

pjWeekFromStart_Www
W1, W2 (the week from the start date of the project)

pjWeekNumber_dd_ww
3 41, 4 41 (number of day in week, number of week in year)

pjWeekNumber_ww
41, 41 (number of week in year)

pjDay_mm_dd
9/30, 10/1

pjDay_mm_dd_yy
9/30/97, 10/1/97

pjDay_m_dd
S 30, O 1

pjDay_mmm_dd
Sep 30, Oct 1

pjDay_mmm_dd_yyy
Sep 30, '97; Oct 1, '97

pjDay_di
T, W

pjDay_di_mm_dd
T 9/30, W 10/1

pjDay_di_dd
T 30, W 1

pjDay_di_m_dd
T S 30, W O 1

pjDay_didd
T30, W1

pjDay_ddi
Tu, We

pjDay_ddi_mm_dd
Tu 9/30, We 10/1

pjDay_ddi_dd
Tu 30, We 1

pjDay_ddi_m_dd
Tu S 30, We O 1

pjDay_ddd
Tue, Wed

pjDay_ddd_mm_dd
Tue 9/30, Wed 2/1

pjDay_ddd_mm_dd_yy
Tue 9/30/97; Wed 10/1/97

pjDay_ddd_dd
Tue 30, Wed 1

pjDay_ddd_m_dd
Tue S 30, Wed O 1

pjDay_ddd_mmm_dd
Tue Sep 30, Wed Oct 1

pjDay_ddd_mmm_dd_yyy
Tue Sep 30, '97; Wed Oct 1, '97

pjDay_ddd_mmmm_dd
Tue September 30, Wed October 1

pjDay_dddd
Tuesday, Wednesday

pjDayFromEnd_dd
4, 3 (the day from the finish date of the project)

pjDayFromEnd_Ddd
D4, D3 (the day from the finish date of the project)

pjDayFromEnd_Day_dd
Day 4, Day 3 (the day from the finish date of the project)

pjDayFromStart_dd
1, 2 (the day from the start date of the project)

pjDayFromStart_Ddd
D1, D2 (the day from the start date of the project)

pjDayFromStart_Day_dd
Day 1, Day 2 (the day from the start date of the project)




pjDayOfYear_dd
273, 274 (the day of the year)

pjDayOfYear_dd_yyyy
273 1997, 274 1997 (the day of the year followed by the year)

pjDayOfYear_dd_yyy
273 '97, 274 '97 (the day of the year followed by the year)

pjWeekLabelNoDateFormat
No date is displayed

DayTitle



Optional Long. The format of day titles. Can be one of the following PjDayLabel constants:

Constant
Example date format




pjDayLabelDay_di
T, W

pjDayLabelDay_ddi
Tu, We

pjDayLabelDay_ddd
Tue, Wed

pjDayLabelDay_dddd
Tuesday, Wednesday

pjDayLabelNoDateFormat
No date is displayed.

ShowPreview

Optional Boolean. True if the next and previous months are previewed.

DaysPerWeek

Optional Integer. The number of days per week to display. Can be set to 5 or 7.

Remarks

Using the CalendarWeekHeadings method without specifying any arguments displays the Timescale dialog box with the Week Headings tab selected.

CanLevel Property

True if the resource may be leveled. Read/write Boolean.
Caption Property

Returns or sets the text in the title bar of the main window (Application object) or a project window (Window object). Read/write String.

Remarks

When the active window is maximized, the title bar displays the caption for both the main and active windows, separating the captions with a hyphen.  For example, if the caption for the main window is "Microsoft Project" and the caption for the active window is "Project1", then the title bar displays "Microsoft Project - Project1" when the active window is maximized.

If you set the Caption property to Empty, the title bar displays a default caption. The default caption for the main window is "Microsoft Project".

In a project with one window, the default caption for the window is the file name of the project. In a project with multiple windows, the default caption for each window is name:n, where name is the file name of the project and n is a unique number for the window.

Caption Property Example

The following example prompts the user to change the caption for the active window.

Sub ChangeWindowCaption()


Dim Entry As String
' Caption entered by user


' Prompt user for a new caption.


Entry = InputBox$("Enter a new caption for the active window (enter 'reset' to set the caption to its default).")


' If user chooses the Cancel button, exit Sub procedure.


If Entry = Empty Then Exit Sub


' Set or reset the caption.


If Entry = "reset" Then



ActiveWindow.Caption = Empty


Else



ActiveWindow.Caption = Entry


End If

End Sub

Cell Object

Represents the active cell. There is no collection for Cell objects. The Cell object can only be accessed through the ActiveCell property of the Application object.

Using the Cell Object

Use the ActiveCell property to return a Cell object. The following example displays the names of all the resources assigned to the task in the active cell.

Dim A As Assignment

For Each A In ActiveCell.Task.Assignments

    MsgBox A.ResourceName

Next A

CellDragAndDrop Property

True if you can move and copy cells by dragging them. False if you can move and copy cells only by cutting or copying and then pasting them. Read/write Boolean.

Change Event

Occurs when a change is made to data in the project. An action affecting several items at once is considered to be one change.

Syntax

Private Sub Project_Change(ByVal pj As MSProject.Project)
pj

The project that changed.

Remarks

The Change event does not occur for actions such as switching views, applying filters, changing formatting, and so on.

ChangeWorkingTime Method

Displays the Change Working Time dialog box, which prompts the user to change a calendar.

Syntax

expression.ChangeWorkingTime
expression


Optional. An expression that returns an Application object.

Remarks

The ChangeWorkingTime method has the same effect as the Change Working Time command on the Tools menu.

CheckField Method

True if the selected tasks or resources meet the specified criteria.

Syntax

expression.CheckField(Field, Value, Test, Op, Field2, Value2, Test2)
expression


Optional. An expression that returns an Application object.

Field





Required String. The name of the field to search.

Value




Required String. The value to compare with the value of the field specified with Field.

Test





Optional String. The type of comparison made between Field and Value. The default value is "equals". Can be one of the following comparison strings:

Comparison String
Description




"equals"
The value of Field equals Value.

"does not equal"
The value of Field does not equal Value.

"is greater than"
The value of Field is greater than Value.

"is greater than or equal to"
The value of Field is greater than or equal to Value.

"is less than"
The value of Field is less than Value.

"is less than or equal to"
The value of Field is less than or equal to Value.

"is within"
The value of Field is within Value.

"is not within"
The value of Field is not within Value.

"contains"
Field contains Value.

"does not contain"
Field does not contain Value.

"contains exactly"
Field exactly contains Value.

Op





Optional String. How the criteria established with Field, Test, and Value relate to the second criteria. The Op argument can be set to "And" or "Or".

Field2




Optional String. The name of a second field to search.

Value2




Optional String. The value to compare with the value of the field specified with Field2.

Test2




Optional String. The type of comparison made between Field2 and Value2. Can be one of the same comparison strings as Test.

Clear Method

Clears the start and finish times of a work shift, or the value of a timescaled data item.

Syntax

expression.Clear

expression



Required. An expression that returns an object in the Applies To list.

Clear Method Example

The following example schedules a half-day of work on Fridays by creating an 8 A.M. to noon shift and removing the second and third shifts.

Sub HalfDayFridays()


With ActiveProject.Calendar.Weekdays(pjFriday)



.Shift1.Start = #8:00:00 AM#



.Shift1.Finish = #12:00:00 PM#



.Shift2.Clear


.Shift3.Clear

End With

End Sub

Close Method

Closes a pane or window.

Syntax

expression.Close

expression


Required. An expression that returns a Pane or Window  object.

Close Method Example

The following example closes the lower pane of every open window.

Sub CloseWindowsOfActiveProject()


Dim W As Window


For Each W in Application.Windows



If Not (W.BottomPane Is Nothing) Then




W.BottomPane.Close


End If


Next W

End Sub

Code Property

Returns or sets the code of a resource. Read/write String.

CodeName Property

Returns the code name for the project. Read-only String.

Remarks

The code name is the name of the module that stores event macros (and other macros you may have defined) for a project. The default name for the module is "ThisProject"; you can view it in the Project window in the Visual Basic Editor.

Changing the project name doesn't change the code name, and changing the code name (using the Properties window in the Visual Basic Editor) doesn't change the project name.

ColumnAlignment Method

Sets the alignment of text in the active columns.

Syntax

expression.ColumnAlignment(Align)
expression

Optional. An expression that returns an Application object.

Align



Required Long. The alignment of text in the active columns. Can be one of the following PjAlignment constants: pjLeft, pjCenter, or pjRight.

ColumnBestFit Method

Sets the width of a column to the width of its widest item.

Syntax

expression.ColumnBestFit Column
expression

Optional. An expression that returns an Application object.

Column


Optional Long. A number that specifies the column to adjust.  Columns are numbered from left to right, starting with 1. If Column is omitted, Microsoft Project adjusts the width of the column that contains the active cell.

ColumnBestFit Method Example

The following example adjusts the widths of the first five columns in the active table.

Sub BestFitFirstFiveCols()


Dim I As Integer

' Index used in For...Next loop.


For I = 1 To 5



ColumnBestFit Column:=I


Next I

End Sub

ColumnDelete Method

Deletes the active column or the column containing the active cell from the view. The actual field and the data it contains are merely hidden.

Syntax

expression.ColumnDelete
expression

Optional. An expression that returns an Application object.

ColumnEdit Method

Displays the Column Definition dialog box for the specified column.

Syntax

expression.ColumnEdit(Column)
expression

Optional. An expression that returns an Application object.

Column


Optional Integer. The number of the column to change. The default value is the number of the active column.

ColumnInsert Method

Inserts a column to the left of the active column, and then displays the Column Definition box.

Syntax

expression.ColumnInsert
expression

Optional. An expression that returns an Application object.

CommandBars Property

Returns a CommandBars collection that represents all the command bars in the application or project. Read-only.

CommandBars Property Example

This example deletes all custom command bars that aren't visible.

Sub RemoveCommandBars()

    Dim Bar As CommandBar

    For Each Bar In Application.CommandBars
        If Not Bar.BuiltIn And Not Bar.Visible Then Bar.Delete

    Next

End Sub

Confirmed Property

Returns the results of task assignments in a Microsoft Project mail message.

Assignment object: True if a resource of a project or task has accepted the assignment. Read/write Boolean.

Resource object: True if the resource has accepted all of his or her assignments. Read-only Boolean.

Task object: True if all resources assigned to the task have accepted their assignments. Read-only Boolean.

ConsolidateProjects Method

Displays the data from one or more projects in a single window.

Syntax

expression.ConsolidateProjects(Filenames, NewWindow, AttachToSources, PoolResources, HideSubtasks)
expression



Optional. An expression that returns an Application object.

Filenames



Optional String. One or more file names of projects to consolidate.

NewWindow



Optional Boolean. True if projects are inserted (consolidated) into a new project. False if projects are inserted into the active project at the selection point. The default value is False.

AttachToSources

Optional Boolean. True if changes in the consolidated project affect source projects. The default value is True.

PoolResources

Due to changes in the object model of Microsoft Project, this argument is ignored. It is retained so that existing macros which make use of this argument do not cause errors.

HideSubtasks


Optional Boolean. True if the subtasks of the projects specified with Filenames are hidden. The default value is True.

Remarks

To specify that a consolidated project should be inserted as read-only, type (R/O) at the end of the file name in Filenames.

If the ConsolidateProjects method is used without specifying any arguments, the Insert Project dialog box appears.

ConsolidateProjects Method Example

The following example creates a consolidated project, prints a report, and closes the consolidated project without saving it.

Sub ConsolidatedReport()

    ConsolidateProjects Filenames:="Project1.mpp,Project2.mpp", NewWindow:=True

    ReportPrint Name:="Critical Tasks"

    FileClose Save:=pjDoNotSave

End Sub

ConstraintDate Property

Returns or sets a constraint date for a task. Read/write Variant.

Remarks

Microsoft Project uses the constraint date only when you set a constraint on a task. To set a constraint on a task, use the ConstraintType property.

ConstraintDate Property Example

The following example sets the constraint type to SNET and the constraint date to the current date for tasks in the active project with the default constraint of ASAP.

Sub SetConstraintDate()

    Dim T As Task   ' Task object used in For Each loop

    For Each T In ActiveProject.Tasks

        If T.ConstraintType = pjASAP Then

            T.ConstraintType = pjSNET

            T.ConstraintDate = ActiveProject.CurrentDate

        End If

    Next T

End Sub

ConstraintType Property

Returns or sets a constraint type for a task. Read/write Long.

Can be one of the following PjConstraint constants:

Constant
Constraint Type
Description





pjALAP
As Late As Possible
Task occurs as late as possible in the schedule without delaying subsequent tasks

pjASAP
As Soon As Possible
Task occurs as soon as possible in the schedule.  This is the default constraint type for tasks

pjFNET
Finish No Earlier Than
Task finishes on or after the constraint date

pjFNLT
Finish No Later Than
Task finishes on or before the constraint date

pjMFO
Must Finish On
Task finishes on the constraint date

pjMSO
Must Start On
Task starts on the constraint date

pjSNET
Start No Earlier Than
Task starts on or after the constraint date

pjSNLT
Start No Later Than
Task starts on or before the constraint date

Remarks

If you set the ConstraintType property to pjFNET, pjFNLT, pjMFO, pjMSO, pjSNET, or pjSNLT, Microsoft Project uses the constraint date for the task. To set the constraint date, use the ConstraintDate property.

ConstraintType Property Example

The following example changes the constraint type of tasks from MSO and MFO to SNET and FNLT.

Sub ChangeConstraintTypes()

    Dim T As Task   ' Task object used in For Each loop

    For Each T In ActiveProject.Tasks

        If T.ConstraintType = pjMSO Then

            T.ConstraintType = pjSNET

        ElseIf T.ConstraintType = pjMFO Then

            T.ConstraintType = pjFNLT

        End If

    Next T

End Sub

Contact Property

Returns or sets contact information of the person who is responsible for a task. Read/write String.

Container Property

Returns the object that contains the specified embedded project. Read-only Object.

Remarks

Use the Container property to access the properties or methods of the object containing the project. If the container doesn't support Automation or the project isn't embedded, this property fails.

Cost Property

Returns the cost of an assignment, resource, or task. Read-only Variant.

Costn Property

Returns or sets the value in an additional cost field for an assignment, resource, or task. The n placeholder can be a number from 1 to 10. Read/write Variant.

CostPerUse Property

Returns or sets the cost per use of a resource. Read/write Variant.

CostPerUse Property Example

The following example displays the sum of the cost per use of each resource in the active project.

Sub TotalCostPerUse()

    Dim R As Resource               ' Resource object used in For Each loop

    Dim TotalCostPerUse As Double   ' The total cost per use

    ' Add up the cost per use of each resource.

    For Each R In ActiveProject.Resources

        TotalCostPerUse = TotalCostPerUse + R.CostPerUse
    Next R

    ' Display the total cost per use.

    MsgBox ("Sum of the cost per use of each resource in this project: " & TotalCostPerUse)

End Sub

CostRateTable Object, CostRateTables Collection Object

Represents a collection of pay rates for a resource. The CostRateTable object is a member of the CostRateTables collection.

Using the CostRateTable Object

Use CostRateTables(Index), where Index is the cost rate table index number or cost rate table name, to return a single CostRateTable object. The following example changes the standard rate on one of a resource's pay rate tables.

Dim GovtRates As CostRateTable

Set GovtRates = ActiveProject.Resources("Bob").CostRateTables("B")

GovtRates.PayRates(1).StandardRate = "$10/h"

Using the CostRateTables Collection

Use the CostRateTables property to return a CostRateTables collection. The following example lists the standard pay rates for all the cost rate tables of the resource in the active cell.

Dim CRT As CostRateTable, PR As PayRate

Dim Rates As String

For Each CRT In ActiveCell.Resource.CostRateTables

    For Each PR In CRT.PayRates

        Rates = Rates & "CostRateTable " & CRT.Name & ": " & PR.StandardRate & vbCrLf

    Next PR

Next CRT

MsgBox Rates

CostRateTable Property

Returns or sets the cost rate table in effect for the assignment. Read/write Variant.

CostRateTables Property

Returns a CostRateTables collection representing the cost rate tables for the resource. Read-only.

CostRateTables Property Example

The following example lists the standard pay rates for all the cost rate tables of the resource in the active cell.

Sub ListPayRates()

    Dim CRT As CostRateTable, PR As PayRate

    Dim Rates As String

    For Each CRT In ActiveCell.Resource.CostRateTables
        For Each PR In CRT.PayRates

            Rates = Rates & "CostRateTable " & CRT.Name & ": " & _

                PR.StandardRate & " (Effective " & PR.EffectiveDate & _

                    ")" & vbCrLf

        Next PR

    Next CRT

    MsgBox Rates

End Sub

CostVariance Property

Returns the variance between the baseline cost and the cost of a resource or task. Read-only Variant.

Count Property

Returns the number of items in the specified collection. Read-only Long.

Remarks

Returns 1 when applied to the Day object. For the Month, Year, or Period objects, returns the number of days in the month, year, or period.

Count Property Example

The following example prompts the user for the name of a resource and then assigns that resource to tasks without any resources.

Sub AssignResource()


Dim T As Task


' Task object used in For Each loop


Dim R
As Resource

' Resource object used in For Each loop


Dim Rname As String
' Resource name


Dim RID As Long

' Resource ID


RID = 0


RName = InputBox$("Enter the name of a resource: ")


For Each R in ActiveProject.Resources



If R.Name = RName Then




RID = R.ID




Exit For



End If


Next R


If RID <> 0 Then



' Assign the resource to tasks without any resources.



For Each T In ActiveProject.Tasks




If T.Assignments.Count = 0 Then





T.Assignments.Add ResourceID:=RID




End If



Next T


Else



MsgBox Prompt:=RName & " is not a resource in this project.", buttons:=vbExclamation


End If

End Sub

Created Property

Returns the date a task was created. Read-only Variant.

Remarks

To find out the creation date of a project, use the CreationDate property.

CreationDate Property

Returns the date a project was created. Read-only Variant.

CreationDate Property Example

The following example adds the creation date of the active project to its notes.

Sub AddCreationDateToNotes()

    ActiveProject.ProjectNotes = ActiveProject.ProjectNotes & vbCrLf & "This project was created on " & ActiveProject.CreationDate & "."

End Sub

Critical Property

True if the task is on the critical path. Read-only Boolean.

Critical Property Example

The following example sets the highest priority for critical tasks in the active project.

Sub MakeCriticalTasksHighestPriority()

    Dim T As Task ' Task object used in For Each loop

    For Each T In ActiveProject.Tasks

        If T.Critical Then T.Priority = pjPriorityHighest

    Next T

End Sub

CurrencyDigits Property

Sets or returns the number of digits following the decimal separator character in currency values. Read/write Variant.

Remarks

Microsoft Project sets the CurrencyDigits property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

CurrencySymbol Property

Returns or sets the characters that denote currency values. Read/write String.

Remarks

Microsoft Project sets the CurrencySymbol property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

CurrencySymbol Property Example

The following example formats currency values in the active project according to the country specified by the user.

Sub FormatCurrency()

    Dim Country As String

    ' Prompt the user to enter the name of a country.

    Country = UCase(InputBox$("Enter the name of a country: ", "Format Currency By Country"))

    Select Case Country

        Case "US", "United States", "USA", "United States of America"

            ActiveProject.CurrencySymbol = "$"

            ActiveProject.CurrencySymbolPosition = pjBefore

        Case "FRANCE"

            ActiveProject.CurrencySymbol = "F"

            ActiveProject.CurrencySymbolPosition = pjAfterWithSpace

        Case "ENGLAND"

            ActiveProject.CurrencySymbol = Chr(163)

            ActiveProject.CurrencySymbolPosition = pjBefore

        Case "GERMANY"

            ActiveProject.CurrencySymbol = "DM"

            ActiveProject.CurrencySymbolPosition = pjAfterWithSpace

        Case "SWEDEN"

            ActiveProject.CurrencySymbol = "kr"

            ActiveProject.CurrencySymbolPosition = pjAfterWithSpace

        ' Warn user if the currency format is not known.

        Case Else

            MsgBox ("The currency format for that country is unknown.")

    End Select

End Sub

CurrencySymbolPosition Property

Returns or sets the location of the currency symbol. Can be one of the following PjPlacement constants: pjBefore, pjAfter, pjBeforeWithSpace, or pjAfterWithSpace. Read/write Long.

Remarks

Microsoft Project sets the CurrencySymbolPosition property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

CurrentDate Property

Returns or sets the current date for a project. Read/write Variant.

Remarks

When a project opens, Microsoft Project automatically sets the project's current date equal to the system date.

CurrentDate Property Example

The following example sets the current date of the active project to the previous Monday.

Sub SetCurrentDateToPreviousMonday()

    ' Loop while the current date is not Monday.

    Do While WeekDay(ActiveProject.CurrentDate) <> pjMonday

        ' Subtract one day from the current date.

        ActiveProject.CurrentDate = _

            DateSerial(Year(ActiveProject.CurrentDate), _

            Month(ActiveProject.CurrentDate), _

            Day(ActiveProject.CurrentDate - 1))

    Loop

End Sub

CurrentFilter Property

Returns the name of the active filter for a project. Read-only String.

CurrentFilter Property Example

The following example displays the names of the active view, table, and filter in a dialog box.

Sub ViewDetails()

    Dim Temp As String

    Temp = "View: " & ActiveProject.CurrentView & vbCrLf

    Temp = Temp & "Table:" & ActiveProject.CurrentTable & vbCrLf

    Temp = Temp & "Filter: " & ActiveProject.CurrentFilter
    MsgBox Temp

End Sub

CurrentTable Property

Returns the name of the active table for a project. Read-only String.

CurrentTable Property Example

The following example displays the names of the active view, table, and filter in a dialog box.

Sub ViewDetails()

    Dim Temp As String

    Temp = "View: " & ActiveProject.CurrentView & vbCrLf

    Temp = Temp & "Table:" & ActiveProject.CurrentTable & vbCrLf

    Temp = Temp & "Filter: " & ActiveProject.CurrentFilter

    MsgBox Temp

End Sub

CurrentView Property

Returns the name of the active view for a project. Read-only String.

CurrentView Property Example

The following example displays the names of the active view, table, and filter in a dialog box.

Sub ViewDetails()

    Dim Temp As String

    Temp = "View: " & ActiveProject.CurrentView & vbCrLf

    Temp = Temp & "Table:" & ActiveProject.CurrentTable & vbCrLf

    Temp = Temp & "Filter: " & ActiveProject.CurrentFilter

    MsgBox Temp

End Sub

CustomDocumentProperties Property

Returns a DocumentProperties collection representing the custom properties of the document. Read-only.

Remarks

To use this property, you should establish a reference to the Microsoft Office 97 Object Library by using the References command on the Tools menu. The Object Library contains definitions for the Visual Basic objects, properties, methods, and constants used to manipulate document properties.  

Use the BuiltinDocumentProperties property to return the collection of built-in document properties.

CustomFieldGetName Method

Returns the friendly name for a custom field.

Syntax

expression.CustomFieldGetName(FieldID)
expression

Optional. An expression that returns an Application object.

FieldID



Required Long. The custom field. Can be one of the following PjCustomField constants:

pjCustomResourceCost1
pjCustomTaskCost1

pjCustomResourceCost2
pjCustomTaskCost2

pjCustomResourceCost3
pjCustomTaskCost3

pjCustomResourceCost4
pjCustomTaskCost4

pjCustomResourceCost5
pjCustomTaskCost5

pjCustomResourceCost6
pjCustomTaskCost6

pjCustomResourceCost7
pjCustomTaskCost7

pjCustomResourceCost8
pjCustomTaskCost8

pjCustomResourceCost9
pjCustomTaskCost9

pjCustomResourceCost10
pjCustomTaskCost10

pjCustomResourceDate1
pjCustomTaskDate1

pjCustomResourceDate2
pjCustomTaskDate2

pjCustomResourceDate3
pjCustomTaskDate3

pjCustomResourceDate4
pjCustomTaskDate4

pjCustomResourceDate5
pjCustomTaskDate5

pjCustomResourceDate6
pjCustomTaskDate6

pjCustomResourceDate7
pjCustomTaskDate7

pjCustomResourceDate8
pjCustomTaskDate8

pjCustomResourceDate9
pjCustomTaskDate9

pjCustomResourceDate10
pjCustomTaskDate10

pjCustomResourceDuration1
pjCustomTaskDuration1

pjCustomResourceDuration2
pjCustomTaskDuration2

pjCustomResourceDuration3
pjCustomTaskDuration3

pjCustomResourceDuration4
pjCustomTaskDuration4

pjCustomResourceDuration5
pjCustomTaskDuration5

pjCustomResourceDuration6
pjCustomTaskDuration6

pjCustomResourceDuration7
pjCustomTaskDuration7

pjCustomResourceDuration8
pjCustomTaskDuration8

pjCustomResourceDuration9
pjCustomTaskDuration9

pjCustomResourceDuration10
pjCustomTaskDuration10

pjCustomResourceFinish1
pjCustomTaskFinish1

pjCustomResourceFinish2
pjCustomTaskFinish2

pjCustomResourceFinish3
pjCustomTaskFinish3

pjCustomResourceFinish4
pjCustomTaskFinish4

pjCustomResourceFinish5
pjCustomTaskFinish5

pjCustomResourceFinish6
pjCustomTaskFinish6

pjCustomResourceFinish7
pjCustomTaskFinish7

pjCustomResourceFinish8
pjCustomTaskFinish8

pjCustomResourceFinish9
pjCustomTaskFinish9

pjCustomResourceFinish10
pjCustomTaskFinish10

pjCustomResourceFlag1
pjCustomTaskFlag1

pjCustomResourceFlag2
pjCustomTaskFlag2

pjCustomResourceFlag3
pjCustomTaskFlag3

pjCustomResourceFlag4
pjCustomTaskFlag4

pjCustomResourceFlag5
pjCustomTaskFlag5

pjCustomResourceFlag6
pjCustomTaskFlag6

pjCustomResourceFlag7
pjCustomTaskFlag7

pjCustomResourceFlag8
pjCustomTaskFlag8

pjCustomResourceFlag9
pjCustomTaskFlag9

pjCustomResourceFlag10
pjCustomTaskFlag10

pjCustomResourceFlag11
pjCustomTaskFlag11

pjCustomResourceFlag12
pjCustomTaskFlag12

pjCustomResourceFlag13
pjCustomTaskFlag13

pjCustomResourceFlag14
pjCustomTaskFlag14

pjCustomResourceFlag15
pjCustomTaskFlag15

pjCustomResourceFlag16
pjCustomTaskFlag16

pjCustomResourceFlag17
pjCustomTaskFlag17

pjCustomResourceFlag18
pjCustomTaskFlag18

pjCustomResourceFlag19
pjCustomTaskFlag19

pjCustomResourceFlag20
pjCustomTaskFlag20

pjCustomResourceNumber1
pjCustomTaskNumber1

pjCustomResourceNumber2
pjCustomTaskNumber2

pjCustomResourceNumber3
pjCustomTaskNumber3

pjCustomResourceNumber4
pjCustomTaskNumber4

pjCustomResourceNumber5
pjCustomTaskNumber5

pjCustomResourceNumber6
pjCustomTaskNumber6

pjCustomResourceNumber7
pjCustomTaskNumber7

pjCustomResourceNumber8
pjCustomTaskNumber8

pjCustomResourceNumber9
pjCustomTaskNumber9

pjCustomResourceNumber10
pjCustomTaskNumber10

pjCustomResourceNumber11
pjCustomTaskNumber11

pjCustomResourceNumber12
pjCustomTaskNumber12

pjCustomResourceNumber13
pjCustomTaskNumber13

pjCustomResourceNumber14
pjCustomTaskNumber14

pjCustomResourceNumber15
pjCustomTaskNumber15

pjCustomResourceNumber16
pjCustomTaskNumber16

pjCustomResourceNumber17
pjCustomTaskNumber17

pjCustomResourceNumber18
pjCustomTaskNumber18

pjCustomResourceNumber19
pjCustomTaskNumber19

pjCustomResourceNumber20
pjCustomTaskNumber20

pjCustomResourceStart1
pjCustomTaskStart1

pjCustomResourceStart2
pjCustomTaskStart2

pjCustomResourceStart3
pjCustomTaskStart3

pjCustomResourceStart4
pjCustomTaskStart4

pjCustomResourceStart5
pjCustomTaskStart5

pjCustomResourceStart6
pjCustomTaskStart6

pjCustomResourceStart7
pjCustomTaskStart7

pjCustomResourceStart8
pjCustomTaskStart8

pjCustomResourceStart9
pjCustomTaskStart9

pjCustomResourceStart10
pjCustomTaskStart10

pjCustomResourceText1
pjCustomTaskText1

pjCustomResourceText2
pjCustomTaskText2

pjCustomResourceText3
pjCustomTaskText3

pjCustomResourceText4
pjCustomTaskText4

pjCustomResourceText5
pjCustomTaskText5

pjCustomResourceText6
pjCustomTaskText6

pjCustomResourceText7
pjCustomTaskText7

pjCustomResourceText8
pjCustomTaskText8

pjCustomResourceText9
pjCustomTaskText9

pjCustomResourceText10
pjCustomTaskText10

pjCustomResourceText11
pjCustomTaskText11

pjCustomResourceText12
pjCustomTaskText12

pjCustomResourceText13
pjCustomTaskText13

pjCustomResourceText14
pjCustomTaskText14

pjCustomResourceText15
pjCustomTaskText15

pjCustomResourceText16
pjCustomTaskText16

pjCustomResourceText17
pjCustomTaskText17

pjCustomResourceText18
pjCustomTaskText18

pjCustomResourceText19
pjCustomTaskText19

pjCustomResourceText20
pjCustomTaskText20

pjCustomResourceText21
pjCustomTaskText21

pjCustomResourceText22
pjCustomTaskText22

pjCustomResourceText23
pjCustomTaskText23

pjCustomResourceText24
pjCustomTaskText24

pjCustomResourceText25
pjCustomTaskText25

pjCustomResourceText26
pjCustomTaskText26

pjCustomResourceText27
pjCustomTaskText27

pjCustomResourceText28
pjCustomTaskText28

pjCustomResourceText29
pjCustomTaskText29

pjCustomResourceText30
pjCustomTaskText30

CustomFieldRename Method

Defines a friendly name for a custom field.

Syntax

expression.CustomFieldRename(FieldID, NewName, Phonetic)
expression

Optional. An expression that returns an Application object.

FieldID



Required Long. The field to be renamed. Can be one of the following PjCustomField constants:

pjCustomResourceCost1
pjCustomTaskCost1

pjCustomResourceCost2
pjCustomTaskCost2

pjCustomResourceCost3
pjCustomTaskCost3

pjCustomResourceCost4
pjCustomTaskCost4

pjCustomResourceCost5
pjCustomTaskCost5

pjCustomResourceCost6
pjCustomTaskCost6

pjCustomResourceCost7
pjCustomTaskCost7

pjCustomResourceCost8
pjCustomTaskCost8

pjCustomResourceCost9
pjCustomTaskCost9

pjCustomResourceCost10
pjCustomTaskCost10

pjCustomResourceDate1
pjCustomTaskDate1

pjCustomResourceDate2
pjCustomTaskDate2

pjCustomResourceDate3
pjCustomTaskDate3

pjCustomResourceDate4
pjCustomTaskDate4

pjCustomResourceDate5
pjCustomTaskDate5

pjCustomResourceDate6
pjCustomTaskDate6

pjCustomResourceDate7
pjCustomTaskDate7

pjCustomResourceDate8
pjCustomTaskDate8

pjCustomResourceDate9
pjCustomTaskDate9

pjCustomResourceDate10
pjCustomTaskDate10

pjCustomResourceDuration1
pjCustomTaskDuration1

pjCustomResourceDuration2
pjCustomTaskDuration2

pjCustomResourceDuration3
pjCustomTaskDuration3

pjCustomResourceDuration4
pjCustomTaskDuration4

pjCustomResourceDuration5
pjCustomTaskDuration5

pjCustomResourceDuration6
pjCustomTaskDuration6

pjCustomResourceDuration7
pjCustomTaskDuration7

pjCustomResourceDuration8
pjCustomTaskDuration8

pjCustomResourceDuration9
pjCustomTaskDuration9

pjCustomResourceDuration10
pjCustomTaskDuration10

pjCustomResourceFinish1
pjCustomTaskFinish1

pjCustomResourceFinish2
pjCustomTaskFinish2

pjCustomResourceFinish3
pjCustomTaskFinish3

pjCustomResourceFinish4
pjCustomTaskFinish4

pjCustomResourceFinish5
pjCustomTaskFinish5

pjCustomResourceFinish6
pjCustomTaskFinish6

pjCustomResourceFinish7
pjCustomTaskFinish7

pjCustomResourceFinish8
pjCustomTaskFinish8

pjCustomResourceFinish9
pjCustomTaskFinish9

pjCustomResourceFinish10
pjCustomTaskFinish10

pjCustomResourceFlag1
pjCustomTaskFlag1

pjCustomResourceFlag2
pjCustomTaskFlag2

pjCustomResourceFlag3
pjCustomTaskFlag3

pjCustomResourceFlag4
pjCustomTaskFlag4

pjCustomResourceFlag5
pjCustomTaskFlag5

pjCustomResourceFlag6
pjCustomTaskFlag6

pjCustomResourceFlag7
pjCustomTaskFlag7

pjCustomResourceFlag8
pjCustomTaskFlag8

pjCustomResourceFlag9
pjCustomTaskFlag9

pjCustomResourceFlag10
pjCustomTaskFlag10

pjCustomResourceFlag11
pjCustomTaskFlag11

pjCustomResourceFlag12
pjCustomTaskFlag12

pjCustomResourceFlag13
pjCustomTaskFlag13

pjCustomResourceFlag14
pjCustomTaskFlag14

pjCustomResourceFlag15
pjCustomTaskFlag15

pjCustomResourceFlag16
pjCustomTaskFlag16

pjCustomResourceFlag17
pjCustomTaskFlag17

pjCustomResourceFlag18
pjCustomTaskFlag18

pjCustomResourceFlag19
pjCustomTaskFlag19

pjCustomResourceFlag20
pjCustomTaskFlag20

pjCustomResourceNumber1
pjCustomTaskNumber1

pjCustomResourceNumber2
pjCustomTaskNumber2

pjCustomResourceNumber3
pjCustomTaskNumber3

pjCustomResourceNumber4
pjCustomTaskNumber4

pjCustomResourceNumber5
pjCustomTaskNumber5

pjCustomResourceNumber6
pjCustomTaskNumber6

pjCustomResourceNumber7
pjCustomTaskNumber7

pjCustomResourceNumber8
pjCustomTaskNumber8

pjCustomResourceNumber9
pjCustomTaskNumber9

pjCustomResourceNumber10
pjCustomTaskNumber10

pjCustomResourceNumber11
pjCustomTaskNumber11

pjCustomResourceNumber12
pjCustomTaskNumber12

pjCustomResourceNumber13
pjCustomTaskNumber13

pjCustomResourceNumber14
pjCustomTaskNumber14

pjCustomResourceNumber15
pjCustomTaskNumber15

pjCustomResourceNumber16
pjCustomTaskNumber16

pjCustomResourceNumber17
pjCustomTaskNumber17

pjCustomResourceNumber18
pjCustomTaskNumber18

pjCustomResourceNumber19
pjCustomTaskNumber19

pjCustomResourceNumber20
pjCustomTaskNumber20

pjCustomResourceStart1
pjCustomTaskStart1

pjCustomResourceStart2
pjCustomTaskStart2

pjCustomResourceStart3
pjCustomTaskStart3

pjCustomResourceStart4
pjCustomTaskStart4

pjCustomResourceStart5
pjCustomTaskStart5

pjCustomResourceStart6
pjCustomTaskStart6

pjCustomResourceStart7
pjCustomTaskStart7

pjCustomResourceStart8
pjCustomTaskStart8

pjCustomResourceStart9
pjCustomTaskStart9

pjCustomResourceStart10
pjCustomTaskStart10

pjCustomResourceText1
pjCustomTaskText1

pjCustomResourceText2
pjCustomTaskText2

pjCustomResourceText3
pjCustomTaskText3

pjCustomResourceText4
pjCustomTaskText4

pjCustomResourceText5
pjCustomTaskText5

pjCustomResourceText6
pjCustomTaskText6

pjCustomResourceText7
pjCustomTaskText7

pjCustomResourceText8
pjCustomTaskText8

pjCustomResourceText9
pjCustomTaskText9

pjCustomResourceText10
pjCustomTaskText10

pjCustomResourceText11
pjCustomTaskText11

pjCustomResourceText12
pjCustomTaskText12

pjCustomResourceText13
pjCustomTaskText13

pjCustomResourceText14
pjCustomTaskText14

pjCustomResourceText15
pjCustomTaskText15

pjCustomResourceText16
pjCustomTaskText16

pjCustomResourceText17
pjCustomTaskText17

pjCustomResourceText18
pjCustomTaskText18

pjCustomResourceText19
pjCustomTaskText19

pjCustomResourceText20
pjCustomTaskText20

pjCustomResourceText21
pjCustomTaskText21

pjCustomResourceText22
pjCustomTaskText22

pjCustomResourceText23
pjCustomTaskText23

pjCustomResourceText24
pjCustomTaskText24

pjCustomResourceText25
pjCustomTaskText25

pjCustomResourceText26
pjCustomTaskText26

pjCustomResourceText27
pjCustomTaskText27

pjCustomResourceText28
pjCustomTaskText28

pjCustomResourceText29
pjCustomTaskText29

pjCustomResourceText30
pjCustomTaskText30

NewName


Required String. The friendly name for the custom field. A value of Null removes the friendly name.

Phonetic


Optional String. The phonetic equivalent of the friendly name. The Phonetic argument is ignored unless the Japanese version of Microsoft Project is used.

CustomForms Method

Displays the Custom Forms dialog box, which prompts the user to manage custom forms.

Syntax

expression.CustomForms
expression

Optional. An expression that returns an Application object.

Remarks

The CustomForms method has the same effect as the Forms command on the Customize submenu, which is available on the Tools menu.

CustomizeField Method

Displays the Customize Field Names dialog box.

Syntax

expression.CustomizeField
expression

Optional. An expression that returns an Application object.

Remarks

The CustomizeField method has the same effect as the Fields command on the Customize submenu, which is available on the Tools menu.

CustomizeIMEMode Method

Customizes which IME mode is used on a given field.

Syntax

expression.CustomizeIMEMode(FieldID, IMEMode)
expression

Optional. An expression that returns an Application object.

FieldID



Optional Long. The field to customize. The default value is pjTaskName.

Can be one of the following PjField constants:

pjResourceAccrueAt
pjTaskContact

pjResourceActualCost
pjTaskCost

pjResourceActualOvertimeCost
pjTaskCost1

pjResourceActualOvertimeWork
pjTaskCost2

pjResourceActualWork
pjTaskCost3

pjResourceACWP
pjTaskCost4

pjResourceAssignmentDelay
pjTaskCost5

pjResourceAssignmentUnits
pjTaskCost6

pjResourceAvailableFrom
pjTaskCost7

pjResourceAvailableTo
pjTaskCost8

pjResourceBaseCalendar
pjTaskCost9

pjResourceBaselineCost
pjTaskCost10

pjResourceBaselineFinish
pjTaskCostRateTable

pjResourceBaselineStart
pjTaskCostVariance

pjResourceBaselineWork
pjTaskCreated

pjResourceBCWP
pjTaskCritical

pjResourceBCWS
pjTaskCV

pjResourceCanLevel
pjTaskDate1

pjResourceCode
pjTaskDate2

pjResourceConfirmed
pjTaskDate3

pjResourceCost
pjTaskDate4

pjResourceCost1
pjTaskDate5

pjResourceCost2
pjTaskDate6

pjResourceCost3
pjTaskDate7

pjResourceCost4
pjTaskDate8

pjResourceCost5
pjTaskDate9

pjResourceCost6
pjTaskDate10

pjResourceCost7
pjTaskDelay

pjResourceCost8
pjTaskDuration

pjResourceCost9
pjTaskDuration1

pjResourceCost10
pjTaskDuration2

pjResourceCostPerUse
pjTaskDuration3

pjResourceCostRateTable
pjTaskDuration4

pjResourceCostVariance
pjTaskDuration5

pjResourceCV
pjTaskDuration6

pjResourceDate1
pjTaskDuration7

pjResourceDate2
pjTaskDuration8

pjResourceDate3
pjTaskDuration9

pjResourceDate4
pjTaskDuration10

pjResourceDate5
pjTaskDurationVariance

pjResourceDate6
pjTaskEarlyFinish

pjResourceDate7
pjTaskEarlyStart

pjResourceDate8
pjTaskEffortDriven

pjResourceDate9
pjTaskExternalTask

pjResourceDate10
pjTaskFinish

pjResourceDuration1
pjTaskFinish1

pjResourceDuration2
pjTaskFinish2

pjResourceDuration3
pjTaskFinish3

pjResourceDuration4
pjTaskFinish4

pjResourceDuration5
pjTaskFinish5

pjResourceDuration6
pjTaskFinish6

pjResourceDuration7
pjTaskFinish7

pjResourceDuration8
pjTaskFinish8

pjResourceDuration9
pjTaskFinish9

pjResourceDuration10
pjTaskFinish10

pjResourceEMailAddress
pjTaskFinishVariance

pjResourceFinish1
pjTaskFixedCost

pjResourceFinish2
pjTaskFixedCostAccrual

pjResourceFinish3
pjTaskFixedDuration

pjResourceFinish4
pjTaskFlag1

pjResourceFinish5
pjTaskFlag2

pjResourceFinish6
pjTaskFlag3

pjResourceFinish7
pjTaskFlag4

pjResourceFinish8
pjTaskFlag5

pjResourceFinish9
pjTaskFlag6

pjResourceFinish10
pjTaskFlag7

pjResourceFlag1
pjTaskFlag8

pjResourceFlag2
pjTaskFlag9

pjResourceFlag3
pjTaskFlag10

pjResourceFlag4
pjTaskFlag11

pjResourceFlag5
pjTaskFlag12

pjResourceFlag6
pjTaskFlag13

pjResourceFlag7
pjTaskFlag14

pjResourceFlag8
pjTaskFlag15

pjResourceFlag9
pjTaskFlag16

pjResourceFlag10
pjTaskFlag17

pjResourceFlag11
pjTaskFlag18

pjResourceFlag12
pjTaskFlag19

pjResourceFlag13
pjTaskFlag20

pjResourceFlag14
pjTaskFreeSlack

pjResourceFlag15
pjTaskHideBar

pjResourceFlag16
pjTaskHyperlink

pjResourceFlag17
pjTaskHyperlinkAddress

pjResourceFlag18
pjTaskHyperlinkHref

pjResourceFlag19
pjTaskHyperlinkSubAddress

pjResourceFlag20
pjTaskID

pjResourceGroup
pjTaskIndicators

pjResourceHyperlink
pjTaskIsAssignment

pjResourceHyperlinkAddress
pjTaskLateFinish

pjResourceHyperlinkHref
pjTaskLateStart

pjResourceHyperlinkSubAddress
pjTaskLevelAssignments

pjResourceID
pjTaskLevelCanSplit

pjResourceIndicators
pjTaskLevelDelay

pjResourceInitials
pjTaskLinkedFields

pjResourceIsAssignment
pjTaskMarked

pjResourceLevelingDelay
pjTaskMilestone

pjResourceLinkedFields
pjTaskName

pjResourceMaxUnits
pjTaskNotes

pjResourceName
pjTaskNumber1

pjResourceNotes
pjTaskNumber2

pjResourceNumber1
pjTaskNumber3

pjResourceNumber2
pjTaskNumber4

pjResourceNumber3
pjTaskNumber5

pjResourceNumber4
pjTaskNumber6

pjResourceNumber5
pjTaskNumber7

pjResourceNumber6
pjTaskNumber8

pjResourceNumber7
pjTaskNumber9

pjResourceNumber8
pjTaskNumber10

pjResourceNumber9
pjTaskNumber11

pjResourceNumber10
pjTaskNumber12

pjResourceNumber11
pjTaskNumber13

pjResourceNumber12
pjTaskNumber14

pjResourceNumber13
pjTaskNumber15

pjResourceNumber14
pjTaskNumber16

pjResourceNumber15
pjTaskNumber17

pjResourceNumber16
pjTaskNumber18

pjResourceNumber17
pjTaskNumber19

pjResourceNumber18
pjTaskNumber20

pjResourceNumber19
pjTaskObjects

pjResourceNumber20
pjTaskOutlineLevel

pjResourceObjects
pjTaskOutlineNumber

pjResourceOverallocated
pjTaskOverallocated

pjResourceOvertimeCost
pjTaskOvertimeCost

pjResourceOvertimeRate
pjTaskOvertimeWork

pjResourceOvertimeWork
pjTaskPercentComplete

pjResourcePeakUnits
pjTaskPercentWorkComplete

pjResourcePercentWorkComplete
pjTaskPredecessors

pjResourcePhonetics
pjTaskPreleveledFinish

pjResourceProject
pjTaskPreleveledStart

pjResourceRegularWork
pjTaskPriority

pjResourceRemainingCost
pjTaskProject

pjResourceRemainingOvertimeCost
pjTaskRecurring

pjResourceRemainingOvertimeWork
pjTaskRegularWork

pjResourceRemainingWork
pjTaskRemainingCost

pjResourceResponsePending
pjTaskRemainingDuration

pjResourceSheetNotes
pjTaskRemainingOvertimeCost

pjResourceStandardRate
pjTaskRemainingOvertimeWork

pjResourceStart
pjTaskRemainingWork

pjResourceStart1
pjTaskResourceGroup

pjResourceStart2
pjTaskResourceInitials

pjResourceStart3
pjTaskResourceNames

pjResourceStart4
pjTaskResourcePhonetics

pjResourceStart5
pjTaskResponsePending

pjResourceStart6
pjTaskResume

pjResourceStart7
pjTaskResumeNoEarlierThan

pjResourceStart8
pjTaskRollup

pjResourceStart9
pjTaskSheetNotes

pjResourceStart10
pjTaskStart

pjResourceSV
pjTaskStart1

pjResourceTaskSummaryName
pjTaskStart2

pjResourceTeamStatusPending
pjTaskStart3

pjResourceText1
pjTaskStart4

pjResourceText2
pjTaskStart5

pjResourceText3
pjTaskStart6

pjResourceText4
pjTaskStart7

pjResourceText5
pjTaskStart8

pjResourceText6
pjTaskStart9

pjResourceText7
pjTaskStart10

pjResourceText8
pjTaskStartVariance

pjResourceText9
pjTaskStop

pjResourceText10
pjTaskSubproject

pjResourceText11
pjTaskSubprojectReadOnly

pjResourceText12
pjTaskSuccessors

pjResourceText13
pjTaskSummary

pjResourceText14
pjTaskSV

pjResourceText15
pjTaskTeamStatusPending

pjResourceText16
pjTaskText1

pjResourceText17
pjTaskText2

pjResourceText18
pjTaskText3

pjResourceText19
pjTaskText4

pjResourceText20
pjTaskText5

pjResourceText21
pjTaskText6

pjResourceText22
pjTaskText7

pjResourceText23
pjTaskText8

pjResourceText24
pjTaskText9

pjResourceText25
pjTaskText10

pjResourceText26
pjTaskText11

pjResourceText27
pjTaskText12

pjResourceText28
pjTaskText13

pjResourceText29
pjTaskText14

pjResourceText30
pjTaskText15

pjResourceUniqueID
pjTaskText16

pjResourceUpdateNeeded
pjTaskText17

pjResourceWork
pjTaskText18

pjResourceWorkContour
pjTaskText19

pjResourceWorkgroup
pjTaskText20

pjResourceWorkVariance
pjTaskText21

pjTaskActualCost
pjTaskText22

pjTaskActualDuration
pjTaskText23

pjTaskActualFinish
pjTaskText24

pjTaskActualOvertimeCost
pjTaskText25

pjTaskActualOvertimeWork
pjTaskText26

pjTaskActualStart
pjTaskText27

pjTaskActualWork
pjTaskText28

pjTaskACWP
pjTaskText29

pjTaskAssignmentDelay
pjTaskText30

pjTaskAssignmentUnits
pjTaskTotalSlack

pjTaskBaselineCost
pjTaskType

pjTaskBaselineDuration
pjTaskUniqueID

pjTaskBaselineFinish
pjTaskUniquePredecessors

pjTaskBaselineStart
pjTaskUniqueSuccessors

pjTaskBaselineWork
pjTaskUpdateNeeded

pjTaskBCWP
pjTaskWBS

pjTaskBCWS
pjTaskWork

pjTaskConfirmed
pjTaskWorkContour

pjTaskConstraintDate
pjTaskWorkVariance

pjTaskConstraintType


IMEMode


Optional Long. Specifies the IME mode to use when the focus is on a table column. The default value is pjIMEModeNoControl.

Can be one of the following PjIMEMode constants:

pjIMEModeAlpha
pjIMEModeKatakana

pjIMEModeAlphaFull
pjIMEModeKatakanaHalf

pjIMEModeDisable
pjIMEModeNoControl

pjIMEModeHangul
pjIMEModeOff

pjIMEModeHangulFull
pjIMEModeOn

pjIMEModeHiragana


Remarks

The CustomizeIMEMode method only produces tangible results if a Far East version of Microsoft Project is used.

Using the CustomizeIMEMode method without specifying any arguments displays the Customize IME Mode dialog box.

CV Property

Returns the CV for an assignment, resource, or task. Read-only Variant.

DateAdd Method

Adds a duration to a date to return a new date.

Syntax

expression.DateAdd(StartDate, Duration, Calendar)
expression

Required. An expression that returns an Application object.

StartDate


Required Variant. The original date to which the duration is added.

Duration


Required Variant. The duration to add to the start date.

Calendar


Optional Object. A resource or base calendar object. The default value is the calendar of the active project.

DateAdd Method Example

The following example displays the finish date of a three-day task that begins on 7/11/97 at 8 A.M.

Sub FindFinishDate()


MsgBox Application.DateAdd(StartDate:="7/11/97 8:00 AM", Duration:="3d")

End Sub

DateDifference Method

Returns the duration between two dates in minutes.

Syntax

expression.DateDifference(StartDate, FinishDate, Calendar)
expression

Required. An expression that returns an Application object.

StartDate


Required Variant. The date used as the beginning of the duration.

FinishDate

Required Variant. The date used as the end of the duration.

Calendar


Optional Object. A resource base calendar object. The default value is the calendar of the active project.

DateDifference Method Example

The following example displays the duration of a task that begins on 7/11/97 at 8 A.M. and ends on 7/13/97 at 5:00 P.M.

Sub FindDuration()


MsgBox Application.DateDifference ("7/11/97 8:00 AM", "7/13/97 5:00 PM")

End Sub

DateFormat Method

Returns a date in the specified format.

Syntax

expression.DateFormat(Date, Format)
expression

Optional. An expression that returns an Application object.

Date




Required Variant. The date to format.

Format



Optional Long. The date format. The default value is pjDateDefault. Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDateDefault
The default format, as specified on the View tab of the Options dialog box.

pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

DateFormat Method Example

The following example displays the start of the selected task using the format "1/31/97 12:33 PM."

Sub OutputDate()


MsgBox DateFormat(ActiveCell.Task.Start, pjDate_mm_dd_yy_hh_mmAM)

End Sub

Daten Property

Returns or sets the value in an additional date field for an assignment, resource, or task. The n placeholder can be a number from 1 to 10. Read/write Variant.

DateOrder Property

Returns the order in date values of the day, month, and year. Can be one of the following PjDateOrder constants: pjDayMonthYear, pjMonthDayYear, or pjYearMonthDay. Read-only Long.

Remarks

Microsoft Project sets the DateOrder property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

DateSeparator Property

Returns the date separator character. Read-only String.

Remarks

Microsoft Project sets the DateSeparator property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

DateSubtract Method

Returns the date that precedes another date by a specified duration.

Syntax

expression.DateSubtract(FinishDate, Duration, Calendar)
expression

Optional. An expression that returns an Application object.

FinishDate

Required Variant. The date used as the end of the duration.

Duration


Required Variant. The duration to subtract from the finish date.

Calendar


Optional Object. A resource or base calendar object. The default value is the calendar of the active project.

DateSubtract Method Example

The following example displays the start date of a task that lasts three days and ends on 7/13/97 at 5:00 P.M.

Sub FindDuration()


MsgBox DateSubtract("7/13/97 5:00 PM", "3d")

End Sub

Day Object, Days Collection Object

Represents a day or the days in a month. The Day object is a member of the Days collection.

Using the Day Object

Use Days(Index), where Index is the day index number or PjWeekday constant, to return a single Day object. The following example counts the number of working days in the month of September 1997 for each selected resource.

Dim R As Resource, D As Integer, WorkingDays As Integer

For Each R In ActiveSelection.Resources()

    WorkingDays = 0

    With R.Calendar.Years(1997).Months(pjSeptember)

        For D = 1 To .Days.Count

            If .Days(D).Working = True Then

                WorkingDays = WorkingDays + 1

            End If

        Next D

    End With

    MsgBox "There are " & WorkingDays & " working days in " _

        & R.Name & "'s calendar."

Next R

Using the Days Collection

Use the Days property to return a Days collection. The following example counts the number of days in the month of September 1997.

ActiveProject.Calendar.Years(1997).Months(pjSeptember).Days.Count

DayLabelDisplay Property

Returns or sets how the day label displays in durations, delays, slack, work values, and so on. Read/write Integer.

The type of display varies from language to language and is determined by its order in the Days as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
d

1
dy

2
day

DayLeadingZero Property

True if Microsoft Project displays zeros before single-digit days in dates. Read-only Boolean.

Remarks

Microsoft Project sets the DayLeadingZero property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Days Property

Returns a Days collection representing the days in a month. Read-only.

Days Property Example

The following example makes January 1 of every year a nonworking day.

Sub NewYearsDayOff()

    Dim Y As Year

    For Each Y In ActiveProject.Calendar.Years

        Y.Months(pjJanuary).Days(1).Working = False

    Next Y

End Sub

DDEExecute Method

Performs actions or runs commands in another application through dynamic data exchange (DDE).

Syntax

expression.DDEExecute(Command, Timeout)
expression

Optional. An expression that returns an Application object.

Command

Required String. The command to carry out in another application.

Timeout


Optional Variant. The number of seconds to wait for the other application to execute before proceeding. The default value is 5.

Remarks

If your macro displays a dialog box in another application, you may need to increase the default value for Timeout.

DDEInitiate Method

Opens a dynamic data exchange (DDE) channel to an application.

Syntax

expression.DDEInitiate(App, Topic)
expression

Optional. An expression that returns an Application object.

App




Required String. The name of the application to which you want to send commands. 

Topic



Required String. A document in the application to which you want to send commands.

DDELinksUpdate Method

Updates DDE links.

Syntax

expression.DDELinksUpdate
expression

Optional. An expression that returns an Application object.

DDEPasteLink Method

Pastes the contents of the Clipboard into the active selection, establishing a link with the application that supplies the information.

Syntax

expression.DDEPasteLink
expression

Optional. An expression that returns an Application object.

DDETerminate Method

Ends a dynamic data exchange (DDE) session.

Syntax

expression.DDETerminate
expression

Optional. An expression that returns an Application object.

Deactivate Event

Occurs when switching from this project to another project, including when the project is closed. This event is the last event to occur for a project, including the BeforeClose event.

Syntax

Private Sub Project_Deactivate(ByVal pj As MSProject.Project)
pj

The project that was deactivated.

Remarks

When you switch between two windows showing the same project, the Deactivate event for the project doesn't occur.

Microsoft Project events do not occur when the project is embedded in another document or application.

DecimalSeparator Property

Returns the character that separates the whole and fractional parts of a number. Read-only String.

Remarks

Microsoft Project sets the DecimalSeparator property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Default Method

Resets certain elements of a resource calendar (period, years, months, weekdays, days, shifts, working times, and nonworking times) to the values in the corresponding base calendar.

Applying the Default method to a base calendar resets these properties to their default values.

Syntax

expression.Default
expression

Required. An expression that returns an object in the Applies To list.

DefaultAutoFilter Property

True if the AutoFilter feature is active for new projects by default. Read/write Boolean.

DefaultDateFormat Property

Returns or sets the default date format. Read/write Long.

Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

DefaultDurationUnits Property

Returns or sets the default duration units. Can be one of the following PjUnit constants: pjMinute, pjHour, pjDay, or pjWeek. Read/write Long.

DefaultEffortDriven Property

True if new tasks are effort-driven by default. Read/write Boolean.

DefaultFinishTime Property

Returns or sets the default time for finish fields. Read/write Variant.

DefaultFixedCostAccrual Property

Returns or sets the default method used to accrue fixed task costs in the project. Can be one of the following PjAccrueAt constants: pjStart, pjEnd, or pjProrated. Read/write Long.

DefaultResourceOvertimeRate Property

Returns or sets the default overtime rate of pay for resources. Read/write Variant.

DefaultResourceStandardRate Property

Returns or sets the default standard rate of pay for resources. Read/write Variant.

DefaultStartTime Property

Returns or sets the default time for start fields. Read/write Variant.

DefaultTaskType Property

Returns or sets the default task type. Can be one of the following PjTaskFixedType constants: pjFixedDuration, pjFixedTask, or pjFixedWork. Read/write Long.

DefaultView Property

Returns or sets the view that appears when you start Microsoft Project. Read/write String.

Can be one of the following strings:

"Calendar"
"Resource Usage"

"Gantt Chart"
"Task Details Form"

"Leveling Gantt"
"Task Entry"

"PERT Chart"
"Task Form"

"Resource Allocation"
"Task Name Form"

"Resource Form"
"Task PERT"

"Resource Graph"
"Task Sheet"

"Resource Name Form"
"Task Usage"

"Resource Sheet"


DefaultWorkUnits Property

Returns or sets the default work units. Can be one of the following PjUnit constants: pjMinute, pjHour, pjDay, or pjWeek. Read/write Long.

Delay Property

Returns or sets the amount of time an assignment is delayed in minutes. Read/write Variant.

Delete Method

Deletes an object from its containing collection.

Syntax

expression.Delete

expression




Required. An expression that returns an object in the Applies To list.

Remarks

The Delete method does not apply to resource calendars.

Delete Method Example

The following example deletes every resource assignment in the active project.

Sub DeleteAssignments()


Dim RA As Assignment

' Assignment object for resources


Dim T As Task


' Task object


' Delete resource assignments.


For Each T in ActiveProject.Tasks



For Each RA in T.Assignments




RA.Delete


Next RA


Next T

End Sub

DeleteFromDatabase Method

Deletes a project stored in a database.

Syntax

expression.DeleteFromDatabase(Name, UserID, DatabasePassWord, FormatID)
expression




Optional. An expression that returns an Application object.

Name






Required String. The name of the source file or data source to open, and the name of the project to delete from the database.

UserID






Optional String. A user ID to use when accessing the database.

DatabasePassWord

Optional String. A password to use when accessing the database.

FormatID





Optional String. The file or database format. If Microsoft Project recognizes the format of the file specified with Name, FormatID is ignored. Can be one of the following format strings:

Format String
Description




"MSProject.mpd"
Microsoft Project database

"MSProject.odbc"
ODBC database

"MSProject.mdb8"
Microsoft Access 97 (8.0) database

Remarks

The Name argument must contain a file name string, or an ODBC data source name (DSN), and the project name string. The syntax for a data source is <DataSourceName>\Projectname. The less than (<) and greater than (>) symbols must be included and a backslash ( \ ) must separate the data source name from the project name. The DataSourceName itself can either be one of the ODBC data source names installed on the computer, a file DSN, or a path and file name for a file-based database.

For example:

"<Corporate SQL Database>\Factory Construction"

"<C:\MY DOCUMENTS\PROJECT1.MDB>\System Roll-out Plan"

"<C:\Program Files\Common Files\ODBC\Data Sources\Projects Database.dsn>\Project X"

DeleteFromDatabase Method Example

The following example deletes projects from a Microsoft Project database, as specified by the user.

Sub KillProjects()

    Dim PathAndDB As String, ProjectName As String

    Dim Continue As Long    ' Used to store user response

    Continue = vbYes    ' Set to Yes so that loop runs

    PathAndDB = InputBox$("Enter the path and file name of the Microsoft Project" & _

        " database to open, including extension: ")

    Do Until Continue = vbNo

        ProjectName = InputBox$("Enter the name of the project to delete: ")

        DeleteFromDatabase "<" & PathAndDB & ">\" & ProjectName, _

            FormatID:="MSProject.mpd"

        Continue = MsgBox("Project " & ProjectName & " deleted from database." & _

            vbCrLf & vbCrLf & "Delete another?", vbYesNo)

    Loop

End Sub

DetailStylesAdd Method

Adds another timescale data field to a usage view.

Syntax

expression.DetailStylesAdd(Item, Position)
expression


Optional. An expression that returns an Application object.

Item





Optional Long. The timescale data field to add. The default value is pjWork.

If the active view is the Resource Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjOverallocation

pjAllAssignmentRows
pjOvertimeWork

pjAllResourceRows
pjPeakUnits

pjBaselineCost
pjPercentAllocation

pjBaselineWork
pjRegularWork

pjBCWP
pjRemainingAvailability

pjBCWS
pjSV

pjCost
pjWork

If the active view is the Task Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjFixedCost

pjAllAssignmentRows
pjOverallocation

pjAllTaskRows
pjOvertimeWork

pjBaselineCost
pjPctComplete

pjBaselineWork
pjPeakUnits

pjBCWP
pjPercentAllocation

pjBCWS
pjRegularWork

pjCost
pjSV

pjCumPctComplete
pjWork

Position


Optional Integer. The position to add the field, relative to other fields. If Position is n + 2 or greater, where n is the number of fields displayed, the field is added at n +1. The default value is n + 1.

DetailStylesAdd Method Example

The following example makes overallocations stand out from other information in a usage view.

Sub HighlightOverallocations()

    DetailStylesAdd pjOverallocation

    DetailStylesFormat Item:=pjOverallocation, Font:="Arial", Size:=12, _

        Bold:=True, Color:=pjRed, CellColor:=pjBlack, Pattern:=pjSolidFill

End Sub

DetailStylesFormat Method

Sets the format of timescale data fields in a usage view.

Syntax

expression.DetailStylesFormat(Item, Font, Size, Bold, Italic, Underline, Color, CellColor, Pattern, ShowInMenu)
expression

Optional. An expression that returns an Application object.

Item




Optional Long. The timescale data field to format.

If the active view is the Resource Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjOverallocation

pjAllAssignmentRows
pjOvertimeWork

pjAllResourceRows
pjPeakUnits

pjBaselineCost
pjPercentAllocation

pjBaselineWork
pjRegularWork

pjBCWP
pjRemainingAvailability

pjBCWS
pjSV

pjCost
pjWork


If the active view is the Task Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjFixedCost

pjAllAssignmentRows
pjOverallocation

pjAllTaskRows
pjOvertimeWork

pjBaselineCost
pjPctComplete

pjBaselineWork
pjPeakUnits

pjBCWP
pjPercentAllocation

pjBCWS
pjRegularWork

pjCost
pjSV

PjCumPctComplete
pjWork

Font




Optional String. The name of the font.

Size




Optional Integer. The size of the font in points.

Bold




Optional Boolean. True if the font is bold.

Italic




Optional Boolean. True if the font is italic.

Underline


Optional Boolean. True if the font is underlined.

Color



Optional Long. The color of the font. Can be one of the following PjColor constants:

PjAqua
pjNavy

PjBlack
pjOlive

PjBlue
pjPurple

PjFuschia
pjRed

PjGray
pjSilver

PjGreen
pjTeal

PjLime
pjYellow

PjMaroon
pjWhite

CellColor


Optional Long. The color of the cell background. Can be one of the PjColor constants.

Pattern



Optional Long. The pattern for nonworking times. Can be one of the following PjFillPattern constants:

PjDarkFillPattern
pjLineCrossPattern

PjDiagonalCrossPattern
pjLineHorizontalPattern

PjDiagonalLeftPattern
pjLineVerticalPattern

PjDiagonalRightPattern
pjMediumFillPattern

PjHollowPattern
pjSolidFillPattern

PjLightFillPattern


ShowInMenu
Optional Boolean. True if the field specified with Item appears in the shortcut menu. The default value is False.

Remarks

Using the DetailStylesFormat method without specifying any arguments displays the Detail Styles dialog box with the Usage Details tab selected.

DetailStylesFormat Method Example

The following example makes overallocations stand out from other information in a usage view.

Sub HighlightOverallocations()

    DetailStylesAdd pjOverallocation

    DetailStylesFormat Item:=pjOverallocation, Font:="Arial", Size:=12, _

        Bold:=True, Color:=pjRed, CellColor:=pjBlack, Pattern:=pjSolidFill

End Sub

DetailStylesProperties Method

Sets the format of details in a usage view.

Syntax

expression.DetailStylesProperties(AlignCellData, RepeatRowLabel, ShortLabels, DisplayDetailsColumn)
expression





Optional. An expression that returns an Application object.

AlignCellData




Optional Long. Specifies the alignment of data in cells. Can be one of the following PjAlignment constants: pjCenter, pjLeft, or pjRight. The default value is pjRight.

RepeatRowLabel



Optional Boolean. True if details headers are repeated on all assignment rows. The default value is True.

ShortLabels





Optional Boolean. True if Microsoft Project displays short details header names. The default value is True.

DisplayDetailsColumn

Optional Long. Specifies whether a details column displays. Can be one of the following PjYesNoAutomatic constants: pjAuto, pjNo, or pjYes. The default value is pjYes.

Remarks

Using the DetailStylesProperties method without specifying any arguments displays the Detail Styles dialog box with the Usage Properties tab selected.

DetailStylesRemove Method

Removes a timescale data field from a usage view.

Syntax

expression.DetailStylesRemove(Item)
expression





Optional. An expression that returns an Application object.

Item








Optional Long. The timescale data field to remove. The default value is pjWork.

If the active view is the Resource Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjOverallocation

pjAllAssignmentRows
pjOvertimeWork

pjAllResourceRows
pjPeakUnits

pjBaselineCost
pjPercentAllocation

pjBaselineWork
pjRegularWork

pjBCWP
pjRemainingAvailability

pjBCWS
pjSV

pjCost
pjWork

If the active view is the Task Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjFixedCost

pjAllAssignmentRows
pjOverallocation

pjAllTaskRows
pjOvertimeWork

pjBaselineCost
pjPctComplete

pjBaselineWork
pjPeakUnits

pjBCWP
pjPercentAllocation

pjBCWS
pjRegularWork

pjCost
pjSV

pjCumPctComplete
pjWork

DetailStylesRemoveAll Method

Removes all timescale data fields from a usage view.

Syntax

expression.DetailStylesRemoveAll
expression

Optional. An expression that returns an Application object.

DetailStylesToggleItem Method

Toggles the display of a timescale data field in a usage view.

Syntax

expression.DetailStylesToggleItem(Item)
expression

Optional. An expression that returns an Application object.

Item




Optional Long. The timescale data field to show or remove. The default value is pjWork.

If the active view is the Resource Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjOverallocation

pjAllAssignmentRows
pjOvertimeWork

pjAllResourceRows
pjPeakUnits

pjBaselineCost
pjPercentAllocation

pjBaselineWork
pjRegularWork

pjBCWP
pjRemainingAvailability

pjBCWS
pjSV

pjCost
pjWork

If the active view is the Task Usage view, can be one of the following PjTimescaledData constants:

pjActualCost
pjCumulativeCost

pjActualOvertimeWork
pjCumulativeWork

pjActualWork
pjCV

pjACWP
pjFixedCost

pjAllAssignmentRows
pjOverallocation

pjAllTaskRows
pjOvertimeWork

pjBaselineCost
pjPctComplete

pjBaselineWork
pjPeakUnits

pjBCWP
pjPercentAllocation

pjBCWS
pjRegularWork

pjCost
pjSV

pjCumPctComplete
pjWork

DisplayAlerts Property

True if Microsoft Project displays error messages when a macro runs. Read/write Boolean.

Remarks

The DisplayAlerts property is reset to True upon completion of a macro that sets it to False.

DisplayEntryBar Property

True if the entry bar is visible. Read/write Boolean.

DisplayOLEIndicator Property

True if an indicator appears in cells containing an OLE link. Read/write Boolean.

DisplayPlanningWizard Property

True if the PlanningWizard is active. Read/write Boolean.

DisplayPlanningWizard Property Example

The following example resets the PlanningWizard to its default settings.

Sub ResetWizard()


Application.DisplayPlanningWizard = True


Application.DisplayWizardErrors = True


Application.DisplayWizardScheduling = True


Application.DisplayWizardUsage = True

End Sub

DisplayProjectSummaryTask Property

True if the summary task for a project is visible. Read/write Boolean.

DisplayProjectSummaryTask Property Example

The following example creates a new project and displays its summary task.

Sub NewProject()


FileNew


ActiveProject.DisplayProjectSummaryTask = True

End Sub

DisplayRecentFiles Property

True if a list of recently used files appears on the File menu. Read/write Boolean.

DisplayScheduleMessages Property

True if messages appear when scheduling problems occur. Read/write Boolean.

DisplayScrollBars Property

True if the scroll bars are visible for all projects. Read/write Boolean.

DisplayScrollBars Property Example

The following example changes the setting of the DisplayScrollBars property.

Sub ChangeDisplayScrollBars


DisplayScrollBars = Not DisplayScrollBars
End Sub

DisplayStatusBar Property

True if the status bar is displayed. Read/write Boolean.

DisplayViewBar Property

True if the View Bar displays. Read/write Boolean.

DisplayWizardErrors Property

True if the PlanningWizard displays messages about errors. Read/write Boolean.

DisplayWizardErrors Property Example

The following example resets the PlanningWizard to its default settings.

Sub ResetWizard()


Application.DisplayPlanningWizard = True


Application.DisplayWizardErrors = True


Application.DisplayWizardScheduling = True


Application.DisplayWizardUsage = True

End Sub

DisplayWizardScheduling Property

True if the PlanningWizard displays messages about scheduling problems. Read/write Boolean.

DisplayWizardScheduling Property Example

The following example resets the PlanningWizard to its default settings.

Sub ResetWizard()


Application.DisplayPlanningWizard = True


Application.DisplayWizardErrors = True


Application.DisplayWizardScheduling = True


Application.DisplayWizardUsage = True

End Sub

DisplayWizardUsage Property

True if the PlanningWizard displays tips about using Microsoft Project more effectively. Read/write Boolean.

DisplayWizardUsage Property Example

The following example resets the PlanningWizard to its default settings.

Sub ResetWizard()


Application.DisplayPlanningWizard = True


Application.DisplayWizardErrors = True


Application.DisplayWizardScheduling = True


Application.DisplayWizardUsage = True

End Sub

DocClose Method

Closes the active project.

Syntax

expression.DocClose
expression

Optional. An expression that returns an Application object.

DocMaximize Method

Maximizes the window of the active project.

Syntax

expression.DocMaximize
expression

Optional. An expression that returns an Application object.

DocMove Method

Moves the active window within the application window.

Syntax

expression.DocMove(XPosition, YPosition, Points)
expression

Optional. An expression that returns an Application object.

XPosition


Optional Long. A number that specifies the distance of the active window from the left edge of the application.

YPosition


Optional Long. A number that specifies the distance of the active window from the top edge of the application.

Points



Optional Boolean. True if XPosition and YPosition are measured in points. False if they are measured in pixels. The default value is False.

Remarks

The positions specified are taken from the upper-left corner of the usable area of the application window. The usable area is the area remaining after removing the menu bar and toolbars.  

DocMove Method Example

The following example moves the window of the active project to the upper-left corner of the main window.

Sub MoveProjectWindowToCorner()


DocMove 0, 0

End Sub

DocRestore Method

Sets the active window to its last nonmaximized state.

Syntax

expression.DocRestore
expression

Optional. An expression that returns an Application object.

DocSize Method

Sets the width and height of the active window.

Syntax

expression.DocSize(Width, Height, Points)
expression

Optional. An expression that returns an Application object.

Width



Optional Long. A number that specifies the new width of the active window.

Height



Optional Long. A number that specifies the new height of the active window.

Points



Optional Boolean. True if Width and Height are measured in points. False if they are measured in pixels. The default value is False.

DocSize Method Example

The following example tiles the windows of open projects vertically within the main window of Microsoft Project.

Sub TileProjectWindowsVertically()

    Dim I As Long   ' Index used in For...Next loop

    For I = 1 To Application.Windows.Count

        Windows(I).Activate

        DocSize Width:=UsableWidth / Windows.Count, Height:=UsableHeight, Points:=True

        DocMove XPosition:=(I - 1) * UsableWidth / Windows.Count, YPosition:=0, Points:=True

    Next I

End Sub

DrawingCreate Method

Creates a drawing.

Syntax

expression.DrawingCreate(Type, Behind)
expression

Optional. An expression that returns an Application object.

Type




Required Long. The type of drawing to create. Can be one of the following PjShape constants: pjOLEObject, pjLine, pjArrow, pjRectangle, pjEllipse, pjArc, pjPolygon, or pjTextBox.

Behind



Optional Boolean. True if the drawing is created behind task bars. The default value is False.

DrawingCycleColor Method

Changes the color of the active drawing object.

Syntax

expression.DrawingCycleColor
expression

Optional. An expression that returns an Application object.

Remarks

The DrawingCycleColor method has the same effect as the Cycle Fill Color button on the Drawing toolbar.

DrawingMove Method

Moves the active drawing object forward or backward in the drawing layers.

Syntax

expression.DrawingMove(Forward, Full)
expression

Optional. An expression that returns an Application object.

Forward


Optional Boolean. True if the active drawing object moves forward in the drawing layers. The default value is False.

Full




Optional Boolean. True if the active drawing object moves the full extent of the direction specified with Forward. False if the object moves only one layer. The default value is False.

DrawingProperties Method

Displays the Format Drawing dialog box, which prompts the user to customize the active drawing object.

Syntax

expression.DrawingProperties(SizePositionTab)
expression



Optional. An expression that returns an Application object.

SizePositionTab

Optional Boolean. True if the Size & Position tab of the Format Drawing dialog box appears. False if the Line & Fill tab appears.

Remarks

The DrawingProperties method displays an error unless a drawing object is active.

The DrawingProperties method has the same effect as the Properties command on the Drawing submenu, which is on the Format menu.

DrawingReshape Method

Toggles the drawing mode between resize and reshape.

Syntax

expression.DrawingReshape
expression

Optional. An expression that returns an Application object.

Remarks

The DrawingReshape method has the same effect as the Edit Points command on the Draw menu of the Drawing toolbar.

DrawingToolbarShow Method

Displays the Drawing toolbar, if it is not visible. When the Drawing toolbar is displayed, this method will change it to a floating toolbar from a docked toolbar.

Syntax

expression.DrawingToolbarShow
expression

Optional. An expression that returns an Application object.

Duration Property

Returns or sets the duration (in minutes) of a task.  Read-only for summary tasks. Read/write Variant.

DurationFormat Method

Returns a duration in the specified units.

Syntax

expression.DurationFormat(Duration, Units)
expression

Optional. An expression that returns an Application object.

Duration


Required Variant. The duration to be expressed.

Units



Required Long. The units used to express the duration. Can be one of the following PjFormatUnit constants: pjMinutes, pjHours, pjDays, pjWeeks, pjElapsedMinutes, pjElapsedHours, pjElapsedDays, or pjElapsedWeeks.

Remarks

The time label that appears next to the duration uses the format specified by the Show timescale as setting on the Edit tab of the Options dialog box, where timescale is "minutes", "hours", "days", "weeks", or "years".

For example, if Duration is "2w", Units is pjDays, and the Show days as setting is "day", the DurationFormat method returns "10 days".

DurationFormat Method Example

The following example displays the duration of the selected task in weeks.

Sub DurationInWeeks()


MsgBox DurationFormat(ActiveCell.Task.Duration, pjWeeks)

End Sub

Durationn Property

Returns or sets the value of an additional duration field for an assignment, resource, or task. The n placeholder can be a number from 1 to 10. Read/write Variant.

DurationValue Method

Returns the number of minutes in a duration.

Syntax

expression.DurationValue(Duration)
expression

Optional. An expression that returns an Application object.

Duration


Required String. The duration to be expressed in minutes.

DurationValue Method Example

The following example adds the entered value to the duration of the selected task.

Sub DurationAdder()

    Dim Temp As String

    Temp = InputBox$("Enter amount by which to increase the duration:")

    ActiveCell.Task.Duration = ActiveCell.Task.Duration + DurationValue(Temp)

End Sub

DurationVariance Property

Returns the variance (in minutes) between the planned duration and the duration of a task. Read-only Variant.

EarlyFinish Property

Returns the earliest date on which a task can finish. Read-only Variant.

EarlyStart Property

Returns the earliest date on which a task can start. Read-only Variant.

EditClear Method

Clears the selected cells.

Syntax

expression.EditClear(Contents, Formats, Notes)
expression

Optional. An expression that returns an Application object.

Contents


Optional Boolean. True if the contents of the selected cells are cleared. The default value is True.

Formats


Optional Boolean. True if the formats of the selected cells are cleared. The default value is False.

Notes



Optional Boolean. True if the notes of the assignment, resource, or task in the selected cells are cleared. The default value is False.

EditClear Method Example

The following example clears the contents, formats, and notes of the selected cells.

Sub ClearAll()


EditClear True, True, True

End Sub

EditClearFormats Method

Clears the format of the active cells.

Syntax

expression.EditClearFormats
expression

Optional. An expression that returns an Application object.

Remarks

The EditClearFormats method has the same effect as the Formats command on the Clear submenu, which is found on the Edit menu.

EditClearHyperlink Method

Clears the Hyperlink, Hyperlink Address, Hyperlink SubAddress, and HyperlinkHREF fields of the selected assignment, resource, or task.

Syntax

expression.EditClearHyperlink
expression

Optional. An expression that returns an Application object.

EditCopy Method

Copies data.

Syntax

expression.EditCopy

expression

Optional. An expression that returns an Application object. 

EditCopyPicture Method

Copies the active view as a picture or an OLE object, or exports the active view to a GIF image file.

Syntax

expression.EditCopyPicture(Object, ForPrinter, FileName, SelectedRows, FromDate, ToDate)
expression

Optional. An expression that returns an Application object.

Object



Optional Boolean. True if the view should be copied as an OLE object. The default value is False.

ForPrinter


Optional Long. Specifies where to copy the view. Can be one of the following PjCopyPictureFor constants: pjScreen, pjPrinter, pjGIF. If Object is True, ForPrinter is ignored. The default value is pjScreen.

FileName



Optional String. The file name for the GIF image file. If ForPrinter is pjGIF, FileName is required. If Object is True, or ForPrinter is not pjGIF, FileName is ignored.

SelectedRows

Optional Boolean. True if Microsoft Project copies only the selected rows. False if the program copies all visible rows.

FromDate



Optional Variant. The beginning of the timescale for the copied picture. If Object is True, FromDate is ignored. If FromDate is specified and ToDate is not, Microsoft Project will use the last entered date for the end of the timescale. If that would create a negative time span, the program will use the latest timescale date visible in the active view. The default value is the earliest timescale date visible in the active view.

ToDate




Optional Variant. The end of the timescale for the copied picture. If Object is True, ToDate is ignored. If ToDate is specified and FromDate is not, Microsoft Project will use the last entered date for the beginning of the timescale. If that would create a negative time span, the program will use the earliest timescale date visible in the active view. The default value is the latest timescale date visible in the active view.

Remarks

Using the EditCopyPicture method without specifying any arguments displays the Copy Picture dialog box.

EditCut Method

Cuts the selected items.

Syntax

expression.EditCut
expression


Optional. An expression that returns an Application object.

EditDelete Method

Deletes the selected row, selected column, or row containing the active cell from the active view. If a column is deleted, the data displayed in that column is unaffected; otherwise, the data is also deleted.

Syntax

expression.EditDelete
expression


Optional. An expression that returns an Application object.

EditGoto Method

Scrolls to a resource, task, or date.

Syntax

expression.EditGoto(ID, Date)
expression


Optional. An expression that returns an Application object.

ID






Optional Long. A number that specifies the identification number of the task or resource to display in the active pane.

Date





Optional Variant. A number or string that specifies the first date to display in the active pane.

EditGoto Method Example

The following example prompts the user for a date or a task name, and then scrolls to that date or task in the active pane. It assumes the user is in a task view.

Sub PromptUserForEditGotoArguments()

       Dim Entry As String     ' Date or task name entered by user.

       Entry = InputBox$("Enter a data or a task name to which you want" _

               & " to scroll in the active pane.")

       ' If user enters a date, scroll to a date in the active pane.

       If IsDate(Entry) Then

        EditGoTo Date:=Entry

       ' Otherwise, scroll to a task in the active pane.

       Else

        EditGoTo ID:=ActiveProject.Tasks(Entry).ID

       End If

   End Sub

EditHyperlink Method

Edits the hyperlink of the selected assignment, resource, or task.

Syntax

expression.EditHyperlink(Name, Address, SubAddress)
expression


Optional. An expression that returns an Application object.

Name




Optional String. The name of the hyperlink as it appears in the Hyperlink field.

Address



Optional String. The address of the target document.

SubAddress


Optional String. A location within the target document.

Remarks

Using the EditHyperlink method without specifying any arguments displays the Edit Hyperlink dialog box.

EditInsert Method

If a column is selected, brings up the Column Definition dialog box; otherwise, inserts a new row above the selected row or the row containing the active cell.

Syntax

expression.EditInsert
expression


Optional. An expression that returns an Application object.

EditPaste Method

Pastes the contents of the Clipboard into the active selection.

Syntax

expression.EditPaste
expression


Optional. An expression that returns an Application object.

EditPasteAsHyperlink Method

Pastes a hyperlink to the source of the contents of the Clipboard.

Syntax

expression.EditPasteAsHyperlink
expression


Optional. An expression that returns an Application object.

EditPasteSpecial Method

Copies or links data from the Clipboard into the active selection.

Syntax

expression.EditPasteSpecial(Link, Type, DisplayAsIcon)
expression


Optional. An expression that returns an Application object.

Link





Optional Boolean. True if the data is linked to its source application.

Type





Optional Integer. A numeric value specifying the type of object to paste or link. The Type argument can be one of the following PjPasteSpecialType constants:

Constant
Description

 


pjEmbedObject
Embedded object

pjPicture
Picture

pjTextData
Text data

pjProjectData
Project data

DisplayAsIcon

Optional Boolean. True if the object appears as an icon.

EffectiveDate Property

Returns the date a pay rate for a resource goes into effect. Read-only Variant.

EffortDriven Property

True if the task is effort-driven. Read/write Boolean.

EMailAddress Property

Returns or sets the electronic mail address of a resource. Read/write String.

EnableCancelKey Property

Returns or sets how CTRL+BREAK is handled when a macro is running. Read/write Long.

Can be one of the following PjEnableCancelKey constants:

Constant
Description

 


pjDisabled
CTRL+BREAK is ignored.

PjErrorHandler
Sends the interrupt to the macro as a trappable error. The error code is 18.

PjInterrupt
CTRL+BREAK interrupts the macro.

EnableCancelKey Property Example

This example shows how you can use the EnableCancelKey property to set up a custom cancellation handler.

Sub CancelOperation()

    Dim X As Long

    On Error GoTo handleCancel

    Application.EnableCancelKey = pjErrorHandler

    MsgBox "This may take a long time; press CTRL+BREAK to cancel."

    For X = 1 To 300000000

        ' Do something here.

    Next X

handleCancel:

    If Err = 18 Then

        MsgBox "Operation cancelled"

    End If

End Sub

EndDate Property

The end date for a period of time that defines a timescale data unit. Read-only Variant.

ExternalTask Property

True if the task is actually a placeholder for a task in another project. Read-only Boolean.

FieldID Property

Returns the identification number of the task or resource field in the active cell. Read-only Long.

If the active cell contains a task, can be one of the following PjField constants:

pjTaskActualCost
pjTaskLinkedFields

pjTaskActualDuration
pjTaskMarked

pjTaskActualFinish
pjTaskMilestone

pjTaskActualOvertimeCost
pjTaskName

pjTaskActualOvertimeWork
pjTaskNotes

pjTaskActualStart
pjTaskNumber1

pjTaskActualWork
pjTaskNumber2

pjTaskACWP
pjTaskNumber3

pjTaskAssignmentDelay
pjTaskNumber4

pjTaskAssignmentUnits
pjTaskNumber5

pjTaskBaselineCost
pjTaskNumber6

pjTaskBaselineDuration
pjTaskNumber7

pjTaskBaselineFinish
pjTaskNumber8

pjTaskBaselineStart
pjTaskNumber9

pjTaskBaselineWork
pjTaskNumber10

pjTaskBCWP
pjTaskNumber11

pjTaskBCWS
pjTaskNumber12

pjTaskConfirmed
pjTaskNumber13

pjTaskConstraintDate
pjTaskNumber14

pjTaskConstraintType
pjTaskNumber15

pjTaskContact
pjTaskNumber16

pjTaskCost
pjTaskNumber17

pjTaskCost1
pjTaskNumber18

pjTaskCost2
pjTaskNumber19

pjTaskCost3
pjTaskNumber20

pjTaskCost4
pjTaskObjects

pjTaskCost5
pjTaskOutlineLevel

pjTaskCost6
pjTaskOutlineNumber

pjTaskCost7
pjTaskOverallocated

pjTaskCost8
pjTaskOvertimeCost

pjTaskCost9
pjTaskOvertimeWork

pjTaskCost10
pjTaskPercentComplete

pjTaskCostRateTable
pjTaskPercentWorkComplete

pjTaskCostVariance
pjTaskPredecessors

pjTaskCreated
pjTaskPreleveledFinish

pjTaskCritical
pjTaskPreleveledStart

pjTaskCV
pjTaskPriority

pjTaskDate1
pjTaskProject

pjTaskDate2
pjTaskRecurring

pjTaskDate3
pjTaskRegularWork

pjTaskDate4
pjTaskRemainingCost

pjTaskDate5
pjTaskRemainingDuration

pjTaskDate6
pjTaskRemainingOvertimeCost

pjTaskDate7
pjTaskRemainingOvertimeWork

pjTaskDate8
pjTaskRemainingWork

pjTaskDate9
pjTaskResourceGroup

pjTaskDate10
pjTaskResourceInitials

pjTaskDelay
pjTaskResourceNames

pjTaskDuration
pjTaskResourcePhonetics

pjTaskDuration1
pjTaskResponsePending

pjTaskDuration2
pjTaskResume

pjTaskDuration3
pjTaskResumeNoEarlierThan

pjTaskDuration4
pjTaskRollup

pjTaskDuration5
pjTaskSheetNotes

pjTaskDuration6
pjTaskStart

pjTaskDuration7
pjTaskStart1

pjTaskDuration8
pjTaskStart2

pjTaskDuration9
pjTaskStart3

pjTaskDuration10
pjTaskStart4

pjTaskDurationVariance
pjTaskStart5

pjTaskEarlyFinish
pjTaskStart6

pjTaskEarlyStart
pjTaskStart7

pjTaskEffortDriven
pjTaskStart8

pjTaskExternalTask
pjTaskStart9

pjTaskFinish
pjTaskStart10

pjTaskFinish1
pjTaskStartVariance

pjTaskFinish2
pjTaskStop

pjTaskFinish3
pjTaskSubproject

pjTaskFinish4
pjTaskSubprojectReadOnly

pjTaskFinish5
pjTaskSuccessors

pjTaskFinish6
pjTaskSummary

pjTaskFinish7
pjTaskSV

pjTaskFinish8
pjTaskTeamStatusPending

pjTaskFinish9
pjTaskText1

pjTaskFinish10
pjTaskText2

pjTaskFinishVariance
pjTaskText3

pjTaskFixedCost
pjTaskText4

pjTaskFixedCostAccrual
pjTaskText5

pjTaskFixedDuration
pjTaskText6

pjTaskFlag1
pjTaskText7

pjTaskFlag2
pjTaskText8

pjTaskFlag3
pjTaskText9

pjTaskFlag4
pjTaskText10

pjTaskFlag5
pjTaskText11

pjTaskFlag6
pjTaskText12

pjTaskFlag7
pjTaskText13

pjTaskFlag8
pjTaskText14

pjTaskFlag9
pjTaskText15

pjTaskFlag10
pjTaskText16

pjTaskFlag11
pjTaskText17

pjTaskFlag12
pjTaskText18

pjTaskFlag13
pjTaskText19

pjTaskFlag14
pjTaskText20

pjTaskFlag15
pjTaskText21

pjTaskFlag16
pjTaskText22

pjTaskFlag17
pjTaskText23

pjTaskFlag18
pjTaskText24

pjTaskFlag19
pjTaskText25

pjTaskFlag20
pjTaskText26

pjTaskFreeSlack
pjTaskText27

pjTaskHideBar
pjTaskText28

pjTaskHyperlink
pjTaskText29

pjTaskHyperlinkAddress
pjTaskText30

pjTaskHyperlinkHref
pjTaskTotalSlack

pjTaskHyperlinkSubAddress
pjTaskType

pjTaskID
pjTaskUniqueID

pjTaskIndicators
pjTaskUniquePredecessors

pjTaskIsAssignment
pjTaskUniqueSuccessors

pjTaskLateFinish
pjTaskUpdateNeeded

pjTaskLateStart
pjTaskWBS

pjTaskLevelAssignments
pjTaskWork

pjTaskLevelCanSplit
pjTaskWorkContour

pjTaskLevelDelay
pjTaskWorkVariance

If the active cell contains a resource, can be one of the following PjField constants:

pjResourceAccrueAt
pjResourceIsAssignment

pjResourceActualCost
pjResourceLevelingDelay

pjResourceActualOvertimeCost
pjResourceLinkedFields

pjResourceActualOvertimeWork
pjResourceMaxUnits

pjResourceActualWork
pjResourceName

pjResourceACWP
pjResourceNotes

pjResourceAssignmentDelay
pjResourceNumber1

pjResourceAssignmentUnits
pjResourceNumber2

pjResourceAvailableFrom
pjResourceNumber3

pjResourceAvailableTo
pjResourceNumber4

pjResourceBaseCalendar
pjResourceNumber5

pjResourceBaselineCost
pjResourceNumber6

pjResourceBaselineFinish
pjResourceNumber7

pjResourceBaselineStart
pjResourceNumber8

pjResourceBaselineWork
pjResourceNumber9

pjResourceBCWP
pjResourceNumber10

pjResourceBCWS
pjResourceNumber11

pjResourceCanLevel
pjResourceNumber12

pjResourceCode
pjResourceNumber13

pjResourceConfirmed
pjResourceNumber14

pjResourceCost
pjResourceNumber15

pjResourceCost1
pjResourceNumber16

pjResourceCost2
pjResourceNumber17

pjResourceCost3
pjResourceNumber18

pjResourceCost4
pjResourceNumber19

pjResourceCost5
pjResourceNumber20

pjResourceCost6
pjResourceObjects

pjResourceCost7
pjResourceOverallocated

pjResourceCost8
pjResourceOvertimeCost

pjResourceCost9
pjResourceOvertimeRate

pjResourceCost10
pjResourceOvertimeWork

pjResourceCostPerUse
pjResourcePeakUnits

pjResourceCostRateTable
pjResourcePercentWorkComplete

pjResourceCostVariance
pjResourcePhonetics

pjResourceCV
pjResourceProject

pjResourceDate1
pjResourceRegularWork

pjResourceDate2
pjResourceRemainingCost

pjResourceDate3
pjResourceRemainingOvertimeCost

pjResourceDate4
pjResourceRemainingOvertimeWork

pjResourceDate5
pjResourceRemainingWork

pjResourceDate6
pjResourceResponsePending

pjResourceDate7
pjResourceSheetNotes

pjResourceDate8
pjResourceStandardRate

pjResourceDate9
pjResourceStart

pjResourceDate10
pjResourceStart1

pjResourceDuration1
pjResourceStart2

pjResourceDuration2
pjResourceStart3

pjResourceDuration3
pjResourceStart4

pjResourceDuration4
pjResourceStart5

pjResourceDuration5
pjResourceStart6

pjResourceDuration6
pjResourceStart7

pjResourceDuration7
pjResourceStart8

pjResourceDuration8
pjResourceStart9

pjResourceDuration9
pjResourceStart10

pjResourceDuration10
pjResourceSV

pjResourceEMailAddress
pjResourceTaskSummaryName

pjResourceFinish1
pjResourceTeamStatusPending

pjResourceFinish2
pjResourceText1

pjResourceFinish3
pjResourceText2

pjResourceFinish4
pjResourceText3

pjResourceFinish5
pjResourceText4

pjResourceFinish6
pjResourceText5

pjResourceFinish7
pjResourceText6

pjResourceFinish8
pjResourceText7

pjResourceFinish9
pjResourceText8

pjResourceFinish10
pjResourceText9

pjResourceFlag1
pjResourceText10

pjResourceFlag2
pjResourceText11

pjResourceFlag3
pjResourceText12

pjResourceFlag4
pjResourceText13

pjResourceFlag5
pjResourceText14

pjResourceFlag6
pjResourceText15

pjResourceFlag7
pjResourceText16

pjResourceFlag8
pjResourceText17

pjResourceFlag9
pjResourceText18

pjResourceFlag10
pjResourceText19

pjResourceFlag11
pjResourceText20

pjResourceFlag12
pjResourceText21

pjResourceFlag13
pjResourceText22

pjResourceFlag14
pjResourceText23

pjResourceFlag15
pjResourceText24

pjResourceFlag16
pjResourceText25

pjResourceFlag17
pjResourceText26

pjResourceFlag18
pjResourceText27

pjResourceFlag19
pjResourceText28

pjResourceFlag20
pjResourceText29

pjResourceGroup
pjResourceText30

pjResourceHyperlink
pjResourceUniqueID

pjResourceHyperlinkAddress
pjResourceUpdateNeeded

pjResourceHyperlinkHref
pjResourceWork

pjResourceHyperlinkSubAddress
pjResourceWorkContour

pjResourceID
pjResourceWorkgroup

pjResourceIndicators
pjResourceWorkVariance

pjResourceInitials


FieldIDList Property

Returns a List object representing all field identification numbers for the selected fields. Read-only.

FieldName Property

Returns the title of the field in the active cell. If a title does not exist, then the name of the field is returned.  Read-only String.

FieldNameList Property

Returns a List object representing the field names (or field titles, if available) for all selected fields. Read-only.

FileClose Method

Closes the active project.

Syntax

expression.FileClose(Save, NoAuto)
expression

Optional. An expression that returns an Application object.

Save




Optional Long. Can be one of the following PjSave constants: pjDoNotSave, pjSave, or pjPromptSave. The default value is pjPromptSave for new project files and projects that have changed since the last save.

NoAuto


Optional Boolean. True if an Auto_Close macro is not run and the Close event is not raised. The default value is False.

FileClose Method Example

The following example saves and closes the active project.

Sub SaveAndCloseActiveProject()


FileClose pjSave

End Sub

FileCloseAll Method

Closes all projects.

Syntax

expression.FileCloseAll(Save)
expression

Optional. An expression that returns an Application object.

Save




Optional Long. Can be one of the following PjSave constants: pjDoNotSave, pjSave, or pjPromptSave. The default value is pjPromptSave for new project files and projects that have changed since the last save.

FileExit Method

Quits Microsoft Project.

Syntax

expression.FileExit(Save)
expression

Optional. An expression that returns an Application object.

Save




Optional Long. Can be one of the following PjSave constants: pjDoNotSave, pjSave, or pjPromptSave. The default value is pjPromptSave for new project files and projects that have changed since the last save.

FileExit Method Example

The following example quits Microsoft Project after prompting the user to save each open project.

Sub QuitProject()


FileExit
End Sub

FileLoadLast Method

Opens one of the last nine most recently used files.

Syntax

expression.FileLoadLast(Number)
expression

Optional. An expression that returns an Application object.

Number


Optional Integer. A number from 1 to 9 that specifies which of the nine most recently used files to open.

FileLoadLast Method Example

The following example opens the nine most recently used files. It assumes the Recently Used File List option has been selected.

Sub OpenThe9MRUFiles()

    Dim I As Integer    ' Index used in For...Next loop

    For I = 1 To 9

        FileLoadLast I

        ' Ignores errors that may be due to missing files.

        On Error Resume Next

    Next I

End Sub

FileNew Method

Creates a new project.

Syntax

expression.FileNew(SummaryInfo)
expression


Optional. An expression that returns an Application object.

SummaryInfo

Optional Boolean. True if the Project Information dialog box is displayed when creating the project. The default is equal to the corresponding setting on the General tab of the Options dialog box.

FileOpen Method

Opens a project or imports data.

Syntax

expression.FileOpen(Name, ReadOnly, Merge, TaskInformation, Table, Sheet, NoAuto, UserID, DatabasePassWord, FormatID, Map, OpenPool)
expression




Optional. An expression that returns an Application object.

Name






Required String. The name of the project file, source file, or data source to open.

ReadOnly





Optional Boolean. True if the file is opened read-only. If selectively importing data instead of loading a complete project, ReadOnly is ignored.

Merge






Optional Long. Specifies whether to automatically merge the file with the active project. If Map is specified, Merge is ignored. Can be one of the following PjMerge constants: pjDoNotMerge, pjMerge, pjAppend, or pjPrompt. The default value is pjDoNotMerge.

TaskInformation


Optional Boolean. True if the file contains information on tasks, for a project saved under a non-Microsoft Project file format. False if the file contains information on resources. If Map is specified, TaskInformation is ignored. The default value is True if the active view is a task view; otherwise it is False.

Table






Optional String. The name of a table in which to place the resource or task information, for a project saved under a non-Microsoft Project file format. If Map is specified, or Name specifies a database file or format, Table is ignored. The default value for Table is the name of the active table.

Sheet






Optional String. The sheet to read when opening a workbook created in Microsoft Excel version 5.0 or later. If Map is specified, or if the file specified with Name is not a Microsoft Excel file, Sheet is ignored.

NoAuto





Optional Boolean. True if any Auto_Open macro is prevented from running. The default value is False.

UserID

Optional String. A user ID to use when accessing a database. If Name or FormatID isn't a database, UserID is ignored.

DatabasePassWord

Optional String. A password to use when accessing a database. If Name or FormatID isn't a database, DatabasePassWord is ignored.

FormatID





Optional String. The file or database format. If Microsoft Project recognizes the format of the file specified with Name, FormatID is ignored. Can be one of the following format strings:

Format String
Description




"MSProject.mpp"
Microsoft Project file

"MSProject.mpt"
Microsoft Project template

"MSProject.mpd"
Microsoft Project database

"MSProject.mpw"
Microsoft Project workspace

"MSProject.mpx"
Microsoft Project 4.0 MPX file

"MSProject.odbc"
ODBC database

"MSProject.xls5"
Microsoft Excel 5.0/95 (7.0) workbook

"MSProject.xls8"
Microsoft Excel 97 (8.0) workbook

"MSProject.mdb8"
Microsoft Access 97 (8.0) database

"MSProject.csv"
CSV file

"MSProject.txt"
TXT file

Map







Optional String. The name of the import/export map to use when importing data.

OpenPool





Optional Long. The action to take when opening a resource pool or sharer file. Can be one of the following PjPoolOpen constants: pjPromptPool, pjPoolReadOnly, pjPoolReadWrite, pjPoolAndShares, or pjDoNotOpenPool. The default value is pjPromptPool.

Remarks

Using the FileOpen method without specifying any arguments displays the File Open dialog box.

The Name argument can contain a file name string or an ODBC data source name (DSN) and project name string. The syntax for a data source is <DataSourceName>\Projectname. The less than (<) and greater than (>) symbols must be included and a backslash ( \ ) must separate the data source name from the project name. The DataSourceName itself can either be one of the ODBC data source names installed on the machine, a file DSN, or a path and file name for a file-based database.

For example:

"<Corporate SQL Database>\Factory Construction"

"<C:\MY DOCUMENTS\PROJECT1.MDB>\System Roll-out Plan"

"<C:\Program Files\Common Files\ODBC\Data Sources\Projects Database.dsn>\Project X"

FilePageSetup Method

Displays the Page Setup dialog box. Equivalent to clicking Page Setup on the File menu.

Syntax

expression.FilePageSetup(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the view for which to set up pages for printing. The default value is the name of the active view.

FilePageSetupCalendar Method

Sets up the Calendar for printing.

Syntax

expression.FilePageSetupCalendar(Name, MonthsPerPage, WeeksPerPage, ScreenWeekHeight, OnlyDaysInMonth, OnlyWeeksInMonth, MonthPreviews, MonthTitle, AdditionalTasks, GroupAdditionalTasks, PrintNotes)
expression





Optional. An expression that returns an Application object.

Name







Optional String. The name of the calendar to edit.

MonthsPerPage



Optional Integer. The number of months to print on each page. Can be 1 or 2. The MonthsPerPage argument is required if OnlyDaysInMonth or OnlyWeeksInMonth is specified.

WeeksPerPage




Optional Integer. The number of weeks to print on each page.

ScreenWeekHeight


Optional Boolean. True if the week height displayed on screen is used for the printout.

OnlyDaysInMonth


Optional Boolean. True if only the days in the month are printed. False if the days at the end of the previous month and at the start of the next month are printed in addition to the days in the current month. The OnlyDaysInMonth argument is ignored unless a value for MonthsPerPage is specified.

OnlyWeeksInMonth


Optional Boolean. True if only the weeks that are fully contained in the month are printed. False if weeks that have one or more days in the month are printed. The OnlyWeeksInMonth argument is ignored unless a value for MonthsPerPage is specified.

MonthPreviews



Optional Boolean. True if preview calendars for the previous and next months are printed.

MonthTitle





Optional Boolean. True if the month's title is printed.

AdditionalTasks



Optional Boolean. True if tasks that do not fit on the Calendar are printed. (Additional tasks appear at the end of the printout.)

GroupAdditionalTasks

Optional Boolean. True if additional tasks are grouped by day.

PrintNotes





Optional Boolean. True if the notes associated with each task are printed. Notes are printed at the end, after any additional tasks.

Remarks

Using the FilePageSetupCalendar method without specifying any arguments displays the Page Setup dialog box with the View tab selected.

The FilePageSetupCalendar method is only available when the Calendar is the active view.

FilePageSetupCalendarText Method

Formats calendar text for printing.

Syntax

expression.FilePageSetupCalendarText(Name, Item, Font, Size, Bold, Italic, Underline, Color)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the calendar to edit.

Item




Optional Long. The text item to format. Can be one of the following PjPageSetupCalendarItem constants: pjAllCalendarItems, pjMonthlyTitles, pjPreviousNextMonths, or pjAdditionalTasks.

Font




Optional String. The name of the font.

Size




Optional Integer. The size of the font in points.
Bold




Optional Boolean. True if the font is bold.

Italic




Optional Boolean. True if the font is italic.

Underline


Optional Boolean. True if the font is underlined.

Color



Optional Long. The color of the text. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Remarks

Using the FilePageSetupCalendarText method without specifying any arguments displays the Text Styles dialog box.

The FilePageSetupCalendarText method is only available when the Calendar is the active view.

FilePageSetupFooter Method

Displays the Page Setup dialog box with the Footer tab selected.

Syntax

expression.FilePageSetupFooter

expression

Optional. An expression that returns an Application object.

FilePageSetupHeader Method

Displays the Page Setup dialog box with the Header tab selected.

Syntax

expression.FilePageSetupHeader

expression

Optional. An expression that returns an Application object.

FilePageSetupLegend Method

Sets up legends for printing.

Syntax

expression.FilePageSetupLegend(Name, TextWidth, LegendOn)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the view or report for which to set up legends for printing.

TextWidth

Optional Integer. The width of the text, in inches or centimeters.

LegendOn

Optional Long. The pages on which the legend appears. Can be one of the following PjLegend constants: pjNoLegend, pjAfterLastPage, or pjOnEveryPage.

Remarks

Using the FilePageSetupLegend method without specifying any arguments displays the Page Setup dialog box with the Legend tab selected.

FilePageSetupMargins Method

Sets up margins for printing.

Syntax

expression.FilePageSetupMargins(Name, Top, Bottom, Left, Right, Borders)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the view or report for which to set up margins for printing.

Top




Optional Integer. The size of the top margin in inches or centimeters.

Bottom



Optional Integer. The size of the bottom margin in inches or centimeters.

Left




Optional Integer. The size of the left margin in inches or centimeters.

Right



Optional Integer. The size of the right margin in inches or centimeters.

Borders


Optional Long. Where to print borders. Can be one of the following PjBorder constants: pjNoBorder, pjAroundEveryPage, or pjOutsidePages.

Remarks

Using the FilePageSetupMargins method without specifying any arguments displays the Page Setup dialog box with the Margins tab selected.

FilePageSetupPage Method

Sets up pages for printing.

Syntax

expression.FilePageSetupPage(Name, Portrait, PercentScale, PagesTall, PagesWide)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the view or report for which to set up pages for printing.

Portrait



Optional Boolean. True if the page orientation is portrait. False if the page orientation is landscape.

PercentScale
Optional Integer. The scaling factor, specified as a percentage of the original. Can be a number between 1 and 500.

PagesTall


Optional Integer. The height the printed project should be fit to, in pages. The PagesTall argument is ignored if PercentScale is specified.

PagesWide

Optional Integer. The width the printed project should be fit to, in pages. The PagesWide argument is ignored if PercentScale is specified.

Remarks

Using the FilePageSetupPage method without specifying any arguments displays the Page Setup dialog box with the Page tab selected.

FilePageSetupView Method

Sets up view-specific options for printing.

Syntax

expression.FilePageSetupView(Name, AllSheetColumns, RepeatColumns, PrintNotes, PrintBlankPages, BestPageFitTimescale)
expression





Optional. An expression that returns an Application object.

Name







Optional String. The name of the view or report for which to set up pages for printing.

AllSheetColumns



Optional Boolean. True if all table columns print. False if only visible table columns print. This argument is only available when the Task Usage view, Resource Usage view, or one of the Gantt views is the active view.

RepeatColumns



Optional Integer. The number of table columns to print on each page. This argument is only available when the Task Sheet, Task Usage view, Resource Sheet, Resource Usage view, or one of the Gantt views is the active view.

PrintNotes





Optional Boolean. True if notes print. If the active view is the Resource Graph, PrintNotes is ignored.

PrintBlankPages



Optional Boolean. True if blank pages print. This argument is only available when the Task Usage view, Resource Usage view, one of the Gantt views, or one of the PERT views is the active view.

BestPageFitTimescale

Optional Boolean. True if the timescale is adjusted so the last printed page is exactly full. This argument is only available when the Task Usage view, Resource Usage view, Resource Graph, or one of the Gantt views is the active view.

Remarks

Using the FilePageSetupView method without specifying any arguments displays the Page Setup dialog box with the View tab selected.

The FilePageSetupView method is not available when the Calendar is the active view.

FilePrint Method

Prints the active view.

Syntax

expression.FilePrint(FromPage, ToPage, PageBreaks, Draft, Copies, FromDate, ToDate, OnePageWide, Preview, Color)
expression

Optional. An expression that returns an Application object.

FromPage

Optional Integer. A number that specifies the first page to print. The default value is 1.

ToPage


Optional Integer. A number that specifies the last page to print. The default is the last page in the project.

PageBreaks

Optional Boolean. True if Microsoft Project uses manual page breaks when printing. The default value is True.

Draft




Optional Boolean. True if Microsoft Project prints the active view in draft mode. The default value is False.

Copies



Optional Integer. A number that specifies the number of copies to print. The default value is 1.

FromDate


Optional Variant. A number or string that specifies the first date to print. The default is the start date of the project.

ToDate



Optional Variant. A number or string that specifies the last date to print. The default is the finish date of the project.

OnePageWide
Optional Boolean. True if Microsoft Project prints only the leftmost columns of the active view. The default value is False.

Preview


Optional Boolean. True if Microsoft Project previews the active view rather than printing it. The default value is False.

Color



Optional Boolean. True if Microsoft Project prints the active view in color. The default value is False.

FilePrint Method Example

The following example prints the active view without using manual page breaks.

Sub PrintViewWithoutPageBreaks()


FilePrint PageBreaks:=False

End Sub

FilePrintPreview Method

Provides a print preview of the active project.

Syntax

expression.FilePrintPreview
expression

Optional. An expression that returns an Application object.

Remarks

The FilePrintPreview method has the same effect as the Print Preview command on the File menu.

FilePrintSetup Method

Specifies the active printer.

Syntax

expression.FilePrintSetup(Printer)
expression

Optional. An expression that returns an Application object.

Printer



Optional String. The full name or port name of the active printer.

FilePrintSetup Method Example

The following example sets the active printer to the printer on the LPT1 port.

Sub SetActivePrinterToLPT1()


FilePrintSetup "LPT1:"

End Sub

FileProperties Method

Displays the Properties dialog box for the active project file.

Syntax

expression.FileProperties
expression

Optional. An expression that returns an Application object.

Remarks

See the BuiltinDocumentProperties and CustomDocumentProperties properties, as well as the appropriate Visual Basic properties of the Project object, to manipulate the values of these properties.
FileSave Method

Saves the active project.

Syntax

expression.FileSave
expression

Optional. An expression that returns an Application object.

FileSaveAs Method

Saves the active project under a new file name or exports data.

Syntax

expression.FileSaveAs(Name, Format, Backup, ReadOnly, TaskInformation, Filtered, Table, UserID, DatabasePassWord, FormatID, Map)
expression




Optional. An expression that returns an Application object.

Name






Required String. The name of a new project under which the active project will be saved or the name of the database where the data will be exported.

Format






Optional Long. The format of the file. The FormatID argument should be used in place of Format, which is included primarily for backwards compatibility. If FormatID is specified, Format is ignored. The default value is pjMPP. Can be one of the following PjFileFormat constants:

Constant
Description

 


pjMPP
Microsoft Project file

pjMPT
Microsoft Project template

pjMPX4
Microsoft Project 4.0 MPX file

pjCSV
CSV file

pjTXT
Text file

pjXLS
Microsoft Excel workbook

Backup





Optional Boolean. True if Microsoft Project makes a backup copy of the file.

ReadOnly





Optional Boolean. True if the file is opened read-only. The default value is False.

TaskInformation


Optional Boolean. True if task information is saved, for a project saved under a non-Microsoft Project file format. False if resource information is saved. If Map is specified, TaskInformation is ignored. The default value is True if the active view is a task view and False otherwise.

Filtered





Optional Boolean. True if filtered tasks or resources are saved, for a project saved under a non-Microsoft Project file format. False if all the tasks or resources are saved. If Map is specified, Filtered is ignored. The default value is False.

Table






Optional String. The name of the table containing the task or resource information, for a project saved under a non-Microsoft Project format. If Map is specified, or Name specifies a database file or format, Table is ignored. The default value is the name of the active table. 

UserID






Optional String. A user ID to use when accessing a database. If Format or FormatID is not a database, UserID is ignored.

DatabasePassWord

Optional String. A password to use when accessing a database. If Format or FormatID isn't a database, DatabasePassWord is ignored.

FormatID





Optional String. The file or database format to use. Can be one of the following format strings:

Format String
Description




"MSProject.mpp"
Microsoft Project file

"MSProject.mpt"
Microsoft Project template

"MSProject.mpd"
Microsoft Project database

"MSProject.mpw"
Microsoft Project workspace

"MSProject.mpx"
Microsoft Project 4.0 MPX file

"MSProject.odbc"
ODBC database

"MSProject.xls5"
Microsoft Excel 5.0/95 (7.0) workbook

"MSProject.pivot5"
Microsoft Excel 5.0/95 (7.0) pivot table

"MSProject.mdb8"
Microsoft Access 97 (8.0) database

"MSProject.csv"
CSV file

"MSProject.txt"
TXT file

"MSProject.html"
HTML document

Map







Optional String. The name of the import/export map to use when exporting data.

FileSaveWorkspace Method

Saves a list of open files and the current settings in the Options dialog box.

Syntax

expression.FileSaveWorkspace(Name)
expression




Optional. An expression that returns an Application object.

Name






Optional String. The name of the file to create. If Name is omitted, Microsoft Project prompts for the file name.

FileSaveWorkspace Method Example

The following example saves the workspace based upon the name of the first project file.

Sub SaveWorkspaceByProjectName()

   Dim WSName As String

    If InStr(Projects(1).Name, ".") Then

      WSName = Left$(Projects(1).Name, Len(Projects(1).Name) - 1) & "W"

    Else

      WSName = Projects(1).Name & ".MPW"

    End If

    FileSaveWorkspace WSName

End Sub

FillAcross Method

Fills the selected cells or columns with the values in the specified cell or column of the selection.

Syntax

expression.FillAcross(Right)
expression

Optional. An expression that returns an Application object.

Right



Optional Boolean. True if values in the leftmost cell or column of the selection are copied right to the other selected cells or columns. False if values in the rightmost cell or column are copied left to the other selected cells or columns. The default value is True.

Remarks

The FillAcross method is only available in timephased cells of usage views.

FillDown Method

Fills the selected cells or rows with the values in the specified cell or row of the selection.

Syntax

expression.FillDown(Down)
expression

Optional. An expression that returns an Application object.

Down



Optional Boolean. True if values in the top cell or row of the selection are copied down to the other selected cells or rows. False if values in the bottom cell or row of the selection are copied up to the other selected cells or rows. The default value is True.

FilterApply Method

Sets the current filter.

Syntax

expression.FilterApply(Name, Highlight, Value1, Value2)
expression

Optional. An expression that returns an Application object.

Name



Required String. The name of the filter to use.

Highlight


Optional Boolean. True if Microsoft Project highlights rows rather than applying the filter. The default value is False.

Value1



Optional String. The first value to use when applying an interactive filter.

Value2



Optional String. The second value to use when applying an interactive filter.

FilterApply Method Example

The following example highlights filtered items.

Sub HighlightCriticalTasks()


FilterApply Name:="Critical", Highlight:=True

End Sub

FilterEdit Method

Creates, edits, or copies a filter.

Syntax

expression.FilterEdit(Name, TaskFilter, Create, OverwriteExisting, NewName, FieldName, NewFieldName, Test, Value, Operation, ShowInMenu, ShowSummaryTasks)
expression




Optional. An expression that returns an Application object.

Name






Required String. The name of a filter to edit, create, or copy.

TaskFilter





Required Boolean. True if the filter specified with Name contains task information. False if the filter contains resource information.

Create






Optional Boolean. True if a new filter is created. The new filter is a copy of the filter specified with Name and is given the name specified with NewName. If NewName is Empty, the new filter is given the name specified with Name. The default value is False.

OverwriteExisting

Optional Boolean. True if the existing filter is overwritten with a new filter. The default value is False.

NewName





Optional String. A new name for the filter specified with Name (Create is False) or a name for the new filter (Create is True). If NewName is Empty and Create is False, the filter specified with Name retains its current name. The default value is Empty.

FieldName




Optional String. The name of a field to change.

NewFieldName



Optional String. A new name for the field specified with FieldName.

Test

Required String. The type of comparison made between FieldName and Value that acts as selection criteria for the filter. Can be one of the following comparison strings:

Comparison String
Description




"equals"
The value of FieldName equals Value.

"does not equal"
The value of FieldName does not equal Value.

"is greater than"
The value of FieldName is greater than Value.

"is greater than or equal to"
The value of FieldName is greater than or equal to Value.

"is less than"
The value of FieldName is less than Value.

"is less than or equal to"
The value of FieldName is less than or equal to Value.

"is within"
The value of FieldName is within Value.

"is not within"
The value of FieldName is not within Value.

"contains"
FieldName contains Value.

"does not contain"
FieldName does not contain Value.

"contains exactly"
FieldName exactly contains Value.

Value






Optional String. The value to compare with the value of the field specified with FieldName.

Operation





Optional String. How the criteria established with FieldName, Test, and Value relate to other criteria in the filter. The Operation argument can be set to "And" or "Or".

ShowInMenu



Optional Boolean. True if the filter is displayed in the Filters menu. (To display the Filters menu, click Filtered for on the Project menu.) The default value is False.

ShowSummaryTasks
Optional Boolean. True if the summary tasks of the filtered tasks are displayed. The default value is False.

FilterEdit Method Example

The following example creates a filter (if one doesn't exist) for tasks with the highest priority and then applies the filter.

Sub CreateAndApplyHighestPriorityFilter()

    Dim TaskFilter As Variant  ' Index for For Each loop

    Dim Found As Boolean    ' Whether or not the filter exists.

    Found = False   ' Assume the filter doesn't exist.

    ' Look for filter.

    For Each TaskFilter In ActiveProject.TaskFilterList

        If TaskFilter = "Highest Priority" Then

            Found = True

            Exit For

        End If

    Next TaskFilter

    ' If filter doesn't exist, create it.

    If Not Found Then FilterEdit Name:="Highest Priority", _

        Create:=True, TaskFilter:=True, FieldName:="Priority", _

        Test:="equals", Value:="Highest"

    FilterApply "Highest Priority"

End Sub

Filters Method

Displays the More Filters dialog box, which prompts the user to use a filter.

Syntax

expression.Filters
expression


Optional. An expression that returns an Application object.

Remarks

The Filters method is equivalent to the More Filters command on the Filtered For submenu, available on the Project menu.

Find Method

Searches for an unfiltered value and returns True if it is found.

Syntax

expression.Find(Field, Test, Value, Next, MatchCase)
expression


Optional. An expression that returns an Application object.

Field





Required String. The name of the field to search.

Test





Required String. The type of comparison made between Field and Value. Can be one of the following comparison strings:

Comparison string
Description




"equals"
The value of Field equals Value.

"does not equal"
The value of Field does not equal Value.

"is greater than"
The value of Field is greater than Value.

"is greater than or equal to"
The value of Field is greater than or equal to Value.

"is less than"
The value of Field is less than Value.

"is less than or equal to"
The value of Field is less than or equal to Value.

"is within"
The value of Field is within Value.

"is not within"
The value of Field is not within Value.

"contains"
Field contains Value.

"does not contain"
Field does not contain Value.

"contains exactly"
Field exactly contains Value.

Value




Required String. The value to compare with the value of the field specified with Field.

Next





Optional Boolean. True if Microsoft Project searches down for the next occurrence of matching search criteria. False if the program searches up for the next occurrence. The default value is True.

MatchCase


Optional Boolean. True if the search is case-sensitive. The default value is False.

Remarks

Using the Find method without specifying any arguments displays the Find dialog box.

Find Method Example

The following example finds the next task with highest priority.

Sub FindFirstID


Find Field:="Priority", Test:="equals", Value:="Highest"

End Sub

FindFile Method

Displays the File Open dialog box, which allows the user to search for a file.

Syntax

expression.FindFile
expression
Optional. An expression that returns an Application object. 

FindNext Method

Repeats the last search and returns True if the search value is found..

Syntax

expression.FindNext
expression
Optional. An expression that returns an Application object.

FindPrevious Method

Repeats the last search and returns True if the search value is found.

Syntax

expression.FindPrevious
expression
Optional. An expression that returns an Application object.

Finish Property

Returns or sets the finish date of an assignment, shift, task portion, or task. Read-only for summary tasks. Read/write Variant.

Finishn Property

Returns or sets the value of an additional finish date field for an assignment, resource, or task. The n placeholder can be a number from 1 to 10. Read/write Variant.

FinishVariance Property

Returns the variance (in minutes) between the baseline finish date and the finish date of an assignment or task. Read-only Variant.

FixedCost Property

Returns or sets a fixed cost for a task. Read/write Variant.

FixedCost Property Example

The following example increases the fixed costs of marked tasks by an amount specified by the user.

Sub IncreaseFixedCosts()

    Dim T As Task           ' Task object used in For Each loop

    Dim Entry As String     ' Amount to add to any existing fixed cost

    Entry = InputBox$("Increase the fixed costs of marked tasks by what amount?")

    ' If entry is invalid, display error message and exit Sub procedure.

    If Not IsNumeric(Entry) Then

        MsgBox ("You didn't enter a numeric value.")

        Exit Sub

    End If

    ' Increase the fixed costs of marked tasks by the specified amount.

    For Each T In ActiveProject.Tasks

        If T.Marked Then

            T.FixedCost = T.FixedCost + Val(Entry)

        End If

    Next T

End Sub

FixedCostAccrual Property

Returns or sets when the task accrues fixed costs. Can be one of the following PjAccrueAt constants: pjStart, pjEnd, or pjProrated. Read/write Long.

Flagn Properties

True if the flag associated with an assignment, resource, or task is set. The n placeholder can be a number from 1 to 20. Read/write Boolean.

Flagn Properties Example

The following example deletes tasks in the active project that have their Flag1 properties set to True.

Sub DeleteNonEssentialTasks()

    Dim T As Task   ' Task object used in For Each loop

    ' Delete nonessential tasks in the active project.

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            If T.Flag1 = True Then T.Delete

        End If

    Next T

End Sub

FollowedHyperlinkColor Property

Returns or sets the color used to denote followed hyperlinks. Read/write Long.

Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

FollowHyperlink Method

Opens the document specified by a hyperlink address.

Syntax

expression.FollowHyperlink(Address, SubAddress, AddHistory, NewWindow)
expression

Optional. An expression that returns an Application object.

Address


Optional String. The address of the target document. If Address is omitted and a text field is selected, the text of the selected field is used. If Address is omitted and a text field is not selected, Microsoft Project returns an error.

SubAddress

Optional String. A location within the target document.

AddHistory

Optional Boolean. True if the target document should be added to the History folder. The default value is True.

NewWindow

Optional Boolean. True if the target document should display in a new window. The default value is False.

FollowHyperlink Method Example

The following example opens a hyperlink to the Microsoft Web site in its own window.

Sub GoToMicrosoft()

    Application.FollowHyperlink Address:="http://www.Microsoft.com", _

        NewWindow:=True, AddHistory:=True

End Sub

Font Method

Sets the font for the text in the active cells.

Syntax

expression.Font(Name, Size, Bold, Italic, Underline, Color, Reset)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the font.

Size




Optional Integer. The size of the font in points.

Bold




Optional Boolean. True if the font is bold.

Italic




Optional Boolean. True if the font is italic.

Underline


Optional Boolean. True if the font is underlined.

Color



Optional Long. The color of the font. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Reset



Optional Boolean. True if the font is reset to its default characteristics. All other arguments are ignored. The default value is False.

Font Method Example

The following example formats selected text using 16-point Tahoma.

   Sub FormatTahoma16()

      Font Name:="Tahoma", Size:=16, Bold:=False, Italic:=False, _

               Underline:=False, Color:=pjBlack

   End Sub

FontBold Method

Applies or removes bold formatting from the selected text.

Syntax

expression.FontBold(Set)
expression

Optional. An expression that returns an Application object.

Set




Optional Boolean. True if bold formatting is applied to the selected text. False if bold formatting is removed from the selected text. The default value is False if the selected text is bold and True if not bold.

FontItalic Method

Applies or removes italic formatting from the selected text.

Syntax

expression.FontItalic(Set)
expression

Optional. An expression that returns an Application object.

Set




Optional Boolean. True if italic formatting is applied to the selected text. False if italic formatting is removed from the selected text. The default value is False if the selected text is italic and True if not italic.

FontUnderline Method

Applies or removes underlining from the selected text.

Syntax

expression.FontUnderline(Set)
expression

Optional. An expression that returns an Application object.

Set




Optional Boolean. True if underlining is applied to the selected text. False if underlining is removed from the selected text. The default value is False if the selected text is underlined and True if not underlined.

Form Method

Displays a custom form. The Form method produces an error if a resource form is specified when the active view is a task view, and vice versa.

Syntax

expression.Form(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of a custom form. The default is a task form when the active view is a task view, and a resource form when the active view is a resource view.

Form Method Example

The following example displays the Cost Tracking form.

Sub DisplayCostTrackingForm


Form("Cost Tracking")
End Sub

FormatCopy Method

Copies the formats of the selected cells.

Syntax

expression.FormatCopy
expression

Optional. An expression that returns an Application object.

FormatPainter Method

Paints the formatting of the selected object onto another object.

Syntax

expression.FormatPainter
expression

Optional. An expression that returns an Application object.

Remarks

The FormatPainter method requires user interaction before additional code can be executed.

FormatPaste Method

Pastes formatscopied with the FormatCopy method) into the selected cells.

Syntax

expression.FormatPaste
expression

Optional. An expression that returns an Application object.

FormViewShow Method

Shows or hides the form view in the lower pane.

Syntax

expression.FormViewShow
expression

Optional. An expression that returns an Application object.

FreeSlack Property

Returns the free slack for a task in minutes. Read-only Variant.

FreeSlack Property Example

The following example eliminates free slack in the active project by changing the start dates of tasks with free slack.

Sub EliminateFreeSlack()

    Dim T As Task ' Task object used in For Each loop

    For Each T In ActiveProject.Tasks

        If T.FreeSlack > 0 Then

            T.Start = Application.DateAdd(T.Start, T.FreeSlack)

        End If

    Next T

End Sub

FullName Property

Returns the path and file name of a project. Read-only String.

Remarks

The FullName property returns the project name (as seen in the title bar) for an unsaved project.

FullName Property Example

The following example prompts the user for the full name of a file and then closes the file, saving it if it has changed.

Sub CloseFile()

    Dim P As Project        ' Project object used in For Each loop

    Dim FileName As String  ' Full name of a file

    ' Prompt user for the full name of a file.

    FileName = InputBox$("Close which file? Include its path: ")

    ' Search the open projects for the file.

    For Each P In Application.Projects

        ' If the file is found, close it.

        If P.FullName = FileName Then

            P.Activate

            FileClose pjSave

            Exit Sub

        End If


Next P


 ' Inform user if the file is not found.

    MsgBox ("Could not find the file " & FileName & ".")

End Sub

GanttBarFormat Method

Formats Gantt bars.

Syntax

expression.GanttBarFormat(TaskID, GanttStyle, StartShape, StartType, StartColor, MiddleShape, MiddlePattern, MiddleColor, EndShape, EndType, EndColor, LeftText, RightText, TopText, BottomText, InsideText, Reset, ProjectName)
expression

Optional. An expression that returns an Application object.

TaskID



Optional Long. The identification number of the task represented by the Gantt bar to be changed. The default is to change the Gantt bars of the selected tasks.

GanttStyle

Optional Integer. The style applied to the Gantt bar to be formatted. The value for GanttStyle is based on the position of the bar style in the list. For example, the value 3 returns the third bar style in the list.

StartShape

Optional Long. The start shape of the Gantt bar. Can be one of the following PjBarEndShape constants:

Constant
Description

 


pjNoBarEndShape
None

pjHouseUp
House

pjHouseDown
Upside-down house

pjDiamond
Diamond

pjCircleDiamond
Circled diamond

pjTriangleUp
Triangle pointing up

pjTriangleDown
Triangle pointing down

pjTriangleRight
Triangle pointing right

pjTriangleLeft
Triangle pointing left

pjCircleTriangleUp
Circled triangle pointing up

pjCircleTriangleDown
Circled triangle pointing down

pjArrowUp
Arrow pointing up

pjArrowDown
Arrow pointing down

pjCircleArrowUp
Circled arrow pointing up

pjCircleArrowDown
Circled arrow pointing down

pjCaretDownTop
Caret pointing down on the top half of the bar

pjCaretUpBottom
Caret pointing up on the bottom half of the bar

pjLine
Line

pjSquare
Square

pjCircle
Circle

pjStar
Star

StartType


Optional Long. The start type of the Gantt bar. Can be one of the following PjBarType constants: pjDashed, pjFramed, or pjSolid.

StartColor

Optional Long. The start color of the Gantt bar. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

MiddleShape
Optional Long. The middle shape of the Gantt bar. Can be one of the following PjBarShape constants: pjNone, pjRectangleBar, pjRectangleTop, pjRectangleMiddle, pjRectangleBottom, pjLineTop, pjLineMiddle, or pjLineBottom.

MiddlePattern
Optional Long. The middle pattern of the Gantt bar. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


MiddleColor

Optional Long. The middle color of the Gantt bar. Can be one of the PjColor constants.

EndShape

Optional Long. The end shape of the Gantt bar. Can be one of the PjBarEndShape constants.

EndType


Optional Long. The end type of the Gantt bar. Can be one of the following PjBarType constants: pjDashed, pjFramed, or pjSolid.

EndColor


Optional Long. The end color of the Gantt bar. Can be one of the PjColor constants.

LeftText


Optional String. The task field to display to the left of the Gantt bar.

RightText


Optional String. The task field to display to the right of the Gantt bar.

TopText


Optional String. The task field to display above the Gantt bar.

BottomText

Optional String. The task field to display below the Gantt bar.

InsideText

Optional String. The task field to display inside the Gantt bar.

Reset



Optional Boolean. True if the bar formatting is reset to the default formatting of the style in the Bar Styles dialog box.

ProjectName
Optional String. The name of the project containing TaskID if consolidation is involved. The default value is the name of the active project.

Remarks

Using the GanttBarFormat method without specifying any arguments displays the Bar Styles dialog box.

Use the GanttBarFormat method to change the formatting of Gantt bars from their default styles. To define the default styles, use the GanttBarStyleEdit method.

GanttBarLinks Method

Shows or hides task links on the Gantt Chart.

Syntax

expression.GanttBarLinks(Display)
expression

Optional. An expression that returns an Application object.

Display



Optional Long. Where links will be drawn from the ends of predecessor links. Can be one of the following PjGanttBarLink constants: PjNoGanttBarLinks, pjToTop, or pjToEnd. The default value is PjNoGanttBarLinks.

GanttBarSize Method

Sets the height, in points, of the Gantt bars in the active Gantt Chart.

Syntax

expression.GanttBarSize(Size)
expression

Optional. An expression that returns an Application object.

Size




Required Long. A constant specifying the height, in points, of the Gantt bars in the active Gantt Chart. Can be one of the following PjBarSize constants: pjBarSize6, pjBarSize8, pjBarSize10, pjBarSize12, pjBarSize14, pjBarSize18, or pjBarSize24.

GanttBarStyleDelete Method

Deletes a Gantt bar style from the active Gantt Chart.

Syntax

expression.GanttBarStyleDelete(Item)
expression

Optional. An expression that returns an Application object.

Item




Required String. The name or row number of the Gantt bar to delete from the Bar Styles dialog box. (The Bar Styles dialog box appears when you click Bar Styles on the Format menu.)

GanttBarStyleEdit Method

Changes or creates a Gantt bar style.

Syntax

expression.GanttBarStyleEdit(Item, Create, Name, StartShape, StartType, StartColor, MiddleShape, MiddleColor, MiddlePattern, EndShape, EndType, EndColor, ShowFor, Row, From, To, BottomText, TopText, LeftText, RightText, InsideText)
expression

Optional. An expression that returns an Application object.

Item




Required Variant. The name or row number of the Gantt bar style to change in the Bar Styles dialog box. (The Bar Styles dialog box appears when you click Bar Styles on the Format menu.)

Create



Optional Boolean. True if a new Gantt bar style is created and inserted in the Bar Styles dialog box before the Gantt bar style specified with Item. If Item is "-1", the new Gantt bar style is added to the end of the list of styles. The default value is False.

Name



Optional String. A new name for the Gantt bar.

StartShape

Optional Long. The start shape of the Gantt bar. The default value is pjNone. Can be one of the following PjBarEndShape constants:

Constant
Description

  


pjNone
None

pjHouseUp
House

pjHouseDown
Upside-down house

pjDiamond
Diamond

pjCircleDiamond
Circled diamond

pjTriangleUp
Triangle pointing up

pjTriangleDown
Triangle pointing down

pjTriangleRight
Triangle pointing right

pjTriangleLeft
Triangle pointing left

pjCircleTriangleUp
Circled triangle pointing up

pjCircleTriangleDown
Circled triangle pointing down

pjArrowUp
Arrow pointing up

pjArrowDown
Arrow pointing down

pjCircleArrowUp
Circled arrow pointing up

pjCircleArrowDown
Circled arrow pointing down

pjCaretDownTop
Caret pointing down on the top half of the bar

pjCaretUpBottom
Caret pointing up on the bottom half of the bar

pjLine
Line

pjSquare
Square

pjCircle
Circle

pjStar
Star

StartType


Optional Long. The start type of the Gantt bar. Can be one of the following PjBarType constants: pjDashed, pjFramed, or pjSolid. The default value is pjSolid.

StartColor

Optional Long. The start color of the Gantt bar. The default value is pjBlue. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

MiddleShape
Optional Long. The middle shape of the Gantt bar. Can be one of the following PjBarShape constants: pjNone, pjRectangleBar, pjRectangleTop, pjRectangleMiddle, pjRectangleBottom, pjLineTop, pjLineMiddle, or pjLineBottom. The default value is pjRectangleBar.

MiddleColor

Optional Long. The middle color of the Gantt bar. Can be one of the PjColor constants. The default value is pjBlue.

MiddlePattern
Optional Long. The middle pattern of the Gantt bar. The default value is pjMediumFillPattern. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


EndShape

Optional Long. The end shape of the Gantt bar. Can be one of the PjBarEndShape constants. The default value is pjNone.

EndType


Optional Long. The end type of the Gantt bar. Can be one of the following PjBarType constants: pjDashed, pjFramed, or pjSolid. The default value is pjSolid.

EndColor


Optional Long. The end color of the Gantt bar. Can be one of the PjColor constants. The default value is pjBlue.

ShowFor


Optional String. One or more task types (such as normal, split, summary, milestone, and so on) separated by the list separator character.

Row




Optional Integer. A number from 1 to 4 that specifies the row in which the Gantt bar appears. The default value is 1.

From



Optional String. The name of a date field specifying the start of the Gantt bar.

To




Optional String. The name of a date field specifying the end of the Gantt bar.

BottomText

Optional String. The task field to display below the Gantt bar.

TopText


Optional String. The task field to display above the Gantt bar.

LeftText


Optional String. The task field to display to the left of the Gantt bar.

RightText


Optional String. The task field to display to the right of the Gantt bar.

InsideText

Optional String. The task field to display inside the Gantt bar.

Remarks

The Bar Styles dialog box can contain up to 40 style entries.

GanttBarStyleEdit Method Example

The following example creates a new bar style that consists of a light green color and ends with a star shape.

Sub ModifyGanttBar()


GanttBarStyleEdit Item:=-1, Create:=True, Name:="My New Bar Style", MiddleColor:=pjLime, EndShape:=pjStar

End Sub

GanttBarTextDateFormat Method

Sets the date format for text around bars on the Gantt Chart.

Syntax

expression.GanttBarTextDateFormat(DateFormat)
expression

Optional. An expression that returns an Application object.

DateFormat

Required Long. A constant specifying the format of dates in the Gantt bar text. Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDateDefault
The default format, as specified on the View tab of the Options dialog box.

pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

GanttChartWizard Method

Starts the GanttChartWizard.

Syntax

expression.GanttChartWizard
expression

Optional. An expression that returns an Application object.

GanttShowBarSplits Method

Shows or hides task splits on the Gantt Chart.

Syntax

expression.GanttShowBarSplits(Display)
expression

Optional. An expression that returns an Application object.

Display



Optional Boolean. True if task splits appear on the Gantt Chart. The default value is True.

GanttShowDrawings Method

Shows or hides drawings on the Gantt Chart.

Syntax

expression.GanttShowDrawings(Display)
expression

Optional. An expression that returns an Application object.

Display



Optional Boolean. True if drawings appear on the Gantt Chart. The default value is True.

GetField Method

Returns the value in a field.

Syntax

expression.GetField(FieldID)
expression

Required. An expression that returns a Resource or Task object.

FieldID



Required Long. The field to get.


If expression is a Task, can be one of the following PjField constants:

pjTaskActualCost
pjTaskLinkedFields

pjTaskActualDuration
pjTaskMarked

pjTaskActualFinish
pjTaskMilestone

pjTaskActualOvertimeCost
pjTaskName

pjTaskActualOvertimeWork
pjTaskNotes

pjTaskActualStart
pjTaskNumber1

pjTaskActualWork
pjTaskNumber2

pjTaskACWP
pjTaskNumber3

pjTaskAssignmentDelay
pjTaskNumber4

pjTaskAssignmentUnits
pjTaskNumber5

pjTaskBaselineCost
pjTaskNumber6

pjTaskBaselineDuration
pjTaskNumber7

pjTaskBaselineFinish
pjTaskNumber8

pjTaskBaselineStart
pjTaskNumber9

pjTaskBaselineWork
pjTaskNumber10

pjTaskBCWP
pjTaskNumber11

pjTaskBCWS
pjTaskNumber12

pjTaskConfirmed
pjTaskNumber13

pjTaskConstraintDate
pjTaskNumber14

pjTaskConstraintType
pjTaskNumber15

pjTaskContact
pjTaskNumber16

pjTaskCost
pjTaskNumber17

pjTaskCost1
pjTaskNumber18

pjTaskCost2
pjTaskNumber19

pjTaskCost3
pjTaskNumber20

pjTaskCost4
pjTaskObjects

pjTaskCost5
pjTaskOutlineLevel

pjTaskCost6
pjTaskOutlineNumber

pjTaskCost7
pjTaskOverallocated

pjTaskCost8
pjTaskOvertimeCost

pjTaskCost9
pjTaskOvertimeWork

pjTaskCost10
pjTaskPercentComplete

pjTaskCostRateTable
pjTaskPercentWorkComplete

pjTaskCostVariance
pjTaskPredecessors

pjTaskCreated
pjTaskPreleveledFinish

pjTaskCritical
pjTaskPreleveledStart

pjTaskCV
pjTaskPriority

pjTaskDate1
pjTaskProject

pjTaskDate2
pjTaskRecurring

pjTaskDate3
pjTaskRegularWork

pjTaskDate4
pjTaskRemainingCost

pjTaskDate5
pjTaskRemainingDuration

pjTaskDate6
pjTaskRemainingOvertimeCost

pjTaskDate7
pjTaskRemainingOvertimeWork

pjTaskDate8
pjTaskRemainingWork

pjTaskDate9
pjTaskResourceGroup

pjTaskDate10
pjTaskResourceInitials

pjTaskDelay
pjTaskResourceNames

pjTaskDuration
pjTaskResourcePhonetics

pjTaskDuration1
pjTaskResponsePending

pjTaskDuration2
pjTaskResume

pjTaskDuration3
pjTaskResumeNoEarlierThan

pjTaskDuration4
pjTaskRollup

pjTaskDuration5
pjTaskSheetNotes

pjTaskDuration6
pjTaskStart

pjTaskDuration7
pjTaskStart1

pjTaskDuration8
pjTaskStart2

pjTaskDuration9
pjTaskStart3

pjTaskDuration10
pjTaskStart4

pjTaskDurationVariance
pjTaskStart5

pjTaskEarlyFinish
pjTaskStart6

pjTaskEarlyStart
pjTaskStart7

pjTaskEffortDriven
pjTaskStart8

pjTaskExternalTask
pjTaskStart9

pjTaskFinish
pjTaskStart10

pjTaskFinish1
pjTaskStartVariance

pjTaskFinish2
pjTaskStop

pjTaskFinish3
pjTaskSubproject

pjTaskFinish4
pjTaskSubprojectReadOnly

pjTaskFinish5
pjTaskSuccessors

pjTaskFinish6
pjTaskSummary

pjTaskFinish7
pjTaskSV

pjTaskFinish8
pjTaskTeamStatusPending

pjTaskFinish9
pjTaskText1

pjTaskFinish10
pjTaskText2

pjTaskFinishVariance
pjTaskText3

pjTaskFixedCost
pjTaskText4

pjTaskFixedCostAccrual
pjTaskText5

pjTaskFixedDuration
pjTaskText6

pjTaskFlag1
pjTaskText7

pjTaskFlag2
pjTaskText8

pjTaskFlag3
pjTaskText9

pjTaskFlag4
pjTaskText10

pjTaskFlag5
pjTaskText11

pjTaskFlag6
pjTaskText12

pjTaskFlag7
pjTaskText13

pjTaskFlag8
pjTaskText14

pjTaskFlag9
pjTaskText15

pjTaskFlag10
pjTaskText16

pjTaskFlag11
pjTaskText17

pjTaskFlag12
pjTaskText18

pjTaskFlag13
pjTaskText19

pjTaskFlag14
pjTaskText20

pjTaskFlag15
pjTaskText21

pjTaskFlag16
pjTaskText22

pjTaskFlag17
pjTaskText23

pjTaskFlag18
pjTaskText24

pjTaskFlag19
pjTaskText25

pjTaskFlag20
pjTaskText26

pjTaskFreeSlack
pjTaskText27

pjTaskHideBar
pjTaskText28

pjTaskHyperlink
pjTaskText29

pjTaskHyperlinkAddress
pjTaskText30

pjTaskHyperlinkHref
pjTaskTotalSlack

pjTaskHyperlinkSubAddress
pjTaskType

pjTaskID
pjTaskUniqueID

pjTaskIndicators
pjTaskUniquePredecessors

pjTaskIsAssignment
pjTaskUniqueSuccessors

pjTaskLateFinish
pjTaskUpdateNeeded

pjTaskLateStart
pjTaskWBS

pjTaskLevelAssignments
pjTaskWork

pjTaskLevelCanSplit
pjTaskWorkContour

pjTaskLevelDelay
pjTaskWorkVariance


If expression is a Resource, can be one of the following PjField constants:

pjResourceAccrueAt
pjResourceIsAssignment

pjResourceActualCost
pjResourceLevelingDelay

pjResourceActualOvertimeCost
pjResourceLinkedFields

pjResourceActualOvertimeWork
pjResourceMaxUnits

pjResourceActualWork
pjResourceName

pjResourceACWP
pjResourceNotes

pjResourceAssignmentDelay
pjResourceNumber1

pjResourceAssignmentUnits
pjResourceNumber2

pjResourceAvailableFrom
pjResourceNumber3

pjResourceAvailableTo
pjResourceNumber4

pjResourceBaseCalendar
pjResourceNumber5

pjResourceBaselineCost
pjResourceNumber6

pjResourceBaselineFinish
pjResourceNumber7

pjResourceBaselineStart
pjResourceNumber8

pjResourceBaselineWork
pjResourceNumber9

pjResourceBCWP
pjResourceNumber10

pjResourceBCWS
pjResourceNumber11

pjResourceCanLevel
pjResourceNumber12

pjResourceCode
pjResourceNumber13

pjResourceConfirmed
pjResourceNumber14

pjResourceCost
pjResourceNumber15

pjResourceCost1
pjResourceNumber16

pjResourceCost2
pjResourceNumber17

pjResourceCost3
pjResourceNumber18

pjResourceCost4
pjResourceNumber19

pjResourceCost5
pjResourceNumber20

pjResourceCost6
pjResourceObjects

pjResourceCost7
pjResourceOverallocated

pjResourceCost8
pjResourceOvertimeCost

pjResourceCost9
pjResourceOvertimeRate

pjResourceCost10
pjResourceOvertimeWork

pjResourceCostPerUse
pjResourcePeakUnits

pjResourceCostRateTable
pjResourcePercentWorkComplete

pjResourceCostVariance
pjResourcePhonetics

pjResourceCV
pjResourceProject

pjResourceDate1
pjResourceRegularWork

pjResourceDate2
pjResourceRemainingCost

pjResourceDate3
pjResourceRemainingOvertimeCost

pjResourceDate4
pjResourceRemainingOvertimeWork

pjResourceDate5
pjResourceRemainingWork

pjResourceDate6
pjResourceResponsePending

pjResourceDate7
pjResourceSheetNotes

pjResourceDate8
pjResourceStandardRate

pjResourceDate9
pjResourceStart

pjResourceDate10
pjResourceStart1

pjResourceDuration1
pjResourceStart2

pjResourceDuration2
pjResourceStart3

pjResourceDuration3
pjResourceStart4

pjResourceDuration4
pjResourceStart5

pjResourceDuration5
pjResourceStart6

pjResourceDuration6
pjResourceStart7

pjResourceDuration7
pjResourceStart8

pjResourceDuration8
pjResourceStart9

pjResourceDuration9
pjResourceStart10

pjResourceDuration10
pjResourceSV

pjResourceEMailAddress
pjResourceTaskSummaryName

pjResourceFinish1
pjResourceTeamStatusPending

pjResourceFinish2
pjResourceText1

pjResourceFinish3
pjResourceText2

pjResourceFinish4
pjResourceText3

pjResourceFinish5
pjResourceText4

pjResourceFinish6
pjResourceText5

pjResourceFinish7
pjResourceText6

pjResourceFinish8
pjResourceText7

pjResourceFinish9
pjResourceText8

pjResourceFinish10
pjResourceText9

pjResourceFlag1
pjResourceText10

pjResourceFlag2
pjResourceText11

pjResourceFlag3
pjResourceText12

pjResourceFlag4
pjResourceText13

pjResourceFlag5
pjResourceText14

pjResourceFlag6
pjResourceText15

pjResourceFlag7
pjResourceText16

pjResourceFlag8
pjResourceText17

pjResourceFlag9
pjResourceText18

pjResourceFlag10
pjResourceText19

pjResourceFlag11
pjResourceText20

pjResourceFlag12
pjResourceText21

pjResourceFlag13
pjResourceText22

pjResourceFlag14
pjResourceText23

pjResourceFlag15
pjResourceText24

pjResourceFlag16
pjResourceText25

pjResourceFlag17
pjResourceText26

pjResourceFlag18
pjResourceText27

pjResourceFlag19
pjResourceText28

pjResourceFlag20
pjResourceText29

pjResourceGroup
pjResourceText30

pjResourceHyperlink
pjResourceUniqueID

pjResourceHyperlinkAddress
pjResourceUpdateNeeded

pjResourceHyperlinkHref
pjResourceWork

pjResourceHyperlinkSubAddress
pjResourceWorkContour

pjResourceID
pjResourceWorkgroup

pjResourceIndicators
pjResourceWorkVariance

pjResourceInitials


GetField Method Example

The following example displays the value of a field specified by the user.

Sub DisplayField()

    Dim Temp As String

    Temp = InputBox$("Enter the name of the field you want to see:")

    Temp = LCase(Temp)

    Select Case Temp

        Case "name"

            MsgBox (ActiveCell.Resource.GetField(FieldID:=pjResourceName))

        Case "initials"

            MsgBox (ActiveCell.Resource.GetField(FieldID:=pjResourceInitials))

        Case "standard rate"

            MsgBox (ActiveCell.Resource.GetField(FieldID:=pjResourceStandardRate))

        Case ""

            End

        Case Else

            MsgBox "You entered an invalid field. Please try again."

            End

    End Select

End Sub

GotoNextOverallocation Method

Scrolls a timescale view to display the next overallocated resource.

Syntax

expression.GotoNextOverallocation
expression

Optional. An expression that returns an Application object.

GotoTaskDates Method

Scrolls the Gantt Chart, Resource Usage, or Task Usage view to display the starting date of the active task, or scrolls the Calendar to view the month containing the starting date of the active task.

Syntax

expression.GotoTaskDates
expression

Optional. An expression that returns an Application object.

Gridlines Method

Displays the Gridlines dialog box. This method is unavailable when the active view is a PERT or form view.

Syntax

expression.Gridlines
expression

Optional. An expression that returns an Application object.

GridlinesEdit Method

Edits gridlines.

Syntax

expression.GridlinesEdit(Item, NormalType, NormalColor, Interval, IntervalType, IntervalColor)
expression

Optional. An expression that returns an Application object.

Item




Required Long. The gridline to edit. Can be one of the following PjGridline constants:

If the Gantt Chart is active:

pjBarRows
pjGanttSheetRows

pjGanttCurrentDate
pjGanttStatusDate

pjGanttPageBreaks
pjGanttTitleHorizontal

pjGanttProjectFinish
pjGanttTitleVertical

pjGanttProjectStart
pjMajorColumns

pjGanttRows
pjMinorColumns

pjGanttSheetColumns


If the Calendar view is active: pjCalendarDays, pjCalendarWeeks, pjTitleHorizontal, pjTitleVertical, pjDateBoxTop, or pjDateBoxBottom.

If the Resource Graph is active: pjMajorVertical, pjMinorVertical, pjHorizontal, pjGraphCurrentDate, pjGraphTitleHorizontal, pjGraphTitleVertical, pjGraphProjectStart, pjGraphProjectFinish, or pjGraphStatusDate.

If the Task Sheet or Resource Sheet is active: pjSheetColumns, pjSheetRows, pjSheetTitleHorizontal, pjSheetTitleVertical, or pjSheetPageBreaks.

If the Task Usage or Resource Usage view is active: pjUsageColumns, pjUsageRows, pjUsageSheetRows, pjUsageSheetColumns, pjUsageTitleHorizontal, pjUsageTitleVertical, or pjUsagePageBreaks.

NormalType


Optional Long. The type for normal gridlines. Can be one of the following PjLineType constants: pjNoLines, pjContinuous, pjCloseDot, pjDot, or pjDash.

NormalColor

Optional Long. The color of normal gridlines. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Interval



Optional Integer. A number from 0 to 99 that specifies the interval between gridlines.

IntervalType

Optional Long. The type for secondary gridlines. Can be one of the PjLineType constants.

IntervalColor
Optional Long. The color of secondary gridlines. Can be one of the PjColor constants.

Group Property

Returns or sets the group to which a resource belongs. Read/write String.

Group Property Example

The following example deletes the resources in the active project that belong to a group specified by the user.

Sub DeleteResourcesInGroup()


Dim Entry As String

' The group specified by the user


Dim Deletions As Integer
' The number of deleted resources


Dim R As Resource



' The resource object used in loop


' Prompt user for the name of a group.


Entry = InputBox$("Enter a group name:")


' Cycle through the resources of the active project.


For Each R in ActiveProject.Resources



' Delete a resource if its group name matches the user's request.



If R.Group = Entry Then




R.Delete




Deletions = Deletions + 1



End If


Next R


' Display the number of resources that were deleted.


MsgBox(Deletions & " resources were deleted.")

End Sub

HasPassword Property

True if a project has a password. Read-only Boolean.

HasPassword Property Example

The following example displays a list of open projects that have passwords.

Sub ListProjectsWithPasswords()


Dim P As Project 





' Project object used in For Each loop


Dim NameList As String



' Names of projects with passwords


' Check each open project for passwords.


For Each P in Application.Projects



' If a project has a password, add its name to the list.



If P.HasPassword Then




NameList = NameList & P.Name & vbCrLf



End If


Next P


' Display information about projects with passwords.


If NameList = "" Then



MsgBox("No open projects have passwords.")


Else



MsgBox("The following open projects have passwords: " & vbCrLf & vbCrLf & NameList)


End If

End Sub

Height Property

Returns or sets the height of the main window (Application object) or a project window (Window object) in points. Read/write Long.

Remarks

A window changes its height by moving its bottom edge, leaving the top edge unaffected.

Height Property Example

The following example places the main window in the lower half of the screen.

Sub PlaceProjectInLowerScreenHalf()


Dim WindowWidth As Double


Application.WindowState = pjMaximized


WindowWidth = Application.Width

'Remember the width when maximized.


Application.Height = Application.Height / 2


Application.Top = Application.Height
 
'Make sure the window uses all the available width.


If Application.Width < WindowWidth Then



Application.Width = WindowWidth



Application.Left = 0


End If

End Sub

HelpAbout Method

Displays the About Microsoft Project dialog box, which lists version, copyright, and license information about Microsoft Project.

Syntax

expression.HelpAbout
expression

Optional. An expression that returns an Application object.

Remarks

The HelpAbout method has the same effect as the About Microsoft Project command on the Help menu.

HelpAnswerWizard Method

Displays the Office Assistant (if it is not already started) and the built-in Assistant balloon.

Syntax

expression.HelpAnswerWizard
expression

Optional. An expression that returns an Application object.

Remarks

The HelpAnswerWizard method has the same effect as the Microsoft Project Help command on the Help menu.

HelpContents Method

Displays the Microsoft Project Help Topics dialog box with the Contents tab on top.

Syntax

expression.HelpContents
expression

Optional. An expression that returns an Application object.

Remarks

The HelpContents method has the same effect as the Contents and Index command on the Help menu.

HelpContextHelp Method

Invokes the ScreenTip cursor. Clicking a context displays a ScreenTip pop-up window.

Syntax

expression.HelpContextHelp
expression

Optional. An expression that returns an Application object.

HelpCreateYourProject Method

Starts a series of Help topics that guide the user through the process of creating a new project.

Syntax

expression.HelpCreateYourProject
expression

Optional. An expression that returns an Application object.

Remarks

The HelpCreateYourProject method has the same effect as the Create Your Project command on the Getting Started menu, available on the Help menu.

HelpLaunch Method

Starts a Help file.

Syntax

expression.HelpLaunch(FileName, ContextNumber, Search, SearchKey)
expression



Optional. An expression that returns an Application object.

FileName




Optional String. The file name of the Help file to start. If FileName is not specified and Search is False, the Contents and Index dialog box appears with the Contents tab on top.

ContextNumber

Optional Long. The context number of a topic to display.

Search





Optional Boolean. True if the Contents and Index dialog box appears with the Index tab on top. If Search is True, ContextNumber is ignored. The default value is False.

SearchKey



Optional String. A letter for the Index tab to search on.

HelpLaunch Method Example

The following example displays the Contents and Index dialog box with the Index tab on top, where "t" is entered as the search word and the first Index entry that starts with "t" is selected.

   Sub SearchHelp()

      HelpLaunch Search:=True, SearchKey:="t"

   End Sub

HelpMSProjectFundamentals Method

Starts a series of Help topics that provide a basic explanation of project management principles.

Syntax

expression.HelpMSProjectFundamentals
expression



Optional. An expression that returns an Application object.

Remarks

The HelpMSProjectFundamentals method has the same effect as the Microsoft Project 101: Fundamentals command on the Getting Started menu, available on the Help menu.

HelpQuickPreview Method

Starts the Quick Preview of Microsoft Project.

Syntax

expression.HelpQuickPreview
expression

Optional. An expression that returns an Application object.

HelpTechnicalSupport Method

Displays information about obtaining technical support for Microsoft Project.

Syntax

expression.HelpTechnicalSupport
expression

Optional. An expression that returns an Application object.

Remarks

The HelpTechnicalSupport method has the same effect as clicking the Tech Support button in the About Microsoft Project dialog box, available on the Help menu.

HideBar Property

True if a task bar does not appear on the Gantt Chart or Calendar. Read/write Boolean.

HonorConstraints Property

True if tasks honor their constraint dates. Read/write Boolean.

HourLabelDisplay Property

Returns or sets how the hour label displays in durations, delays, slack, work values, and so on. Read/write Integer.

The type of display varies from language to language and is determined by its order in the Hours as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
h

1
hr

2
hour

HoursPerDay Property

Returns or sets the number of hours per day for tasks in a project. Read/write Double.

HoursPerWeek Property

Returns or sets the number of hours per week for tasks in a project. Read/write Double.

Hyperlink Property

Returns or sets a friendly name representing a hyperlink address. The name may also be a URL or UNC path. Read/write String.

Hyperlink Property Example

The following example adds a hyperlink to all tasks in the active project, including tasks in subprojects.

Sub AddHyperlink()

    Dim T As Task

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            T.Hyperlink = "Microsoft"

            T.HyperlinkAddress = "http://www.microsoft.com/"

        End If

    Next T

End Sub

HyperlinkAddress Property

Returns or sets the URL or UNC path of a document. Read/write String.

HyperlinkAddress Property Example

The following example adds a hyperlink to all tasks in the active project, including tasks in subprojects.

Sub AddHyperlink()

    Dim T As Task

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            T.Hyperlink = "Microsoft"

            T.HyperlinkAddress = "http://www.microsoft.com/"

        End If

    Next T

End Sub

HyperlinkColor Property

Returns or sets the color used to denote unfollowed hyperlinks. Read/write Long.

Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

HyperlinkHREF Property

Returns or sets a combination of the hyperlink address and subaddress, separated by a "#". Read/write String.

HyperlinkSubAddress Property

Returns or sets the address of a location within the target document. Read/write String.

ID Property

Returns the identification number of a project, resource, or task. Read-only Long.

Remarks

The ID property changes when a task or resource moves to a new location on the Task Sheet or Resource Sheet.  Use the UniqueID property if you want a constant reference to a task or resource.

Index Property

Returns the index of an object in its containing collection. Read-only Long.

Remarks

For the Shift object, the Index property returns a shift number (1, 2, or 3).  For the Pane object, the Index property returns 1 for an upper pane or 2 for a lower pane.

Index Property Example

The following example switches to a window in the next project with the same index as the active window. This macro can help you compare information between projects that have a similar window arrangement.

For example, if you always put a Gantt chart in the same index of a project's Windows collection, you can display a Gantt chart in one project and then use this macro to easily switch to the Gantt charts of your other projects.

Sub ActivateSameWindowInNextProject()


' Check for a next project.


If ActiveProject.Index = Application.Projects.Count Then



MsgBox("No more open projects")


' Check for an equivalent window in the next project.


ElseIf ActiveProject.Windows.ActiveWindow.Index > Projects(ActiveProject.Index + 1).Windows.Count Then



MsgBox("No equivalent window in the next project")


' If everything's okay, switch to the window in the next project.


Else



Projects(ActiveProject.Index + 1).Windows(ActiveWindow.Index).Activate


End If

End Sub

InformationDialog Method

Displays the Assignment Information, Resource Information, or Task Information dialog box for the selected assignment, resource, or task.

Syntax

expression.InformationDialog(Tab)
expression

Optional. An expression that returns an Application object.

Tab




Optional Long. The tab to display in the Assignment Information, Resource Information, or Task Information dialog boxes.


If an assignment is selected, can be one of the following PjInformationTab constants: pjAssignmentGeneralTab, pjAssignmentTrackingTab, or pjAssignmentNotesTab.


If a resource is selected, can be one of the following PjInformationTab constants: pjResourceGeneralTab, pjResourceWorkingTimeTab, pjResourceCostsTab, or pjResourceNotesTab.


If a task is selected, can be one of the following PjInformationTab constants: pjTaskGeneralTab, pjTaskPredecessorsTab, pjTaskResourcesTab, pjTaskAdvancedTab, or pjTaskNotesTab.

Initials Property

Returns or sets the initials of a resource. Read/write String.

Initials Property Example

The following example sets the initials of each resource in the active project according to the spaces in the resource's name.  For example, a resource called "Glue Gun" receives the initials "GG."

Sub SetInitialsBasedOnName()

    Dim I As Integer        ' Index used in For loop

    Dim R As Resource       ' Resource used in For Each loop

    Dim NewInits As String  ' The new initials of the resource

    ' Cycle through the resources of the active project.

    For Each R In ActiveProject.Resources

        ' Initialize with first character of name.

        NewInits = Mid(R.Name, 1, 1)

        ' Look for spaces in the resource's name.

        For I = 1 To Len(R.Name)

           ' If not first character, and space is found, then add initial.

            If I > 1 And Mid(R.Name, I, 1) = Chr(32) Then

                If I + 1 <= Len(R.Name) Then

                    NewInits = NewInits & Mid(R.Name, I + 1, 1)

                End If

            End If

        Next I

        ' Give the resource its new initials.

        R.Initials = NewInits

    Next R

End Sub

InsertHyperlink Method

Inserts a hyperlink on the selected assignment, resource, or task.

Syntax

expression.InsertHyperlink(Name, Address, SubAddress)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the hyperlink as it appears in the Hyperlink field.

Address


Optional String. The address of the target document.

SubAddress

Optional String. A location within the target document.

Remarks

Using the InsertHyperlink method without specifying any arguments displays the Insert Hyperlink dialog box.

InsertNotes Method

Prompts the user to enter notes for the active assignment, resource, or task. If a resource or task doesn't exist for the selected cell, Microsoft Project creates a new resource (when a resource view is active) or a new task (when a task view is active).

Syntax

expression.InsertNotes
expression

Optional. An expression that returns an Application object.

Item Property

Returns a single item from a collection. Read-only Object.

Syntax

expression.Item(Index)
expression

Required. An expression that returns an object from the Applies To list.

Index



Required Variant. The name or index number of the object to return.

LastPrintedDate Property

Returns the date a project was last printed. Read-only Variant.

LastSaveDate Property

Returns the date a project was last saved. Read-only Variant.

LastSavedBy Property

Returns the name of the user who last saved a project. Read-only String.

LastSavedBy Property Example

The following example adds the date the active project was last saved and the name of the user who last saved it to the notes of the active project.

Sub AddSaveInfoToNotes()

    ActiveProject.ProjectNotes = ActiveProject.ProjectNotes & vbCrLf & "This project was last saved on " & CStr(ActiveProject.LastSaveDate) & " by " & ActiveProject.LastSavedBy & "."

End Sub

LateFinish Property

Returns the latest date on which a task can finish. Read-only Variant.

LateStart Property

Returns the latest date on which a task can start. Read-only Variant.

Layout Method

Displays the Layout dialog box, which allows the user to set layout options for the active view.

Syntax

expression.Layout
expression

Optional. An expression that returns an Application object.

Remarks

The Layout method is only available when a Gantt, PERT, or Calendar view is active.

LayoutNow Method

Lays out the active view according to its layout options.

Syntax

expression.LayoutNow
expression

Optional. An expression that returns an Application object.

Remarks

Layout options can be set with the Layout method.

The LayoutNow method is only available when a PERT or Calendar view is active.

Left Property

Returns or sets the distance of the main window from the left edge of the screen (Application object) or the distance of a project window from the left edge of the main window (Window object) in points. Read/write Long.

Level Method

Levels a resource.

Syntax

expression.Level

expression

Required. An expression that returns an object in the Applies To list.

Level Method Example

The following example levels the resources of the selected tasks.

Sub LevelResourcesInSelectedTasks()

    Dim T As Task       ' Task object used in For Each loop

    Dim A As Assignment ' Assignment object used in For Each loop

    For Each T In ActiveSelection.Tasks

        For Each A In T.Assignments

            If ActiveProject.Resources(A.ResourceID).Overallocated Then

                ActiveProject.Resources(A.ResourceID).Level
            End If

        Next A

    Next T

End Sub

LevelClearDates Method

Sets the leveling range to include the entire project.

Syntax

expression.LevelClearDates
expression

Optional. An expression that returns a Project object.

LevelEntireProject Property

True if the entire project is leveled. False if only overallocated resources within specified dates are leveled. Read/write Boolean.

LevelFromDate Property

Returns or sets the starting date of a range in which overallocated resources are leveled. The default is the project start date or the last entered date value. Read/write Variant.

LevelFromDate Property Example

The following example lets the user change the date range where leveling occurs, if the current range starts on the project start date or finishes on the project finish date.

Sub ChangeLevelingDates()

    Dim Response As Long

    Dim NewFrom As Variant, NewTo As Variant

    With ActiveProject

        If Application.DateDifference(.ProjectSummaryTask.Start, .LevelFromDate) = 0 Then

            Response = MsgBox("Overallocated resources are leveled from " & _

                "the project start date. Should that be changed?", vbYesNo)

            If Response = vbYes Then

                NewFrom = InputBox("Date to level from: ")

                .LevelFromDate = NewFrom

            Else

                MsgBox "Resources remain leveled from the project start date."

            End If

        End If

        If Application.DateDifference(.ProjectSummaryTask.Finish, .LevelToDate) = 0 Then

            Response = MsgBox("Overallocated resources are leveled to " & _

                "the project finish date. Should that be changed?", vbYesNo)

            If Response = vbYes Then

                NewTo = InputBox("Date to level to: ")

                .LevelToDate = NewTo

            Else

                MsgBox "Resources remain leveled to the project finish date."

            End If

        End If

    End With

End Sub

LevelIndividualAssignments Property

True if leveling can adjust individual assignments on a task. False if all assignments on a task will be adjusted, including those that are not overallocated. Read/write Boolean.

LevelingCanSplit Property

True if leveling can create splits in remaining work. Read/write Boolean.

LevelingClear Method

Removes the effects of leveling.

Syntax

expression.LevelingClear(All)
expression

Optional. An expression that returns an Application object.

All




Optional Boolean. True if delays are removed from all tasks. False if delays are removed from selected tasks only.

Remarks

Using the LevelingClear method without specifying any arguments displays the Clear Leveling dialog box.

LevelingDelay Property

Returns or sets the amount to delay the assignment or task due to leveling. Read/write Variant.

LevelingOptions Method

Specifies leveling options for the active project.

Syntax

expression.LevelingOptions(Automatic, DelayInSlack, RemoveDelay, Order, LevelEntireProject, FromDate, ToDate, PeriodBasis, LevelIndividualAssignments, LevelingCanSplit)
expression

Optional. An expression that returns an Application object.

Automatic

Optional Boolean. True if Microsoft Project automatically levels tasks in the active project.

DelayInSlack
Optional Boolean. True if the active project can only be leveled within the available slack time. False if the project can be delayed in order to level resources.

RemoveDelay
Due to changes in the Microsoft Project object model, this argument no longer has an effect. It has been retained for backwards compatibility.

Order



Optional Long. A constant that specifies how Microsoft Project should resolve resource conflicts when leveling tasks in the active project. Can be one of the following PjLevelOrder constants:

Constant
Description

 


pjLevelID
Microsoft Project uses only identification numbers to resolve resource conflicts.

pjLevelStandard
Microsoft Project uses predecessor relationships, slack time, dates, priority, and task constraints to resolve resource conflicts.

pjLevelPriority
Microsoft Project considers priority first when resolving resource conflicts.

LevelEntireProject

Optional Boolean. True if the entire project is leveled. False if only the resources in the date range specified with FromDate and ToDate are leveled.

FromDate





Optional Variant. The starting date of a range within which overallocated resources are leveled. The FromDate argument is ignored if LevelEntireProject is True.

ToDate






Optional Variant. The ending date of a range within which overallocated resources are leveled. The ToDate argument is ignored if LevelEntireProject is True.

PeriodBasis




Optional Long. Specifies how often Microsoft Project should look for overallocated resources. Can be one of the following PjLevelPeriodBasis constants: pjMinuteByMinute, pjHourByHour, pjDayByDay, pjWeekByWeek, or pjMonthByMonth.

LevelIndividualAssignments

Optional Boolean. True if leveling can adjust individual assignments on a task.

LevelingCanSplit


Optional Boolean. True if leveling can create splits in remaining work.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Resource Leveling dialog box.

Using the LevelingOptions method without specifying any arguments brings up the Resource Leveling dialog box.

LevelingOptions Method Example

The following example levels resources in the application using priority to resolve conflicts.

Sub LevelOverallocatedResources()


LevelingOptions Order:=pjLevelPriority


LevelNow (True)

End Sub

LevelNow Method

Levels overallocated resources.

Syntax

expression.LevelNow(All)
expression


Optional. An expression that returns an Application object.

All





Optional Boolean. True if all resources are leveled. False if only selected resources are leveled.

Remarks

Using the LevelingNow method without specifying any arguments displays the Level Now dialog box.

LevelOrder Property

Returns or sets the order in which tasks with overallocations will be delayed when resources are leveled. Can be one of the following PjLevelOrder constants: pjLevelID, pjLevelStandard, or pjLevelPriority. Read/write Long.

LevelPeriodBasis Property

Returns or sets the period by which resources are checked for overallocations. Can be one of the following PjLevelPeriodBasis constants: pjMinuteByMinute, pjHourByHour, pjDayByDay, pjWeekByWeek, or pjMonthByMonth. Read/write Long.

LevelToDate Property

Returns or sets the ending date of a range in which overallocated resources are leveled. The default is the project finish date or the last entered date value. Read/write Variant.

LevelToDate Property Example

The following example lets the user change the date range where leveling occurs, if the current range starts on the project start date or finishes on the project finish date.

Sub ChangeLevelingDates()

    Dim Response As Long

    Dim NewFrom As Variant, NewTo As Variant

    With ActiveProject

        If Application.DateDifference(.ProjectSummaryTask.Start, .LevelFromDate) = 0 Then

            Response = MsgBox("Overallocated resources are leveled from " & _

                "the project start date. Should that be changed?", vbYesNo)

            If Response = vbYes Then

                NewFrom = InputBox("Date to level from: ")

                .LevelFromDate = NewFrom

            Else

                MsgBox "Resources remain leveled from the project start date."

            End If

        End If

        If Application.DateDifference(.ProjectSummaryTask.Finish, .LevelToDate) = 0 Then

            Response = MsgBox("Overallocated resources are leveled to " & _

                "the project finish date. Should that be changed?", vbYesNo)

            If Response = vbYes Then

                NewTo = InputBox("Date to level to: ")

                .LevelToDate = NewTo

            Else

                MsgBox "Resources remain leveled to the project finish date."

            End If

        End If

    End With

End Sub

LevelWithinSlack Property

True if leveling must occur within total slack. Read/write Boolean.

LinkedFields Property

True if the assignment, resource, or task contains fields that are linked to other applications through OLE. Read-only Boolean.

LinkPredecessors Method

Adds predecessors to a task.

Syntax

expression.LinkPredecessors(Tasks, Type, Lag)
expression

Required. An expression that returns a Task object.

Tasks



Required Object. The Task or Tasks object specified becomes a predecessor of the task specified with expression.

Type




Optional Long. A constant that specifies the relationship between tasks that become linked. Can be one of the following PjTaskLinkType constants: pjFinishToStart, pjStartToFinish, pjStartToStart, or pjFinishToFinish. The default value is pjFinishToStart.

Lag




Optional Variant. A string that specifies the duration of lag time between linked tasks. To specify lead time between tasks, use an expression for Lag that evaluates to a negative value.

LinkPredecessors Method Example

The following example prompts the user for the name of a task and then makes the task a predecessor of the selected tasks.

Sub LinkTasksFromPredecessor()

    Dim Entry As String     ' Task name entered by user

    Dim T As Task           ' Task object used in For Each loop

    Dim I As Long           ' Used in For loop

    Dim Exists As Boolean   ' Whether or not the task exists

    Entry = InputBox$("Enter the name of a task:")

    Exists = False          ' Assume task doesn't exist.

    ' Search active project for the specified task.

    For Each T In ActiveProject.Tasks

        If T.Name = Entry Then

            Exists = True

            ' Make the task a predecessor of the selected tasks.

            For I = 1 To ActiveSelection.Tasks.Count

            ActiveSelection.Tasks(I).LinkPredecessors Tasks:=T

            Next I

        End If

    Next T

    ' If task doesn't exist, display error and quit Sub procedure.

    If Not Exists Then

        MsgBox ("Task not found.")

        Exit Sub

    End If

End Sub

LinksBetweenProjects Method

Specifies whether the Links between Projects dialog box appears when opening a project containing cross-project links.

Syntax

expression.LinksBetweenProjects(AcceptAll)
expression

Optional. An expression that returns an Application object.

AcceptAll


Optional Boolean. True if all changes to external predecessors and successors are accepted. False if the Links between Projects dialog box appears. The default value is False.

LinkSuccessors Method

Adds successors to a task.

Syntax

expression.LinkSuccessors(Tasks, Type, Lag)
expression

Required. An expression that returns a Task object.

Tasks



Required Object. The Task or Tasks object specified becomes a successor of the task specified with expression.

Type




Optional Long. A constant that specifies the relationship between tasks that become linked. Can be one of the following PjTaskLinkType constants: pjFinishToStart, pjStartToFinish, pjStartToStart, or pjFinishToFinish. The default value is pjFinishToStart.

Lag




Optional Variant. A string that specifies the duration of lag time between linked tasks. To specify lead time between tasks, use an expression for Lag that evaluates to a negative value.

LinkTasks Method

Links the selected tasks in the Gantt Chart, Calendar, Task Sheet, or Task Usage view.

Syntax

expression.LinkTasks
expression

Optional. An expression that returns an Application object.

LinkTasksEdit Method

Edits task dependencies (links).

Syntax

expression.LinkTasksEdit(From, To, Delete, Type, Lag, PredecessorProjectName, SuccessorProjectName)
expression

Optional. An expression that returns an Application object.

From



Required Long. The identification number of a predecessor task.

To




Required Long. The identification number of a successor task.

Delete



Optional Boolean. True if Microsoft Project deletes the referenced link. The default value is False.

Type




Optional Long. The relationship between tasks that become linked. Can be one of the following PjTaskLinkType constants: pjFinishToFinish, pjFinishToStart, pjStartToFinish, or pjStartToStart. The default value is pjFinishToStart.

Lag




Optional Variant. The duration between linked tasks in default units.  To specify lead time between tasks, use a negative value.

PredecessorProjectName

Optional String. The name of the inserted project in a consolidated project that contains the task identified with From. If PredecessorProjectName is omitted, the current project is assumed.

SuccessorProjectName

Optional String. The name of the inserted project in a consolidated project that contains the task identified with To. If SuccessorProjectName is omitted, the current project is assumed.

LinkTasksEdit Method Example

The following example prompts the user for a range of task identification numbers, and then links the tasks in the range from finish to start. This example assumes the ID range is valid, as well as the absence of any duplicate tasks, null tasks, consolidated projects, and so on.

Sub LinkFinishToStart()

    Dim FirstID As String     ' The ID number of the first task

    Dim LastID As String      ' The ID number of the last task

    Dim NextID As Long        ' The ID number of the next task to link

    FirstID = InputBox$("Enter the ID number of the first task to link:")

    If FirstID = Empty Then Exit Sub

    LastID = InputBox$("Enter the ID number of the last task to link:")

    If LastID = Empty Then Exit Sub

    ' Convert FirstID from String to Long, then "seed" the loop.

    NextID = CLng(FirstID)

    Do Until NextID = CLng(LastID)

        LinkTasksEdit From:=NextID, To:=NextID + 1, Type:=pjFinishToStart

        NextID = NextID + 1

    Loop

End Sub

List Object

Represents a collection of strings or numbers that contain field identification numbers, field names, reports, resource filters, resource tables, resource views, task filters, task tables, task views, or views. There is no collection for List objects. Where the List object appears in this diagram, it can be accessed through the ItemList properties of the appropriate objects, where Item is a placeholder for one of the items mentioned above.

Using the List Object

Use a property like the ReportList property to return a List object. The following example displays a list of all the reports available in the active project.

Dim Items As Integer, ReportNames As String

For Items = 1 To ActiveProject.ReportList.Count

    ReportNames = ActiveProject.ReportList(Items) & _

        ListSeparator & " " & ReportNames

Next Items

MsgBox Left$(ReportNames, Len(ReportNames) - Len(ListSeparator & " "))

ListSeparator Property

Returns the character that separates items in lists. Read-only String.

Remarks

Microsoft Project sets the ListSeparator property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

LoadLastFile Property

True if the file last opened opens automatically when Microsoft Project is started. Read/write Boolean.

Macro Method

Runs a macro.

Syntax

expression.Macro(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the macro to run. If Name is omitted, the Macros dialog box appears.

Macro Method Example

The following example runs a macro named CheckShifts.

Sub RunMacro()


Macro "CheckShifts"

End Sub

MacroShowCode Method

Starts the Visual Basic Editor and displays any macro code in the active project.

Syntax

expression.MacroShowCode
expression

Optional. An expression that returns an Application object.

MacroShowVba Method

Starts the Visual Basic Editor.

Syntax

expression.MacroShowVba
expression

Optional. An expression that returns an Application object.

Remarks

The MacroShowVba method has the same effect as the Visual Basic Editor command on the Macro submenu, which is available on the Tools menu.

MacroVirusProtection Property

True if macro virus protection is enabled. Read/write Boolean.

MailLogoff Method

Closes an established MAPI mail session.

Syntax

expression.MailLogoff
expression

Optional. An expression that returns an Application object.

MailLogoff Method Example

The following example checks for an existing mail session and logs off it. If not logged on, the following example logs on, downloads any new mail, and then logs off.

Sub LogoffFromMail()

    If Not IsNull(MailSession) Then

        MsgBox "Logging off mail session: " & MailSession

        Application.MailLogoff
    Else

        MsgBox "Logging on to mail session now."

        Application.MailLogon DownloadNewMail:=True

        MsgBox "Logging off mail session: " & MailSession

        Application.MailLogoff
    End If

End Sub

MailLogon Method

Logs on to a MAPI mail system and establishes a mail session. A mail session must be established before mail or document routing methods can be used.

Syntax

expression.MailLogon(Name, Password, DownloadNewMail)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The mail account name.

Password


Optional String. The mail account password.

DownloadNewMail

Optional Boolean. True if new mail is downloaded immediately.

Remarks

Previously established mail sessions are logged off before an attempt is made to establish the new session.

Omit both Name and Password to use the default mail session for the system.

MailLogon Method Example

The following example logs on to the mail system and downloads any new mail.

Sub SessionLogon()


If IsNull(MailSession) Then



Application.MailLogon "oscarx", "mypassword", True


End If

End Sub

MailPostDocument Method

Displays the Send To Exchange Folder dialog box to post a document to Microsoft Exchange.

Syntax

expression.MailPostDocument
expression

Optional. An expression that returns an Application object.

Remarks

The MailPostDocument method is only available when a mail system utilizes a Microsoft Exchange server. 

MailProjectMailCustomize Method

Customizes workgroup messages.

Syntax

expression.MailProjectMailCustomize(Action, Position, FieldID, Title, IncludeInTeamStatus, Editable)
expression

Optional. An expression that returns an Application object.

Action



Optional Long. The type of action to be taken. Can be one of the following PjCustomizeMailAction constants:

Constant
Description

 


pjMailEndFields
End of field definitions

pjMailStartFields
Number of fields

pjMailDefineField
Field definitions

Position


Optional Long. If Action is pjMailStartFields, the number of fields. The value of Position must be greater than 6 to allow for other fields that are required. If Action is pjMailDefineField, the position of the field specified by FieldID. Required if Action is pjMailStartFields or pjMailDefineField.

FieldID



Optional Long. The fields to be included in the message. Required if Action is pjMailDefineField. Can be one of the following PjMailField constants:

Constant
Description

 


pjMailActualWork
Actual Work field for workgroup messages

pjMailComments
Comments field for workgroup messages

pjMailFinish
Finish field for workgroup messages

pjMailStart
Start field for workgroup messages

pjMailWork
Work field for workgroup messages

pjMailTaskContact
Contact field

pjMailTaskCost
Cost field

pjMailTaskCost1
Cost1 field

pjMailTaskCost2
Cost2 field

pjMailTaskCost3
Cost3 field

pjMailTaskCost4
Cost4 field

pjMailTaskCost5
Cost5 field

pjMailTaskCost6
Cost6 field

pjMailTaskCost7
Cost7 field

pjMailTaskCost8
Cost8 field

pjMailTaskCost9
Cost9 field

pjMailTaskCost10
Cost10 field

pjMailTaskCritical
Critical field

pjMailTaskDate1
Date1 field

pjMailTaskDate2
Date2 field

pjMailTaskDate3
Date3 field

pjMailTaskDate4
Date4 field

pjMailTaskDate5
Date5 field

pjMailTaskDate6
Date6 field

pjMailTaskDate7
Date7 field

pjMailTaskDate8
Date8 field

pjMailTaskDate9
Date9 field

pjMailTaskDate10
Date10 field

pjMailTaskDuration
Duration field

pjMailTaskDuration1
Duration1 field

pjMailTaskDuration2
Duration2 field

pjMailTaskDuration3
Duration3 field

pjMailTaskDuration4
Duration4 field

pjMailTaskDuration5
Duration5 field

pjMailTaskDuration6
Duration6 field

pjMailTaskDuration7
Duration7 field

pjMailTaskDuration8
Duration8 field

pjMailTaskDuration9
Duration9 field

pjMailTaskDuration10
Duration10 field

pjMailTaskEarlyFinish
Early Finish field

pjMailTaskEarlyStart
Early Start field

pjMailTaskFinish1
Finish1 field

pjMailTaskFinish2
Finish2 field

pjMailTaskFinish3
Finish3 field

pjMailTaskFinish4
Finish4 field

pjMailTaskFinish5
Finish5 field

pjMailTaskFinish6
Finish6 field

pjMailTaskFinish7
Finish7 field

pjMailTaskFinish8
Finish8 field

pjMailTaskFinish9
Finish9 field

pjMailTaskFinish10
Finish10 field

pjMailTaskFixedCost
Fixed Cost field

pjMailTaskFlag1
Flag1 field

pjMailTaskFlag2
Flag2 field

pjMailTaskFlag3
Flag3 field

pjMailTaskFlag4
Flag4 field

pjMailTaskFlag5
Flag5 field

pjMailTaskFlag6
Flag6 field

pjMailTaskFlag7
Flag7 field

pjMailTaskFlag8
Flag8 field

pjMailTaskFlag9
Flag9 field

pjMailTaskFlag10
Flag10 field

pjMailTaskFlag11
Flag11 field

pjMailTaskFlag12
Flag12 field

pjMailTaskFlag13
Flag13 field

pjMailTaskFlag14
Flag14 field

pjMailTaskFlag15
Flag15 field

pjMailTaskFlag16
Flag16 field

pjMailTaskFlag17
Flag17 field

pjMailTaskFlag18
Flag18 field

pjMailTaskFlag19
Flag19 field

pjMailTaskFlag20
Flag20 field

pjMailTaskFreeSlack
Free Slack field

pjMailTaskLateFinish
Late Finish field

pjMailTaskLateStart
Late Start field

pjMailTaskMarked
Marked field

pjMailTaskName
Name field

pjMailTaskNumber1
Number1 field

pjMailTaskNumber2
Number2 field

pjMailTaskNumber3
Number3 field

pjMailTaskNumber4
Number4 field

pjMailTaskNumber5
Number5 field

pjMailTaskNumber6
Number6 field

pjMailTaskNumber7
Number7 field

pjMailTaskNumber8
Number8 field

pjMailTaskNumber9
Number9 field

pjMailTaskNumber10
Number10 field

pjMailTaskNumber11
Number11 field

pjMailTaskNumber12
Number12 field

pjMailTaskNumber13
Number13 field

pjMailTaskNumber14
Number14 field

pjMailTaskNumber15
Number15 field

pjMailTaskNumber16
Number16 field

pjMailTaskNumber17
Number17 field

pjMailTaskNumber18
Number18 field

pjMailTaskNumber19
Number19 field

pjMailTaskNumber20
Number20 field

pjMailTaskPercentComplete
Percent Complete field

pjMailTaskPercentWorkComplete
Percent Work Complete field

pjMailTaskPriority
Priority field

pjMailTaskProject
Project field

pjMailTaskResourceNames
Resource Names field

pjMailTaskStart1
Start1 field

pjMailTaskStart2
Start2 field

pjMailTaskStart3
Start3 field

pjMailTaskStart4
Start4 field

pjMailTaskStart5
Start5 field

pjMailTaskStart6
Start6 field

pjMailTaskStart7
Start7 field

pjMailTaskStart8
Start8 field

pjMailTaskStart9
Start9 field

pjMailTaskStart10
Start10 field

pjMailTaskText1
Text1 field

pjMailTaskText2
Text2 field

pjMailTaskText3
Text3 field

pjMailTaskText4
Text4 field

pjMailTaskText5
Text5 field

pjMailTaskText6
Text6 field

pjMailTaskText7
Text7 field

pjMailTaskText8
Text8 field

pjMailTaskText9
Text9 field

pjMailTaskText10
Text10 field

pjMailTaskText11
Text11 field

pjMailTaskText12
Text12 field

pjMailTaskText13
Text13 field

pjMailTaskText14
Text14 field

pjMailTaskText15
Text15 field

pjMailTaskText16
Text16 field

pjMailTaskText17
Text17 field

pjMailTaskText18
Text18 field

pjMailTaskText19
Text19 field

pjMailTaskText20
Text20 field

pjMailTaskText21
Text21 field

pjMailTaskText22
Text22 field

pjMailTaskText23
Text23 field

pjMailTaskText24
Text24 field

pjMailTaskText25
Text25 field

pjMailTaskText26
Text26 field

pjMailTaskText27
Text27 field

pjMailTaskText28
Text28 field

pjMailTaskText29
Text29 field

pjMailTaskText30
Text30 field

pjMailTaskTotalSlack
Total Slack field

pjMailTaskWBS
WBS field

pjMailTaskWork
Work field

Title



Optional String. The title of the field presented to the user. If Title is omitted, the field name is used for the title string.

IncludeInTeamStatus

Optional Boolean. True if the fields specified with FieldID are included in TeamAssign and TeamStatus messages. False if the fields specified with FieldID are only included in TeamAssign messages. Required if Action is pjMailDefineField. The default value is True.

Editable

Optional Boolean. True if the field is editable by a resource. Required if Action is pjMailDefineField.

Remarks

The MailProjectMailCustomize method is available even when no projects are open.

MailProjectMailCustomize Method Example

The following example first sets up how many fields will be defined (Action:=pjMailStartFields). The next set of lines define each field (Action:=pjMailDefineField). You must include the definitions of the default fields with the same values for the IncludeInTeamStatus and Editable arguments. The last line indicates that the definitions are complete (Action:=pjMailEndFields). It will check for the existence of the default fields and give a run-time error if they are not given.

Note   The default fields (Name, Work, Start, Finished, Completed and Remaining Work, and Comments) must be included in every workgroup message. The order of these fields can change, but their basic definition (Editable, IncludeInTeamStatus) must remain the same as the default.

Sub MailProjectMailCustomize()

    MailProjectMailCustomize Action:=pjMailStartFields, Position:=number of fields
    MailProjectMailCustomize Action:=pjMailDefineField, Position:=1, FieldID:=constant, Title:="My Title"

    ...

    MailProjectMailCustomize Action:=pjMailDefineField, Position:=n, FieldID:=constant, Title:="another title"

    MailProjectMailCustomize Action:=pjMailEndFields

End Sub

Where number of fields is the number of fields in the message, constant is one of the PjMailField constants, n is the position of the field within the message, and another title is the title of a newly defined field.

MailRoutingSlip Method

Adds a mail routing slip to the active project.

Syntax

expression.MailRoutingSlip(To, Subject, Body, AllAtOnce, ReturnWhenDone, TrackStatus, Clear, SendNow)
expression

Optional. An expression that returns an Application object.

To




Optional String. The user names of the recipients of the message, separated by commas.

Subject


Optional String. The subject of the message.

Body



Optional String. The main text of the message.

AllAtOnce

Optional Boolean. True if the message is sent to all users at the same time. False if the message is routed from one user to the next. The default value is False.

ReturnWhenDone

Optional Boolean. True if the message returns to the sender after reaching the last recipient. The default value is True.

TrackStatus

Optional Boolean. True if the location of the message is tracked. The default value is True.

Clear



Optional Boolean. True if the list of user names in the Routing Slip dialog box is cleared. The default value is False.

SendNow


Optional Boolean. True if the project is sent. False if the mail slip is edited without sending the project. The default value is False.

Remarks

Using the MailRoutingSlip method without specifying any arguments displays the Routing Slip dialog box.

MailRoutingSlip Method Example

The following example sends the current schedule to Julie Rogers and then to Michael Edwards.

Sub PlanApproval()


MailRoutingSlip To:="Julie Rogers,Michael Edwards", 



Subject:="Project Plan Approval", _



Body:="Please review the following plan for approval.", _



AllAtOnce:=False, ReturnWhenDone:=True, _



TrackStatus:=True, SendNow:=True

End Sub

MailSend Method

Sends a mail message.

Syntax

expression.MailSend(To, Cc, Subject, Body, Enclosures, IncludeDocument, ReturnReceipt, Bcc, Urgent, SaveCopy, AddRecipient)
expression

Optional. An expression that returns an Application object.

To




Optional String. The user names of the primary recipients of the message, separated by commas.

Cc




Optional String. The user names of the secondary recipients of the message, separated by commas.

Subject


Optional String. The subject of the message.

Body



Optional String. The main text of the message.

Enclosures



Optional String. The file names of one or more files to include with the message. Use the list separator character to separate multiple file names. Do not add space between the list separator and the file name.

IncludeDocument

Optional Boolean. True if the active project is included in the message. The default value is True.

ReturnReceipt


Optional Boolean. True if a message is sent to the sender when the recipient opens the message. The default value is False.

Bcc






Optional String. The user names of the message recipients which are not displayed, separated by semicolons. This argument is only supported in Microsoft Project for the Macintosh version 4.0.

Urgent





Optional Boolean. True if the message is given a high priority. This argument is only supported in Microsoft Project for the Macintosh version 4.0.

SaveCopy



Optional Boolean. True if a copy of the message is saved in the Sent Items folder. This argument is only supported in Microsoft Project for the Macintosh version 4.0.

AddRecipient


Optional Boolean. True if recipients of the message are added to a personal address book. This argument is only supported in Microsoft Project for the Macintosh version 4.0.

Remarks

If the MailSend method is used without specifying any arguments and there are no existing routing slips, a standard compose mail window appears with the active project as an embedded object. Otherwise, using the MailSend method without specifying any arguments prompts whether or not to use the routing slip.

MailSendProjectMail Method

Sends mail about the active project.

Syntax

expression.MailSendProjectMail(MessageType, Subject, Body, Fields, UpdateAsOf, ShowDialog, InstallationMessage)
expression


Optional. An expression that returns an Application object.

MessageType

Optional String. The type of message to send. Can be one of the following message types:

Message Type
Description




"Custom"
Sends custom project information to resources assigned to selected tasks

"TaskRequest"
Sends a message about task assignments

"TaskUpdates"
Notifies resources of changes in assigned tasks

"UpdateRequest"
Sends a message requesting status on selected tasks

Subject



Optional String. The subject of the message.

Body




Optional String. The main text of the message.

Fields




Optional String. The names of one or more project fields to send in the message. Use the list separator character to separate multiple project fields. To specify a title for a field, enclose the title in brackets immediately after the field name.


For all message types except "Custom", the fields are added at the end of the default fields that would normally be sent. Default fields can be changed in the Customize Workgroup dialog box, found on the Customize submenu of the Tools menu.


If Fields is omitted and MessageType is "Custom", the Field Options dialog box appears so that the user can customize the field list.

UpdateAsOf


Optional Variant. The date through which a resource is asked to update status in response to an update request message.

ShowDialog


Optional Boolean. True if the message type's corresponding dialog box appears.

If MessageType is
the dialog box is




"Custom"
Send Project Information

"TaskRequest"
TeamAssign

"TaskUpdates"
TeamUpdate

 "UpdateRequest"
TeamStatus

InstallationMessage

Optional String. The message that appears to users who do not have the message handler installed. If specified, InstallationMessage replaces the default Microsoft Project message.

Remarks

If the MailSendProjectMail method is used without specifying any arguments, the TeamAssign dialog box appears.

MailSendScheduleNote Method

Sends a schedule note in mail.

Syntax

expression.MailSendScheduleNote(Manager, TaskContacts, Resources, Selection, IncludeDocument, IncludePicture, Body, Subject)
expression



Optional. An expression that returns an Application object.

Manager




Optional Boolean. True if the note is sent to the manager of the active project. The default value is True.

TaskContacts


Optional Boolean. True if the note is sent to the contacts for the active project. The default value is False.

Resources



Optional Boolean. True if the note is sent to the resources for the active project. The default value is True.

Selection




Optional Boolean. True if the note is sent to the selected resource. False if the note is sent to all resources. In a task view, Selection only applies to resources that are assigned to tasks. The default value is False.

IncludeDocument

Optional Boolean. True if the active project is included in the note. The default value is False.

IncludePicture


Optional Boolean. True if a picture of the active project is included in the note. The default value is True.

Body





Optional String. The main text of the note.

Subject




Optional String. The subject of the note.

Remarks

If the MailSendScheduleNote method is used without specifying any arguments, the Send Schedule Note dialog box appears.

MailSession Method

Returns the MAPI mail session number as a hexadecimal string if there is an active session, or returns Null if there is no session.

Syntax

expression.MailSession
expression



Optional. An expression that returns an Application object.

MailSystem Method

Returns the type of e-mail system installed on the host machine.

Syntax

expression.MailSystem
expression



Optional. An expression that returns an Application object.

Can return one of the following PjMailSystem constants:

Constant
Description




pjNoMailSystem
Unrecognized or missing e-mail system

pjMAPI
Microsoft Mail

pjMAPICompatible
E-mail system that is compatible with MAPI

MailSystem Method Example

The following example sends the project file if the host machine is using MAPI.

Sub SendMAPI()


If Application.MailSystem = pjMAPI Then



MailSend To:="Jean Selva", Subject:="Sample Subject"


End If

End Sub

MailUpdateProject Method

Uses feedback from Microsoft Project mail to update a project.

Syntax

expression.MailUpdateProject(DataFile)
expression



Optional. An expression that returns an Application object.

DataFile




Required String. The name of the file on which to base the update.

MapEdit Method

Creates or edits an import/export map.

Syntax

expression.MapEdit(Name, Create, OverwriteExisting, NewName, DataCategory, CategoryEnabled, TableName, FieldName, ExternalFieldName, ExportFilter, ImportMethod, MergeKey, HeaderRow, AssignmentData, TextDelimiter, TextFileOrigin, UseHtmlTemplate, TemplateFile, IncludeImage, ImageFile)
expression



Optional. An expression that returns an Application object.

Name





Required String. The name of the map to create, copy, or edit.

Create





Optional Boolean. True if Microsoft Project should create a new map. If NewName is not specified, the new map is given the name specified with Name. Otherwise, the new map is a copy of the map specified with Name and is given the name specified with NewName. The default value is False.

OverwriteExisting
Optional Boolean. True if an existing map should be overwritten with a new one. The default value is False.

NewName




Optional String. A new name for the existing map (Create is False) or the name for the new map copied from the existing map (Create is True). If NewName is not specified and Create is False, the map specified with Name retains its current name. The default value is Empty.

DataCategory


Optional Long. The category of data that will be modified by other arguments. Required if any of CategoryEnabled, TableName, FieldName, ExternalFieldName, ExportFilter, or MergeKey is specified. Can be one of the following PjDataCategory constants: pjMapTasks, pjMapResources, or pjMapAssignments.

CategoryEnabled

Optional Boolean. True if the map imports and exports the category of data specified with DataCategory. If Create is True and NewName is not specified, CategoryEnabled is set to True.

TableName



Optional String. The name of the external table or worksheet that the map imports data from or exports data to. The type of table is determined by the value of DataCategory. If Create is True and NewName is not specified, TableName is required.

FieldName



Optional String. The name of a field to add to the map. The field is mapped to the external field specified with ExternalFieldName. The type of field is determined by the value of DataCategory. If Create is True and NewName is not specified, FieldName is required.

ExternalFieldName
Optional String. The name of the external field to add to the map. The external field is mapped to the field specified with FieldName. If ExternalFieldName is not specified, the name specified with FieldName is also used for ExternalFieldName.

ExportFilter



Optional String. The name of the filter to use when exporting data. The type of filter is determined by the value of DataCategory. The default value is "All Tasks" when DataCategory is pjMapTasks, "All Resources" when DataCategory is pjMapResources, and ExportFilter is ignored when DataCategory is pjMapAssignments.

ImportMethod


Optional Long. The method to use when importing data. The default value is pjImportNew. Can be one of the following PjImportMethods constants:

Constant
Description

 


pjImportNew
Imported data is placed in a new project.

PjImportAppend
Imported data is appended to the end of the active project.

PjImportMerge
Imported data is merged into the active project.

MergeKey




Optional String. The name of the Microsoft Project field to use as a key when merging imported data. The field must exist and have already been added to the map. The type of field is determined by the value of DataCategory. If ImportMethod is pjImportMerge, MergeKey is required.

HeaderRow



Optional Boolean. True if a column header row should be created in the external file during an export and whether it exists in the external file during an import. If creating a headerless map (HeaderRow is False) that will be used to import the same data it exports, ExternalFieldName is required and must be a sequentially numbered value for each field exported, beginning with "1", to indicate its column position in the exported file. The default value is True.

AssignmentData

Optional Boolean. True if assignment rows should be included with exported resources and tasks. If True, assigned resources appear under each task in a task table and assigned tasks appear under each resource in a resource table. Data exported when AssignmentData is True cannot be imported by Microsoft Project. The default value is False.

TextDelimiter


Optional String. The character to use as a field delimiter when importing data from a text file. The default value is a tab character.

TextFileOrigin


Optional Long. Specifies the character set under which a text file was created. Can be one of the following PjTextFileOrigin constants: pjTextOriginWin, pjTextOriginDOS (including OS/2), pjTextOriginUnicode, or pjTextOriginMac.

UseHtmlTemplate
Optional Boolean. True if an export to an HTML file will be based on an HTML template.

TemplateFile


Optional String. The HTML template file to use when exporting to HTML. If UseHtmlTemplate is True and the map specified with Name does not contain the name of an HTML template file, TemplateFile is required.

IncludeImage


Optional Boolean. True if a reference to an image file should be included when exporting to HTML. The default value is False.

ImageFile




Optional String. The name of an image file to include when exporting to HTML.

MapEdit Method Example

The following example simply creates a map that allows the information on the default Gantt Chart to be exported and imported.

Sub MakeEntryTableMap()

    MapEdit Name:="Fields in the Gantt Chart View", Create:=True, OverwriteExisting:=True, _

        DataCategory:=pjMapTasks, CategoryEnabled:=True, TableName:="Task_Table", _

            FieldName:="ID", ExternalFieldName:="ID"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Name", ExternalFieldName:="Tasks"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Duration"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Start", ExternalFieldName:="Start_Date"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Finish", ExternalFieldName:="Finish_Date"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Predecessors"

    MapEdit Name:="Fields in the Gantt Chart View", DataCategory:=pjMapTasks, _

        FieldName:="Resource Names", ExternalFieldName:="Resources"

End Sub

Marked Property

True if the task is marked. Read/write Boolean.

MaxUnits Property

Sets or returns the maximum number of units of a resource. Read/write Variant.

MaxUnits Property Example

The following example sets the maximum units of each resource in the active project to a number specified by the user.

Sub SetDefaultMaxUnits()

    Dim Entry As String     ' Maximum units specified by user

    Dim R As Resource       ' Resource object used in loop

    Entry = InputBox$("Enter the default maximum units for each resource.")

    If IsNumeric(Entry) Then

        For Each R In ActiveProject.Resources

            R.MaxUnits = Entry

        Next R

    Else

        MsgBox ("You didn't enter a numeric value.")

    End If

End Sub

Message Method

Displays a message in a message box.

Syntax

expression.Message(Message, Type, YesText, NoText)
expression

Optional. An expression that returns an Application object.

Message


Required String. The message to display in the dialog box.

Type




Optional Long. The buttons to include in the message dialog box. Can be one of the following PjMessageType constants: pjOKOnly, pjOKCancel, pjYesNo, or pjYesNoCancel. The default value is pjOKOnly.

YesText


Optional String. The text to be displayed on the Yes button. The YesText argument is ignored unless Type is pjYesNo or pjYesNoCancel. The default value is "Yes".

NoText



Optional String. The text to be displayed on the No button. The NoText argument is ignored unless Type is pjYesNo or pjYesNoCancel. The default value is "No".

Remarks

The Message method is provided for compatibility with the macro language used in Microsoft Project version 3.x.

Milestone Property

True if the task is a milestone. Read/write Boolean.

Milestone Property Example

The following example marks as milestones any tasks in the active project with names that begin with the word "Inspection."

Sub MarkInspectionTasks()

    Dim T As Task ' Task object used in For Each loop

    Dim MilestoneName As String

    Dim NameLength As Integer

    MilestoneName = "Inspection"

    NameLength = Len(MilestoneName)

    For Each T In ActiveProject.Tasks

        ' If the task's name begins with Inspection, it's a milestone.

        If UCase(Left(T.Name, NameLength)) = UCase(MilestoneName) Then

            T.Milestone = True

        End If

    Next T

End Sub

MinuteLabelDisplay Property

Returns or sets how the minute label displays in durations, delays, slack, work values, and so on. Read/write Integer.

The type of display varies from language to language and is determined by its order in the Minutes as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
m

1
min

2
minute

Month Object, Months Collection Object

Represents a month or the months in a year. The Month object is a member of the Months collection.

Using the Month Object

Use Months(Index), where Index is the month index number, month name, or PjMonth constant, to return a single Month object. The following example counts the number of working days in each month of 1997 for each selected resource.

Dim R As Resource

Dim D As Integer, M As Integer, WorkingDays As Integer

For Each R In ActiveSelection.Resources()

    WorkingDays = 0

    With R.Calendar.Years(1997)

        For M = 1 To .Months.Count

            WorkingDays = 0

            For D = 1 To .Months(M).Days.Count

                If .Months(M).Days(D).Working = True Then

                    WorkingDays = WorkingDays + 1

                End If

            Next D

            MsgBox "There are " & WorkingDays & " working days in " & _

                .Months(M).Name & " for " & R.Name & "."

        Next M

    End With

Next R

Using the Months Collection

Use the Months property to return a Months collection. The following example counts the number of months in 1997.

ActiveProject.Calendar.Years(1997).Months.Count

MonthLeadingZero Property

True if Microsoft Project displays zeros before single-digit months in dates. Read-only Boolean.

Remarks

Microsoft Project sets the MonthLeadingZero property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Months Property

Returns a Months collection representing the months in a year. Read-only.

Months Property Example

The following example makes January 1 of every year a nonworking day.

Sub NewYearsDayOff()

    Dim Y As Year

    For Each Y In ActiveProject.Calendar.Years

        Y.Months(pjJanuary).Days(1).Working = False

    Next Y

End Sub

MoveAfterReturn Property

True if the field below the active field becomes active when you press enter. False if the field remains active. Read/write Boolean.

MultipleCriticalPaths Property

True if Microsoft Project calculates multiple critical paths for the project. False if only one critical path is calculated. Read/write Boolean.

Name Property

Returns the name of an application, calendar, cost rate table, day, month, project, resource, task, weekday, or year. Read-only String.

Remarks

The Name property is supported read/write for the Calendar, Project, Resource, and Task objects.

Name Property Example

The following example displays the task names that contain the specified text.

Sub NameExample()


Dim t As Task


Dim x As String


Dim y As String



x = InputBox$("Search for tasks that include the following text in their names:")


If Not x = "" Then



For Each t In ActiveProject.Tasks




If InStr(1, t.Name, x, 1) Then





y = y & vbCrLf & t.ID & ": " & t.Name



End If



Next t



If Len(y) = 0 Then




MsgBox "No tasks with the text " & x & " found in the project", 
vbExclamation



Else




MsgBox y



End If


End If

End Sub

NewProject Event

Occurs when a new project is created, including the default project created each time Microsoft Project starts, and is analogous to the Open event for existing projects. The NewProject event occurs before the new project's Activate event.

Syntax

Private Sub object_NewProject(ByVal pj As MSProject.Project)
Object



An object of type Application declared with events in a class module. For more information, see Using events with the Application object.

Pj

The project that was created.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

NewProject Event Example

The following example sets the number of working hours per day for every new project created. (This example requires a new class module and additional code for it to have an effect. For more information, see Using events with the Application object.)

Private Sub App_NewProject(ByVal pj As MSProject.Project)

    pj.HoursPerDay = 10

End Sub

Notes Property

Returns or sets the notes for an assignment, resource, or task. Read/write String.

Remarks

The Notes property does not accept characters with an ASCII value less than 32, except for the carriage return (ASCII 13) and linefeed (ASCII 10) characters.

Notes Property Example

The following example adds a comment to the notes of the resource in the active cell.

Sub SaveAndNoteTime()

    ActiveCell.Resource.Notes = ActiveCell.Resource.Notes & vbCrLf & vbCrLf & "No status report yet."

End Sub

Numbern Properties

Returns or sets a number associated with an assignment, resource, or task. The n placeholder can be a number from 1 to 20. Read/write Double.

NumberOfResources Property

Returns the number of resources in a project, not including blank entries. Read-only Long.

NumberOfTasks Property

Returns the number of tasks in a project, not including blank entries. Read-only Long.

ObjectChangeIcon Method

Changes the icon of the active object if it is displayed as one.

Syntax

expression.ObjectChangeIcon
expression

Optional. An expression that returns an Application object.

Remarks

The ObjectChangeIcon method has the same effect as the Change Icon command, which is available as a button in the Convert dialog box. (To open the Convert dialog box, click Object on the Edit menu, and then click Convert.)

ObjectConvert Method

Displays the Convert dialog box, which prompts the user to convert the active object to a new format.

Syntax

expression.ObjectConvert
expression

Optional. An expression that returns an Application object.

Remarks

The ObjectConvert method has the same effect as the Convert command on the Object submenu, which is available on the Edit menu.

ObjectInsert Method

Displays the Insert Object dialog box, which prompts the user to insert an object.

Syntax

expression.ObjectInsert
expression

Optional. An expression that returns an Application object.

Remarks

The ObjectInsert method has no effect if the active view is a combination view, PERT Chart, Task PERT Chart, or Resource Graph. In addition to these views, the ObjectInsert method has no effect unless a non-null task or resource is selected in the Task or Resource Sheet views. It is also disabled from the Calendar view.

ObjectLinks Method

Displays the Links dialog box, which prompts the user to edit OLE links in the active project.

Syntax

expression.ObjectLinks
expression

Optional. An expression that returns an Application object.

Remarks

The ObjectLinks method has the same effect as the Links command on the Edit menu.

To create an OLE link, use the EditPasteSpecial method.

Objects Property

Returns the number of OLE objects contained within a task or resource. Any objects inserted in a task's or resource's Notes field are not included in the count. Read-only Long.

ObjectVerb Method

Instructs the active object to perform an action.

Syntax

expression.ObjectVerb(Verb)
expression

Optional. An expression that returns an Application object.

Verb




Optional Long. The action that the active object should perform.

Remarks

For a list of the actions an object can perform, select the object, and then click Object on the Edit menu.

In Microsoft Windows 95 or Microsoft Windows NT 4.0, to determine the number associated with a particular action, run the command "regedit" by clicking the Start button and then clicking Run. The file RegEdit.exe is in your Windows folder.

For Microsoft Windows NT 3.5 or 3.51, run "regedt32" by using the Run command on the File menu. The file RegEdt32.exe is in the System32 directory of your Windows directory.

Negotiate the registry tree to  HKEY_CLASSES_ROOT\Name.DocumentName\protocol\StdFileEditing\Verb\number, where Name is the name of the application, DocumentName is the name of the document, and number is the key for an action. For Microsoft Project, for example, HKEY_CLASSES_ROOT\MSProject.Project.8\protocol\StdFileEditing\Verb\0 is the key for the "edit" command.

ODBCCreateDataSource Method

Displays the Create New Data Source dialog box so that new data sources can be defined for installed drivers.

Syntax

expression.ODBCCreateDataSource
expression

Optional. An expression that returns an Application object.

ODBCManageDataSource Method

Displays the ODBC Data Source Administrator dialog box so that defined data sources can be managed.

Syntax

expression.ODBCManageDataSource
expression

Optional. An expression that returns an Application object.

Open Event

Occurs when the project opens, but before the Activate event.

Syntax

Private Sub Project_Open(ByVal pj As MSProject.Project)
pj


The project that was opened.

Remarks

Microsoft Project events do not occur when the project is embedded in another document or application.

Open Event Example

This example adds the user's e-mail alias and the current date to a project's Comments field whenever it is opened. Placing this example in the Open event of a project would provide a simple access history for the file.

Private Sub Project_Open(ByVal pj As MSProject.Project)

    Dim Alias As String

    Alias = InputBox$("Please enter your e-mail alias: ")

    pj.ProjectSummaryTask.AppendNotes vbCrLf & "Opened by " & Alias & _

        " on " & Date$ & "."

End Sub

OperatingSystem Property

Returns the name and version of the operating system. Read-only String.

Remarks

For example, in Microsoft Windows 95, the OperatingSystem property returns "Windows (32-bit) 4.00".

OptionsCalculation Method

Sets calculation options.

Syntax

expression.OptionsCalculation(Automatic, AutoTrack, SpreadPercentToStatusDate, SpreadCostsToStatusDate, AutoCalcCosts, FixedCostAccrual, CalcMultipleCriticalPaths, CriticalSlack, SetDefaults)
expression


Optional. An expression that returns an Application object.

Automatic


Optional Boolean. True if the calculation mode is automatic.

AutoTrack


Optional Boolean. True if task tracking fields automatically update resource assignments.

SpreadPercentToStatusDate

Optional Boolean. True if edits to total task percent complete are spread to the status date.

SpreadCostsToStatusDate


Optional Boolean. True if edits to total actual cost are spread to the status date. The SpreadCostsToStatusDate argument is ignored if AutoCalcCosts is True.

AutoCalcCosts

Optional Boolean. True if actual costs are always calculated by Microsoft Project.

FixedCostAccrual





Optional Long. The default method used to accrue fixed costs. Can be one of the following PjAccrueAt constants: pjStart, pjEnd, or pjProrated.

CalcMultipleCriticalPaths



Optional Boolean. True if Microsoft Project calculates multiple critical paths for the project.

CriticalSlack


Optional Integer. The maximum amount of slack allowed for critical tasks.

SetDefaults


Optional Boolean. True if the values specified for all arguments except Automatic become the default for new projects.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Calculation tab of the Options dialog box.

Using the OptionsCalculation method without specifying any arguments brings up the Options dialog box with the Calculation tab selected.

OptionsCalendar Method

Sets options for the calendar of the active project.

Syntax

expression.OptionsCalendar(StartWeekOnMonday, StartYearIn, StartTime, FinishTime, HoursPerDay, HoursPerWeek, SetDefaults, StartWeekOn, UseFYStartYear)
expression


Optional. An expression that returns an Application object.

StartWeekOnMonday

Optional Boolean. True if the calendar week starts on Monday. False if the calendar week starts on Sunday. If StartWeekOn is specified, StartWeekOnMonday is ignored. (The StartWeekOn argument is a better way to specify the start of the week.)

StartYearIn


Optional Long. The first month of the fiscal year. Can be one of the following PjMonth constants:

pjJanuary
pjJuly

pjFebruary
pjAugust

pjMarch
pjSeptember

pjApril
pjOctober

pjMay
pjNovember

pjJune
pjDecember

StartTime



Optional Variant. The default start time for working days.

FinishTime


Optional Variant. The default finish time for working days.

HoursPerDay

Optional Double. The default number of work hours per day.

HoursPerWeek

Optional Double. The default number of work hours per week.

SetDefaults


Optional Boolean. True if the values of StartYearIn, StartTime, FinishTime, HoursPerDay, HoursPerWeek, StartWeekOn, and UseFYStartYear are used as the default values for new projects. The default value is False.

StartWeekOn

Optional Long. The first day of the week. Can be one of the following PjWeekday constants: pjSunday, pjMonday, pjTuesday, pjWednesday, pjThursday, pjFriday, or pjSaturday.

UseFYStartYear
Optional Boolean. True if a fiscal year is determined by the year of the first month of that fiscal year. False if determined by the last month of the fiscal year.


For example, if StartYearIn was pjJuly (to denote July 1997) and UseFYStartYear was True, the fiscal year ending in June 1998 would be FY97.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Calendar tab of the Options dialog box.

Using the OptionsCalendar method without specifying any arguments displays the Options dialog box with the Calendar tab selected.

OptionsEdit Method

Sets editing options.

Syntax

expression.OptionsEdit(MoveAfterReturn, DragAndDrop, UpdateLinks, CopyResourceUsageHeader, PhoneticInfo, PhoneticType, MinuteLabelDisplay, HourLabelDisplay, DayLabelDisplay, WeekLabelDisplay, YearLabelDisplay, SpaceBeforeTimeLabel, SetDefaults)
expression




Optional. An expression that returns an Application object.

MoveAfterReturn


Optional Boolean. True if the next cell or field becomes active when enter is pressed. False if the current cell or field remains active.

DragAndDrop



Optional Boolean. True if cells may be copied or moved by dragging them.

UpdateLinks



Optional Boolean. True if OLE links are updated automatically when the relevant information changes.

CopyResourceUsageHeader

Due to changes in the object model of Microsoft Project, this argument is ignored. It is retained so that existing macros which make use of this argument do not cause errors.

PhoneticInfo



Optional Boolean. True if phonetic information is automatically provided for resource names and custom fields. The PhoneticInfo argument is ignored unless the Japanese version of Microsoft Project is used.

PhoneticType



Optional Long. Specifies the type of characters used to display phonetic information. Can be one of the following PjPhoneticType constants: pjKatakanaHalf, pjKatakana, or pjHiragana. The PhoneticType argument is ignored unless the Japanese version of Microsoft Project is used.

MinuteLabelDisplay

Optional Integer. Specifies how the minute label displays. The type of display varies from language to language and is determined by its order in the Minutes as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
m

1
min

2
minute

HourLabelDisplay

Optional Integer. Specifies how the hour label displays. The type of display varies from language to language and is determined by its order in the Hours as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
h

1
hr

2
hour

DayLabelDisplay


Optional Integer. Specifies how the day label displays. The type of display varies from language to language and is determined by its order in the Days as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
d

1
dy

2
day

WeekLabelDisplay

Optional Integer. Specifies how the week label displays. The type of display varies from language to language and is determined by its order in the Weeks as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
w

1
wk

2
week

YearLabelDisplay


Optional Integer. Specifies how the year label displays. The type of display varies from language to language and is determined by its order in the Years as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
y

1
yr

2
year

SpaceBeforeTimeLabel

Optional Boolean. True if a time value should be separated from its time label by a space.

SetDefaults






Optional Boolean. True if the values of PhoneticInfo, PhoneticType, MinuteLabelDisplay, HourLabelDisplay, DayLabelDisplay, WeekLabelDisplay, YearLabelDisplay, and SpaceBeforeTimeLabel are used as the default values for new projects. The default value is False.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Edit tab of the Options dialog box.

Using the OptionsEdit method without specifying any arguments displays the Options dialog box with the Edit tab selected.

OptionsGeneral Method

Sets general options.

Syntax

expression.OptionsGeneral(PlanningWizard, WizardUsage, WizardErrors, WizardScheduling, ShowTipOfDay, AutoAddResources, StandardRate, OvertimeRate, LastFile, SummaryInfo, UserName, SetDefaults, ShowWelcome, ShowToolTips, AutoFilter, MacroVirusProtection, DisplayRecentFiles, RecentFilesMaximum, FontConversion)
expression





Optional. An expression that returns an Application object.

PlanningWizard



Optional Boolean. True if the PlanningWizard is active.

WizardUsage




Optional Boolean. True if the PlanningWizard displays tips about using Microsoft Project more effectively.

WizardErrors




Optional Boolean. True if the PlanningWizard displays messages about errors.

WizardScheduling


Optional Boolean. True if the PlanningWizard displays messages about scheduling problems.

ShowTipOfDay




Optional Boolean. True if the Tip of the Day appears when Microsoft Project is started.

AutoAddResources


Optional Boolean. True if resources are automatically added to the resource pool.

StandardRate




Optional Variant. The default standard pay rate for resources.

OvertimeRate




Optional Variant. The default overtime pay rate for resources.

LastFile






Optional Boolean. True if the last opened file is automatically opened when Microsoft Project starts.

SummaryInfo




Optional Boolean. True if the Project Information dialog box appears when a new project is created.

UserName





Optional String. The name of the current user.

SetDefaults





Optional Boolean. True if the values of AutoAddResources, StandardRate, and OvertimeRate are used as default values for new projects.

ShowWelcome




Optional Boolean. True if the Welcome dialog box appears when Microsoft Project is started.

ShowToolTips




Due to changes in the Microsoft Project object model, this argument no longer has an effect. It has been retained for backwards compatibility.

AutoFilter

Optional Boolean. True if the AutoFilter is active.

MacroVirusProtection

Optional Boolean. True if macro virus protection is enabled.

DisplayRecentFiles


Optional Boolean. True if a list of recently used files appears on the File menu.

RecentFilesMaximum

Optional Integer. The maximum number of recently used files to display on the File menu. Can be a number from 0 to 9. Setting RecentFilesMaximum to 0 also sets DisplayRecentFiles to False.

FontConversion



Optional Boolean. True if the font automatically changes when opening a file that uses a font that cannot display native characters. The FontConversion argument is ignored unless a Far East version of Microsoft Project is used.

Remarks

If an argument is omitted, its default value is specified by the current setting on the General tab of the Options dialog box.

Using the OptionsGeneral method without specifying any arguments displays the Options dialog box with the General tab selected.

OptionsSchedule Method

Sets scheduling options.

Syntax

expression.OptionsSchedule(ScheduleMessages, StartOnCurrentDate, AutoLink, AutoSplit, CriticalSlack, TaskType, DurationUnits, WorkUnits, AutoTrack, SetDefaults, AssignmentUnits, EffortDriven, HonorConstraints)
expression





Optional. An expression that returns an Application object.

ScheduleMessages


Optional Boolean. True if messages display when scheduling problems occur.

StartOnCurrentDate


Optional Boolean. True if new tasks start on the current date. False if new tasks start on the project start date.

AutoLink






Optional Boolean. True if tasks are automatically linked.

AutoSplit






Optional Boolean. True if tasks in progress are automatically split.

CriticalSlack





Optional Variant. The maximum amount of slack allowed for critical tasks.

TaskType






Optional Long. The default type for new tasks. Can be one of the following PjTaskFixedType constants: pjFixedUnits, pjFixedDuration, or pjFixedWork.

DurationUnits




Optional Long. The default duration unit for tasks. Can be one of the following PjUnit constants: pjMinutes, pjHours, pjDays, or pjWeeks.

WorkUnits




Optional Long. The default work unit for resource assignments. Can be one of the PjUnit constants.

AutoTrack




Optional Boolean. True if task tracking fields automatically update resource assignments.

SetDefaults




Optional Boolean. True if the values specified for all arguments except ScheduleMessages and AssignmentUnits become the defaults for new project files.

AssignmentUnits


Optional Long. Specifies how assignment units should display. Can be one of the following PjAssignmentUnit constants: pjPercentageAssignmentUnits or pjDecimalAssignmentUnits.

EffortDriven




Optional Boolean. True if new tasks are effort-driven.

HonorConstraints

Optional Boolean. True if tasks honor their constraint dates.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Schedule tab of the Options dialog box.

Using the OptionsSchedule method without specifying any arguments displays the Options dialog box with the Schedule tab selected.

OptionsSpelling Method

Sets options for the spelling checker.

Syntax

expression.OptionsSpelling(TaskName, TaskNotes, TaskText1, TaskText2, TaskText3, TaskText4, TaskText5, TaskText6, TaskText7, TaskText8, TaskText9, TaskText10, ResourceCode, ResourceName, ResourceNotes, ResourceGroup, ResourceText1, ResourceText2, ResourceText3, ResourceText4, ResourceText5, AssignNotes, IgnoreUppercase, IgnoreNumberWords, AlwaysSuggest, UseCustomDictionary)
expression





Optional. An expression that returns an Application object.

TaskName





Optional Boolean. True if task names are checked.

TaskNotes





Optional Boolean. True if task notes are checked.

TaskText1





Optional Boolean. True if the Text1 field of tasks is checked.

TaskText2





Optional Boolean. True if the Text2 field of tasks is checked.

TaskText3





Optional Boolean. True if the Text3 field of tasks is checked.

TaskText4





Optional Boolean. True if the Text4 field of tasks is checked.

TaskText5





Optional Boolean. True if the Text5 field of tasks is checked.

TaskText6





Optional Boolean. True if the Text6 field of tasks is checked.

TaskText7





Optional Boolean. True if the Text7 field of tasks is checked.

TaskText8





Optional Boolean. True if the Text8 field of tasks is checked.

TaskText9





Optional Boolean. True if the Text9 field of tasks is checked.

TaskText10





Optional Boolean. True if the Text10 field of tasks is checked.

ResourceCode




Optional Boolean. True if resource codes are checked.

ResourceName



Optional Boolean. True if resource names are checked.

ResourceNotes



Optional Boolean. True if resource notes are checked.

ResourceGroup



Optional Boolean. True if resource groups are checked.

ResourceText1




Optional Boolean. True if the Text1 field of resources is checked.

ResourceText2




Optional Boolean. True if the Text2 field of resources is checked.

ResourceText3




Optional Boolean. True if the Text3 field of resources is checked.

ResourceText4




Optional Boolean. True if the Text4 field of resources is checked.

ResourceText5




Optional Boolean. True if the Text5 field of resources is checked.

AssignNotes




Optional Boolean. True if assignment notes are checked.

IgnoreUppercase



Optional Boolean. True if words consisting entirely of uppercase letters are ignored.

IgnoreNumberWords

Optional Boolean. True if words that contain numbers are ignored.

AlwaysSuggest



Optional Boolean. True if Microsoft Project will always suggest alternate spellings to misspelled words.

UseCustomDictionary

Optional Boolean. True if the custom dictionary is used.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Spelling tab of the Options dialog box.

Using the OptionsSpelling method without specifying any arguments displays the Options dialog box with the Spelling tab selected.

OptionsView Method

Sets view options.

Syntax

expression.OptionsView(DefaultView, DateFormat, ProjectSummary, DisplayStatusBar, DisplayEntryBar, DisplayScrollBars, CurrencySymbol, SymbolPlacement, CurrencyDigits, DisplayOutlineNumber, DisplayOutlineSymbols, DisplayNameIndent, DisplaySummaryTasks, DisplayOLEIndicator, DisplayExternalSuccessors, DisplayExternalPredecessors, CrossProjectLinksInfo, AcceptNewExternalData)
expression








Optional. An expression that returns an Application object.

DefaultView








Optional String. The name of the default view.

DateFormat








Optional Long. The date format. Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

ProjectSummary






Optional Boolean. True if the project summary task is visible.

DisplayStatusBar






Optional Boolean. True if the status bar appears.

DisplayEntryBar






Optional Boolean. True if the entry bar appears.

DisplayScrollBars





Optional Boolean. True if scroll bars appear.

CurrencySymbol






Optional String. The symbol to use for currency values.

SymbolPlacement





Optional Long. The position to display the currency symbol in currency values. Can be one of the following PjSymbolPlacement constants: pjBefore, pjAfter, pjBeforeWithSpace, or pjAfterWithSpace.

CurrencyDigits







Optional Integer. The number of digits following the decimal point in currency values.

DisplayOutlineNumber




Optional Boolean. True if the outline numbers for tasks appear.

DisplayOutlineSymbols



Optional Boolean. True if the outline symbols for tasks appear.

DisplayNameIndent





Optional Boolean. True if the names of tasks are indented.

DisplaySummaryTasks



Optional Boolean. True if summary tasks appear.

DisplayOLEIndicator




Optional Boolean. True if the OLE indicator appears.

DisplayExternalSuccessors


Optional Boolean. True if successors in an external project should be displayed.

DisplayExternalPredecessors

Optional Boolean. True if predecessors in an external project should be displayed.

CrossProjectLinksInfo




Optional Boolean. True if the Links Between Projects dialog box appears when a project containing cross project links is opened.

AcceptNewExternalData



Optional Boolean. True if new or changed data from an external project is automatically accepted when a project is opened. If CrossProjectLinksInfo is True, AcceptNewExternalData is ignored.

Remarks

If an argument is omitted, its default value is specified by the current setting on the View tab of the Options dialog box.

Using the OptionsView method without specifying any arguments displays the Options dialog box with the View tab selected.

OptionsWorkgroup Method

Sets workgroup options.

Syntax

expression.OptionsWorkgroup(WorkgroupMessages, ServerURL, ServerPath, ReceiveNotifications, SendHyperlinkNote, HyperlinkColor, FollowedHyperlinkColor, UnderlineHyperlinks, SetDefaults)
expression






Optional. An expression that returns an Application object.

WorkgroupMessages


Optional Long. The default for how workgroup messages will be sent to new resources. Can be one of the following PjWorkgroupMessages constants: pjNoWorkgroupMessages, pjWorkgroupViaEmail, pjWorkgroupViaEmailAndWeb, or pjWorkgroupViaWeb.

ServerURL






Optional String. The URL of the Web server for workgroup messages.

ServerPath






Optional String. The UNC of the Web server for workgroup messages.

ReceiveNotifications


Optional Boolean. True if the manager receives notification when new messages arrive in the WebInbox. Microsoft Project checks for new messages every ten minutes.

SendHyperlinkNote



Optional Boolean. True if resources receive e-mail notification when new mail arrives in their TeamInbox.

HyperlinkColor





Optional Long. The color used to denote unfollowed hyperlinks. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

FollowedHyperlinkColor

Optional Long. The color used to denote followed hyperlinks. Can be one of the PjColor constants.

UnderlineHyperlinks


Optional Boolean. True if hyperlinks are underlined.

SetDefaults

Optional Boolean. True if the values specified become the defaults for new project files.

Remarks

If an argument is omitted, its default value is specified by the current setting on the Workgroup tab of the Options dialog box.

Using the OptionsWorkgroup method without specifying any arguments displays the Options dialog box with the Workgroup tab selected.

Organizer Method

Displays the Organizer dialog box, which prompts the user to manage calendars, views, toolbars, maps, forms, tables, filters, reports, and modules.

Syntax

expression.Organizer(Type, Task)
expression

Optional. An expression that returns an Application object.

Type




Optional Long. The type of item to manage. Can be one of the following PjOrganizer constants: pjViews, pjTables, pjFilters, pjModules, pjReports, pjCalendars, pjToolbars, pjForms, or pjMaps. The default value is pjViews.

Task




Optional Boolean. True if the item applies to tasks. False if the item applies to resources. The default value is True.

OrganizerDeleteItem Method

Deletes an item from the Organizer.

Syntax

expression.OrganizerDeleteItem(Type, FileName, Name, Task)
expression

Optional. An expression that returns an Application object.

Type




Optional Long. The type of item to delete. Can be one of the following PjOrganizer constants: pjViews, pjTables, pjFilters, pjModules, pjReports, pjCalendars, pjToolbars, pjForms, or pjMaps. The default value is pjViews.

FileName


Required String. The name of the file containing the item to delete.

Name



Required String. The name of the item to delete.

Task




Optional Boolean. True if the item applies to tasks. False if the item applies to resources. The default value is True.

OrganizerMoveItem Method

Moves an item in the Organizer.

Syntax

expression.OrganizerMoveItem(Type, FileName, ToFileName, Name, Task)
expression

Optional. An expression that returns an Application object.

Type




Optional Long. The type of item to move. Can be one of the following PjOrganizer constants: pjViews, pjTables, pjFilters, pjModules, pjReports, pjCalendars, pjToolbars, pjForms, or pjMaps. The default value is pjViews.

FileName


Required String. The name of the file containing the item to move.

ToFileName

Required String. The name of the file where the item should be placed.

Name



Optional String. The name of the item to move. The default is to move all items specified with Type.

Task




Optional Boolean. True if the item applies to tasks. False if the item applies to resources. The default value is True.

OrganizerRenameItem Method

Renames an item in the Organizer.

Syntax

expression.OrganizerRenameItem(Type, FileName, Name, NewName, Task)
expression

Optional. An expression that returns an Application object.

Type




Optional Long. The type of item to rename. Can be one of the following PjOrganizer constants: pjViews, pjTables, pjFilters, pjModules, pjReports, pjCalendars, pjToolbars, pjForms, or pjMaps. The default value is pjViews.

FileName


Required String. The name of the file containing the item to rename.

Name



Required String. The name of the item to rename.

NewName


Required String. The new name for the item specified with Name.

Task




Optional Boolean. True if the item applies to tasks. False if the item applies to resources. The default value is True.

OutlineChildren Property

Returns a Tasks collection representing the children of a task in the outline. Read-only.

OutlineChildren Property Example

The following example displays the names of all tasks at the same outline level as the selected task.

Sub Siblings()

    Dim MyParent As Task

    Dim Sibling As Task

    Dim Temp As String

    Set MyParent = ActiveCell.Task.OutlineParent

    For Each Sibling In MyParent.OutlineChildren
        Temp = Sibling.Name & ListSeparator & " " & Temp

    Next Sibling

    Temp = Left$(Temp, Len(Temp) - Len(ListSeparator & " "))

    MsgBox Temp

End Sub

OutlineHideSubtasks Method

Hides the subtasks of the selected task or tasks.

Syntax

expression.OutlineHideSubtasks
expression

Optional. An expression that returns an object in the Applies To list.

OutlineHideSubtasks Method Example

The following example collapses the entire outline of the first task.

Sub OutlineHideAllSubtasks()


ActiveProject.Tasks(1).OutlineHideSubtasks
End Sub

OutlineIndent Method

Indents a task in the outline.

Syntax

expression.OutlineIndent(Levels)
expression

Optional. An expression that returns an object in the Applies To list.

Levels



Optional Long. A number that specifies how many levels to indent the task. Applies to Application object only. The default value is 1.

OutlineLevel Property

Returns the outline level of a task. Read-only Long.

OutlineNumber Property

Returns the outline number of a task. Read-only String.

OutlineOutdent Method

Promotes a task in the outline.

Syntax

expression.OutlineOutdent(Levels)
expression

Required. An expression that returns an object in the Applies To list.

Levels



Optional Long. A number that specifies how many levels to outdent the task. Applies to Application object only. The default value is 1.

OutlineParent Property

Returns a Task object representing the parent of a task in the outline. Read-only.

OutlineParent Property Example

The following example displays the names of all tasks at the same outline level as the selected task.

Sub Siblings()

    Dim MyParent As Task

    Dim Sibling As Task

    Dim Temp As String

    Set MyParent = ActiveCell.Task.OutlineParent
    For Each Sibling In MyParent.OutlineChildren

        Temp = Sibling.Name & ListSeparator & " " & Temp

    Next Sibling

    Temp = Left$(Temp, Len(Temp) - Len(ListSeparator & " "))

    MsgBox Temp

End Sub

OutlineShowAllTasks Method

Expands all summary tasks in the project.

Syntax

expression.OutlineShowAllTasks

expression

Required. An expression that returns an object in the Applies To list.

OutlineShowSubtasks Method

Shows the subtasks of the selected task or tasks.

Syntax

expression.OutlineShowSubtasks
expression

Optional. An expression that returns an object in the Applies To list.

OutlineSymbolsToggle Method

Shows or hides outline symbols.

Syntax

expression.OutlineSymbolsToggle(Show)
expression

Optional. An expression that returns an Application object.

Show



Optional Boolean. True if Microsoft Project displays outline symbols. The default value is True if outline symbols are hidden and False if they are visible.

Overallocated Property

True if an assignment or resource is overallocated, or if any of the assignments for a task is overallocated. Read-only Boolean.

Overallocated Property Example

The following example displays the percentage of resources in the active project that are overallocated.

Sub DisplayOverallocatedPercentage()

    Dim R As Resource               ' Resource object used in For Each loop

    Dim NOverallocated As Long      ' Number of overallocated resources

    For Each R In ActiveProject.Resources

        If R.Overallocated Then NOverallocated = NOverallocated + 1

    Next R

    MsgBox (Str$((NOverallocated / ActiveProject.Resources.Count) * 100) _

    & " percent (" & Str$(NOverallocated) & "/" & Str$(ActiveProject.Resources.Count) _

    & ")" & " of the resources in this project are overallocated.")

End Sub

OvertimeCost Property

Returns the overtime cost for an assignment, resource, or task. Read-only Variant.

OvertimeRate Property

Returns or sets the overtime rate of a resource. Read/write Variant.

OvertimeRate Property Example

The following example sets the current overtime rate of each resource in the active project to 1.5 times its standard rate.

Sub SetOverTimeRate()

    Dim R As Resource       ' Resource object used in For Each loop

    Dim StdRate As Double   ' Numeric value of resource's standard rate

    Dim Count As Integer    ' Counter used in For Next loop

    Dim FirstNumber As Integer  ' Position of the first number

    For Each R In ActiveProject.Resources

      ' Find the first character that is a number

      For Count = 1 To Len(R.StandardRate)

        If IsNumeric(Mid(R.StandardRate, Count, 1)) Then

          FirstNumber = Count - 1

          Exit For

        End If

      Next Count

   ' Strip off any leading currency symbol and then use the

   ' Val function to ignore any characters that follow the number

   StdRate = Val(Right$(R.StandardRate, Len(R.StandardRate) - FirstNumber))

   ' Set the overtime rate

   R.OvertimeRate = 1.5 * StdRate

   Next R

   End Sub

OvertimeWork Property

Assignment and Task object: Returns or sets the overtime work. Read/write Variant.

Resource object: Returns the overtime work. Read-only Variant.

PageBreakRemove Method

Removes a manual page break from the active row.

Syntax

expression.PageBreakRemove
expression

Optional. An expression that returns an Application object.

PageBreakSet Method

Sets a page break in the active row.

Syntax

expression.PageBreakSet
expression

Optional. An expression that returns an Application object.

PageBreaksRemoveAll Method

Removes all manual page breaks in the active project.

Syntax

expression.PageBreaksRemoveAll
expression

Optional. An expression that returns an Application object.

PageBreaksShow Method

Shows or hides page breaks on the PERT Chart.

Syntax

expression.PageBreaksShow(Show)
expression

Optional. An expression that returns an Application object.

Show



Optional Boolean. True if page breaks appear on the PERT Chart. The default is to toggle the current setting.

Pane Object

Represents a pane of a window. There is no collection for Pane objects. Where the Pane object appears in this diagram, it can be accessed through the ActivePane, TopPane, and BottomPane properties of a Window object.

Using the Pane Object

Use a property like the BottomPane property to return a Pane object. The following example checks for the existence of a pane at the bottom of the window and then creates, and applies, a new two-pane view.

If ActiveWindow.BottomPane Is Nothing Then

    ViewEditCombination Name:="Check Resources View", Create:=True, _

        TopView:="Gantt Chart", BottomView:="Resource Sheet"

 ViewApplyName:="Check Resources View"

End If

PaneClose Method

Closes the lower pane of the active window.

Syntax

expression.PaneClose
expression

Optional. An expression that returns an Application object.

PaneCreate Method

Creates a lower pane for the active window. If the active view is one of the task views, including the Task Usage view, the new pane will be the Task Form. If the active view is one of the resource views, including the Resource Usage view, the new pane will be the Resource Form.

Syntax

expression.PaneCreate
expression

Optional. An expression that returns an Application object.

PaneNext Method

Activates the lower pane if the upper pane is active; activates the upper pane if the lower pane is active.

Syntax

expression.PaneNext
expression

Optional. An expression that returns an Application object.

Parent Property

Returns the parent of the object. Read-only Object.

Remarks

Use the Parent property to access the properties or methods of an object's parent.

Path Property

Returns the path of Microsoft Project or an open project. Read-only String.

Remarks

The Path property returns Empty for an unsaved project or a project created in a Microsoft Office Binder section.

PathSeparator Property

Returns the path separator character. Read-only String.

PayRate Object, PayRates Collection Object

Represents a line of rates from a resource's cost rate table. The PayRate object is a member of the PayRates collection.

Using the PayRate Object

Use PayRates(Index), where Index is the pay rate index number or date for which to return the rates in effect, to return a single PayRate object. The following example returns the standard pay rate for Tamara's first row of rates in cost rate table C.

ActiveProject.Resources("Tamara").CostRateTables("C").PayRates.Add _ "12/1/96", "$25/h", "$40/h", "$0"

Using the PayRates Collection

Use the PayRates property to return a PayRates collection. The following example lists the standard pay rates for all the cost rate tables of the resource in the active cell.

Dim CRT As CostRateTable, PR As PayRate

Dim Rates As String

For Each CRT In ActiveCell.Resource.CostRateTables

    For Each PR In CRT.PayRates

        Rates = Rates & "CostRateTable " & CRT.Name & ": " & PR.StandardRate & vbCrLf

    Next PR

Next CRT

MsgBox Rates

Use the Add method to add a PayRate object to the PayRates collection. The following example adds a line to Tamara's cost rate table "C," with an Effective Date date of 12/1/96, a standard rate of $25.00/h, and overtime rate of $40.00/h and a per use cost of $0.

ActiveProject.Resources("Tamara").CostRateTables("C").PayRates.Add ("12/1/96", "$25/h", "$40/h", "$0")

PayRates Property

Returns a PayRates collection that represents the various pay rates on a resource's cost rate table. Read-only.

Remarks

For the Resource object, the PayRates property returns pay rates for cost rate table A, the default table.

PayRates Property Example

The following example lists the standard pay rates for all the cost rate tables of the resource in the active cell.

Sub ListPayRates()

    Dim CRT As CostRateTable, PR As PayRate

    Dim Rates As String

    For Each CRT In ActiveCell.Resource.CostRateTables

        For Each PR In CRT.PayRates
            Rates = Rates & "CostRateTable " & CRT.Name & ": " & _

                PR.StandardRate & " (Effective " & PR.EffectiveDate & _

                    ")" & vbCrLf

        Next PR

    Next CRT

    MsgBox Rates

End Sub

Peak Property

Returns the largest number of resource units assigned for the assignment. Read-only Double.

Peak Property Example

The following example finds any assignments with more than a certain number of resource units assigned.

Sub FindOverassigned()

    Dim T As Task, A As Assignment

    Dim TooMany As Double, Results As String

    TooMany = InputBox("Enter maximum allowed units per assignment: ")

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            For Each A In T.Assignments

                If A.Peak > TooMany Then

                    Results = Results & T.Name & ": " & A.ResourceName & vbCrLf

                End If

            Next A

            If Results <> "" Then MsgBox "The following resources are " & _

                "assigned more than " & TooMany & " units:" & vbCrLf & Results

            Results = ""

        End If

    Next T

End Sub

PeakUnits Property

Returns the largest number of units of a resource used at one time. Read-only Double.

PercentComplete Property

Returns or sets the percent complete of a task. Read/write Variant.

PercentComplete Property Example

The following example removes a resource from tasks in the active project that have two or more resources and are 85 percent complete.

Sub ReallocateResource()

    Dim Entry As String     ' The name of the resource to remove

    Dim T As Task           ' The task object used in For loop

    Dim RA As Assignment    ' The resource assignment object to the task

    Entry = InputBox$("Enter a resource name:")

    ' Remove the resource from 85 percent complete tasks with 2+ resources.

    For Each T In ActiveProject.Tasks

        If T.PercentComplete >= 85 And T.Resources.Count >= 2 Then

            For Each RA In T.Assignments

                If UCase(Entry) = UCase(RA.ResourceName) Then

                    RA.Delete

                End If

            Next

        End If

    Next T

End Sub

PercentWorkComplete Property

Returns or sets the percentage of work complete for an assignment, resource, or task.  Read-only for the Resource object and summary tasks. Read/write Integer.

PercentWorkComplete Property Example

The following example sets the Marked property to True for each task in the active project with a percentage of work complete that exceeds the percentage specified by the user.

Sub MarkTasks()

    Dim T As Task           ' Task object used in For Each loop

    Dim Entry As String     ' Percentage entered by user

    ' Prompt user for a percentage.

    Entry = InputBox$("Mark tasks that exceed what percentage of work complete? (0-100)")

    If Not IsNumeric(Entry) Then

        MsgBox ("Please enter a number only.")

        Exit Sub

    ElseIf Entry < 0 Or Entry > 100 Then

        MsgBox ("You did not enter a percentage from 0 to 100.")

        Exit Sub

    End If

    ' Mark tasks with percentage of work complete greater than user entry.

    For Each T In ActiveProject.Tasks

        If T.PercentWorkComplete > Val(Entry) Then

            T.Marked = True

        Else

            T.Marked = False

        End If

    Next T

End Sub

Period Object

Represents a period in a calendar. There is no collection for Period objects.

Using the Period Object

Use the Period property to return a Period object. The following example sets P as an object reference to the last week in September 1997.

Dim P As Period

Set P = ActiveProject.Calendar.Period("9/29/97", "10/3/97")

Period Property

Returns a Period object representing a period of time in a calendar.

Syntax

expression.Period(StartDate, FinishDate)
expression

Optional. An expression that returns a Calendar object.

StartDate


Required Variant. The start date of the desired period.

FinishDate

Optional Variant. The finish date of the desired period. The default value is the same date as StartDate.

Period Property Example

The following example sets a winter holiday for the active project.

Sub SetWinterHoliday()


ActiveProject.Calendar.Period("12/20/97", "12/31/97").Working = False

End Sub

PERTBorders Method

Sets the style and color of box borders on the PERT Chart.

Syntax

expression.PERTBorders(CriticalStyle, CriticalColor, NoncriticalStyle, NoncriticalColor, CriticalMilestoneStyle, CriticalMilestoneColor, NoncriticalMilestoneStyle, NoncriticalMilestoneColor, CriticalSummaryStyle, CriticalSummaryColor, NoncriticalSummaryStyle, NoncriticalSummaryColor, CriticalSubprojectStyle, CriticalSubprojectColor, NoncriticalSubprojectStyle, NoncriticalSubprojectColor, CriticalMarkedStyle, CriticalMarkedColor, NoncriticalMarkedStyle, NoncriticalMarkedColor, CriticalExternalTaskStyle, CriticalExternalTaskColor, NoncriticalExternalTaskStyle, NoncriticalExternalTaskColor)
expression







Optional. An expression that returns an Application object.

CriticalStyle







Optional Long. The style of box borders for critical tasks. Can be one of the following PjPERTBoxStyle constants: pjPlainBox, pjThickBox, pjShadowBox, pjDottedBox, pjFramed, pjGrayFrame, pjPatternFrame, or pjMarquee.

CriticalColor







Optional Long. The color of box borders for critical tasks. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

NoncriticalStyle






Optional Long. The style of box borders for noncritical tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalColor






Optional Long. The color of box borders for noncritical tasks. Can be one of the PjColor constants.

CriticalMilestoneStyle




Optional Long. The style of box borders for critical milestone tasks. Can be one of the PjPERTBoxStyle constants.

CriticalMilestoneColor




Optional Long. The color of box borders for critical milestone tasks. Can be one of the PjColor constants.

NoncriticalMilestoneStyle


Optional Long. The style of box borders for noncritical milestone tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalMilestoneColor


Optional Long. The color of box borders for noncritical milestone tasks. Can be one of the PjColor constants.

CriticalSummaryStyle




Optional Long. The style of box borders for critical summary tasks. Can be one of the PjPERTBoxStyle constants.

CriticalSummaryColor




Optional Long. The color of box borders for critical summary tasks. Can be one of the PjColor constants.

NoncriticalSummaryStyle


Optional Long. The style of box borders for noncritical summary tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalSummaryColor


Optional Long. The color of box borders for noncritical summary tasks. Can be one of the PjColor constants.

CriticalSubprojectStyle



Optional Long. The style of box borders for critical inserted project tasks. Can be one of the PjPERTBoxStyle constants.

CriticalSubprojectColor



Optional Long. The color of box borders for critical inserted project tasks. Can be one of the PjColor constants.

NoncriticalSubprojectStyle


Optional Long. The style of box borders for noncritical inserted project tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalSubprojectColor


Optional Long. The color of box borders for noncritical inserted project tasks. Can be one of the PjColor constants.

CriticalMarkedStyle





Optional Long. The style of box borders for critical marked tasks. Can be one of the PjPERTBoxStyle constants.

CriticalMarkedColor





Optional Long. The color of box borders for critical marked tasks. Can be one of the PjColor constants.

NoncriticalMarkedStyle



Optional Long. The style of box borders for noncritical marked tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalMarkedColor



Optional Long. The color of box borders for noncritical marked tasks. Can be one of the PjColor constants.

CriticalExternalTaskStyle



Optional Long. The style of box borders for critical external tasks. Can be one of the PjPERTBoxStyle constants.

CriticalExternalTaskColor


Optional Long. The color of box borders for critical external tasks. Can be one of the PjColor constants.

NoncriticalExternalTaskStyle

Optional Long. The style of box borders for noncritical external tasks. Can be one of the PjPERTBoxStyle constants.

NoncriticalExternalTaskColor

Optional Long. The color of box borders for noncritical external tasks. Can be one of the PjColor constants.

PERTBoxStyles Method

Sets the style of boxes on the PERT Chart.

Syntax

expression.PERTBoxStyles(Size, DateFormat, Gridlines, CrossMarks, Field1, Field2, Field3, Field4, Field5)
expression



Optional. An expression that returns an Application object.

Size






Optional Long. The size of boxes. Can be one of the following PjPERTBoxSize constants: pjIDOnly, pjSmall, pjMedium, or pjLarge.

DateFormat



Optional Long. The date format for boxes. Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDateDefault
The default format, as specified on the View tab of the Options dialog box.

pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

Gridlines


Optional Boolean. True if gridlines separate the fields in boxes.

CrossMarks

Optional Boolean. True if crossmarks appear in boxes to show finished and ongoing tasks.

Field1



Optional Long. The name of the first field in boxes. Can be one of the following PjPERTField constants:

pjPERTTaskActualCost
pjPERTTaskMilestone

pjPERTTaskActualDuration
pjPERTTaskName

pjPERTTaskActualFinish
pjPERTTaskNotes

pjPERTTaskActualStart
pjPERTTaskNumber1

pjPERTTaskActualOvertimeCost
pjPERTTaskNumber2

pjPERTTaskActualOvertimeWork
pjPERTTaskNumber3

pjPERTTaskActualStart
pjPERTTaskNumber4

pjPERTTaskActualWork
pjPERTTaskNumber5

pjPERTTaskACWP
pjPERTTaskNumber6

pjPERTTaskBaselineCost
pjPERTTaskNumber7

pjPERTTaskBaselineDuration
pjPERTTaskNumber8

pjPERTTaskBaselineFinish
pjPERTTaskNumber9

pjPERTTaskBaselineStart
pjPERTTaskNumber10

pjPERTTaskBaselineWork
pjPERTTaskNumber11

pjPERTTaskBCWP
pjPERTTaskNumber12

pjPERTTaskBCWS
pjPERTTaskNumber13

pjPERTTaskConfirmed
pjPERTTaskNumber14

pjPERTTaskConstraintDate
pjPERTTaskNumber15

pjPERTTaskConstraintType
pjPERTTaskNumber16

pjPERTTaskContact
pjPERTTaskNumber17

pjPERTTaskCost
pjPERTTaskNumber18

pjPERTTaskCost1
pjPERTTaskNumber19

pjPERTTaskCost2
pjPERTTaskNumber20

pjPERTTaskCost3
pjPERTTaskObjects

pjPERTTaskCost4
pjPERTTaskOutlineLevel

pjPERTTaskCost5
pjPERTTaskOutlineNumber

pjPERTTaskCost6
pjPERTTOverallocated

pjPERTTaskCost7
pjPERTTOvertimeCost

pjPERTTaskCost8
pjPERTTOvertimeWork

pjPERTTaskCost9
pjPERTTaskPercentComplete

pjPERTTaskCost10
pjPERTTaskPercentWorkComplete

pjPERTTaskCostVariance
pjPERTTaskPredecessors

pjPERTTaskCreated
pjPERTTaskPreleveledFinish

pjPERTTaskCritical
pjPERTTaskPreleveledStart

pjPERTTaskCV
pjPERTTaskPriority

pjPERTTaskDate1
pjPERTTaskProject

pjPERTTaskDate2
pjPERTTaskRecurring

pjPERTTaskDate3
pjPERTTaskRegularWork

pjPERTTaskDate4
pjPERTTaskRemainingCost

pjPERTTaskDate5
pjPERTTaskRemainingDuration

pjPERTTaskDate6
pjPERTTaskRemainingOvertimeCost

pjPERTTaskDate7
pjPERTTaskRemainingOvertimeWork

pjPERTTaskDate8
pjPERTTaskRemainingWork

pjPERTTaskDate9
pjPERTTaskResourceGroup

pjPERTTaskDate10
pjPERTTaskResourceInitials

pjPERTTaskDuration
pjPERTTaskResourceNames

pjPERTTaskDuration1
pjPERTTaskResourcePhonetics

pjPERTTaskDuration2
pjPERTTaskResponsePending

pjPERTTaskDuration3
pjPERTTaskResume

pjPERTTaskDuration4
pjPERTTaskRollup

pjPERTTaskDuration5
pjPERTTaskSheetNotes

pjPERTTaskDuration6
pjPERTTaskStart

pjPERTTaskDuration7
pjPERTTaskStart1

pjPERTTaskDuration8
pjPERTTaskStart2

pjPERTTaskDuration9
pjPERTTaskStart3

pjPERTTaskDuration10
pjPERTTaskStart4

pjPERTTaskDurationVariance
pjPERTTaskStart5

pjPERTTaskEarlyFinish
pjPERTTaskStart6

pjPERTTaskEarlyStart
pjPERTTaskStart7

pjPERTTaskEffortDriven
pjPERTTaskStart8

pjPERTTaskExternalTask
pjPERTTaskStart9

pjPERTTaskFinish
pjPERTTaskStart10

pjPERTTaskFinish1
pjPERTTaskStartVariance

pjPERTTaskFinish2
pjPERTTaskStop

pjPERTTaskFinish3
pjPERTTaskSubproject

pjPERTTaskFinish4
pjPERTTaskSubprojectReadOnly

pjPERTTaskFinish5
pjPERTTaskSuccessors

pjPERTTaskFinish6
pjPERTTaskSummary

pjPERTTaskFinish7
pjPERTTaskSV

pjPERTTaskFinish8
pjPERTTaskTeamStatusPending

pjPERTTaskFinish9
pjPERTTaskText1

pjPERTTaskFinish10
pjPERTTaskText2

pjPERTTaskFinishVariance
pjPERTTaskText3

pjPERTTaskFixedCost
pjPERTTaskText4

pjPERTTaskFixedCostAccrual
pjPERTTaskText5

pjPERTTaskFlag1
pjPERTTaskText6

pjPERTTaskFlag2
pjPERTTaskText7

pjPERTTaskFlag3
pjPERTTaskText8

pjPERTTaskFlag4
pjPERTTaskText9

pjPERTTaskFlag5
pjPERTTaskText10

pjPERTTaskFlag6
pjPERTTaskText11

pjPERTTaskFlag7
pjPERTTaskText12

pjPERTTaskFlag8
pjPERTTaskText13

pjPERTTaskFlag9
pjPERTTaskText14

pjPERTTaskFlag10
pjPERTTaskText15

pjPERTTaskFlag11
pjPERTTaskText16

pjPERTTaskFlag12
pjPERTTaskText17

pjPERTTaskFlag13
pjPERTTaskText18

pjPERTTaskFlag14
pjPERTTaskText19

pjPERTTaskFlag15
pjPERTTaskText20

pjPERTTaskFlag16
pjPERTTaskText21

pjPERTTaskFlag17
pjPERTTaskText22

pjPERTTaskFlag18
pjPERTTaskText23

pjPERTTaskFlag19
pjPERTTaskText24

pjPERTTaskFlag20
pjPERTTaskText25

pjPERTTaskFreeSlack
pjPERTTaskText26

pjPERTTaskHideBar
pjPERTTaskText27

pjPERTTaskHyperlink
pjPERTTaskText28

pjPERTTaskHyperlinkAddress
pjPERTTaskText29

pjPERTTaskHyperlinkHref
pjPERTTaskText30

pjPERTTaskHyperlinkSubAddress
pjPERTTaskTotalSlack

pjPERTTaskID
pjPERTTaskType

pjPERTTaskLateFinish
pjPERTTaskUniqueID

pjPERTTaskLateStart
pjPERTTaskUniquePredecessors

pjPERTTaskLevelAssignments
pjPERTTaskUniqueSuccessors

pjPERTTaskLevelingCanSplit
pjPERTTaskUpdatedNeeded

pjPERTTaskLevelingDelay
pjPERTTaskWBS

pjPERTTaskLinkedFields
pjPERTTaskWork

pjPERTTaskMarked
pjPERTTaskWorkVariance

Field2

Optional Long. The name of the second field in boxes. Can be one of the PjPERTField constants.

Field3

Optional Long. The name of the third field in boxes. Can be one of the PjPERTField constants.

Field4

Optional Long. The name of the fourth field in boxes. Can be one of the PjPERTField constants.

Field5

Optional Long. The name of the fifth field in boxes. Can be one of the PjPERTField constants.

PERTLayout Method

Controls the layout of the active PERT Chart.

Syntax

expression.PERTLayout(Straight, DisplayArrows, AdjustForPageBreaks, DisplayPageBreaks)
expression





Optional. An expression that returns an Application object.

Straight






Optional Boolean. True if the lines connecting the nodes of the active PERT Chart are straight. False if the lines form right angles. The default value is True.

DisplayArrows




Optional Boolean. True if arrows connect the nodes of a PERT Chart. The default value is True.

AdjustForPageBreaks

Optional Boolean. True if the nodes of a PERT Chart will be adjusted around page breaks. The default value is True.

DisplayPageBreaks


Optional Boolean. True if page breaks will be displayed. The default value is True.

Remarks

The value specified for AdjustForPageBreaks has no effect until the PERTLayout or LayoutNow method is used.

PERTLayout Method Example

The following example changes the link line formatting in the active PERT Chart to straight with arrows.

Sub DisplayStraightArrows()


PERTLayout Straight:=True, DisplayArrows:=True

End Sub

PERTSetTask Method

Creates, selects, or moves a task on the PERT Chart.

Syntax

expression.PERTSetTask(Create, Move, TaskID, XPosition, YPosition)
expression

Optional. An expression that returns an Application object.

Create



Optional Boolean. True if a new task is created. The default value is False.

Move



Optional Boolean. True if the task is moved. False if the task is selected. The default value is False.

TaskID



Optional Long. The identification number of the task. Required if Move is True, or if both Move and Create are False.

XPosition


Optional Long. The horizontal position (Create is True) or the relative horizontal position (Move is True) of the task, in increments of one-quarter of the box height. Required if Move is True.

YPosition


Optional Long. The vertical position (Create is True) or the relative vertical position (Move is True) of the task, in increments of one-quarter of the box height. Required if Move is True.

PERTShowHideFields Method

Shows or hides the task data fields of the active PERT Chart.

Syntax

expression.PERTShowHideFields(Show)
expression

Optional. An expression that returns an Application object.

Show



Optional Boolean. True if the fields of PERT boxes are displayed in the active PERT Chart. The default value is True if the active PERT Chart isn't showing fields and False if it is.

Phonetics Property

Returns or sets the phonetic representation of a resource name. The Phonetics property only produces tangible results if the Japanese version of Microsoft Project is used. Read/write String.

PhoneticType Property

Returns or sets the type of characters used to display phonetic information. Can be one of the following PjPhoneticType constants: pjKatakanaHalf, pjKatakana, or pjHiragana. The PhoneticType property only produces tangible results if the Japanese version of Microsoft Project is used. Read/write Long.

PMText Property

Returns the text Microsoft Project displays next to evening hours in the 12-hour time format. Read-only String.

Remarks

Microsoft Project sets the PMText property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Predecessors Property

Returns or sets a list of the identification numbers of a task's predecessors. Read/write String.

Remarks

If the predecessors of the specified task have identification numbers of 2 and 10, and the list separator character is the comma, the Predecessors property returns "2,10".

PredecessorTasks Property

Returns a Tasks collection representing the tasks that are predecessors of a task. Read-only.

PreleveledFinish Property

Returns the finish date of a task before leveling occurred. Read-only Variant.

PreleveledFinish Property Example

The following example calculates the difference, if any, between the projected finish date and the projected finish date before the task was leveled for each task in the project, and then displays those that changed.

Sub DateDifferences()

    Dim T As Task, Results As String

    For Each T In ActiveProject.Tasks

        If Not (T Is Nothing) Then

            ' Tasks that have never been leveled return "NA"

            If T.PreleveledFinish <> "NA" And T.Finish <> T.PreleveledFinish Then

                Results = Results & T.Name & ": " & _

                    DateDiff("d", T.PreleveledFinish, T.Finish) & _

                        " days" & vbCrLf

            End If

        End If

    Next T

    If Results <> "" Then MsgBox Results

End Sub

PreleveledStart Property

Returns the start date of a task before leveling occurred. Read-only Variant.

Priority Property

Returns or sets the priority of a task. Can be one of the following PjPriority constants: pjPriorityDoNotLevel, pjPriorityHighest, pjPriorityVeryHigh, pjPriorityHigher, pjPriorityHigh, pjPriorityMedium, pjPriorityLow, pjPriorityLower, pjPriorityVeryLow, or pjPriorityLowest. Read/write Long.

Remarks

Microsoft Project uses the priorities of tasks when leveling resources.

Priority Property Example

The following example sets the tasks on the critical path to the highest priority in the active project.

Sub SetPriorityOfCriticalTasks()

    Dim T As Task     ' Task object used in For Each loop

    ' Look for tasks on the critical path.

    For Each T In ActiveProject.Tasks

        If T.Critical Then

            T.Priority = pjPriorityHighest

        End If

    Next T

End Sub

ProgressLines Method

Displays the Progress Lines dialog box.

Syntax

expression.ProgressLines
expression


Optional. An expression that returns an Application object.

Remarks

The ProgressLines method has no effect unless the active view is a Gantt view.

The ProgressLines method has the same effect as the Progress Lines command on the Tracking submenu, which is available on the Tools menu.

Project Object, Projects Collection Object

Represents a project or all open projects. The Project object is a member of the Projects collection.

Using the Project Object

Use Projects(Index), where Index is the project index number or project name, to return a single Project object. The following example switches among all the open projects, memorizes the full name of each, and then displays the results.

Dim Temp As Long, Names As String

For Temp = 1 To Projects.Count

    Projects(Temp).Activate

    Names = Names & Projects(Temp).FullName & vbCrLf

Next Temp

MsgBox Names

Using the Projects Collection

Use the Projects property to return a Projects collection. The following example counts the number of open projects.

Application.Projects.Count

Because the Projects collection is a top-level object, the following example is functionally identical to the one above.

Projects.Count

Use the Add method to add a Project object to the Projects collection. The following example creates a new project without prompting for project information.

Projects.Add False

Project Property

Returns the name of the project containing the assignment, resource, or task. Read-only String.

ProjectFinish Property

Returns or sets the finish date for a project. Setting ProjectFinish also causes the project to be scheduled from its finish date. This has the same effect as setting the ScheduleFromStart property to False. Read/write Variant.

ProjectNotes Property

Returns or sets the notes for the project. Read/write String.

ProjectNotes Property Example

The following example adds the date and time to the Comments field in the Project Properties dialog box and then saves the project.

Sub SaveAndNoteTime()

    Projects(1).ProjectNotes = Projects(1).ProjectNotes & vbCrLf & "This project was last saved on " _

        & Date$ & " at " & Time$ & "."

    FileSave

End Sub

Projects Property

Returns a Projects collection representing the open projects in Microsoft Project. Read-only.

Projects Property Example

The following example adds the date and time to the Comments field in the Project Properties dialog box and then saves the project.

Sub SaveAndNoteTime()

    Projects(1).ProjectNotes = Projects(1).ProjectNotes & vbCrLf & "This project was last saved on " _

        & Date$ & " at " & Time$ & "."

    FileSave

End Sub

ProjectStart Property

Returns or sets the start date for a project. Setting ProjectStart also causes the project to be scheduled from its start date. This has the same effect as setting the ScheduleFromStart property to True. Read/write Variant.

ProjectStatistics Method

Displays the Project Statistics dialog box.

Syntax

expression.ProjectStatistics(Project)
expression

Optional. An expression that returns an Application object.

Project



Optional String. The name of a project.

Remarks

The ProjectStatistics method has the same effect as clicking Project Information on the Project menu and then clicking the Statistics button.

ProjectSummaryInfo Method

Sets information about a project.

Syntax

expression.ProjectSummaryInfo(Project, Title, Subject, Author, Company, Manager, Keywords, Comments, Start, Finish, ScheduleFrom, CurrentDate, Calendar, StatusDate)
expression


Optional. An expression that returns an Application object.

Project




Optional String. The file name of the project that should have its project information edited.

Title





Optional String. The title of the project.

Subject



Optional String. The subject of the project.

Author




Optional String. The author of the project.

Company



Optional String. The company associated with the project.

Manager



Optional String. The manager of the project.

Keywords



Optional String. The keywords associated with the project.

Comments


Optional String. The comments associated with the project.

Start





Optional Variant. The start date of the project. If ScheduleFrom is pjProjectFinish, Start is ignored.

Finish




Optional Variant. The finish date of the project. If ScheduleFrom is pjProjectStart, Finish is ignored.

ScheduleFrom

Optional Long. Can be one of the following PjScheduleProjectFrom constants: pjProjectStart or pjProjectFinish.

CurrentDate


Optional Variant. The current date for the project.

Calendar



Optional String. The name of the base calendar for the project.

StatusDate


Optional Variant. The current status date for the project.

Remarks

Using the ProjectSummaryInfo method without specifying any arguments displays the Project Information dialog box.

ProjectSummaryTask Property

Returns a Task object representing the project summary task for the active project. Read-only.

ProjectSummaryTask Property Example

The following example returns the scheduled start and finish dates for the active project.

Sub ProjectStartAndFinish()

    Dim ProjStart As String, ProjFinish As String

        With ActiveProject.ProjectSummaryTask
        ProjStart = Left$(.Start, InStr(.Start, " ") - 1)

        ProjFinish = Left$(.Finish, InStr(.Finish, " ") - 1)

    End With

        MsgBox "The project is scheduled to start on " & ProjStart & _

            vbCrLf & " and finish on " & ProjFinish & "."

    End Sub

PromptForSummaryInfo Property

True if the Project Information dialog box displays when a new project is created. Read/write Boolean.

Quit Method

Quits Microsoft Project.

Syntax

expression.Quit(SaveChanges)
expression


Optional. An expression that returns an Application object.

SaveChanges

Optional Long. Specifies whether Project saves changes before quitting. Can be one of the following PjSaveFormat constants: pjDoNotSave, pjSave, or pjPromptSave. The default is pjPromptSave for new project files and projects that have changed since the last save.

Quit Method Example

The following example saves all open projects and then quits Microsoft Project.

Sub SaveChangesAndQuit()


Quit SaveChanges:=pjSave

End Sub

ReadOnly Property

True if a project has read-only access. Read-only Boolean.

ReadOnly Property Example

The following example copies projects with read-only access into new files with read-write access.

Sub CopyReadOnlyFiles()

    Dim P As Project        ' Project object used in loop

    Dim OldName As String   ' Name of project

    Dim Path As String      ' File path to project

    Dim NewName As String   ' New name of project

    ' Check each open project for read-only access.

    For Each P In Application.Projects

        If P.ReadOnly Then      ' See if project has read-only access.

            OldName = P.Name    ' Store its name.

            Path = P.Path       ' Store its path.

            ' Create a new name for the file and save it.

            NewName = "New " & Left(OldName, Len(OldName) - 4) & ".MPP"

            P.Activate

            FileSaveAs Path & PathSeparator & NewName

        End If

    Next P

End Sub

ReadOnlyRecommended Property

True if the project should be opened with read-only access. Read-only Boolean.

Remarks

To assign a new value to the ReadOnlyRecommended property, use the FileSaveAs method.

ReadOnlyRecommended Property Example

The following example displays the recommended access type for the active project.

Sub DisplayAccessType()

    If ActiveProject.ReadOnlyRecommended Then

        MsgBox "Read-only access is recommended for this project."

    ElseIf ActiveProject.ReadOnly Then

        MsgBox "This project may only be opened read-only."

    Else

        MsgBox "Read/write access is allowed for this project."

    End If

End Sub

ReceiveNotifications Property

True if the manager receives notification when new messages arrive in the WebInbox. Read/write Boolean.

Remarks

Microsoft Project checks for new messages every ten minutes.

RecentFilesMaximum Property

Returns or sets the maximum number of recently used files to display on the File menu. Can be a number from 0 to 9. Read/write Integer.

Remarks

Setting the RecentFilesMaximum property to 0 also sets the DisplayRecentFiles property to False.

Recurring Property

True if the task is a recurring task. Read-only Boolean.

RecurringTaskInsert Method

Displays the Recurring Task Information dialog box, which prompts the user to insert a recurring task.

Syntax

expression.RecurringTaskInsert
expression

Optional. An expression that returns an Application object.

RegularWork Property

Returns the amount of regular work for an assignment, resource, or task. Read/write for the Assignment object. Read-only Variant.

RemainingCost Property

Returns the remaining cost for an assignment, resource, or task. Read-only Variant.

RemainingDuration Property

Returns or sets the remaining duration (in minutes) of a task.  Read-only for summary tasks. Read/write Variant.

RemainingOvertimeCost Property

Returns the remaining overtime cost for an assignment, resource, or task. Read-only Variant.

RemainingOvertimeCost Property Example

The following example returns the remaining overtime cost of each task in the active project.

Sub ReturnOvertimeCost()

    Dim T As Task           ' Task object used in For Each loop

    Dim Results As String

    For Each T In ActiveProject.Tasks

        Results = Results & T.Name & ": " & ActiveProject.CurrencySymbol & _

            T.RemainingOvertimeCost & ListSeparator & " "

    Next T

    Results = Left$(Results, Len(Results) - Len(ListSeparator & " "))

    MsgBox Results

End Sub

RemainingOvertimeWork Property

Returns the remaining overtime work (in minutes) for an assignment, resource, or task. Read/write for the Assignment object. Read-only Variant.

RemainingWork Property

Returns or sets the remaining work (in minutes) for an assignment, resource, or task. Read-only for the Resource object and summary tasks. Read/write Variant.

ReminderSet Method

Sets a reminder in Microsoft Outlook for the start time or finish time of the active tasks.

Syntax

expression. ReminderSet(Start, LeadTime)
expression

Optional. An expression that returns an Application object.

Start




Optional Boolean. True if the reminder is set for the start time of the active tasks. False if the reminder is set for the finish time. The default value is True.

LeadTime


Optional String. The amount of lead time for Microsoft Outlook reminders. The default value is "15m", which triggers reminders 15 minutes before the start time (Start is True) or after the finish time (Start is False).

Replace Method

Searches for an unfiltered value and replaces it with the specified value. The Replace method returns True if replacements were made.

Syntax

expression.Replace(Field, Test, Value, Replacement, ReplaceAll, Next, MatchCase)
expression

Optional. An expression that returns an Application object.

Field




Required String. The name of the field to search.

Test




Required String. The type of comparison made between Field and Value. Can be one of the following comparison strings:

Comparison string
Description




"equals"
The value of Field equals Value.

"does not equal"
The value of Field does not equal Value.

"is greater than"
The value of Field is greater than Value.

"is greater than or equal to"
The value of Field is greater than or equal to Value.

"is less than"
The value of Field is less than Value.

"is less than or equal to"
The value of Field is less than or equal to Value.

"is within"
The value of Field is within Value.

"is not within"
The value of Field is not within Value.

"contains"
Field contains Value.

"does not contain"
Field does not contain Value.

"contains exactly"
Field exactly contains Value.

Value



Required String. The value to compare with the value of the field specified with Field.

Replacement
Required String. The text used to replace Value. Use "" (an empty string) to clear Field where it meets the test specified by Test and Value.

ReplaceAll

Optional Boolean. True if all occurrences of Value are replaced. False if only the first occurrence is replaced. The default value is False.

Next

Optional Boolean. True if Microsoft Project searches down for the next occurrence of matching search criteria. False if the program searches up for the next occurrence. The default value is True.

MatchCase

Optional Boolean. True if the search is case-sensitive. The default value is False.

Remarks

Using the Replace method without specifying any arguments displays the Replace dialog box.

Replace Method Example

The following example lowers the priority of all tasks from highest to high.

Sub LowerPriority()

    Replace Field:="Priority", Test:="equals", Value:="Highest", Replacement:="High", _

        ReplaceAll:=True

End Sub

ReportList Property

Returns a List object representing the reports in the active project. Read-only.

ReportList Property Example

The following example lists all the reports in the active project.

Sub SeeAllReports()

    Dim Temp As Variant

    Dim ReportNames As String

    For Each Temp In ActiveProject.ReportList
        ReportNames = ReportNames & vbCrLf & Temp

    Next Temp

    MsgBox ReportNames

End Sub

ReportPrint Method

Prints a report.

Syntax

expression.ReportPrint(Name, FromPage, ToPage, PageBreaks, Draft, Copies, FromDate, ToDate, Preview, Color)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the report to print.

FromPage

Optional Integer. A number that specifies the first page to print.

ToPage


Optional Integer. A number that specifies the last page to print.

PageBreaks

Optional Boolean. True if Microsoft Project uses manual page breaks when printing. The default value is True.

Draft




Optional Boolean. True if Microsoft Project prints the report in draft mode. The default value is False.

Copies



Optional Integer. A number that specifies the number of copies to print. The default value is 1.

FromDate


Optional Variant. A number or string that specifies the first date to print. The default value is the start date of the project.

ToDate



Optional Variant. A number or string that specifies the last date to print. The default value is the finish date of the project.

Preview


Optional Boolean. True if Microsoft Project previews the active view rather than printing it. The default value is False.

Color



Optional Boolean. True if Microsoft Project prints the report in color. The default value is False.

Remarks

Using the ReportPrint method without specifying any arguments displays the Custom Reports dialog box.

ReportPrint Method Example

The following example creates a consolidated project, prints a report, and closes the consolidated project without saving it.

Sub ConsolidatedReport()


ConsolidateProjects Filenames:="project1.mpp,project2.mpp"


ReportPrint Name:="Project Summary"


FileClose Save:=pjDoNotSave

End Sub

ReportPrintPreview Method

Shows an on-screen preview of a printed report.

Syntax

expression.ReportPrintPreview(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of a report for which to show an on-screen preview. If Name is omitted, the Custom Reports dialog box appears.

Reports Method

Displays the Reports dialog box, which prompts the user to manage reports.

Syntax

expression.Reports
expression

Optional. An expression that returns an Application object.

Reset Method

Resets base calendar properties to their default values; resets resource calendar properties to the values in the corresponding base calendar.

Syntax

expression.Reset
expression

Required. An expression that returns a Calendar object.

Reset Method Example

The following example resets every resource calendar in the active project.

Sub ResetResourceCalendars()

    Dim R As Resource   ' Resource object used in For Each loop

    For Each R In ActiveProject.Resources

        R.Calendar.Reset
    Next R

End Sub

Resource Object, Resources Collection Object

Represents a resource or resources. The Resource object is a member of the Resources collection.

Using the Resource Object

Use Resources(Index), where Index is the resource index number or resource name, to return a single Resource object. The following example lists the names of all resources in the active project.

Dim R As Long, Names As String

For R = 1 To ActiveProject.Resources.Count

    Names = ActiveProject.Resources(R).Name & ", " & Names

Next R

Names = Left$(Names, Len(Names) - Len(ListSeparator & " "))

MsgBox Names

Using the Resources Collection

Use the Resources property to return a Resources collection. The following example generates the same list as the previous example, but does it by setting an object reference to ActiveProject.Resources, and then using R where ActiveProject.Resources is used.

Dim R As Resources, Temp As Long, Names As String

Set R = ActiveProject.Resources

For Temp = 1 To R.Count

    Names = R(Temp).Name & ", " & Names

Next Temp

Names = Left$(Names, Len(Names) - Len(ListSeparator & " "))

MsgBox Names

Use the Add method to add a Resource object to the Resources collection. The following example adds a new resource named Matilda to the active project.

ActiveProject.Resources.Add "Matilda"

Resource Property

Returns a Resource object representing the resource in the active cell. Read-only.

ResourceAddressBook Method

Displays a MAPI-compliant mail system's address book from which the user can select resources for the project. This method is only available in resource views.

Syntax

expression.ResourceAddressBook
expression

Optional. An expression that returns an Application object.

ResourceAssignment Method

Assigns, removes, or replaces the resources of the selected tasks, or changes the number of units for a resource.

Syntax

expression.ResourceAssignment(Resources, Operation, With)
expression

Optional. An expression that returns an Application object.

Resources

Optional String. The names of the resources to be assigned, removed, or replaced in the selected tasks.

Operation


Optional Long. If Operation is omitted, Microsoft Project assigns the resources to the selected tasks. The default value is pjAssign. Can be one of the following PjResAssignOperation constants:

Constant
Description

 


pjAssign
Assigns the specified resources to the selected tasks.

pjRemove
Removes the specified resources from the selected tasks.

pjReplace
The resources specified with With replace the resources specified with Resources.

pjChange
Changes the resource units for the specified resource. This constant can be used only for a single resource.

With




Optional String. When used with the pjReplace constant for Operation, specifies the names of the resources that replace the resources of the selected tasks.

ResourceAssignment Method Example

The following example prompts the user for the name of a resource, and then assigns that resource to the selected tasks.

Sub AssignResourceToSelectedTasks()

    Dim Entry As String     ' The name of the resource to add to selected tasks

    Dim R As Resource       ' Resource object used in For Each...Next loop

    Dim Found As Boolean    ' Whether or not the resource is in the active project

    Entry = InputBox$("Enter the name of the resource you want to add to the selected tasks.")

    ' Assume resource doesn't exist in the active project.

    Found = False

    ' Look for the resource.

    For Each R In ActiveProject.Resources

        If Entry = R.Name Then Found = True

    Next R

    ' If the resource is found, then assign it to selected tasks.

    If Found Then

        ResourceAssignment Resources:=Entry, Operation:=pjAssign

    ' Otherwise, tell user the resource doesn't exist.

    Else

        MsgBox ("There is no resource in the active project named " & Entry & ".")

    End If

End Sub

ResourceCalendarEditDays Method

Edits days in a resource calendar.

Syntax

expression.ResourceCalendarEditDays(ProjectName, ResourceName, StartDate, EndDate, Weekday, Working, Default, From1, To1, From2, To2, From3, To3)
expression



Optional. An expression that returns an Application object.

ProjectName


Required String. The name of the project containing the resource calendar to edit.

ResourceName

Required String. The name of the resource to edit.

StartDate




Optional Variant. The first date to edit.

EndDate




Optional Variant. The last date to edit.

Weekday




Optional Long. The weekday to edit. If StartDate and EndDate are specified, WeekDay is ignored. Can be one of the following PjWeekday constants: pjSunday, pjMonday, pjTuesday, pjWednesday, pjThursday, pjFriday, or pjSaturday.

Working




Optional Boolean. True if the days are working days. If Default is True, Working is ignored.

Default





Optional Boolean. True if the resource calendar uses the values in the corresponding base calendar as defaults. The default value is False.

From1





Optional Variant. The start time of the first shift.

To1






Optional Variant. The end time of the first shift.

From2





Optional Variant. The start time of the second shift.

To2






Optional Variant. The end time of the second shift.

From3





Optional Variant. The start time of the third shift.

To3






Optional Variant. The end time of the third shift.

ResourceCalendarReset Method

Resets a resource calendar.

Syntax

expression.ResourceCalendarReset(ProjectName, ResourceName, BaseCalendar)
expression



Optional. An expression that returns an Application object.

ProjectName


Required String. The name of the project containing the resource calendar to reset.

ResourceName

Required String. The name of the resource for the calendar to reset.

BaseCalendar


Optional String. The name of the base calendar on which to base the new settings of the resource calendar. The default value is the name of the current resource's base calendar.

ResourceCalendars Method

Displays the Change Working Time dialog box, which prompts the user to manage calendars.

Syntax

expression.ResourceCalendars
expression



Optional. An expression that returns an Application object.

ResourceDetails Method

Displays the details from a MAPI-compliant mail system's address book for a resource. This method is only available in resource views.

Syntax

expression.ResourceDetails(Name)
expression



Optional. An expression that returns an Application object.

Name





Optional String. The name of a resource to locate in the address book. If the name is found, the Properties dialog box for the individual is displayed. If an exact match is not found, the mail system displays the Check Names dialog box to allow the user to choose a valid name from the address book. If Name is omitted, the selected resource is used.

ResourceFilterList Property

Returns a List object representing all resource filters in the active project. Read-only.

ResourceFilterList Property Example

The following example lists all the resource filters in the active project.

Sub SeeAllResFilters()

    Dim Temp As Variant

    Dim ResFilterNames As String

    For Each Temp In ActiveProject.ResourceFilterList
        ResFilterNames = ResFilterNames & vbCrLf & Temp

    Next Temp

    MsgBox ResFilterNames

End Sub

ResourceGraphBarStyles Method

Sets the styles of bars on the Resource Graph.

Syntax

expression.ResourceGraphBarStyles(TopLeftShowAs, TopLeftColor, TopLeftPattern, BottomLeftShowAs, BottomLeftColor, BottomLeftPattern, TopRightShowAs, TopRightColor, TopRightPattern, BottomRightShowAs, BottomRightColor, BottomRightPattern, ShowValues, ShowAvailabilityLine, PercentBarOverlap)
expression




Optional. An expression that returns an Application object.

TopLeftShowAs


Optional Long. The bar type for the category in the upper-left corner of the Bar Styles dialog box. Can be one of the following PjResourceGraphStyle constants: pjBar, pjArea, pjStep, pjLine, pjStepLine, or pjDoNotShow.

TopLeftColor



Optional Long. The bar color for the category in the upper-left corner of the Bar Styles dialog box. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

TopLeftPattern



Optional Long. The bar pattern for the category in the upper-left corner of the Bar Styles dialog box. Can be one of the following PjResourceGraphPattern constants:

For line shapes: pjNoGraphLine, pjContinuous, pjGraphDash, pjDot, pjDashDot, or pjDashDotDot.

For nonline shapes:

pjDarkFill
pjLineCross

pjDiagonalCross
pjLineHorizontal

pjDiagonalLeft
pjLineVertical

pjDiagonalRight
pjMediumFill

pjHollow
pjSolid

pjLightFill


BottomLeftShowAs

Optional Long. The bar type for the category in the lower-left corner of the Bar Styles dialog box. Can be one of the PjResourceGraphStyle constants.

BottomLeftColor


Optional Long. The bar color for the category in the lower-left corner of the Bar Styles dialog box. Can be one of the PjColor constants.

BottomLeftPattern

Optional Long. The bar pattern for the category in the lower-left corner of the Bar Styles dialog box. Can be one of the PjResourceGraphPattern constants.

TopRightShowAs


Optional Long. The bar type for the category in the upper-right corner of the Bar Styles dialog box. Can be one of the PjResourceGraphStyle constants.

TopRightColor



Optional Long. The bar color for the category in the upper-right corner of the Bar Styles dialog box. Can be one of the PjColor constants.

TopRightPattern


Optional Long. The bar pattern for the category in the upper-right corner of the Bar Styles dialog box. Can be one of the PjResourceGraphPattern constants.

BottomRightShowAs
Optional Long. The bar type for the category in the lower-right corner of the Bar Styles dialog box. Can be one of the PjResourceGraphStyle constants.

BottomRightColor

Optional Long. The bar color for the category in the lower-right corner of the Bar Styles dialog box. Can be one of the PjColor constants.

BottomRightPattern

Optional Long. The bar pattern for the category in the lower-right corner of the Bar Styles dialog box. Can be one of the PjResourceGraphPattern constants.

ShowValues




Optional Boolean. True if the corresponding values appear below the bars.

ShowAvailabilityLine
Optional Boolean. True if a horizontal line appears where a resource reaches its maximum availability.

PercentBarOverlap

Optional Integer. A number from 0 to 100 that specifies the overlap percentage of displayed bars.

ResourceGroup Property

Returns the names of groups associated with the resources assigned to a task, separated by the list separator. Read-only String.

Remarks

For example, if Bob's group is "Writers" and Greg's group is "Editors", and Greg and Bob are assigned to the same task, then the ResourceGroup property for that task returns  "Writers,Editors".

This example assumes that the list separator character is the comma (,).  The list separator character can be set with the ListSeparator property.

ResourceID Property

Returns or sets the identification number of a resource in an assignment. Read/write Long.

ResourceInitials Property

Returns the initials of the resources assigned to a task, separated by the list separator. Read-only String.

ResourceName Property

Returns or sets the name of the resource in an assignment. Read/write String.

ResourceNames Property

Returns or sets the names of the resources assigned to a task. Read/write String.

Remarks

For a task with more than one resource, the ResourceNames property returns the names of the resources, separated by the list separator character. For example, the ResourceNames property returns "Tamara,Tanya" if the list separator character is the comma (,) and the task has two resources named Tamara and Tanya.

Microsoft Project uses the list separator specified in the Regional Settings icon of the Microsoft Windows Control Panel.

ResourcePhonetics Property

Returns the phonetic representation of a resource name. The ResourcePhonetics property only produces tangible results if the Japanese version of Microsoft Project is used. Read-only String.

ResourcePoolName Property

Returns the file name of the resource pool used by a project. If the project is not using a resource pool, returns the name of the project. Read-only String.

Resources Property

Returns a Resources collection representing the resources in a project, selection, or task. Read-only.

Resources Property Example

The following example displays the name of each resource assigned to the selected task.

Sub ResourceNames()

    Dim R As Resource

    For Each R In ActiveCell.Task.Resources
        MsgBox R.Name

    Next R

End Sub

ResourceSharing Method

Controls resource sharing.

Syntax

expression.ResourceSharing(Share, Name, Pool)
expression

Optional. An expression that returns an Application object.

Share



Optional Boolean. True if resources are shared. If Name is specified, Share is ignored.

Name



Optional String. The file name of the resource pool.

Pool




Optional Boolean. True if resources in the pool take precedence over resources in the local project.

Remarks

Using the ResourceSharing method without specifying any arguments displays the Share Resources dialog box.

ResourceSharingPoolAction Method

Performs actions on a resource pool.

Syntax

expression.ResourceSharingPoolAction(Action, FileName, ReadOnly)
expression

Optional. An expression that returns an Application object.

Action



Required Long. The actions to perform on the resource pool. Can be one of the following PjPoolAction constants:

Constant
Description

 


pjPoolTakesPrecedence
Causes the resource pool to take precedence over the sharers. 

pjSharersTakePrecedence
Causes the sharers to take precedence over the resource pool.

pjOpenSharer
Opens the sharer. (The sharer is specified with the FileName argument.)

pjOpenAllSharers
Opens all sharers into a consolidated project.

pjUnlinkSharer
Unlinks the sharer from the resource pool.

FileName


Optional String. The file name of the resource pool on which to perform the action.

ReadOnly


Optional Boolean. True if the files specified with FileName are opened read-only.

ResourceSharingPoolRefresh Method

Refreshes the resource sharing pool.

Syntax

expression.ResourceSharingPoolRefresh
expression

Optional. An expression that returns an Application object.

ResourceSharingPoolUpdate Method

Synchronizes the information in the sharer with the information in the resource pool.

Syntax

expression.ResourceSharingPoolUpdate(AllSharers)
expression

Optional. An expression that returns an Application object.

AllSharers

Optional Boolean. True if the information from all open sharers is updated in the pool. False if only the information from sharers in the active project is updated in the pool. If AllSharers is omitted and only one sharer is open, that information is updated in the pool; otherwise, the user is prompted for whether all open sharers or just those in the active project should be updated in the pool.

ResourceTableList Property

Returns a List object representing all resource tables in the active project. Read-only.

ResourceTableList Property Example

The following example lists all the resource tables in the active project.

Sub SeeAllResTables()

    Dim Temp As Variant

    Dim ResTableNames As String

    For Each Temp In ActiveProject.ResourceTableList
        ResTableNames = ResTableNames & vbCrLf & Temp

    Next Temp

    MsgBox ResTableNames

End Sub

ResourceUniqueID Property

Returns or sets a unique identification number of a resource in an assignment. Read/write Long.

ResourceViewList Property

Returns a List object representing all resource views in the active project. Read-only.

ResourceViewList Property Example

The following example lists all the resource views in the active project.

Sub SeeAllResViews()

    Dim Temp As Variant

    Dim ResViewNames As String

    For Each Temp In ActiveProject.ResourceViewList
        ResViewNames = ResViewNames & vbCrLf & Temp

    Next Temp

    MsgBox ResViewNames

End Sub

ResponsePending Property

Assignment object: True if a response has not been received for a TeamAssign message. Read/write Boolean.

Resource object: True if the resource has not responded to at least one TeamAssign message. Read-only Boolean.
Task object: True if a response has not been received for at least one TeamAssign message. Read-only Boolean.

Resume Property

Returns or sets the date a task will resume. Read/write Variant.

RevisionNumber Property

Returns the number of times a project has been saved. Read-only Long.

Rollup Property

True if the dates of a subtask appear on its corresponding summary task bar. This property must be True on the summary task as well as the subtasks for the rollup to occur. Read/write Boolean.

Rollup Property Example

The following example sets the Rollup property to True for milestone tasks, and False for other tasks in the active project.

Sub DisplayMilestonesInSummaryBars()


Dim T As Task

' Task object used in For Each loop


' Cycle through tasks in active project.


For Each T In ActiveProject.Tasks



' If task is a milestone or a summary, set its Rollup property to True.



If T.Summary Or T.Milestone Then




T.Rollup = True



' If task isn't a summary task or milestone, set its Rollup property to False.



Else




T.Rollup = False



End If


Next T

End Sub

RowClear Method

Clears the active row.

Syntax

expression.RowClear
expression

Optional. An expression that returns an Application object.

RowDelete Method

Deletes the active row or the row that contains the active cell.

Syntax

expression.RowDelete
expression

Optional. An expression that returns an Application object.

RowInsert Method

Inserts a row above the active row.

Syntax

expression.RowInsert
expression

Optional. An expression that returns an Application object.

Saved Property

True if a project has not changed since it was last saved. Read-only Boolean.

ScheduleFromStart Property

True if Microsoft Project calculates projects forward from their start dates. False if Microsoft Project calculates projects backward from their finish dates. Read/write Boolean.

SelectAll Method

Selects all cells on the active sheet.

Syntax

expression.SelectAll
expression

Optional. An expression that returns an Application object.

SelectBeginning Method

Selects the first cell in the active table.

Syntax

expression.SelectBeginning(Extend)
expression

Optional. An expression that returns an Application object.

Extend



Optional Boolean. True if the current selection is extended to the first cell. If the active view is the PERT Chart or Resource Graph, Extend is ignored. The default value is False.

Remarks

In the Resource Graph, SelectBeginning selects the resource with the lowest identification number. In the PERT Chart, SelectBeginning selects the PERT box closest to the upper-left corner of the view.

The SelectBeginning method is not available when the Calendar is the active view.

SelectCell Method

Selects a cell.

Syntax

expression.SelectCell(Row, Column, RowRelative)
expression

Optional. An expression that returns an Application object.

Row




Optional Long. The row number (RowRelative is False) or the relative row position (RowRelative is True) of the cell to select.

Column


Optional Integer. The column number of the cell to select.

RowRelative

Optional Boolean. True if the row number is relative to the active cell. The default value is True.

Remarks

Using the SelectCell method without specifying any arguments retains the current cell as the active cell.

The SelectCell method is not available when the Calendar, PERT Chart, or Resource Graph is the active view.

SelectCellDown Method

Selects cells downward from the current selection.

Syntax

expression.SelectCellDown(NumCells, Extend)
expression

Optional. An expression that returns an Application object.

NumCells


Optional Long. The number of cells to select downward from the current selection. The default value is 1.

Extend



Optional Boolean. True if the current selection is extended to the specified cell. The default value is False.

Remarks

The SelectCellDown method is not available when the Calendar, PERT Chart, or Resource Graph is the active view.

SelectCellLeft Method

Selects cells to the left of the current selection.

Syntax

expression.SelectCellLeft(NumCells, Extend)
expression

Optional. An expression that returns an Application object.

NumCells


Optional Long. The number of cells to select to the left of the current selection. The default value is 1.

Extend



Optional Boolean. True if the current selection is extended to the specified cell. The default value is False.

Remarks

The SelectCellLeft method is not available when the Calendar, PERT Chart, or Resource Graph is the active view.

SelectCellRight Method

Selects cells to the right of the current selection.

Syntax

expression.SelectCellRight(NumCells, Extend)
expression

Optional. An expression that returns an Application object.

NumCells


Optional Long. The number of cells to select to the right of the current selection. The default value is 1.

Extend



Optional Boolean. True if the current selection is extended to the specified cell. The default value is False.

Remarks

The SelectCellRight method is not available when the Calendar, PERT Chart, or Resource Graph is the active view.

SelectCellUp Method

Selects cells upward from the current selection.

Syntax

expression.SelectCellUp(NumCells, Extend)
expression

Optional. An expression that returns an Application object.

NumCells


Optional Long. The number of cells to select upward from the current selection. The default value is 1.

Extend



Optional Boolean. True if the current selection is extended to the specified cell. The default value is False.

Remarks

The SelectCellUp method is not available when the Calendar, PERT Chart, or Resource Graph is the active view.

SelectColumn Method

Selects one or more columns.

Syntax

expression.SelectColumn(Column, Additional, Extend, Add)
expression

Optional. An expression that returns an Application object.

Column


Optional Integer. The number of the column to select. (Columns are numbered from left to right, starting with 2.) The default is the active column.

Additional

Optional Integer. The number of columns to select in addition to the active column.

Extend



Optional Boolean. True if the active selection is extended into the new selection. The default value is False.

Add




Optional Boolean. True if the new selection is added to the active selection. The default value is False.

SelectEnd Method

Selects the last cell in the active table that contains a resource or task.

Syntax

expression.SelectEnd(Extend)
expression

Optional. An expression that returns an Application object.

Extend



Optional Boolean. True if the current selection is extended to the last cell. If the active view is the PERT Chart or Resource Graph, Extend is ignored. The default value is False.

Remarks

In the Resource Graph, SelectEnd selects the resource with the highest identification number. In the PERT Chart, SelectEnd selects the PERT box closest to the lower-right corner of the view.

The SelectEnd method is not available when the Calendar is the active view.

Selection Object

Represents a selection in the active project. There is no collection for Selection objects. The Selection object can only be accessed through the ActiveSelection property of the Application object.

Using the Selection Object

Use the ActiveSelection property to return a Selection object. The following example lists the names of all the resources in the selection.

Dim R As Resource, Names As String

For Each R In ActiveSelection.Resources

    Names = R.Name & ListSeparator & " " & Names

Next R

MsgBox Left$(Names, Len(Names) - Len(ListSeparator & " "))

SelectionExtend Method

Turns selection extending on or off.

Syntax

expression.SelectionExtend(Extend, Add)
expression

Optional. An expression that returns an Application object.

Extend



Optional Boolean. True if extend mode is active. (If extend mode is active, all items between the selection and the active item become part of the selection.) If Extend is True, Add is ignored. The default value is False.

Add




Optional Boolean. True if add mode is active. (If add mode is active, only the active item is added to the selection.) The default value is False.

SelectRange Method

Selects one or more cells.

Syntax

expression.SelectRange(Row, Column, RowRelative, Width, Height, Extend, Add)
expression

Optional. An expression that returns an Application object.

Row




Required Long. The number of the row containing the cell to select.

Column


Required Integer. The number of the column containing the cell to select. (Columns are numbered from left to right, starting with 2.)

RowRelative

Optional Boolean. True if the location of the new selection is relative to the active selection. The default value is True.

Width



Optional Long. The number of columns to select in addition to the active cell.

Height



Optional Long. The number of rows to select in addition to the active cell.

Extend



Optional Boolean. True if the active selection is extended into the new selection. The default value is False.

Add




Optional Boolean. True if the new selection is added to the active selection. The default value is False.

SelectResourceCell Method

Selects a cell containing resource information.

Syntax

expression.SelectResourceCell(Row, Column, RowRelative)
expression

Optional. An expression that returns an Application object.

Row




Optional Long. The row number (RowRelative is False) or the relative row position (RowRelative is True) of the cell to select.

Column


Optional String. The field name of the cell to select.

RowRelative

Optional Boolean. True if the row number is relative to the active cell. The default value is True.

Remarks

Using the SelectResourceCell method without specifying any arguments retains the current cell as the active cell.

The SelectResourceCell method is only available when the Resource Sheet or Resource Usage view is the active view.

SelectResourceColumn Method

Selects a column containing resource information.

Syntax

expression.SelectResourceColumn(Column, Additional, Extend, Add)
expression

Optional. An expression that returns an Application object.

Column


Optional String. The field name of the column to select. The default is the column containing the active cell.

Additional

Optional Integer. The number of additional columns to select to the right of Column. If Extend is True, Additional is ignored. The default value is 0.

Extend



Optional Boolean. True if all columns between the current selection and Column are selected. The default value is False.

Add




Optional Boolean. True if the current column is included in the selection. The default value is False.

Remarks

The SelectResourceColumn method is only available when the Resource Sheet or Resource Usage view is the active view.

SelectResourceField Method

Selects a resource field.

Syntax

expression.SelectResourceField(Row, Column, RowRelative, Width, Height, Extend, Add)
expression

Optional. An expression that returns an Application object.

Row




Required Long. The number of the row containing the field to select.

Column


Required String. The name of the column containing the field to select.

RowRelative

Optional Boolean. True if the location of the new selection is relative to the active selection. The default value is True.

Width



Optional Long. The number of columns to select in addition to the active field.

Height



Optional Long. The number of rows to select in addition to the active field.

Extend



Optional Boolean. True if the active selection is extended into the new selection. The default value is False.

Add




Optional Boolean. True if the new selection is added to the active selection. The default value is False.

SelectRow Method

Selects one or more rows.

Syntax

expression.SelectRow(Row, RowRelative, Height, Extend, Add)
expression

Optional. An expression that returns an Application object.

Row




Optional Long. The number of the row to select. The default is the active row.

RowRelative

Optional Boolean. True if the location of the new selection is relative to the active selection. The default value is True.

Height



Optional Long. The number of rows to select in addition to the active cell.

Extend



Optional Boolean. True if the active selection is extended into the new selection. The default value is False.

Add




Optional Boolean. True if the new selection is added to the active selection. The default value is False.

SelectRowEnd Method

Selects the last cell in the row containing the active cell.

Syntax

expression.SelectRowEnd(Extend)
expression

Optional. An expression that returns an Application object.

Extend



Optional Boolean. True if the current selection is extended to the last cell. The default value is False.

Remarks

The SelectRowEnd method is only available when the Gantt Chart, Task Sheet, Task Usage view, Resource Sheet, or Resource Usage view is the active view.

SelectRowStart Method

Selects the first cell in the row containing the active cell.

Syntax

expression.SelectRowStart(Extend)
expression

Optional. An expression that returns an Application object.

Extend



Optional Boolean. True if the current selection is extended to the first cell. The default value is False.

Remarks

The SelectRowStart method is only available when the Gantt Chart, Task Sheet, Task Usage view, Resource Sheet, or Resource Usage view is the active view.

SelectSheet Method

Selects all cells in the active table.

Syntax

expression.SelectSheet
expression

Optional. An expression that returns an Application object.

Remarks

The SelectSheet method is only available when the Gantt Chart, Task Sheet, Task Usage view, Resource Sheet, or Resource Usage view is the active view.

SelectTaskCell Method

Selects a cell containing task information.

Syntax

expression.SelectTaskCell(Row, Column, RowRelative)
expression

Optional. An expression that returns an Application object.

Row




Optional Long. The row number (RowRelative is False) or the relative row position (RowRelative is True) of the cell to select.

Column


Optional String. The field name of the cell to select.

RowRelative

Optional Boolean. True if the row number is relative to the active cell. The default value is True.

Remarks

Using the SelectTaskCell method without specifying any arguments retains the current cell as the active cell.

The SelectTaskCell method is only available when the Gantt Chart, Task Sheet, or Task Usage view is the active view.

SelectTaskColumn Method

Selects a column containing task information.

Syntax

expression.SelectTaskColumn(Column, Additional, Extend, Add)
expression

Optional. An expression that returns an Application object.

Column


Optional String. The field name of the column to select. The default is the column containing the active cell.

Additional

Optional Integer. The number of additional columns to select to the right of Column. If Extend is True, Additional is ignored. The default value is 0.

Extend



Optional Boolean. True if all columns between the current selection and Column are selected. The default value is False.

Add




Optional Boolean. True if the current column is included in the selection. The default value is False.

Remarks

The SelectTaskColumn method is only available when the Gantt Chart, Task Sheet, or Task Usage view is the active view.

SelectTaskField Method

Selects a task field.

Syntax

expression.SelectTaskField(Row, Column, RowRelative, Width, Height, Extend, Add)
expression

Optional. An expression that returns an Application object.

Row




Required Long. The number of the row containing the field to select.

Column


Required String. The name of the column containing the field to select.

RowRelative

Optional Boolean. True if the location of the new selection is relative to the active selection. The default value is True.

Width



Optional Long. The number of columns to select in addition to the active field.

Height



Optional Long. The number of rows to select in addition to the active field.

Extend



Optional Boolean. True if the active selection is extended into the new selection. The default value is False.

Add




Optional Boolean. True if the new selection is added to the active selection. The default value is False.

SelectTimescaleRange Method

Selects one or more timescale data cells in a usage view.

Syntax

expression.SelectTimescaleRange(Row, StartTime, Width, Height)
expression

Optional. An expression that returns an Application object.

Row




Required Long. The number of the row containing the cell to select.

StartTime


Required Variant. A time (from the timescale) that functions as the starting point of the selection.

Width



Required Integer. The number of columns to select.

Height



Required Long. The number of rows to select.

SelectTimescaleRange Method Example

The following example selects a five-day range of timescale data cells for the specified row. It assumes the timescale has not been changed from the default setting. The SelectRow method is not required for this example, but is included to make the result easier to read.

Sub SelectWeek()

    Dim WhichRow As Integer, StartDate As Variant

    WhichRow = InputBox("Start selection on which row?")

    StartDate = InputBox("Enter the date for the start of a week: ")

    SelectRow WhichRow, False

    SelectTimescaleRange Row:=WhichRow, StartTime:=StartDate, Width:=5, Height:=1

End Sub

SendHyperlinkNote Property

True if resources receive e-mail notification when new mail arrives in their TeamInbox. Read/write Boolean.

ServerPath Property

Returns or sets the UNC of the Web server for workgroup messages. Read/write String.

ServerPath Property Example

The following example sets the Web server path for workgroup messages based upon a department code at the beginning of each project's name.

Sub SetServerPerDepartment()

    If Left$(ActiveProject.Name, 3) = "011" Then

        ActiveProject.ServerPath = "\\Corporate\Finance"

    ElseIf Left$(ActiveProject.Name, 3) = "024" Then

        ActiveProject.ServerPath = "\\Corporate\Engineering"

    End If

End Sub

ServerURL Property

Returns or sets the URL of the Web server for workgroup messages. Read/write String.

SetActiveCell Method

Sets the value of the active cell.

Syntax

expression.SetActiveCell(Value, Create)
expression

Optional. An expression that returns an Application object.

Value



Required String. The new value for the active cell.

Create



Optional Boolean. True if a new assignment, resource, or task should be created when setting the value of the active cell, if one doesn't already exist. The default value is True.

SetActiveCell Method Example

The following example enters the specified text in the active cell. It assumes the active cell accepts string input.

Sub AddCommentToTable()

    Dim M As String

    M = InputBox$("Enter your comment: ")

    SetActiveCell M, False

End Sub

SetField Method

Sets the value in a field for the selected task or resource. The SetField method may apply to an Application object (Syntax 1), or to a Resource or Task object (Syntax 2).

Syntax 1

expression.SetField(Field, Value, Create)
expression

Optional. An expression that returns an Application object.

Field




Required String. The name of the field to set.

Value



Required String. The value of the field.

Create



Optional Boolean. True if a new task or resource is created. The default value is True.

Syntax 2

expression.SetField(FieldID, Value)
expression

Required. An expression that returns a Resource or Task object.

FieldID



Required Long. The field to set.


If expression is a Task, can be one of the following PjField constants:

pjTaskActualCost
pjTaskLinkedFields

pjTaskActualDuration
pjTaskMarked

pjTaskActualFinish
pjTaskMilestone

pjTaskActualOvertimeCost
pjTaskName

pjTaskActualOvertimeWork
pjTaskNotes

pjTaskActualStart
pjTaskNumber1

pjTaskActualWork
pjTaskNumber2

pjTaskACWP
pjTaskNumber3

pjTaskAssignmentDelay
pjTaskNumber4

pjTaskAssignmentUnits
pjTaskNumber5

pjTaskBaselineCost
pjTaskNumber6

pjTaskBaselineDuration
pjTaskNumber7

pjTaskBaselineFinish
pjTaskNumber8

pjTaskBaselineStart
pjTaskNumber9

pjTaskBaselineWork
pjTaskNumber10

pjTaskBCWP
pjTaskNumber11

pjTaskBCWS
pjTaskNumber12

pjTaskConfirmed
pjTaskNumber13

pjTaskConstraintDate
pjTaskNumber14

pjTaskConstraintType
pjTaskNumber15

pjTaskContact
pjTaskNumber16

pjTaskCost
pjTaskNumber17

pjTaskCost1
pjTaskNumber18

pjTaskCost2
pjTaskNumber19

pjTaskCost3
pjTaskNumber20

pjTaskCost4
pjTaskObjects

pjTaskCost5
pjTaskOutlineLevel

pjTaskCost6
pjTaskOutlineNumber

pjTaskCost7
pjTaskOverallocated

pjTaskCost8
pjTaskOvertimeCost

pjTaskCost9
pjTaskOvertimeWork

pjTaskCost10
pjTaskPercentComplete

pjTaskCostRateTable
pjTaskPercentWorkComplete

pjTaskCostVariance
pjTaskPredecessors

pjTaskCreated
pjTaskPreleveledFinish

pjTaskCritical
pjTaskPreleveledStart

pjTaskCV
pjTaskPriority

pjTaskDate1
pjTaskProject

pjTaskDate2
pjTaskRecurring

pjTaskDate3
pjTaskRegularWork

pjTaskDate4
pjTaskRemainingCost

pjTaskDate5
pjTaskRemainingDuration

pjTaskDate6
pjTaskRemainingOvertimeCost

pjTaskDate7
pjTaskRemainingOvertimeWork

pjTaskDate8
pjTaskRemainingWork

pjTaskDate9
pjTaskResourceGroup

pjTaskDate10
pjTaskResourceInitials

pjTaskDelay
pjTaskResourceNames

pjTaskDuration
pjTaskResourcePhonetics

pjTaskDuration1
pjTaskResponsePending

pjTaskDuration2
pjTaskResume

pjTaskDuration3
pjTaskResumeNoEarlierThan

pjTaskDuration4
pjTaskRollup

pjTaskDuration5
pjTaskSheetNotes

pjTaskDuration6
pjTaskStart

pjTaskDuration7
pjTaskStart1

pjTaskDuration8
pjTaskStart2

pjTaskDuration9
pjTaskStart3

pjTaskDuration10
pjTaskStart4

pjTaskDurationVariance
pjTaskStart5

pjTaskEarlyFinish
pjTaskStart6

pjTaskEarlyStart
pjTaskStart7

pjTaskEffortDriven
pjTaskStart8

pjTaskExternalTask
pjTaskStart9

pjTaskFinish
pjTaskStart10

pjTaskFinish1
pjTaskStartVariance

pjTaskFinish2
pjTaskStop

pjTaskFinish3
pjTaskSubproject

pjTaskFinish4
pjTaskSubprojectReadOnly

pjTaskFinish5
pjTaskSuccessors

pjTaskFinish6
pjTaskSummary

pjTaskFinish7
pjTaskSV

pjTaskFinish8
pjTaskTeamStatusPending

pjTaskFinish9
pjTaskText1

pjTaskFinish10
pjTaskText2

pjTaskFinishVariance
pjTaskText3

pjTaskFixedCost
pjTaskText4

pjTaskFixedCostAccrual
pjTaskText5

pjTaskFixedDuration
pjTaskText6

pjTaskFlag1
pjTaskText7

pjTaskFlag2
pjTaskText8

pjTaskFlag3
pjTaskText9

pjTaskFlag4
pjTaskText10

pjTaskFlag5
pjTaskText11

pjTaskFlag6
pjTaskText12

pjTaskFlag7
pjTaskText13

pjTaskFlag8
pjTaskText14

pjTaskFlag9
pjTaskText15

pjTaskFlag10
pjTaskText16

pjTaskFlag11
pjTaskText17

pjTaskFlag12
pjTaskText18

pjTaskFlag13
pjTaskText19

pjTaskFlag14
pjTaskText20

pjTaskFlag15
pjTaskText21

pjTaskFlag16
pjTaskText22

pjTaskFlag17
pjTaskText23

pjTaskFlag18
pjTaskText24

pjTaskFlag19
pjTaskText25

pjTaskFlag20
pjTaskText26

pjTaskFreeSlack
pjTaskText27

pjTaskHideBar
pjTaskText28

pjTaskHyperlink
pjTaskText29

pjTaskHyperlinkAddress
pjTaskText30

pjTaskHyperlinkHref
pjTaskTotalSlack

pjTaskHyperlinkSubAddress
pjTaskType

pjTaskID
pjTaskUniqueID

pjTaskIndicators
pjTaskUniquePredecessors

pjTaskIsAssignment
pjTaskUniqueSuccessors

pjTaskLateFinish
pjTaskUpdateNeeded

pjTaskLateStart
pjTaskWBS

pjTaskLevelAssignments
pjTaskWork

pjTaskLevelCanSplit
pjTaskWorkContour

pjTaskLevelDelay
pjTaskWorkVariance


If expression is a Resource, can be one of the following PjField constants:

pjResourceAccrueAt
pjResourceIsAssignment

pjResourceActualCost
pjResourceLevelingDelay

pjResourceActualOvertimeCost
pjResourceLinkedFields

pjResourceActualOvertimeWork
pjResourceMaxUnits

pjResourceActualWork
pjResourceName

pjResourceACWP
pjResourceNotes

pjResourceAssignmentDelay
pjResourceNumber1

pjResourceAssignmentUnits
pjResourceNumber2

pjResourceAvailableFrom
pjResourceNumber3

pjResourceAvailableTo
pjResourceNumber4

pjResourceBaseCalendar
pjResourceNumber5

pjResourceBaselineCost
pjResourceNumber6

pjResourceBaselineFinish
pjResourceNumber7

pjResourceBaselineStart
pjResourceNumber8

pjResourceBaselineWork
pjResourceNumber9

pjResourceBCWP
pjResourceNumber10

pjResourceBCWS
pjResourceNumber11

pjResourceCanLevel
pjResourceNumber12

pjResourceCode
pjResourceNumber13

pjResourceConfirmed
pjResourceNumber14

pjResourceCost
pjResourceNumber15

pjResourceCost1
pjResourceNumber16

pjResourceCost2
pjResourceNumber17

pjResourceCost3
pjResourceNumber18

pjResourceCost4
pjResourceNumber19

pjResourceCost5
pjResourceNumber20

pjResourceCost6
pjResourceObjects

pjResourceCost7
pjResourceOverallocated

pjResourceCost8
pjResourceOvertimeCost

pjResourceCost9
pjResourceOvertimeRate

pjResourceCost10
pjResourceOvertimeWork

pjResourceCostPerUse
pjResourcePeakUnits

pjResourceCostRateTable
pjResourcePercentWorkComplete

pjResourceCostVariance
pjResourcePhonetics

pjResourceCV
pjResourceProject

pjResourceDate1
pjResourceRegularWork

pjResourceDate2
pjResourceRemainingCost

pjResourceDate3
pjResourceRemainingOvertimeCost

pjResourceDate4
pjResourceRemainingOvertimeWork

pjResourceDate5
pjResourceRemainingWork

pjResourceDate6
pjResourceResponsePending

pjResourceDate7
pjResourceSheetNotes

pjResourceDate8
pjResourceStandardRate

pjResourceDate9
pjResourceStart

pjResourceDate10
pjResourceStart1

pjResourceDuration1
pjResourceStart2

pjResourceDuration2
pjResourceStart3

pjResourceDuration3
pjResourceStart4

pjResourceDuration4
pjResourceStart5

pjResourceDuration5
pjResourceStart6

pjResourceDuration6
pjResourceStart7

pjResourceDuration7
pjResourceStart8

pjResourceDuration8
pjResourceStart9

pjResourceDuration9
pjResourceStart10

pjResourceDuration10
pjResourceSV

pjResourceEMailAddress
pjResourceTaskSummaryName

pjResourceFinish1
pjResourceTeamStatusPending

pjResourceFinish2
pjResourceText1

pjResourceFinish3
pjResourceText2

pjResourceFinish4
pjResourceText3

pjResourceFinish5
pjResourceText4

pjResourceFinish6
pjResourceText5

pjResourceFinish7
pjResourceText6

pjResourceFinish8
pjResourceText7

pjResourceFinish9
pjResourceText8

pjResourceFinish10
pjResourceText9

pjResourceFlag1
pjResourceText10

pjResourceFlag2
pjResourceText11

pjResourceFlag3
pjResourceText12

pjResourceFlag4
pjResourceText13

pjResourceFlag5
pjResourceText14

pjResourceFlag6
pjResourceText15

pjResourceFlag7
pjResourceText16

pjResourceFlag8
pjResourceText17

pjResourceFlag9
pjResourceText18

pjResourceFlag10
pjResourceText19

pjResourceFlag11
pjResourceText20

pjResourceFlag12
pjResourceText21

pjResourceFlag13
pjResourceText22

pjResourceFlag14
pjResourceText23

pjResourceFlag15
pjResourceText24

pjResourceFlag16
pjResourceText25

pjResourceFlag17
pjResourceText26

pjResourceFlag18
pjResourceText27

pjResourceFlag19
pjResourceText28

pjResourceFlag20
pjResourceText29

pjResourceGroup
pjResourceText30

pjResourceHyperlink
pjResourceUniqueID

pjResourceHyperlinkAddress
pjResourceUpdateNeeded

pjResourceHyperlinkHref
pjResourceWork

pjResourceHyperlinkSubAddress
pjResourceWorkContour

pjResourceID
pjResourceWorkgroup

pjResourceIndicators
pjResourceWorkVariance

pjResourceInitials


Value



Required String. The value of the field.

SetMatchingField Method

Sets the value in the field of selected tasks or resources that meet the specified criteria.

Syntax

expression.SetMatchingField(Field, Value, CheckField, CheckValue, CheckTest, CheckOperation, CheckField2, CheckValue2, CheckTest2)
expression

Optional. An expression that returns an Application object.

Field




Required String. The name of the field to set.

Value



Required String. The value to which the field is set.

CheckField

Required String. The name of the field to check.

CheckValue

Required String. The value to compare with the value of the field specified with CheckField.

CheckTest

Optional String. The type of comparison made between CheckField and CheckValue. The default value is "equals". Can be one of the following comparison strings:

Comparison String
Description




"equals"
The value of CheckField equals CheckValue.

"does not equal"
The value of CheckField does not equal CheckValue.

"is greater than"
The value of CheckField is greater than CheckValue.

"is greater than or equal to"
The value of CheckField is greater than or equal to CheckValue.

"is less than"
The value of CheckField is less than CheckValue.

"is less than or equal to"
The value of CheckField is less than or equal to CheckValue.

"is within"
The value of CheckField is within CheckValue.

"is not within"
The value of CheckField is not within CheckValue.

"contains"
CheckField contains CheckValue.

"does not contain"
CheckField does not contain CheckValue.

"contains exactly"
CheckField exactly contains CheckValue.

CheckOperation

Optional String. How the criteria established with CheckField, CheckTest, and CheckValue relate to the second criteria, if specified. The CheckOperation argument can be set to "And" or "Or". The default value is "And".

CheckField2



Required String. The name of the second field to check.

CheckValue2


Required String. The value to which the second field is set.

CheckTest2



The type of comparison made between CheckField2 and CheckValue2. Can be one of the same comparison strings as CheckTest.

SetResourceField Method

Sets the value of a resource field.

Syntax

expression.SetResourceField(Field, Value, AllSelectedResources, Create, ResourceID, ProjectName)
expression



Optional. An expression that returns an Application object.

Field






Required String. The name of the resource field to set.

Value





Required String. The value of the resource field.

AllSelectedResources

Optional Boolean. True if the value of the field is set for all selected resources. False if the value is set for the active resource. The default value is False.

Create





Optional Boolean. True if Microsoft Project should create a new resource if the active cell is on an empty row. The default value is True.

ResourceID



Optional Long. The identification number of the resource containing the field to set. If AllSelectedResources is True, ResourceID is ignored.

ProjectName


Optional String. If the active project is a consolidated project, specifies the name of the project for the resource specified by ResourceID. If ResourceID is not specified, ProjectName is ignored. The default value is the name of the active project.

SetTaskField Method

Sets the value of a task field.

Syntax

expression.SetTaskField(Field, Value, AllSelectedTasks, Create, TaskID, ProjectName)
expression


Optional. An expression that returns an Application object.

Field





Required String. The name of the task field to set.

Value




Required String. The value of the task field.

AllSelectedTasks

Optional Boolean. True if the value of the field is set for all selected tasks. False if the value is set for the active task. The default value is False.

Create




Optional Boolean. True if Microsoft Project should create a new task if the active cell is on an empty row. The default value is True.

TaskID




Optional Long. The identification number of the task containing the field to set. If AllSelectedTasks is True, TaskID is ignored.

ProjectName

Optional String. If the active project is a consolidated project, specifies the name of the project for the task specified by TaskID. If TaskID is not specified, ProjectName is ignored. The default value is the name of the active project.

Shift Object

Represents a work shift for a day, month, period, weekday, or year. There is no collection for Shift objects. Where the Shift object appears in this diagram, it can be accessed through the Shiftn properties of the appropriate objects.

Using the Shift Object

Use the Shiftn property to return a Shift object. The following example sets every Friday as a half-day by setting the start and finish times for the first shift and clearing the values of the second and third shifts.

With ActiveProject.Calendar.WeekDays(pjFriday)

    .Shift1.Start = #8:00:00 AM#

    .Shift1.Finish = #12:00:00 PM#

    .Shift2.Clear

    .Shift3.Clear

End With

Shiftn Property

Returns a Shift object representing a shift of a day, month, period, weekday, or year. Read-only.

Syntax

expression.Shiftn
expression

Required. An expression that returns an object in the Applies To list.

n





Required Integer. A number from 1 to 3 that specifies the shift to return.

Shiftn Property Example

The following example schedules a half-day of work on Fridays by creating an 8 A.M. to noon shift.

Sub HalfDayFridays()

    With ActiveProject.Calendar.WeekDays(pjFriday)

        .Shift1.Start = #8:00:00 AM#

        .Shift1.Finish = #12:00:00 PM#

        .Shift2.Clear

        .Shift3.Clear

    End With

End Sub

ShowAssignmentUnitsAs Property

Returns or sets how assignment units display. Can be one of the following PjAssignmentUnits constants: pjDecimalAssignmentUnits or pjPercentageAssignmentUnits. Read/write Long.

ShowCriticalSlack Property

Returns or sets how much slack causes a task to be displayed as a critical task. Read/write Long.

Remarks

If a task's slack time does not exceed the number of days returned by the ShowCriticalSlack property, Microsoft Project displays the task as critical.

ShowCrossProjectLinksInfo Property

True if the Links between Projects dialog box appears when a project containing cross-project links is opened. Read-only Boolean.

ShowExternalPredecessors Property

True if predecessors linked from an external project should be displayed. Read-only Boolean.

ShowExternalSuccessors Property

True if successors linked from an external project should be displayed. Read-only Boolean.

ShowTipOfDay Property

True if the Tip of the Day appears when Microsoft Project is started. Read/write Boolean.

ShowWelcome Property

True if the Welcome dialog box appears when Microsoft Project is started. Read/write Boolean.

Sort Method

Sorts the tasks or resources in the active pane.

Syntax

expression.Sort(Key1, Ascending1, Key2, Ascending2, Key3, Ascending3, Renumber, Outline)
expression

Optional. An expression that returns an Application object.

Key1




Optional String. The name of a primary field to sort. If Key1 is omitted, the Sort dialog box appears, which prompts the user to specify sorting information.

Ascending1

Optional Boolean. True if the primary field will be sorted in ascending order. The default value is True.

Key2




Optional String. The name of a secondary field to sort.

Ascending2

Optional Boolean. True if the secondary field will be sorted in ascending order. The default value is True.

Key3




Optional String. The name of a tertiary field to sort.

Ascending3

Optional Boolean. True if the tertiary field will be sorted in ascending order. The default value is True.

Renumber

Optional Boolean. True if Microsoft Project should renumber tasks after sorting them. For task views, Renumber can be True only if Outline is True. If Outline is True, then Renumber defaults to the current setting in the Sort dialog box.  If Outline is False, Renumber is ignored.

Outline



Optional Boolean. True if the outline level of tasks or resources will be preserved after sorting them. The default value is True.

Sort Method Example

The following example sorts the tasks in the active project by priority, and then renumbers the tasks.

Sub SortByPriority()


Sort Key1:="Priority", Ascending1:=True, Renumber:=True

End Sub

SpaceBeforeTimeLabels Property

True if a time value should be separated from its time label by a space. Read/write Boolean.

SpellingCheck Method

Checks the spelling in the active project.

Syntax

expression.SpellingCheck
expression

Optional. An expression that returns an Application object.

Remarks

The SpellingCheck method has the same effect as the Spelling command on the Tools menu.

Split Method

Splits a task into portions.

Syntax

expression.Split(StartSplitOn, EndSplitOn)
expression

Required. An expression that returns a Task object.

StartSplitOn

Required Variant. If a time is not specified, the project's default end time for the working period is used.

EndSplitOn
   Required Variant. The end date of the task split. If a time is not specified, the project's default start time for the working period is used.. If EndSplitOn is on or before the date specified with StartSplitOn, the split is not created.

Split Method Example

The following example creates a split in the specified task.

Sub CreateSplit()

    Dim WhichTask As Long

    Dim SplitFrom As Variant, SplitTo As Variant

     WhichTask = InputBox("Enter the ID of the task you would like to " _

        & "split:")

    SplitFrom = InputBox("Enter the date and time for the start of the" & _

        " split: " & vbCrLf & vbCrLf & "(The default time is the end" & _

            " time of the preceding working period.)")

    SplitTo = InputBox("Enter the date and time for the end of the split: " & _

        vbCrLf & vbCrLf & "(The default time is the start time of the next" & _

            " working period.)")

    ActiveProject.Tasks(WhichTask).Split SplitFrom, SplitTo

End Sub

SplitPart Object, SplitParts Collection Object

Represents a task portion. The SplitPart object is a member of the SplitParts collection.

Using the SplitPart Object

Use SplitParts(Index), where Index is the task portion index number, to return a single SplitPart object. The following example lists the start and finish times of each task portion of the task in the active cell.

Dim Part As Long, Portions As String

For Part = 1 To ActiveCell.Task.SplitParts.Count

    With ActiveCell.Task

        Portions = Portions & "Task portion " & Part & ": Start on " & _

            .SplitParts(Part).Start & ", Finish on " & _

            .SplitParts(Part).Finish & vbCrLf

    End With

Next Part

MsgBox Portions

Using the SplitParts Collection

Use the SplitParts property to return a SplitParts collection. The following example returns the number of task portions for each task in the active project.

Dim T As Task

For Each T In ActiveProject.Tasks

    If Not (T Is Nothing) Then

        MsgBox T.Name & ": " & T.SplitParts.Count

    End If

Next T

Use the Split method (Task object) to add a SplitPart object to the SplitParts collection. (The Split method creates a split in a task.) The following example creates a split in the task from Wednesday to Monday.

ActiveCell.Task.Split "10/1/97", "10/6/97"

SplitParts Property

Returns a SplitParts collection that represents the portions of a task. Read-only.

SplitParts Property Example

The following example returns the number of task portions for each task in the active project.

Sub CountTaskPortions()

    Dim T As Task, HowMany As Long

    For Each T In ActiveProject.Tasks

        HowMany = 0

        If Not (T Is Nothing) Then

            HowMany = HowMany + T.SplitParts.Count

            MsgBox T.Name & ": " & HowMany & " task portion(s)"

        End If

    Next T

End Sub

SplitTask Method

Enters interactive task split mode, enabling the user to manually create task splits.

Syntax

expression.SplitTask(Lock)
expression

Optional. An expression that returns an Application object.

Lock




Optional Boolean. True if the task split pointer stays active after a split is made, enabling more task splits to be made. False if the pointer returns to normal after making a split. The default value is False.

Remarks

The SplitTask method requires user interaction before additional code can be executed.

The SplitTask method is only available in Gantt views.

SpreadCostsToStatusDate Property

True if edits to total actual cost are spread to the status date, or the current date if the status date is "NA". False if they are spread to the calculated stop date of the task. Read/write Boolean.

SpreadPercentCompleteToStatusDate Property

True if edits to total task percent complete are spread to the status date, or the current date if the status date is "NA". False if they are spread to the calculated stop date of the task. Read/write Boolean.

SpreadPercentCompleteToStatusDate Property Example

The following example checks the status date of the active project. If it has never changed from the default, but edits to total task percent complete are spread to the status date, it asks for a status date to use. If edits to total task percent complete are spread to the calculated stop date of the task, it asks the user if they should be spread to a status date instead and, if so, asks for a status date to use.

Sub SpreadPercentComplete()

    Dim NewStatus As Date, AskToSpread As Long

    With ActiveProject

        If .StatusDate = "NA" And .SpreadPercentCompleteToStatusDate Then

            NewStatus = InputBox("Enter a status date for the project: ")

            .StatusDate = NewStatus

            MsgBox "The status date was set to " & .StatusDate & "."

        ElseIf .SpreadPercentCompleteToStatusDate = False Then

            AskToSpread = MsgBox("Should changes to total task percent complete" & _

                " be spread to a status date?", vbYesNo)

            If AskToSpread = vbYes Then

                NewStatus = InputBox("Enter a status date for the project: ")

                .StatusDate = NewStatus

                .SpreadPercentCompleteToStatusDate = True

                MsgBox "The status date was set to " & .StatusDate & "."

            End If

        End If

    End With

    End Sub

StandardRate Property

Returns or sets the standard rate of a resource. Read/write Variant.

Start Property

Returns or sets the start date of an assignment, shift, task portion, or task.  Read-only for summary tasks. Read/write Variant.

StartDate Property

The start date for a period of time that defines a timescale data unit. Read-only Variant.

Startn Property

Returns or sets the value in an additional start field for an assignment, resource, or task. The n placeholder can be a number from 1 to 10. Read/write Variant.

StartOnCurrentDate Property

True if tasks start on the current date. False if tasks start on the project start date. Read/write Boolean.

StartVariance Property

Returns the variance (in minutes) between the baseline start date and the start date of an assignment or task. Read-only Variant.

StartVariance Property Example

The following example displays the number of tasks in the active project that have started late.

Sub CountLateTasks()

    Dim T As Task               ' Task object used in For Each loop

    Dim LateTasks As Integer    ' The number of late tasks

    LateTasks = 0

    ' Look for late tasks in the active project.

    For Each T In ActiveProject.Tasks

        If T.BaselineStart < ActiveProject.CurrentDate And T.StartVariance > 0 Then

            LateTasks = LateTasks + 1

        End If

    Next T

    MsgBox "There are " & LateTasks & " late tasks in this project."

End Sub

StartWeekOn Property

Returns or sets the first day of the week for new projects (Application object) or for the specified project (Project object). Can be one of the following PjWeekday constants: pjSunday, pjMonday, pjTuesday, pjWednesday, pjThursday, pjFriday, or pjSaturday. Read/write Long.

StartYearIn Property

Returns or sets the start of the fiscal year for new projects (Application object) or for the specified project (Project object). Read/write Long.

Can be one of the following PjMonth constants:

pjJanuary
pjJuly

pjFebruary
pjAugust

pjMarch
pjSeptember

pjApril
pjOctober

pjMay
pjNovember

pjJune
pjDecember

StatusDate Property

Returns or sets the current status date for the project. If there is no status date, returns "NA". Read/write Variant.

StatusDate Property Example

The following example checks the status date of the active project. If it has never changed from the default, but edits to total task percent complete are spread to the status date, it asks for a status date to use. If edits to total task percent complete are spread to the calculated stop date of the task, it asks the user if they should be spread to a status date instead and, if so, asks for a status date to use.

Sub SpreadPercentComplete()

    Dim NewStatus As Date, AskToSpread As Long

    With ActiveProject

        If .StatusDate = "NA" And .SpreadPercentCompleteToStatusDate Then

            NewStatus = InputBox("Enter a status date for the project: ")

            .StatusDate = NewStatus

            MsgBox "The status date was set to " & .StatusDate & "."

        ElseIf .SpreadPercentCompleteToStatusDate = False Then

            AskToSpread = MsgBox("Should changes to total task percent complete" & _

                " be spread to a status date?", vbYesNo)

            If AskToSpread = vbYes Then

                NewStatus = InputBox("Enter a status date for the project: ")

                .StatusDate = NewStatus

                .SpreadPercentCompleteToStatusDate = True

                MsgBox "The status date was set to " & .StatusDate & "."

            End If

        End If

    End With

End Sub

Stop Property

Returns or sets the date on which a task stops. Read/write Variant.

SubProject Property

Returns or sets the name of a subproject for the task. Read/write String.

SubProjectReadOnly Property

True if the inserted project is read-only. Read/write Boolean.

Successors Property

Returns or sets a list of the identification numbers of a task's successors. Read/write String.

Remarks

If the successors of the specified task have identification numbers of 2 and 10, and the list separator character is the comma, the Successors property returns "2,10".

SuccessorTasks Property

Returns a Tasks collection representing the tasks that are successors of a task. Read-only.

Summary Property

True if the task is a summary task. Read-only Boolean.

SupportsMultipleDocuments Property

Always True for Microsoft Project and any other application that supports multiple documents (projects). Read-only Boolean.

Remarks

The SupportsMultipleDocuments property is useful with Automation.  For example, suppose you want to open a second document in the application referred to by a variable. If the variable refers to one of several possible applications, you may want to use the SupportsMultipleDocuments property to confirm that the application currently referenced by the variable can have more than one document open at a time.

SupportsMultipleWindows Property

Always True for Microsoft Project and any other application that can have more than one window open at a time. Read-only Boolean.

Remarks

The SupportsMultipleWindows property is useful with Automation.  For example, suppose you want to open a second window in the application referred to by a variable. If the variable refers to one of several possible applications, you may want to use the SupportsMultipleWindows property to confirm that the application currently referenced by the variable can have more than one window open at a time.

SV Property

Returns the SV of an assignment, resource, or task. Read-only Variant.

TableApply Method

Applies a table to the active view.

Syntax

expression.TableApply(Name)
expression

Optional. An expression that returns an Application object.

Name



Required String. The name of the table to apply.

TableApply Method Example

The following example applies the Variance table to the active view.

Sub ApplyVarianceTable()


TableApply "Variance"

End Sub

TableEdit Method

Creates, edits, or copies a table.

Syntax

expression.TableEdit(Name, TaskTable, Create, OverwriteExisting, NewName, FieldName, NewFieldName, Title, Width, Align, ShowInMenu, LockFirstColumn, DateFormat, RowHeight, ColumnPosition, AlignTitle)
expression



Optional. An expression that returns an Application object.

Name





Required String. The name of a table to edit, create, or copy.

TaskTable



Required Boolean. True if the active table contains information about tasks or resources.

Create





Optional Boolean. True if Microsoft Project should create a new table. If NewName is Empty, the new table is given the name specified with Name. Otherwise, the new table is a copy of the table specified with Name and is given the name specified with NewName. The default value is False.

OverwriteExisting
Optional Boolean. True if an existing table should be overwritten with a new one. The default value is False.

NewName




Optional String. A new name for the existing table (Create is False) or new table (Create is True). If NewName is Empty and Create is False, the table specified with Name retains its current name. The default value is Empty.

FieldName



Optional String. The name of a field to change.

NewFieldName


Optional String. The name of a new field.  The field specified with NewFieldName replaces the field specified with FieldName.

Title






Optional String. The title for the field specified with FieldName.

Width





Optional Long. A number that specifies the width of the field specified with FieldName. The default value is 10 for new fields.

Align





Optional Long. A constant that specifies how to align the text in the field specified with FieldName. Can be one of the following PjAlignment constants: pjLeft, pjCenter, or pjRight. The default value is pjRight.

ShowInMenu


Optional Boolean. True if the table name appears in the Tables menu. (The Tables menu appears when you click Table on the View menu.) The default value is False.

LockFirstColumn

Optional Boolean. True if Microsoft Project should lockor prevent changes tothe first column of the table. The default value is False.

DateFormat



Optional Long. A constant that specifies the format for the date fields in the table. The default value is pjDateDefault. Can be one of the following PjDateFormat constants:

 Constant
Date format applied to 9/30/97 (12:33 PM)




pjDateDefault
The default format, as specified on the View tab of the Options dialog box. (To open the Options dialog box, click Options on the Tools menu.)

pjDate_mm_dd_yy_hh_mmAM
9/30/97 12:33 PM

pjDate_mm_dd_yy
9/30/97

pjDate_mm_dd_yyyy
9/30/1997

pjDate_mmmm_dd_yyyy_hh_mmAM
September 30, 1997 12:33 PM

pjDate_mmmm_dd_yyyy
September 30, 1997

pjDate_mmm_dd_hh_mmAM
Sep 30 12:33 PM

pjDate_mmm_dd_yyy
Sep 30, '97

pjDate_mmmm_dd
September 30

pjDate_mmm_dd
Sep 30

pjDate_ddd_mm_dd_yy_hh_mmAM
Tue 9/30/97 12:33 PM

pjDate_ddd_mm_dd_yy
Tue 9/30/97

pjDate_ddd_mmm_dd_yyy
Tue Sep 30, '97

pjDate_ddd_hh_mmAM
Tue 12:33 PM

pjDate_mm_dd
9/30

pjDate_dd
30

pjDate_hh_mmAM
12:33 PM

pjDate_ddd_mmm_dd
Tue Sep 30

pjDate_ddd_mm_dd
Tue 9/30

pjDate_ddd_dd
Tue 30

pjDate_Www_dd
W41/2

pjDate_Www_dd_yy_hh_mmAM
W41/2/97 12:33 PM

RowHeight



Optional Integer. The height of the rows in the table. The default value is 1.

ColumnPosition

Optional Long. The number of the column to edit. (Columns are numbered from the left to right, starting with 0.) If a value for NewFieldName is specified, a new column is inserted in the table. If ColumnPosition is set to 0, the new field is inserted in the first column (LockFirstColumn is False) or the second column (LockFirstColumn is True) of the table. Set ColumnPosition to -1 to specify the last column of the table. The default value is -1.

AlignTitle




Optional Long. A constant that specifies the alignment of the column's title. Can be one of the following PjAlignment constants: pjLeft, pjCenter, or pjRight. The default value is pjCenter.

Remarks

Microsoft Project sets the order of the items in a date format (such as years, months, and days) equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

TableEdit Method Example

The following example creates a new table based on the Task Usage table and adds it to the Table menu. It adds the Priority field as the second column with a title and width of 12, changes the default date format, and then makes the new table the active view.

Sub CreateNewTaskUsageTable()

    TableEdit Name:="Usage", TaskTable:=True, Create:=True, _

        NewName:="Priority Tasks"

    TableEdit Name:="Priority Tasks", TaskTable:=True, _

        NewFieldName:="Priority", Title:="Priority", Width:=12, _

        ShowInMenu:=True, DateFormat:=pjDate_mm_dd_yy, _

        ColumnPosition:=1

    TableApply "Priority Tasks"

End Sub

Tables Method

Displays the More Tables dialog box, which prompts the user to manage tables.

Syntax

expression.Tables
expression



Optional. An expression that returns an Application object.

Remarks

The Tables method has the same effect as the More Tables command on the Table submenu on the View menu.

Task Object, Tasks Collection Object

Represents a task or tasks. The Task object is a member of the Tasks collection.

Using the Task Object

Use Tasks(Index), where Index is the task index number or task name, to return a single Task object. The following example prints the names of every resource assigned to every task in the active project.

Dim Temp As Long, A As Assignment

Dim TaskName As String, Assigned As String, Results As String

For Temp = 1 To ActiveProject.Tasks.Count

    TaskName = "Task: " & ActiveProject.Tasks(Temp).Name & vbCrLf

    For Each A In ActiveProject.Tasks(Temp).Assignments

        Assigned = A.ResourceName & ListSeparator & " " & Assigned

    Next A

    Results = Results & TaskName & "Resources: " & _

        Left$(Assigned, Len(Assigned) - Len(ListSeparator & " ")) & vbCrLf & vbCrLf

    TaskName = ""

    Assigned = ""

Next Temp

MsgBox Results

Using the Tasks Collection

Use the Tasks property to return a Tasks collection. The following example displays the name of every task in the selection.

Dim T As Task, Names As String

For Each T In ActiveSelection.Tasks

    Names = Names & T.Name & vbCrLf

Next T

MsgBox Names

Use the Add method to add a Task object to the Tasks collection. The following example adds a new task to the end of the task list.

ActiveProject.Tasks.Add "Hang clocks"

Task Property

Returns a Task object representing the task in the active cell. Read-only.

Task Property Example

The following example displays the names of all tasks at the same outline level as the selected task.

Sub Siblings()

    Dim MyParent As Task

    Dim Sibling As Task

    Dim Temp As String

    Set MyParent = ActiveCell.Task.OutlineParent

    For Each Sibling In MyParent.OutlineChildren

        Temp = Sibling.Name & ListSeparator & " " & Temp

    Next Sibling

    Temp = Left$(Temp, Len(Temp) - Len(ListSeparator & " "))

    MsgBox Temp

End Sub

TaskFilterList Property

Returns a List object representing all task filters in the active project. Read-only.

TaskFilterList Property Example

The following example lists all the task filters in the active project.

Sub SeeAllFilters()

    Dim Temp As Variant

    Dim TaskFilterNames As String

    For Each Temp In ActiveProject.TaskFilterList
        TaskFilterNames = TaskFilterNames & vbCrLf & Temp

    Next Temp

    MsgBox TaskFilterNames

End Sub

TaskID Property

Returns or sets the identification number of a task in an assignment. Read/write Long.

TaskName Property

Returns or sets the name of a task in an assignment. Read/write String.

Tasks Property

Returns a Tasks collection representing the tasks in the active project or selection. Read-only.

Tasks Property Example

The following example displays the name of every task in the selection.

Sub TaskNames()

    Dim T As Task, Names As String

    For Each T In ActiveSelection.Tasks
        Names = Names & T.Name & vbCrLf

    Next T

End Sub

TaskSummaryName Property

Returns the name of the summary task of the task in an assignment. Read-only String.

TaskTableList Property

Returns a List object representing all task tables in the active project. Read-only.

TaskTableList Property Example

The following example lists all the task tables in the active project.

Sub SeeAllTables()

    Dim Temp As Variant

    Dim TaskTableNames As String

    For Each Temp In ActiveProject.TaskTableList
        TaskTableNames = TaskTableNames & vbCrLf & Temp

    Next Temp

    MsgBox TaskTableNames

End Sub

TaskUniqueID Property

Returns or sets a unique identification number of a task in an assignment. Read/write Long.

TaskViewList Property

Returns a List object representing all task views in the active project. Read-only.

TaskViewList Property Example

The following example lists all the task views in the active project.

Sub SeeAllViews()

    Dim Temp As Variant

    Dim TaskViewNames As String

    For Each Temp In ActiveProject.TaskViewList
        TaskViewNames = TaskViewNames & vbCrLf & Temp

    Next Temp

    MsgBox TaskViewNames

End Sub

TeamMembersCanDeclineTasks Property

True if team members can decline tasks when sent via TeamAssign messages. Read/write Boolean.

TeamStatusPending Property

Assignment object: 
True if a response has not been received for a TeamStatus message. Read/write Boolean.

Resource object: 
True if the resource has not responded to at least one TeamStatus message. Read-only Boolean.

Task object: 

True if a response has not been received for at least one TeamStatus message. Read-only Boolean.

Template Property

Returns the name of the template associated with a project. Read-only String.

Template Property Example

The following example creates a new project based on the template of the active project, if the active project was previously created from a Microsoft Project template file (.mpt).

      Sub CreateNewProject()

          FileOpen ActiveProject.Template & ".mpt"

      End Sub

Text Property

Returns the text of the cell. Read-only String.

Textn Properties

Returns or sets text associated with an assignment, resource, or task. The n placeholder can be a number from 1 to 30. Read/write String.

TextStyles Method

Sets the text styles for tasks and resources in the active view.

Syntax

expression.TextStyles(Item, Font, Size, Bold, Italic, Underline, Color)
expression

Optional. An expression that returns an Application object.

Item




Optional Long. The type of text to change. Can be one of the following PjTextItem constants:

If the Gantt Chart is active:

pjAll
pjGanttMinorTimescale

pjBarTextBottom
pjMarked

pjBarTextInside
pjMilestone

pjBarTextLeft
pjNoncritical

pjBarTextRight
pjProjectSummary

pjBarTextTop
pjSummary

pjCritical
pjTaskFilterHighlight

pjGanttExternalTask
pjTaskRowColumnTitles

pjGanttMajorTimescale


If the Calendar view is active:

pjAll
pjMarked

pjCalendarExternalTask
pjMilestone

pjCalendarMonthlyTitles
pjMonthPreviews

pjCritical
pjNoncritical

pjDailyTitles
pjProjectSummary

pjDateBoxBottomLeft
pjSummary

pjDateBoxBottomRight
pjTaskFilterHighlight

pjDateBoxTopLeft
pjWeeklyTitles

pjDateBoxTopRight


If the Task Usage view is active:

pjAll
pjTaskFilterHighlight

pjCritical
pjTaskMajorTimescale

pjMarked
pjTaskMinorTimescale

pjMilestone
pjTaskRowColumnTitles

pjNoncritical
pjTaskUsageAssignmentRow

pjProjectSummary
pjTaskUsageExternalTask

pjSummary


If the Task Sheet is active:

pjAll
pjProjectSummary

pjCritical
pjSummary

pjMarked
pjTaskSheetExternalTask

pjMilestone
pjTaskFilterHighlight

pjNoncritical
pjTaskRowColumnTitles

If the PERT Chart is active:

pjAll
pjNoncriticalSubproject

pjCriticalMarked
pjNoncriticalSummary

pjCriticalMilestone
pjPERTCritical

pjCriticalSubproject
pjPERTExternalTask

pjCriticalSummary
pjPERTNoncritical

pjNoncriticalMarked
pjPERTNoncriticalExternalTask

pjNoncriticalMilestone


If the Resource Graph is active: pjAll, pjAllocated, pjOverallocated, pjGraphMajorTimescale, pjGraphMinorTimescale, pjTickLabels, or pjLegendLabels.

If the Resource Usage view is active: pjAll, pjAllocated, pjOverallocated, pjResourceFilterHighlight, pjResourceRowColumnTitles, pjResourceMajorTimescale, pjResourceMinorTimescale, or pjResourceUsageAssignmentRow.

If the Resource Sheet is active: pjAll, pjAllocated, pjOverallocated, pjResourceFilterHightlight, or pjResourceRowColumnTitles.

Font




Optional String. The name of the font. The Font argument is ignored if the active view is the PERT Chart and Item is not pjAll.

Size




Optional Integer. The size of the font in points. The Size argument is ignored if the active view is the PERT Chart and Item is not pjAll.

Bold




Optional Boolean. True if the font is bold.

Italic




Optional Boolean. True if the font is italic.

Underline


Optional Boolean. True if the font is underlined.

Color



Optional Long. The color of the font. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Remarks

Using the TextStyles method without specifying any arguments displays the Text Styles dialog box.

ThousandsSeparator Property

Returns the thousands separator character. Read-only String.

Remarks

Microsoft Project sets the ThousandsSeparator property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

TimeLeadingZero Property

True if Microsoft Project displays zeros before times with single-digit hours. Read-only Boolean.

Remarks

Microsoft Project sets the TimeLeadingZero property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Timescale Method

Displays the Timescale dialog box, which prompts the user to set timescale options.

Syntax

expression.Timescale
expression


Optional. An expression that returns an Application object.

Remarks

The Timescale method is only available when the active view is the Gantt Chart, Resource Graph, Resource Usage, or Task Usage view.

The Timescale method has the same effect as the Timescale command on the Format menu.

TimeScaleData Method

Returns timephased information for an assignment, resource, or task.

Syntax

expression.TimeScaleData(StartDate, EndDate, Type, TimeScaleUnit, Count)
expression


Required. An expression that returns an object in the Applies To list.

StartDate



Required Variant. The start date for the timephased data. If the start date falls within an interval, it is "rounded" to the start of the interval. For example, if TimeScaleUnit was pjTimescaleWeeks and StartDate specified a Wednesday, it would be rounded to the preceding Monday (assuming the work week started on a Monday).

EndDate



Required Variant. The end date for the timephased data. If the end date falls within an interval, it is "rounded" to the end of the interval.

Type





Optional Long. The type of timephased data. The default value is pjexpressionTimescaledWork, where expression is Assignment, Resource, or Task.


If expression is an Assignment, can be one of the following PjAssignmentTimescaledData constants:

pjAssignmentTimescaledActualCost
pjAssignmentTimescaledCumulativeWork

pjAssignmentTimescaledActualOvertimeWork
pjAssignmentTimescaledCV

pjAssignmentTimescaledActualWork
pjAssignmentTimescaledOverallocation

pjAssignmentTimescaledACWP
pjAssignmentTimescaledOvertimeWork

pjAssignmentTimescaledBaselineCost
pjAssignmentTimescaledPeakUnits

pjAssignmentTimescaledBaselineWork
pjAssignmentTimescaledPercentAllocation

pjAssignmentTimescaledBCWP
pjAssignmentTimescaledRegularWork

pjAssignmentTimescaledBCWS
pjAssignmentTimescaledSV

pjAssignmentTimescaledCost
pjAssignmentTimescaledWork

pjAssignmentTimescaledCumulativeCost



If expression is a Resource, can be one of the following PjResourceTimescaledData constants:

pjResourceTimescaledActualCost
pjResourceTimescaledCumulativeWork

pjResourceTimescaledActualOvertimeWork
pjResourceTimescaledCV

pjResourceTimescaledActualWork
pjResourceTimescaledOverallocation

pjResourceTimescaledACWP
pjResourceTimescaledOvertimeWork

pjResourceTimescaledBaselineCost
pjResourceTimescaledPeakUnits

pjResourceTimescaledBaselineWork
pjResourceTimescaledPercentAllocation

pjResourceTimescaledBCWP
pjResourceTimescaledRegularWork

pjResourceTimescaledBCWS
pjResourceTimescaledRemainingAvailability

pjResourceTimescaledCost
pjResourceTimescaledSV

pjResourceTimescaledCumulativeCost
pjResourceTimescaledWork


If expression is a Task, can be one of the following PjTaskTimescaledData constants:

pjTaskTimescaledActualCost
pjTaskTimescaledCumulativePercentComplete

pjTaskTimescaledActualOvertimeWork
pjTaskTimescaledCumulativeWork

pjTaskTimescaledActualWork
pjTaskTimescaledCV

pjTaskTimescaledACWP
pjTaskTimescaledFixedCost

pjTaskTimescaledBaselineCost
pjTaskTimescaledOverallocation

pjTaskTimescaledBaselineWork
pjTaskTimescaledOvertimeWork

pjTaskTimescaledBCWP
pjTaskTimescaledPercentComplete

pjTaskTimescaledBCWS
pjTaskTimescaledRegularWork

pjTaskTimescaledCost
pjTaskTimescaledSV

pjTaskTimescaledCumulativeCost
pjTaskTimescaledWork

TimeScaleUnit

Optional Long. Can be one of the following PjTimescaleUnit constants: pjTimescaleYears, pjTimescaleQuarters, pjTimescaleMonths, pjTimescaleWeeks, pjTimescaleDays, pjTimescaleHours, pjTimescaleMinutes. The default value is pjTimescaleWeeks.

Count




Optional Long. The number of timescale units to group together. The default value is 1.

TimeScaleData Method Example

The following example displays the number of hours of work per day for a resource during the first full week in October. It assumes a resource view is the active view.

Sub WorkHoursPerDay()

    Dim TSV As TimeScaleValues, HowMany As Long

    Dim HoursPerDay As String

    Set TSV = ActiveCell.Resource.TimeScaleData("10/6/97", "10/10/97", _

        TimescaleUnit:=pjTimescaleDays)

    For HowMany = 1 To TSV.Count

        If TSV(HowMany).Value = "" Then

            HoursPerDay = HoursPerDay & TSV(HowMany).StartDate & " - " & _

                TSV(HowMany).EndDate & ": 0 hours" & vbCrLf

        Else

            HoursPerDay = HoursPerDay & TSV(HowMany).StartDate & " - " & _

                TSV(HowMany).EndDate & ": " & TSV(HowMany).Value / 60 & _

                    " hours" & vbCrLf

        End If

    Next HowMany

    MsgBox HoursPerDay

End Sub

TimescaleEdit Method

Formats timescales for the Gantt Chart, Resource Graph, Task Usage, and Resource Usage views.

Syntax

expression.TimescaleEdit(MajorUnits, MinorUnits, MajorLabel, MinorLabel, MajorAlign, MinorAlign, MajorCount, MinorCount, MajorTicks, MinorTicks, Enlarge, Separator)
expression


Optional. An expression that returns an Application object.

MajorUnits


Optional Long. The major units for the timescale. Can be one of the following PjTimescaleUnit constants: pjTimescaleYears, pjTimescaleHalfYears, pjTimescaleQuarters, pjTimescaleMonths, pjTimscaleThirdsOfMonths, pjTimescaleWeeks, pjTimescaleDays, pjTimescaleHours, or pjTimescaleMinutes.

MinorUnits


Optional Long. The minor units for the timescale. Can be one of the PjTimescaleUnit constants.

MajorLabel


Optional Long. The major label for the timescale. Can be one of the following PjDateLabel constants:

If MajorUnits is pjTimescaleYears:

Constant
Example of date format




pjYear_yyyy
1997, 1998

pjYear_yyy
'97, '98

pjYear_yy
97, 98

pjYearFromEnd_yy
3, 2, 1 (year from the finish date of the project)

pjYearFromEnd_Yyy
Y3, Y2, Y1 (year from the finish date of the project)

pjYearFromEnd_Year_yy
Year 2, Year 1 (year from the finish date of the project)

pjYearFromStart_yy
1, 2, 3 (year from the start date of the project)

pjYearFromStart_Yyy
Y1, Y2, Y3 (year from the start date of the project)

pjYearFromStart_Year_yy
Year 1, Year 2 (year from the start date of the project)

If MajorUnits is pjTimescaleHalfYears:

Constant
Example of date format




pjHalfYear_h
1, 2

pjHalfYear_Hh
H1, H2

pjHalfYear_Hh_yyy
H1, '97, H2 '97

pjHalfYear_hhh_Half
1st Half, 2nd Half

pjHalfYear_hHyy
1H97, 2H97

pjHalfYear_Hlf_h
Half 1, Half 2

pjHalfYear_Hlf_h_yyyy
Half 1, 1997; Half 2, 1997

pjHalfYearFromEnd_h
2, 1 (half year from the finish date of the project)

pjHalfYearFromEnd_Half_h
Half 2, Half 1 (half year from the finish date of the project)

pjHalfYearFromEnd_Hh
H2, H1 (half year from the finish date of the project)

pjHalfYearFromStart_h
1, 2 (half year from the start date of the project)

pjHalfYearFromStart_Half_h
Half 1, Half2 (half year from the start date of the project)

pjHalfYearFromStart_Hh
H1, H2 (half year from the start date of the project)

If MajorUnits is pjTimescaleQuarters:

Constant
Example of date format




pjQuarter_q
1, 2

pjQuarter_qQyy
1Q97, 2Q97

pjQuarter_qqq_Quarter
1st Quarter, 2nd Quarter

pjQuarter_Qq
Q1, Q2

pjQuarter_Qq_yyy
Q1 '97, Q2 '97

pjQuarter_Qtr_q
Qtr 1, Qtr 2

pjQuarter_Qtr_q_yyyy
Qtr 1, 1997; Qtr 2, 1997

pjQuarterFromEnd_q
3, 2, 1 (quarter from the finish date of the project)

pjQuarterFromEnd_Qq
Q3, Q2, Q1 (quarter from the finish date of the project)

pjQuarterFromEnd_Quarter_q
Quarter 2, Quarter 1 (quarter from the finish date of the project)

pjQuarterFromStart_q
1, 2, 3 (quarter from the start date of the project)

pjQuarterFromStart_Qq
Q1, Q2, Q3 (quarter from the start date of the project)

pjQuarterFromStart_Quarter_q
Quarter 1, Quarter 2 (quarter from the start date of the project)

If MajorUnits is pjTimescaleMonths:

Constant
Example of date format




pjMonth_mm
9, 10

pjMonth_mm_yy
9/97, 10/97

pjMonth_mm_yyy
9 '97, 10 '97

pjMonth_m
S, O

pjMonth_mmm
Sep, Oct

pjMonth_mmm_yyy
Sep '97, Oct '97

pjMonth_mmmm
September, October

pjMonth_mmmm_yyyy
September 1997, October 1997

pjMonthFromEnd_mm
5, 4 (months from the finish date of project)

pjMonthFromEnd_Mmm
M5, M4 (months from the finish date of project)

pjMonthFromEnd_Month_mm
Month5, Month4 (months from the finish date of project)

pjMonthFromStart_mm
1, 2 (months from the start date of project)

pjMonthFromStart_Mmm
M1, M2 (months from the start date of project)

pjMonthFromStart_Month_mm
Month1, Month2 (months from the start date of project)

If MajorUnits is pjTimescaleThirdsOfMonths:

 Constant
Example of date format




pjThirdsOfMonths_dd
1, 11, 21

pjThirdsOfMonths_ddd
B, M, E

pjThirdsOfMonths_dddd
Beginning, Middle, End

pjThirdsOfMonths_mm_dd
9/1, 9/11, 9/21

pjThirdsOfMonths_mm_dd_yy
9/1/97, 9/11/97, 9/21/97

pjThirdsOfMonths_mm_ddd_yy
9/B/97, 9/M/97, 9/E/97

pjThirdsOfMonths_mm_ddd
9/B, 9/M, 9/E

pjThirdsOfMonths_mmm_dd
Sep 1, Sep 11, Sep 21

pjThirdsOfMonths_mmm_dd_yy
Sep 1, '97; Sep 11, '97; Sep 21 '97

pjThirdsOfMonths_mmm_ddd
Sep B, Sep M, Sep E

pjThirdsOfMonths_mmm_ddd_yy
Sep B, '97; Sep M, '97; Sep E, '97

pjThirdsOfMonths_mmmm_dd
September 1, September 11, September 21

pjThirdsOfMonths_mmmm_dd_yyyy
September 1, 1997; September 11, 1997; September 21, 1997

pjThirdsOfMonths_mmmm_dddd_yyyy
September Beginning 1997, September Middle 1997, September End 1997

pjThirdsOfMonths_mmmm_dddd
September Beginning, September Middle, September End

If MajorUnits is pjTimescaleWeeks:

Constant
Example of date format




pjWeek_mm_dd
9/30, 10/1

pjWeek_mm_dd_yy
9/30/97, 10/1/97

pjWeek_m_dd
S 30, O 1

pjWeek_mmm_dd
Sep 30, Oct 1

pjWeek_mmm_dd_yyy
Sep 30, '97; Oct 1 '97

pjWeek_mmmm_dd
September 30, October 1

pjWeek_mmmm_dd_yyyy
September 30, 1997; October 1, 1997

pjWeek_di_mm_dd
T 9/30, W 10/1

pjWeek_di_m_dd
T S 30, W O 1

pjWeek_di_mmm_dd
T Sep 30, W Oct 1

pjWeek_ddi_mm_dd
Mo 1/31, Mo 2/7

pjWeek_ddi_m_dd
Tu 9/30, We 10/1

pjWeek_ddi_mmm_dd
Tu Sep 30, We Oct 1

pjWeek_ddd_mm_dd
Tue 9/30, Wed 10/1

pjWeek_ddd_mm_dd_yy
Tue 9/30/97, Wed 10/1/97

pjWeek_ddd_dd
Tue 30, Wed 1

pjWeek_ddd_ww
Tue 41, Wed 41 (number of week in year)

pjWeek_ddd_m_dd
Tue S 30, Wed O 1

pjWeek_ddd_mmm_dd
Tue Sep 30, Wed Oct 1

pjWeek_ddd_mmm_dd_yyy
Tue Sep 30, '97; Wed Oct 1, '97

pjWeek_ddd_mmmm_dd
Tue September 30, Wed October 1

pjWeek_ddd_mmmm_dd_yyy
Tue September 30, '97; Wed October 1, '97

pjWeekDayOfMonth_dd
30, 1 (number of day in month)

pjWeekFromEnd_Week_ww
Week 4, Week 3 (weeks from the end date of the project)

pjWeekFromEnd_ww
4, 3 (weeks from the end date of the project)

pjWeekFromEnd_Www
W4, W3 (weeks from the end date of the project)

pjWeekFromStart_Week_ww
Week 1, Week 2 (weeks from the start date of the project)

pjWeekFromStart_ww
1, 2 (weeks from the start date of the project)

pjWeekFromStart_Www
W1, W2 (weeks from the start date of the project)

pjWeekNumber_dd_ww
3 41, 4 41 (number of day in week and number of week in year)

pjWeekNumber_ww
41, 41 (number of week in year)

If MajorUnits is pjTimescaleDays:

Constant
Example of date format




pjDay_mm_dd
9/30, 10/1

pjDay_mm_dd_yy
9/30/97, 10/1/97

pjDay_m_dd
S 30, O 1

pjDay_mmm_dd
Sep 30, Oct 1

pjDay_mmm_dd_yyy
Sep 30, '97; Oct 1, '97

pjDay_di
T, W

pjDay_di_mm_dd
T 9/30, W 10/1

pjDay_di_dd
T 30, W 1

pjDay_di_m_dd
T S 30, W O 1

pjDay_didd
T30, W1

pjDay_ddi
Tu, We

pjDay_ddi_mm_dd
Tu 9/30, We 10/1

pjDay_ddi_dd
Tu 30, We 1

pjDay_ddi_m_dd
Tu S 30, We O 1

pjDay_ddd
Tue, Wed

pjDay_ddd_mm_dd
Tue 9/30, Wed 2/1

pjDay_ddd_mm_dd_yy
Tue 9/30/97; Wed 10/1/97

pjDay_ddd_dd
Tue 30, Wed 1

pjDay_ddd_m_dd
Tue S 30, Wed O 1

pjDay_ddd_mmm_dd
Tue Sep 30, Wed Oct 1

pjDay_ddd_mmm_dd_yyy
Tue Sep 30, '97; Wed Oct 1, '97

pjDay_ddd_mmmm_dd
Tue September 30, Wed October 1

pjDay_dddd
Tuesday, Wednesday

pjDayFromEnd_dd
4, 3 (the day from the finish date of the project)

pjDayFromEnd_Ddd
D4, D3 (the day from the finish date of the project)

pjDayFromEnd_Day_dd
Day 4, Day 3 (the day from the finish date of the project)

pjDayFromStart_dd
1, 2 (the day from the start date of the project)

pjDayFromStart_Ddd
D1, D2 (the day from the start date of the project)

pjDayFromStart_Day_dd
Day 1, Day 2 (the day from the start date of the project)

pjDayOfMonth_dd
30, 1 (the day of the month)

pjDayOfYear_dd
273, 274 (the day of the year)

pjDayOfYear_dd_yyyy
273 1997, 274 1997 (the day of the year followed by the year)

pjDayOfYear_dd_yyy
273 '97, 274 '97 (the day of the year followed by the year)

If MajorUnits is pjTimescaleHours:

 Constant
Example of date and time format




pjHour_mm_dd_hhAM
9/30 11 AM, 10/1 12 PM

pjHour_hh
11, 12

pjHour_hh_mmAM
11:00 AM, 12:00 PM

pjHour_hhAM
11 AM, 12 PM

pjHour_mmm_dd_hhAM
Sep 30, 11 AM; Oct 1, 12 PM

pjHour_ddd_mmm_dd_hhAM
Tue Sep 30, 11 AM; Wed Oct 1, 12 PM

pjHourFromEnd_hh
3, 2, 1 (hour from the finish date of the project)

pjHourFromEnd_Hhh
H3, H2, H1 (hour from the finish date of the project)

pjHourFromEnd_Hour_hh
Hour 2, Hour 1 (hour from the finish date of the project)

pjHourFromStart_hh
1, 2, 3 (hour from the start date of the project)

pjHourFromStart_Hhh
H1, H2, H3 (hour from the start date of the project)

pjHourFromStart_Hour_hh
Hour 1, Hour 2 (hour from the start date of the project)

If MajorUnits is pjTimescaleMinutes:

Constant
Example of time format




pjMinute_hh_mmAM
11:45 AM, 11:46 AM

pjMinute_mm
45, 46

pjMinuteFromEnd_mm
3, 2, 1 (minute from the finish date of the project)

pjMinuteFromEnd_Mmm
M3, M2, M1 (minute from the finish date of the project)

pjMinuteFromEnd_Minute_mm
Minute 2, Minute 1 (minute from the finish date of the project)

pjMinuteFromStart_mm
1, 2, 3 (minute from the start date of the project)

pjMinuteFromStart_Mmm
M1, M2, M3 (minute from the start date of the project)

pjMinuteFromStart_Minute_mm
Minute 1, Minute 2 (minute from the start date of the project)

MinorLabel


Optional Long. The minor label for the timescale. Can be one of the PjDateLabel constants. The MinorLabel argument is influenced by the value of MinorUnits in the same manner as MajorLabel is influenced by MajorUnits.

MajorAlign


Optional Long. The alignment of major units on the timescale. Can be one of the following PjAlignment constants: pjLeft, pjCenter, or pjRight.

MinorAlign


Optional Long. The alignment of minor units on the timescale. Can be one of the PjAlignment constants.

MajorCount


Optional Integer. The number of major timescale units to appear together.

MinorCount


Optional Integer. The number of minor timescale units to appear together.

MajorTicks


Optional Boolean. True if Microsoft Project displays ticks between the major timescale units.

MinorTicks


Optional Boolean. True if Microsoft Project displays ticks between the minor timescale units.

Enlarge



Optional Integer. A number from 25 to 1000 that specifies the scaling factor for the timescale.

Separator



Optional Boolean. True if Microsoft Project draws a line between the major and minor timescales.

Remarks

The TimescaleEdit method is only available when the active view is the Gantt Chart, Resource Graph, Resource Usage, or Task Usage view.

Using the TimescaleEdit method without specifying any arguments displays the Timescale dialog box with the Timescale tab selected.

TimescaleNonWorking Method

Sets the format of nonworking times.

Syntax

expression.TimescaleNonWorking(Draw, Calendar, Color, Pattern)
expression


Optional. An expression that returns an Application object.

Draw




Optional Long. How nonworking times are denoted in relation to Gantt bars. Can be one of the following PjNonWorkingPlacement constants: pjBehind, pjInFront, or pjDoNotDraw.
Calendar



Optional String. The name of the calendar to format.

Color




Optional Long. The color of nonworking times. Can be one of the following PjColor constants:

pjAqua
pjNavy

pjBlack
pjOlive

pjBlue
pjPurple

pjFuschia
pjRed

pjGray
pjSilver

pjGreen
pjTeal

pjLime
pjYellow

pjMaroon
pjWhite

Pattern




Optional Long. The pattern for nonworking times. Can be one of the following PjFillPattern constants:

pjDarkFillPattern
pjLineCrossPattern

pjDiagonalCrossPattern
pjLineHorizontalPattern

pjDiagonalLeftPattern
pjLineVerticalPattern

pjDiagonalRightPattern
pjMediumFillPattern

pjHollowPattern
pjSolidFillPattern

pjLightFillPattern


Remarks

Using the TimescaleNonWorking method without specifying any arguments displays the Timescale dialog box with the Nonworking Time tab selected.

TimeScaleValue Object, TimeScaleValues Collection Object

Represents a timescaled data item. The TimeScaleValue object is a member of the TimeScaleValues collection.

Using the TimeScaleValue Object

Use TimeScaleValues(Index), where Index is the timescaled data index number, to return a single TimeScaleValue object. The following example displays the number of hours of work per day for a resource during the first full week in October.

Dim TSV As TimeScaleValues, HowMany As Long

Dim HoursPerDay As String

Set TSV = ActiveCell.Resource.TimeScaleData("10/6/97", "10/10/97", TimescaleUnit:=pjTimescaleDays)

For HowMany = 1 To TSV.Count

    HoursPerDay = HoursPerDay & TSV(HowMany).StartDate & " - " & _

        TSV(HowMany).EndDate & ", " & TSV(HowMany) / 60 & vbCrLf

Next HowMany

MsgBox HoursPerDay

Using the TimeScaleValues Collection

Use the TimeScaleData method to return a TimeScaleValues collection. The following example returns a TimeScaleValues collection for the amount of work done by the resource in the active cell between the specified dates, split into week-long portions.

ActiveCell.Resource.TimeScaleData("10/1/97", "10/31/97")

Use the Add method to add a TimeScaleValue object to the TimeScaleValues collection. The following example adds 8 hours of work to Tuesday of that week.

Dim TSV As TimeScaleValues

Set TSV = ActiveCell.Resource.TimeScaleData("10/6/97", "10/10/97", TimescaleUnit:=pjTimescaleDays)

TSV.Add 480, 2

TimeSeparator Property

Returns the time separator character. Read-only String.

Remarks

Microsoft Project sets the TimeSeparator property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

TipOfTheDay Method

Displays the Tip of the Day.

Syntax

expression.TipOfTheDay
expression

Optional. An expression that returns an Application object.

ToggleAssignments Method

Shows or hides assignments in usage views.

Syntax

expression.ToggleAssignments
expression

Optional. An expression that returns an Application object.

Top Property

Returns or sets the distance of the main window from the top edge of the screen (Application object) or the distance of a project window from the top edge of the main window (Window object) in points. Read/write Long.

Remarks

The position of the window is measured from the top of the main screen, not from the bottom of the menu bar.

TopPane Property

Returns a Pane object representing the top pane of a window. Read-only.

TotalSlack Property

Returns the total slack for a task in minutes. Read-only Variant.

TrackOvertimeWork Property

True if TeamStatus messages prompt for overtime work. Read/write Boolean.

TwelveHourTimeFormat Property

True if Microsoft Project returns the time in a 12-hour format. False if the time is returned in a 24-hour format. Read-only Boolean.

Remarks

Microsoft Project sets the TwelveHourTimeFormat property equal to the corresponding value in the Regional Settings icon of the Microsoft Windows Control Panel.

Type Property

Returns or sets how the units, duration, and work on a task are calculated. Can be one of the following PjTaskFixedType constants: pjFixedUnits, pjFixedDuration, or pjFixedWork. Read/write Long.

UnderlineHyperlinks Property

True if hyperlinks are underlined. Read/write Boolean.

UniqueID Property

Assignment, Project, Resource, or Task object: Returns the unique identification number of an assignment, project, resource, or task (Syntax 1). Read-only Long.

Assignments, Resources, or Tasks collection: Returns an Assignment, Resource, or Task object from its containing collection (Syntax 2).

Syntax 1

expression.UniqueID
expression

Required. An expression that returns an Assignment, Project, Resource, or Task object.

Syntax 2

expression.UniqueID(Index)

expression

Required. An expression that returns an Assignments, Resources, or Tasks collection.

Index



Required Long. The position of the object within its containing collection.

UniqueIDPredecessors Property

Returns or sets the unique identification numbers of the predecessors of a task, separated by the list separator. Read/write String.

UniqueIDSuccessors Property

Returns or sets the unique identification numbers of the successors of a task, separated by the list separator. Read/write String.

Units Property

Returns or sets the number of resource units. Read-write Double.

UnlinkPredecessors Method

Removes predecessors from a task.

Syntax

expression.UnlinkPredecessors(Tasks)
expression

Required. An expression that returns a Task object.

Tasks



Required Object. The predecessor Task or Tasks specified with Tasks are removed from the task specified with expression.

UnlinkSuccessors Method

Removes successors from a task.

Syntax

expression.UnlinkSuccessors(Tasks)
expression

Required. An expression that returns a Task object.

Tasks



Required Object. The successor Task or Tasks specified with Tasks are removed from the task specified with expression.

UnlinkSuccessors Method Example

The following example removes the specified successor from every task in the active project.

Sub RemoveSuccessor()

    Dim Entry As String     ' Successor specified by user

    Dim SuccTask As Task    ' Successor task object

    Dim T As Task           ' Task object used in For Each loop

    Dim S As Task           ' Successor (task object) used in loop

    Entry = InputBox$("Enter the name of a successor to unlink from every task in this project.")

    Set SuccTask = Nothing

    ' Look for the name of the successor in tasks of the active project.

    For Each T In ActiveProject.Tasks

        If T.Name = Entry Then

            Set SuccTask = T

            Exit For

        End If

    Next T

    ' Remove the successor from every task in the active project.

    If Not (SuccTask Is Nothing) Then

        For Each T In ActiveProject.Tasks

            For Each S In T.SuccessorTasks

                If S.Name = Entry Then

                    T.UnlinkSuccessors SuccTask

                    Exit For

                End If

            Next S

        Next T

    End If

End Sub

UnlinkTasks Method

Unlinks the selected tasks.

Syntax

expression.UnlinkTasks
expression

Optional. An expression that returns an Application object.

UpdateNeeded Property

Assignment object: True if the resource assigned to a task needs to be updated as to the status of the task. Read-only Boolean.

Resource object: True if at least one task the resource is assigned to has updates that the resource needs to receive. Read-only Boolean.

Task object: True if at least one resource assigned to the task needs to be updated as to the status of the task. Read-only Boolean.

UpdateProject Method

Records progress on specified tasks.

Syntax

expression.UpdateProject(All, UpdateDate, Action)
expression

Optional. An expression that returns an Application object.

All




Optional Boolean. True if all tasks in the active project are updated. False if only the selected tasks are updated. The default value is True.

UpdateDate

Optional Variant. The date used to indicate progress.

Action



Optional Long. The action to take with the specified tasks. Can be one of the following PjProjectUpdate constants:

Constant
Description

 


pj0Or100Percent
Sets the Actual Start and Actual Finish dates only.

pj0To100Percent
Sets the percent complete to reflect the update date.

pjReschedule
Schedules the remainder of the work to start on the update date.

UpdateTasks Method

Updates the active tasks.

Syntax

expression.UpdateTasks(PercentComplete, ActualDuration, RemainingDuration, ActualStart, ActualFinish, Notes)
expression




Optional. An expression that returns an Application object.

PercentComplete


Optional Variant. The percent complete of the active tasks.

ActualDuration



Optional Variant. The actual duration of the active tasks.

RemainingDuration

Optional Variant. The remaining duration of the active tasks.

ActualStart




Optional Variant. The actual start date of the active tasks.

ActualFinish



Optional Variant. The actual finish date of the active tasks.

Notes






Optional String. Any comments for the active tasks.

Remarks

Using the UpdateTasks method without specifying any arguments displays the Update Tasks dialog box.

UsableHeight Property

Returns the maximum height available for a project window in points. Read-only Long.

Remarks

The UsableHeight property equals the total amount of vertical space inside the main window minus the space taken up by toolbars, menu bars, status bars, scroll bars, and the title bar.

UsableHeight Property Example

The following example moves the windows of every open project inside the main window.

Sub FitWindows()

    Dim W As Window   ' The Window object used in For Each loop

    For Each W In Application.Windows

        ' Adjust the height of each window, if necessary.

        If W.Height > UsableHeight Then

            W.Height = UsableHeight
            W.Top = 0

        ' Adjust the vertical position of each window, if necessary.

        ElseIf W.Top + W.Height > UsableHeight Then

            W.Top = UsableHeight - W.Height

        End If

        ' Adjust the width of each window, if necessary.

        If W.Width > UsableWidth Then

            W.Width = UsableWidth

            W.Left = 0

        ' Adjust the horizontal position of each window, if necessary.

        ElseIf W.Left + W.Width > UsableWidth Then

            W.Left = UsableWidth - W.Width

        End If

    Next W

End Sub

UsableWidth Property

Returns the maximum width available for a project window in points. Read-only Long.

Remarks

The UsableWidth property equals the total amount of horizontal space inside the main window minus the space taken up by toolbars and scroll bars.

UseFYStartYear Property

True if a fiscal year is determined by the year of the first month of that fiscal year. False if determined by the last month of the fiscal year. Read/write Boolean.

UserControl Property

True if the application was started, or the project was opened or created, by the user. Read-only Boolean.

UserName Property

Returns or sets the name of the current user. Read/write String.

Remarks

Use the UserName property to customize Microsoft Project options or macros for a particular user.

Suppose you have written a macro called PrintReport that prints the report Mine.mpp when you press ctrl+r, but another user wants to use the same shortcut keys to print the report Yours.mpp. You can edit the PrintReport macro so it checks the UserName property and then prints Mine.mpp if you are the current user or prints Yours.mpp if you are not.

By default, the UserName property equals the Author property.

UserName Property Example

The following example sets preferences in Microsoft Project according to the name of the current user.

Sub GetUserName()


' Prompt user for his or her name.


UserName = InputBox$("What's your name?", , UserName)


' If user is Tamara, then set certain preferences.


If UserName = "Tamara" Then



DisplayScheduleMessages = False



BarRounding On:=False



Calculation = True


' If user is not Tamara, then set default preferences.


Else



DisplayScheduleMessages = True



BarRounding On:=True



Calculation = False


End If

End Sub

Value Property

Returns or sets the value of a timephased data item. Work values are returned or set in minutes. Read/write Double.

VBE Property

Returns a VBE object that represents the Visual Basic Editor. Read-only.

VBProject Property

Returns a VBProject object that represents the Visual Basic project in the specified project. Read-only.

Version Property

Returns the version number of Microsoft Project. Read-only String.

Remarks

The Version property returns "8.0" for Microsoft Project 98.

ViewApply Method

Sets the view in the active window.

Syntax

expression.ViewApply(Name, SinglePane, Toggle)
expression

Optional. An expression that returns an Application object.

Name



Required String. The name of the view to display in the active window.

SinglePane

Optional Boolean. True if any existing split is removed and the active window displays a single-pane view. The default value is False.

Toggle



Optional Boolean. True if the active window switches from one pane to two panes, or from two panes to one pane. Toggle is ignored if SinglePane is True. The default value is False.

ViewApply Method Example

The following example sets the active window to a single-pane view of the Resource Sheet. It assumes that the active view is a combination of the Gantt Chart and the Task Form.

Sub ChangeWindowToResourceSheet()


ViewApply Name:="Resource Sheet", SinglePane:=True

End Sub

ViewBar Method

Shows or hides the View Bar.

Syntax

expression.ViewBar
expression

Optional. An expression that returns an Application object.

ViewEditCombination Method

Creates, edits, or copies a combination view.

Syntax

expression.ViewEditCombination(Name, Create, NewName, TopView, BottomView, ShowInMenu)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of a two-pane view to edit, create, or copy. The default is the name of the active view.

Create



Optional Boolean. True if Microsoft Project should create a new two-pane view. If NewName is Empty, the new view is given the name specified with Name. Otherwise, the new view is a copy of the view specified with Name and is given the name specified with NewName. The default value is False.

NewName


Optional String. A new name for the view specified with Name (Create is False) or a name for the new view just created (Create is True). If NewName is Empty and Create is False, the view specified with Name retains its current name. The default value is False.

TopView


Optional String. The name of the view to display in the upper pane. The view specified by Name will display in the lower pane.

BottomView

Optional String. The name of the view to display in the lower pane. The view specified by Name will display in the upper pane.

ShowInMenu
Optional Boolean. True if the view name appears on the View menu. The default value is False.

ViewEditCombination Method Example

The following example creates a new combination view with the Resource Sheet in the upper pane and the Resource Graph in the lower pane.

Sub CheckResourcesView()

    ViewEditCombination Name:="Check Resources View", Create:=True, _

        TopView:="Resource Sheet", BottomView:="Resource Graph"

End Sub

ViewEditSingle Method

Creates, edits, or copies a single-pane view.

Syntax

expression.ViewEditSingle(Name, Create, NewName, Screen, ShowInMenu, HighlightFilter, Table, Filter)
expression


Optional. An expression that returns an Application object.

Name




Optional String. The name of a single-pane view to edit, create, or copy. The default is the name of the active view.

Create




Optional Boolean. True if Microsoft Project should create a new single-pane view. If NewName is Empty, the new view is given the name specified with Name. Otherwise, the new view is a copy of the view specified with Name and is given the name specified with NewName. The default value is False.

NewName



Optional String. A new name for the view specified with Name (Create is False) or a name for the new view just created (Create is True). If NewName is Empty and Create is False, the view specified with Name retains its current name. The default value is False.

Screen




Optional Long. A constant specifying the view to display. The default value is pjGantt. Can be one of the following PjScreen constants:

pjCalendar
pjResourceUsage

pjGantt
pjTaskDetailsForm

pjPERT
pjTaskForm

pjResourceForm
pjTaskNameForm

pjResourceGraph
pjTaskPERT

pjResourceNameForm
pjTaskSheet

pjResourceSheet


ShowInMenu

Optional Boolean. True if the view name appears on the View menu. The default value is False.

HighlightFilter

Optional Boolean. True if Microsoft Project should highlight filtered items. The default value is False.

Table




Optional String. The name of a table to display in the view. Required for a new view.

Filter




Optional String. The name of a filter to apply to the view. Required for a new view.

ViewEditSingle Method Example

The following example creates a new view for tasks currently in progress.

Sub DisplayMyTasks()

    ViewEditSingle Name:="My Tasks", Create:=True, _

        Screen:=pjGantt, Filter:="In Progress Tasks", _

        Table:="Schedule"

End Sub

ViewList Property

Returns a List object representing all views in the active project. Read-only.

ViewList Property Example

The following example lists all the views in the active project.

Sub SeeAllViews()

    Dim Temp As Variant

    Dim ViewNames As String

    For Each Temp In ActiveProject.ViewList
        ViewNames = ViewNames & vbCrLf & Temp

    Next Temp

    MsgBox ViewNames

End Sub

Views Method

Displays the More Views dialog box, which prompts the user to manage views.

Syntax

expression.Views
expression


Optional. An expression that returns an Application object.

Remarks

The Views method has the same effect as the More Views command on the View menu.

ViewShowAvailability Method

Displays availability information in the active Resource Graph view.

Syntax

expression.ViewShowAvailability
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowAvailability method has no effect unless the active window contains the Resource Graph view.

ViewShowCost Method

Displays cost information in the active view.

Syntax

expression.ViewShowCost
expression


Optional. An expression that returns an Application object.

ViewShowCumulativeCost Method

Displays cumulative cost information in the active Resource Graph view.

Syntax

expression.ViewShowCumulativeCost
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowCumulativeCost method has no effect unless the active window contains the Resource Graph view.

ViewShowCumulativeWork Method

Displays cumulative work information in the active Resource Graph view.

Syntax

expression.ViewShowCumulativeWork
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowCumulativeWork method has no effect unless the active window contains the Resource Graph view.

ViewShowNotes Method

Displays note information in the active view.

Syntax

expression.ViewShowNotes
expression


Optional. An expression that returns an Application object.

ViewShowObjects Method

Displays object information in the active view.

Syntax

expression.ViewShowObjects
expression


Optional. An expression that returns an Application object.

ViewShowOverallocation Method

Displays overallocation information in the active Resource Graph view.

Syntax

expression.ViewShowOverallocation
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowOverallocation method has no effect unless the active window contains the Resource Graph view.

ViewShowPeakUnits Method

Displays peak units information in the active Resource Graph view.

Syntax

expression.ViewShowPeakUnits
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowPeakUnits method has no effect unless the active window contains the Resource Graph view.

ViewShowPercentAllocation Method

Displays percent allocation information in the active Resource Graph view.

Syntax

expression.ViewShowPercentAllocation
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowPercentAllocation method has no effect unless the active window contains the Resource Graph view.

ViewShowPredecessorsSuccessors Method

Displays predecessors and successors information in the active view.

Syntax

expression.ViewShowPredecessorsSuccessors
expression


Optional. An expression that returns an Application object.

ViewShowResourcesPredecessors Method

Displays resources and predecessors information in the active Task Form view.

Syntax

expression.ViewShowResourcesPredecessors
expression


Optional. An expression that returns an Application object.

ViewShowResourcesSuccessors Method

Displays resources and successors information in the active Task Form view.

Syntax

expression.ViewShowResourcesSuccessors
expression


Optional. An expression that returns an Application object.

ViewShowSchedule Method

Displays the schedule fields in a resource or task form. The ViewShowSchedule method has no effect unless the active view contains a resource or task form.

Syntax

expression.ViewShowSchedule
expression


Optional. An expression that returns an Application object.

ViewShowWork Method

Displays work information in the active pane.

Syntax

expression.ViewShowWork
expression


Optional. An expression that returns an Application object.

Remarks

The ViewShowWork method has no effect unless the active window contains one of the following views: Resource Graph, Resource Form, Resource Name Form, Task Details Form, or Task Name Form.

Visible Property

True if the object is visible. Read/write Boolean.

Remarks

The Application object's Visible property can only be set to False if the Application object's UserControl property is False and there are no visible projects.

If the Application object's UserControl property is True, the Window object's Visible property is also True.

WBS Property

Returns or sets the WBS code of a task. Read/write String.

WebAddToFavorites Method

Adds a link to the current document or selection to the Favorites folder. This method is unavailable if the file has never been saved.

Syntax

expression.WebAddToFavorites(CurrentLink)
expression


Optional. An expression that returns an Application object.

CurrentLink


Optional Boolean. True if a link will be added to the current selection. False if a link will be added to the current document. The default value is False.

WebCopyHyperlink Method

Copies the current hyperlink to the Clipboard. This method is unavailable if the selected item does not contain a hyperlink.

Syntax

expression.WebCopyHyperlink
expression


Optional. An expression that returns an Application object.

WebGoBack Method

Goes to the previous document in the history list.

Syntax

expression.WebGoBack
expression


Optional. An expression that returns an Application object.

WebGoForward Method

Goes to the next document in the history list.

Syntax

expression.WebGoForward
expression


Optional. An expression that returns an Application object.

WebHelp Method

Opens the document corresponding to a command on the Microsoft on the Web submenu.

Syntax

expression.WebHelp(Type)
expression


Optional. An expression that returns an Application object.

Type





Optional Integer. The command to activate. Application-specific commands (above the separator bar on the Microsoft on the Web submenu) are numbered 1 through 8, while Office-wide commands are numbered 9 through 16. The Microsoft Home Page command is 17.

Remarks

The Microsoft on the Web submenu is available on the Help menu.

In Microsoft Windows 95 or Microsoft Windows NT 4.0, to customize the WebHelp commands, run the command "regedit" by clicking the Start button and then clicking Run. The file RegEdit.exe is in your Windows folder.

In Microsoft Windows NT 3.5 or 3.51, run "regedt32" by using the Run command on the File menu. The file RegEdt32.exe is in the System32 directory of your Windows directory.

For application-specific commands, negotiate the registry tree to HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Application\WebHelp, where Application is the name of the application. For Office-wide commands, negotiate the registry tree to HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Common\WebHelp. If the WebHelp key doesn't exist, create it by pointing to New on the Edit menu, clicking Key, and then typing WebHelp.

Custom commands can be added by creating registry keys named Commandx, where x is a number between 1 and 8. With the WebHelp key selected, point to New on the Edit menu, and then click String Value. Double-click the Commandx string value and, in the Value data field, enter &Command name,URL, where Command name is the command to appear on the Microsoft on the Web submenu and URL is the address of the document to open. The ampersand (&) should be placed immediately before the letter that you want to appear underlined on the submenu.

Adding a custom command hides all the default commands for that part of the submenu. If you want to provide a mix of custom and default commands, you need to create custom commands that mimic the default commands.

To display this command
Enter this value data string in the Value data field




Free Stuff
&Free Stuff,,Application,,0x0409,8.0,free

Product news
&Product News,,Application,,0x0409,8.0,news

Frequently Asked Questions
Frequently Asked &Questions,,Application,,0x0409,8.0,faq

Online Support
Online &Support,,Application,,0x0409,8.0,support

Microsoft Office Home Page
Microsoft &Office Home Page,,office,,0x0409,8.0,home

Send Feedback
Send Feedbac&k…,,office,,0x0409,8.0,feedback

Best of the Web
&Best of the Web,,msft,,0x0409,,directory,,office8

Search the Web
Search the &Web…,,msft,,0x0409,,search,,office8

Web Tutorial
Web &Tutorial,,msft,,0x0409,,tutorial,,office8

If you plan to restore some or all of the default commands, it is a good idea to limit custom items to Command5 through Command8 (application-specific commands) or Command6 through Command8 (Office-wide commands).

WebHideToolbars Method

Shows or hides all toolbars except the Menu and Web toolbars.

Syntax

expression.WebHideToolbars(Hide)
expression

Optional. An expression that returns an Application object.

Hide




Optional Boolean. True if all toolbars except the Menu and Web toolbars are hidden. The default value is True if toolbars other than Menu and Web are displayed, and False if they are not.

WebInbox Method

Displays the WebInbox login screen. The user may be prompted for a password.

Syntax

expression.WebInbox
expression

Optional. An expression that returns an Application object.

Remarks

The WebInbox method has the same effect as the WebInbox command on the Workgroup submenu, which is available on the Tools menu.

WebOpenFavorites Method

Opens the Favorites folder.

Syntax

expression.WebOpenFavorites
expression

Optional. An expression that returns an Application object.

WebOpenHyperlink Method

Opens the document specified by a hyperlink address. This method is only available when the selected assignment, resource, or task field contains a hyperlink.

Syntax

expression.WebOpenHyperlink(Address, SubAddress, AddHistory, NewWindow)
expression

Optional. An expression that returns an Application object.

Address


Optional String. The address of the target document. If Address is omitted, the text of the selected field is used.

SubAddress

Optional String. A location within the target document.

AddHistory

Optional Boolean. True if the target document should be added to the History folder. The default value is True.

NewWindow

Optional Boolean. True if the target document should display in a new window. The default value is False.

WebOpenSearchPage Method

Opens the Search Page.

Syntax

expression.WebOpenSearchPage
expression

Optional. An expression that returns an Application object.

WebOpenStartPage Method

Opens the Start Page.

Syntax

expression.WebOpenStartPage
expression

Optional. An expression that returns an Application object.

WebRefresh Method

Displays the previously viewed document, without reading it from the cache.

Syntax

expression.WebRefresh
expression

Optional. An expression that returns an Application object.

WebSetSearchPage Method

Specifies a document as the Search Page.

Syntax

expression.WebSetSearchPage(Address)
expression

Optional. An expression that returns an Application object.

Address


Optional String. The address to use as a Search Page. If Address is omitted, the current document is set as the Search Page.

WebSetStartPage Method

Specifies a document as the Start Page.

Syntax

expression.WebSetStartPage(Address)
expression

Optional. An expression that returns an Application object.

Address


Optional String. The address to use as a Start Page. If Address is omitted, the current document is set as the Start Page.

WebStopLoading Method

Stops loading the document.

Syntax

expression.WebStopLoading
expression

Optional. An expression that returns an Application object.

WebToolbar Method

Shows or hides the Web toolbar.

Syntax

expression.WebToolbar(Show)
expression

Optional. An expression that returns an Application object.

Show



Optional Boolean. True if the Web toolbar is shown. The default is to toggle the current setting.

Weekday Object, Weekdays Collection Object

Represents a weekday or the weekdays in a calendar. The Weekday object is a member of the Weekdays collection.

Using the Weekday Object

Use Weekdays(Index), where Index is the weekday index number, three letter abbreviation of the day name, or PjWeekday constant, to return a single Weekday object. The following example sets Friday (the sixth day of a week starting on Sunday) as a half-day by setting the start and finish times for the first shift and clearing the values of the second and third shifts.

With ActiveProject.Calendar.WeekDays(6)

    .Shift1.Start = #8:00:00 AM#

    .Shift1.Finish = #12:00:00 PM#

    .Shift2.Clear

    .Shift3.Clear

End With

A much better way to return the same object would be to use the predefined constant for Friday instead of the nonintuitive number 6. Thus, the first line of the preceding example would be

With ActiveProject.Calendar.WeekDays(pjFriday)

Using the Weekdays Collection

Use the Weekdays property to return a Weekdays collection.

ActiveProject.Calendar.WeekDays

Weekdays Property

Returns a Weekdays collection representing the weekdays in a calendar. Read-only.

Weekdays Property Example

The following example makes Friday a nonworking day in the calendar for the active project.

Sub MakeFridaysNonworking()


ActiveProject.Calendar.Weekdays(pjFriday).Working = False

End Sub

WeekLabelDisplay Property

Returns or sets how the week label displays in durations, delays, slack, work values, and so on. Read/write Integer.

The type of display varies from language to language and is determined by its order in the Weeks as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
w

1
wk

2
week

Width Property

Returns or sets the width of the main window (Application object) or a project window (Window object) in points. Read/write Long.

Remarks

A window changes its width by moving its right edge, leaving the left edge unaffected. 

Width Property Example

The following example places the main window in the left half of the screen.

Sub PlaceProjectInLeftScreenHalf()


Dim WindowHeight As Double


Application.WindowState = pjMaximized


WindowHeight = Application.Height
'Remember the height when maximized.


Application.Width = Application.Width / 2


Application.Top = 0


Application.Left = 0


'Make sure the window uses all the available height.


If Application.Height < WindowHeight Then Application.Height = WindowHeight

End Sub

Window Object, Windows Collection Object

Represents a window or windows in the application or project. The Window object is a member of the Windows collection. The Windows collection for the Application object contains all the windows in the application, whereas the Windows collection for the Project object contains only the windows in the specified project.

Using the Window Object

Use Windows(Index), where Index is the window index number or window caption, to return a single Window object. The following example maximizes the first window in the window list.

Application.Windows(1).WindowState = pjMaximized

The window caption is the text shown in the title bar at the top of the window when the window isn't maximized. The caption is also shown in the list of open files on the bottom of the Windows menu. Use the Caption property to set or return the window caption. Changing the window caption doesn't change the name of the project. The following example hides the window containing "Project1".

If Application.Windows(1).Caption = "Project1" Then

    Application.Windows(1).Visible = False

End If

Using the Windows Collection

Use the Windows property to return a Windows collection. The following example cascades all the windows that are currently displayed in Microsoft Project.

With Application.Windows

    For I = 1 To .Count

        .Item(I).Activate

        .Item(I).Top = (I - 1) * 15

        .Item(I).Left = (I - 1) * 15

    Next I

End With

Use the WindowNewWindow method to create a new window and add it to the collection. The following example creates a new window for the active project.

Application.WindowNewWindow

WindowActivate Method

Activates a window.

Syntax

expression.WindowActivate(WindowName, TopPane, DialogID)
expression


Optional. An expression that returns an Application object.

WindowName

Optional String. The name of the window to activate. The name of a window is the exact text that appears in the title bar of the window. The default is the name of the active window.

TopPane



Optional Boolean. True if Microsoft Project should activate the upper pane. The default value is True.

DialogID



Optional Long. A constant specifying the dialog box to activate. Can be the following PjDialog constant: pjResourceAssignment.

WindowActivate Method Example

The following examples allow the user to specify and activate a "hot" window.  If you assign the ActivateHotWindow procedure to a shortcut key, you can press that key to quickly activate the hot window.

Public HotWindowName As String  ' The name of the current hot window

Sub ActivateHotWindow()

    Dim IsOpen As Boolean   ' Whether or not the current hot window is open

    Dim I As Long           ' Index for For...Next loop

    IsOpen = False          ' Assume the hot window is not open.

    For I = 1 To Windows.Count  ' Look for the current hot window.

        If LCase(Windows(I).Caption) = LCase(HotWindowName) Then

            IsOpen = True

            Exit For

        End If

    Next I

    ' If the current hot window is not open or defined, then run

    ' the ChangeHotWindow procedure.

    If Len(HotWindowName) = 0 Or Not IsOpen Then

        MsgBox ("The current hot window is not open or has not been defined.")

        ChangeHotWindowName

    ' If the hot window is open, activate it.

    Else

        WindowActivate (HotWindowName)

    End If

End Sub

Sub ChangeHotWindowName()

    Dim Entry As String     ' The text entered by the user

    Entry = InputBox$("Enter the name of the hot window.")

    ' If the user chooses Cancel, then exit the Sub procedure.

    If Entry = Empty Then Exit Sub

    ' Otherwise, set the name of the hot window and then activate it.

    HotWindowName = Entry

    ActivateHotWindow

End Sub

WindowArrangeAll Method

Arranges all the open windows in Microsoft Project.

Syntax

expression.WindowArrangeAll
expression

Optional. An expression that returns an Application object.

WindowHide Method

Hides a window.

Syntax

expression.WindowHide(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of the window to hide. The name of a window is the exact text that appears in the title bar of the window. The default is the active window.

WindowHide Method Example

The following example hides all windows except the active window.

Sub HideAllWindowsExceptActive()

    Dim I As Long   ' Index for For...Next loop

    For I = 1 To Windows.Count

        If Windows(I) <> ActiveWindow And Windows(I).Visible Then

            WindowHide Windows(I).Caption

        End If

    Next I

End Sub

WindowMoreWindows Method

Displays the Window Activate dialog box, which prompts the user to activate a window.

Syntax

expression.WindowMoreWindows
expression

Optional. An expression that returns an Application object.

WindowNewWindow Method

Creates a new window.

Syntax

expression.WindowNewWindow(Projects, View, AllProjects, ShowDialog)
expression

Optional. An expression that returns an Application object.

Projects


Optional String. The names of one or more projects, separated by the list separator character. The new window contains data from the projects you specify. The default is to create a copy of the active window.

View




Optional String. The name of an initial view for the new window. The default is equal to the value returned by the DefaultView property.

AllProjects

Optional Boolean. True if the new window contains data from all open projects. When True, AllProjects overrides Projects. The default value is False.

ShowDialog

Optional Boolean. True if the New Window dialog box is displayed so that a view or project can be selected. The default value is False.

WindowNewWindow Method Example

The following example creates a new window that combines the data from all open projects.

Sub NewCombineProjectsInNewWindow()


WindowNewWindow AllProjects:=True

End Sub

WindowNext Method

Activates the next window.

Syntax

expression.WindowNext(NoWrap)
expression

Optional. An expression that returns an Application object.

NoWrap


Optional Boolean. True if using WindowNext on the last opened window doesn't wrap around to the first opened window. The default value is False.

Remarks

The window order should not be confused with the order that projects appear in the window list, where they are sorted alphabetically.

WindowPrev Method

Activates the previous window.

Syntax

expression.WindowPrev(NoWrap)
expression

Optional. An expression that returns an Application object.

NoWrap


Optional Boolean. True if using WindowPrev on the first opened window doesn't wrap around to the last opened window. The default value is False.

Remarks

The window order should not be confused with the order that projects appear in the window list, where they are sorted alphabetically.

Windows Property

Returns a Windows collection representing the open windows in the application or active project. Read-only.

Windows Property Example

The following example cascades all the open windows.

Sub CascadeWindows()

    Dim I As Integer

    ActiveWindow.WindowState = pjNormal ' Restore the window.

    With Application.Windows
        For I = 1 To .Count

            .Item(I).Activate

            .Item(I).Top = (I - 1) * 15

            .Item(I).Left = (I - 1) * 15

        Next I

    End With

End Sub

WindowSplit Method

Creates a lower pane for the active window. Closes the lower pane, if it already exists.

Syntax

expression.WindowSplit
expression

Optional. An expression that returns an Application object.

WindowState Property

Returns or sets the state of the main window (Application object) or all project windows (Window object). Can be one of the following PjWindowState constants: pjNormal, pjMinimized, or pjMaximized. Read/write Long.

WindowState Property Example

The following example maximizes all project windows.

Sub MaximizeProjectWindows()


ActiveWindow.WindowState = pjMaximized

End Sub

WindowUnhide Method

Shows a hidden window.

Syntax

expression.WindowUnhide(Name)
expression

Optional. An expression that returns an Application object.

Name



Optional String. The name of a hidden window to show. The name of a window is the exact text that appears in the title bar of the window. If Name is omitted, the Unhide dialog box appears, which prompts the user to show a hidden window in the active project.

WindowUnhide Method Example

The following example unhides all open windows.

Sub UnhideAllWindows()

    Dim I As Long   ' Index for For...Next loop

    For I = 1 To Windows.Count

        If Not Windows(I).Visible Then

            WindowUnhide Windows(I).Caption

        End If

    Next I

End Sub

Work Property

Returns or sets the work (in minutes) for an assignment, resource, or task. Read-only for the Resource object and summary tasks. Read/write Variant.

WorkContour Property

Returns or sets the type of work contour for a resource assignment. Can be one of the following PjWorkContourType constants: pjBackLoaded, pjBell, pjContour, pjDoublePeak, pjEarlyPeak, pjFlat, pjFrontLoaded, pjLatePeak, or pjTurtle. The default value is pjFlat. Read/write Long.

Workgroup Property

Returns or sets how workgroup messages will be sent to the resource. Can be one of the following PjWorkgroupMessages constants: pjNoWorkgroupMessages, pjWorkgroupViaEmail, pjWorkgroupViaEmailAndWeb, pjWorkgroupViaWeb, or pjDefaultMessages. Read/write Long.

Remarks

Specifying pjDefaultMessages for the Workgroup property uses the value specified by the Default workgroup messaging for resources setting on the Workgroup tab of the Options dialog box.

WorkgroupMessages Property

Returns or sets the default for how workgroup messages will be sent to new resources. Can be one of the following PjWorkgroupMessages constants: pjNoWorkgroupMessages, pjWorkgroupViaEmail, pjWorkgroupViaEmailAndWeb, or pjWorkgroupViaWeb. Read/write Long.

Working Property

True if any day in a calendar period is a working day. Read/write Boolean.

Working Property Example

The following example makes June, July, and August nonworking months for resources in the "Student" group of the active project.

Sub GiveStudentsSummerOff()

    Dim R As Resource   ' Resource object used in For Each loop

    Dim Y As Year       ' Year object used in For Each loop

    ' Look for resources in the "Student" group of the active project.

    For Each R In ActiveProject.Resources

        ' Give the summer off to resources in the "Student" group.

        If R.Group = "Student" Then

            For Each Y In R.Calendar.Years

                Y.Months("June").Working = False

                Y.Months("July").Working = False

                Y.Months("August").Working = False

            Next Y

        End If

    Next R

End Sub

WorkVariance Property

Returns the variance between the baseline work and the work for an assignment, resource, or task. Read-only Variant.

WriteReserved Property

True if a password is required to open a project for read/write access. Read-only Boolean.

Year Object, Years Collection Object

Represents a year or the years in a calendar. The Year object is a member of the Years collection.

Using the Year Object

Use Years(Index), where Index is the year index number, to return a single Year object. The following example counts the number of working days in the month of September 1997 for each selected resource.

Dim R As Resource, D As Integer, WorkingDays As Integer

For Each R In ActiveSelection.Resources()

    WorkingDays = 0

    With R.Calendar.Years(1997).Months(pjSeptember)

        For D = 1 To .Days.Count

            If .Days(D).Working = True Then

                WorkingDays = WorkingDays + 1

            End If

        Next D

    End With

    MsgBox "There are " & WorkingDays & " working days in " _

        & R.Name & "'s calendar."

Next R

Using the Years Collection

Use the Years property to return a Years collection. The following example lists all the years in the active project's calendar.

Dim C As Long, Temp As String

For C = 1 To ActiveProject.Calendar.Years.Count

    Temp = Temp & ListSeparator & " " & _

        ActiveProject.Calendar.Years(C + 1983).Name

Next C

MsgBox Right$(Temp, Len(Temp) - Len(ListSeparator & " "))

Remarks

The Years collection in Microsoft Project starts at 1984 and ends at 2049.

YearLabelDisplay Property

Returns or sets how the year label displays in rates. Read/write Integer.

The type of display varies from language to language and is determined by its order in the Years as list, found on the Edit tab of the Options dialog box:

Order in list
Display




0
y

1
yr

2
year

Years Property

Returns a Years collection representing the years in a calendar. Read-only.

Years Property Example

The following example makes January 1 of every year a nonworking day.

Sub NewYearsDayOff()

    Dim Y As Year

    For Each Y In ActiveProject.Calendar.Years
        Y.Months(pjJanuary).Days(1).Working = False

    Next Y

End Sub

Zoom Method

Displays the Zoom dialog box, which prompts the user to zoom in on or out from the active view.

Syntax

expression.Zoom
expression

Optional. An expression that returns an Application object.

ZoomCalendar Method

Zooms in on or out from the Calendar.

Syntax

expression.ZoomCalendar(NumWeeks, StartDate, EndDate)
expression

Optional. An expression that returns an Application object.

NumWeeks

Optional Long. The number of weeks to display. If StartDate and EndDate are specified, NumWeeks is ignored.

StartDate


Optional Variant. The first date to display.

EndDate


Optional Variant. The last date to display.

Remarks

Using the ZoomCalendar method without specifying any arguments displays the Zoom dialog box.

ZoomCalendar Method Example

The following example displays four weeks at a time in the Calendar view.

Sub FourWeekCalendar()


ZoomCalendar NumWeeks:=4

End Sub

ZoomIn Method

Zooms in on the active view. Not available on the Resource Sheet, Task Sheet, or any of the form views.

Syntax

expression.ZoomIn
expression

Optional. An expression that returns an Application object.

ZoomOut Method

Zooms out from the active view. Not available on the Resource Sheet, Task Sheet, or any of the form views.

Syntax

expression.ZoomOut
expression

Optional. An expression that returns an Application object.

ZoomPERT Method

Zooms in on or out from the PERT Chart.

Syntax

expression.ZoomPERT(Percent, Entire)
expression

Optional. An expression that returns an Application object.

Percent


Optional Variant. The percentagebetween 25 and 400to reduce or enlarge the PERT Chart. If Entire is True, Percent is ignored.

Entire



Optional Boolean. True if the PERT Chart resizes in order to fit the entire project onto the screen, within the same limits described for Percent. The default value is False.

ZoomPERT Method Example

The following example attempts to fit all tasks onto the screen. It assumes the PERT Chart is the active view.

Sub Display()


ZoomPERT Entire:=True

End Sub

ZoomTimescale Method

Zooms in on or out from the Gantt Chart, Resource Graph, Resource Usage, or Task Usage view to show information about tasks or resources in a certain duration.

Syntax

expression.ZoomTimescale(Duration, Entire, Selection, Reset)
expression

Optional. An expression that returns an Application object.

Duration


Optional Variant. The duration to display in the view.

Entire



Optional Boolean. True if the view resizes in order to fit the entire project onto the screen. The default value is False.

Selection


Optional Boolean. True if the view resizes in order to fit only the selected tasks onto the screen. The default value is False.

Reset



Optional Boolean. True if the view is reset to its default size. The default value is False.

Remarks

Except for the Resource Graph, where the entire view is affected, all zooming occurs in the nonentry portion of the active view.

ZoomTimescale Method Example

The following example attempts to fit the entire project onto the screen.

Sub Display()


ZoomTimescale Entire:=True

End Sub

Body Code (may be several lines)
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